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Module 1

Digital Video Workflow, Project Planning and Writing Tips

Your students probably want to dive right into Adobe® Premiere® Pro and Adobe’s other Windows® –based digital video
(DV) products. You can’t blame them. If they’ve had any experience editing videos with earlier versions of Adobe Premiere
or other PC nonlinear video editors they might be able to do a lot with Adobe Premiere Pro right off the bat. However,
formal, hands-on work with Adobe Premiere Pro doesn’t begin until Module 4.

This first module diagrams the DV workflow. Adobe now offers a full collection of tightly integrated, professional DV
software: tools for any kind of DV work your students can imagine. To start this module, we diagram where they fit in the
production workflow.

How to visualize a project before shooting the first clip is the next course objective. A practical guide to multi-camera
production follows, and finally, we offer a how-to guide to writing in the “active voice” and some scriptwriting advice from
two Hollywood veterans.

At the end of this lesson students will be able to:

• Diagram the digital video workflow

• Incorporate Bob Dotson’s story creation tips into their productions

• Understand how to setup multi-camera remote productions

• Write in the active voice

• Use proven scriptwriting techniques

Diagramming the digital video workflow

Premiere Pro is the hub of a newly expanded, five-product suite of tools geared to digital video production. All five feature
tight integration and complement and enhance one another. Here’s a brief rundown of Adobe Premiere Pro’s four
teammates:

• Adobe Photoshop® CS (Creative Suite) — the latest update to this industry-standard graphic creation and editing
product.

• Adobe After Effects® 6.5 -— the tool-of-choice for video editors looking to animate graphics and text.

• Adobe Encore™ DVD 1.5—- a new DVD authoring product built from the ground up to work closely with Adobe
Premiere Pro, After Effects 6.5 and Photoshop CS.

• Adobe Audition™ 1.5 —- a professional-level audio editing and sweetening product. Adobe purchased it (Cool
Edit Pro) from Syntrillium Software in the summer of 2003 and supplemented it with more than 5,000 loops —-
music snippets that editors can use to create entire musical selections.

Taken individually and collectively, nothing can come close to the power, productivity and creativity these Adobe products
will bring to your student’s video projects.
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The focus of the Adobe DV curriculum is Adobe Premiere Pro. It’s the engine that drives
your production. But each of the other four products in the collection has one or more
significant roles to play.

We will offer modules on those supporting products throughout the Adobe DV
curriculum. To see how they fit into that workflow, take a look at Figure 1.1.

Figure 1.1: The digital video workflow using the Adobe Video Collection.

Your workflow may vary depending on your production needs. Basically, your students will use Adobe Premiere Pro to
assemble raw and finished parts into a completed whole. Here are a few mini-workflow scenarios:

• Photoshop captures and touches up photos from a digital camera or a scanner. It then exports them to Adobe
Premiere Pro.

• Photoshop creates images from scratch or edits still images created in Adobe Premiere Pro, then sends them on to
Adobe Premiere Pro.
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• Adobe Audition enables you to create custom music and edit existing music and sounds either to an existing
video clip or production, or as a separate audio file. That audio might come from digital video captured by Adobe
Premiere Pro. Do fine-tuning in Adobe Audition and send it back to Adobe Premiere Pro.

• Adobe Premiere Pro captures raw video from a camcorder or VCR. You then edit it and can record it to tape using a
camcorder or VCR.

• Send sequences created in Adobe Premiere Pro to After Effects 6.5 to apply complex motion and animation, then
send those updated motion sequences back to Adobe Premiere Pro.

• Use After Effects  to create and animate text in ways far beyond the capabilities of Adobe Premiere Pro.

• Import Adobe Premiere Pro-created video projects into Adobe Encore DVD to use in DVD projects. You can use
those videos as the foundation of a project or as motion menus.

• Create menus and menu buttons for Adobe Encore DVD in Photoshop, or use Photoshop to edit menus created
using Adobe Encore DVD templates.

• Use After Effects 6.5 to build motion menus for Adobe Encore DVD using Photoshop- or Adobe Encore DVD-
created static menus.

Video Production Planning

Many video production courses hammer on planning, frequently down to the most minute details. Those admonitions
make sense for higher-budget productions with crews, actors, and caterers.

For most high school and college DV productions, much of the “planning” takes place on the fly, in the field. Unexpected
things come up frequently: lighting changes, wind, missing actors, burned out light bulbs, crowds, and no crowds. If you
know some basic story creation fundamentals, you can overcome most of these hiccups.

We think your students will stand to benefit more from these upcoming tips than from any elaborate, production planning.

NBC-TV Today Show correspondent Bob Dotson is the source for this collection of tips. He is one of the
best human-interest feature-story TV reporters today. He is a rare artist who both understands his craft
and can explain his methodology. He has conducted numerous seminars on his video production
concepts and leaves his students with what he calls his “Story Checklist.”

Bob Dotson, NBC-TV reporter.

Although your students may not aspire to be TV producers or reporters, they will create human-interest stories: Dotson's
forte. If there‘s a storyteller out there you should emulate, I think he's the one.

Here are Dotson’s three principal messages:

• Give viewers a reason to remember the story.

• When interviewing people, try not to ask questions. Merely make observations. That loosens people up, letting
them reveal their emotional, human side to you.

• Make sure you get a closing shot. Most video producers look for dramatic opening shots or sequences (and that's
still a good thing), but your viewers are more likely to remember the closing shot.

Bob Dotson's Story Checklist

Dotson's "Storyteller's Checklist" inspired his book Make It Memorable (Bonus Books) and a companion videotape of all the
stories in the book. He prepared his list (and book) with TV news reporters in mind, but his tips apply to professional,
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corporate, and student video producers as well. Some of these points apply to your student’s work in the field, while most
focus on actual story writing. In any event, as you students shoot their video, they need to think in terms of all items on this
checklist:

• Make sure the commitment is present. Commitment is your description of the story, stated in one sentence. That is
what you want the audience to take away from the production. You should be able to state the commitment as a
complete sentence with subject, verb, and object. "Outside money is altering the city's architecture," "This cow has
never taken an order in her life," "You can't murder a pumpkin," and so on. You formulate the commitment to
yourself to help guide the story creation. Then you use your images to prove the commitment visually. Very seldom
will you state the commitment verbally in any story.

• The main body of the story should usually be no more than three to five main points, which you prove visually
once you have identified them.

• Write your pictures first. Give them a strong lead, preferably visual, that instantly telegraphs the story to come.

• Address the larger issue. "A trailer home burned down." Such a story fails to meet the "so what?" test. "The trailer
home burned down because the walls are full of flammable insulation" describes the larger issue and meets the
"so what?" test.

• Throughout the story, build your report around sequences—two or three shots of a guy buying basketball tickets;
two or three shots of a husband and wife drinking coffee at a kitchen table, and so on. Sequences demand
matched action.

• Allow for moments of silence. Stop writing occasionally and let two or three seconds or more of compelling action
occur without voiceover. For a writer, nothing is more difficult to write than silence. For viewers, sometimes
nothing is more eloquent.

• Use strong natural sound to heighten realism, authenticity, and believability, and to heighten the viewer's sense of
vicarious participation in the events you're showing. Some reports merely let you watch what happened. The best
reports let you experience what happened.

• Tell your story through people. People sell your story. Try to find strong central characters engaged in compelling
action that is visual or picturesque.

• Build in surprises to sustain viewer involvement. Surprises help viewers feel something about the story; surprises
lure uninterested viewers to the screen. Surprises can be visual, wild sounds, short bites, or poetic script. Surprises
are little moments of drama.

• Short sound bites prove the story you are showing. Don't use sound bites as substitutes for more effective
storytelling.

• Always remember that the reporter (or video producer) is not the story.

• Write loose. Be hard on yourself as a writer. Say nothing in the script your viewers would already know or that the
visuals say more eloquently.

• Create a strong close that you can't top, something you build toward throughout the story. Ideally, the ending is
also visual.

• Finally, make your story memorable. Can your viewers feel something about the story and its subjects? If feeling is
present, the story will be memorable. It will stick in the viewers’ minds.

Keep It Simple—and Short

As a coda to Dotson's advice, you need to remind your students: This is only TV. You need some mighty compelling or
entertaining material to keep viewers glued to the tube for more than a few minutes.
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Think about whatever message you're trying to get across in your video project, and consider what images, sound, and
graphics will convey that message in the briefest, most effective manner. Then shoot with brevity in mind.

That's not to say that you don't grab unplanned video that looks great. Or that you cut interviews short even if you haven't
heard some compelling sound bites. Videotape is expendable. Feel free to shoot plenty. Although it's true that you might
have to wade through a lot to find the best shots, the advantage of DV is that once these shots are located, you can simply
capture them to your hard drive and they become immediately accessible.

Setting up Remote, Multi-camera Productions

Shooting events with more than one camera is a mainstay of video producers: from corporate sales presentations to
concerts. As your students move into real-world video production, they will undoubtedly find themselves involved in such
work.

Unlike basic single-camera work, multi-camera productions definitely take some planning and preparation.

Cinemagic Studios, in Portland, Oregon, specializes in multi-camera remotes. They typically switch them live in their truck
(while taping each camera separately), and then fine-tune the program in postproduction. Getting it right in the field keeps
that postproduction work to a minimum, saving time and money.

Joe Walsh started Cinemagic in 1980 (    www.cinemagicstudios.com    ). His truly dedicated team
members, several of whom have worked for him for many years, have gained the confidence of a
broad range of clients by meeting those clients’ unique needs and solving their communication
problems. Along the way, that work has garnered more than 30 Telly Awards.

Joe Walsh, Cinemagic Studios, CEO.

Here's Walsh's remote production checklist:

• Make sure you have a clear understanding of your client's expectations and budget. Crew prices vary
depending on the market. In Cinemagic's case, we charge $1,500 per day for a standard DVCAM or Beta SP camera
package with a cameraman and an audio person.

• Do a site check and rehearsal to determine the best camera locations. For two-camera remotes, it is best to
have a back and front position. Place the cameras on risers so you can shoot over people's heads. Position the
cameras so you don't "cross the plane" and shoot toward each other. Use the rehearsal to iron out details with the
people in charge of the location.

• Use multiple cameras and switch the event live to minimize editing afterward. Later, if the budget allows, you
can improve the product by tossing in some post-production editing and graphics. Cinemagic's remote multi-
camera setup includes a digital switcher, intercom system, audio mixer, studio recorder, and monitors for each
camera crew, plus preview and program feed monitors. Budding producers take note: To buy the equivalent gear
that we use for your own two-camera remote setup would cost about $75,000.

• Always have the cameras record separate tapes. Even though we switch events live, if the technical director
makes a bad switch or a cameraman makes an awkward move, we can fix it in post.

• "Jam sync" all recorders before starting to record. Setting the timecode to match all recorders makes it much
easier to find footage that you need if you have to fix something in editing.

• Have a pre-production meeting with your crew to discuss the project and assign responsibilities. Onsite
setup usually takes one hour for a single camera and two hours for multiple cameras. Make sure that all the cables
are tucked away or taped down. After the setup, do a test record and playback check. During the event we always
monitor the audio and video signals.
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• Ensure your location is well lit.
For a lot of our events, the
house handles the lighting,
which makes our job a lot
easier. If not, we typically turn to
our basic light kit: a Lowel light
system with two broad throw
Tota lights and one wide-focus-
range Omni to use as a key- or
backlight (see Figure 1.2).

Figure 1.2: Lowel Tota light (left) and
Lowel Omni light. (Images courtesy Lowel-
Light Manufacturing, Inc.)

• Audio is crucial. When events handle their own audio, we take a line feed from their soundboard and use
shotgun mics for backup and ambient audio. Otherwise, we rely on our standard mic kit: camera mic, shotgun,
lavaliere, handheld, and PZM (pressure zone microphone, useful for a conference table with several speakers).

• When using wireless mics, select UHF instead of VHF to avoid frequency conflicts. All sorts of fun stuff can go
wrong with wireless mics. Your receiver can pick up other sources on your channel, such as radio stations (we
always get country music), pizza delivery guys, or other wireless mics from local commercial TV stations. The UHF
wireless mics have multiple channels at the higher MHz frequency range, so there is less chance of interference.
Always keep fresh batteries on hand. As the batteries grow weak, reception problems occur.

Cinemagic’s favorite wireless mic story happened when they were taking an audio line feed from the house. The house
audio man placed a wireless mic on the presenter. Just moments before he was to go on, the presenter went to the
bathroom. Not only did we pick up the very graphic audio, so did the 500 people in the auditorium.

Writing in the "Active Voice"

Getting your students to write in the “active voice” will dramatically improve the quality of their productions.

The tireless proponent of writing in the active voice is Mackie Morris. The former chairman of the Broadcast News
Department at the University of Missouri School of Journalism and vice president of a major media consulting firm, Morris
regularly instructs television writers on his active-voice approach to writing.

For example, instead of this passive-voice example:

A bill was passed by the Senate.

Use this active voice version instead:

The Senate passed a bill.

Putting the receiver of the verb's action after the verb changes passive-voice writing into active-voice.

Instead of the passively voiced "John Doe was arrested by police" (Doe is the receiver of the action and is ahead of the
verb), change that to "Police arrested John Doe."
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Morris emphasizes that passive voice deadens, complicates, and lengthens writing. It's not ungrammatical, but it's more
suitable for print than television copy. You use passive voice sparingly in everyday conversation, and you should use it
sparingly in video productions. You are asking people to listen to your words, not read them. Make it easy. Make it active.

It will take some effort to make your students shift from passive voice to active voice. Simply recognizing passive voice
takes extra attentiveness. The biggest giveaway is some form of the "to be" verb in a verb phrase. The following sentences
are all in the passive voice:

The students were praised by the teacher.

The unruly customer was told to leave by the maitre 'd.

The forest was destroyed by fire.

Make them active by moving the receiver of the action to after the verb:

The teacher praised the students.

The maitre 'd told the unruly customer to leave.

Fire destroyed the forest.

That one fundamental technique will make their sentences simpler and shorter.

Morris calls it "straight-line meaning. " The listener understands the copy better because it flows in a straight line. You know
that when you read a newspaper you frequently go back and reread some sentences because something didn't add up.
Video viewers don't have that luxury.

Besides simply switching the sentence around ("relocating the actor," as Morris puts it), you can teach your students to fix
passive sentences in three other ways:

• Identify the missing actor and insert it into the sentence. Change "The airplane was landed during the storm"
to "A passenger landed the airplane during the storm."

• Change the verb. Instead of writing "The bell was sounded at noon", write, "The bell rang at noon." (Or tolled,
pealed, chimed—using active voice fosters the use of more descriptive words.)

• Drop the "to be" verb. Change "The spotlight was focused on downtown" to "The spotlight focused on
downtown."

Not all "to be" verb phrases are passive. "The man was driving south" contains a verb phrase and a "to be" helper. But the
man was performing the action, not receiving it. Therefore the sentence is active. A sentence is passive only if the receiver
of the verb's action precedes the verb.

Writing in the active voice forces your students to get out of their writing rut. Instead of saying the same old things in the
same old "to be" passive way, they will select new active verbs and constructions. They'll write more conversationally and
with a fresher and more interesting style.

That's not to say that they'll write exclusively in the active voice. They should write, "He was born in 1984," or "She was
injured in the accident" because that's what people say.

Focusing on active voice will make your students’ copy more interesting and easier to understand.
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Mackie Morris' Writing Tips

Few, if any, media consultants match Mackie Morris' 25-year record as a journalism and
communications seminar leader, teacher, coach, and practitioner. Founder and president of
Mackie Morris Communications, he works with a wide range of corporate and public service
clients to enhance their communication skills.

Previously, Morris served as chairman of the Broadcast News Department in the University of
Missouri School of Journalism. He later worked as a vice president and lead consultant for Frank
N. Magid Associates, a major media consulting firm, where he implemented a series of
instructional workshops for broadcast professionals. Morris continues to be one of the most
sought-after broadcast-writing seminarians ever.

The Good Writer's Dazzlin' Dozen

At his seminars, Morris relentlessly drives home his active-voice message. But peppered throughout his presentation are
other useful writing tips. He calls them "The Good Writer's Dazzlin' Dozen":

• Write factually and accurately. The best technique and the finest form mean nothing if your copy's wrong.

• Write in the active voice. This technique will make your copy tighter, complete, easier to listen to, and more
interesting. Do whatever you must to avoid the passive voice.

• Write in the present or present perfect tenses. They make your copy more immediate, and immediacy is more
interesting. Avoid the word today. If you use past tense, make sure you give a time reference to avoid confusion.

• Keep your writing simple. Choose positive forms over negative forms. Write one thought to a sentence. Don't
search for synonyms, because repetition is not a sin. Don't search for complicated, "intellectual" language. Give the
audience the best possible chance to understand the story.

• Be complete and clear. In your quest for brevity and conciseness, don't omit necessary information.

• Be creative. Stick to the rules but develop your own style. Try to say the same old thing in a different, new way.
Make use of writing devices that make copy easier to listen to and more interesting, such as using the "rule of
threes" (that is, grouping items by threes, such as red, white, and blue; left, right, and center; over, under, and
through). Saying things in groups of three always sounds better. Pausing before saying the third item is even more
effective.

• Write to be heard. Maintain a sense of rhythm in your writing. All life has rhythm, and rhythmic writing is easier to
hear. Avoid potentially confusing homonyms. Always, always test your copy by reading it aloud.

• Avoid interruptives. Don't force the listener to make difficult mental connections. Put modifiers next to what
they modify. Don't split verb phrases (split infinitives).

Incorrect: Will eventually decide.

Correct: Eventually will decide.

Incorrect: Doctors only gave him six months to live.

Correct: Doctors gave him only six months to live.

• Avoid commas. A comma demands a hitch in reading and the resulting jerkiness frustrates the listener. Avoiding
commas also will eliminate subordinate clauses. Such clauses kill the impact of copy, especially if they come at the
top of a story or sentence.

• Avoid numbers. The listener has trouble remembering them.
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• Avoid pronouns. If you must use a pronoun, make sure the pronoun agrees with its antecedent and appears
close to the antecedent. For example, "John Doe hit Bob Smith on the head and paramedics took him to the
hospital." In this case, instead of "him" use "Smith."

• Write to the pictures but not too closely to the pictures. Remember that more specific video requires more
general writing, and vice versa. Utilize the touch-and-go method, wherein you write directly to the video at the
beginning of a sequence and then allow the writing to become more general with background information and
other facts as the video continues.

Storytelling with Video

The goal for your students is to tell stories. In most cases, they might go out on a shoot with only a basic idea of what
they're going to tape and how they're going to piece it together. That kind of approach will get them only so far.

At some point they will need to work from a script. It might be as straightforward as a corporate safety video production
with employees doing the acting, or they may have aspirations to create a dramatic feature.

In either case, some fundamental scriptwriting skills will help them raise the bar of your production. We tapped two of
Hollywood's top writers to do the honors.

Stephen Black and Henry Stern's Scriptwriting Tips

Stephen Black’s and Henry Stern’s TV scriptwriting and producing credits would fill this page. They forged new directions in
episodic dramas with their work on Dynasty, Falcon Crest, Flamingo Road, Matlock, and Knot's Landing. Their work as head
writers on As the World Turns and consultants for One Life to Live stirred things up and added
sizzle to both of these long-running daytime staples. They've had a hand in a half-dozen TV
movies, including the only TV film starring Audrey Hepburn, Love Among Thieves.

Stephen Black (left) and Henry Stern (right), TV scriptwriters and producers.

They got their start as a writing team doing comedies in the mid-1970s. Stern had been one
of Broadway's youngest producers, and Black had written a couple plays. Despite failing to sell their first comedy script to
the Mary Tyler Moore Show, they were given free access to the set, where they watched rehearsals and show tapings, all the
while taking copious notes. That led to a brief stint writing for a new show called The Love Boat ("It paid the bills and got us
in the Writers Guild") and finally landed them a job with Norman Lear Productions, the company behind All in the Family.

These days, they're working on their second novel and a movie script. Here's their advice to aspiring scriptwriters:

• The most important thing is that we like to tell stories.

• And the most important thing in stories is the characters. The best kind of character is one with the ability to
surprise you. The audience is not dumb. You've got to come up with something unpredictable. You don't want a
white hat or black hat. You want people wearing gray hats. People you can't read. You want to be interested in
what happens to them.

• It's not a good idea to start your script-writing with a plot. It's better to start with a theme. Know what you want to
say, how you want to say it, and where you want to be at the end. The theme of our current film script is, How does
the death of someone affect his three closest friends?

• With the theme in hand, we next create the characters. What is their arc and how will that change throughout the
story? We invent detailed character bios. Where did they go to school? What were their parents like? What was
their childhood like? We don't have to use all that in the script, but it's good for us to know to help craft the story.

• Next we sit down with a yellow legal pad and make 30 to 40 story points, such as guy robs bank, hides in mother's
house, falls in love with neighbor, and so on.
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• Then we write an extensive narrative outline—30 pages or more. We include texture—the tone and detail. We
take time to describe settings and characters. Instead of merely using physical descriptions of characters, such as
Bob is 6 feet 2inches tall with the torso of a long distance runner, we're more likely to write, "As John was driving
up Canyon Avenue, he looked out his rain-spattered window and caught sight of Bob, one more time, running in
the rain." That says a lot. We love doing that. It makes it easier to do the script.

• It's really crucial that you learn how to structure a piece so your story will make sense. Know where your story is
going and how plot elements and character elements will build on one another so they peak at certain points. An
excellent film example of structure is Two for the Road, with Audrey Hepburn and Albert Finney. Even though they
use multiple flashbacks, you know that from beginning to end this is a story of a marriage on the skids.

• Tell as much of the story as you can without dialogue. Tell it cinematically. Don't give camera directions such as
wide, tight medium. That's the director's job and disrupts the story flow. But it's okay to script camera angles. We
wrote a scene where a woman was about to tell her husband their son was killed in combat. The husband ran a
steak house and happened to be in the walk-in freezer when his wife arrived. We directed the camera to look
through the window and, without any dialogue, watch the woman tell the husband and see the reaction.

• You can't write if you're not an observer. We're constantly eavesdropping in restaurants. We're acutely aware of
dialogue going on around us. Our characters have to speak in the vernacular of the time.

• Dialogue is more than just writing down what two people say to each other. Good dialogue is succinct, crisp,
entertaining, and rich. It's a level above conversation.

• Bury the "pipe." The pipe is the exposition, the conduit of information, the stuff the audience needs to know to
make sense of the story. Say the character's been divorced three times, has six kids with six different women, and
runs a grocery. You don't come out and say that. You impart it to the audience in an interesting way.

• Scriptwriting is collaborative. Everyone has a hand in it. A screenplay will go through 10 to 15 drafts before
shooting begins.

• Writing is hard work. To sit there in front of a blank, empty computer screen knowing that you have to come up
with compelling characters and stimulating plots, week after week after week, can be daunting. Back in 1970, we
were working with Leon Uris on a musical production of his novel Exodus. After several tiring meetings with
potential backers, Stephen asked him whether he had any advice for aspiring playwrights. He said, "Put your ass in
a chair in front of a typewriter." This was the most succinct, valuable information we were ever given.

Unblocking Creativity

Writer's block strikes us all. As Black and Stern said, it's darned hard to sit down in front of a blank computer screen and
start putting words in the computer.

Here are some ways to get the creative juices flowing:

• Bounce ideas off others. Have your students talk about their projects. Typically, that will give them a whole new
perspective. Listening to questions posed to them about their work will help them focus their writing.

• Have them change their work environment. Simply stepping outside for a moment in the fresh air helps bust loose
a few cobwebs.

• Turn away from the computer, grab a yellow legal pad and a felt-tip pen, and scribble down some ideas. Connect
the thoughts on paper.

• Take a break. Listen to a great tune. Take a jog. Then get back to work—you're on deadline!
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Exercises and Activities

1. Scriptwriter Stephen Black's dad fostered his writing from very early on. One exercise he asked his son to do while they
were working on a novel together was to sit down during a large family gathering and invent characters for the novel
using the characteristics of the gathered guests as his inspiration. It worked for Black. It's also a great way for you to
avoid the usual idle family chitchat.

2. Take a local newspaper story about an event or breaking news. Read it aloud with an ear for passive-voice phrases,
such as "She was hit by a speeding car," "The house was destroyed by the blaze," and "The budget was presented by
the Governor." Rewrite the story in active voice.

3. Contact a local TV station and arrange for your students to accompany reporters on news stories. This one day of this
on-the-job training will be invaluable.

4. Contact a local video production company and get permission to tag along during a remote, multi-camera taping.
They might let you help set up (it's called "gaffer's” tape not "duct” tape) and sit in the control room. That will be an
eye-opening and educational experience.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education

Adobe, the Adobe logo, Adobe Premiere, Adobe Audition, Adobe Encore, Acrobat, After Effects, GoLive, Illustrator, InDesign, Photoshop, and Tools for the
New Work are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. All other
trademarks are the property of their respective owners.

© 2004 Adobe Systems Incorporated. All rights reserved.
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Module 2

Digital Still Photography: Issues and Techniques

Building a fundamental foundation is critical to developing expertise down the road. It’s a good idea to start
your students down the video production path by teaching them some fundamental still photography
techniques. Since most own or will migrate to digital cameras, they also need to understand that medium’s
limitations.

At the end of this lesson, students will be able to:

• Know about digital still camera issues

• Understand what to look for when purchasing a digital camera

• Improve their still photography skills

• Know what to look for in a scanner

Digital or Film Cameras—What Will Work Best for You

Film has its plusses, but you can’t deny the mass migration to digital cameras. That said, digital cameras cannot
yet replace film cameras. They have too many drawbacks:

• Shutter lag time (see sidebar: “Consumer Digital Cameras Don’t Do Action”). Press the button and
wait—for up to two seconds—to actually take the photo.

• Delay between shots—from 2 to 5 seconds.

• They devour batteries.

• Slow auto focus.

• Poor flash metering—they use “pre-flashes” instead of responding to light during the actual exposure.

• Frequent color- or white-balance miscues.

• “Digital focal multiplier”—your 35mm SLR (single lens reflex) camera wide angle lens won’t work
properly on a digital SLR (see sidebar on “Three Changing Digital Camera Technologies.”)

• Rapid obsolescence—buy a digital camera one day and see a better, less expensive model advertised
the next.

• Yet another technology to learn with frequently complicated, arcane, and incomprehensible controls.

• Poor low-light capabilities.

• Expensive printers and paper.

But millions of digital camera users all can’t be wrong. There are advantages:

• Immediate feedback. Don’t like how the photo turned out? Erase it and try again.

• Never buy film again.
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• Don’t have to pay to process your film.

• Print only the photos you need when you need them.

• Quick and easy image upload to your PC.

• No need to use a scanner.

• Prices are dropping and quality is increasing.

• Give a digital camera to your students and don’t sweat wasted film.

Sidebar: Consumer Digital Cameras Don’t Do Action

The first time your students try a digital camera, I guarantee they’ll wonder what’s going wrong.

They’ll look through the viewfinder and see nothing. “Ooops, I need to turn the darned thing on.”
Click—pause—on.

That done, they’ll compose a shot and press the shutter. Again, nothing will happen. They might press
again. A bit harder. Still nothing. They hold the shutter down longer—a second or two—finally a click and
whir and an image appears. But it’s not exactly the image they thought they were going to get. Certainly it’s
not that moment, frozen in time, that they visualized when they pressed the shutter.

That moment passed their digital camera by. Why? Electronics, surprisingly, can be slow.

Here’s what goes on as they press the shutter:

As with a film camera, a digital camera emits an infrared signal to set the focus, adjusts the autoexposure by
changing the aperture (f-stop) and/or the shutter speed, and if it’s dark, sends out a small burst of light to
determine how much flash to use. At this point, a film camera would snap the picture. But a digital camera
has much more work to do.

That digital camera flushes the photo-sensitive computer chip’s electric charge to prepare it to receive a
new image.

Photons from the image hit that chip. It converts them to electrons, changes them to digital data (typically
at least  2 million chunks of color and brightness data) and moves them to an interim storage location. From
shutter press to image capture, up to 2 seconds.

Ready to take another picture? Sorry, your students have to wait from 2 to 5 seconds while their digital
camera recycles. The camera has to compress that digital information and store it before it’s ready to take
another photo.

Shooting action photos is just about out of the question. And expecting portrait subjects to “hold that
smile” for a second and a half is asking a lot. No longer is it, “Three, two, one, click.” Now it’s, “Three, two,
depress shutter, one, click.”

There is one way around this. Spend a few thousand dollars for a professional digital camera. They use “one-
click/one-shot”, or sequencing, technology.

But even then, depending on the camera, photographers might need to wait more than a second between
photos, they can’t use the flash (it can’t recycle fast enough), the photos might have lower resolution than
normal, and the color balance may be way off.
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So if they use a digital camera they’ll need to make some adjustments. See “Compensating for Lag Time”
later in this module.

Digital Camera Buying Tips

The demand for digital cameras continues to grow. Here are some  digital camera buying tips you might pass
along to those students contemplating a purchase:

• Megapixels—millions of “picture elements” or data points on the light sensitive chip—make a
difference. Two megapixels is the minimum for a decent 5-by-7 photo printout, three magapixels for an
8-by-10, and four megapixels for an 11-by-17.

• Storage capacity. Larger megapixel images require more storage space. Note how much capacity comes
with the camera and the cost for additional memory modules: CompactFlash, SmartMedia, Secure
Media or Memory Sticks. Don’t buy cameras with floppy disk or CD storage. They’re too slow.

• Try before they buy. The feel, size, and weight of the camera, along with the location of its controls are
important.

• Optical Zoom Capability. 2X is the minimum, but 3X is much better. Ignore references to “digital” zoom.
That just reduces the resolution of the image. Your students can use Adobe® Photoshop® or Adobe
Premiere® Pro for digital zooming.

• Rechargeable batteries and a charger. These are a must. Buying them separately adds $30+ to the total
price. NiMH (Nickel Metal Hydride) rechargeable batteries are better than NiCad (Nickel Cadmium).
Always keep a second set on the charger. Many rechargeable batteries tend to lose power during
periods of non-use and can lose the ability to recharge.

• Burst—or “sequence shooting”—mode to compensate for shutter and shot-to-shot lag times.

• Check out the software bundle. Some cameras come with some excellent products. Most do not.

• Color LCD (Liquid Crystal Display) panel to preview photos and determine whether exposure or color
balance adjustments are needed.

• Macro Function to make extreme close-ups—from an inch or so away from the subject.

• USB PC connectivity. It’s ubiquitous.

Importing Digital Photos to Photoshop

Most digital still cameras come with basic image acquisition and editing software. That might suit your students
needs for a time, but I believe they will want to move up to Photoshop sooner or later.

Task: Using Photoshop to Download Photos
This is the first of many tasks I present in these DV curriculum modules. In most cases, they are detailed, step-by-
step instructions. The best way for your students to get some value out of these modules is to complete the
tasks.

One of Photoshop’s easy-to-use functions is importing images from digital cameras. It uses WIA, Windows Image
Acquisition technology. Here’s a quick step-by-step explanation of how your students can send images from
their digital camera to their hard drive and into Photoshop:
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1. Choose File > Import > WIA Support.

2. Choose a destination on your computer for saving your image files.

3. Make sure Open Acquired Images in Photoshop is checked. If you have a large number of images to
import, or if you want to edit the images at a later time, deselect it.

4. Make sure Unique Subfolder is selected if you want to save the imported images directly into a folder
named with the current date.

5. Click Start.

6. Select the digital camera from which you want to import images.

Note: Missing Camera Model?

If the name of your camera does not appear in the submenu, verify that the software and drivers were
properly installed and that the camera is connected.

7. Choose the image or images you want to import:

• Click the image from the list of thumbnails to import the image.

• Hold down Shift and click on multiple images to import them at the same time.

• Click Select All to import all available images.

8. Click Get Picture to import the image.

Making High-Quality Photos—Tips and Tricks

Whether digital or film, here are some
standard tricks and tips that will help your
students improve their picture-taking
results.

Putting an End to Blurry Images

The biggest bugaboo in amateur photos is
blurry pictures. The principal reason is
camera movement. Figure 2.1 is a classic
example. Instead of gently pressing the
shutter, many amateur photographers
abruptly push it, shaking the entire
camera. Digital cameras exacerbate this
since shutter lag time leads many digital
camera users to press down even harder.

Figure 2.1: When everything in an image is
blurry, you can bet camera movement is the
culprit.
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Autofocus on Wrong Subject. Autofocus usually sets the
focus based on whatever is in the center of the viewfinder. If
you’re framing a scene with something in the foreground, as in
Figure 2.2, the autofocus may “see” the frame, not the
submect. Point your camera at the subject, depress the shutter
halfway to set the autofocus, compose your shot, and then
press the shutter the rest of the way.

Figure 2.2: The autofocus “saw” the cornstalk frame, not the
pumpkin-picker subjects.

Composing Your Shots

Get close to your subject. Instead of typical tourist shots of family members off in the distance standing directly
in front of some fountain, frame the fountain to fill your viewfinder, then have your family stand close to the
camera and a bit off to one side of the frame.

Note: Depth of Field

If you put your friends up close with the fountain some distance away and then focus on your friends, does
that mean the fountain will be out of focus? It depends. In daylight, the auto aperture (iris) will be very small
creating a deep “depth of field.” Foreground and background elements will all be in focus. In low-light
settings, the aperture is wide open and the depth of field is very shallow. Then the fountain will be out of
focus. Using a narrow depth of field well can lead to dramatic images.

Add a foreground element—something between you and your subject. That gives depth to your images.

Keep your subject off-center. That creates much more visual interest.
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Use the “rule of thirds.” As shown in Figure 2.3, divide
your image into thirds and place the object of interest at
one of the intersecting lines.

Figure 2.3: This image has elements from each of the three
previous tips: Foreground element, subject is off-center, and
it uses the “rule of thirds.”

Shoot at oblique angles. As with Figure 2.4
instead of straight on, shoot a subject from a
non-perpendicular angle.

Figure 2.4: Use oblique angles to add interest.
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Other Photo-Taking Tips

Watch back-lit scenes. As in Figure 2.5, your camera’s
autoexposure will set itself for the light behind your
subjects, meaning they’ll be silhouettes. Either set the
autoexposure on them first and then compose the shot,
or use fill-in flash, or do both.

Figure 2.5: When the sun’s behind your subjects, silhouettes
may be all you get.

Use fill-in flash. Just about any time you shoot
outdoors, adding flash brings out the colors and details
of your subject. Figure 2.6 shows how fill-in flash can
overcome the silhouette effect of back-lit shots.

Figure 2.6: Fill-in flash can overcome backlit scenes
(getting them to stop squinting takes much more effort).
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Note: Flash Range

Flash has a very limited range—about 10-15 feet. Next time you’re at a concert or nighttime sporting event,
note all the fans with point-and-shoot cameras taking flash photos from 100 rows back. What they’ll get is
brightly illuminated backs of heads from a couple rows in front of them. Don’t waste your time. The only way
to use a flash is to get close to your subject.

Don’t overexpose foreground objects.
As shown in Figure 2.7, when using flash,
objects close to the camera will be over-
illuminated. This is one time when
adding a foreground element might not
work.

Figure 2.7: The flash tends to illuminate
the closest object, which might not be your
desired outcome.

Avoid stiff poses. Encourage your subjects to do stuff. Walk, talk, point. Anything to add interest.

Keep the background simple. Distractions draw the attention away from your subject.
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Use lines to add interest. S-curves and diagonal
lines, like those in Figure 2.8, add visual interest.

Figure 2.8: Diagonal lines help draw attention to
the subject (the backlit cloud of dust is kind of a nice
touch, too).

Compensating for Lag Time

In the “If you can’t beat ‘em, join ‘em” department—here are some tips to overcome lag time inherent to digital
cameras.

• Turn on your camera before you need it, but, if possible, keep the LCD viewfinder and flash turned off
(they drain too much battery power).

• Get used to depressing the shutter release halfway to lock focus and exposure and then depress the
shutter all the way to take the picture.

• When shooting action-switch to the burst or sequence modes. However, those modes typically create
less than perfect images.

• If you let your subjects know when you’re going to take the photo by counting down from three, press
the shutter on “one.”

• Anticipate action. Shoot sooner than normal.

Sidebar: Updating Three Rapidly Changing Digital Image Technologies

Digital camera technology does not stand still. Here are three recent developments:

CMOS vs. CCD. Most still cameras and video camcorders used CCDs (charge-coupled devices) to capture
images. Kodak and Canon have challenged that dominance with two ultra-high resolution digital still
cameras: The 14 megapixel Kodak DCS Pro 14n and the 11 megapixel Canon EOS-1DS both use CMOS
(complementary metal-oxide semiconductor) chips.

CCD chips with the same resolution would be more costly and bulky. And CMOS chips use far less power
than CCDs. Another advantage, the CMOS chip has the same frame size as 35 mm film, meaning there is no
need for owners of SLR (single-lens reflex) cameras to buy new lenses.
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Digital Focal Multiplier. That CCDs are smaller than 35mm film creates a sometimes expensive
inconvenience for owners of digital SLR cameras using their film SLR lenses. The smaller image capturing
area effectively increases the focal length of any interchangeable lens used on a digital SLR camera. That
boosts telephoto lens power—arguably a nifty benefit—but narrows the view of wide angle lenses. Creating
distortion-free wide-angle lenses is an expensive art. Buying a new one just for a digital SLR camera can
easily cost more than $1,000.

Olympus, Kodak and Fuji think they have an answer: the Four Thirds System (4/3 System), a standardized
lens mounting scheme for digital SLRs. If enough companies sign up, this will resolve the Digital Focal
Multiplier issue (you’ll still have to buy new lenses), will lead to smaller, lighter lenses, and will ensure
uniform lens mounts across all brand lines, something that does not exist for 35 mm SLRs.

Foveon X3 image sensor. CCDs and CMOS technology pales in comparison to the image clarity of Foveon
X3 (www.foveon.com). These new
chips capture three times the color
resolution, feature a simpler
design, and offer higher overall
performance for digital still and
video cameras.

Standard digital camera chips use a
mosaic pattern of pixels in groups
of three red, green, and blue
photodetectors. The resulting
image, when viewed up close,
looks like a checkerboard.

As illustrated in Figure 2.9, Foveon
embeds three layered
photodectors in silicon at every
pixel location to capture all colors
within each pixel. The result is
sharper images with more accurate
color reproduction.

Figure 2.9: Foveon X3
Technology—illustration ©2002,
Foveon, Inc.

So far three cameras use the Foveon X3 direct image sensor technology: the 10 megapixel Sigma 9 and
Sigma 10 and the 4.5 megapixel Polaroid x530. Photoshop CS users now can import Foveon Raw image data
using the Camera Raw plug-in available for download at:
www.adobe.com/products/photoshop/cameraraw.html.

Selecting a Scanner for Your Video and DVD Projects

A scanner is a critical part of you students’ video production tool set. Frequently they will need to include non-
digital photos, logos, graphics, or other printed material in their projects. To do that, they’ll need a scanner.
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Now is a great time to buy either their first scanner or one to replace that old clunker in the corner. For $200 or
less, they can get plenty of horsepower.

Scanner Buying Tips

DPI—dots per inch—and color depth. 1,200 DPI is plenty for video production work. 2,400 works well for high-
end photo or pre-press projects. 42 or 48 bit color depth is more than they’ll ever use. Most image editing
software scales down to 24 bits—8 bits per color (red, green, and blue).

Caution: Watch Manufacturer DPI Claims

DPI is supposed to be noted as horizontal by vertical as in 1,200 x 2,400. The horizontal number is the true
resolution and refers to the density of sensors in the image chip. The vertical number equals the steps per
inch that the scanner motor moves the scanner head. Some manufacturers flip the numbers. So keep on
your toes.

CCD vs. CIS. Most scanners use CCDs (charged-couple devices), the same kind of image sensor chips found in
digital still and video cameras. A couple companies—Canon and Mustek at last word—rely on CIS (contact
image sensor) chips. CIS chips use less power and are more compact, but they have trouble with books that
don’t lie absolutely flat on the scanner glass. And CIS scanners from Canon and Mustek are slower than the norm.
My take: Stick with the industry standard CCD scanners.

Scanning speed. This varies greatly and changes with each new model. I’d suggest checking online at either
http://www.pcworld.com or http://computers.cnet.com/ for current bench test results. At last word Epson, H-P,
and Visioneer had the best scanning speeds for low-resolution (300 dpi) scans—typically about 20 seconds.

Tip: DPI for TV Display

Generally you don’t need to scan at high resolution for display on TV. 300 dpi usually is more than adequate
(unless you have a very small photo that you want to display full-screen).

Connection Speed. USB 2.0 scanners are slowly appearing on the scene. If your school’s or students’ PCs have
USB 2.0 capability, then they will see speed improvements, but only for higher resolution images. Otherwise,
USB 1.1 is fine.

Transparencies. Most consumer scanners do not handle slides or negatives as a standard feature. They’ll need
an optional tray—typically costing about $25.

On-Board Buttons. Some scanners give you all sorts of controls on the scanner itself. They can be very
convenient and helpful.

Bundled Software. Most scanners come with the excellent Abbyy FineReader OCR (optical character
recognition) software and a barebones image editing package. Even though all scanners these days are TWAIN
compliant, meaning products like Microsoft® Word and Photoshop can directly access and operate your scanner,
the software bundle usually includes a rudimentary scanner control interface.
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Exercises

1. Using the photo-taking tips I listed in this module, have your students grab their cameras (film or
digital), head out the door, and take some pictures. Tell them to concentrate less on subject matter and
more on techniques. Look for interesting angles, s-curves, and foreground elements. Use the rule of
thirds. And keep their cameras steady.

2. Along the lines of Exercise #1, come up with an easy-to-find subject you want to photograph. It could
be park benches, car bumpers, or jelly donuts. Then grab your camera and go on a quest for that
subject. This exercise forces you to come up with different ways to approach a subject. I did this with
gravestones once, and it got pretty weird. But it opened my eyes to new possibilities.

3.  National Geographic works with the best photographers in the world. Thumb through a few issues and
take a critical look at the photographs. Note the oblique angles, the placement of subjects, strong
foreground elements, and action. You may also notice that most exterior photos have long shadows.
The light is best early and late in the day.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education

Adobe, the Adobe logo, Adobe Premiere, Adobe Audition, Adobe Encore, Acrobat, After Effects, GoLive, Illustrator, InDesign, Photoshop, and

Tools for the New Work are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other

countries. All other trademarks are the property of their respective owners.

© 2004 Adobe Systems Incorporated. All rights reserved.
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Module 3

Digital Video: Camcorder Features and Shooting Tips

Digital video camcorders and nonlinear editors have changed everything. Now a $1,000 DV camcorder and a
laptop PC can serve as a high-end video production studio. This module explains DV technology, covers legacy
analog video issues, and lists some characteristics to look for when purchasing camcorders.

The future is high-definition video. Since high-def is still a bit out of reach for most student and school budgets,
I’ll only touch on it and will introduce the first prosumer HD-style camcorders and the software that allows you to
edit that video in Premiere Pro.

To make an excellent video production, your students need to start with high-quality raw material—the original
footage. No amount of clever, whiz-bang editing can turn mediocre raw video into a dazzling final product. The
old computer-programming adage applies: garbage in, garbage out. In the TV world, that adage has a slightly
different twist: You can't fix it in post. That is, postproduction techniques will not resurrect reels of video junk.

To ensure your students start their projects with high-quality raw material, have them follow the 18 video
shooting tips in this module plus the expert advice given at its conclusion.

At the end of this lesson, students will be able to:

• Understand the fundamentals of digital video

• Know what to look for when buying a DV camcorder

• Explain the limitations of analog video

• Have a basic understanding of high-definition video

• Begin to use standard camcorder shooting techniques

• Apply professional video shooting tips presented in this module

Digital Video Changes Everything

The message for your students is that DV changes everything.

In the old days (a couple years ago), analog was it. DV was ridiculously expensive and definitely not a budget
video production option. Now, for virtually any student project, DV is the way to go. Yes, there are some analog
camcorders, notably high-end Beta SP, that look better, but DV solves so many problems and is so easy to work
with, it’s the pragmatic choice for all student projects.

Analog Issues

An analog video signal is a continuous waveform. Small disruptions to that otherwise smooth, continuous signal
lead to degradation in image and color quality. Simply dubbing (recording) an analog tape to another tape
results in some quality loss. With each additional dub—each added "generation"—images look less defined,
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colors become increasingly washed out, and the pictures get grainy. Audio quality also suffers some degradation
with each generation.

In tape-only editing systems, to make simple scene transitions—such as dissolves—or to add special
effects—such as showing videos in moving boxes—means doing multiple edits or recording passes. Each pass
adds more video "noise" to the tape. Editors using analog tape machines have to plan carefully to avoid creating
projects with obvious shifts in video quality from one section to another.

Digital Makes All the Difference

DV makes generation quality loss a thing of the past. DV is a binary signal. A stream of ones and zeros. Unlike an
analog signal, which has a wide range of data possibilities and many ways for electronic equipment to
misinterpret it, a digital signal rarely loses quality during transmission and doesn't suffer from generation loss.

Note: Long-distance Digital Video

Home satellite systems that use those pizza-sized dishes are digital. To reach your home, those digital TV
signals travel from an Earth-based transmitter to a satellite in geosynchronous orbit (22,000 miles into
space) and then back to your parabolic pizza pie receiver—44,000 miles and the picture is crystal clear.

Although some noise may creep into the signal, electronic
equipment easily can filter this out because all it's looking for
are zeros and ones (see Figure 3.1). Little ragged edges on the
signal rarely are large enough to lead to obvious signal quality
loss.

Figure 3.1: Signal noise can dramatically affect analog signals
but has virtually no impact on binary signals.

More importantly for our purposes, multiple DV edits or dubs
do not lead to generational loss. The signal simply remains
zeros and ones. You are no longer constrained to limiting your
creative considerations to ensure low-noise video. No matter
how many edits you perform, no matter how many layers of
elements you pile up in a clip, there should be no discernible
noise or degradation to fidelity.

Therefore, your first order of business is to buy, borrow, or rent a DV camcorder. A purchase will run you from
$500 to $4,000 (see the upcoming sidebar for a rundown of several prosumer camcorders). Three things drive
camcorder prices: lens quality, features, and whether they have one or three image-gathering and -processing
integrated circuits or chips.

As you move up the price range, you'll see an increasing number of competitive features—longer focal length
lenses, larger LCD screen viewfinders, programmable settings, and fast shutter speeds. But the biggest
differentiator is that top-end camcorders have three chips, versus a single chip for lower-priced products.
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Choosing a Camcorder

First up is your gear—and topping the list is your camcorder. This is an exciting time. For years video pros have
lugged around shoulder-numbing Sony Beta SP and Ikegami broadcast-quality cameras. Their rich colors and
low-light capabilities used to put "prosumer" (a step up from consumer but still not broadcast quality)
camcorders to shame.

Not any longer. Some might quibble and say today's top prosumer camcorders are not true "broadcast quality,"
but only the most highly trained eye can discern an appreciable difference between the $3,300 Canon XL1S or
the $2,300 Sony DCR-VX2100 and anything a $15,000+ broadcast camera can crank out. See Figure 3.2 for some
high-quality prosumer camcorder models. In the meantime, even lower-priced prosumer and consumer models
are more than acceptable and work fine with Adobe® Premiere® Pro.

Figure 3.2: Top-of-the-line prosumer DV camcorders. Canon XL1S (estimated street price $3,300), the Sony DCR-
VX2100 ($2,300), and the Panasonic PV-DV953 ($1,300). You can't go wrong with any of these models.

Camcorder Selection Tips

Camcorders use a charged coupled device (CCD) chip to convert brightness and color to a digital signal. Single-
chip camcorder CCDs have to crunch a lot of data. Three-chip camcorders use a prism to divide incoming light
into separate red, green, and blue (RGB) hues, thus letting each respective CCD gather more information within
its designated segment of the color spectrum. Even though single-chip camcorders use special RGB filters to
help their one CCD interpret color data, three-chip cameras have distinctly better color and low-light capabilities.

Your choice in camcorders then comes down to your audience. If your videos are only for home or Web page
viewing, a single-chip camcorder will work fine. If you will be projecting your videos on large screens for sales
presentations or shareholder meetings, you should give strong consideration to a three-chip camcorder. And if
you want to move into the professional video-production business, a three-CCD camcorder is a must. Showing
up at a client's office with a palm-sized, single-chip camcorder is a sure way to jinx a deal.

Prosumer Camcorder Rundown

Camcorder buying is one of those things that may simply come down to "feel." You pick up a camcorder and it
fits well in your hands, the controls are logical and accessible, the menus make sense, and the images look right.
Or not. When you start digging into the details—all those features—it becomes brain numbing.
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So, here are the basics: Top-of-the-line gets you three CCDs and plenty of manual override options: focus, iris,
shutter speed, and white balance. If you're serious about shooting high-quality videos you'll want to have that
level of control. For example, setting a higher shutter speed—the Panasonic PV DV953 I tested for this book has
a super-fast 1/8,000th of a second shutter speed—means you can capture very crisp images of a very fast
subject. Racecars and sprinters all look sharp at such shutter speeds. You do need plenty of light to make this
work, though.

Other features of importance include the following:

• Substantial optical zoom—at least 10X, but 25X is better.

• Input and output capabilities. IEEE 1394 (the industry-standard means to transfer digital video) is a
given, as is a means to record from and to a VCR or other camcorder (S-Video connectors are better than
composite). Analog-in lets you record analog video to DV and/or pass it through directly to your PC via
the IEEE 1394 cable.

• An external mic plug is a necessity as well as a headphone plug.

• Optical image stabilizing using prisms or some other means (versus the less desirable electronic
stabilization).

Superfluous features—and there are many—include the following:

• Digital zoom. All you get are chunky pixels. Use Adobe Premiere Pro's Motion or Transforms effects to
handle this.

• Titler; Fade-in, Fade-out; and Digital Effects (picture in picture, wipes, multipicture mode, sepia, and so
on). Adobe Premiere Pro will handle all these without forcing you to fumble with awkward on-camera
controls and menus.

• Wide-screen view (unless it's a true 16:9—few offer this). "Faux wide screen" simply adds black bars to
the top and bottom of the screen covering parts of the image. Again, you can create this “look” in
Adobe Premiere Pro.

• Built-in lighting compensation modes, including back-lit, low-light, portrait, sports, and extremely
bright settings (surf and snow). You should use the manual features to more accurately handle these
situations.

The prosumer industry de facto standard camcorder is the Canon XL1S, followed closely by the Sony DCR-
VX2100, the Canon GL2 and the Panasonic PV-DV953.

Stepping down a notch, but still a prosumer-quality 3CCD camcorder, is the Sony DCR-TRV950.

Legacy Analog Camcorders

You may own a legacy analog camcorder—VHS (dread the thought), S-VHS, or Hi-8—and aren't ready to shell
out the cash for a DV camcorder. Your old clunker may get the job done, but the results will be several cuts
below pure DV video. Image quality from most legacy camcorders falls below today's DV camcorders (Hi-8 still
looks pretty good, and professional Beta SP is better than Prosumer DV). But no matter how good the original
video looks, the final edited product will not look that great. That's largely because when loading the analog
video into your PC (video capture), Adobe Premiere Pro converts it to a digital video file (losing some quality in
the process), and when you record it back to analog tape for viewing, it will lose even more quality. Because
Adobe Premiere Pro stores video digitally, there will be no generation loss for converted-analog video (or DV)
during editing.
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One other minor fly in the ointment: You'll need to buy a video capture card (see Module 6, "Scene Selection and
Video Capture") with analog input connectors. A straightforward DV-only capture card will not work.

Moving Up (Way Up) to High-Definition Video

High-definition TV (HDTV) is imminent. Sort of. It’s been imminent for nearly two decades. Back in 1987, I did a
news story about how KSL-TV (my employer at the time) in Salt Lake City was going high-def. The consumer
response since then has been decidedly underwhelming.

That’s about to change. Top-down pressure from the Federal Communications Commission on TV networks,
their affiliates and independent stations, to switch to digital TV (including high-def) by 2006 is one reason.

But I think bottom-up pressure will be the main reason we move to HDTV. Video producers, advertisers,
independent film makers, and consumers will lead the charge to HDTV.

HD image quality nearly matches 35mm film, comparable quality cameras and editing equipment are less
expensive (about $200,000 for top-end HDTV versus $400,000 for a high-quality film camera), and high-def
videotapes cost much less. With processing included, film costs about $5,000 an hour. A one-hour HD tape
costs $60.

Adobe Premiere Pro can handle HDTV, but it takes some specialized hardware and software to do it. As of this
module’s release, only one company had announced an HDTV-
style software-only product for Adobe Premiere Pro: CineForm’s
$1,200 Aspect HD software plug-in (a separate piece of software
that works within Adobe Premiere Pro). It works only with HDV-
compatible camcorders (as of mid-2004 there were only two:the
$3,000 JVC JY-HD10U or the $2,400 JVC GR-HD1 prosumer
camcorders -- see Figure 3.3). HDV is a less-than-full-resolution HD
format that uses MPEG-2 video streams to enable it to transfer HD
to a PC over a standard firewire connection.

Figure 3.3: The JVC JY-HD10U is the first prosumer-priced HD camcorder.

BOXX Technologies announced it plans to start shipping a $23,000, full-HD editing hardware/software Premiere
Pro solution in June, 2004. It’ll use Cineform’s new Prospect HD (a superset of Aspect HD) Premiere Pro plug-in.
For more information visit www.cineform.com and www.boxxtech.com.

HD is a small part of Adobe Premiere Pro’s current feature set, but that feature set won’t stay limited for long.
Adobe is working with several camcorder manufacturers and high-definition video card companies and expects
to announce several partnerships in the near future.

Eighteen Tips on Shooting Great Video

With camcorder of choice in hand, it's time for your students to venture off and shoot videos. Here are my video-
shooting axioms:

• Stripe your DV tapes.

• Adhere to the "rule of thirds."

• Get a closing shot.
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• Get an establishing shot.

• Keep your shots steady—use a tripod.

• Let your camera follow the action.

• Use trucking shots to move with the action.

• Try out unusual angles.

• Lean into or away from subjects.

• Get wide and tight shots to add interest.

• Try to match action in multiple shots.

• Shoot sequences to help tell the story.

• Avoid fast pans and snap zooms—they're for MTV only.

• Remember to shoot cutaways to avoid jump cuts.

• Make sure you don't break the "plane."

• Get plenty of natural sound.

• Use lights to make your project brilliant.

• Plan your shoot.

I've jammed a lot into these 18 items. All will help make your video shine with a professional glow. I discuss each
in detail below.

Stripe Your DV Tapes

This is a tedious but ultimately timesaving step. Your DV camcorder lays down timecode as it records. Later, as
you transfer DV to your computer, you'll likely use that timecode to create a video clip log. Once you've
completed logging your tape or tapes, you'll tell Adobe Premiere Pro to automatically retrieve the logged clips
by automatically shuttling the tape to the timecodes noted in the log and then record them to your hard drive.

Most camcorders, when powered up, reset their timecode to zero seconds. If you do that more than once using
the same videotape, you'll end up with several instances of the same timecode on one tape. As a result, Adobe
Premiere Pro probably will retrieve the wrong clip. Striping your tapes before doing any shooting resolves that.
You stripe tapes by simply placing a fresh tape in your camcorder, capping your lens, pressing Record, and
waiting for your camcorder to stripe the entire tape. Rewind the tape and you're ready to go. Now, as you use
your camcorder, it'll record new video over the black video you taped but won't change the timecode. It will
change the time stamp, the day, and date information recorded to a separate area of the tape.
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Adhere to the "Rule of Thirds"

Composition is the most fundamental element of camerawork, and the "rule of thirds" is the textbook. As with
still photography, when composing your shot, think of your viewfinder as being crisscrossed by two horizontal
and two vertical lines (refer to Figure 3.4). The center of interest
should fall on one of the four intersections. One rule of thumb is
to look around the viewfinder as you shoot, not just stare at its
center. Check the edges to see whether you're filling the frame
with interesting images. Avoid large areas of blank space.

Figure 3.4: Adhere to the same rule of thirds covered in Module #1.
Place the center of interest at one of the intersecting lines.

Get a Closing Shot

This may seem like I'm taking things way out of order, but the one shot that should be uppermost in your mind is
the closing shot (the opening shot or shots are important but have a much less lasting impact). Your closing
images are what will stick in people's minds. They are what your audience will take away from your video
production. If you start a shoot without knowing what your closing shot will be, you should be constantly on the
lookout for that one shot or sequence that will best wrap up your story.

Note: Dotson’s Rule

The importance of the closing shot came through loud and clear at a seminar I attended given by NBC-TV
feature reporter Bob Dotson (see Module 1, "DV Workflow, Project Planning and Writing Tips"). He and his
photographer never fail to find a closing shot. It could be as simple as someone closing a door, capping a
pen, petting a dog, turning out the lights, or releasing a butterfly from their cupped hands. If you happen to
see a Dotson feature story, consider its close. It's sure to be memorable.

Get an Establishing Shot

An establishing shot sets a scene. It doesn't have to be the opening shot. One of the greatest establishing shots
of all time is in Robert Redford's The Natural. Those who have seen this marvelous film know what I'm talking
about: the shot from the top row of the baseball stadium during a night game that takes in the entire field with
blazing lights ringing the park. Anyone who has been to a major league ballpark gets goose bumps when that
image appears onscreen. It tells a dramatic story in one image.

That should be your goal for your project's establishing shot or shots (you may need several if you're covering
several topics in one video).

Tip: Think Different

Although super-wide works sometimes—aerials make great establishing shots—it pays to think "outside the
box." Don't fall back on the old standbys, such as the scoreboard, the corporate sign, or the medium shot of
a hospital operating room. Try something different. A tight shot of a soccer ball with natural sound of
children's voices, a low-angle image through a glass table of someone using your client's product, or a close-
up of a scalpel with light glinting off its surface.

Each grabs the viewer's attention and helps tell your story.
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Keep Your Shots Steady—Use A Tripod

We all know that photographers take the images we view on TV, and that someone uses a camera to create
them. But as video producers, we don't want to remind viewers of that. We want to give them the sense that
they're looking through a window or, better yet, are there on location.

A shaky camera shatters that illusion.

Despite a recent trend away from the use of tripods—MTV started it, and shows such as 48 Hours have run with
it—there's plenty to be said for smooth-looking video. If you're doing a sit-down interview or grabbing close-
ups, put your camcorder on "sticks." When possible, use a tripod with a fluid head. That'll let you make smooth
pans or tilts. Good tripods are not cheap. Reasonably high-quality sticks start at about $150. See Figure 3.5 for a

top-of-the-line example.

Figure 3.5: The Sachtler DA 75 L aluminum tripod (left) weighs only 2 kg. Its DV 2 fluid head (right) works well with
lightweight camcorders.

Tip: Makeshift Tripods

If a tripod is too expensive, cumbersome, or inconvenient; if the action is too fast-paced; or if you need to
move the camera during the shot, then try to find some way to stabilize the shot. For still shots, lean against
a wall, put your elbows on a table, or place the camcorder on a solid object. For moving shots, get the
camcorder off your shoulder, hold it about waist high, and let your arms work as shock absorbers.

Another alternative is to buy or make a “Steadicam.” A Steadicam Jr—complete with a built-in
monitor—that works with prosumer camcorders costs $900. See http://www.steadicam.com/prohh_jr.htm.

And here is a web site for a home-built steady cam: http://www-2.cs.cmu.edu/~johnny/steadycam/. It’s a
heck of lot cheaper.
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Let Your Camera Follow the Action

This may seem obvious, but keep your viewfinder on the ball (or puck, face, conveyor belt, and so on). Your
viewers' eyes will want to follow the action, so give them what they want.

One nifty trick is to use directed movement as a pan motivator. That is, follow a leaf's progress as it moves down
a stream and then continue your camera motion past the leaf—panning—and widen out to show something
unexpected: a waterfall, a huge industrial complex, or a fisherman.

Use Trucking Shots to Move with the Action

This is an excellent way to follow action (so named because using a camera on a moving vehicle is one way to
get this shot). Truck right along with some action. If you're shooting a golf ball rolling toward the cup, tag along
right behind, in front of, or beside it. When walking through tall grass, dangle your camcorder at knee level and
walk right through it, letting the grass blades smack into the lens. Ever wonder how they get those cool downhill
snow-skiing shots? The cameraperson skis backward with a heavy electronic news-gathering (ENG) camera on
his shoulder or dangling from his hand at snow level (see the next section). I've watched my good friend Karl
Peterson (see the upcoming sidebar) do that amazing maneuver several times.

Try Out Unusual Angles

Move your camcorder away from eye level. Shoulder shots have their place—they represent probably as much
as 80 percent of all video—but getting the camcorder off your shoulder leads to more interesting and enjoyable
shots. Ground-level "ferret-cam" shots are great for cavorting puppies or crawling babies. Climb a ladder or use a
tall building to get a "crane" shot. Shoot through other objects or people while keeping the focus on your
subject.

Tip:  Stop-Action

You'll need "sticks" to create stop-action or time-lapse photography. Both methods require that the camera
remain steady. The other requirement is that the focal length and aperture cannot change. So when you set
your camcorder up to shoot the same scene for a long time, planning to compress time during editing,
make sure your autofocus, auto-white balance, and auto-iris are turned off.

Lean Into or Away from Subjects

Too many shooters rely too heavily on the zoom lens. A better way to move in close or away from a subject is
simply to lean in or out. Lean way in and start your shot tight on someone's hands as he works on a wood
carving; then lean way back (perhaps widening your zoom lens as well) to reveal that he is working in a
sweatshop full of folks hunched over their handiwork. It's much more effective than a standard lens zoom and a
lot easier to pull off.

Get Wide and Tight Shots to Add Interest

Most novice videographers create one boring medium shot after another. The reason: It fits our experience. Our
eyes tend to take in things the same way. Instead, think wide and tight. Grab a wide shot and a tight shot of your
subject. It's much more interesting.
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Tip: Get Close to the Subject

When you grab your tight shots, try to avoid relying on your zoom lens. Instead, get as close as practical to
your subject and then grab that tight shot. Unless you want your shot to look like you took it from a
distance, it's much more interesting to change positions rather than simply toggle that zoom button. Also,
audio is much better when you’re closer to the subject.

Try to Match Action in Multiple Shots

Repetitive action—running assembly-line machinery, demonstrating a golf swing, or working in a
barbershop—lends itself to matched action shots. A barber clips someone's hair and it falls to the floor. Get a
shot of the scissors, the hair hitting the floor, a wide shot of the entire shop, and a close-up reflection of the
scissors in the mirror or the barber's glasses. You'll later edit those separate shots into one smooth collection of
matched action.

Shoot Sequences to Help Tell the Story

Shooting repetitive action in sequence is another way to build interest and even suspense. A bowler wipes his
hands on a resin bag, dries them over a blower, wipes the ball with a towel, picks the ball up, fixes his gaze on
the pins, steps forward, swings the ball back, releases it, slides to the foul line, watches the ball's trajectory, then
reacts to the shot. Instead of simply capturing all this in one long shot, piecing these actions together in a
sequence of edits is much more compelling. You easily can combine wide and tight shots, trucking moves, and
matched action to turn repetitive action into attention-grabbing sequences.

Avoid Fast Pans and "Snap" Zooms

These moves fall into MTV and amateur video territory. Few circumstances call for such stomach-churning
camerawork. In general, it's best to minimize all pans and zooms. As with a shaky camera, they remind viewers
that they're watching TV.

If you do zoom or pan, do it for a purpose: to reveal something, to follow someone's gaze from his or her eyes to
the subject of interest, or to continue the flow of action (as in the floating leaf example earlier). A slow zoom in,
with only a minimal change to the focal length, can add drama to a sound bite. Again, do it sparingly.

Tip:  Keep on Rolling Along

Don't let this no-fast-moves admonition force you to stop rolling while you zoom or pan. If you see
something that warrants a quick close-up shot or you need to suddenly pan to grab some possibly fleeting
footage, keep rolling. You can always edit around that sudden movement later.

If you stop recording to make the pan or zoom and adjust the focus, you may lose some or all of whatever it
was you were trying so desperately to shoot. Plus you won't miss any accompanying natural sound.

Remember to Shoot Cutaways to Avoid Jump Cuts

Cutaways literally let you cut away from the action or interview subject. One important use is to avoid jump
cuts—two clips that when edited one after the other create a disconnect in the viewer's mind.
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Consider the standard news or corporate interview. You might want to edit together two 10-second sound bites
from the same person. Doing so would mean the interviewee would look like he suddenly moved. To avoid that
jump cut—that sudden disconcerting shift—you make a cutaway of the interview. That could be a wide shot, a
hand shot, or a reverse-angle shot of the interviewer over the interviewee's shoulder. You then edit in the
cutaway over the juncture of the two sound bites to cover the jump cut.

The same holds true for a soccer game. It can be disconcerting simply to cut from one wide shot of players on
the field to another. If you shoot some crowd reactions or the scoreboard, you can use those shots to cover up
what would have been a jump cut.

Make Sure You Don't Break the "Plane"

This is another of those viewer disconnects you want to avoid. If you're shooting in one direction, you don't want
your next shot to be looking back at your previous camera location. For instance, if you're shooting an interview
with the camera peering over the left shoulder of the
interviewer, you want to shoot your reverse cutaways
behind the interviewee and over his right shoulder.

That keeps the camera on the same side of the plane—an
imaginary vertical flat surface running through the
interviewer and interviewee. To shoot over your subject's
left shoulder would break that plane, meaning the viewer
would think the camera that took the previous shot
should somehow be in view. Figure 3.6 shows an
interview with correct and incorrect (broken plane)
camera placements. This also applies to larger settings like
shooting from both sides of a basketball court or football
field.

In general, you want to keep all your camera positions on
one side of that plane. This isn't true for all situations.
Consider a TV show of a rock group performance. Camera
crew members typically scramble all over the stage,
grabbing shots from multiple angles, and frequently
appear on camera themselves. That's much different from
breaking the plane in a formal sit-down interview.

Figure 3.6: The "plane" is an imaginary vertical wall
running, in this case, through the reporter and interviewee.
Breaking the plane—particularly when shooting a reverse
cutaway—leads to camera shots that cause viewer
disconnects.

Tip: Switch Sides

If you conduct formal, sit-down interviews with more than one person for the same piece, consider shooting
each subject from a different side of the interviewer. That is, if you shoot one subject with the camera
positioned over the left shoulder of the reporter, position the camera over the right shoulder of the reporter
for the next interview. That avoids a subtle jump cut that happens when you edit two bites from two
individuals who are both facing the same way.
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Get Plenty of Natural Sound

This is absolutely critical. We tend to take sound for granted. However, relying on your camcorder's built-in mic
and taking extra steps to improve the audio quality will dramatically improve the production value of your
projects. I'll cover audio issues in depth in Module 13, "Acquiring Audio." For now, think in terms of using
additional mics: shotgun mics to narrow the focus of your sound and avoid extraneous noise, lavalieres tucked
out of sight for interviews, and wireless mics to get sound when your camera can't be close enough to get just
what you need.

Use Lights to Make Your Project Brilliant

Lights add dazzle and depth to otherwise bland and flat scenes. An onboard camcorder fill light is a convenient
way to brighten dull shots. And a full (but admittedly cumbersome) lighting kit with a few colored gels can liven
up an otherwise dull research laboratory. If you don't have the time, money, patience, or personnel to deal with
adding lights, do whatever you can to increase the available light. Open curtains, turn on all the lights, or bring a
couple desk lamps into the room. One caveat: Low-light situations can be dramatic, and flipping on a few desk
lamps can destroy that mood in a moment.

Tip:  Watch Your White Balance

No matter what kind of lighting situation you're in, you always need to watch your white balance. Different
lights operate with different color temperatures. Your eyes automatically compensate for those color
differences, but your camcorder is not that proficient. These days most camcorders have auto–white
balance, and many have manual white balance as well. Auto–white balance works in most situations. As you
move from room to room or from inside to outside, the camera "assumes" everything in its field of view is
gray and adjusts its color balance accordingly.

Caution: Tricky Lighting Situations

Problems arise when you shoot indoors and have a window in the scene. In that circumstance, whatever you
see through the window probably will have a blue tint. The other tricky white balance situation is when you
shoot a scene with a predominant color, such as doing product shots using a solid-color background. The
auto–white balance will "think" that solid color is gray, and the image will look horrible. That's when you
need to place a gray or white card in the scene, fill the viewfinder with that card under whatever lighting
you plan to use for the product shots, and click the manual white balance button. For a fun practical lesson
in the value of a manual white balance, roll tape throughout this procedure or when you walk from indoors
to outdoors to watch the colors change.

Plan Your Shoot

When you consider a video project, plan what you need to shoot to tell the story. Videotaping your kid's soccer
championship match, a corporate backgrounder, or a medical procedure each require planning to ensure
success. Know what you want your final video project to say and think of what you need to videotape to tell that
story.

Even the best-laid plans and most carefully scripted projects may need some adjusting once you start rolling and
recording in the field. No matter how you envision the finished project, be willing to make changes as the
situation warrants.
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Expert Advice from a Professional TV News Photographer

Karl Petersen is my favorite TV news photographer. We met in Boise, Idaho, where we worked at competing
stations. We later worked together at KSL-TV in Salt Lake City. We formed a video production company in
Oregon called Glint Video (we always tried to get a "glint" shot in all our news pieces). Then Karl moved on to
KGW-TV in Portland, Oregon, where he is now chief photographer.

Karl Petersen—Chief Photographer, KGW-TV, Portland, Oregon

Karl has seen and done it all. Absolutely nothing fazes him. He'll
venture into the tensest situation and shoot with aplomb. When we
went out on stories we had an unspoken understanding—I never had
to tell Karl what kind of images and sound I needed. I knew he would
always get exactly what would make the story "work." Karl's regular
beat these days is chopper photog. "Sky 8," KGW's Bell 407, has two Flir
cameras. One is infrared and can operate in total darkness.

Karl's advice is worth much more than the price of this book. Take it to
heart:

• My first shooting advice is, don't do it. Pursue a career of doctor, lawyer, teamster, stevedore, bordello
piano player, whatever.

• Having failed that, my first tip is always to shoot as an editor. Always think about how to get from one
shot to the next. Try to get some kind of transition shot with either an entry or exit. Close-ups are
especially helpful in editing to get from point A to point B.

• Get a good shot mix—wide, medium, close-up (extreme close-ups work well), and unusual angles. Get
lots of shots. Variety is an editor's friend.

• Get an establishing shot that tells viewers where you are.

• Fundamentals: Make sure you have freshly charged batteries, always monitor audio by wearing an
earpiece (if you don't, you're guaranteed to get burned), and watch your color balance.

• For all indoor interviews, I recommend using at least two lights, three if you have time (I usually
don't—TV news is hectic). If I'm to the reporter's right, I place a light with an umbrella reflector slightly
to his left. That means the interviewee is looking toward the light. I place a Lowel Omni with "barn
doors" (to keep it from shining into the lens) behind and over the left shoulder of the interview subject
(that is, to my right). This adds nice highlights. If I have time, I place a third umbrella well behind the
camera to add fill. See Figure 3.7.
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Figure 3.7: A Lowel Tota with an umbrella (left), and a Lowel Omni with barn doors. Images courtesy of Lowel-Light.

• If I'm shooting in a room with sunlight coming in a window, I use blue gels—especially balanced for
daylight—and then color balance for sunlight.

• For underwater photography, I recommend using an Ewa-Marine plastic bag video camcorder housing
(see   http://www.ewa-marine.de/english/index.htm    ). They're good to a depth of about 30 feet, easy to
use, and relatively inexpensive (about $350).

When shooting from “Sky 8“, I sit in the warmth and comfort of the back seat and operate the cameras with a
laptop and a joystick. Not many video producers have this luxury. For those who must shoot from a side window,
here are some tips:

• Think safety first. Make sure nothing can fall off the camera—such as a lens shade—or out of the
back seat and possibly hit the rotor. That makes the chopper spin like crazy, so you get real dizzy
before you die.

• Shooting with the door off is ideal (remove it before you take off).

• Try to keep the camera slightly inside the doorframe to keep it out of the wind.

• Have the pilot "crab" (fly sort of sideways) so you can shoot straight ahead. That's much more dramatic.
It's a great way to fly along a river, for instance.

• Have the pilot fly low. This allows cool "reveal" shots, such as flying over a ridge to reveal an expansive
vista.

Finally, don't forget to grab that "glint" shot.
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Exercises

1. Have your students grab their camcorders and shoot some video. Keep my 18 tips in mind. Remember
the “rule of thirds.” Get wide, tight, and trucking shots. Follow the action, use unusual angles, and
record plenty of natural sound.

2. Ask your students to critically view their videos, looking for poorly framed shots, shaky camera work,
and lousy lighting. Encourage them to learn from their mistakes.

3. As in Module #1, contact a video production company or TV news station and ask whether a student or
students can tag along on a shoot. The best arrangement would be to go along on a magazine-style,
longer-format story (breaking news stories tend to be “run and gun”). Watch how the photographer
works. When and how does he use “sticks” or lights, does he move in extra close on some shots, or use
trucking shots or unusual angles? How much does he shoot relative to the length of the story? How do
the reporter and photographer decide what to shoot?

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education
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Module 4

Touring Adobe Premiere Pro’s Interface and Features

This module presents a tour of Adobe® Premiere® Pro’s workspace.

In it, I explain that Adobe Premiere Pro is a nonlinear editor. That means you can place audio, video, and graphics
anywhere on a sequence (timeline), rearrange them, add transitions, apply effects, and do any number of other
video editing steps in basically any order that suits you.

Adobe Premiere Pro has a logically laid-out workspace that facilitates a smooth and efficient workflow. At its
center are the Effect Controls and Timeline Windows. Adobe Premiere Pro now puts many of its editing tools in
the ECW, giving you immediate access to many features that heretofore required a lot of rummaging around in
various windows and dialog boxes.

Clearly, Adobe Premiere Pro’s developers focused their attention on planning and looking long term. Adobe
Premiere Pro uses industry standard technologies and always aims for the highest common denominator. That
means there is no degradation in quality at any stage of the production and that Adobe will be able to upgrade
Adobe Premiere Pro quickly and effectively.

At the end of this lesson, students will:

• Understand the characteristics and benefits of a nonlinear editor

• Tour Adobe Premiere Pro’s workspace

• Explain Adobe Premiere Pro’s special features and technologies

Adobe Premiere Pro —A Nonlinear Editor

Adobe Premiere Pro is a nonlinear editor (NLE). It looks and feels a whole
lot different than standard, non-digital (or analog) linear videotape-
editing systems. This might be patently obvious to some of your
students, but bear with me a bit.

On tape systems, you need to lay down edits consecutively and
contiguously. If you decide to expand a story already edited on tape by
inserting a sound bite in the middle, you simply cannot slip that bite into
the piece and slide everything after it further into the story.

You need to edit in that sound bite over your existing edits and reedit everything after it. Alternatively, you first
can make a dub (or copy) of the story segment after the new edit point and lay that down after adding the
sound bite (causing generation quality loss in the process).
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Note: Mid-Story Changes—The Horror

Makes me shudder to think of the news stories I produced, back in the days of videotape-only editing, that
screamed for some minor mid-story fixes. But I knew those fixes would have taken too much time and
caused too much reporter/editor grumbling to do. Such is life in deadline-driven TV news.

As newsrooms have moved to NLEs, reporter/editor tension (at least over silly little things such as adding a
sound bite in the middle of a piece, ah-hem) has dissipated.

Adobe Premiere Pro (and other NLEs like it) has come to the rescue. Now you can make changes with a few
mouse clicks. If you want to edit the all-important production closing shots before editing anything else, that's
fine. It's nonlinear. Feel free to do things non-sequentially.

The other overwhelming improvement over videotape-editing systems is immediate access to your video clips.
No longer do you need to endlessly fast forward or rewind through miles of tape to find that one snippet of
natural sound. With Adobe Premiere Pro, and other NLEs, it's all a mouse click away.

Touring Adobe Premiere Pro’s Workspace

Before diving into nonlinear editing (Module 7, "Creating a Cuts-only Video”), I want to give you a brief tour of
the video-editing workspace.

Task: Checking Out Adobe Premiere Pro’s Interface

This is the first of many tasks involving Adobe Premiere Pro that I present in these DV curriculum modules. To
ease you into this powerful nonlinear editor, I’ve made this a kind of task-lite. No real, detailed instructions.
Rather a basic introduction to Adobe Premiere Pro’s workspace. Your students should have Adobe Premiere Pro
open and follow along as you go over Adobe Premiere Pro’s features:

1. Install Adobe Premiere  Pro. It’s fairly straightforward but your students will need to restart their PCs
when completed.

2. Double-click the Adobe Premiere Pro icon on your desktop to open it. After the splash screen
disappears, the opening interface displays, as shown in Figure 4.1.
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Figure 4.1: Adobe Premiere Pro’s opening dialog box enables you to quickly access projects-in-progress or start a new
project.

Note:  Out with the Old

I can’t say it enough (and I do say it several more times throughout this curriculum guide): Adobe built
Adobe Premiere Pro from the ground up to streamline the video creation process. The New Project dialog
box is a case in point. Previous Adobe Premiere iterations presented about two dozen choices. Adobe
Premiere Pro offers up eight, four each for NTSC and PAL (you can create your own customized project
settings). Why so few? Briefly stated: it’s because of new internal video and audio processing. I explain more
in the next section: “Adobe Premiere Pro’s Special Features and Technologies.”
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3. Click New Project to open the New Project dialog box shown in Figure 4.2.

Figure 4.2: This simple interface exemplifies the streamlined workflow in Adobe Premiere Pro.
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4. If you’re working with NTSC (see following “TV Standards” sidebar for more information), select DV-
NTSC, Standard 32kHz (kHz is the audio “sampling” rate). If you’re a PAL user, click the ‘+’ plus sign next
to DV-PAL and select Standard 32kHz. For version 1.5, Adobe added a Panasonic 24P option. This is a 24
frame per second (the standard film frame rate) and works with Panasonic 24P Advanced camcorders
like the AG-DVX100 or AL-SDX900. If you are using a 24PA camcorder click the ‘+’ plus sign next to
Panasonic 24P and select your screen size and audio rate. Give your project a name at the bottom of the
screen, then click OK. That opens the Adobe Premiere Pro user interface (UI) shown in Figure 4.3.

Figure 4.3: Adobe Premiere Pro’s workspace may seem daunting to first-time NLE users, but you’ll soon see the logic
behind its layout.

Sidebar: TV Standards

NTSC, PAL and SECAM—although it’s not an option in Adobe Premiere Pro—what's with all the different
(and incompatible) standards?
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• National Television Standard Committee (NTSC) is the TV standard for most of North and South America
as well as Japan. It’s clearly the worst of these three TV standards. It has only 525 lines of resolution and
displays at a nearly incomprehensible 29.97 frames per second (film displays at 24 frames per second).

• Phase Alternate Line (PAL), at 625 lines, has better resolution and displays at 25 frames per second. It’s
available in Western Europe and Australia.

• Sequential Couleur A'memorie (SECAM) has the highest resolution—819 lines—as well as a separate
channel for color information. Like PAL, it runs at 25 FPS. It’s used in France and in scattered locations
around the Middle East and Africa.

Because of NTSC's tendency toward color variability, engineers jokingly refer to it as "Never The Same Color."
There is a glimmer of hope: North America is grudgingly elbowing the higher-resolution PAL and SECAM
folks aside with High-Definition TV (HDTV), which is set for full adoption in the United States by 2006.

Adobe Premiere Pro’s Workspace Layout

If your students have never seen a nonlinear editor, this workspace might throw them for a loop. Not to worry.
The layout reflects many years of experience on the part of Adobe Premiere Pro’s development team. They
understand the NLE workflow and have put innumerable fixes into Adobe Premiere Pro to further refine it. I’ve
identified its principal elements in Figure 4.4.

Figure 4.4: Adobe Premiere Pro’s workspace windows and palettes.
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Note: Windows, Palettes and Dialog Boxes

Adobe Premiere Pro’s developers use some standard terms for some elements of this NLE. I’ll try to point out
those items as they arise. In this case Windows are resizable work areas in which you take some action,
Palettes present essentially unchangeable items like effects and editing tools, and Dialog Boxes request user
input such as preferences.

In the following sections, I briefly explain the salient elements of the Adobe Premiere  Pro user interface (UI). I go
into greater detail in later modules.

Project Window

Start by taking a look at the Project Window in the upper-left corner of the UI in Figure 4.4. This is where you
store and access your original video clips—your raw footage—as well as audio files, graphics and sequences
(Adobe’s new name for timelines). It uses bins (Adobe's name for file folders) to organize your "assets."

Figure 4.5 shows how it looks after I add a few files to it and expand the view to display the characteristics of the
those video, audio, and image files.

Tip: Adding Files to the Project Window

I explain this process in detail in Module 6, “Scene Selection and Video Capture.” If you want to add some
files now, select File > Import, navigate to some media files, select them and click Open. You can also use a
shortcut: In the Project window, double-click in the blank area below the word “Sequence” to open the
Import window. Once you’ve added a few files and expanded the width of your Project Window, it should
look something like Figure 4.5.

Figure 4.5: The Project Window is the storage space for all your project’s media assets and sequences (timelines).

In Figure 4.5, the Project Window displays characteristics such as media type, length, video resolution, and audio
information. You can sort on characteristics by clicking their column names and click-drag columns to new
locations. Note that the Project Window uses icons and label colors to further differentiate media types.
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Effects

Clicking the Effects tab in the Project Window
opens the Effects Palette. As Figure 4.6 shows,
effects include scene transitions, such as dissolves
and wipes; video effects to alter the appearance of
your clips; two audio crossfade transitions; and
numerous audio effects to spice up your sound. For
version 1.5, Adobe added a Presets folder that
contains numerous effects with preset parameters
to automate some tasks and for your students to
store their own custom-made presets. I begin
covering these powerful (but frequently overused)
tools in Module 8, “Adding Transitions Between
Clips.”

Figure 4.6: The Effects Palette gives you immediate
access to dozens of transitions and effects.

You apply an effect by dragging it to a clip, and you
place transitions between clips and—new to Adobe
Premiere Pro—on clips. That nifty new trick,
combined with another very cool new feature—the
ability to apply transitions on any track instead of
only on clips on track one—means you can create
all sorts of animated effects. Especially with
geometric shapes created in Adobe Premiere Pro’s
Title Designer. I cover that in Module 9, “Creating
Text: Using the Title Designer.”
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Monitor Window

You use the Monitor Window to view and trim “raw” clips (your original footage) and view your project-in-
progress. You can open the Monitor with only one screen—the Program screen—or, as shown in Figure 4.7, two
screens—Program and Source.

Figure 4.7: You view your raw clips in the Monitor window’s Source screen (left) and your finished product in the
Program screen (right).

The controls at the bottom middle of each screen work much like your VCR, with the addition of a very nice
shuttle (the wide button in the middle of that group). The other controls are principally for editing. I start
covering them in Module 7, “Creating Cuts-only Videos.”

Timeline Window

This is where you'll do most of your actual editing (because this is Adobe Premiere Pro, there are always multiple
means to perform any one task). Figure 4.8 shows the Adobe Premiere Pro timeline window.
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Note: Timeline or Sequence

To avoid confusion, Premiere Pro’s developers chose to use the term “sequence” for what most video editors
would call a “timeline.” This new name reflects a sequence’s new functionality. Since sequences are now
nestable, they can be used to segment a video edit and enable a production to be broken up into
manageable "sequences."

The word timeline seems very self-contained, so Premiere Pro’s development team changed it to sequence
to reflect this extra capability.

Figure 4.8: The sequences (timelines) in Premiere Pro's Timeline Window will look familiar to anyone who has worked
with other nonlinear editors.

The Timeline Window can have multiple sequences, each accessible via a tab at the top of the window. In this
case, in Figure 4.8 there are two sequences, one for my project and the other for the Adobe Photoshop® PSD file
I added to the Project Window. Basically, each sequence is a collection of video and audio tracks.

Anyone who has edited with an NLE will feel comfortable working with Adobe Premiere Pro’s sequences
(although there is a bit of a learning curve that I cover in Module 7, “Creating Cuts-only Videos”). Anyone coming
from the linear, videotape-editing world may find sequences a bit daunting at first but soon will come to
appreciate them.
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You can layer—composite—video clips, images, graphics, and titles in up to 99 tracks. Clips in higher-numbered
tracks cover whatever is directly below them on a sequence. Therefore, you need to give clips in higher-
numbered tracks some kind of transparency or reduce their size if you want to let clips in lower tracks show
through. I start covering those topics in Module 19, “Compositing Part 2: Alpha Channels and Mattes.”

Tools Palette

This thin, vertical palette shown in Figure 4.9 is a refinement of a similar tools collection found in previous
versions of Adobe Premiere.

Figure 4.9: The Tools Palette is another example of Adobe Premiere Pro’s streamlined editing methodology.

Each icon represents a tool that performs a specific function, typically different kinds of edits. What makes
this updated Tools Palette better than its predecessors is that there are no hidden sub-menus within this
palette. What you see is what you get. The reason for the change? A new context-sensitive cursor.
Depending on the situation, the cursor in Adobe Premiere Pro changes to indicate a new function that
matches the circumstances. And if you choose, you can press keyboard shortcuts to change the cursor.

History and Info Palettes

Here are two useful tools:

• The History Palette (shown in Figure 4.10) tracks
every step you take in your video production and
lets you back up if you don't like your latest efforts.
If History is not showing up in your workspace,
select Window > History from the main menu. Note
that when you back up to a previous condition, all
steps that came after that point remain in the
history palette but are grayed-out. That means you can
move around without obliterating all your work. The one
caveat: You cannot extract a single misstep buried within
the current list.

Figure 4.10: The History Palette tracks every step—large or
small—you make as you edit your project.
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• The Info Palette has a limited purpose. It offers only
a brief data snapshot of whatever element—clip,
transition, or effect—you've currently selected in a
sequence or the Project Window. In the case of
Figure 4.11, it notes that the selected clip is an AVI
(audio/video interleaved) file with stereo audio.
One neat little feature: the Info Palette notes the
location of your cursor (as opposed to the Current
Time Indicator—edit line. As you move the cursor
around a sequence, the Cursor readout notes your
location within the sequence.

Figure 4.11: The Info Palette displays facts about whatever
clip you’ve selected.

 Adobe Premiere Pro’s Special Features and Technologies

What sets Adobe Premiere Pro apart from its predecessors and the competition is how carefully the
development team worked to create a consistent look and functionality, to incorporate industry standard
technologies, and to aim high.

It's exciting to work with such carefully crafted software. That so much effort went into getting the fundamentals
right and that the development team took the high road in terms of technology demonstrate that Adobe is
making a long-term commitment to creating a powerful, compelling, market leading product.

Here are a few examples of Adobe Premiere Pro’s special features and technologies.

Native YUV Video Processing

Previous versions of Adobe Premiere converted video to the computer-friendly RGB (red, green, blue) color
scheme. Then, when exported from Adobe Premiere, converted it back to a standard TV signal called YUV
(Y=luminance and UV=color). These multiple conversions caused some visual quality degradation. Now all video
is stored on your hard drive in its native YUV scheme. Only when displaying video on your PC monitor, does
Adobe Premiere Pro convert YUV to RGB.



Adobe Digital Video Curriculum Guide – Module 4 4-13

Adobe Digital Video CURRICULUM GUIDE

Color Correction

Adobe Premiere lacked a true color correction tool. Adobe Premiere Pro rectifies that. Its new color corrector,
coupled with the vector scopes shown in Figure 4.12, help you maintain a consistent look for your project
(despite changing lighting conditions during a video shoot) or give it a hue that helps set a mood. I cover the
color corrector in Module 21, “Adobe Premiere Pro Editing Tips, Tricks and Techniques: Part 2.”

Figure 4.12: Use these vector scopes plus a color corrector to ensure the highest visual quality for your projects.
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New Audio Technologies and Tools

Audio quality and editing in Adobe Premiere Pro nearly matches that found in high-end audio-only production
suites. There are two reasons: audio conforming and sample-level editing.

As you add—import—an audio clip or a video clip with audio to your Project Window, Adobe Premiere Pro
conforms it (you might note the little conforming progress bar in the lower-right corner, shown in Figure 4.13).

Figure 4.13: As you add audio, Adobe Premiere Pro
conforms it to match the audio project settings.

Conforming converts your audio into a separate file instead of keeping it interleaved it with video. It also
converts it to 32-bit, floating-point quality (see the following By the Way) and “up-converts” all audio to match
the kHz rate set for your project.

Note: Floating-Point Versus Integer

Converting audio to 32-bit floating-point ensures it remains at its absolutely highest quality possible—even
after applying effects and volume changes. For instance, CD audio is in a 16-bit integer format, which limits
it to 65,536 increments. 32-bit floating point represents sound using a full range of numbers with a variable
number of decimal places, thereby giving the audio reproduction more accuracy.

What this all means is that no matter what changes you make to audio within Adobe Premiere Pro, all your audio
will remain at its original quality. And instead of editing audio only at video frame junctions (one every 1/30 of a
second), you can edit audio at the sample rate (up to every 1/96,000 of a second depending on your selected
project kHz setting). This leads to absolute audio editing precision.

These changes lead to better real-time performance. No longer does Adobe Premiere Pro need to process video
as it plays audio since audio is now kept in separate files.

The small downside is the conversion time (during which you can still edit and listen to whatever portion of the
clip that has been conformed) and the use of additional hard drive space—typically about 1.4 GB per hour of DV.

Note: Audio Mixer—Appearing as Master Meter

Sometimes when opening the Audio Mixer using Window > Audio Mixer, only a little, so-called Master Meter
displays. If that’s the case, click it’s Wing-out triangle and select Audio Mixer (your only “choice”) and that
opens the full Audio Mixer.
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Adobe Premiere Pro lets you work in
mono, stereo, and 5.1 Dolby Digital. One
other major improvement is the audio
mixer, shown in Figure 4.14 and
accessed by selecting Window > Audio
Mixer.

Figure 4.14: The revamped Audio Mixer
gives you greater control.

The Audio Mixer makes it possible for
you combine audio tracks into separate
sub-mixes, to apply audio effects to
entire tracks to improve consistency, and
to add a real-time voice over narration. I
cover audio topics in Modules 13
through 16.

If you want to take your audio editing to
even higher levels or to create custom
music using loops or your own
compositions, you might consider
working with Adobe Audition™. I give
you some hands-on instructions on that
product in Module 16, “Adobe Audition:
A High-end Audio Tool.”
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Tight Integration with Photoshop CS and After Effects 6.0

Back in Figure 4.5, you might have noticed a file folder called Postcard. That file folder holds a Photoshop PSD
file. Figure 4.15 shows an expanded view.

Figure 4.15: When you import layered Photoshop PSD files into Adobe Premiere Pro, you have the option of splitting
that file into its constituent layers.

If you have worked with Photoshop, you know you can create graphics in layers—typically one graphic element
or effect per layer. If you import a layered PSD graphic into Adobe Premiere Pro it gives you the option of
breaking it down into those separate layers so that you can manipulate them individually on sequences. This is a
very powerful tool and is new to Adobe Premiere Pro.

Likewise, when you import an Adobe Premiere Pro project into Adobe After Effects® , Adobe’s industry-standard
graphic animation tool, it displays it in its separate tracks. New to Premiere Pro 1.5 and After Effects 6.5 is the
ability to copy/paste clips from a sequence, directly into After Effects, retaining all the effects and transitions
applied to those clips. I demonstrate how to use Photoshop and After Effects 6.0 for Adobe Premiere Pro projects
in Modules 23-25.
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Effect Controls Window

Another workflow improvement is how Adobe Premiere Pro displays and enables you to customize effects,
transitions, transparencies, and motion control. Its revamped Effect Controls Window gives you absolute control,
including changing clips over time. Figure 4.16 shows one example of a transition applied between two clips (in
this case, the “Doors” transition).

Figure 4.16: The Effect Controls Window enables you to control all aspects of effects and transitions.

Instead of opening separate windows or dialog boxes for different effect, transition, transparency, and motion
control elements; Adobe Premiere Pro puts all controls in the Effect Controls Window (ECW).

For instance, in its upper-right corner, the ECW displays transition placement. Elsewhere in the ECW, you control
the color and width of the transition edge border and its duration. You can watch all these changes in real time
in the monitor or use the Play button in the upper left corner of the ECW.

This window is a very powerful tool. It is the hub of Adobe Premiere Pro’s workflow.
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Customizable Keyboard Shortcuts

This nice feature (shown in Figure 4.17), accessed by selecting Edit > Keyboard Customization from the main bar,
enables editors to create their own, comfortable workflow. As topics come up throughout this book, I fill you in
on the applicable keyboard shortcuts.

Figure 4.17: The Keyboard Customization dialog box lets you set a workflow that matches your style.
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Exercises

1. I’m a real believer in learning from experts. You’d be surprised how willing most experts are to give you
some tips. Contact local video production companies, ask whether they use nonlinear editors
(even if they’re not Adobe Premiere Pro), and make an appointment to watch an editor at work.
You’ll learn a lot.

2. Take your own tour of Adobe Premiere Pro’s workspace. Open menus, check out preferences (Edit >
Preferences—and—Project > Project Settings), take a look at the keyboard shortcuts, and examine the
various pre-set workspaces (Windows > Workspace > Effects—and—Audio—or—Color Correction.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education

Adobe, the Adobe logo, Adobe Premiere, Adobe Audition, Adobe Encore, Acrobat, After Effects, GoLive, Illustrator, InDesign, Photoshop, and

Tools for the New Work are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other

countries. All other trademarks are the property of their respective owners.

© 2004 Adobe Systems Incorporated. All rights reserved.
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Module 5

Adobe Premiere Pro Set-up

Adobe created Adobe® Premiere® Pro with high-performance PCs—or, more aptly, DV workstations—in mind. A
PC DV workstation with plenty of horsepower will enable your students to get the best out of Adobe Premiere
Pro. In this module, I present some tips on what to consider when buying a DV workstation or upgrading a PC.

One component of a high-end DV workstation is a specialized video capture card that enhances the Adobe
Premiere Pro editing experience. I will give an overview of two cards from Matrox that work hand-in-hand with
Premiere Pro.

I conclude this module by showing you how to have your students start up Adobe Premiere Pro and make a few
user interface tweaks to get them ready for editing.

At the end of this module, students will:

• Know how to configure a powerful DV workstation

• Understand the role video capture cards play with Adobe Premiere Pro

• Start Adobe Premiere Pro and select appropriate project settings

• Organize Adobe Premiere Pro’s workspace

Configuring a Powerful DV Workstation

Adobe Premiere Pro’s developers aimed high. If you have anything less than a truly top-end PC, you will not see
Adobe Premiere Pro operate at its best.

As I wrote these modules, I used two PCs, a DV workstation powerhouse loaned to me while writing these
modules by Alienware (see sidebar, “Alienware MJ-12 DV Workstation,” later in this module) and a PC that
slightly exceeded Adobe Premiere Pro’s minimum specs. The differences were dramatic.

Adobe Premiere Pro’s Minimum (and Recommended) Specs

If you’ve looked at your Adobe Premiere Pro retail box, you might already know the minimum specs. Here’s a
quick rundown:

• Intel Pentium III 800MHz processor (Pentium 4, 3 GHz recommended)

• 256MB of RAM (1 GB recommended)

• 800MB of hard-disk space for installation

• Microsoft DirectX compatible sound card (ASIO-compatible sound card recommended)

• Dedicated, large-capacity 7200 RPM hard drive for media assets

• 1,280x1024 32-bit color video display adapter (OpenGL card recommended)
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• Microsoft Windows XP

Adobe Premiere Pro has design characteristics that scale its performance to match the PC. So if your PC barely
meets these minimum specs, Adobe Premiere Pro will work fine but there may be some sluggishness and a
slight change in the displayed video quality. In this case, you want to make sure there are no unnecessary
programs running in the background. That said, here’s what you can expect:

• You might have to scale Adobe Premiere Pro back to a lower-resolution display to achieve real-time
playback.

• Rendering—converting any files with special effects applied or that don’t match the project audio and
video data rates—will take longer and will consume 100% of your processor’s cycles.

• Audio conforming will take some extra time.

• As you move around on a sequence or work with effects, there will be occasional lags between mouse
clicks and on-screen actions.

My System Recommendations

Adobe Premiere Pro takes advantage of certain technologies and configurations. Here’s a few PC specs to keep
in mind, starting with the top three most effective performance enhancers:

• RAM. The more RAM you have the better. Adobe Premiere Pro uses 90-120 MB of RAM simply to
function. As you scrub through a video project, Adobe Premiere Pro consumes even more RAM for
media caching, thereby creating smoother playback. By design, Adobe Premiere Pro will use up to
about one-third of your total RAM for caching. On a 1 GB RAM PC, total RAM usage will peak at about
400 MB, or several video frames. If you have 2 GB, that’ll more than double the number of cached
frames, meaning even better playback performance.

• Hyperthreading. Adobe Premiere Pro takes advantage of Intel Pentium 4’s hyperthreading technology.
That is, if Adobe Premiere Pro detects you have a hyperthreading CPU, it will divide its processing into
multiple streams to work faster and more efficiently. The corollary to this is that it also takes advantage
of PCs with multiple processors (both non-hyperthreading and hypterthreading)—such as the
Alienware DV workstation described later in this module). Theoretically (at least until someone makes
such a PC), Adobe Premiere Pro can use up to 16 threads!

Note: Dual CPUs and Hyperthreading in Action

To see graphic evidence that dual CPUs with hyperthreading really are doing their job take a look at
Windows Task Manager (shown in Figure 5.1). Access the Task Manager by right-clicking the task bar (or
pressing Ctrl+Alt+Delete) then clicking the Performance tab. In the case of the Alienware DV workstation,
two Intel P4s with hyperthreading means the PC functions as if it has four CPUs.
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Figure 5.1: Windows Task Manager displays a CPU utilization graph for each CPU—two hyperthreading CPUs equals
four graphs.

• RAID. Using a RAID (Redundant Array of Inexpensive—or Independent—Disks) array opens the tightest
bottleneck on your PC, your hard drive’s throughput. Adobe Premiere Pro frequently “asks” your hard
drive to max out. With a RAID, that max is significantly higher than with a single hard drive. A typical
two-drive RAID makes a huge difference in video performance.

• Dual Monitors. Adobe Premiere Pro works best with extra screen real estate. Two monitors is the
standard, professional editing setup and will make your life a whole lot easier. To do that, you’ll need a
dual-monitor video card. My Alienware system uses an NVIDIA Quadro FX 1000 with dual DVI (Digital
Video Interface) plugs (they work with analog monitors too).

• ASIO audio hardware. Audio Stream In/Out (ASIO) technology, developed by Steinberg (the Germany-
based audio subsidiary of Pinnacle Systems), ensures sound cards have much lower latency and are
more responsive. Such cards give you a much better feel for the final product when mixing audio,
especially when working with 5.1 Dolby Digital. The SoundBlaster Audigy in my Alienware system is
ASIO compliant and works like a charm.
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Note: ASIO and VST

Adobe Premiere Pro uses another Steinberg technology: VST (Virtual Studio Technology). This nearly
ubiquitous software technology ensures that third-party created VST-compliant audio plug-ins work
smoothly in Adobe Premiere Pro. Plug-ins are mini programs that, in this case, augment Adobe Premiere
Pro’s audio effects suite. I cover the VST plug-ins in Module 15, “Sweetening Your Sound.”

• Video capture card. Full-featured video capture cards serve three primary functions: analog (as well as
DV) video capture, hardware-based MPEG encoding (converting video into the compressed MPEG
format used on DVDs and digital satellites) and real-time video effects and transitions. There used to be
three main contenders on the PC side that specifically worked with previous iterations of Premiere:
Canopus, Matrox, and Pinnacle. But now, Pinnacle no longer bundles its products with Premiere.
Canopus does still offer Premiere bundles with two of its cards but you have to dig deep in Canopus'
web site (www.canopus.com) to find them. Only Matrox both bundles Premiere Pro with its video cards
and actively promotes those packaging deals.

These components are not inexpensive. A fully tricked-out DV workstation will cost about $6,000. If your
students are PC hobbyists, they can take the build-it-yourself route, but the price difference between buying the
components separately or purchasing a turnkey system is much less than it was a couple years ago.

They can take a middle road. That is, upgrade their existing PCs. The biggest performance boosts will come from
additional RAM, RAID, and a hyperthreading CPU (Pentium 4 Xeons).

If you choose the turnkey approach, I recommend looking first at Alienware (http://www.alienware.com). There
aren’t many other PC makers that focus on this high-end DV market. Here are two companies with product lines
that approach the full-featured Alienware DV workstation: Dell’s Dimension XPS series (http://www.dell.com)
and Falcon Northwest’s Mach V high-end gaming PCs (http://www.voodoocomputers.com).

Video Capture Cards—Adding Video Editing Magic

Video cards are a specialized part of a DV workstation. You can spend several thousand dollars for a high-end,
broadcast-quality card. But the more likely scenario is to buy a mid-priced but still very powerful and feature-rich
card for $700 to $1,100. Keep in mind that the two cards covered here come bundled with full versions of Adobe
Premiere Pro, Encore DVD and Audition. If purchased separately at the educators’ price, they’d cost $647. The
Adobe Video Collection Standard 2.5, has all three products plus After Effects and sells to educators for $499.

The only video card manufacturer working closely with Adobe is Matrox.(   http://www.matrox.com     ). It offers two
excellent cards:

• Matrox RT.X10 Xtra, $700

• Matrox RT.X100 Xtreme, $1,100

Both cards offer amazing functionality for the price. I won't attempt to dissect all the strengths and weaknesses
of these cards. I will give you a basic rundown of what these two cards have to offer.
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The Matrox RT.X10 Suite has both a hardware card and a “breakout” box – a device with in/out connectors for DV
(digital video) and analog video (consumer-ish composite and higher-quality S-video). The hardware card has
video processors that relieve your PC’s CPU of some work and allow for smoother multi-track video and special
effect real-time playback within Adobe Premiere Pro. And its "Grab" function captures single frame images
directly from your student’s DV tapes.

Figure 5.2: The Matrox RT.X10 greatly expands on the standard suite of Premiere Pro visual effects.

Where the RT.X10 really shines is with its package of video and text special effects and transitions. These include
some eye-popping, exciting 2D and 3D visual effects, very smooth fast-motion and slow-motion capability, and
broadcast-quality titles with cool motion effects. Adding the RT.X10 Suite of effects nearly doubles the number
shipped with Adobe Premiere Pro.

Here’s a quick rundown:

• 2D & 3D Digital Video Effects (DVEs). Take a look at Figure 5.3. That User Interface gives you ready
access to dozens of 2D and 3D effects. Realtime DVEs let you position, scale, zoom, and rotate your
video and graphic layers in 3D space, in real time. You can easily create picture-in-picture (PiP) effects,
tumbles, and spins. Matrox RT.X10 Suite features high-quality scaling and smooth motion. You can add
soft edges, borders, and true shadows in real time.
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Figure 5.3: The RT.X10 gives you immediate access to a full range of exciting DVE possibilities.

• Realtime Page Curls. The Matrox RT.X10 Suite lets you add smooth page curls and page rolls to your
projects. These are true 3D page curls with full-motion video on the reverse side and realistic highlights.
Page curls on graphics let you create great-looking text effects. You control the position, rotation,
scaling, and zooming of page curls in 3D space. You also have control over the softness of the edges.
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Figure 5.4: The collection of Page Curl effects offers some exciting extra features that expand on what you’ll find in
the Premiere Pro Effects collection.

• Realtime Organic Wipes. More than 150 realtime organic wipes use grayscale gradients to transition
from one layer to another in a particular pattern. You can choose from a wide variety of pre-created
effects or easily create your own customized wipe patterns using Adobe Photoshop.
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Figure 5.5: Organic wipes are an excellent alternative to standard hard-edged transitions.

• Realtime Speres and Cubes. Realtime sphere effects let you morph your video into spheres with
shadow and highlight. You can map video, graphics, or solid colors to the faces of 3D cubes and slabs,
then rotate them in 3D space to create effects such as those you often see during sports broadcasts.
And you can explode, shatter, blast, and break apart your images with realtime particle effects.
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Figure 5.6: RT.X10’s 3D Sphere and Cube Effects will dazzle your audience.

• Realtime Particle Effects and 3D Tiles. You can explode, shatter, blast, and break apart your images
with realtime particle effects. 3D tile effects slice your video into a variety of different tile and slab
patterns that rotate, flip, swirl, pivot, or spin in real time to reveal another clip.
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Figure 5.7: Particle Effects create nifty explosions while 3D tiles break a scene into flying rectangles, revealing another
scene behind them.

The Matrox RT.X100 Xtreme is a super-set of the RT.X10. It offers many more realtime 3D effects including Pan &
Scan, Old Movie filters, realtime MPEG-2 capture and encoding, a high-end Chroma Key tool and some plug-ins
for After Effects and Photoshop.
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Sidebar: Alienware MJ-12 DV Workstation

I am a longtime fan of Alienware (   http://www.alienware.com    ), from its early days in the late 1990s as a maker
of PCs geared to hardcore PC gamers to its position today as a market leader in high-performance PCs.

Figure 5.8: Alienware—the leading PC maker for hardcore gamers and DV enthusiasts.

Considering Adobe Premiere Pro’s new tack as a technology-driven NLE, I knew I’d need some extra PC
power to test its full functionality and performance. So I turned to Alienware, and they agreed to provide a
loaner DV workstation: their top-of-the-line MJ-12 (shown in Figure 5.9).

The MJ-12 has every technological component available to enhance the Adobe Premiere Pro experience.
Running side-by-side with a reasonably powerful PC
dramatically demonstrates the performance
enhancements it provides.

Figure 5.9: The Alienware MJ-12 DV workstation
powerhouse.

It has every element I enumerated earlier this hour:

• Dual Pentium 4 Xeon 3.2 GHz CPUs

• Two GB Corsair 266 MHz DDR SDRAM

• A two-disk RAID array A/V work drive  using
Seagate Barracuda 120 GB hard drives and a
system RAID array drive using two 10,000 RPM
Western Digital Raptor drives.

• An NVidia Quadro 3000 dual-monitor video
card with dual DVI (Digital Video Interface) connectors that support the latest digital flat panels and
also work with standard analog PC monitors

• An ASIO-compliant, THX certified, SoundBlaster Audigy 2 ZS, 7.1 digital surround sound card

• A Plextor PX-708A DVD recorder
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These are more than vanilla components; they all are the best of breed at the moment Alienware built my
MJ-12. And Alienware doesn’t just cobble these components together. What sets Alienware apart from other
system builders is their attention to detail. They cut no corners. From the high quality case and extra
strength power supply down to the multi-fan cooling system and neat and tidy “cable management,”
Alienware consistently delivers the best DV systems.

Note: Since testing the MJ-12, Alienware has developed a new DV workstation line. Roswell DV workstations
range in price from $2,800 to $6,250. The top-of-the-line Roswell 3200 ships with either the Matrox RT.X10
Xtra or RT.X100 Xtreme card. Otherwise it more or less matches the MJ-12 in features and components.

Starting Adobe Premiere Pro for the first time

If you performed the task in the Module 4, “Touring Adobe Premiere Pro’s Interface and Features,” you already
have installed and opened Adobe Premiere Pro. In this section, we take a closer look at Adobe Premiere Pro’s
opening screens.

Adobe Premiere Pro’s developers greatly simplified its project settings, limiting the default choices to various
flavors of DV—digital video. The only other choice—Video for Windows (VFW)—is for projects that use a variety
of PC or analog video. The focus of these modules is DV so I’ll give you only a glimpse into the VFW options.

Task: Checking Project Preferences

The basic rule of thumb when selecting project settings is: Match settings to your source material and not to the
final output. Even if your goal is to create a low-resolution video to run on the Internet, wait until you finish
editing and then reduce the output quality settings. One other advantage to matching your source material
settings is that you have more output options later. Here’s how this works:
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1. Open Adobe Premiere Pro by double-clicking its icon on the desktop. That pops up the Welcome screen
I showed you earlier. If you started a project then, your welcome screen will look something like Figure
5.10. It lists recent projects. Clicking on one takes you to the workspace as you left it when you
previously worked on Adobe Premiere Pro. For this task, start anew by clicking New Project to open the
New Project dialog box.

Figure 5.10: How the Welcome screen looks after you’ve worked on a couple projects.

2. Your only obvious options are: NTSC, PAL or Panasonic 24P, 32 or 48 kHz, and Standard (4:3 aspect ratio)
or Widescreen (16:9). Most of you will simply choose the setting that matches your original DV and
move on. In this case, though, click the Custom Settings tab circled in Figure 5.10.
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Note: What kHz Setting to Choose

Many DV camcorders give you two audio quality options: 16-bit audio recorded at 48 kHz or lower quality
12-bit audio recorded at 32 kHz. The latter lays down two stereo tracks: one with audio recorded by the on-
camera mic and the other giving you an option to insert a narration or some other audio. Kilohertz refers to
the number of samples recorded per second. More is better. CD audio is 44.1 kHz. MPEG audio for DVD
playback is 48 kHz. Bottom line, select 32 kHz or 48 kHz depending on how you set up your camcorder. If
you recorded at 32 kHz and set your project to 48 kHz that is not a problem. Adobe Premiere Pro will simply
take a little longer to up-convert your audio during the conforming process.

Figure 5.11: The New Project screen offers up only three basic choices. Clicking the Custom Settings tab presents
many more options.

3. The Custom Settings dialog box has dozens of options, most of which you might never access. So I’ll
simply gloss over them. Select Video for Windows from the drop-down list shown in Figure 5.12.
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Figure 5.12: The Custom Settings dialog box enables you to fine-tune your project settings.

4. After you’ve selected VFW, many options become available (DV has very few options because it’s a
standardized video format). Click through the various drop-down lists, basically just to see what’s
available. Your choices fall into frame rate and size plus extra audio quality options.

5. Click through the three other dialog boxes by selecting in turn, Capture, Video Rendering, and Default
Sequence. Under Capture, unless you have an analog video capture card like the Matrox RT.X10, your
only “choice” will be DV/IEEE 1394 Capture. Video Rendering offers up several codecs
(    CO    mpression/    DEC   ompression algorithms) to convert analog video or other video files to DV for use in
Adobe Premiere Pro. Default Sequence has nothing to do with DV or VFW; it’s how a newly opened
sequence (timeline) will look.

6. Click the Load Preset tab to return to the default dialog box, select a DV preset that matches your source
material, give your new project a name (change that file’s disk storage location if that suits you) and
then click OK. That opens the main Adobe Premiere Pro user interface—UI—shown in Figure 5.13.
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Figure 5.13: Adobe Premiere Pro’s default, new project user interface.

 Organizing the Workspace

After you work with Adobe Premiere for a while, you'll want to organize the workspace to suit your needs. Here’s
an approach you might want your students to try. They will likely settle on their own workspace depending on
their monitor setup and as they gain some comfort working with Adobe
Premiere Pro.

Because I’m working in 1024x768 for these modules (higher resolutions
don’t reproduce well in print), I need as much editing, screen real estate
as I can get. For starters, I dock the History and Info palettes by dragging
and dropping the Info tab next to the History tab. It ends up looking like
the palette in Figure 5.14. Then I close it by clicking the little ‘x’ in its
upper-right corner. If I need to open either History or Info, I select
Window > History—or—Info.

Figure 5.14 Combine History and Info by dragging and dropping the Info
tab next to the History tab.
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Then I get rid of the Tools Palette by using an Adobe keyboard shortcut that works on all Adobe digital imaging
products: Tab. Pressing Tab removes the Tools Palette, and pressing Tab again, brings it back. That way, when I
need a tool, I simply press Tab, select the tool, use it, change back to the default Pointer tool, and press Tab again
to lose the Tools Palette.

Tip:  Tab Shortcut Key Behavior

If I had not clicked the little ‘x’ to close the combined History/Info Palette, pressing Tab would have closed it
along with the Tools Palette. Pressing Tab again would then pop open both Palettes. That’s not the behavior
I want. So, by manually closing the History/Info Palette, Tab then opens/closes only the Tools Palette. Adobe
Premiere Pro is nothing if not insanely configurable.

With the History, Info, and Tools palettes gone, I drag the edges of the Timeline Window all the way to the right
and left sides of the screen as shown in Figure 5.15.

Figure 5.15: My personal workspace features a wider timeline and closed History, Info ,and Tools palettes.
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There are other means to adjust the look of your workspace. As shown in Figure 5.16, you can change from a
dual-monitor view to a single-monitor view (using a single PC monitor) by clicking the wing menu (sometimes
called the fly-out menu) triangle in the upper-right corner and selecting Single View (Figure 5.16 shows how the
Monitor Window looks after making that selection).

Figure 5.16: Switch between dual- and single-monitor views.

I prefer a dual-monitor view, but some editors do not. In any event, when I’m working on a complex effect,
sometimes it’s good to work in single-monitor view and expand the Monitor Window. In particular, when
working with Motion Control settings, sometimes you need to drag motion paths outside the monitor screen.
For example, expanding the Monitor Window, clicking the little “fit” drop-down menu triangle at the bottom of
the screen, and selecting 50% places the screen in the middle of a lot of empty space, giving you room to create
your off-screen motion path. I explain Motion Settings in Module 10, “Advanced Editing Techniques and
Workspace Tools.”
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Tip: Save Your Customized Workspace

Because I'm the only one who uses my PC, I don't need to worry about some other editor messing with my
customized Adobe Premiere Pro workspace changes. If your students share their computers with other
editors who don't like their layout, they can save their workspace by selecting Window > Workspace > Save
Workspace. Then type in a name and click Save. To open that custom workspace, select Window >
Workspace and then select that named workspace.

Use Workspace Pre-sets

Different editing modes demand different workspaces. As shown
in Figure 5.17, Adobe Premiere Pro accommodates those needs
with four workspace pre-sets. Access them by selecting Window
> Workspace and then choosing from the four pre-sets. Click
through all four (Editing is the default, opening screen) to see
how they differ. Effects brings the Effects palette and Effect
Controls window front and center. Audio opens the Audio Mixer.
And Color Corrector opens a second reference monitor.

Figure 5.17: The four workspace pre-sets work well for their specific
situations.
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Finally, take a look at the General Preferences dialog box. It has a nice feature that lets you set the brightness
level for Adobe Premiere Pro’s overall look. Access it by selecting Edit > Preferences > General from the main
menu bar. That opens the screen shown in Figure 5.18.

Figure 5.18: Use the Preferences dialog box to set screen brightness and to access a plethora of other options.

Move the User Interface Brightness slider to adjust overall brightness. This comes in real handy for those
production studios that keep their NLEs in a dark room to emphasize the quality displayed on the monitor(s).

While in the Preferences dialog box, click Scratch Disks to set the locations for where you will store captured
audio and video as well as audio and video previews and conformed audio. If you have two hard drives but no
RAID, it’s a good idea to put captured audio and video on one drive and the conformed audio and previews on
the other.
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Q. As PCs get more powerful, why do I need to buy a video capture card as a way to boost performance?

A. My message is not that you must buy a high-end video capture card. That said, consider that a card’s
performance boost is only one benefit. Most cards also offer analog video in/out capability, hardware MPEG
encoding, and a boatload of special effects that you’d pay hundreds of dollars for if purchased separately from
third party plug-in providers.

Q. ASIO, VST, RAID, and MEG. Help! I’m getting “acronymed” out. Do I need to know all these terms?

A. My teaching (and book writing) philosophy is that I want students (and readers) to at least have a feel for why
developers make certain decisions. And what sets Adobe Premiere Pro apart from its competition and
predecessors is the care its developers put into building its foundation. A large part of that decision-making
process was choosing to support current (and likely coming) industry standards. You don’t have to know how
ASIO reduces latency (thus improving audio responsiveness), just that writing code that supports it makes
Adobe Premiere Pro a faster race horse.

Quiz

1. How do you make palettes disappear?

2. What three changes will give your PC the greatest performance boost when working with Adobe Premiere
Pro?

3. If you’re using DV and building your video project to run in low resolution on the Internet, should you select
VFW for your project settings?
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Answers

1. Either click their little x’s to close them (then use Windows > [Palette Name] to reopen them), or use Adobe’s
ubiquitous keyboard shortcut: Tab.

2. Ranked from biggest boost down (depending on your system): RAM, Hyperthreading and/or Dual
Processors, and RAID.

3. No. Match your project settings to your original video. In this case, DV set to whatever audio level you used
in your camcorder. If you don’t know the audio kHz level (32kHz or 48kHz), choose DV 48 kHz to ensure
maximum quality. When you complete your project, select output settings to suit the output medium. I
cover outputting projects in module 22, “Exporting Frames, Clips, and Projects.”

Exercises

1. Experiment with the Adobe Premiere Pro workspace. Click every Main Menu drop-down list. Check all the
preferences by selecting Edit > Preferences and Project > Project Settings (the latter are the same items as in
the opening New Project dialog box).

2. Visit www.Matrox.com to check on their video capture cards. Prices and features change rapidly in this
exciting DV editing environment. The firm frequently offers special bundles that throw many additional
special effects into the mix.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education

Adobe, the Adobe logo, Adobe Premiere, Adobe Audition, Adobe Encore, Acrobat, After Effects, GoLive, Illustrator, InDesign, Photoshop, and

Tools for the New Work are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other

countries. All other trademarks are the property of their respective owners.

© 2004 Adobe Systems Incorporated. All rights reserved.



Adobe Digital Video Curriculum Guide – Module 6 6-1

Adobe Digital Video CURRICULUM GUIDE

Module 6

Scene Selection and Video Capture

Your students begin the editing process as they plan and shoot their video. But even the best photographers get
more material than they need. And there are always those shots that just don’t turn out right. So the next step in
editing is reviewing the original videotapes, even before they transfer—capture in NLE parlance—their video to
their PCs.

Adobe® Premiere® Pro offers tools to take some of the manual labor out of that process. You can set up Adobe
Premiere Pro to simply record your entire videotape as one long clip, mark individual clips for automated
capturing later, or have Adobe Premiere Pro use its scene detection feature to analyze videotapes and
automatically create separate clips whenever the videographer pressed the pause/record button on his or her
camcorder. Working with analog video is not as simple (unless you have professional quality, remotely
controlled analog devices). I explain how that works in this module.

Finally, as your students capture their video clips to their PCs, it’s best for them to organize them. That is, create a
set of logically named file folders and give the clips descriptive names and place them in applicable folders to
make them easier to find as deadlines loom.

At the end of this lesson, students will:

• Refine their video clip selection process

• Capture digital video

• Understand the analog video capture methodology

• Manage their assets

Selecting Video Clips

Before your students use Adobe Premiere Pro to capture—or transfer—video to their PC’s hard drive, they need
to critically view their raw footage. You want them to look for "keeper" clips and sequences, the best interview
sound bites, and any natural sound that will enhance their production.

The purpose is twofold: to better manage media “assets” and to speed up the video capture process. The latter is
an example of how DV really shines—the capability to automatically transfer selected video clips to a computer.
Your students simply will create a list of video clips, tell Adobe Premiere Pro to transfer them, and then grab the
Frisbee and take a break while Adobe Premiere Pro handles the chores. Nice.

Before they bolt for the door, I want to run through some scene-selection tips.
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Note: Shoot Plenty of Video

The basic tenet in the video or film production world is that you will shoot a whole lot more raw footage
than you'll put in your final production. Probably at least five times what you'll need. You've heard of film
scenes "hitting the cutting room floor." Next time you watch a DVD movie, check to see if it has "deleted
scenes." You'll be amazed at how many difficult-to-shoot, well-acted, and expensive scenes did not make it
into the final cut.

Your students’ task now is to critically review their tape(s) and weed out the chaff while retaining the grain. True,
they can transfer entire tapes to their hard drive and do weeding later. But an hour of DV and Adobe Premiere
Pro’s associated conforming audio consume about 14 GB of hard drive space. Instead, selecting usable clips,
naming them and assigning them to a set of organized folders before actual video capture makes finding those
special shots much easier than scanning through a one-hour video file.

You want your students to transfer only the best sound bites, the coolest scenes, and the highest-quality natural
sound. If they did more than one take of a scene, have them find the one that works best. If they videotaped that
soccer championship game, select all the goals, great plays, and enthusiastic crowd reactions, skipping most of
the up-and-down-the-field ball handling.

Getting Good Bites

My view is that the video producer or writer can do a much better job telling the story than the folks you
interview for the story. It's your job to distill factual information and create a coherent, cohesive story.

So it's best to use interview sound bites, not to state facts but to present emotions, feelings, and opinions. You
should be the one to say, "At the bottom of the ninth, the bases were loaded, with two outs." Let the batter, who
is recalling this dramatic moment say, "My legs felt like jelly."

Even in a corporate backgrounder, employees should be the ones stating how enthusiastic they are about a new
product. It’s the video producer’s job is to say what that product does.

In general, keep sound bites short. Let them be punctuation marks, not paragraphs.

Note:  Exceptions for Idiosyncratic Characters

A caveat: None of these admonitions are carved in stone. Some characters you'll videotape are so
compelling, quirky, or humorous that your best bet is to let them be the primary narrator. Then you'll want
to consider what scenes you can use to illustrate their commentary. You don't want to fill your entire video
with a "talking head."

Listening for Effective Natural Sound

As your students review their raw footage, they should keep their ears tuned for brief instances of dramatic
sound: a wire cutter clipping a piano wire (one of the most memorable for me—see “Editing Tips from an
Expert—John Crossman” in Module 10, “Advanced Editing Techniques and Workspace Tools”), the crack of a
baseball bat, a gurgling brook, a hawk screeching.

You'll want your students to transfer these as separate clips even though they might also transfer a long clip of
the soaring hawk with that sound somewhere in it. Why? Later, when they edit in that soaring hawk, they easily
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can find and edit in the screech "nat-sound" (which means natural sound in TV news parlance) to give the image
more punch.

Capturing Digital Video

"Capturing" or transferring video from a camcorder to a PC can be mindlessly easy or maddeningly difficult.

Digital video—DV—transfer falls on the easy end of the scale.

On the other hand, analog video capture is fraught with potential snafus. You need a video capture card with
analog video inputs, and you cannot automate the capture process. It’s completely manual. If the only cameras
available to your students are analog—Hi-8, SVHS or VHS—go over this upcoming section—“Preparing for Video
Capture”—with them, and then skip to the “Tackling Manual Analog Movie Capture” later in this module.

Preparing for Video Capture

Before you transfer your first frame of raw video to your PC, you need to decide where to store your clips.

It all depends on your computer's hard drive configuration. Ideally you have more than one hard drive. One for
your Windows XP operating system (OS) and program files (including Adobe Premiere Pro); the other for video,
images, graphics, and sound—your so-called A/V (audio/visual) drive. The OS frequently accesses its hard drive
even in the middle of an edit or video capture. Having separate OS and A/V drives ensures a smoother operation.
Regularly defragmenting your hard drives as well as closing background applications will also improve
performance.

Caution: Sufficient Throughput

Your A/V drive should be able to sustain a throughput of 4MBps (more, if you're working with analog video).
Most recent hard drive models can handle that easily, typically operating at more than 10MBps.

If you have only one drive and it's reasonably fast, you should have no noticeable problems during video
capture.

Now it's time to tell Adobe Premiere Pro where to store your video clips and to make sure that Adobe Premiere
Pro and your DV camcorder can communicate with each other. After that has been resolved, you can view, log,
and transfer video to your computer.
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Task: Tell Adobe Premiere Pro Where to Store Your Clips
First you'll tell Adobe Premiere Pro where you want to store captured clips. Adobe Premiere Pro calls these hard
disk locations scratch disks. That's a holdover to the days of massive, removable storage devices. Now, 120 GB
internal hard drives are common, and removable storage is not that critical to computerized video editing. Here
are the steps to follow for this task:

1. Open Adobe Premiere Pro. In the Welcome dialog box, select one of your projects.

2. From the Main Menu bar select Edit > Preferences > Scratch Disks to open the Preferences dialog box
with the Scratch Disks entry already selected (see Figure 6.1).

Figure 6.1: Use this dialog box to tell Adobe Premiere Pro where your scratch disks are.

3. Click the Browse button next to Captured Video. Navigate to a the directory you want to use to store
your captured A/V files, click Make New Folder, type in a name (I suggest “Captured Video”) and click
OK.
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Figure 6.2: Use the Make New Folder feature to set a
location for your captured A-V files.

4. Do the same thing for Captured Audio (in
the same Scratch Disks dialog box). You’ll
use that file folder to store music “ripped”
from CDs, narrations recorded directly to
your PC, and other audio created in
programs like Adobe Audition™.

Caution: Confirm Your Folder Location

When you select Make New Folder to create the “Captured Audio” file folder, Adobe Premiere Pro will
automatically want to create a sub-folder in the Captured Video folder. So before clicking Make New Folder,
select the main directory where you want that file folder to reside.

Tip: Use Default Locations for Other Media

You may go through the same new file folder process for Video and Audio Previews as well as Conformed
Audio, but leaving them in the default project file location will work fine. The project file storage location
defaults to your Adobe Premiere Pro directory in My Documents. Your project file does not actually hold
your original clips, only data noting their location and any edits you've made to your project. Since My
Documents is on your system disk, make sure you have sufficient space to handle these files.
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Using Adobe Premiere Pro to Control Your Camcorder

Premiere Pro offers three ways to “capture” or transfer video from a DV camcorder to your PC:

1. Go through your video, mark the in-point and out-point for individual clips, and capture them one at a
time.

2. View your video, log a number of clips (noting in-points and out-points plus naming each clip), and then
have Premiere Pro automatically capture the clips all the clips in a batch process.

3. Use Premiere Pro’s Scene Detection feature to automatically capture an entire tape (or whatever length
you designate), creating a new clip at each scene change.

In the upcoming Tasks, you’ll follow method number two. But it’s worth your time to check out the Scene
Detection feature, since it works so much better in version 1.5 than it did in Premiere Pro 1.0. I’ll explain it after
the next Task.

Task: Remotely Controlling Your Camcorder
The fun is about to begin. If you haven't used a computer to control a DV device, this task is guaranteed to
elevate your heart rate:

1. Turn your camcorder to VCR/VTR mode (as opposed to Camera mode).

Note: Use AC not a Battery

When firing up your camcorder use its AC adapter, not its battery. Here’s why: When using a battery,
camcorders go into “sleep” mode after a while. And the battery will invariably run out in the middle of an
automated transfer.

2. Using an IEEE 1394 (FireWire) cable, connect your camcorder to your PC’s video card, IEEE 1394 card, or
other DV outlet. That probably will cause Windows to display the dialog box shown in Figure 6.3. If it
does, keep things simple and click Cancel.

Tip: Avoid Nagging Windows Queries

You can get Windows to stop bugging you whenever you plug in a DV device (or any other piece of
hardware like that). When that dialog box pops up, select the Take no Action icon and click the Always
perform the selected action checkbox.
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Figure 6.3: The Digital Video Device dialog box opens
when you connect your camcorder to your PC.

3. Open Adobe Premiere Pro, select an existing
project (or start a new one).

4. Open the Capture window by selecting File >
Capture. Figure 6.4 represents what you
should have in front of you: a TV screen with
standard video-editing-style VCR controls.

Caution: What to Do If You Don’t See Your Video

DV camcorders have become standardized such that just about any DV camcorder or other DV device will
connect flawlessly with your PC. You’ll know if yours is not making the connection if the word “Stopped”
does not appear at the top of the capture screen or if the VCR controls have no effect. If that’s the case, click
the Settings tab, then click Options (I’ve circled it in the lower right corner of the Capture window). That
opens a drop-down list of camera manufacturers (Device Brand) and camcorder models (Device Type).
Select yours and see whether that clears things up.
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Figure 6.4: The Capture window. Using standard VCR and videotape-editing controls, you easily can scan through
your tape to find "keeper" video clips to transfer to your hard drive.

5. Click the Play button (circled in Figure 6.4. Is this not cool? There is your raw video playing on your
computer.

6. Try out some of the other buttons: Fast-forward, Rewind, and Stop.

Note: Use Pop-up Tool Tips

If you’re not sure what just about any button or icon in Adobe Premiere Pro does, simply place your
cursor on it. As shown in Figure 6.5, after a moment, that object’s tool tip—and keyboard shortcut (if
any)—will appear.
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Figure 6.5: Use the Tool Tip pop-ups to help you
identify each button’s name and keyboard shortcut
(if it has one).

7. Now try some of the special buttons:
Shuttle (the wide button in the middle) enables you to move slowly or zip quickly—depending on how
far you move the slider off center—forward or backward through your tape. You also have frame-at-a-
time Step Forward and Backward buttons, Forward and Reverse Slow Play, and a single-frame Jog
control (the ruled line—”virtual wheel”—beneath all the other controls).

Automatic Capture Using Scene Detection

Sometimes it’s easier simply to capture an entire tape or tape segment rather than selecting and logging
individual scenes. If you want to take this one-step approach, use Premiere Pro’s Scene Detection feature.

Note: Scene Detection: How It Works

Adobe Premiere Pro’s Scene Detection reads a videotape’s time stamp—as opposed to its timecode. The time
stamp is the original video’s date and time-of-day recorded in a data track (timecode is the time relative to
the length of the video you’ve shot). Virtually all DV camcorders have the data time stamp feature. Adobe
Premiere Pro detects any discontinuities—times when you pressed the Pause/Record button on your
camcorder—and creates new clips at each juncture. It does not notice those instances when you pointed
your camcorder at a new scene without clicking the Pause/Record button.

Referring to Figure 6.5,cue up your tape up to where you want to start capturing scenes, click the Scene
Detection checkbox, leave handles set to ‘0’ (otherwise Premiere Pro will shorten each clip by many frames –

reverse of how “handles” normally works), then click
the large Tape button.

Figure 6.5.5: Use the Scene Selection feature to
automatically capture and name all clips on your tape.

Premiere Pro will start playing your tape and
transferring each scene to your Project Window. It will

sequentially number each new clip. If you let the tape run to the end or where you stopped recording, the
capture process will end automatically. Otherwise you can click the Stop button at any point to end the Scene
Detection capture process.

Using Video Clip Naming Conventions

As you log your clips, you will give each clip a name (you can let Adobe Premiere Pro do that automatically, like
Clip01, Clip02, and so on., but doing so is ineffective). Think through how you're going to name your clips. You
might end up with dozens of clips, and if you don't give them descriptive names, it'll slow down editing.

You might use a naming convention for sound bites such as Bite-1, Bite-2, and so forth. Adding a brief
descriptive comment such as Bite 1 Laugh will help. With natural sound you could say Nat 1 Hawk screech.
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Tip: Automatic Naming Not So Helpful

If your video clip naming convention uses numbers at the end of each clip name, Adobe Premiere Pro will
automatically add one to that number when you return to the Logging page. (I cover that process in the
next task, “Log and Capture Your Clips”). So if you name a clip Home Run-1, when you click Log In/Out,
Adobe Premiere Pro stores that clip information in the Project Window and then returns to the Logging
page and automatically places Home Run-2 in the File Name window.

Nice? Sort of. Turns out you don't necessarily have all the home runs back-to-back on your tape, so the next
clip you log might be Crowd Reacts-3 and you'll have to type that over Home Run-2.

With all other scenes (that is, besides natural sound and sound bites), you can drop the prefixes and just give
them consistent yet descriptive names: Goal-3, Crowd React-2 Applause, Hawk Soaring-4, and Interview
cutaway-1 reverse.

Tip: Using a Naming Convention Eases Project Window Organization

Later, right before you make your first edit, you'll create some file folders (Adobe calls them bins) in your
Project window then place you clips in them. My suggestion is to put each category of clip into a separate
folder—for example: natural sound, sound bites, and scenes. Depending on your project's size, you might
want to use subcategories for scenes. Using a consistent naming convention will help in other areas.
Because you can sort clips alphabetically, you can find all the nat-sound clips, select them all, and easily
place them in the Nat-Sound file folder (bin).

Task: Log and Capture Your Clips
As you log your tapes, you give each clip a name (or Adobe Premiere Pro does that automatically) and then
Adobe Premiere Pro stores each clip’s in-point and out-point data in your Project Window under each clip’s
name. You specify in which folder you want to store that data (you can change the folder for each clip if you
choose) so that when you do the actual capture, Adobe Premiere Pro places that clip’s reference information in
that Project Window bin.

Here are the steps to follow:

1. In the Capture window Setup area, click the
Logging tab.

2. As shown in Figure 6.6, select where you want to
store each clip’s in- and out- data. By default, the
Capture Window displays whatever bins you have
in your Project Window. Because you probably have
not created any bins, your only choice will be your
project’s main bin. In my case, it’s Sams Book
Test.prproj (prproj is the file extension for Adobe
Premiere Pro projects).

Figure 6.6: Select a bin from the Project Window list to store clip information.
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3. Change the Handles setting (found in lower right of Logging tab in Capture window—refer to Figure
6.7). This adds a user-specified number of frames (using 30 FPS) to the start and finish of a clip. By
adding handles to each clip, you’re guaranteed to have enough extra video to add transitions without
covering up important elements of the clip.

Tip: Using the Mouse Drag Method to Change Numeric Values

You can type in a figure—I recommend at least 30 frames (30 frames equals 1 second)—or place your cursor
over the handles number and drag it left or right to change the value. This method to change a numeric
value is used throughout Adobe Premiere Pro, especially in the Effect Controls Window, so give it a try here
to get a feel for it.

Figure 6.7: Add handles to ensure that you have enough
“slop” at the start and end of your clip for a transition (if
needed).

4. In the Clip Data section, as shown in Figure 6.8,
give your tape a unique name (Adobe Premiere
Pro remembers clip in/out data based on tape
names). And, if you know what your first clip will be,
add its name.

Figure 6.8: Give your videotape a name (write it on the tape as
a reminder) to begin logging.

5. Start logging your tape. To do that, rewind it and
then play it. When you see the start of a clip you
want to transfer to your PC, stop the tape, rewind to
that spot and click the Set In button, as shown in
Figure 6.9, at the beginning of that clip. When you
get to the end of that clip (you can use Fast-forward
or simply Play to get there) click Set Out. The In/Out
times will display as well as the clip length.
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Figure 6.9: Use the Timecode section of the Capture
Window to log In/Out times for each clip that you want
to capture.

Tip: Three Other Ways to Set In/Out Points

As is the case with just about anything you do with Adobe Premiere Pro, there are other means to set in-
points and out-points for selected clips. You can click the brackets shown in Figure 6.10 on the play controls,
use the keyboard shortcuts—“i” for In and “o” for Out—or you can change the In/Out time directly in the
Timecode area by clicking on the timecode and dragging your cursor left or right.

Figure 6.10: You can set In/Out points using the
brackets next to the VCR controls. Note the
keyboard shortcut shown in the tool tip: (O).
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6. Click Log Clip. That opens the Log Clip
dialog box shown in Figure 6.11. Change
the name, if needed, add appropriate
notes if you want, and then click OK. That
adds this clip’s name with its in/out and
tape name info to the Project Window.
You’ll go there later to do the actual
capture.

Figure 6.11: Use the Log Clip dialog box to add any
additional information about your clip before adding
its name to the Project Window.

7. Log clips for the rest of your tape using the
same method.

Note: Capture? Not Really. More Like Transfer

Before you "capture" your first clip, I want to clarify one point. Capture is a somewhat misleading term used
throughout the NLE world. On the digital video (DV) side of things, transfer would be a more descriptive
term. Because DV already is digital, all Adobe Premiere Pro does is tell your camcorder to transfer the
selected digital clip data through the IEEE 1394 interface and onto your hard drive. Done. No "capturing"
necessary. It does use a codec to place the clip into a file wrapper that Adobe Premiere Pro can recognize but
that codec does not change the original DV data.

In the analog world, "transfer, conversion, compression and wrapping" would more accurately describe the
capture process. In that case your camcorder transfers the video and audio to a video capture card. Then
that card's built-in hardware converts the waveform signal to a digital form, compresses it using a codec,
wraps it in the AVI file format and then stores it to your hard drive. It's a much less user-friendly process
made even more tedious by the inability to remotely control your camcorder (in most cases). I'll explain that
process in the next section, “Tackling Manual Analog Movie Capture.”

8. To perform the actual capture, open the Project Window (refer to Figure 6.12) and select all the clips you
want to capture (see following Tip for three methods to do that). As shown in Figure 6.12, Adobe
Premiere Pro calls already captured video clips “Movies” and gives them a film/speaker icon (they have
both audio and video). Uncapatured clips are called “Offline” and have a different icon. You can sort
them by Media Type to group all offline clips.

Tip: Three Ways to Select More Than One Item

Windows and Adobe Premiere Pro offer three ways to select more than one object. If they are contiguous,
mouse-click on the top one and Shift+click on the last one in the group or click to the left and above the top
click and drag to the last one to highlight a group. If the objects are scattered about, Ctrl+click on each one
in turn.
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Figure 6.12: In the Project window, Adobe Premiere Pro
identifies captured (movie) versus ready-to-be-captured
(offline) clips.

9. Select File > Batch Capture. That opens a very
simple Batch Capture dialog box that asks whether
you want to override the camcorder settings. Leave
that box unchecked and click OK.

10. The Capture window opens as does another little dialog box telling you to insert the proper tape (in
your case, it’s probably still in the camcorder). Click OK.

11. Adobe Premiere Pro now takes control of your camcorder, cues the tape up to the first clip (or to
whatever number of frames ahead of it if you set using handles), and transfers that clip and all other
clips to your hard drive. You can monitor the capture process by watching the PC screen or your
camcorder’s display. When completed, take a look at your Project window to see the results. Offline files
have become Movies.

Tip: Discontinuities Lead to Capture Breakdowns

If your tape does not have continuous time code and you logged clips from different areas of the tape,
Adobe Premiere Pro might not be able to automatically capture your clips. Your tape will not have
continuous timecode, for instance, if you record on the tape, eject it, reinsert it and record some more. As I
mentioned in Module 3, it’s best to stripe your tapes first.

Tackling Manual Analog Movie Capture

If you need to transfer analog video—consumer-level VHS, S-VHS, Hi-8 or professional-grade video like Beta-
SP—you need a video capture card with analog inputs. Most such cards, such as the Matrox RT.X10 covered in
Module 5, “Adobe Premiere Pro Setup,” have consumer-quality composite connectors as well as S-video and
sometimes top-of-the-line component plugs.

Tip: Convert Analog to DV to Automate That Capture Process

If you have access to a DV camcorder, there is one way to avoid the manual analog capture process: Dub
your analog tapes to that DV camcorder. That’s a fairly straightforward procedure. Most DV camcorders have
analog inputs (composite or S-video outlets). After your tapes have been dubbed over, you can use the DV
camcorder to automate the capture process. One side benefit: you have a digital backup of your analog
tape.

You'll need to use your card's documentation to set up the capture criteria. Typically you do that when you first
open Adobe Premiere Pro and refine that later when you open the Project Settings, Capture dialog box.

The drop-down menus will display options with your card's manufacturer listed.
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You'll then go through the movie-capture process in a much more hands-on fashion. For starters, the only way
you can log clips for later automated capture is if your camcorder records industry-standard timecode on the
tape and has device control. Most consumer analog camcorders do not do that. If you do have such a
camcorder—it's probably a broadcast-quality Beta SP device—then follow the capture process used for DV. If
not, you'll manually transfer each clip, one by one.

Task: A Typical Video Capture Card Scenario
If you do step up to specialized video capture card, each has its own set steps to capture video. But they typically
match those listed here:

Make sure that your camcorder is turned on and set to VCR/VTR.

1. Open the Capture window, click the Settings tab, and change the Device Control setting to your capture
card.

2. Press Play on your camcorder (again, unless yours is a professional grade camcorder, there will be no
means for Adobe Premiere Pro to control it).

3. If your video card installation and setup went smoothly, you should see the video in the Movie Capture
window.

4. Using the controls on your camcorder, search for a scene you like, back up the tape a few seconds, press
Play, and then click the Record button on the Movie Capture window.

Note: Analog Capture Processing

Your capture card converts that analog video signal into a digital format, compresses it, and sends it to the
designated file folder on your hard drive. Some capture cards will split the signal into video-only and audio-
only files (you easily can sync them up during editing).

5. When you reach the end of that particular scene, press Esc or click the Record button to stop the
recording.

6. Adobe Premiere Pro will ask you to name the clip, just as it did during DV movie capture.

7. Click OK to return to the Movie Capture window and continue selecting and transferring clips, one at a
time.

 Managing Your Assets

You used naming conventions to make accessing your video and other media assets easier. One additional step
will enhance that ease-of-access: organizing your Project window.

The Project window is simply a means to access your "assets"—video clips, audio cuts, and graphics. Each listed
media asset is basically just a link. The files themselves—the video clips and so on—remain in their scratch disk
file folder(s).
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Note: Project Windows Holds Only Small Bits of Data

It's a good thing that the Project window contains only links and not actual asset files. It saves disk space by
not copying assets to a new location. This means that you can have multiple projects access the same assets
without duplicating them. It also means that you can delete a project file without mistakenly deleting your
precious video clips.

Even when you trim a clip, the original clip remains untouched. Adobe Premiere Pro doesn't lop off the
unwanted sections; it merely records the data that describes how you trimmed the clip. Adobe Premiere Pro
is nondestructive.

Task: Organize Your Assets
Logically arranging your assets in the Project window is simple. It not much more than adding a few bins and
then doing some dragging and dropping. Here’s how it works:

1. Take a look at the Project window. You should see all your newly captured video clips. Expand the view
of that window by dragging its lower-right corner.

2. Change the display to Icon (more accurately, thumbnail) view by clicking the monitor button, circled in
Figure 6.13.

Figure 6.13: Use the Icon view to get a visual representation of your clips.
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3. Test the Project window media viewer by selecting one of your clips and clicking on the Play triangle
next to the screen in the upper-left corner of the Project window.

4. Create new file folders (bins) by clicking the folder button to the right of the Icon view button (also
circled in Figure 6.13). That displays a bin in the Project window. Give it a name that matches your
planned video clip organization. Do that for all the bins you planned for your clips.

5. Select and drag video clips to their respective bins. You can select more than one clip using the
methods described earlier: shift+click or click+drag to select contiguous clips or ctrl+click to select
scattered clips. Once selected, click on the image portion of a clip (as opposed to a beige border) and
drag the clip collection to its respective bin. Repeat that for all your clips.
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Before you can edit your video, you need to capture it—transfer it to your PC. That process can be as simple as
copying an entire tape to your hard drive and storing it as one long clip or it can take a more selective route. That
latter approach gives you the chance to review your raw footage to choose keepers and to give your chosen
clips descriptive names that will make it easier to track down elusive clips later.

Adobe Premiere Pro has a scene selection (detection) feature that relies on breaks in a DV tape’s time stamp.
Finally, after you’ve captured your clips, organize your clips into bins in the Project window.

Q. I get a report that there were "dropped frames" during the batch capture. What's going on?

A. If you experience dropped frames, you may have too many programs running in the background that are
interfering with video capture. In Windows, press Ctrl+Alt+Del to open the Task Manager and take a look at the
Applications tab and the Processes tab to see what programs and processes are running in the background. If it's
more than three or four programs, you might disable some of them. Also check what programs load
automatically during startup by selecting Start > Run, typing in msconfig and clicking OK. That opens the System
Configuration Utility. Click its Startup tab. I am a firm believer in not having anything running in the background
(except virus checking software). You can probably unclick everything else there to free up some resources. One
other point: If you're capturing analog video, you may be using an outdated codec or one with too high a data
rate.

Q. When I open the Capture window, I don't see an image in the video monitor and I can't control my DV
camcorder.

A. This could be one of several things: Your camcorder is not turned on (if you're using a battery, it might be in
sleep mode), you have it in Camera mode instead of VCR/VTR, or you have not inserted your tape.

Quiz

1. During the capture process, it’s a good idea to add some extra frames to the start and end of each clip to
ensure that you have enough footage to do transitions. How do you do that?

2. You want to capture a clip for its video plus a portion of that clip for a snippet of natural sound. How do you
do that?
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Quiz Answers

1. Put some number of frames in the Handles option in the Capture section of the Capture window. A
reminder: One second of video equals approximately 30 frames for NTSC or 25 frames for PAL.

2. Simply log that entire clip and then go back and log the natural sound portion. It’s not a problem to capture
a video from the same location on your original tape more than once. Adobe Premiere Pro simply treats
each instance as a separate clip and shuttles the tape to the proper in and out points, whether or not it’s
been there before.

Exercises

1. After your students transfer a tape or two to Adobe Premiere Pro, it will become second nature. So, even if
they do not have a field tape of their own, have them log and capture clips from a couple tapes.

2. If your students (or school) have any analog tapes, now is as good a time as any to convert them to DV.
Obtain a DV camcorder with analog video outlets (S-Video is better than composite) and dub those tapes to
DV. DV lasts longer than analog and is much easier to work with.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education
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Module 7

Creating Cuts-only Videos

Video editing has come a long way from massive tape machines operated only by engineers to desktop PCs
offering anyone an opportunity to enjoy the art of video editing.

A good introduction to nonlinear editing is via the storyboard. I explain that in this module. After your students
have organized their clips on the storyboard and then moved them to a timeline —or sequence in Adobe®
Premiere® Pro parlance—they will have countless options to trim, move, add, and delete clips. Those topics
conclude this module.

At the end of this lesson, students will be able to:

• Explain the evolution of video editing: from engineers to artists

• Start a project using the storyboard approach

• Know their way around the Timeline window

• Edit clips in a sequence

Video Editing: From Engineers to Artists

Adobe Premiere Pro and other nonlinear editors like it have opened new opportunities. Anyone with a PC, even
a laptop, now can do broadcast-quality video editing. What was once reserved for high-end video production
studios and well-equipped TV stations, now has reached the mass market (at least those willing to spend $2,000
for software and a DV camcorder along with their PC).

But just as buying a hammer does not make you an expert house builder, installing Adobe Premiere Pro will not
make you a stellar editor.

Old-Fashioned Editing

To gain some perspective on the video editing process, a little history is in order. In the early days of TV,
engineers did the editing. They had to. They were trained to deal with unruly, bulky, and complex tape
machines. They had to monitor things such as color framing, sync timing, and blanking.

Here's how John Crossman, a long-time editor friend of mine, puts it (see "Expert Editing Tips" in Module 10,
“Advanced Editing Techniques and Workspace Tools”):

The logic was that the same people who pushed the "record" and "playback" buttons in the tape room should be
the ones to run the editing machines. Videotape editing then was considered a very technical job, not an artistic
job.

Eventually, microprocessors resolved and automated many of those technical issues, and non-engineering
people—folks with an eye for editing—started populating the editing bays.
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However, prohibitive costs limited access to those machines. As recently as a few years ago, whenever I created a
video that called for some special transitions, I worked "offline" (that is, I used copies of my original master tapes
on a lower-priced editing system to create an Edit Decision List). Figure 7.1 shows an example created in Adobe
Premiere 6.5.

Note: EDLs—On Their Way Out

Adobe Premiere Pro does not create EDLs. Adobe chose to migrate to an emerging cross-platform
technology called AAF—Advanced Authoring Format. It resolves two drawbacks to EDLs: They’re text-only,
and they have limited transition and effect options. According to the AAF Association
(http://www.aafassociation.org), “AAF is a multimedia file format that enables content creators to easily
exchange digital media and metadata across platforms, and between systems and applications. The AAF
simplifies project management, saves time, and preserves valuable metadata that was often lost when
transferring media between applications in the past.”

Figure 7.1: An Edit Decision List created by Adobe Premiere 6.5.

Then I took my original raw footage and that EDL data file, with all the transition commands built in, to an
expensive online facility that automatically (with some manual labor) cranked out a polished product. That
process, while more time-consuming than working online from start to finish, saved a ton of money.

Today the pendulum has swung to the opposite extreme, and you are riding that pendulum. Anyone can work
solely online (that is, use the original video footage from start to finish). No longer do video producers need to
rely on high-priced production houses. Heck, now you can do it at home. The purpose is to do it well, and that
starts with getting your assets arranged.
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Using a Storyboard Approach

I think the easiest way to take your first steps into nonlinear video editing is by using a storyboard. You’ve
probably seen how feature film directors sometimes use photos or call on artists to sketch out scenes to help
visualize story flow and camera angles. I've seen animated feature film storyboards that filled several conference
room walls.

Few video editors rely on the storyboard. It's more a bridge to editing than a true productivity tool. In previous
versions of Adobe Premiere, it was a separate feature. Adobe Premiere Pro’s developers chose to drop the
storyboard but changed the Project window to offer much of the old storyboard’s functionality.

You can display video clip thumbnails in the Project window—in storyboard fashion—to help structure the flow
of your production. This approach can come in handy by revealing gaps in your story—places that need fleshing
out with more video or graphics. It's also a way to note redundancy and to quickly place a whole bunch of
ordered clips on a sequence. But for most folks it serves solely as a one-time introduction to nonlinear editing.
Use it once and move on.

Task: Creating a Storyboard
The methodology is fairly simple, but there are some limitations. The first limitation is that switching to Icon view
in the Project window displays thumbnails of clips only from a single bin (folder). Because you have multiple
bins, this makes creating a storyboard a bit inconvenient. Here’s a workaround for that, as well as an explanation
of the rest of the storyboard creation process:

1. In the Project window, create a Storyboard bin by clicking the new Bin button and naming it
Storyboard.

2. The goal is to place copies of all the clips you intend to use in your storyboard in this newly created bin.
Open a bin with clips that you intend to use and select all the needed clips from that bin.

Note: Context-Clicking

Adobe Premiere Pro is rife with context-sensitive menus that are accessible by right-clicking on objects or
within windows. Feel free to right-click on scattered items in the Adobe Premiere Pro workspace. You’ll find
that clicking in the Monitor, Timeline and Effect Controls windows presents you with numerous options.
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3. As shown in Figure 7.2, right-click (context-click in
Adobe Premiere Pro parlance) on one of the selected
clips to bring up the context menu. Select Copy (that
will copy the entire collection of clips).

Figure 7.2: Open bins one at a time, select clips you want to place
in your storyboard, and use the right-click context menu to copy
them.

4. As shown in Figure 7.3, right-click on the Storyboard bin
and select Paste. Repeat this for all the clips you want to
place in your storyboard.

Note: Audio Re-conforming

The unfortunate side effect of all this copying is that Adobe
Premiere Pro will re-conform all the audio for these clips,
consuming extra hard drive space and tying up your
processor for a while.
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Figure 7.3: Highlight the Storyboard bin with a right mouse click
and then paste your clip copies there.

5. With your Storyboard bin loaded to the brim, expand
your Project window view as wide and tall as you can
and change the view to display clip thumbnails by
clicking the Icon button (circled in Figure 7.4) at the
bottom-left corner of the Project window.

6. This causes Adobe Premiere Pro to close any opened
bins and display bin icons only. Remedy that by double-
clicking the Storyboard bin to display all its clips. Your
Project window should look like Figure 7.4. If the
thumbnails don’t display, click the wing menu triangle
(in the upper right corner in Figure 7.4), and select
Thumbnails > Large, Medium or Small.

Note: No Word Wrap

Here’s another limitation to Adobe Premiere Pro’s
storyboard implementation. The old Adobe Premiere
storyboard used something like word wrap. If there were too
many thumbnails for the Project window screen size they’d
fill the screen width and then scroll down the window
(standard behavior for most windows). You could at least
see a group of consecutively placed thumbnails in the
window.

With Adobe Premiere Pro the thumbnails generally run past
the right side of the window, meaning you have to use the
slider on the bottom of the window to see consecutively
placed thumbnails. To gather them within the width of your
expanded Project window, open the wing menu (the little
triangle in the upper right corner) and select Clean Up.
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Figure 7.4: Expand your Project window and convert it to Icon (thumbnail) view by clicking the circled Icon button.
Use the Wing Menu and select Clean Up to remove any empty storyboard frames.

7. A clip’s thumbnail image—or poster frame—defaults to the first frame of video for that clip. You can set
a new thumbnail image by selecting the clip then playing it in the little Project window video monitor.
When you see a more representative image, click the camera button highlighted in Figure 7.5.
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Figure 7.5: If you choose to do so, you can change the thumbnail
poster frame image by using the small video screen and camera
button.

Arrange Your Storyboard

Now you can look over the storyboard and do two things:
rearrange and delete clips. Remember, you're just deleting clips
from the Storyboard bin. The original clip references remain in
their respective Project window bins.

To move a clip, simply drag it to a new location. A black, vertical
line indicates placement.

To use the same clip or portions of the same clip in more than
one location, right-click on that clip and select Duplicate. That
instantly adds a copy of that clip (adding the word Copy at the end of its file name) someplace in the Storyboard.
Track it down and place it where it suits you. I tell you how to trim it in the next task.

To remove a clip from the Storyboard, select it and press Delete (or right-click and select Cut). That leaves an
empty placeholder. You can remove such gaps later by opening the Project window wing menu (the triangle in
the upper-right corner) and selecting Clean Up.

Task: Trim Clips in the Source Monitor
It’s helpful to trim clips before moving them from the Storyboard to the sequence. Do that by double-clicking a
thumbnail to display it to the Source Monitor window and trim it there. Here’s how it’s done:

1. With your Storyboard still open, double-click a clip you'd like to slim down. The Monitor window pops
up (depending on your screen resolution, it may pop up on top of the Storyboard) with your clip's first
frame on display on the Source screen (another way to open a clip like this is to simply drag it from the
Storyboard to the Source Monitor window).

2. As shown in Figure 7.6, play the clip to where you’d like it to start. Use the Play button or scrub through
the clip using the Current Time Indicator (CTI). Mark that In-point by clicking the Set In-Point “{” bracket
(or pressing the “i” shortcut key). Do the same for the out-point. No need to be too exact. You can make
more precise edits when you work in the Timeline window.
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Figure 7.6: You can trim your storyboard clips in the Source Monitor window using the in- and out-markers.

3. Refer back to the Storyboard bin (Figure 7.5) and you’ll see that the clip duration displayed below the
clip thumbnail has changed to reflect the new in-point and out-point.

Feel free to trim down as many of your clips as you like (you always can adjust the in-point and out-point later in
the timeline).

Once you're satisfied that your clips are in the right sequence, that you've weeded out the redundancies and
trimmed the fat, it's time to send your project to the timeline for additional editing.

Task: Automate Your Storyboard to a Sequence
Now you're going to move your storyboard clips to the timeline—placing them contiguously, in sequential
order. Adobe Premiere Pro calls this “Automate to Sequence.” Here’s how you do that:
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1. Select the clips to place on a sequence. You probably want to select all clips. To do that, select Edit >
Select All. You can Ctrl+click to select scattered clips or drag a marquee over a group of contiguous
clips.

2. Click the Automate to Sequence button in the lower-left corner of the Project Window. I highlighted it
in Figure 7.7.

Figure 7.7: The Automate to Sequence button will place your storyboard clips on
the timeline.

3. In the newly opened Automate to Sequence dialog box, shown in Figure 7.8, you face several options:

Ordering—Sort Order puts clips on a sequence in the order you established in the Storyboard. Selection Order
places them in the order you selected them by Ctrl+clicking on individual clips.

Placement—Place your clips sequentially on the timeline as opposed to at unnumbered markers (something we
haven't covered anyway).

Method—The choices are Insert or Overlay. I discuss both concepts later this hour in the “Editing clips in a
sequence” section. Because you probably are placing the clips on an empty sequence, both methods do the
same thing.

Clip Overlap—Here's where I suggest that you deviate from the defaults. Overlap presumes that you’ll put a
transition such as a cross-dissolve between
all clips. The goal this hour is to create a cuts-
only video; that is, a video with no transitions
or special effects. Set Clip Overlap to zero.

Note: Keep Transitions in Check

I will mention, more than once in this
book, that transitions (and special
effects) are overused and distracting.
Fewer is better.

Apply Default Audio/Video
Transition—Because you will opt for no
transitions, uncheck these boxes.

Ignore Audio/Video—Because you want to
put both the audio and video portions of
your DV clips on a sequence, keep these
boxes unchecked.

Figure 7.8: Adjust settings in the Automate to
Sequence dialog box to complete the process.
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Tip: Checking the Destination Sequence

Before you click OK, check your Timeline window. Adobe Premiere Pro will place your clips on whatever
sequence is open, starting wherever you have placed the CTI in that sequence. If you have followed these
modules to a “T” then there should be one, empty sequence in the Timeline window. If not, cancel out of the
Automate to Sequence dialog box, select File > New > Sequence, and click OK in the New Sequence dialog
box. Now return to the Automate to Sequence dialog box, make the appropriate adjustments and go to step
4.

4. Click OK. This places your clips in order on the sequence in the Timeline window.

Taking a Timeline Window Tour

The Timeline window and its sequences are the heart and soul of Adobe Premiere Pro. Everything you do in
Adobe Premiere Pro relies on the timeline sequences. You do further editing of you clips here, add special
effects, place transitions between clips, and your output emanates from it.

The first thing you'll notice is your ordered clips residing on Video Track 1 with their audio (in this case, natural
sound) on Audio Track 1. It should look a lot like Figure 7.9. The name of each clip appears right after each edit
point.

Figure 7.9: The timeline, immediately after completing the Automate to Timeline process.
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Tip: Timeline Window Keyboard Shortcuts

Depending on the length of your project, you probably see only a few of the clips you automatically added
to the sequence. You can change the scale of the sequence to show more clips (or fewer—your choice).
Here are three keyboard shortcuts:

• “/” (backslash) will display your entire project within the width of the Timeline window.

• “-” (hyphen key—not the numeric keypad minus sign) incrementally increases the time displayed in
the timeline thereby showing more of your project assets. This is the same as the Zoom Out—small
mountain—button in the lower-left corner of the Timeline window).

• “=” (equals key) incrementally reduces the time displayed. The "+" is an uppercase "=" but you don't
need to use the Shift key for this shortcut. It’s the same as the Zoom In—double
mountain—button.

To take a look at your masterpiece in action, drag the CTI (circled in Figure 7.9) to the beginning and press the
spacebar (the keyboard shortcut for Play/Pause). Your cuts-only video will display in the Monitor window’s
program screen. You can stop it by pressing the spacebar again. You also can use the VCR button controls in the
program screen.

Tip: Scrubbing

You quickly can "scrub" through your project by clicking and dragging the CTI (or the edit line below it and
outside any clips.

Editing Clips in a Sequence

In a departure from standard Adobe Premiere Pro how-to instructions, I think the best way to learn about using
the timeline is to experiment with it a bit. When I first learned to use earlier versions of Adobe Premiere by
reading how-to books, their narrow, specific, step-by-step explanations
kept me from seeing the big picture. I think the way around that is for you
to take Adobe Premiere Pro's timeline for a test drive by doing a few
straightforward edits.

And don't worry. There's really no way you can mess up your storyboard
handiwork. Adobe Premiere Pro is fairly forgiving. If you do something
that looks wrong, you always can click Edit, Undo to fix it (or the standard
Windows shortcut: Ctrl+z). Do several things "wrong" and you can use the
History palette to move back as many steps as you like, even as far back
as to the original Automate to Sequence (refer to Figure 7.10).

Figure 7.10: If things get out of hand, use the History palette to back up any
number of steps, even all the way back to Automate to Sequence.
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One of the beauties of Adobe Premiere Pro is how easy it is to add clips anywhere in the project, move them
around, remove them altogether, or change their lengths. Here's how you do all that.

Changing a Clip's Length

Note that as you move your Selection tool (the default arrow cursor) across a clip, it changes shape to a left or
right red square bracket—either "[" or "]". This little tool, shown in Figure 7.11, lets you change the length of a
clip.

Figure 7.11: The Selection tool’s Trim mode makes it possible for you to change the length of a clip by moving the
beginning or end of a clip.

Move the bracket to the end of a clip directly before the edit point with the next clip. Notice that the bracket
faces left. If you click and drag it to the left you will trim the end of that clip. You can look for an appropriate trim
edit point by watching the Program Monitor screen. Release the mouse and your clip shrinks, leaving a gap
where the trimmed footage used to be. I explain how to get rid of that gap in a few minutes.

Note: Trimming Changes Audio, Too

As you trim your video, its associated audio gets trimmed as well. You can trim only the video or only the
audio portion of such a linked clip. I show you how in the next hour, “Applying Professional Edits and Adding
Transitions.”

To trim the beginning of a clip, do the same thing except make sure that the bracket faces right—into the clip.
Then drag it to the right and release when you reach an appropriate edit point.
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Tip: Snap to Edges

Adobe Premiere Pro has a tremendously useful attribute called "Snap to Edges." It's a default setting, and in
only a few instances will you want to deselect it. Snap to Edges means that as you drag a clip toward another
clip, it'll jump to the edge of the clip to make a clean, unbroken edit. With Snap to Edges turned off, you'd
have to slide the new clip very carefully next to the other clip to ensure there is no gap.

Snap to Edges is also useful when making precise edits. Using the Selection tool (in its trim mode) to trim a
clip is a bit inexact. You can make it frame specific. Locate the frame you want to edit to by dragging the CTI
through your sequence to that frame’s approximate location and then using the Step Forward/Back buttons
(keyboard shortcuts: right arrow key and left arrow key) in the Program Monitor window to move to the
specific frame. That places the CTI right at that frame on the clip in the timeline. Use the Selection tool and
drag the edge of the clip toward the CTI line. When it gets near it, it will "snap" to the CTI, and you'll have
made a frame-specific edit.

You can use this technique in all sorts of circumstances.

Removing a Clip

Select a clip by clicking it and pressing Delete. Gone. There's that gray gap again. We'll fix that later. If you want
your clip back, select Edit, Undo (Ctrl+Z).

Closing the Gaps—Ripple Delete

By now you might have left a few gaps in your production. Removing them and closing the gaps is a snap. As
shown in Figure 7.12, right-click a gap and click Ripple Delete (so named because its effect ripples through the
entire sequence). Ripple Delete removes the gap by sliding all the material after the gap to the left. Do this for all
the gaps, and your production will play back smoothly.

Figure 7.12: Ripple Delete slides
everything in a sequence, on all video
and audio tracks, to the left (earlier in
the production) to fill a gap.
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Save yourself a step by applying Ripple Delete to remove an entire clip. Right-click on a clip; that opens the
lengthy context-sensitive menu shown in Figure 7.13. I cover some of that menu’s commands later in these
modules. In this case-select Ripple Delete. Doing so removes the selected clip and slides everything else on the
sequence (video and audio clips) over to the left to fill the gap.

Figure 7.13: Right-click on a clip to open this extensive context-sensitive menu. In this case, use it to Ripple Delete the
clip.
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Using the Ripple Edit Tool

Another way to avoid creating those gaps is to use the Ripple Edit tool. It's one of the 11 tools in
the Tools palette. I've highlighted the Ripple Edit tool in Figure 7.14 (keyboard shortcut: “b”).

You use the Ripple Edit tool to change the length of a clip. It works much like the Selection tool
(its icon is a thicker Selection tool bracket). The basic difference between the Selection and Ripple
Edit tools is how the rest of the clips on a track behave once you change the length of a clip.

You know that when you use the Selection tool to shorten a clip by dragging in one end of that
clip, that action leaves a gap between two clips. To close that gap, you right-click on it and select
Ripple Delete.

If instead you use the Ripple Edit tool, there’s no need to do that final Ripple Delete step. When
you use the Ripple Edit tool to lengthen or shorten a clip, your action ripples through the
sequence. That is, all clips after that edit slide to the left to fill the gap or to slide to the right
accommodate a lengthened clip.

Figure 7.14: The Ripple Edit tool. Using it saves you the extra step of doing Ripple Deletes on gaps in
your timeline.

Position the Ripple Edit tool at the beginning or end of a clip you want to shorten and then click
and drag it accordingly. If the edit point abuts another clip, Adobe Premiere Pro shows adjacent

frames in the Monitor window as you are dragging. After you've found the point where you want to make your
edit, release the mouse button. The Ripple Edit tool shortens the clip and slides everything on every track (audio
and video) of the sequence over to the left to close the gap. I introduce the other Tools palette items later in this
hour, in the “Using Other Editing Tools” section.
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Lifting and Moving a Clip

There are two kinds of moves: Lift and Extract. Lift leaves a gap. Extract is the equivalent of what is usually
referred to as a Ripple Delete because other clips move over to fill the gap. Extract uses a keyboard modifier (see
next section). To lift and move a clip (both the video and its linked audio), click and drag the clip from one point
on the Video 1 track and drop it at the end of your clip collection. The behavior should match that shown in
Figure 7.15.

Figure 7.15: The Lift and Move behavior.



Adobe Digital Video Curriculum Guide – Module 7 7-17

Adobe Digital Video CURRICULUM GUIDE

Note: Overlaying a Clip

If you lift a clip and then place it on top of another clip or clips, the moved clip will cover those clips and its
audio will replace what was on the sequence before. That’s called an Overlay edit and I discuss that a bit
more later this hour in “Adding a Clip Inside a Sequence—Overlay or Insert.”

Using a Keyboard Modifier to Extract and Move

Extract introduces something new to Adobe Premiere Pro: keyboard modifiers. By holding down Ctrl or Alt+Ctrl
when adding, removing or moving a clip, you change how the rest of the clips on the sequence behave. At first it
might seem confusing, but the behavior is logical and predictable. You use the Alt key only for sequences with
clips on more than one set of tracks. I cover it in Module 19, “Compositing Part 2: Alpha Channels and Mattes.”
We’ll stick with using the Ctrl keyboard modifier in this hour.

Extract is the same as Ripple Delete. You remove a clip and all other clips slide to the left to fill the gap. In this
case, since you’re doing an Extract and Move, those sliding clips include the Extracted clip.
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Take a look at Figure 7.16 to see how this behavior plays out. You click on a clip and hold down the Ctrl key as
you Extract it from its place on the sequence. You now can release the Ctrl key and move it to the end of your
sequence. When you drop it there (release the mouse button), the moved clip and the clips ahead of it, slide to
fill its former position—an Extract and Move.

Figure 7.16: The Extract and Move behavior.

Note: Modifier Key Feedback

Note that as you drag a clip from the Project window to a sequence or from one place on a sequence track
to another, Adobe Premiere Pro displays a little text message at the bottom of the user interface. If you are
not using CTRL, it’ll say “Drop in Track to Overwrite. Use Ctrl to enable insert.” Press Ctrl and Adobe Premiere
Pro will let you know that you can use ALT to “limit the tracks that shift.”
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Adding a Clip Inside a Sequence—Overlay or Insert

No matter how carefully you selected clips for your storyboard, you probably will add clips to your sequence
later. Refer to Figure 7.17.

Figure 7.17: Overlay (no keyboard modifier) and Insert (using Ctrl modifier) Behaviors.

An Overlay (or Overwrite) does just what it says. Here’s how it works. Drag a clip from the Project window to the
sequence. As shown in Figure 7.18, the Monitor window Program screen changes into two images. The left side
is the new out-point of the clip that precedes your newly positioned clip. The right side is the in-point of the clip
that follows your newly placed clip (you don’t see an image of the clip you are positioning). As you slide the clip
left and right, those side-by-side images change accordingly.
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Figure 7.18: Use the Monitor window Program split-screen to locate the new in-point and out-point for the overlaid
clip.

If you want to position your new clip at an edit point or at the CTI edit line, Snap to Edges will take care of that
and give you a visual reference by popping up a thin, black, vertical line at those points as you move close to
them. When you’re satisfied with the new position, release the mouse button.

Note: Razoring Behavior

This Overlay (as well as Insert) behavior—positioning a clip anywhere within an existing clip or set of clips—is
called razoring. In one step ,you are making two razor slices, removing the stuff between the cuts, and
dropping a new clip in that gap. This is a new, very powerful, time-saving feature in Adobe Premiere Pro.

Take a look back at Figure 7.17 to see how an Insert edit behaves. In this case, it does not overwrite a clip or set of
clips; it razors a clip at the left edge of the new clip, slides everything to the right of that razor cut to the right and
drops the new clip on the sequence in that newly created gap. Nothing is covered up. All previously placed
video and audio remain on the sequence.

To perform an Insert edit, follow the same process as you did with an Overlay. But this time, hold down the Ctrl
key as you position the clip in the sequence. In this case, the Monitor window Program split-screen will show the
same image on both sides (unless you position the left edge of the new clip at an edit point). When you find an
edit point that suits you, release the mouse button. Voilà—an Insert edit.
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Using Other Editing Tools

The Tools palette has lost weight in Adobe Premiere Pro. Previous versions of Adobe Premiere packed 18 tools in
an even smaller space than the current Tools palette. Adobe Premiere Pro places only 11 on that vertical bar.
Table 7.1. shows a quick rundown.

Table 7.1:Tools Palette Tools

Icon Shortcut Tool Name Function Keyboard

Selection Multipurpose, all-around aide. v

Track Select Discussed later this module. m

Ripple Edit Already discussed. b

Rolling Edit See Module 10. n

Rate Stretch See Module 10. x

Razor tool Discussed later. c

Slide tool See Module 10. u

Slip tool See Module 10. y

Pen tool Discussed later this module. p

Hand tool Discussed later this module. h

Zoom tool Discussed later this module. z

Track Select

Not to be confused with the Selection tool, the Track Select tool enables you to select all clips to the left of
wherever you position it on a video or audio track. You can Shift-click to select other tracks. After they've been
selected, you can slide them, delete them, cut/paste them, or copy/paste them.

Edit Tools

I've already explained the Ripple Edit tool. I'll cover Rolling, Rate Stretch, Slide and Slip in Module 10, “Advanced
Editing Techniques and Workspace Tools.” The one you might experiment with now is the Rate Stretch tool.
Select it and then click and drag it on a clip to stretch or compress that clip and in the process slow it down or
speed it up.

Razor

Razor slices a clip or clips in two. It has multiple uses, and I'll cover them in several different modules.
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Pen

A very limited-use tool used to add, select, move, or delete keyframes on a sequence. I briefly explain it in
Module 15, “Sweetening Your Sound.”

Hand

A limited-use tool. Use the Hand tool to move an entire sequence by grabbing a clip and sliding it to one side. It
works the same as moving the scrollbar at the bottom of the Timeline window.

Zoom Tool

This works like the Zoom In and Zoom Out buttons in the lower left corner of the Timeline window and the
Zoom Bar at the top of the sequence above the Time Ruler. Default is Zoom In (the “+” cursor). Hold down Alt to
change that to Zoom Out (the “-” cursor). When you want to see a set of clips in greater detail, click and drag the
Zoom tool around those clips.
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Video editing has moved from an engineering function to art. NLEs have opened this art form to anyone with a
PC and a camcorder. An easy introduction to nonlinear editing is a storyboard. It enables you to visualize the
flow of your production as it moves from one video clip to the next.

Adobe Premiere Pro’s Project window storyboard implementation is not as elegant as the dedicated storyboards
in its predecessors, but it achieves the same results. You can use the Project window’s icon view to arrange clips
and then trim them in the Monitor window Source screen.

After you’ve automated the clips to a sequence, it’s easy to trim, delete, add, extract, and insert clips. Adobe
Premiere Pro’s new keyboard modifier—Ctrl, in the instances covered this hour—gives you more control
without the need to change tools or perform extra steps.

Q. The storyboard is fine as an introduction to nonlinear editing, but I want to skip it and work directly on
the timeline. How can I do this?

A. This is the approach you will probably end up taking as you gain experience working with Adobe Premiere
Pro. Instead of opening a new storyboard each time you start a new production, just drag clips from your Project
window and drop them on the timeline. Drop them all on the Video 1 track. You can select a number of clips at
once in the Project window and drag them all to the timeline. In that case, they'll appear in the same order they
appeared in the Project bin or in the order you selected them.

Q. Since Adobe Premiere Pro can have up to 99 video and audio tracks, why can’t I place video in some
other track besides Video 1?

A. You can place your clips on any track you want. And as you gain experience, you will do that for every project.
It’s just that placing clips on multiple tracks introduces a level of complexity that might be more than you want
to tackle at this stage. Feel free to experiment. The basic rule is that video clips on higher-numbered tracks cover
whatever is below them on a sequence, whereas audio tracks all play at once and mix together. Later in the
curriculum guide, I show you how to composite—or layer video—and how to mix multiple audio tracks.

Quiz

1. You set up the Project window to display thumbnails. But one thumbnail is black. Why? What can you do
about it?

2. You've created a storyboard, but several clips are obviously too long. How do you trim that excess baggage?

3. How do you trim a clip in the timeline without creating a gray gap?
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Quiz Answers

1. It's black because the first frame of that clip is black. The thumbnail defaults to the first frame. To change the
thumbnail image, select the clip, play it in the little Project Monitor window, and when you see an image
that represents the clip, click the little box in the lower-right corner. That sets a new thumbnail image. It
should show up right away in the Project Bin window.

2. Double-click each extra-long clip to open it in the Source Monitor. Play it or drag the CTI to where you want
the edited clip to start. Click the left in-point bracket ({). Then do the same for the out-point. Notice that your
clip's new time shows up in its storyboard thumbnail caption.

3. Use the Ripple Edit tool. You'll find it in the Tools palette. It's the third one down—a fat vertical line with
arrows sticking out both sides. Move it to the end of the clip you want to shorten. Drag it to the new edit
point and release. The clip will shrink and the rest of the project automatically will fill the gap.

Exercises

1. Take the right-click menu for a test drive (you've already used this technique to use Ripple Delete). Right-
click a clip in the timeline and check out the various options. Speed/Duration and Frame Hold are both
excellent editing tools that I'll cover later. Try them out on some clips.

2. Shoot and edit a sequence. Grab your camcorder and head out looking not for a subject but rather for a
sequence. For example, go to a public place such as a park and tape someone tossing a ball to his dog. Get
wide and tight shots and various angles (oh, and get permission). Then transfer that video and build a
sequence. This is a real test of editing skill because it involves editing techniques such as wide/tight and
matching shots.

3. Practice, practice, and practice all the various editing moves described in this hour. Trim, delete, overlay,
insert, lift, and extract. Use the Ctrl modifier key. Note that the Insert/Overlay icon changes as you press and
release the Ctrl key. The more you work with this new functionality, the more it will become second nature.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education
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Module 8

Adding Transitions

Applying transitions between clips—dissolves, page wipes, spinning screens, and many more—is a nice way to
ease viewers from one scene to the next or to grab their attention.

Adding transitions is a simple drag-and-drop process. Most offer additional options, and all let you fine-tune
their exact placement and duration. Editors new to Adobe® Premiere® Pro’s wealth of transition possibilities
might opt to overuse them. I strongly suggest restraint.

At the end of this lesson, students will be able to:

• Understand the value of using transitions with restraint

• Select and add transitions between clips

• Work with the Effect Controls A/B window

Using Transitions with Restraint

Watch some TV news stories. Most use cuts-only edits. If you see any transitions, I'd be surprised.

Why? Time is a factor. But more and more stations these days have ready access to nonlinear editors such as
Adobe Premiere Pro, and it takes almost no time to add a transition using an NLE.

The principal reason for the dearth of transitions is that they can be distracting. If a TV news editor uses one, it's
for a purpose. Typically they take what would have been a jarring edit—such as a major jump cut—and make it
more palatable.

An oft-heard newsroom phrase applies: "If you can't solve it, dissolve it."

On the other hand, consider the Star Wars movies. Remember all the highly stylized transitions? Obvious, slow
wipes for example. George Lucas knows what he's doing. Each of those transitions has a purpose. In general,
they are reminiscent of old serialized movie and TV shows. Specifically, they send a clear message to the
audience: “Pay attention. We're transitioning across space and time.”

Transitions can add whimsy. Here are a few examples:

• Start on a tight hand shot of someone cutting a deck of cards and make a Swap transition—one image
slides to one side and another slides over it—to another card-related shot.

• Start with a tight shot of a clock (analog, not digital) and use the aptly named Clock Wipe—a line
centered on the screen sweeps around to reveal another image—to move to another setting and time.

• Get that James Bond, through-the-bloody-eye effect using the Iris Round transition.

• Take a medium shot of a garage door and use a Push—one image moves off the top while another
replaces it from below—to transition to the next shot of the garage interior.
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• With some planning and experimentation, you can videotape someone pushing against a wall while
walking in place and use that same Push transition (after applying a horizontal direction to it) to have
that person "slide" the old scene off screen.

Transitions can work with your video to add visual interest:

• Take a shot of a car driving through the frame and use a wipe, synced with the speed of the car, to move
to the next scene.

• Transition from a shot of driving rain or a waterfall using the Slash Slide transition, in which streaks, like
driving rain, slice through an image revealing another image behind it.

• Use the aptly named Venetian Blinds transition as a great way to move from an interior to an exterior.

• A Page Peel transition works well with a piece of parchment.

The possibilities are truly endless. During this module, I'll encourage you to experiment with all that Adobe
Premiere Pro has to offer.

Trying Some Transitions

Adobe Premiere Pro ships with more than 70 transitions. Some are subtle, and some are “in your face.” The more
you experiment with them the more likely you are to use them well.

Applying a transition between two clips starts with a simple drag-and-drop. That might be enough for many
transitions, but Adobe Premiere Pro gives you a wide variety of options to fine-tune transitions. Most of that
work takes place in the Effect Controls window. Some transitions have a Custom button that opens a separate
dialog box with sets of options unique to each.

In the following tasks, I will start you off on simple transitions and gradually introduce you to the extra options
available.

Task: Prepare Your Workspace to Test Transitions
I want to keep things simple. In this task, you will work on a very basic sequence, with only two video clips. Once
you complete that setup, I will introduce you to the Effects palette. Here’s how:

1. Open Adobe Premiere to your current project.

2. Select Windows > Workspace > Effects to change the workspace to Effects. That makes it easier to work
with transitions.
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3. Open a new sequence by selecting File > New Sequence. That opens the New Sequence dialog shown
in Figure 8.1.

Figure 8.1: Use the New Sequence dialog box to open a very basic, one-track sequence.

4. Change the number of video tracks to 1 and click OK. That opens a second sequence in your Timeline
window.

Note: Transitions on Any Track

Adobe Premiere Pro lets you add transitions between two clips on any track in a sequence (previous
versions of Premiere restricted transitions to only the Video Track 1). This is a very useful improvement that
saves several awkward steps needed to accomplish the same thing. I limit you to a single track here to
simplify things and because transition behavior on Track 1 is the same as on any other track.

5. Open your Project window (if it’s closed or you can’t find it, select Window > Project). Select two short
clips, and by clicking on their icons, drag them one at a time to the newly created sequence (you can
select both using CTRL-click, then drag both to the sequence where they will appear sequentially). Press
the “\” backslash key to display both clips within the Timeline window. Your Timeline window should
look like Figure 8.2.
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Note: Head and Tail Handles Make for Smoother Transitions

Take a look at the junction of your two clips. Because you probably have not trimmed them, those clips are
their original full length. If that’s the case, small triangles, like those circled in Figure 8.2, will be in the top
right or left corners of any untrimmed edges of a clip. For transitions to work smoothly, you need
handles—some head and tail overlap between the clips. That is, trimmed video that will be used in the
transition (see Step 6 for a how-to). Head and tail room are not absolutely necessary. Adobe Premiere Pro
gives you several options to deal in the event you have no slop. I discuss this whole issue in “Manipulating
Transitions in the A/B Window.”

Figure 8.2: A basic sequence with only one video, one audio, and one master audio track plus two clips. Note that the
little triangles mean there are no handles available to do a smooth transition.

6. You need to make sure your clips have sufficient handles—or head and tail room overlap (see previous
Note). Use the Ripple Edit tool (third icon from the top in the Tools palette) to drag the right edge of the
first clip to the left to shorten it (to give it tail room handles—at least a second) and drag the left edge of
the second clip to the right to give it some head room
handles. By using the Ripple Edit tool, these two trims
should leave no gap. If there is a gap, right-click on it and
select Ripple Delete.

7. In the Effects palette (if you changed to the Effects
workspace, it should already be open), click the Video
Transitions tab. Note that the transitions are organized
into 10 folders or bins. Click the triangle next to the
Dissolve folder to open it, and, as shown in Figure 8.3,
note that Cross Dissolve has a red box around it. That
means it’s the default transition. Drag Cross Dissolve to
the edit between your two clips on the sequence.

Figure 8.3: Opening the Video Transitions folder and all its sub-
folders will reveal more than 70 transitions. Note that Cross
Dissolve has a red box around it signifying it’s the user-set default
transition.
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 Tip: Changing the Default Transition

There are two primary uses for the default transition: when automating a storyboard to a sequence or as a
quick means to add a transition using the keyboard shortcut—Ctrl+D. As you gain experience with
transitions, you might want to set a different default transition. To do that: Select the transition you want to
use, click the Effects palette’s wing-menu triangle, and select Set Default Transition. A red box will now
appear around that transition. If you select Default Transition Duration from the wing menu, you open the
General Preferences dialog box where you can change that video and audio setting.

A Plethora of Transitions

Where to begin? The many choices can be a bit mind-boggling. To bring some order to this chaos, I'll take you
through several transitions, each of which offers some additional options.

Task: Testing Transitions
You’ll start with the Cross Dissolve transition, and then move on to Page Peel, Wipe, Iris Round, and Pinwheel.
Here’s how you add transitions and adjust their characteristics:

1. Click on the Cross Dissolve icon and drag it to the junction between your two clips. That junction should
look like Figure 8.4.

Figure 8.4: Dragging a transition to the video track on your sequence adds a little purple box with a diagonal line
running through it.

Note: Transition Placement Counts

If you drag the transition slightly to the right or left of that junction, Adobe Premiere Pro will display little
icons showing that your transition will either end or begin at the junction. You can make that placement
later in the Effect Controls window, so it’s not critical at this point. For now, center the transition right on the
cut point between the two clips.
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Note: Sequence Display Changes

Two things about how your sequence should look:

• A short red, horizontal line will appear above any new transition. That red line means that this
portion of the sequence must be rendered before you can record it back to tape or create a file of
your finished project. Rendering happens automatically when you export your project, but you can
choose to render selected portions of your sequence to make those sections display more smoothly
on slower PCs.

• If your Video or Audio tracks are taller than those in Figure 8.4, the little purple transition marker
might be too small to select with your Selection Tool. Switch your video track to its shortest setting
by clicking the little triangle to the left of “Video 1.” That should flip the triangle so it points to the
right, reduce the height of the track display, and more prominently display the transition in the
video track. You also might have to zoom in on your sequence to expand the width of the transition
to enable you to select it.

2. Click on the transition marker in the sequence to select it. That displays the transition settings in the
Effect Controls window (ECW). Your ECW should look like Figure 8.5. I have expanded the Monitor
window to make adjusting transitions settings go more smoothly. You should do the same.

Figure 8.5: Make adjustments to the transitions settings in the Effect Controls window.
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Note: Open the ECW’s Timeline Display

If the Timeline section of the ECW is hidden, click the Show/Hide button annotated in Figure 8.5.

3. There are several ways to preview your transition. The most effective is to view it in real-time in the
Program monitor screen. In the ECW, click on the timeline ruler just ahead of the transition (I’ve circled
that spot in Figure 8.5) to move the Current Time Indicator (CTI) to that point. Then press the space bar
to do a real-time preview. You will see the first clip dissolve—or fade—into the second clip. Neat.

Note: Other Preview Methods

Try two other preview methods: First, click the small triangle in the upper left corner of the ECW. That plays a
representation of transition using the A & B color boxes. Second, drag the slider below the large "A"
rectangle. To view those transitions using your actual video clips, click the Show Actual Sources box.

Note: Leaving that slider in that new position will cause your dissolve to start at that point in the dissolve
process. So, for now, slide it back.

Tip: Dissolve Up from—or Down to—Black

To ease in or out of a video, most producers dissolve—or fade—up from or down to black. You can do either
using an effect newly added to Premiere Pro 1.5: Dip to Black (it’s in the Dissolve folder). Drag Dip to Black to
the beginning of a clip to fade up from black or place it at the end of a clip to fade down to black. The
default fade time is one second (30 frames). Placing it on the edit point between two clips will fade to black
and immediately fade back up to the next clip. This too has a one second default duration. I show you how
to adjust the length of the duration —making it more dramatic or more abrupt— in the next task,
“Manipulating Transitions in the A/B Window.”

4. Change the transition to Page Peel by opening the Page Peel folder, clicking on the Page Peel transition
icon, and dragging it to the Cross Dissolve transition in the sequence. Doing so automatically replaces
the Cross Dissolve with the Page Peel. Click on that transition (the purple marker with the diagonal line)
to open the Page Peel transition in the ECW.

5. Page Peel offers additional options. In this case, as shown in Figure 8.6, you can change the direction of
the Page Peel by clicking the triangles around the preview screen. Click the little Play button to see the
changed transition behavior. Click Reverse to change from a Page Peel that reveals the second clip to a
Page Peel that covers the first clip. You will see both motion direction triangles and the Reverse option
in many transitions.
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Figure 8.6: Clicking the triangles around the preview screen changes the Page Peel direction. Clicking Reverse,
changes the transition from a peel away to a peel onto.

6. Change to the Wipe transition by locating it in the Effects palette’s Video Transition Wipe folder and
dragging it to the Page Peel transition in the sequence. Click on the purple marker to select it and
display it in the ECW.

7. As shown in Figure 8.7, Wipe offers four more directions (eight in all) for the transition movement plus a
new feature: a border and anti-aliasing (see sidebar: “Clean Up the Jaggies with Anti-aliasing”).
Experiment with the border width and give it a color by either clicking the rectangular Border Color
swatch and selecting a color from the standard Windows Color Picker shown in Figure 8.8 or by clicking
and dragging the eyedropper tool to the Monitor window Program screen. As you roll the Eyedropper
tool over the images, it picks up a color from the scene and displays it in the color swatch. Releasing the
mouse button grabs the current color. Selecting a color this way keeps the border color from clashing
with the images.
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8. Click on the transition marker in the sequence to select it. That displays the transition settings in the
Effect Controls window (ECW). Your ECW should look like Figure 8.5. I have expanded the Monitor
window to make adjusting transitions settings go more smoothly. You should do the same.

Figure 8.7: Wipe offers more movement directions plus a border.

Tip: Easy Search Tool

If you know the name of a transition but forget its folder, simply start typing its name in the Effects palette’s
Contains window. As you type, all transitions and effects with those starting letters will display in the Effects
palette. The more letters you type, the more that narrows your search. That the transitions and effects
appear in real time as you type (as opposed to after you press Enter) is a labor-saving feature.
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Figure 8.8: Use the Color Picker (shown here) to select a color for the border or use the Eyedropper tool to select a
color from the Monitor window Program screen. Make sure they are NTSC safe by avoiding oversaturated colors (those
that cause the caution sign to pop on screen).

Sidebar: Clean Up the Jaggies with Anti-aliasing

Every transition that offers a border option also has an anti-aliasing option. Aliasing is the jagged edge
common along sharply defined diagonal lines in computer graphics and TV sets. If you look closely enough
at a diagonal line, even in your PC monitor (which has a higher resolution than your TV set), you'll see stair
steps. That's aliasing.

To get rid of aliasing, you select, ahem, Anti-Aliasing. Adobe Premiere Pro's default setting is to disable anti-
aliasing. I don't get this. Aliasing looks bad, so the default should be anti-aliasing. Nevertheless, on an effect
such as a vertical or horizontal wipe, there should be no noticeable aliasing, whether or not you've opted for
anti-aliasing. But if you click one of those little white triangles in the corners of the little ECW preview
monitor and switch to a diagonal wipe, you'll probably want to turn on anti-aliasing.

You do that by clicking the little Anti-aliasing Quality triangle and, as shown in Figure 8.7, selecting Low,
Medium or High. You get immediate feedback in the Monitor window Program monitor. The diagonal
border edges get increasingly softer as you ratchet up anti-aliasing.
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Caution: Stay “Safe”

If you click around the Color Picker long enough, you'll eventually select a color that prompts Adobe
Premiere Pro to pop up a little yield/exclamation mark sign (see Figure 8.8). That’s because you've selected a
non-NTSC-Safe color that will not display well on a standard TV set (it'll work fine on your PC monitor,
though). For instance, selecting a highly saturated color value of 250 or more for the Red, Green, or Blue (the
R, G, or B numbers) color components, with a very low number for one of the other two colors, will create an
over-saturated color that will smear on an NTSC monitor. You can fix that by clicking on the Yield sign a few
times until Adobe Premiere Pro finds a similar, but NTSC-Safe, color. You can click around the Color Picker to
find a Safe color or type in a lower number (249 or less should work) in the offending color's box.

8. Change to the Iris Round transition. You’ll find it in the Iris folder. You know the drill by now; just
remember to click on the transition in the sequence for it to show up in the ECW.

9. What sets Iris Round and several other similar transitions apart (see next note) is the option to set, in this
case, a starting or ending location or both. As shown in Figure 8.9, simply drag the start location icon in
the Start window (circled in Figure 8.9) to a place that suits the scene. You might start the Iris Round
transition on a circular object in the scene, for instance.

Figure 8.9: Some transitions enable you to set the specific start-point or end-point for extra dramatic effect.
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Note: Similar Transitions

Other transitions that allow a custom starting or ending point are 3D Motion Tumble Away, Iris Cross, Iris
Diamond, Iris Square, Zoom, Zoom Cross, and Zoom Trails.

 Tip: Go in Reverse

Try Reverse on Iris Round (and on any other transitions if you like). Instead of starting as a small dot and
growing to reveal the next clip, selecting Reverse means the circle starts large and shrinks to that spot. So by
using Reverse, Iris Round actually has a start or an end point—it’s your choice.

10. Change to the Pinwheel transition (it’s in the Wipe folder), and check it out in the ECW.

11. Pinwheel, as well as about a dozen other Adobe Premiere Pro transitions, has a Custom button. Click it.
In this case, your only option is the Number of wedges. Type in a number (32 is the maximum allowed in
this case), and, as shown in Figure 8.10, if the CTI is somewhere within the transition, you will get real-
time feedback on how your number selection looks.

Figure 8.10: The Pinwheel transition and about a dozen other Adobe Premiere Pro transitions offer special custom
settings unique to each of those transitions.
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12. Save your project; I want to keep this setup available for use in the next section, “Manipulating
Transitions in the A/B Window.”

13. Try out some other transitions with Custom settings: Venetian Blinds, Random Blocks, Slash Slide, Iris
Shapes, Band Slide, and Swirl.

Tip: Fiddle with Flip Over

Give the Flip Over transition a test drive. It’s in the 3D Motion folder, a collection of transitions that use
perspective to give your transitions greater depth. The Flip Over transition takes the A clip and spins it like a
flat board horizontally or vertically and then reveals the B clip on the "board's" other side. That flipping
motion briefly leaves an empty space behind the board. You can change the color of that space and split the
"board" into as many as eight slats by opening the Custom dialog box.

I have touched on most of the primary types of transitions but have purposely skipped two. They are specialized
transitions that require a little more editing experience to tackle, so I'm saving them for Module 10, "Advanced
Editing Techniques and Workspace Tools," which is a catchall for other editing techniques. There, I'll go over the
Image Mask and Gradient Mask transitions.

Manipulating Transitions in the A/B Window

Because Adobe Premiere Pro’s developers created this product from the ground up, they had the opportunity to
make some fundamental decisions. One was to no longer include A/B editing in the Timeline window (there is
still an A/B style interface in the Effect Controls window).

A/B editing is old-school, film-style editing. Film editors frequently use two reels of film—an A-roll and a B-roll,
usually duplicates made from the same original. The two-reel approach permits nice, easy-on-the-eyes cross-
dissolves, gradually fading down the images from one reel while fading up the other (see sidebar: “Still
‘Grabbing B-Roll’ After All These Years”).

There was one advantage to having A/B editing in older versions of Adobe Premiere. You could more easily
modify certain transition characteristics—the exact location where the transition began on one clip and ended
on the other, the length of the transition, and its mid-point—more intuitively in an A/B mode interface layout.

Well, here’s the good news for both A/B and single-track editing camps: Premiere Pro includes all of that
functionality in its Effect Controls Window. I take you through its paces after the following notes in “Using the
A/B Mode to Fine-tune a Transition.”
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Note: To A/B or Not to A/B

In my book on the previous version of Premiere, “SAMS Teach Yourself Adobe Premiere 6.5 in 24 Hours,” I
recommended that readers simply ignore the A/B mode. In my view, in this NLE era, it’s counter-intuitive.

But there are some editors who swear by it, including some Adobe Premiere Pro beta testers. Removing A/B
editing was the single most discussed (to the point of derisive name-calling) decision in the beta group.

To Adobe’s credit, it stayed the course. Not only because A/B editing is archaic, but, more importantly,
because removing A/B editing meant Adobe could design Adobe Premiere Pro to allow transitions on any
track.

This is such an improvement over previous versions of Adobe Premiere that even the naysayers should
recognize that its benefits far outweigh any lost functionality.

Sidebar: Still "Grabbing B-Roll" After All These Years

In the TV news business—back when everyone used film and didn't have time to make duplicate reels—the
A-roll typically was the interview and the B-roll was everything else. They relied on two reels because the
audio and images were not synced in the same place on the film. Older film projectors use a sound track
that is 20–26 frames (about a second) ahead of the associated images because the sound pickup in the
projector is not in the lens. If you've ever threaded a film projector, you know how important it is to get just
the right size loops to ensure the sound syncs to the images.

So in the old TV news film era, to get a sound bite to play audio at the right time, that clip had to play
"behind" the B-roll for about a second to allow enough time for the sound to reach the audio pickup device.
Only then would a director cut to the A-roll image to play the interview segment and then would cut back to
the B-roll once the sound bite ended. Despite this now-outmoded means of editing or playing back news
stories, news photographers still say they're going to go "grab some B-roll."

When stations began switching to ENG (electronic news gathering) video gear, there was no longer a need
to use A/B-rolls. Audio and video were on the same place on videotape, but the only way to do those
smooth cross-dissolves was to make a copy of the original videotape (leading to some quality loss), run it on
a second VCR, and make the cross-dissolve with an electronic "switcher." That was a time-consuming and
cumbersome process fraught with timing problems. Older VCRs frequently were not "frame-accurate”, and
you ended up with spasmodic-looking dissolves.

DV and NLEs change that. No more dubbing, no more generation loss, no more timing problems, and no
more need to edit using ancient A/B-roll methods.

Using the A/B Mode to Fine-tune a Transition

Basically, A/B editing splits a single video track into two sub-tracks. What would normally be two consecutive
and contiguous clips on a single track now display as individual clips on separate sub-tracks, giving you the
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option to apply a transition between them and to manipulate their head and tail frames—or handles—and
other transition elements.

Task: Working With the ECW’s A/B Feature
This is yet another very clever, useful, and powerful new feature in Adobe Premiere Pro. Once you get a sense for
its functionality, I think you will see what an excellent little tool it is. Here’s how it works:

1. If Adobe Premiere Pro is open to where you left off (with the Pinwheel transition loaded), that will work
fine. If not, select File > Open Recent Project and select the project you saved in the previous task. You
can use any transition for this task.

2. Take a look at Figure 8.11. Take note of a few things:

Figure 8.11: The elements of the A/B transition mode.

• The light green color on each clip is the portion of that clip that will display during playback.

• The darker green portion is the extra head or tail handles or frames you have available if you want to
lengthen the transition duration. Clip A (the first clip in the two-clip sequence) has tail handles. Clip B
has head handles.

• The thin white line is the Edit Point where you butted the two clips together. Its default position is
centered in the transition. You can move that edit (keeping the transition centered over it), and you
can move the transition off-center without adjusting the Edit Point.

• The purple rectangle is the transition. The box width shows its relative duration. A display to the left
of the Timeline Display notes the actual duration time.

• You can move the CTI within the purple transition box to display how the transition will look at any
point.
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3. There are two ways to lengthen the transition: First, position your cursor over either end of that purple
box, and it will change to a Trim tool. Just as you would with a clip, drag the end to lengthen or shorten
it. Second, change the duration time by typing in a new time or clicking on the time display and
dragging your mouse left or right to change the duration.

4. To change the position of the Transition relative to the edit point, simply move the cursor over the
transition box until it changes into the Slide Transition icon shown in Figure 8.12 and then drag left or
right. You might notice that if you move the Transition, the Alignment display (to the left of the Timeline
display window) changes from the default Center at Cut to Custom Start.

Note: Other Transition Locations

Instead of dragging the Transition to position it at the exact beginning or end of the original cut edit
(aligning it with the edit point), use the Alignment drop-down list. Click the triangle and select Start at Cut or
End at Cut. If you’ve moved the transition at all, the alignment will be called Custom Start.

Figure 8.12: Move the transition relative to
the edit point by simply positioning the
cursor over it until it changes into the Slide
Transition tool, and then dragging it left or
right.
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5. You can change the Edit Point by positioning the
cursor over that thin white line (as shown in
Figure 8.13, the cursor turns into a Rolling Edit
tool) and dragging it right or left. In essence, you
are changing the out- and in-points of the
adjacent clips without changing the overall
length of the two clips taken together. A split-
screen display in the Program monitor (see Figure
8.14) shows you the new out- and in-points as
you drag the Rolling Edit tool.

Figure 8.13: Drag the Edit Point between the two clips (the
Rolling Edit tool appears there automatically) to change its
location.

Figure 8.14: A split-screen view
pops on automatically to show
you the new in-point and out-
point as you move the centerline.

Dealing With Inadequate (or no) Head or Tail Handles

Eventually you will want to place transitions at edit points where you don’t have adequate head or tail handles.
This might be because you paused the camcorder too soon or didn’t get it started fast enough. You might want
to add a transition to ease what would be an abrupt cut edit. Adobe Premiere Pro deals with that elegantly.

Task: Working Without Handles
What you’ll do here, to show how this can work, is un-trim a clip. Drag its in- or out-point as far as it will go, butt a
trimmed clip up to that point, then apply a transition. Then you’ll see how Adobe Premiere Pro deals with that
differently than two clips with adequate head and tail room. Here’s how it works:

1. On your sequence, grab the B-clip (the second clip) and drag it to the right—far enough to let you un-
trim the A-clip.

2. Drag the A-clip’s out-point as far as it will go. If you de-select it by clicking outside that clip, you will see
it has those little triangles I discussed earlier this module, showing that there are no frames left to use as
handles. Now slide clip B back to the right edge of clip A. Your sequence should look like Figure 8.15.
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Figure 8.15: The little triangles
indicate Clip A has no tail handles.
Clip B has no triangles and,
therefore, does have head handles.

Note: No Head Handles—Start at Cut Placement

If instead your B-clip had no head handles and the A-clip had enough handles, Adobe Premiere Pro would
have forced placement of the transition starting at the edit point—a so-called Start at Cut transition.

3. Drag a transition to that edit point (I recommend Wipe since it’s easy to see the freeze frames Adobe
Premiere Pro is about to make to ensure this transition works). You’ll notice that you cannot center the
transition on the edit point. Adobe Premiere Pro forces you to locate it completely to the left of the edit
point because the A-clip has no extra tail handles to make the transition. Adobe Premiere Pro also
displays a transition icon that represents a transition that ends at the clip junction. Select the transition
so that it shows up in the ECW (refer to Figure 8.16). You’ll see that the ECW already has identified this as
an End at Cut transition.
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Figure 8.16: Adobe Premiere Pro automatically creates an End at Cut transition for a clip that has no tail handles (I
added a border to better display the transition).

4. Drag the CTI to see that the transition works smoothly. It starts sooner than it would have if you had two
clips with enough tail and head handles, but viewers probably will not notice the subtle shift.
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5. You can extend the transition farther into the B-clip. Drag the
transition’s right edge or the entire transition to the right. As shown
in Figure 8.17, parallel diagonal lines appear. These signify that
Adobe Premiere Pro has created freeze frames of the last frame of
the A-clip, to make the transition.

Figure 8.17: If you extend a transition from Clip A (with no tail handles) into Clip
B, Adobe Premiere Pro adds freeze frames to the transition.

6. Drag the CTI and note that once it passes the edit point, Clip A
becomes a still image. Because most transitions happen quickly and
most viewers’ attention will be on Clip B, they might not even notice
that Clip A has become a still image. It works similarly if Clip A has tail
handles and Clip B does not.

7. Finally, extend both of your clips to their original untrimmed state and butt them together. Now,
neither has any tail or head handles. Apply a transition to them and, as shown in Figure 8.18, you get an
information message that there is “insufficient media” and parallel diagonal lines appear in the purple
transition rectangle.
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Figure 8.18: Applying a transition to two clips with no tail or head room leads to this informational message.

8. Take a look at this transition in the ECW. Slowly drag the CTI to see how it works. Clip A plays fine until
the edit point (halfway through the transition) and then changes to a still image. Meanwhile, clip B
starts as a freeze frame but goes into motion at the moment Clip A becomes a freeze frame.



Adobe Digital Video Curriculum Guide – Module 8 8-22

Adobe Digital Video CURRICULUM GUIDE

Using Transitions on Your Clips

Now is the time to experiment. Look for clips that lend themselves to specific transitions. Try out a variety. Then
after you've had some fun, be sure to use transitions judiciously. Restraint is a good thing when it comes to
transitions.

To give you an overview of virtually all the transitions Adobe Premiere has to offer, take a look at the next few
pages of transitions. I have grouped them in Figure 8.19 by their respective file folders (bins).
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Figure 8.19: Virtually every transition available in Adobe Premiere Pro.
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Transitions can make a video move more smoothly or snap the audience to attention. Some can be whimsical,
others draw attention to a portion of the scene, and still others create a frantic mood. Fun stuff, but use restraint.

Applying transitions takes not much more than a simple drag and drop. You can add things such as colored
borders, change directions, and start and end locations. Plus some have custom options unique to those
individual transitions. The Effect Controls Window’s A/B timeline display makes it easy to move transitions
relative to the edit point, change the transition duration, and apply transitions to clips that don’t have sufficient
head or tail handles.

Q. All the transitions I add last for only one second. I want all of them to last longer. I know I can change
them one-at-a-time, but is there an easier way to do this?

A. Two ways to do that: One, select Edit > Preferences > General and change the Video Transition Duration from
the default 30 frames (one second) to whatever length you want. Two, with the Effects palette tab open, click the
wing menu, select Default Transition Duration. That, too, opens the General Preferences dialog box.

Q. Finding Transitions by name is cumbersome. I remember seeing some with descriptive names, but
searching through all of the Video Transition folders is tedious. Is there a better way?

A. You bet. Simply start typing in the Contains field. As you type, Adobe Premiere Pro will display all effects and
transitions (audio and video) that have that letter combination. The more you type, the shorter that list becomes.

Quiz

1. You apply a transition to a clip, but it’s not what you’re looking for. So, you want to replace that transition.
How do you do that?

2. You have a clip with no tail handles, and you want to use every frame. However, the next clip looks very
similar, so to avoid a jump cut you need a transition. How do you do that?

3. The Iris Square transition starts as a square somewhere on clip A with clip B inside the square. It then
expands to fill the screen to reveal the next clip. You want it to start as a full-screen square and shrink,
revealing the Clip B behind it. How do you do that?
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Quiz Answers

1. Drag and drop the replacement transition on top of the rejected transition. The new one automatically
replaces the old one.

2. Just apply the transition as you would normally. Adobe Premiere Pro will automatically end the transition at
the edit point. You can slide that transition to the right, ensuring that special video snippet gets its full due.
If you move the out-point of the transition, Adobe Premiere Pro will add freeze frames of Clip A’s last frame
to use as tail handles.

3. Simple. Check the Reverse box. That switches the movement from starting small and ending full screen to
starting full screen and ending small.

Exercises

1. Scan your video collection for clips that lend themselves to transitions. Those could be cars or other things
moving horizontally or vertically through the screen, rain splattering in a puddle, curtains, playing cards,
clock faces (analog clocks that is), or kids’ alphabet blocks. Try some transitions on them, and see what
works and what does not work.

2. The Effects Palette enables you to create a personalized collection of favorites. Do that by clicking the Effect
palette’s wing menu and selecting New Custom Bin. That creates a folder called Favorites 1. You can change
its name by clicking on it twice and typing in a new name. Then you can drag and drop individual transitions
or entire folders. All the original transitions remain in their original folders, but your Favorites folder makes
the ones you use more accessible.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education

Adobe, the Adobe logo, Adobe Premiere, Adobe Audition, Adobe Encore, Acrobat, After Effects, GoLive, Illustrator, InDesign, Photoshop, and

Tools for the New Work are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other

countries. All other trademarks are the property of their respective owners.

© 2004 Adobe Systems Incorporated. All rights reserved.
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Module 9

Creating Text: Using the Title Designer

Onscreen text helps tell your story. Using a location super (superimposed text) sets the scene and saves the
narration for other relevant points. Displaying an interviewee's name and title at the bottom of the screen
reminds viewers who this person is. Using onscreen bulleted points reinforces the message your students are
trying to get across, or gives your students’ productions a title screen or rolling credits at the end.

Adobe® Premiere® Pro's Title Designer is such a full-featured product that you might never fully tap its potential.
With the Title Designer, you can create simple text, rolling credits, and colorful shapes. You can use any font
stored on your PC, and your text can be any color (or multiple colors), any degree of transparency, and darned
near any shape. Using the Path tool, you can place your text on the most convoluted curved line you can
imagine. The Title Designer is an engaging and powerful tool. Anything you create in the Title Designer, you can
save as a clip and use in any project.

At the end of this lesson, students will have learned about:

• Using supers to tell their stories

• Using a template to examine properties

• Creating text

• Adding motion and putting their text on a path

• Creating geometric objects

Using Supers to Help Tell Your Story

Consider this opening sequence: A telephoto shot of scorched desert sand with rippling heat distorting the
scene. Desiccated, lifeless sagebrush. A lizard slowly seeking shade beneath a small stone. And a small plume of
dust in the distance. Attention-getting stuff.

Now a narrator intones, "The summer heat beats down on the Bonneville Salt Flats." Effective. But what might
work better is a super (onscreen text)—something such as Bonneville Salt Flats. Then, as the plume of dust
moves toward the camera, add another super: Speed Trials—Summer 2003. Then a rocket-shaped vehicle
screams through the scene.

Rather than interrupt the mounting suspense with a dulcet-toned narrator, save him for later. Instead, simply
slap on a couple supers to set up your story.

Here are a couple other sample instances in which text can be an effective alternative to voice-overs:

• Instead of using a voice-over to say, "John Jones, president of the XYZ Association for the Preservation
of Salient Sayings," put that information in a super at the bottom of the screen.
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• Instead of simply saying a collection of statistics, such as 12 drummers drumming, 11 pipers piping, 10
lords a-leaping, and so on, use a collection of bulleted points that you pop onscreen with each new
numbered item. If you have small graphic images of each element, you can add them along with the
text.

Text strengthens your project.

Using a Template to Examine Properties

Open Adobe Premiere Pro to your workspace and locate the Title Designer. It's not where you might
expect—under the Windows drop-down menu along with Audio Mixer, Navigator, History, and the like. Instead,
it's in the File menu.

Select File > New > Title (or use the keyboard shortcut: the F9 key). Doing so pops up the Title Designer. The
default opening view displays whatever video frame is under the CTI. For now, turn that display off by
unchecking Show Video at the top of the Title Designer window (see Figure 9.1).

FIGURE 9.1: Adobe Premiere Pro's Title Designer with the Templates button and the Show Video checkbox
highlighted.

The background now consists of a grayscale checkerboard. That signifies a transparency. That is, if you place text
created in this window on a sequence video track above other video, that video will display wherever you see
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that checkerboard. As you create text or geometric objects, you can give them some transparency. In that case,
you’ll see the checkerboard through an object, which means the video will show through but it’ll appear as if it’s
covered with smoked or tinted glass.

I’m going to take a different and, I think, more intuitive approach to explaining this Adobe Premiere Pro
functionality. Instead of having your first tasks be to build text from scratch, you’ll start by dissecting a finished
product. In that way, you’ll get a practical view of a number of title creation methods.

You’ll work with some of Adobe Premiere Pro’s built-in title templates. These are tremendously useful. Simply
open one in the Title Designer and replace the placeholder text with your own copy, change a color to suit your
project, or change a shape to suit your style. You can select “lower-“ or “upper-third” templates and use them to
identify an interviewee or a location. Select a matte to frame part of a scene. Or use a bulleted list template to
add such a list to your project.

Task: Dissecting a Template’s Text
In this task, my expectation is that you'll do lots of experimenting. I’m going to ask you to click on just about
every title option and change just about every title characteristic. The purpose is to give you an idea of the
breadth and power of the
Adobe Title Designer. Here we
go:

1. Open the Templates
dialog box by clicking
the Templates button
highlighted in Figure
9.1.

2. As shown in Figure
9.2, open as many
template folders and
click through as many
templates as you like.
When you’ve seen
enough, open the
Lower Thirds folder,
select lower third
1024_7, and click
Apply.

FIGURE 9.2: Use a template to
see how to create titles.
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Note: Why This Template?

I chose this particular template because it has a number of features, including four-color gradient,
transparency, sheen, and outer strokes. I explain these in the upcoming steps.

3. Back in the Title Designer, click the Selection tool (the keyboard shortcut is V) and then hover it over the
template. As you move it around, bounding boxes will appear, delineating the three elements of this
title. Grab each box in turn and drag each element up the screen so you can see the template’s
components. Your screen should look like Figure 9.3.

FIGURE 9.3: Breaking a template into its constituent parts clarifies the title creation process.
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4. Select Title One to display its bounding box with its eight
sizing handles. That opens up its Properties listing in the
Object Style window on the right side of the Title Designer
window (refer to Figure 9.4). Note the various Properties
elements, including Font, Font Size, Slant, and Underline.

FIGURE 9.4: Selecting the template’s Title One text opens its Properties
listing.

5. Click on the Font drop-down list. Overwhelming, isn’t it?
Click on More to view additional font names, then click on
More in that newly opened column of font names to display
the next alphabetical grouping and so on.

6. To get a different picture of what’s available, select Browse
from the top of that long list to open the dialog box shown
in Figure 9.5. You can drag its top and bottom to see more
fonts at once and select a new one if you want.

FIGURE 9.5: Use the Font Browser to get a clearer
picture of what will work well with your project.



Adobe Digital Video Curriculum Guide – Module 9 9-6

Adobe Digital Video CURRICULUM GUIDE

7. Check the Small Caps and Underline checkboxes to see how they work. Then select the numeric
properties in turn and drag your cursor left and right to change their values, noting the effect on the
Title One text. Here is a brief rundown of what those items do:

• Aspect changes the width of the individual characters.

• Leading is the amount of space between lines of type. In the case of this template, there is only one
line of type, so changing the Leading value has no apparent effect.

• Kerning changes spacing between characters.

• Tracking changes spacing between groups of characters.

• Baseline Shift moves selected characters vertically. It's useful
when you want to user superscripts or subscripts.

• Slant adjusts the angle of an object.

• Small Caps, Small Caps Size, and Underline are all self-
explanatory.

• Distort stretches or shrinks text along either the X-axis, Y-
axis, or both (to see it, click the disclosure triangle).

8. Click the Fill disclosure triangle to open that collection of
Properties (see Figure 9.6). Click the Fill Type drop-down list and
scroll through its options. I’ll cover gradients in the next task. For
now, select Bevel and experiment with the various options
(Bevel gives each text character a 3D feel). You'll quickly see that
the possibilities are endless. Clicking one of the color boxes
opens the standard Adobe Premiere Pro color picker.

FIGURE 9.6: Use the Fill properties to change the text’s interior
characteristics.

9. Click the Strokes disclosure triangle. This template’s text has no inner strokes, but it does have three
outer strokes. Click the second Outer Stroke disclosure triangle (it has more features applied than the
other two).

Note: Different Strokes

Strokes is Adobe’s term for inner or outer text or graphic borders. These strokes or borders have the same
collection of properties available as are available for text and other Title Designer objects.
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10. To get a better feel for how strokes work, drag the corner handles of the Title One bounding box to
expand it. To see additional stroke features, select Depth from the Type drop-down list and click the
Sheen disclosure triangle. Your window should look something like Figure 9.7.

FIGURE 9.7: Strokes give outer or inner borders to text or graphic objects. Selecting Depth adds unique shading to
those strokes.

11. Experiment with the size and angle of the outer stroke. By using Depth and a larger size, plus adjusting
the angle, you can create true 3D text.

12. Sheen is a soft-edged color that typically runs horizontally through text or, in this case, through only the
outer stroke. You can
change that angle plus
its size and where it’s
located in the stroke
text by altering the size,
angle, and offset. Check
out Figure 9.8 for an
example of how you
can use all these stroke
options.

FIGURE 9.8: How your text can
look after giving it some depth
and apply a sheen to its outer
stroke.
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13. Finally, as far as this Title One text goes, click the Shadow disclosure triangle to reveal its properties and
click the Shadow Angle disclosure triangle to open that feature, too. You might note that Title One
doesn’t have an obvious shadow. That’s because the shadow opacity is 100% and its size is only 2
points. Change all the characteristics to see how the Shadow feature works. Take a look at my example
in Figure 9.9.

Everything is self-explanatory, with the exception of Spread. Increasing the Spread value softens the shadow.

FIGURE 9.9: Changing the Shadow characteristics gives your text even more depth.

 Working with the Template’s Geometric Shapes

The lower-third template has two other elements: rectangles. The graphic artist who created this template used
the Title Designer to make these as well. As with the text dissection, taking a look at why these shapes look the
way they do will go a long way to showing you how to do it on your own.

Task: Dissecting a Template’s Shapes
Shapes can have the same set of features that you can apply to text. In this task, I take a look at those features
that were not used in the template’s text line or were not used in an interesting fashion. Here’s how these
objects were put together:
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1. Continue where you left off in the previous task. Either grab a handle of the Title One bounding box and
drag it to shrink it and get it out of the way, or simply select it and press Delete. You can always start
fresh by reopening the Templates dialog box and reselecting this or any other template.

2. Select the black rectangle. As shown in Figure 9.10, doing so opens its Properties display. It has very few
properties, so I clicked all the unused property disclosure triangles to clean up the workspace.

FIGURE 9.10: The black rectangle has only a couple properties of interest: 4 Color Gradient and Stop Color Opacity.

Note: Why Use Only Black in a Four-Color Gradient?

The black rectangle gradually becomes transparent on its left side. This is a nice way to give text a slightly
more dramatic look. To create that effect, use the four-color gradient’s four color stops—the colors you set
for each corner. In this case, they are all black. Then apply transparency to the stop(s) of your choice
(see Step 3).

3. To achieve that graduated transparency look, the Adobe graphic artist selected the upper and lower left
color stops and then set their Color Stop Opacity values to 0%. Click on all the color stops and adjust
their opacities to see how that works.

4. Drag the black rectangle out of the way (or delete it), and slide the yellow/brown rectangle into the
center of the workspace. Drag the bounding box corners to dramatically expand it. Take a look at its
properties and you’ll see it has a lot going on with it: 4 Color Gradient, Sheen, and two Outer Strokes. I
expanded those outer strokes to better display the sheens applied to them.



Adobe Digital Video Curriculum Guide – Module 9 9-10

Adobe Digital Video CURRICULUM GUIDE

FIGURE 9.11: This rectangle (expanded to better display its characteristics) has two outer strokes, each with a sheen.

5. Double-click on each of the four color stop boxes around the 4 Color Gradient display. Note that each
color is just slightly different than the other four and that the colors at the top are slightly darker than
the bottom colors. This gives this rectangle some extra depth. Feel free to change the colors and reduce
the opacities a bit.

Tip: Lift a Color from Your Video

Instead of using the Color Picker to change the color stop color (or any other colored item), use the
Eyedropper tool to select a color from your video. To see the video, click the Show Video checkbox at the
top of the Title Designer window. Move to a clip you want to use by clicking on the time code and dragging
left or right. Click the Eyedropper tool next to the color swatch and drag it into your video scene. Note that
the eyedropper acts in real-time. The color in the 4 Color Gradient window (in this case) changes as you
move around the video clip in the window.

6. Note the sheen running horizontally through the rectangle is a dark brown to complement the other
colors. Change its color and angle to see what else works well.

7. Uncheck and recheck the two Outer Stroke check boxes to see how those two strokes look. Note that
both are only 3 points wide and fall on top of each other. The artist used two as a means to apply two
sheens to the box border.

Tip: Nothing Is Cut in Stone

As is the case in anything you do with Adobe Premiere Pro, you can always undo some editing step. In the
case of the Title Designer, step back any number of steps using the History palette (select Window >
History), select Edit > Undo or use the keyboard shortcut Ctrl+Z.
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8. Take a look at the Outer Strokes Sheens properties. Note that the angle is 291 degrees for the first and
91 degrees for the second. That is, the sheen appears just a bit above the center line on one side and a
bit below the center line on the other. If the sheens ran through the box, they’d form a flat X. This is a
clever bit of visual artistry. When you’re done experimenting, delete all the objects and text to create a
clean slate for the next task.

Creating Text

Up to this point, you’ve worked with a template. In upcoming tasks, you’ll create text from scratch. One
admonition: As with video transitions, it’s mighty tempting to go overboard and create text using some wild
styles. The purpose is to make your text interesting but readable. Splashy, 3D-style text with sheens, strokes, and
drop shadows can distract viewers from whatever message you’re trying to get across. And, if you’re applying
text over video or still images, you need to take care that it stands out from that video without clashing with it.

 The Adobe Title Designer offers three text creation approaches: anywhere within the title window, within a text
box, or along a path. In each of those instances, as shown in Figure 9.12, you can orient your text horizontally or
vertically.

FIGURE 9.12: Three text types from top to
bottom: Point, Area, and Path. Selecting an
icon from the left or right side determines
whether the text will orient horizontally or
vertically.

Here's an explanation of each type:

• Point Text—This style builds a text bounding box as you type. If you change the shape and size of the
box after you stop typing, that action correspondingly changes the shape and size of the text.
Stretching the box stretches the text.

• Area Text—In this case, you set the size and shape of your text box before entering text. After selecting
this tool, you need to define your text boundary by dragging and dropping a box in the text window.
Changing the box size later displays more or less text. It does not change the shape or size of the text.

• Path Text—You can build a path for your text to follow by clicking and moving your cursor around the
text window. This is not an animation tool. It merely creates a line—albeit as contorted as you
want—for the text to set on. You can use Path Text style to create something simple, such as a rainbow-
shape curve of text.  Once built, you can grab a path’s handles to reshape it. And after adding text to a
path, you can change font size.

Task: Create Point Text
If you’ve worked with just about any graphics program, you’ll get the hang of manipulating text in the Adobe
Title Designer. Here’s how to get started:

1. Select the horizontal Text Tool (the capital letter T) or use the keyboard shortcut: T. Click anywhere in
the Title Designer window on top of the grayscale checkerboard.

2. Clicking in the Title Designer window switches on the text property display. Click the Font drop-down
list, select Browse, and select a wild font, such as Wingdings.
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3. In the Adobe Premiere Pro main menu bar, select Title to open its drop-down menu (see Figure 9.13).
Open the various wing menus to see what’s offered. In this case, see to it that Word Wrap is checked.
Also, note menu items that are not available in the Title Designer window:

• Type Alignment enables you to choose left, center, or right.

• Word Wrap means that as you type and reach the title-safe
margin (the inner box defined by the thin white lines), the
text automatically continues on the next line instead of
running off screen to the right.

• Tab Stops opens a little window that enables you to state
how far the cursor will move each time you click Tab.

• Logo enables you to add images or graphics to the Title
Designer, either within a text box or as a separate object.

• Select is useful if there are several objects on top of one
another and it’s difficult to select a specific one.

• Arrange takes a selected object and moves it front or back
one layer or all the way depending on the command you
choose.

• View lets you choose whether to display the title-safe and
action-safe boxes (both are on by default), the text baselines
(the line that shows where the bottom of the text will run),
and tab markers.

FIGURE 9.13: The Title menu offers additional Title Designer features.

Note: Title and Action Safe Zones

NTSC TV sets cut off the edges of the TV signal. How much they cut varies from set to set. To ensure that
your text is completely within the edges of everyone’s TV screens, keep your text within the title-safe zone
(the inner box) and any action you want viewers to see within the action-safe zone. Despite this admonition,
it’s still okay to extend the background graphics, like the rectangular boxes used in the template earlier in
this module, to the edges  of the screen to fill the frame for viewing on TV monitors and computer screens.
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4. Start typing. Because you selected
Wingdings (or a nutty looking
equivalent) and word wrap, you
should get some crazy-looking
text filling your screen within the
confines of the title-safe
area—something like what's
shown in Figure 9.14.

FIGURE 9.14: Taking the Title Designer for a
test drive with Wingdings.

5. Click the Selection tool (keyboard
shortcut V) and click inside the
text bounding box to switch on its
handles. Move your cursor to the
corners of the bounding box. As
you approach each corner, the
cursor turns into a double-arrow
to indicate that you can stretch
the box. But if you move the cursor a bit farther out of
the box, it changes into a curved double-arrow like the
one in Figure 9.15. Use that to spin the box to any angle
you choose.

FIGURE 9.15: Move the cursor just outside the bounding box
handles to turn it into a rotation tool.
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6. As you spin the box, look at the Transform section in the
lower-right corner of the Title Designer window. I've
highlighted it in Figure 9.16. Note how the Rotation values
change.

FIGURE 9.16: As you rotate or move the box, note how the values
change in the Transform widow.

Note: More Than One Way to Move a Box

Instead of dragging bounding box handles, you can change values in the Transform window. Either type in
new values or place your cursor on a value and drag left or right to set a new value. You will get immediate
feedback as whatever object you selected adjusts its position as you change values.

7. Move the box around the text window and watch the X-position and Y-position change.

8. Finally, change the box shape and watch Width and Height values change.

Tip: Saving Text

At any point in your text-creation process, you can save your work by selecting File > Save from the main
menu bar. Doing that would normally save your project, but with the Title Designer window open, Adobe
Premiere Pro saves your text.

Doing so places that new title in your Project window. Once there, you can drag it to a sequence either on a
track above a clip or clips or on Video 1 to display as a standalone object.

In this case, there’s no need to save this work, so delete all your text by clicking the Selection tool, clicking inside
the bounding box, and pressing Delete. Alternatively, you can use the Text tool, drag it over the text to highlight
it, and then press Delete or Backspace to remove all the selected text.

Tip: Reediting Text—Retaining a Style

After your text has been saved, you can always reedit it. If you create a unique text and graphic style that
you think will help viewers recognize your productions or give them some consistency, you can simply
change the wording in saved text files while retaining the style. This comes in very handy if you've created a
standard way to superimpose locations or interviewees' names. Or you can save that text format as a style
by selecting the text’s bounding box, clicking the Styles wing menu triangle, and selecting New Style. Give
your style a name, click OK, and it will appear as a two-letter icon in the Styles thumbnail collection.
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Task: Test the Area Text Style
To experiment with the Area Text style, follow these steps:

1. Try Area Text by selecting its tool—the T in a lined box. In this case, before you can start typing text, you
need to create the text bounding box. Position your cursor in the text window, click to set an upper-left
corner to your bounding box, and then drag your cursor down and to the right to create the bottom-
right corner.

2. Fill the box with text. You'll notice the first difference between Area Text and Point Text. Instead of
expanding to accommodate more text, as the Point Text box did, the Area Type box has your type
disappear off the bottom of the screen. Figure 9.17 demonstrates that.

3. If you expand the box, the text doesn't change shape or size, but the altered box reveals the text that
ran outside the box's original confines.

FIGURE 9.17: The Area Text bounding box does not expand laterally to accommodate more text. Rather, your text
runs down and off the screen.
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Tip: Vertical Text

While you're doing your text testing, try the two vertically oriented text types. They're the two large T's with
arrows pointing down. There really is hardly any difference between these two and their horizontal partners.
True, as you type, the letters run from the top of the bounding box to the bottom, but they still display side
by side, not standing on top of each other. The only difference is in the rotation. Instead of rotating on an
axis at the center of the box, as do the horizontally oriented text tools, the vertical text boxes rotate on a
point outside and above the boxes. Give that little feature a try.

Adding Motion and Putting Text on a Path

You've seen opening and closing movie and TV show credits hundreds of times. In Adobe Premiere Pro, that's
rolling text; words that scroll vertically up or down the screen.

Also, you've seen news bulletins that slide horizontally along the bottom or top edges of the page. In the TV
news business, we used to call them Chyron crawls after the once de facto industry-standard, text-creation tool
(Chyron Corp. is still a major player in the graphics and TV production world). In Adobe Premiere Pro, they're
crawling text.

In either case, they take only a couple additional text-creation steps to make.

Task: Set Up Rolling Text
To set up rolling text, follow these steps:

1. In the upper-left corner of Title Designer interface, click the Title Type
drop-down list and select Roll. I've highlighted this in Figure 9.18.

FIGURE 9.18: Title Type with Roll selected.

Note: A Scroll bar Appears

When you select Roll, the Title Designer adds a scroll bar on the right side of its window that enables you to
view your text as it runs off the bottom of the screen. If you select the Crawl option, that scroll bar will
appear at the bottom to enable you to view text running off the right edge of the window.

2. Click the Type tool (the capital ‘T’) instead of the Area Type tool. Type in your rolling text. If you don't
press Enter and word wrap is on, you'll continue typing down the page. At the end of each line of text,
you can press Enter to start a new line or let the word wrap take care of that for you.
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3. When this is done, click the Roll/Crawl Options
(next to the Title Type drop-down list) to open the
dialog box shown in Figure 9.19 (alternatively, you
can select Title > Roll/Crawl Options from the
workspace's main menu bar). You have the
following options (note that Rolling text always
moves up the screen):

FIGURE 9.19: The Roll/Crawl Options dialog box enables you
to control the timing of moving text and, in the case of
Crawling text, whether it moves from right to left or from left to
right.

• Start Off Screen—Specifies whether the credits
start completely off the screen and roll on

• End Off Screen—Indicates whether the credits roll completely off the screen

• Pre-Roll—Specifies the number of frames before the first words appear onscreen

• Ease-In—Indicates the number of frames to get up to full speed when the first words appear

• Ease-Out—Slows the credits down at the end.

Creating Crawling Text

You create crawling text the same way as rolling text, only you start by selecting Crawl in the Title Type window.
As you type, your text rolls off the right side of the text window. In this case, the scroll bar appears at the bottom
of the text window, enabling you to see all your text.

Using the Path Tool

The Path Text tool is both elegant and tricky. It enables you to build simple or complex, straight and/or curved
paths for your text to follow.

Task: Text on a Path
If you've worked with the Pen tool in Adobe Photoshop®, you know how to use the Path Text tool. Basically, you
define a path by clicking a number of locations in the Title Designer window and dragging handles at each point
to use to define the curves. Here’s how it works:

1. Delete any text in the Title Designer window and select the Path tool (the T on a slope).

2. Click and hold down the mouse button anywhere in the text creation window. While still holding down
the mouse button, drag the mouse to create long handles. You’ll use these to define the curve’s
characteristics.

3. Click, hold, and drag somewhere else to create another anchor point and handles. The Title Designer
automatically connects the two anchor points. Move the cursor to the handles. Your cursor will change
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to a black arrow—use it to drag the handles. Make them longer, shorter, or move them around to see
how this works.

4. Adjust the curve by clicking on the handle endpoints and dragging. Your text window should look
something like Figure 9.20. You can add as many anchor points as you want. Move your cursor near the
curve and it will change to a black arrow to signify that you can grab the curve and drag it to reshape it.

FIGURE 9.20: Create a path by clicking and dragging to form handles and then repeat that for as many anchor points
as you want.



Adobe Digital Video Curriculum Guide – Module 9 9-19

Adobe Digital Video CURRICULUM GUIDE

5. When you’ve finished your path creation work, change the cursor to the Selection tool (click the Arrow
or press ‘V’), place your  cursor somewhere inside the newly created bounding box and click. It will place
a  text cursor at the beginning of the curved line. Type some text. That text will position itself on your
line. I created a simple three-anchor point curve for Figure 9.21. It takes practice to perfect this
technique, but if you give it a few tries, you'll get a basic idea how it works.

FIGURE 9.21: The Path Text tool can create a twisting text display.

Tip: Grabbing a Path Can Be Tricky

To change the shape of the curve means clicking on the path line, the little handles on the path, or at the
end of each handle’s extension lines. It can be tricky to make those connections. Try one of these methods:

After setting all the path points, you can roll the cursor on that path, note when it turns into a black arrow,
and grab the line or a handle to move it.

Or you can click the Selection tool, double-click in the path bounding box to re-display the path line, and
know that if you inadvertently click off the path, that will not create a new path point.
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Tip: Other Pen Tools

When you use the Pen tool and click anywhere in the Title Designer window, you activate the three other
Pen tool icons for the Add, Delete, and Convert Anchor Point tools. Select one, then click on any path point
to make the respective changes.

Creating Geometric Objects

If you've created shapes in graphics-editing software such as Photoshop or Illustrator, you know how to create
geometric objects in Adobe Premiere Pro. Select from the various shapes to the left of the text window, drag and
draw the outline, and release the mouse. The Line tool creates line segments and curves by using the same
procedure you used with the Path Tool. Click to set a starting point and then drag and click to set the endpoint.
Each segment has its own bounding box.

Tip: Other Pen Tools

When you use the Pen tool and click
anywhere in the Title Designer
window, you activate the three
other Pen tool icons for the Add,
Delete, and Convert Anchor Point
tools.

As you learned when working with
templates, you can use the numerous
properties to give your shapes special
characteristics. In Figure 9.22, I drew a
few shapes and added some gradients,
various opacity levels, strokes, and
shadows to demonstrate what you can
do.

FIGURE 9.22: Some graphic objects
created with gradients and various opacity
levels.

When you draw objects, they appear as solid white with no borders. Create a border by adding an inner or outer
stroke.

Tip: Special Drawing Keyboard Shortcuts

If you want to create a square, circle, right triangle, or a square clipped rectangle (as opposed to a rectangle,
oval, non-right triangle, or stretched clipped rectangle), hold down the Shift key when dragging the shape's
border. If you want to maintain the aspect ratio for a shape you've already made, hold the Shift key before
resizing that shape.
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It's fairly easy to build layers of graphic objects and add text as well. You can send an object backward or forward
by highlighting it, selecting Title > Arrange and then choosing from Bring to Front (that is, on top of all other
objects), Bring Forward (on top of the next highest object), Send to Back (that is, make it the bottom/deepest
object), or Send Backward (behind the next lower object).

Using transparent layers as backgrounds for supers is an excellent way to create a production studio or product
line identity. When you have a look you like, save it as a style or save an entire text design, including graphics,
and re-use it like a template.

New to Premiere Pro 1.5 is a set of Text and Object alignment and distribution icons. Instead of only accessing
this functionality via the Title Menu, you now can select a group of text or geometric objects (simply use the
Selection tool to marquee select -- click and drag) within the Title Designer window and then click on one or
more of the Align and Distribute buttons (highlighted in Figure 9.23).

FIGURE 9.23: Some graphic objects created with gradients and various opacity levels.
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Adding text or supers to your video project gives it another element and adds depth. Text sometimes can send a
message much more succinctly and clearly than a narration. It can reinforce narrated information or remind
viewers about the people in your piece and the message you're trying to convey.

The text tools in Adobe Premiere Pro are similar to those in standard graphics/text programs, with several extra
features tossed in. The infinite customizability of your text's appearance means that you can create a look unique
to your productions.

Q. When I resize my text bounding box, the text changes shape and size. How do I change the box without
changing the contents?

A. You're using Point Text, Adobe Premiere Pro's default text style. Instead, select the T in the lined box (Area
Text), drag and drop a text bounding box, and start typing. If you need to increase the size of the box, the text
will remain the same shape and size.

Q. I want to make a circle in a square, but all I get are ovals in rectangles.

A. You need to hold down the Shift key before you define the size of the quadrilateral or round figure. Doing
that keeps all sides equal and forces your oval to be a circle.

Quiz

1. How do you keep text from running outside the viewable area on a typical NTSC TV set?

2. There are too many typefaces! How can you wade through all that and quickly find one that works for you?

3. How do you create a rectangle with a gradient inside it and a two-color border?
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Quiz Answers

1. Use the Title Safe Zone option, which is accessible in the Title menu or in the Monitor menu for viewing in
the Source and Program Monitors. If you select the Word Wrap option, the Title Designer automatically
keeps all text within the title safe zone as you type.

2. Browse. Go to Title > Font > Browse and scroll all the font samples. Or click the Font drop-down list and
select Browse.

3. Open the Title Designer. Create a rectangle by selecting the Rectangle tool and clicking and dragging within
the text window to define a rectangle. In the Properties window, click the Fill disclosure triangle, select
Linear Gradient from the Fill Type drop-down list, and select two colors in turn. Select Strokes, Inner and
Outer Stroke, in turn, and give each inner and outer border a color and other characteristics to suit you.

Exercises

1. Create rolling credits with different font sizes and text alignments. Main headings could be aligned left and
individuals' names centered.

2. Make a rainbow using the Line tool. Click one side of the text window and then click the other, making a
straight line. Then drag the center handle to make a curve. Repeat this three or four more times and color
each line to create a rainbow look. Now add text along another arc over the rainbow. Do you feel a song
coming on?

3. Create a three-layer collection of rectangles with varying transparencies and drop shadow values. Create the
three rectangles by dragging and dropping them in separate locations. Make the large one opaque (100%
opacity) with a drop shadow of 50% opacity, the middle one 40% opacity with a drop shadow of 20%
opacity, and the small one 25% opacity with a drop shadow of 30% opacity. Then select colors and gradients
that give a contrast so that you can see one through the other. One other suggestion: Give one or two of the
rectangles a Repeat value to create parallel lines to make them stand out even more. Also, pick a drop
shadow that is similar in color to the object on which the shadow falls.

4. Watch TV news stories and note how their interview supers look. Attempt to emulate those styles by
creating a standard interviewee super with one font, two text sizes (larger for the name, smaller for the title),
a colored line running between the two text lines, and three overlapping and transparent boxes on the left,
acting as a unique production studio identifier. Make sure that you save this—you actually might want to
use it.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education
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Module 10

Advanced Editing Techniques and Workspace Tools

I believe that your students should start specializing only after they learn the fundamentals. If all a basketball
player practices is a spinning, reverse, wrong-handed flip shot, he'll make no more than a bucket a game. Not
many opportunities for that shot arise.

By now, given enough practice, your students might have mastered straightforward Adobe® Premiere® Pro cuts-
only editing techniques. They’ve worked with transitions and all their options, and have created text and
geometric shapes.

That being the case, this module ramps up those fundamental techniques a bit. I explain some standard
professional editing concepts, show you some other ways to manipulate clips, go over some time-saving editing
tools, and explain two higher-end transitions. Finally, I believe in learning from experts. The best video editor I’ve
worked with offers up his advice at the conclusion of this module.

At the end of this lesson, students will have learned about:

• Adding a professional touch to a project

• Playing clips backward, changing speed, and freezing frames

• Adding cutaways

• Rolling, slip, and slide edits

• Special transitions: masks and gradient wipes

• Editing tips from an expert—John Crossman

Adding a Professional Touch to Your Project

One reason to use the video shooting tips in Module 3, "Digital Video: Camcorder Features and Shooting Tips," is
to open up more creative opportunities during editing. Right now, you're doing fundamental, simplified editing,
but trying out some standard professional editing techniques will help as we move to more complex editing
later.

Using Establishing Shots

Do you have establishing shots? As I mentioned in Module 3, you need them to let viewers know where they are.
Try to place establishing shots near the beginning of any new setting or location.

Using Matching Shots

If you shot any repetitive action, look for matching shots. You might have a wide shot of someone typing at her
computer and a tight shot of that person's hands on the keyboard. Edit them together and make sure you avoid
jump cuts. The person in the wide shot might take her hands off the keyboard for a moment. If the tight shot is
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of her hands on the keyboard, make sure that you trim the wide shot to the point where the person still has her
hands on the keyboard.

Using Wide and Tight Shots

These shots add interest. You might have a wide shot of a football game with the quarterback barking out
signals. The next edit could be a tight shot of his face. You could have shot these two clips during two different
plays, but by editing them back-to-back, they appear to be one play.

Sequences

This is a great way to build interest. The fish shops at Seattle's Pike Place Market provide a nonstop sideshow full
of repetitive action. Most videographers would opt for a medium shot or two. Instead, put together a sequence
of a tight shot of hands grabbing a fish from the display case, a medium shot from behind the shopkeeper as he
tosses the fish to an employee, that employee catching the fish and placing it on a scale, and so on. Look for
sequences like that in your raw video. Build your sequences well by using tight and wide shots and matching
shots.

Cutaways

Avoid putting two very similar shots together. Two wide shots of the same soccer game, for instance. Instead,
between the two wide shots, edit in a cutaway—a crowd shot, a parent shouting encouragement, or the
scoreboard—to avoid creating a viewer disconnect. The same holds true for interviews. If you "butt together"
two bites from the same interviewee, put a cutaway between them. A hand shot or a reverse cutaway of the
interviewer.

Caution: Resolving Cutaway Audio Conflicts

When using cutaways, you usually lay only video over the edited video and audio clips. For instance, if you
use a reverse cutaway of an interviewer during a sound bite, you don’t want to hear whatever sound is on
that cutaway clip. But in the case of the soccer parent shouting encouragement, you do want to mix both
the shout and the original natural sound of the game. The techniques in this module’s “Adding News-Style
Cutaways” section cover the first method. I leave the audio cutaway to Module 14, “Editing Audio.”

Playing Clips Backward, Changing Speed, and Freezing Frames

By the time you finish this section, you'll know how to create a video sequence that incorporates all three of
these concepts.

Going in Reverse and Altering Speed

First, two fun and simple techniques: playing a clip backward and changing its speed. Consider the possibilities.
Kids diving out of a pond, a pitcher retrieving his fastball, and a reverse replay of an explosive building
demolition. Combine that with slow-motion, or speed things up and you can add drama or humor.
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Task: Playing a Clip Backward and Changing Clip
Speed
You can apply both effects within the same dialog box. This small interface
updates a less user-friendly process in previous versions of Adobe Premiere.
It now packs a lot of fun into a small package. Here’s how it works:

1. Select any clip, either on a sequence or in the Project window.

2. Right-click on that clip to open the context menu and select
Speed/Duration. As shown in Figure 10.1, that opens the Clip
Speed/Duration dialog box. Here are its features:

FIGURE 10.1: You can dramatically change the nature of your video using this
simple Clip Speed/Duration dialog box.

• Speed—set a percentage of the original clip speed here. 200% doubles the speed, whereas 50%
slows things down by half. As you change the percentage, the duration changes as well. 200% cuts
the duration in half.

• Link/Unlink—If you want to retain the length of the clip on the sequence but want to change its
speed, click this icon to unlink the percentage with the duration.

Caution: Unlink Doesn’t Always Work

Adobe Premiere Pro can override your unlink command. That happens when you increase the clip speed
and there aren’t enough unused head or tail frames to accomplish the change without changing the
duration.

Doubling the speed normally shortens the clip by half. To keep the clip the same length, Adobe Premiere
Pro uses those head or tail frames to fill in the clip length. If there aren't enough head or tail room frames,
Adobe Premiere Pro behaves as if the Link icon were unbroken and changes the clip length accordingly.

• Reverse Speed—Does what it says: plays the clip backward at whatever speed you set. It also plays
the audio backward. You can disassociate that audio by unlinking it from the video (not to be
confused with the Link/Unlink feature in the Clip Speed/Duration dialog box). In this case, you are
unlinking the audio and video elements of an A/V clip. I explain that in the next task.

• Maintain Audio Pitch—This is a very clever feature. When audio speeds up, it normally sounds like
Alvin and the Chipmunks. When it slows down, it’s a slow drawl. Maintaining the audio's pitch
means that the audio changes speed but keeps the original pitch.

Tip: Rapid Fire Narrations

The Maintain Audio Pitch feature is great if you want to speed up an announcer’s voice to fit his copy into
that end-of-commercial disclaimer common to car financing commercials.
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3. Take a look at how Adobe Premiere Pro displays your altered clips on the sequence. Previous versions of
Adobe Premiere changed the clip name by adding a reference to the new clip speed. Adobe Premiere
Pro doesn’t do that. But as shown in Figure 10.2, if you hover your cursor over the clip, a pop-up
message indicates the new speed percentage.

FIGURE 10.2: When you hover your cursor over a speed-altered clip, Adobe Premiere Pro displays its new rate.

Tip: Rate Stretch Tool

You can forgo the dialog box approach to changing a clip’s speed. Use the Rate Stretch tool (the fifth tool
down on the Tools palette). You can use it only on clips that have no clips adjacent to them on the right (but,
if there is a gap between clips, you can stretch a clip to fill that gap). And the audio automatically adjusts
accordingly with the associated pitch change. It is an imprecise tool, but it is an easy way to stretch a clip to
exactly fill a gap.

4. Check your work by playing the clip either by dragging it from the Project window to the Source
Monitor screen or by playing it from the sequence. Use the keyboard shortcut—the space bar—to see it
play in real-time.

Tip: Getting That Slow-Mo Music Video Look

You’ve seen those MTV videos of vocalists lip-synching their tunes while loping in slow-motion on a beach.
How, you ask, can they apply slow-motion and still have the lip-synch work right?

The video director makes a speeded-up version of the song and plays it while shooting the video. So, the
singer lip-synchs at a faster rhythm. Then the video editor slows down that video to match the beat of the
original tune.



Adobe Digital Video Curriculum Guide – Module 10 10-5

Adobe Digital Video CURRICULUM GUIDE

For example, if you use Adobe Premiere Pro to speed up the original tune to 150% of its original speed,
you’ll need to play back the video at 66.67% to get it to synchronize to the original tune. Cool.

If the math isn’t clear, here’s a different take:

Use the Clip Speed dialog to change the Duration and don’t worry about the speed percentage. Just shorten
it so the percentage is about 150% (fast enough to create a slo-mo look without making your singer go into
a frenzy to keep up). When you drop the video you made using the speeded up song into the sequence, use
Duration to lengthen it to match the original clip length. The speed should read about 68% in this case.

Unlinking Clips

If you have audio associated with the clip, any speed or reverse direction applied to the video portion of the clip
changes the audio accordingly. You can override that by unlinking that audio.

All video clips that have audio appear as one clip in the Project window, but when you place them on a
sequence, Adobe Premiere Pro divides them into their constituent video and audio portions. As you trim, move,
or remove them, the video and audio act in concert. If you want to deal with them independently, unlink them.

Tip: Unlink for Cutaways

Unlinking audio also comes in handy when you add cutaways to your piece. I discuss that general editing
style in Module 18, “Compositing Part 1: Layering Images and Clips.” In this module’s “Adding News-Style
Cutaways,” I show you a different way to add a cutaway without adding its associated audio.

Task: Unlinking Audio and Video
Unlinking and relinking video and audio is a bit non-intuitive. Especially if, after unlinking the audio, you move it
to some other place, and then want to link it back up to the original video and have the audio and video get
back into synch. Here’s how you do all of that:

1. Take a look at Figure 10.3. Clip A is linked
and Clip B is unlinked. You can tell because
“Clip A” is underlined, and “Clip B” is not.
The unlinked clip B also loses its video (V)
and audio (A) designators.

FIGURE 10.3: Clip B is unlinked (meaning that you
can edit its audio and video portions independently of
each other). Unlinking a clip changes the appearance
of its name in a sequence, removing the clip name
underline and (V) and (A) notations.
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2. To unlink a linked A/V clip, right-click on
that clip to open the context menu shown
in Figure 10.4 and choose Unlink Audio
and Video.

3. That simple right-click and select action
doesn't quite finish the job. As long as both
clips are highlighted, they'll continue to act
as if they were linked. To finish the task,
click anywhere in the sequence except on
the video or audio portion of the formerly
linked clips. That deselects them so that
you can change the video speed without
affecting the audio.

FIGURE 10.4: To unlink a clip, right-click on it and
select Unlink Audio and Video.

Tip: Unlink Keyboard Shortcut

There is a handy keyboard shortcut that enables you to briefly unlink audio and video so that you can trim
either one while keeping both in synch. Hold down Alt as you make that trim. This greatly simplifies what
used to be a kind of complex process to make what are called J and L cuts. I explain both in Module 14,
“Editing Audio.”

4. Drag an unlinked audio or video segment away from its formerly linked sibling. The two are now out of
synch, but Adobe Premiere Pro does not note that in any way.

5. To re-link and re-synch those two unlinked clips, select both clips by clicking on either the audio or
video clip and then Shift+clicking on the other clip. Right-click on either one to open the clip's context
menu, and then select Link Audio and Video.
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6. As shown in Figure 10.5, relinking the clips causes Adobe Premiere Pro to display a time box that notes
how out of synch they are. It’s easy to re-synch them—that is to slide either the audio or video segment
so that it re-aligns with its partner and makes the audio synch up properly with its associated video.
Choose which clip you want
to move, right-click the
time code display, and
choose Move into Synch.
That moves that clip so that
it lines up with the other
clip.

FIGURE 10.5: After relinking a clip
(and before resynching it), Adobe
Premiere Pro displays how much the
video and audio portions are out of
synch.

Caution: Re-synch Caveats

Two things: If you trimmed either the video or audio portion of this relinked clip, the clips will line up to
synch the audio so that the ends are not flush. In addition, the portion of the clip that moves does an overlay
edit by default, so it’ll cover up whatever is on its track at its new location.

Using Freeze Frames

If you want to create a sequence of clips that starts with a regular-speed clip, slows down, stops, shifts to a slow
reverse, and finishes at full-speed reverse, you need to create a freeze frame (along with two razor edits).

You also can use a freeze frame as an effective way to close a segment or an entire production. Freeze the final
frame and then fade to black. To do either, you first need to create a freeze—or hold—frame.

Task: Working with Freeze Frames
To end a piece with a freeze frame and then a fade to black takes a few steps: clip trimming, copying, pasting,
freezing, and adding a transition. The process to place a freeze frame in the middle of a series of clips takes a few
more steps. Here’s how to do both:

1. Place a clip on a sequence and trim its end to the frame you want to hold and then fade to black.

2. Right-click on that clip and select Copy.

3. Move the CTI to the end of your clip or just past the end.
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4. Select Edit > Paste from the main menu. That places a copy of the original clip on the sequence, right
after its twin clip.

Note: No Right-click Paste Option

Many editing tools are available in right-click, context-sensitive menus. Pasting a clip on a sequence is not.
Thus, the need to use the Main menu bar to do the Edit > Paste or the keyboard shortcut: Ctrl-V.

5. Right-click on that duplicate clip,
select Rename, and, as shown in
Figure 10.6, give that clip a
descriptive name. In my case:
Freeze – Clip A.

FIGURE 10.6: When creating a duplicate clip
that you’ll use as a freeze frame, give it a
descriptive name.

6. Right-click on the duplicate clip and
select Frame Hold. In the dialog box
shown in Figure 10.7, check the Hold On
box, select Out Point from the drop-
down list, and click OK.

FIGURE 10.7: Use the Frame Hold dialog box to
create a freeze frame; in this case, using a clip’s out-
point.

7. Now if you place the CTI over the first clip and press the space bar to play the sequence, the video will
get to the end of that clip and then play the next clip, which is a still image of the first clip’s last frame. In
other words, the video will freeze on the last frame of the first clip.

Caution: Trim After the Fact

If you want to trim the length of the duplicate clip, don’t trim from the endpoint. If you do, the freeze frame
will change to match the new out-point. Here are two ways to shorten a clip with a frame hold set to the
out-point:

• Use the Ripple Edit tool (keyboard shortcut: ‘B’) to trim it from its in-point.

• Use the Selection tool to trim the still frame clip’s left edge (creating a gap in the process), right-click
on the gap, and select Ripple Delete to close that gap.

8. To have that freeze frame fade to black, drag the Cross Dissolve transition to the end of the freeze
frame. You can adjust the length of the Cross Dissolve in the Effect Controls window.
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Tip: Be Wary of Duplicate Audio

The audio for your duplicated clip will be the same as the original clip, even with a Hold Frame applied. So, if
you do nothing with the audio on the second clip, you’ll have an awkward moment as the audio from the
first clip jumps back to its start and plays again. I explain how to fix that in Module 14. It involves unlinking
the audio/video of both clips, deleting the audio portion of the freeze frame clip, dragging the right-edge of
the audio from the original clip under the freeze frame, and gradually fading it out.

9. Here’s a quick explanation of how to add a freeze frame in the middle of a clip (it uses many of the same
steps you just completed). Find the frame to duplicate, use the Razor tool to cut the clip at that point,
and right-click. Copy the portion of the clip to the right of the slice.

10. Slide the right-side clip out of the way, paste the duplicate in front of it, and rename that duplicate to
something like Freeze A-2. Right-click the duplicate, select Frame Hold, check Hold On and In Point,
and click OK. Your
sequence should look
something like Figure 10.8:
a freeze frame in the middle
of a clip. You can adjust the
length of that freeze frame
by using the Ripple Edit
tool on its out-point.

FIGURE 10.8: To add a freeze frame
in the middle of a clip, slice that clip,
duplicate the second half, place that
duplicate between the two halves, and
apply a Frame Hold to its in-point.

11. For a final bit of legerdemain, split the two outside clips and apply slow motion and reverse slow motion
to them, respectively. I’ve labeled clips in Figure 10.9 to show you how this works. Delete the right-side
clip (you’ll replace it with the split opening clip). Move the freeze frame to the right to give the left clip
enough room to expand when you apply slow motion to it. Use the razor to slice the first clip and apply
slow motion to the right slice to ease into the freeze frame. Copy that right clip and paste it after the
freeze frame. Apply reverse motion to it (it already has slow motion applied). Copy the first clip and
paste it at the end. Apply reverse motion to it.
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FIGURE 10.9: Going from regular to slow-motion, to a freeze frame, and then reverse slow-motion and regular speed
reverse motion takes several razor slices, speed changes, and clip copies.

Note: Mid-clip Speed Change Can Be Abrupt

Slicing a clip to change its speed mid-clip might seem a bit abrupt. Adobe Premiere Pro does not let you
gradually change clip speed over time. By making a few additional clip splits and changing speed slightly in
each one, you can make the changes take place more smoothly.

Adding News-Style Cutaways

To see cutaways in action, simply watch some TV news stories. During some interviews, the view typically shifts
to the interviewer listening intently. This is primarily used when the news reporter chose to butt-together two
brief sound bites to make one longer one. The editor adds a cutaway there to avoid a jump cut. Or, if the story is
about a football game, for example, the view might switch in the middle of a play to a tight shot of screaming
fans and then switch back to the play itself.

Both of these edits are cutaways. The first would have no audio added; the second might mix the crowd audio
with the audio from the play. The upcoming task deals only with the former: nonaudio cutaway. I leave adding
cutaways with audio to Module 18, “Compositing Part 1: Layering and Keying Clips.”

Task: Editing Cutaways
This task uses the Source Monitor screen as a means to define the in-points and out-points for a cutaway and
then to remove audio before you add the cutaway to your sequence. Here’s how to do it:

1. Clear your sequence of clips or create a new one. Then add a clip to Video 1.
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Note: My Cutaway Task

Because this task is simply for practice, you don’t need to find the perfect cutaway or the perfect place to
edit it in. In this case, I’ll show you how I did it with my magic show video. I shot a kids’ magic show and want
to insert a tight shot of one of the trick setups. I don’t want to disrupt the audio flow, only insert a brief
cutaway (3 seconds typically works well).

2. Drag the video clip with the cutaway you want to use to the Source Monitor screen.

3. Locate that cutaway and mark its in-point and out-point using the brackets below the Source Monitor
screen.

4. To edit in a video-only cutaway, click the Toggle Take Audio and Video button highlighted in Figure
10.10 and select the filmstrip icon. The other choices are video with audio—a filmstrip with a
speaker—and audio-only—a speaker.

FIGURE 10.10: Set the in-points and out-points for your cutaway in the Source Monitor window and then tell Adobe
Premiere Pro to edit in only video by selecting the highlighted filmstrip icon in the Toggle Take Audio and Video
button.

5. Move the CTI on the sequence to the frame where you want to place the cutaway.
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6. Click in the Source Monitor screen and drag that to the clip on the sequence, using Snap to Edges to
line up its in-point with the CTI edit line. Release the mouse. As a reminder, this is an overlay edit. It
replaces whatever was on the sequence at that point and, in this case, does not add audio.

Note: What Happens If You Add Audio, Too

If you had selected the audio/video option and dragged the clip from the Source Monitor screen to the clip
on the sequence, it would have overlaid the audio portion of the selected clip as well. As I explain in Module
18, “Compositing Part 1: Layering Images and Clips,” the workaround for that is to add another audio track,
target that track, and then use the Overlay button in the Source Monitor window instead of dragging the
clip to the sequence.

Tip: Alternative Method to Find Edit Location

You don’t have to mark the cutaway location with the CTI edit line. You simply can drag the cutaway to the
clip and then drag it left or right, watching the split-screen in the Program Monitor to find a good location.

Rolling, Slip, and Slide Edits

You'll tap this set of editing tools when you want to preserve the overall length of your program. They come in
handy for precisely timed projects such as 30-second advertisements.

In many cases, it might be easier to make individual edits and forgo these special tools, but it's good for any
professional editor to know how to do rolling, slide, and slip edits. It can be a challenge to remember what each
tool does (during one demo I attended, an Adobe Premiere Pro team member struggled in vain to remember
which tool did what). So here is a quick run-through. (Table 10.1 provides a slightly different overview of these
three specialized edits):

• Rolling edit—Rolls the cut point between 2 adjacent clips.

• Slide edit— Slides the clip along the other material timeline.

• Slip edit—Slips the part of the clip used in the timeline.

Table 10.1: Rolling, Slide, and Slip Edits

Edit Effect Clip Length(s) Clip(s) In/Out

Rolling edit Changes the duration and in-points and out-
points of two adjacent clips.

Changes Changes

Slide edit The selected clip remains unchanged, but
out-points, in-points, and lengths of both
adjacent clips are changed.

Unchanged Unchanged

Slip edit Changes only the selected clip's in-points
and out-points.

Unchanged Changes



Adobe Digital Video Curriculum Guide – Module 10 10-13

Adobe Digital Video CURRICULUM GUIDE

Task:  Make Rolling, Slide, and Slip Edits
We’ll start with the Rolling edit (the easiest of the three) and then move on to Slide and Slip edits. Here are the
steps to follow:

1. Place three clips side by side on a sequence’s Video 1 track. Make sure that all of them have plenty of
head and tail frames to allow
for the edits. The easiest way is
to shorten each clip by
dragging in the beginning and
end (the in-points and out-
points) with the Selection tool.

2. Select the Rolling Edit tool
from the Tools palette
(keyboard shortcut ‘N’). Move
its cursor between the two
clips that you want to edit. I've
highlighted the Rolling Edit
Tool palette icon and its edit-
point cursor in Figure 10.11.

FIGURE 10.11: The Rolling Edit tool on
the Tools palette and positioned between
two clips.

3. What makes this Rolling Edit
different from any you've done to this point is that you'll use the Program Monitor screen to make the
edit. Click the Rolling Edit tool at the cut between the two clips and drag it in either direction. If you
drag it left, you're shortening
the first clip (clip A, in my
example) and lengthening clip
B. As shown in Figure 10.12, as
you move the Rolling Edit tool,
the monitor shows the new out-
point and in-point of the
adjacent clips.

FIGURE 10.12: As you drag the Rolling
Edit tool, use the Program Monitor to view
the changing out-point and in-point of the
two adjacent clips.
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Note: Rolling Edits Change Adjacent Clip Lengths

Simply to confirm what you just experienced: The Rolling Edit tool preserves the overall project length but
rolls the out-points and in-points of two adjacent clips—shortening one clip while lengthening the other.

4. Switch to the Slide
Edit tool and place
it over the middle
clip (not at an edit
point) as shown in
Figure 10.13.

FIGURE 10.13: The Slide
Edit tool on the Tools palette
and positioned on a clip.

5. Click on the middle clip and drag it left or right. Take a look at the Program Monitor screen shown in
Figure 10.14. The two top images are the in-point and out-point of the selected clip. They will not
change. The two larger images
are the out-point and in-point
of the adjacent (left and right,
respectively) clips. As in a
Rolling Edit, these edit points do
change as you move the
selected clip.

FIGURE 10.14: As you drag the Slide Edit
tool, the Program Monitor displays the
changing out-point and in-point of the
two adjacent clips and the unchanged
selected clip’s in-point and out-point.
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6. Switch to the Slip
Edit tool and place
it over the center
clip (you can place
it over any clip
because it affects
only the selected
clip, but the center
clip presents a
more descriptive
example). Use
Figure 10.15 for
reference.

FIGURE 10.15: The Slip Edit
tool on the Tools palette and
positioned on a clip.

7. Click on the middle
clip and drag it left or right. Take a
look at the Program monitor screen
shown in Figure 10.16. The two top
images are the out-points and in-
points of the two adjacent clips.
They will not change. The two larger
images are the in-point and out-
point of the selected clip. These edit
points change as you move the
selected clip left or right.

Figure 10.16: As you drag the Slip Edit tool,
the Program Monitor displays its shifting in-
point and out-point, and the unchanged out-
and in-points of the adjacent clips.

Tip: Using the Slip Tool at the Beginning or End of Your Video

Although the Slip Edit tool is intended to adjust the in-point and out-point of a clip between two other clips,
you can use it on the first or last clip of your piece. Give that a try to see how it works.

The Rolling, Slip, and Slide Edit tools work with both cuts-only edits and transitions. However, I recommend you
remove any transitions before using these tools and then reapply those transitions to make sure that they work
the way you expected. One example: You might have created a transition with a move that starts at a specific
point in clip A and moves to a point in clip B. Those start points and end points will likely shift as you make
adjustments using a rolling, slip, or slide edit.
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Creating Special Transitions

Back in Module 8, "Adding Transition Between Clips," I skipped two of the more-involved transitions: Image Mask
and Gradient Wipe. I'll run them by you here.

Using the Image Mask Transition

This is more like a special effect than a transition. Basically, you use any image—black-and-white, grayscale, or
full color—as a means to display part(s) of clip A and part(s) of clip B at the same time.

For instance, you might want to display part of an image in the sky of another image or have a clip play playing
in a frame on a wall or through a window. In each case, you’d create a black mask to match the area where you
want the video to show through the first video.

Clip A shows through the black area of your image (or any part of it that is 50% or more gray), and clip B shows
through the white area (or any part that is less than 50% gray). To reiterate, when using the Image Mask
transition, Adobe Premiere Pro sees the mask only as black or white. Even if you use a mask with color, Adobe
Premiere Pro makes the transition by converting the color image to grayscale and then calculating which
portions are more or less than 50% gray.

To do this, you'll need a mask. To get some hands-on experience, I'd suggest you make a rudimentary mask
using a tool such as Microsoft Paint or Adobe Premiere Pro’s Title Designer. Create your mask and save it on your
Adobe Premiere Pro scratch disk.
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Figure 10.17 shows how a mask might look. It's basically a stark black-and-white graphic. Remember that the
black area lets that part of clip A show through, and the white area displays that section of clip B.

FIGURE 10.17: A rudimentary mask created in Adobe Photoshop® for use with the Image Mask transition.
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Task: Create an Image Mask Transition
To create an Image Mask transition, follow these steps:

1. Delete the three video clips from your sequence
or create a new sequence.

2. To make it clear how the Image Mask transition
works, I'd like you to make two color
mattes—solid color graphics that you can use as
clips in your project. As shown in Figure 10.18,
click on the New Item icon in the Project window
and select Color Matte (or right-click on any blank
space in the Project window to open the context
menu and select New Item > Color Matte). Select
a color from the Color Picker and give your matte
a descriptive name. Do that again for a distinctly
different color.

FIGURE 10.18: Create color mattes by clicking the New Item
button.

Tip: Color Mattes Are Useful Objects

Now that you know about how to make color mattes,
consider using them in your projects. For instance,
use them if you want a simple color background for
text or for pictures-in-pictures.

3. Drag each matte to the Video 1 track of your
sequence. Your sequence should look like Figure
10.19.
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FIGURE 10.19: The Image Mask
transitions sequence setup.

4. Locate the Image Mask
transition in the Special
Effect folder in the Effect
palette’s Video Transitions
folder and drag it to the
edit point between the two
mattes. This pops up a small
Image Mask Settings dialog
box, as illustrated in Figure 10.20.
This is a tad confusing because
you'd expect to see a standard
Transitions Settings dialog box with
a Custom button instead (we'll get
to that dialog box in a moment).

FIGURE 10.20: The preliminary Image Mask
Settings dialog box.

5. Click Select Image, locate your mask, and double-click it. When this brings you back to the Image Mask
Settings dialog box, click OK.

6. Now open the Effect Controls window and click on the purple Image Mask transition rectangle on the
sequence to select it. Ah-ha. This looks more familiar (see Figure 10.21), but you'll notice that there is no
A and B preview window; there's only a window that combines both clips. Although this is called a
transition, it's really a way to let parts of one clip show through on another.
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FIGURE 10.21: The actual Image Mask Effect Controls window settings.

7. You can give your mask transition a border. Note that whatever portion of the original Image Mask
graphic was black shows the A clip and whatever was white shows the B clip.

As with most transitions, if you click the down arrow, you'll switch how Adobe Premiere Pro performs this
transition. Instead of letting clip A show through the black portion of your mask, clip A now shows through the
white and clip B shows through the black.

Creating a Gradient Wipe Transition

This is more like what you'd expect to see in a transition. It works like the Image Mask transition in that it lets
parts of clip A and clip B display together using a custom mask, but the Gradient Wipe transition actually moves
from one scene to the next using a smooth animation. It’s like other Wipe transitions, but in this case, you control
the shape of the edge.

In a reversal of the Image Mask transition, clip B shows through the black area, whereas clip A shows through the
white area. Also, in this case, Adobe Premiere Pro does see things as gray—gradually. As the transition
progresses, the gray areas darken and more of clip B shows through until at the end of the transition only clip B
is onscreen.

As in the previous task (the Image Mask transition), I suggest that you create a grayscale gradient mask. Figure
10.22 shows a very rudimentary example using black, two grayscale areas, and white.
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FIGURE 10.22: A rudimentary grayscale mask created in Microsoft Paint for use with the Gradient Wipe transition.

Task: Create a Gradient Wipe Transition
To create a Gradient Wipe transition, follow these steps:

1. Return to your timeline and replace the Image Mask transition with the Gradient Wipe transition (it's in
the Wipe folder).
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2. This, too, pops up a little preliminary
Gradient Wipe Settings dialog box, as shown
in Figure 10.23. Click Select Image, locate
your gradient graphic, and double-click it.

FIGURE 10.23: The preliminary Gradient Wipe settings
dialog box.

3. This returns you to the preliminary Gradient
Wipe Transition dialog box. Select a Softness setting (this smoothes sharp edges in your gradient
graphic). Click OK.

4. As with the Image Mask transition, click the transition on the sequence to display its settings in the
Effect Controls window. As shown in Figure 10.24, this display has all the trappings of a real transition,
including separate A and B clip windows.

5. Click Show Actual Sources and drag the slider under clip A to see how this transition works. As you
move the slider, Adobe Premiere Pro is in effect making the Image Mask graphic darker and letting
more of clip B appear in the increasingly black areas of the graphic you created for this transition.

FIGURE 10.24: The Gradient Wipe transition works like other transitions with the extra feature of a user-created
gradient graphic.
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Similar to the Image Mask transition, you can change how this transition works by clicking, in this case, the R
button. This starts the transition from the top instead of the bottom.

Sidebar: Sequence and Project Window Label Colors

As you've worked with the Project and Timeline windows, you might have noticed that objects in both
windows follow a certain color scheme (Adobe favors pastels). Those colors are customizable. Here's a
rundown of the default color scheme:

• Video-only clips are blue.

• Audio-only clips are green.

• Linked or formerly linked video/audio clips are cyan.

• Graphics or mattes are violet.

• Sequences are gray.

• Red bar(s) near top of a sequence indicate segments that need rendering before the project is
completed.

• Project window bins are orange.

The one small flaw is that there is no distinctive color for the unlinked portions of a formerly linked A/V clip.

In any event, if the pastels don’t resonate with you, you can change the color scheme by selecting Edit >
Preferences > Label Colors. Then select new colors using the Color Picker. Associate those new colors with
their labels by selecting Label Defaults from the same Preferences dialog box.

Editing Tips from an Expert—John Crossman

Forever seared in my brain is one edit. It was in my first "magazine" piece for KSL-TV in Salt Lake City. This was
back in the mid-1980s. The national Radio and Television News Directors Association had just named KSL the TV
news station of the year—an honor that KSL would win an unprecedented two years in a row. KSL had the
highest-rated (by percentage of viewers) news shows in the country. It was a TV news powerhouse. I had just
moved there from a medium-sized market and was in awe of the professionalism, the scope of the news
operation, and the array of high-tech goodies.

Buried deep in the editing bays was something akin to the command
center of the Starship Enterprise. At its helm was John Crossman, KSL's
chief editor. For me, having come from a station with no editors (the
photographers did all the editing), this was a tad overwhelming. One of
my first assignments was a long feature story on a local piano
manufacturer. I'd never done a magazine-style piece and handed John
a straightforward news-style voice-over. He barely batted an eye.

A couple hours later, he called me into his realm wanting to show me
how the piece was coming together. It sang. It danced. It had rhythm. I was confounded. The segment ended
with a Billy Joel piano crescendo followed by a loud "clip" of a wire cutter snipping a piano string. I looked at
John and all his whiz-bang electronics and made one of the dumbest comments I've ever muttered in my TV
career: "This equipment is amazing!" Fortunately, he forgave me my egregious error, and we got on famously
after that.
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John spent eight years at KSL and now runs Crossman Post Production (    www.crossmanpost.com     ) just outside of
Salt Lake City. He provides video editing, graphics, and computer-generated animation for a lengthy list of
corporate, educational, and broadcast clients. He's won five regional Emmys, 26 national Tellys, and a slew of
other awards.

John is a wonderfully talented guy who has a true passion for the art of editing. Here are his editing tips.

To begin, good editors need certain basic talents:

• Rhythm—Life has a rhythm; so does editing. If you can't feel it, it's very hard to learn.

• Visualization—Good editors can see the completed project before they start. The actual editing is just
the detail work. The images already are completely edited in their minds.

• Patience—Even when you can see it in your mind's eye, you'll have to make compromises on every
project. The true test of an editor is whether he can make compromises work well. The best editors
make it look like every single choice was the best choice.

• Positive attitude—Your attitude will go a long, long way toward determining your success. You'll spend
countless hours editing in a small dark space, usually on a deadline, and always with budget pressure,
client pressure, spouse pressure, you name it. And the better the attitude, the better the job will go.

• Team player—You're part of a team. Try not to criticize the other members. Remember, you didn't have
your eye in the viewfinder when the bomb went off. Thinking you could have had that shot when you're
looking at the tape hours and miles away is easy, but not productive. Let the producer say, "I wish he
had gotten closer." You say, "Well, let's do it this way and it will still work." That's where the editor earns
his money, his reputation, and his loyalty.

To edit well, you need to do the following:

• Use motivation and logic—This is the most important concept in editing. Your editing should be
motivated. You should have a reason for the shots you select and the order in which you select them.
There should be a purpose to why you dissolve, why you use a wipe, as well as why you cut. Your goal is
to communicate clearly what has happened. Your shot selection and the time spent on each shot
should reinforce the narration while conveying information.

• Plan as you digitize—As you digitize the video, you should see in your mind's eye how the pictures are
going to line up to get you to where you want to be at the end. Is the shot a great scene-setter
(beginning)? Is it incredibly beautiful (possible ending shot)? Is it self-explanatory or incomprehensible
(possible cutting-room floor material)?

• Build new skills—If you're in the professional ranks, or want to be, you must budget a considerable
amount of time and money toward keeping current. At the very least, you're going to need to learn
about how to incorporate graphics, animation, compositing, and special effects into your editing to
serve the demands of your clients.

• In the world of broadcast television, you are surrounded by people who know how to create good
stories. In corporate production, you might be working with someone who has no clue. At this point,
you become 90% teacher and 10% editor. Your attitude will win you a loyal client or lose you a lifetime
customer.

• Like music in a movie, good editing helps communicate your message and shouldn't really stand out to
the viewer. The editing is not the message, but the editing can make the message work, not work, or
work better than it should.
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Professional video editors have a handful of editing tricks up their sleeves: establishing shots, wide and tight,
sequences, and cutaways. Editors are so accustomed to adding these nifty touches to their projects, they are
almost second nature. Keep them in mind as you shoot your raw video and do your initial edits.

As you use those techniques, you'll come to rely on several Adobe Premiere Pro editing tools. Adjusting clip
speed and direction plus adding freeze frames expands your editing possibilities. Rolling, slip, and slide edits
take that cuts-only style even further. The two mask transitions enable you to use custom images to display two
clips at once. Adding cutaways makes it possible for you add some visual interest to an interview or other video
clip.

Q. When I use the Rolling, Slip, and Slide Edit tools, the clip frames shift in the monitor screens, showing
the new edit points, but after a while, they stop and won't let me move the edit point any farther. What's
up?

A. You've reached the end of the line—the beginning or end of the original clip. There are no additional head or
tail frames to enable you to move the edit any farther.

Q. I create a freeze frame by selecting Frame Hold and checking Hold On the Out Point. That freeze holds
for a bit too long, so I trimmed it, and now the freeze frame image is different than the one I wanted.
What’s going on?

A. You trimmed your clip by dragging its out-point. Because that’s the image you told Adobe Premiere Pro to
hold, it updates that freeze frame as you change the out-point. To avoid this issue, use the Ripple Edit tool and
trim the clip from its in-point.

Quiz

1. You've completed a project that is exactly one minute long and needs to stay that length. You like one clip,
but you want to shift its position slightly between two other clips. What edit tool do you use? Why?

2. What are the principal differences between the Image Mask and Gradient Mask transitions?

3. You want to make sure that when you drag a cutaway from the Source Monitor screen, it doesn’t alter the
audio of the original clip. How do you do that?
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Quiz Answers

1. The Slide Edit tool. It enables you to slide a clip between two others, changing their in-points and out-points
while keeping the selected clip intact.

2. The Image Mask transition sees everything in black or white—no gray area for that guy. And it’s not a true
transition. It's merely a means to sandwich two clips together. The Gradient Mask transition has a built-in
transition motion, revealing the next clip from either the bottom of the screen going up or from the top and
going down, and sees things in shades of gray.

3. Click the little Toggle Take Audio and Video button until it turns into a filmstrip icon without a speaker (that
button is below the lower-right corner of the monitor screen). Now drag the image in the Source Monitor
screen to the Video 1 track of your sequence. The original clip’s audio should remain untouched. Take care
not to click it one time too many—that turns it into an audio-only edit.

Exercises

1. I demonstrated the process to create a sequence using regular forward motion, slow motion, stop action,
reverse slow motion, and reverse full-speed motion. Now, find a clip of your own that would work well with
those edits and apply them.

2. To really get a feel for the four edit tools presented in this module—Rolling, Slide, Slip, and Rate
Stretch—plus the Ripple Edit tool, you need to use them. I guarantee that if you use them a half-dozen times
each, they'll become second nature. And you'll see the beauty of how well Adobe Premiere Pro’s developers
implemented all this functionality. It’s a marked improvement over previous versions of Adobe Premiere.

3. Combine two concepts presented in this module: professional editing techniques and the Ripple, Rolling,
Slide, and Slip Edit tools. Use these tools to make matching edits and build sequences. What makes these
tools so powerful is that you can view just how the edits will work in the Program Monitor screen.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education
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Module 11

Working With Video Effects

Adobe® Premiere® Pro's video effects give your students more ways than they can imagine to jazz up their
videos and dazzle viewers. They can put clips in motion, distort them, shrink them, fly them across other clips,
and change their color, style, and overall appearance.

They can apply these effects—video and audio—gradually over time or immediately. They can combine effects.
For instance, they can posterize a clip, flip it around, and fly it off screen. It's a cliché, but it applies: The only limit
is their imagination.

At the end of this lesson, students will have learned about:

• An overview of Adobe Premiere Pro’s video effects

• Working with simple video effects

• Changing effects over time—keyframing

• Working with effect Presets

• Using Bezier keyframe Interpolation with video effects

An Overview of Adobe Premiere Pro's Video
Effects

This module marks the first of several during which I
cover Adobe Premiere Pro’s many video effects. I
introduce the Effects palette here and go over some
of the simpler effects: those that have few, if any,
options. I present most of the remaining video effects
in Module 17, “Using Higher-Level Video Effects” (see
following Note: “Keying—Newly Categorized as an
Effect,” for an explanation about the remaining
effects).

Adobe Premiere Pro ships with about 90  effects
(several dozen more are available if you have Adobe
After Effects), and many more are available from third-
party providers. If you have Adobe Premiere Pro open,
click in the Effects tab in the Project window and
open the Video Effects palette. I've illustrated part of
that palette in Figure 11.1.

FIGURE 11.1: The Video Effects palette.
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As a convenience, Adobe created 14 categories to organize these video effects, but you'll find that one category
can sometimes seem a lot like another, and video effects in different palettes can be very similar.

Note: Additional Video Effect Categories

You might have more than 14 categories. If your PC has a graphics processing unit – GPU – that supports
Direct3D and Pixel Shading 1.3, you’ll see a GPU effects folder that contains three effects (see following
note). You also might have installed 2d3’s Steadymove plug-in which resides in its own folder. Finally, if you
have After Effects installed on your PC, Premiere Pro 1.5 automatically includes many of its effects in the
Video Effects listing plus might add an additional category: Video Effect Transitions.

Note: New GPU –Accelerated Effects in Premiere Pro 1.5

The Premiere Pro development team added three realtime 3D effects in version 1.5 that work only if your PC
has a high-end graphics processing unit. That GPU needs to support Direct 3D and Pixel Shading 1.3 (Vertex
Shading 2.0 and Pixel Shading 2.0 for some effect options) for these effects to work. During installation,
Premiere Pro tests your card and if it passes, it adds the GPU Effects category to your Video Effects list. That
category includes three effects: Ripple, Refraction and Page Curl. Ripple and Page Curl are available as non-
GPU Video Effects but the GPU versions offer more options and look better.

Note: Keying—Newly Categorized as an Effect

Until this release of Adobe Premiere Pro, keying was not considered an effect. Keying falls more into what
most editors would call a compositing tool. That is, it’s a means to give a video clip some transparency to
enable layering—or compositing—it with other clips. Keying is a concept that takes some explanation as well
as a shift from single-track editing to multiple tracks. I introduce keying in Module 18, “Compositing Part 1:
Layering Images and Clips.”

There are three basic types of video effects that ship with Premiere Pro: Standard, Adobe Photoshop®, and
Adobe After Effects®. Adobe used to differentiate the After Effects group by giving it a special icon. No longer.
The only obvious way you can discover which effect falls into which group is by looking in Adobe Premiere Pro’s
main file directory.

Sidebar: Digging Into the Effects

If you’re so inclined, navigate to wherever you installed Adobe Premiere Pro. If you opted for the default
installation, you’ll find it at     C:/Program Files/Adobe/Premiere Pro/ . Open the Plug-ins folder. In it, among
other things, you'll see a collection of files that all start with the word Filter and have PRM file extensions.
Those are the old Adobe Premiere stand-by video effects (they called them filters in previous Adobe
Premiere iterations).

You also might notice a collection of AEFilter files with AEX file extensions. Most of these are the keying
filters discussed in the previous Note. New to this group and to Adobe Premiere Pro are the Color Corrector
and ColorMatch After Effects filters (for some programming reason, they're stored in the Plug-ins folder, not
the After Effects folder) and Motion and Opacity After Effects filters. The latter two are called fixed effects
because they are always available for your use in the newly revamped, all-in-one, Effect Controls window
(ECW). I cover opacity in Module 18, and I explain Motion in the next module, “Putting Video and Still Clips in
Motion.”



Adobe Digital Video Curriculum Guide – Module 11 11-3

Adobe Digital Video CURRICULUM GUIDE

Dig a little deeper into separate AEFilters and PSFilters folders, and you’ll find the After Effects and
Photoshop effects used in earlier versions of Premiere (there are four new Photoshop effects in Premiere Pro
1.5: Shadow/Highlight, Auto Color, Auto Contrast, and Auto Levels). The Photoshop effects (all have 8BF file
extensions) tend to have few options, so I’ll cover some of them in this module. Basically, they're lifted
straight from Photoshop, where they are used on static graphics or photos. Adobe Premiere Pro gives you
the opportunity to use them on moving pictures and change their characteristics over time. That so-called
keyframing capability, even with only a few parameters, can be very powerful.

The After Effects tend to be a little wilder and more involved. Many have built-in animations and multiple
features. If you have a copy of After Effects, Premiere Pro 1.5 now can use many of its effect plug-ins. Just
make sure you install the AE plug-ins in the default folder. I take you through the set of AE effects that ship
with Premiere Pro in Module 17.

You apply video effects simply by dragging and dropping them to a clip on a sequence or in the Effect Controls
window. You can add multiple video effects to a single clip. Doing so can produce surprising and unpredictable
results.

I concentrate on the simplest video effects in this module to give you a taste of their variety and value. Then I
show you one of the real strengths of Adobe Premiere Pro: the capability to change effects over time. Even static
effects like those lifted from Photoshop can be animated.

Task: Convert a Clip to Grayscale
I'll begin with Adobe Premiere Pro's simplest video effect: Black & White. It converts any clip to grayscale (shades
of gray). Follow these steps:

1. You can open Adobe Premiere Pro to your own workspace, but to make sure we’re on the same plate,
switch to the Effects workspace by selecting Window > Workspace > Effects.

2. Add a brief video or linked video/audio clip to your timeline by dragging it from the Project window.

3. Select the video portion of that clip by clicking it with the Selection tool.

4. Note that the name of the clip shows up in the Effect Controls window (it should be open in the Source
side of the Monitor window by virtue of your having switched to the Effects workspace).
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5. In the Video Effects folder (under the
Effects tab in the Project window),
open the Image Control file folder and
drag and drop Black & White on the
clip on the timeline or to the left side
of the Effect Controls window. This
action adds the video effect name to
the Effect Controls window, below
Motion and Opacity and above
Volume (if you're using a linked
audio/video clip). I've illustrated this in
Figure 11.2. Note that there’s a little f
icon on the left side. Clicking this turns
off the effect while keeping it in the
ECW.

FIGURE 11.2: After the Black & White video effect
is applied to a clip, it appears in the Effect
Controls window.

Tip: Finding Effects (and Transitions)

With the many video effects file folders, it’s sometimes tricky to locate an effect. If you know an effect’s name
(or part of its name), type it in the Contains: line at the top of the Effects palette. Adobe Premiere Pro
immediately displays all effects that match those letters, narrowing the search as you type.

Note: New Horizontal Lines in the Sequence

You might note that when you add an effect to a clip, two thin horizontal lines show up in the sequence. A
red line below the Time Ruler indicates that this clip will need rendering before final output. And a line at
the bottom of the clip in the sequence serves simply as a reminder that you’ve added an effect to this clip.
That line is green when the clip is selected and purple when it’s not selected.

6. The Black & White video effect happens immediately. Place the CTI edit line on the clip and note that its
image in the Program Monitor screen shifts instantly to a grayscale image. Preview your clip (press the
spacebar) to see the Black & White effect in action.

7. Using the Black & White video effect can be abrupt. To make this clip gradually shift to black-and-white,
use the Razor tool to slice it, put the Black & White video effect on the second section, and add a cross-
dissolve on the sliced edit between the two clips.
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Task: Try the Camera Blur Video Effect
Black & White is as basic as Adobe Premiere Pro's video effects get. To move things up a notch, try the Camera
Blur video effect:

1. Remove Black & White from the Effect Controls palette by clicking on its name and pressing Delete (or
right-click on the effect name and select Cut).

2. Open the Blur & Sharpen file folder and drag
and drop Camera Blur onto the timeline or
the Effect Controls window.

3. Note that as I’ve illustrated in Figure 11.3,
there are three extra items in expanded view
of the Camera Blur section in the ECW: a little
window icon, two disclosure triangles, and a
stopwatch (the latter is to set keyframes,
which I cover in the next section, “Changing
Effects Over Time—Keyframing”). The
window icon and the disclosure triangles
both access this effect’s one control: Percent
Blur.

FIGURE 11.3: Camera Blur has three additional features
in its Effect Controls window display: a window icon to
access a set-up dialog box, a disclosure triangle to access
that setup info within the ECW, and a stopwatch to
switch on keyframes.

Tip: Accessing Parameters

Virtually all effects have a disclosure triangle. Clicking it typically displays a list of nested parameters, most of
which have disclosure triangles of their own.

Meanwhile, only some clips have that little window icon that accesses a separate set-up dialog box.
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Caution: Settings Dialog Box Opening by Itself

When you add this effect, and others that use a settings
dialog box (see Step 4), the dialog box should not open
until you click its little window icon in the ECW. But, as a
result of what might be a minor glitch in Adobe Premiere
Pro’s code, sometimes when you add such an effect to the
ECW, its settings dialog box opens on its own. It’s a
nonissue, really, but this is just a heads-up in case it
throws you the first time it happens.

4. Click the window icon to view the Camera Blur
Settings dialog box.

5. Move the percentage slider to see its effect in the
Settings dialog box preview window (see Figure 11.4).
Click OK.

FIGURE 11.4: Camera Blur has only one option: Percent Blur.

Tip: Preview Frame Behaviors

When you preview an effect in its Settings dialog box, the image displayed might not be what you expect to
see. If you have the CTI (Current Time Indicator) on the clip (clicking on the clip to select it does not move
the CTI to it), the Settings dialog box displays the frame under the CTI. If the CTI isn't on the clip, the Settings
dialog box displays a frame from the clip, but there does not appear to be any rhyme or reason as to which
frame. If you instead preview your work in the Monitor window’s Program screen (see steps 6 and 7), you’ll
need to move the CTI edit line to the clip to see the effect in action.

6. To see how the controls in the ECW work, click the disclosure triangle next to Camera Blur and click the
disclosure triangle below and to the left of the first one. Your screen will look like Figure 11.3 shown
earlier.

Note: ECW Controls—Eminently Keyframable

That these dialog box controls are also available in the ECW means that you can apply keyframes to any or
all of them. This is a major improvement in Adobe Premiere Pro over its predecessors.

7. Move the CTI to your clip to see it in the Monitor window Program screen, and then move the slider to
change the percent blur. Note the immediate change in the Monitor.
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Tip: Photoshop Video Effects

Camera Blur is the first of several Photoshop video effects you’ll work with. Most have similar, simple dialog
box interfaces and offer most of those dialog box controls in the Effect Controls window. This demonstrates
the elegance of Adobe Premiere Pro. Previous versions of Adobe Premiere presented effects in myriad ways;
now all are accessible within the ECW as well as in their former interfaces.

For your information, here's a list of the Photoshop video effects:Lens Flare, Polar Coordinates, Radial Blur,
Spherize, Twirl, and Wave. All but one use a Settings dialog box, and most are simple and fun.

New to Premiere Pro 1.5 are four additional Photoshop Video Effects. All are in the Adjust folder: Auto Color,
Auto Contrast, Auto Levels and Shadow/Highlight. Drag each one in turn to a clip and note their individual
impact.

Auto Color will give any clip that is not perfectly color-balanced a nice, warm, and full color spectrum.

Auto Contrast maps the lightest and darkest pixels in an image to white and black, which makes highlights
appear lighter and shadows appear darker.

Auto Levels works a lot like Auto Contrast but it adjusts shadows and highlights within individual color
channels so it tends to change clip colors.

Shadow/Highlight corrects video with silhouetted images due to strong backlighting or fixes subjects that
have been slightly washed out due to camera lighting. It has numerous options that might seem daunting
but it’s worth checking out.

Experiment with the following simple video effects. Although you can apply multiple effects to a clip (sometimes
with unpredictable and exciting results), in this case it would be best to delete each effect before moving on to
the next one:

Facet—Found in the Pixelate file folder, this effect is reminiscent of Gauguin paintings. It creates a smooth oil
painting–like effect by clumping together pixels of similar color values. As with Black & White, there are no
options.

Replicate—Found in the Stylize file folder, this effect divides the screen into tiles and displays the whole clip in
each tile—from a 2x2 grid to 16x16.

Solarize—This effect is found in the Stylize file folder. By blending between a negative and a positive image,
Solarize makes your clip look like film briefly exposed to light during developing. A setting of 0% leaves your clip
unchanged, whereas 100% turns it into a negative image.

Before moving to keyframes, I want to fill you in on a few more basic but useful effects.
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Task:  Apply the Lens Distortion Video Effect
The Lens Distortion effect warps your image, making it look as if someone's contorting your lens. Here are the
steps:

1. Remove Camera Blur (and all other effects) from the Effect Controls window by selecting it and deleting it.

2. Open the Distort file folder and drag and drop Lens Distortion into the Effect Controls window or onto the
clip in the sequence.

3. Click on the settings dialog box icon to open it (if it hasn’t opened automatically). As shown in Figure 11.5,
this video effect has several numeric values and a Fill section. Adjust a few to see their impact on the overall
view. If you shrink the screen enough so it no longer fills the screen, you can select a Fill color to use other
than the default white. In Module 19: “Compositing Part 2: Alpha Channels and Mattes,” I’ll show you how
you can put another video clip in the Fill section.

4.  You can forgo the separate settings box by clicking Cancel and opening all the disclosure triangles to reveal
the same group of settings. In Premiere Pro 1.0, you needed to access the separate Settings dialog to access
the Fill section. That no longer applies. As you encounter other Settings dialog boxes, check to see if you
really need to use them. It makes much mose sense to use the settings in the ECW since they are
keyframable (more on that in the next section).

Changing Effects Over Time—Keyframing

Keyframing has changed dramatically for the better in Adobe Premiere Pro versus previous versions. Virtually all
options for all effects are keyframable. That is, you can change the effect’s behavior over time in myriad ways.

For instance, you can have Camera Blur gradually “rack” the scene out of focus or start out of focus and gradually
sharpen the image. Or you can use the Spherize effect to bulge out a scene a little at the start and gradually
make the entire scene blow up like a balloon.

This new functionality has the same look and feel as Adobe’s very powerful motion graphics and text animation
product: After Effects. This duplication of functionality is purposeful. Adobe has gone whole hog to create a
tightly integrated suite of DV tools—Adobe Premiere Pro, After Effects, Photoshop CS, Adobe Audition™ and
Adobe Encore™ DVD—that look and behave similarly (Adobe Audition has not yet received an Adobe face-lift,
but the other four do feature similar user interfaces).

Task: Try Out Video Effect Keyframing
To see keyframing in action, you’ll apply it to the Posterize effect, gradually increasing and decreasing the cell
size over time. To see how keyframing works, follow these steps:

1. Remove Spherize and any other effects from the ECW.

2. Drag the Posterize video effect (from the Adjust file folder) to the Effect Controls window. Twirl down
the disclosure triangle.

3. Move the CTI to somewhere near the middle of your clip (either drag the CTI within the ECW or in the
Timeline window).
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4. As shown in Figure 11.6, click the Keyframe stopwatch to turn on keyframes. When you do, you’ll note
several changes:

FIGURE 11.6: Switching on the keyframe stopwatch adds a keyframe at the current CTI location plus turns on the
keyframe navigation controls.

• The stopwatch displays a sweep hand to let you know that you have activated keyframes.

• A set of icons appears on the right side of the display. You use them to move from one keyframe to
the previous or next one in a collection. The diamond in the middle enables you to set a keyframe
wherever the CTI edit line is at that moment.

• A little diamond appears in the ECW timeline area. That marks this new keyframe. At the moment,
it’s solid gray. That will change when you add the next keyframe.

5. Change the Posterize Level setting to a large number. Something greater than 20 will do (the larger the
number the more normal the image will look).

6. Move the CTI edit line to the beginning of the clip either by using the Home keyboard shortcut or
dragging the CTI to the beginning in the ECW or the sequence.

Note: ECW’s Mini-Timeline

One other very cool feature of the ECW is its mini-timeline—that section on its right side. If you don’t see it in
your ECW, click the little chevron button in the upper right corner to open it. You can drag its left edge to
widen its view and use the zoom icons at the bottom of the ECW to change its view. It’s a very handy tool.
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7. Decrease the Level setting to 2 (its lowest amount) which maximizes the Posterize effect..

Note: What Just Happened?

When you move the CTI and change the effect’s value, Adobe Premiere Pro automatically adds another
keyframe icon in the ECW. Simply moving it without changing an effect value does not set a new keyframe.
In this case, the keyframe icon is a triangle pointing to the right, indicating that it’s marking the keyframe for
the first frame in the clip. (When you apply a keyframe to the last clip, it’ll be a triangle pointing to the left.)
All other keyframes are diamond-shaped unless you apply interpolation controls to them (see “Using
Keyframe Interpolation Controls” later in this module).

8. Move to the last frame of your clip either by using the keyboard shortcut End or by dragging the CTI in
the ECW mini-timeline or in the sequence.

Caution: When End Means Beginning

Using the End shortcut key can be disconcerting. When you use it on a clip, it doesn’t take you to the last
frame of that clip; it takes you to the first frame of the next clip (if there is no clip at the end of the selected
clip, it’ll display black).

Adobe Premiere Pro’s development team queried the beta group about this behavior, and I voiced my
opposition to it. As it turns out, there apparently was a programming reason that forced their hand, and they
had to stick with this counterintuitive approach.

The team members admit it’s not ideal. In the meantime, if you want to go to a clip’s last frame, press End
and then press the Left Arrow key once to move back one frame so that you can see your work.

Note: Watch Those Keyframe Icons

With two keyframes in your clip, notice how their appearance changes. The one on the left is a white
(actually, a very light gray) triangle. The one in the middle is white on the left and dark gray on the right. The
dark gray indicates it’s the last keyframe—chronologically—in this clip. If you now put a keyframe after it (and
you will in Step 9), it’ll turn completely white to indicate there are keyframes on both sides of it.
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9. Add another keyframe by changing the cell size back to something small like 3. Your ECW should look
something like Figure 11.7.

FIGURE 11.7: After adding keyframes at the beginning, middle, and end of a clip, your ECW should look something
like this.

10. Play your clip. Your video clip transitions from a color saturated abstract painting-like image to a normal
video and back to  that lovely painting again.

Keyframe Manipulation

After you add keyframes, they’re not immutable. You can move them, delete them, add more, and change their
attributes. Here’s a rundown of those methods:

• Add a Keyframe—You already know that you can add a keyframe by moving the CTI to a new location
and changing an effect value there. Another way is by moving the CTI to a frame where you want to add
a keyframe and clicking the little diamond between the two triangles. You can change the value now or
come back to it later.

• Move a Keyframe—First, move the CTI to the new location so that you can see that spot. (If the effect is
so drastic that you can’t see the video well enough, turn off the little f icon until you find the right spot,
and then click the effect f icon back to its on state.) Click and drag the keyframe to position it directly
under the CTI edit line. Unfortunately, Snap to Edges does not work when moving keyframes, so you
might not get absolutely frame-accurate placement.

• Delete a Keyframe—Click on the keyframe and press Delete or right-click on it and select Cut.

• Delete All Keyframes—Click the stopwatch. Adobe Premiere Pro will prompt you before removing all
keyframes from the ECW.
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• Move to a Keyframe—Move to a keyframe by using the two little keyframe navigation triangles or
moving the CTI to a keyframe and noting when the little diamond between those two triangles changes
its appearance, which indicates that you’ve landed on a keyframe.

• Change a Keyframe’s Attributes—Move to a keyframe and then adjust whatever setting(s) you’ve already
applied.

Multiple, Keyframable Attributes

Most video effects offer more than one adjustable attribute. Lightning, for instance, has 25! The ECW makes it
easy to set keyframes for each attribute at any number of points within a clip. This is a huge improvement in
Adobe Premiere Pro over its predecessors. I present
many of those multiple-feature video effects in
Module 17.

For now, feel free to experiment. I suggest using
ZigZag. It’s in the Distort folder. It has two attributes
that create a very cool, pebble-dropped-in-a-pool
effect. When animated with keyframes, you can start
with a few ridges, increase that number, and then
decrease it. Follow the same procedure for the size of
the ridges.

Working With Video Effect Presets

Adobe added a new feature to Premiere Pro 1.5: Effect
Presets. These automate some basic effects and give
you the opportunity to build and then save your own
set of effects and keyframe parameter presets.

To see what this is all about, click the Effects tab and
open the Presets folder. In Figure 11.8, I expanded all
the Video Effect presets with the exception of PiPs
(Picture-in-Pictures), which I’ll discuss in Module 19:
“Compositing Part 2: Alpha Channels, Mattes and
Pictures-in-a-Picture.”

FIGURE 11.8: Effect Presets automatically expands the
timeline view and switches on keyframes so you can see
the keyframes you just set. Straight lines run between
them. You will use Bezier interpolation to change those
lines to curves.

Premiere Pro 1.5 ships with five video effect presets: Bevel Edges, Blurs, Mosaics, Solarizes and Twirls. Each set
has a preset for the beginning of a clip and one for the end: an In effect and an Out effect.
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Apply Twirl In to a clip. Using
Figire 11.9 as a reference, note
that it displays in the ECW with
the disclosure triangles already
open and with keyframes
applied.

FIGURE 11.9: Each Effect Preset
has keyframes and parameters
already set.

Play this clip to see the Twirl effect in action. The clip starts as a vortex and gradually settles down to a regular,
full-frame video clip. This preset saves you the extra steps of setting those keyframe attributes. What you can do
now is change the parameters: move the keyframes, change the Twirl Radius or Angle, or move its center point
(you can keyframe that as well, moving the center point around the clip as it spins).

If you make any changes and want to use that basic set of parameters on other clips, you can save your preset by
clicking on its name, opening the ECW wing menu and selecting Save Preset. Then give it a new name, note
whether it should anchor at the beginning or end of your clip or whether to scale it proportionately to the length
of any clip you apply it to. Then click OK. Your new preset will appear immediately below at the top of the Preset
folder.

Using Bezier Keyframe Interpolation with Video Effects

Another very slick additional tool new to Adobe Premiere Pro 1.5 is Bezier keyframe interpolation. You use this to
adjust the rate of change for an effect attribute as it moves away from a keyframe and approaches the next
keyframe.

Effects normally change linearly over time. That is, if you were to graph an effect’s values on the Y axis and time
on the X axis, it would define a straight line.

Task: Using Bezier Keyframe Interpolation
Using Bezier keyframe interpolation, you can turn the start and end points of that line into curves; that is, ease
out of a keyframe and quickly accelerate into the next one. It works in the same way you adjust handles on a text
path in the Title Designer. Here’s a quick overview:

1. If you still have the Posterize effect applied to a clip, delete it and  add Horizontal Hold I want you to use
Horizontal Hold because the changes it creates on a clip are very obvious.

2. Give it three key frames: Set the start Offset value to 50 (nearly fully skewed to the right) move one-third
the way into your clip and change the Offset to about 450 (nearly fully skewed left), move two-thirds in
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and set the Offset back to 250 (normal) and move to the end and set that to 200. I want you to not select
the maximum or minimum
values so you can better
work with the Bezier curves
in the Timeline window.

3. Using Figure 11.10 as a
reference, expand the view
of your Video 1 track, click
the Show Keyframes
button, and select the
Horizontal Hold/Offset
keyframes as the ones you
want displayed. Note that
the lines connecting each
keyframe are straight. You
will use Bezier keyframe
interpolation to change
them into curves.

FIGURE 11.10: Expand the timeline
view and switch on keyframes to see
the keyframes you just set. Straight
lines run between them. You will use
Bezier interpolation to change those
lines to curves.

4. Right-click on the first keyframe in the ECW and take a look at the context menu (refer to Figure 11.11).
You have seven options:
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FIGURE 11.11: Bezier keyframe interpolation tools enable you to give attribute changes a bit more of a realistic feel.

• Linear—Straight line interpolation of an effect’s parameter (this is the default keyframe condition)

• Bezier Gives you precise control over an effect parameter’s behavior at a keyframe

• Auto Bezier —Creates a smooth rate of change at a keyframe no matter how you change the Bezier
handles (which operate in unison)

• Continuous Bezier—It too creates a smooth rate of change but you can adjust each handle
individually

• Hold--Holds the current keyframe attribute until the next keyframe or the end of the clip

• Ease In and Ease Out—An automated Bezier curve that gradually increases or decreases an effect
parameter’s rate of change as it move from or toward a keyframe.

5. Select Ease Out. That does two things: It changes the keyframe’s icon to an hourglass shape to indicate
that it has a Bezier interpolation applied to it.
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6. In the Timeline window, note that a curved line
now runs from the first keyframe to the second.
Click on that first keyframe and note that a thin,
blue handle line appears. That’s the Bezier
handle (I’ve annotated it in Figure 11.12). Click
and drag it. Note how the curve changes.
Lengthen or shorten the handle and note how
that affects the curve.

FIGURE 11.12: Changing the keyframe interpolation to
Ease Out, creates a Bezier handle at that keyframe.

7. In the ECW, right-click on the second keyframe
and select Continuous Bezier. Note in the
Timeline window that as you move one of that keyframe’s new Bezier handles, the other moves in the
opposite direction assuring a smooth rate of change. The curve on one side of the keyframe has the
same basic shape (except that it’s a mirror image) as the other side.

8. In the Timeline window right-click on the third keyframe and select Auto Bezier. Note that a small circle
appears in the ECW. However, if you make
any changes to the keyframe in the
Timeline window, it reverts to a
Continuous Bezier keyframe. Also note that
when you click on a Bezier keyframe, the
handles of adjacent keyframes switch on.
Figure 11.13 demonstrates that.

FIGURE 11.13: When you click on a Bezier keyframe,
handles on adjacent Bezier keyframes display, letting
you know that you can change the characteristics of
the rate of change using those keyframes as well.

9. Play this clip and note how the behavior of
the Horizontal Hold behaves now that you have created smooth curves at each keyframe. Depending
on how steep or shallow your curves are, the rate of change will increase dramatically or gradually.

10. Finally, move the keyframes in the Timeline window. You can adjust their values by moving them up
and down or move them in time by sliding them left and right.
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Non-Keyframable Effects

Not all video effects are keyframable. They simply do something with no parameters. Here’s a list:

Anti-Alias—This effect is found in the Blur file folder. Just as anti-aliasing in transitions blurs sharply defined
diagonal lines, this effect softens the edges between highly contrasting colors.

Black & White—Found in the Image Control file folder, this effect converts color clips into grayscale.

Facet—Found in the Pixelate file folder, this effect creates the oil-painting look.

Field Interpolate—Found in the Video file folder. This is a technical fix, not a creative tool. It re-creates missing
scan lines dropped during capture.

Gaussian Sharpen—Found in the Sharpen file folder, this effect is supposed to dramatically sharpen a clip, but it
looks more like the Crystallize effect.

Ghosting—Found in the Blur file folder, this very nifty effect creates a "comet tail" on any moving object
(including camera moves). It's great for showing the flight of a thrown/hit/kicked ball. A steady camera is a must.

Horizontal Flip—Found in the Transform file folder, this effect reverses a clip left to right but still plays the clip
forward. Use it if you broke the plane while shooting a cutaway.

Sharpen Edges—Found in the Sharpen file folder, this effect looks just as odd as Gaussian Sharpen. Apparently,
it's only effective for very soft focus clips.

Vertical Flip—Found in the Transform file folder, this effect flips clips upside down.

Vertical Hold—Found in the Transform file folder, this effect makes your clip look like the vertical hold is out of
whack.
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Adobe Premiere's video effects run the gamut from mundane and technical to dazzling and exciting. Adding
video effects is a simple drag-and-drop process. It’s easy to combine a variety of effects on one clip.

By putting virtually all the effects features in the Effect Controls window, Adobe Premiere Pro makes it easy to set
the behaviors of those effects. In addition, you can change those behaviors over time by using keyframes. And
you can apply keyframes individually and independently to every attribute listed in the ECW. Using keyframes
and Bezier curves to control those effects make them that much more entertaining and effective.

Q. When I apply a video effect to a clip, it doesn’t show up in the Monitor window’s Program screen. How
am I supposed to see any changes I apply to this clip?

A. Even though you’ve selected that clip by clicking on it or dragging an effect to it, you still need to move the
CTI’s edit line to that clip for it to display in the Monitor window Program screen.

Q. I’ve selected a clip and am working on it in the ECW. I clicked End to move to that clip’s last frame, but
all I see is a black screen in the Monitor window Program screen. What’s going on?

A. This is an Adobe Premiere Pro anomaly. Pressing End takes you to the first frame of the next clip. To see the
last frame of the selected clip, press the Left Arrow key once.

Quiz

1. You want to make a clip gradually shift to black-and-white for the duration of that clip. How do you do that?

2. How do you make an effect start within a clip rather than at the beginning?

3. You want your effect to jump out of the gate but slide gradually into the next clip. How do you do that?
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Quiz Answers

1. Razor the clip somewhere near the middle. Apply Black & White to the second half. Apply a Cross Dissolve
transition to the edit. In the ECW, drag the ends of the Cross Dissolve transition all the way to the beginning
and end of the razored clips. If you can’t see the entire clip in the ECW, expand your view by clicking the little
hill icon at the bottom of the window.

2. Use a keyframe. Move the CTI to the frame where you want to start the effect and click the keyframe
stopwatch. That sets the first keyframe. You can add other keyframes after that point if you want.

3. Use keyframe interpolation controls. Right-click on the first keyframe and select Fast Out. That automatically
sets the next keyframe (the last keyframe in this case) to Slow In.

Exercises

1. Layer multiple video effects on the same clip. You might try Crystallize, Solarize, and Replicate. Alternatively,
apply Horizontal Hold and Vertical Hold to the same clip. Change the order to see whether that makes any
difference.

2. With those or some other multiple effects, apply keyframes to turn them on and off at different times. You
might set Pointillize to start changing off the top, and then bring in ZigZag later to give that animation a
"ripply" feel. The more you experiment, the better the chance that you’ll discover some very cool effect
combos that work well for you.

3. Use video effects to make apparent video transitions. To do that, apply the same effect to adjacent clips. Use
keyframes to gradually change the effect in the first clip until, in the case of Crystallize, for example, it’s a
jumbled mess by the end of the clip. Then start the next clip at that same jumbled mess setting and
gradually minimize the mess to reveal the true clip appearance.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education
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Module 12

Putting Video and Still Clips in Motion

You've seen videos with clips flying over other images or that spin video clips onscreen—having them start as
small dots and expanding to full-screen size. Your students can create those effects using Adobe® Premiere®
Pro's motion settings.

To add some realism, they can add drop shadows to those moving clips. Finally, Adobe Premiere Pro can impart
motion to still images: panning and zooming to add interest.

At the end of this lesson, students will have learned about:

• Applying motion

• Enhancing motion—Changing size and adding rotation

• Using Bezier keyframe interpolation on motion paths

• Giving clips a 3D look

• Working with still images—special issues

Applying Motion and Changing a Clip’s Size

Adobe Premiere Pro’s Motion effect is a significant improvement over the Motion Settings window used in its
predecessors. That previous, separate interface presented editors with some arcane and nonintuitive controls.
For me, its two redeeming features were its looping preview mode that gave immediate feedback for any
changed motion settings and its Skew feature.

With Adobe Premiere Pro’s capability to play every effect in real-time in the Monitor window Program screen,
the loss of the looping preview is inconsequential. And you can use the Transform effect to apply Skew to a clip.

What you gain is four things:

• All your motion control work takes place within the Effect Controls and Monitor windows

• Direct motion settings using either on-screen drag-and-drop methods or numerical values in the Effect
Controls window

• Precise keyframe control over several motion aspects

• Bezier Keyframe interpolation lets you put objects in motion along curved paths

To see motion controls in their best light means displaying them over a background. To do that in Adobe
Premiere Pro means placing the clips in a track other than Video 1 and using some other clip on Video 1 to serve
as a background. This is an example of compositing or layering. I'll cover that subject in detail starting in Module
18, “Compositing Part 1: Layering Images and Clips.” For this coming exercise, you’ll keep things simple and use
a solid color matte as that background.
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Task: Setting Up Adobe Premiere Pro to Apply Its Motion Effect
As you become more comfortable with Adobe Premiere Pro, working with the Motion effect will become second
nature. But I believe in starting with the basics, and that means, for now, I want to present the Motion effect in its
simplest form. To do that, you first need to set up your sequence, Effect Controls window, and Monitor window
to get a clear picture of how this effect works. Here's how to do that:

1. Switch to the Effects workspace by selecting Window > Workspace > Effects. Then clear your sequence
by deleting all clips on it.

2. Create a color matte by clicking the New Item button in the Project window, selecting Color Matte,
choosing a color, clicking OK, giving it a name, and clicking OK.

3. Drag that color matte to Video 1.

Tip: Why a Color Matte for a Background?

You could place a video clip or still image on Video 1 to serve as a backdrop for the clips you'll put in motion
over that backdrop. I prefer using a matte at this point because it’s less distracting and makes it easier to see
how the Motion effect works.

4. Drag a video or linked video/audio clip to the Video 2 track (if your sequence does not have a Video 2
track, drag the clip to
the gray area above
Video 1 to
automatically create
a new video track).
This will be the clip
you’ll put in motion.
Trim it to about 20
seconds.

5. Extend the color
matte to equal the
length of the video
clip. Your sequence
should look like
Figure 12.1.

FIGURE 12.1: How your sequence should look to carry out this exercise.

6. Click on your clip in Video 2 to select it.

7. Open the Effect Controls window. Click Motion to switch on that effect (or click on the clip image in the
Monitor window Program screen) and twirl down all the disclosure triangles. As shown in Figure 12.2,
that opens up five "keyframable" options:

• Position—The screen location of the clip’s anchor point (its center unless you change the anchor
point). Because the NTSC screen size is 720x480, the default starting values of 360 and 240 place the
center of the clip at the center of the screen. 0,0 puts the center in the upper-left corner and 720,
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480 puts it in the lower right. You can drag the clip completely off-screen, meaning that the values
can be less than 0 and greater than 720 and 480.

• Scale—The relative size of the clip. The slider has a range from 0% to 100%, but you can use the
numerical representation to increase the clip size to 600% of its original size.

• Scale Width—You need to uncheck Uniform Scale to make that active. Doing so  enables you to
change the width and height independently.

• Rotation—The first figure represents the number of full 360-degree spins. A positive number is
clockwise and a negative number is counterclockwise. The maximum value for each direction is 90,
meaning that you can apply up to 180(!) full rotations to a clip. The second figure represents a
partial rotation and goes from -360 to 360 degrees.

• Anchor Point—The center of the rotation, as opposed to the center of the clip. You can set the clip
to rotate around one of its corners or around a point outside the clip, if you so choose.

8. To work more effectively with the Motion effect, change the zoom level of the Monitor window
Program screen by clicking the drop-down list highlighted in Figure 12.2 and selecting 50% or less. This
will give you more screen real estate when dragging a clip completely off-screen.

FIGURE 12.2: Select Motion and twirl down the disclosure triangles to view the five, keyframable motion settings
options. Uncheck Uniform Scale to make Scale Width available.

Note: Effects with Motion Controls

Several video effects have a Motion Control component. I cover them in Module 17, “Using Higher Level
Video Effects.” For now, if you want to see what I’m talking about, take a look at Transform, Twirl, or Crop.
Each sports that little bounding box icon that indicates it offers motion controls.

Each of those effects has its own unique application of motion controls. Of particular interest is Transform.
It’s the video effect used by Adobe Premiere Pro’s design team to serve as the foundation for the fixed
Motion effect. The team included it as a separate video effect, in part, because it offers additional features
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such as the capability to skew the clip and enables you to add a drop shadow that works properly with a
rotating clip.

Note: Uniform Scale—As It Pleases You

Feel free to uncheck the Uniform Scale box. Doing so means that you can set Width and Height
independently and keyframe them separately.

Task: Applying Motion to a Clip
Working with the Motion effect is a lot like working with a text bounding box. Switching on the Motion effect
places a bounding box around the perimeter of the video clip or still image. Not only can you adjust it using
numeric values in the ECW (Effect Controls Window), but you also can manipulate it directly in the Monitor
Program screen. You can drag it to a new location, change its shape and size, and rotate it. Here’s how it works:

1. Press Home to put the CTI (Current Time Indicator) edit line at the beginning of your clip.

2. Turn on keyframes by clicking the stopwatch next to Position.

3. Click on the word Motion to switch on that effect (or click on the clip image in the Monitor window
Program screen). That places a bounding box around the clip in the Monitor window Program screen.
Click on its center crosshairs and drag the bounding box (and the clip inside it) completely off the left
side of the screen. Use Figure 12.3 as a reference.

FIGURE 12.3: Click on the clip bounding box crosshairs and then drag the clip off screen. Note the Position numeric
values that correspond to moving the clip off the left side of the screen.
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Note: Checking Position Numeric Values

In my example (shown in Figure 12.3), the Position numeric values in the ECW are -360 and 240. That means
the clip’s center is 360 pixels to the left of the left edge of the screen, which puts the full-screen clip just off
screen. The 240 means the center of the clip is on the extended horizontal centerline of the screen. Because
you've slid the entire clip off screen, the Monitor window Program screen should display a full-screen view
of the color matte on Video 1.

4. By moving the CTI, turning on keyframes, and dragging the clip to a new location, you automatically
added a keyframe at the start of the clip. You’ll do the same for the clip’s last frame. Move the CTI edit
line to the end of the clip by clicking End and clicking the left arrow once.

5. Instead of dragging the clip to a new location, change the numeric values to 1080 and 240. That will put
it completely off the right side of the screen—720+360=1080—and keep it on the screen’s horizontal
center line.

6. Press Home and the spacebar to play the clip. It should start completely off screen to the left then
gradually work its way horizontally until it slides off screen to the right.

7. Now you'll add two more positions toward the middle of the clip to make the clip move from the left to
above the center of the screen, straight down to the bottom and angle off beyond the right side of the
screen. Start that process by moving the CTI edit line about a third of the way into the clip and then
dragging the clip bounding box or inputting numeric values to move the clip off the top center of the
screen (numeric values: 360, -240).

Note: Developer Comment—Why Upper Left Is 0,0

There's no official answer, but the likely reason has to do with the standard way coordinate systems work on
Windows, which has the (0,0) coordinates point to the upper-left corner of the screen. This has been the case
since Windows 1.0.

There are more evolved (some might say resolution-independent) coordinate systems available on Windows
that have the lower-left corner defined as (0,0), but most app developers never use these, since it makes it
harder to design good-looking interfaces with that system.

8. Move the CTI edit line about two-thirds of the way into the clip and then drag the clip or input numeric
values to move the clip off the bottom center of the screen (numeric values: 360, 720).
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9. Take a look at the motion tracking lines in the Monitor window’s Program screen. Figure 12.4 shows
how yours should look with the CTI set to slightly past the mid-point of your clip. Move the CTI and note
how the tracking line display moves with the CTI,
always showing the motion path before and after
the current location of the CTI. Also note that the
dotted line indicates the relative speed of the clip
along the path. The wider the spacing between
dots, the faster the motion. Finally, new to
Premiere Pro 1.5 is the default Bezier curve
motion setting. All motion now falls on smooth
curves. You can change that to linear motion (I’ll
show you how in an upcoming section: “Using
Bezier Keyframe Interpolation on Motion Paths”).

FIGURE 12.4: The motion tracking dotted lines show the
entire Position path. The image position is slightly after the
midpoint of the complete motion path.

Caution: What Happened to the Motion Tracking Lines?

If you click somewhere outside the Motion effect portion of the ECW, the motion tracking lines disappear (as
will the clip bounding box).

The reason? By clicking elsewhere, you deselect the Motion effect. To switch those lines and the clip
bounding box back on (along with other motion features), simply reselect Motion by clicking its name in the
ECW or clicking on the clip image in the Monitor window Program screen.

10. Press Home and the space bar to see the animation. You should see the lower-right corner of the clip
slide diagonally from the left side to above the screen, move vertically straight down the screen (filling
the view edge to edge at its midpoint), and then move diagonally off and up to the middle-right side.

Enhancing Motion—Changing Size and Adding Rotation

Simply sliding a clip around only begins to exploit Motion effect’s possibilities. What makes the Motion effect
really cool is the capability to shrink or expand the clip and to spin it.

In particular, you can start a clip full-screen (or zoom in even farther) and then shrink it to reveal another clip
below it on the sequence. You can spin a clip onto the screen starting as a small dot and then spin it off the
screen, having it grow or shrink as it moves away. And you can layer multiple clips, creating several pictures-in-a-
picture. I cover that latter technique in Module 19, “Compositing Part 2: Alpha Channels and Mattes.”
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Task: Changing the Clip Size
The steps you follow to add these features are not much different than setting the position values. But there are
some keyframe timing issues that you can use to enhance these motion features. Here’s a basic rundown of how
to enhance motion:

1. Clear the Motion Position settings you created in the previous task by clicking the Position Keyframe
stopwatch icon. Adobe Premiere Pro will prompt you to make sure that this is what you want to do.
Click OK.

2. To remove any changed Motion setting vestiges, click the Reset button (located to the right of the word
Motion in the ECW).

3. This first part of this coming complex Motion effect will be to have the clip start as a tiny dot in the
upper-left corner, grow to full-screen, and then shrink down to the lower-right corner. Start by pressing
Home to place the CTI at the beginning of the clip, switch on keyframes for Position, and move the
center of the clip to the upper-left corner (position 0,0).

4.  Switch on the keyframe stopwatch for Scale and drag the slider to zero (or change the numeric value to
zero). That sets the size to zero for the beginning of the clip.

5.  Move the CTI about a third of the way into the clip and press Reset (yes, the Reset button can come in
handy) to create two keyframes with default settings (clip at full size and centered in the screen).

6.  Move the CTI about two-thirds of the way into the clip and press Reset again. Doing that causes the clip
to remain centered and at full screen for the time between the two keyframes.

9. Move the CTI to the end of the clip (press End and the Left Arrow button once) then move the clip to the
lower right (720,480) and change the Scale back to zero. At this point, your ECW should look like Figure
12.5.

Note: Bezier Handle versus Clip Handle Confusion

If you try to move the clip by grabbing its center crosshair, you will probably grab its Bezier handle instead.
The cursor’s appearance tells you its function. Move your cursor anywhere inside the bounding box except
on the center crosshair and note that it has a black border, meaning you can click and drag the entire clip. If
instead you hover the cursor over a Bezier handle (in the crosshair in this case) it has a black and white
border with a little circle next to it. If you click and drag you will change the nature of the Bezier curve.
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FIGURE 12.5: How your motion settings should look after setting the fourth set of keyframes for Position and Scale.

Sidebar: Why Not Use Reset to Clear All Motion Settings?

The Reset button can be a handy tool or an aggravating nuisance. Clicking Reset leads to one of three
results:

• If you haven't set any keyframes (or have cleared keyframe settings by switching off all the
keyframe stopwatches), clicking Reset returns all changed motion settings to their default values.

• If you've set keyframes for only one motion setting (such as Position, for example), moving the CTI
to a keyframe and clicking Reset returns the values at that keyframe to their default setting.

• Things can get aggravating if you have set keyframes for more than one Motion feature (or multiple
features for any other video effect). If you move the CTI to a keyframe and click Reset, Adobe
Premiere Pro returns that keyframe to its default settings—and—creates keyframes at that point for
all other motion settings that have keyframes turned on and sets all those new keyframes to their
default settings. This can be a royal pain, so be careful when using Reset.

10. Preview this Position/Scale combo Motion effect by pressing the Home key and the space bar. The clip
should grow from a tiny dot in the upper left and move to full-screen in the center, hold there for a
while, and then shrink to a dot while moving to the lower-right corner.
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Task: Adding Rotation
Finally, you’ll add rotation using some new keyframes as well as change the rotation center—or anchor point. In
the end, you’ll impart your clip with some complex characteristics. This is the most detailed of all the tasks in this
module. Its purpose is to give you a complete look at rotation characteristics. Here’s how to wrap up this effect:

1. Add Rotation to this clip by pressing Home to position the CTI edit line at the beginning of the clip.
Switch on the Keyframe stopwatch for Rotation. That sets a starting keyframe for Rotation without
applying any rotation to the clip.

2. To have the rotation stop just before the clip reaches full-screen size, move the CTI to just before the
second set of keyframes.

3. You can manually rotate the clip a few times
by moving the cursor to just outside the
bounding box to switch on the rotation icon
(as shown in Figure 12.6) and dragging it
around the clip a few times (for this exercise,
do it clockwise). The easier and more
exacting method is to change the first
Rotation value to something like 4 (for four
full clockwise rotations). The second number
is degrees and represents a partial rotation.

FIGURE 12.6: You can manually rotate the clip by
moving the cursor until this icon appears and then
dragging it around the clip bounding box.

4. Move the CTI to just past the third set of Position and Scale keyframes and click the little Rotation
keyframe diamond (between the two keyframe navigation triangles) to create a new keyframe without
making any changes to the rotation settings.

5. Move to the end of the clip (press End and the left-arrow key—or—click either the Position or Scale
keyframe right navigation triangle). Rewind your clip rotation by manually spinning it counterclockwise
four times or changing the first Rotation setting back to 0 (four counterclockwise rotations to return it to
its default position). If you set it to -4 (minus 4), it would rotate counterclockwise 8 times.

6. Return the CTI to the clip’s first frame by pressing Home.

7. Turn on the anchor point’s keyframe stopwatch and set the numeric values to 0,0 (the clip will spin
around its upper-left vertex).

8. Move to the Rotation’s second keyframe by clicking its keyframe navigation triangle and then change
the anchor point’s numeric values to 720,480 (setting the clip’s rotation vertex to its lower-right corner).

Caution: Changing the Anchor Point Changes the Position

If you preview at this point, the results might surprise you. The clip will not settle in the center of the screen.
Rather, it will end up in the upper-left corner. The reason? Changing the Rotation's anchor point sets that
location as the point the Position “thinks” is the center of the clip. In this case, to get the clip centered in the
screen, you’ll need to change the Position values. Do that in Step 9.
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9. Move to the Position’s second and third keyframes and change those values from 360,240 to 720,480.
Because the anchor point is the clip’s lower-right corner, using these values places that corner at the
lower-right corner of the screen, thereby placing the entire clip squarely in the center of the screen.

10. Use Rotation’s keyframe navigation controls to move to that feature’s third keyframe and then click the
anchor point’s keyframe diamond to set a new keyframe there without changing its current value (using
Rotation’s keyframes to set an anchor point keyframe means that they’ll fall at the same place in the
sequence).

11. Move to the clip’s last keyframe by pressing End and the left-arrow key.

12. Change the anchor point to the clip’s upper-right corner by changing its value to 720,0. Your ECW
timeline should look something like Figure 12.7. (I moved the CTI edit line to a position near the
beginning of the clip to better display its motion path in the Monitor window.)

FIGURE 12.7: How your ECW timeline should look after adding keyframes for all Motion elements.

13. Preview your motion settings by pressing Home and the space bar. If all goes well, the clip will spin on
screen from the upper-left corner, its vertex will shift as it spins, it’ll grow to full-screen size, and it will
then spin down to the right with the vertex shifting once again.

Using Bezier Keyframe Interpolation on Motion Paths

I introduced Bezier Keyframe Interpolation in the previous Module: “Working with Video Effects.” When working
with video effects, Bezier keyframe interpolation affected the rate of change of an effect’s parameter. In the case
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of motion settings, Bezier keyframe interpolation also affects an object’s movement through the screen. Adobe
likes to say you use Bezier keyframe interpolation controls to change the way an effect behaves both spatially
and temporally—in space and time.

You make the temporal changes in the ECW or the Timeline window by setting keyframe locations and then, if
desired, using Ease In, Ease Out or changing the Bezier handles to adjust the length of the path approaching or
moving away from a keyframe. You adjust spatial settings in the Monitor window Program screen or changing
Motion Parameter values in the ECW to change the physical location of keyframes within the screen real estate.

Take a look at Figure 12.8. In it I set three Motion/Position parameters, spaced equal distance apart in the ECW.
By default Premiere Pro set each keyframe’s Spatial Bezier interpolation to Auto Bezier creating a smooth curve.
By default the Temporal interpolation is set to Linear.

I grabbed and lengthened one Bezier handle,
increasing the length of the curve leading into
the keyframe. That changes the Spatial (location)
characteristics of the keyframe and lengthened
the path caused the clip to speed up. That faster
motion is because the clip now covers more
distance in the same time.

FIGURE 12.8: Motion Position keyframes are by
default set to Auto Bezier. Lengthening a handle
typically increases the length of the curve, thereby
speeding up the clip motion along
that path.

You can change the Interpolation
characteristics by right-clicking on
a keyframe in the Program screen,
the ECW or in the Timeline. In
Figure 12.9 I right-clicked on the
second keyframe in the ECW and
changed its Temporal
Interpolation to Ease Out. Note a
few things: the keyframe icon
changes to an hour glass
(meaning it now has a Bezier
Temporal Interpolation setting),
and the keyframe line in the
Timeline window changed from a
straight line to a curve.

FIGURE 12.9: You can access
Bezier Keyframe Interpolation
options from three locations: the
ECW, the Monitor window and the
Timeline window.
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That line in the Timeline window indicates the relative speed of the object in motion. If the line is at the bottom
of the clip view, the clip is not moving. If it’s at the top, the clip is moving at top speed. So, when applying the
Ease Out Bezier Temporal Interpolation, the clip starts moving slowly, accelerates then kind of eases into the
next keyframe.

If I change that next keyframe to Ease In, the curve changes into a parabola, as shown in Figure 12.10. That is it
accelerates out of the 2nd

keyframe and decelerates as it
approaches the 3rd keyframe.

FIGURE 12.10: The Timeline
window keyframe display
shows the relative speed of the
motion. If you set adjacent
keyframes to Ease Out and Ease
In, the speed curve becomes a
symmetric parabola.

You can use the Pen tool
(keyboard shortcut ‘P’) to select keyframes within the clip in the Timeline window and adjust handles there to
change the relative speed of the object in motion as well as move the keyframes in time left and right.

To master Bezier Keyframe Interpolation you need to experiment. Set keyframes for other parameters, right-click
on them in the Timeline, Monitor and ECW to make changes. And use the Pen tool to adjust characteristics in the
Timeline window.

Giving Clips a 3D Look

Pictures-in-pictures have a much more realistic feel when those pictures have drop shadows. And adding
borders or frames further enhances that look. You’ll do both in this coming task.

Task: Adding Shadows and Frames
Adding these two characteristics to moving clips is surprisingly easy. You simply use two video effects: Drop
Shadow and Bevel Edges. Here’s how you do this:

1. Clear all motion characteristics by clicking each keyframe stopwatch and clicking the Reset button.

2. Shrink your clip by changing its scale to 50% (you can’t see the drop shadow if your clip is full screen).

3. Apply the Drop Shadow video effect to your shrunken clip by dragging it from the Perspective folder to
the ECW.

4. Twirl down all of Drop Shadow’s disclosure triangles to reveal its six options:

• Shadow Color—Set it to any color you want. You might want to have it be a darker version of your
matte color.

• Opacity—Most shadows aren't opaque. You can vary to match the lighting of the original clips.
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• Direction—The point indicates in which direction the shadow will fall. Using keyframes, you can
vary that direction such that the shadow spins around the clip.

• Distance—How far the shadow falls from edge of the clip.

• Softness—Give your shadow hard edges or let them disappear gradually.

• Shadow Only—Switch off your clip and display only its shadow.

5. Give your shadow some distance and some softness (values of 30 for both features work well). Your
settings and Monitor window display should look something like Figure 12.11.

FIGURE 12.11: Use Drop Shadow’s keyframable options to create a more realistic look for your motion effects.

6. Use Position keyframes to give your clip some motion. Preview your work and note that the shadow
follows the clip perfectly.

Caution: Motion Effect’s Rotation Does Not Work with Shadows

If you use the Motion effect to apply rotation to your shadow and clip, the shadow will rotate with the clip as
a single unit. That’s unrealistic. It should always fall away from the rotating clip in the same direction. To get
a realistic drop shadow with rotation applied, you need to use the Transform video effect. I cover that in
Module 20, “Tips, Tricks and Techniques: Part 1.”



Adobe Digital Video Curriculum Guide – Module 12 12-14

Adobe Digital Video CURRICULUM GUIDE

7. Add a very nice frame to your clip by dragging Bevel Edges from the Video Effects, Perspective folder (or
use one of the Bevel Edges Presets) to the ECW above Drop Shadow and below the Video Effects section
label. Twirl down its disclosure triangles. Your setup should look like Figure 12.12.

FIGURE 12.12: Use Bevel Edges to give your moving clip a nice framed look.

Caution: Video Effects—Order Counts

You need to place the Bevel Edges effect above Drop Shadow because Adobe Premiere Pro applies effects
in order from the top of the Video Effects group and down. Therefore, if Drop Shadow were at the top, Bevel
Edges would apply its frame effect to the clip and the shadow. Not a desirable result.

8. Change the Light Angle value to the complement of the Drop Shadow Direction (add or subtract 180
degrees from the Drop Shadow Direction value) so that the bevel and shadow look realistic (the default
Direction and Light Angle values for Drop Shadow and Bevel Edges are such that the shadows should
already be in proper alignment).

9. Adjust the Edge Thickness setting to suit your tastes and change the Light Intensity value so that it
works well with your drop shadow’s Opacity and Softness qualities.

10. Preview your work.
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Tip: Making an Opaque Frame

It can be a bit disconcerting to have animated beveled edges. If you want to turn those edges into solid
color (or at least darker) frames, simply select a dark light color (yes, the nomenclature can be confusing)
and increase the Light Intensity value to bring out the 3D beveled look.

Tip: Another Framing Option

Adobe Premiere Pro is chock-a-block with multiple means to an end. Along those lines, try the Clip video
effect to make a frame. It adds a border using a color or colors (this feature is keyframable) you select to a
solid rectangular border. That border steals pixels from the edge of your clip, so this is not a perfect solution,
but it's easy and effective. I cover it in more detail in Module 17.

Layering Clips in Motion

Placing one clip in motion—with a drop shadow and a frame—is a reasonably cool effect. It becomes much
more interesting if you fly a collection of clips around the screen. I cover that technique in Module 19.

In one of the upcoming end-of-module exercises, I suggest you experiment with that. The basic procedure is to
place several clips, one above the other, on separate video tracks. Then give motion settings, drop shadows, and
beveled edges to each in turn.

Working with Still Images—Special Issues

Unlike its predecessors, Adobe Premiere Pro does not automatically change the size and aspect ratio of imported
still images and graphics to match the project settings (in most cases 720x480 pixels). Rather, Adobe Premiere
Pro preserves those clips’ original sizes and aspect ratios.

That means if you import a large image (greater than 720 pixels wide or 480 pixels tall in most cases), Adobe
Premiere Pro centers it in the Monitor window screens and truncates it. Unless you take some steps to shrink that
image to fit, only the center portion that fits the project resolution will end up in your final project.

On the other hand, if you import a small image, Adobe Premiere Pro does not blow it up to fit. Adobe Premiere
Pro centers the image and displays it in its original resolution.

Tip: Blowing Up Small Resolution Images Can Be Messy

When possible, always use still images that are at least as large as your project resolution. If you use smaller
resolution images and then zoom in on them, they lose visual quality. Sort of like a digital zoom on a
camcorder. You end up with blocky chunks.

This resolution retention is an excellent development. It’s predicable and, more importantly, it enables you to
put large clips in motion while maintaining a relatively high screen resolution. You’ve seen those Ken Burns
public TV specials with all their stills-in-motion. Adobe Premiere Pro lets you do the same thing easily.

Rather than take you through a Task, I’ll briefly explain how to do it and illustrate that process with a few figures.
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Zooming In on a High-Resolution Image

I like to make family tree videos and DVDs,
so I frequently work with old family photos
and documents. Figure 12.13 shows a
portrait that I captured at 1,150x1,650
resolution. When placed on a sequence
and displayed in the Monitor window
Program screen, only the center 720x480
pixels display.

FIGURE 12.13: When working with a large
format image, Adobe Premiere Pro displays
only the center 720x480 pixel portion.

Here’s how I turn that large format image
into an attention-holding zoom:

1. I place the still image on Video 2
and drag the clip’s right edge to
lengthen it from the default 5-
second duration for still images.

2. I create a new color matte using a
color that complements the
photo’s sepia tone and place it on
Video 1 beneath my image clip.

3. I want to start wide on this image
and zoom in on the faces of the
two young men. To do that, I use
the Motion effect and reduce the
Scale setting (in this case to 30%).

4. As shown in Figure 12.14, I also
switch on the Safe Margins display
to ensure that I don’t put
important parts of the image
outside the viewing area of most
NTSC TV sets.

FIGURE 12.14: Use the Motion effect Scale
feature to zoom out from a high-resolution
image. Turn on Safe Margins to avoid
clipping important photo elements.
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Tip: Turning on the Safe Margins Display

As a reminder, to turn on the Safe Margins display, click the Monitor window Wing Menu disclosure triangle
and select Safe Margins.

5. I place the CTI edit line on the
photo’s first frame and switch
on the Position and Scale
keyframe stopwatches to set
the zoomed-out view as the
starting point.

6. I move to the end of the clip.
There I change the Position
and Scale settings (thereby
setting new keyframes) to
zoom in on the portrait to the
point shown in Figure 12.15.

FIGURE 12.15: Use the Motion effect to
zoom in to add a little drama to a still
image.

You can use the Motion effect in
myriad ways to add interest to still
images. Pan across wide shots, zoom
out to reveal an interesting detail, or
zoom in on an individual in a family portrait and then add an oval highlight (I show you how to do highlight
portions of a clip in Module 20).
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Adobe Premiere Pro’s new Motion effect is a wonderful tool. It can add drama to static images, and it allows you
to change image sizes, fly them anywhere on and off the screen, as well as rotate them. You can further enhance
those motion characteristics by adding drop shadows and frames to your animated clips.

The Adobe Premiere Pro implementation of the Motion effect is a significant improvement over its predecessors.
Now all the motion work takes place within the Effect Controls and Monitor windows, you can apply motion
settings using a simple drag-and-drop method or the more precise numeric value approach, and all of its
features are keyframable, giving you a full range of control.

Q. I rotate a clip two times when bringing it on screen, and then set the rotation value to –2 (minus 2) to
spin it back off. But it spins four times, not twice as I’d expect. What’s going on?

A. The number of spins equals the difference between two keyframe rotation values. So, you rotated the clip
twice to bring it on, using a Rotation numeric value of 2. But when you set the numeric value to -2 to spin it off,
the difference between the two settings is 4—four counterclockwise spins. Set the Rotation value back to 0
(zero) to have it spin counterclockwise twice.

Q. I import a photo, but when I view it in the Monitor window, I see only part of it. I changed the View
Zoom Level value and the screen size changes, but I still see only that same portion. What’s up?

A. Previous versions of Adobe Premiere used to shrink or expand still images to fit the project resolution and
aspect ratio (usually standard TV—4:3). Fortunately, that behavior is now a thing of the past. Now you can
import images as large as 4,000x4,000 pixels. But Adobe Premiere Pro will display only the center 720x480 pixel
portion of such large format images. To see your entire image, use the Motion effect Scale setting to shrink it to
fit the screen display.

Quiz

1. You want a clip to appear full screen for a few seconds and then spin away. How do you make the Motion
effect Rotation feature start within a clip rather than at the beginning?

2. You use Motion’s Scale feature to shrink a clip and then add a frame using Bevel Edges. How do you give
those edges a solid (or nearly solid) color while retaining the beveled look?

3. Using a high-resolution photo, how do you start tight on an individual, hold that position for a while, and
then pull back to reveal the entire image.
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Answers

1. Use keyframes. Move the CTI edit line to the point at which you want to start spinning the clip off screen and
click the Rotation keyframe stopwatch to set its starting keyframe at that position. Then move the CTI edit
line to the end of the clip and change the rotation setting to suit your purposes (update the clip Position and
Scale settings if needed). That will automatically add an ending Rotation keyframe with its new values
applied.

2. Although the nomenclature makes this sound counterintuitive, choose a dark light color and then increase
the Light Intensity value to emphasize the beveled frame corners. You might also play with the Light Angle
setting to find the direction that gives the greatest 3D look. Settings at the compass’s cardinal points—0, 90,
180 and 270 degrees—work well for me.

3. Use the Motion effect Scale and Position settings for the initial tight view and proper framing, and then
move the CTI edit line to the point at which you want to begin pulling back and switch on the keyframe
stopwatches for those two motion elements (that will set keyframes using the Scale and Position values you
set for the first frame). Move the CTI to the location in the clip where you want the move to end and change
the Scale and Position values. That automatically sets new keyframes and concludes the move. You can use
interpolation controls to have a Slow In or Easy Curve In effect to add even more drama.

Exercises

1. Do some extensive work with the Motion effect and its keyframes. Try moving keyframes around by clicking
and dragging them. Change values for the five Motion effect features. Experiment with Rotation, Anchor
Point, and Position to see how they interact. The more you work with this very powerful and important part
of Adobe Premiere Pro, the more likely you are to use it effectively.

2. Try creating multiple pictures-in-a-picture. The basic way to do that is to start with a background matte,
image or video on Video 1 and then place multiple clips, one above the other, on ascending video tracks. To
create those additional tracks, simply drag each clip to the gray area in the sequence above the existing
uppermost video track and Adobe Premiere Pro will automatically create a new track. Switch off all the video
track eyeballs except Video 1 and Video 2. Shrink the clip on Video 2 and put it in motion. Then switch on
the eyeball of Video 3, shrink that clip, and give it motion (you’ll see how it works with the clip on Video 2),
and continue working up through the video tracks.

3. Scan in some photos in relatively high resolution—1,500x1,000 works well because it’s about double DV
resolution—and apply some pans and zooms to them, aiming to create a dramatic effect. Either reveal
something or zoom in to draw attention to a subject.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education

Adobe, the Adobe logo, Adobe Premiere, Adobe Audition, Adobe Encore, Acrobat, After Effects, GoLive, Illustrator, InDesign, Photoshop, and
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Module 13

Acquiring Audio

Audio is crucial. The best images will lose their impact if their audio is mediocre. Adobe® Premiere® Pro offers
plenty of ways to give your project a sonic boost.

Your students will need to acquire some of that audio during on-location taping. Relying solely on their onboard
camcorder microphone (or mic, for short) might lead to disappointing results. Choosing and using additional
mics will sweeten their sound.

After they’re back in their studio—be it at school, home, or work—they'll likely add narration. There's no need to
rent an expensive audio studio—your camcorder or soundcard and a simple makeshift audio recording area will
do the trick. Some professional narration techniques will help as well. Finally, there’s no need to hire a composer
and musicians for noncommercial-use music: use Adobe Audition™ or Microsoft Media Player to rip CDs.

At the end of this lesson, students will have learned about:

• Selecting the right microphones for the job

• Connecting microphones to your camcorder or PC

• Expert audio tips from a Shure, Inc. engineer

• Building a voice recording area

• Voicing professional narrations

• Ripping Music CDs

Selecting the Right Mic for the Job

The topic is microphones, but the first order of business is to get a good headset—one that covers the ears to
block out extraneous sound. Plug it into your camcorder. As you record, listen. Is that how you want your video
production to sound?

Onboard microphones take the middle ground. They pick up sound from everywhere, including camera noise
and wind. If you zoom in on a subject, onboard mics don't zoom with you. They still pick up noise from all
around you. Crowd noise, sound reflecting off walls, the hum from the air conditioner, the zoom lens itself—as
well as noise you create while handling the camcorder.
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What you need are some external mics. Specialized mics
that serve narrow but useful functions. I've illustrated
them in Figure 13.1. Here are the five basic types:

• Handheld

• Shotgun

• Wireless

• Surface mount

• Lavaliere

FIGURE 13.1: Five standard-issue mics: handheld, shotgun,
wireless handheld, boundary, and lavaliere. (Products
provided by Shure, Inc.)

Handheld Mic

If you own only one external mic, make it a handheld. They're the rugged workhorses of the audio industry. Built
with internal shock mounts to reduce handling noise, you'll use these mics for interviews, place them on
podiums to record speeches, and use them to create narrations.

Many handheld mics are omnidirectional, meaning that they pick up sound from all directions. So, they'll pick up
ambient room noise as well as close-up audio. To minimize that unwanted noise, keep the mic as close to your
subject as practical—about a foot from the speaker's mouth works well.

A top-of-the-line, rugged, durable handheld costs from $150 to $250. Shure, Inc. (http://www.shure.com), the
world's leading mic manufacturer, loaned me a handheld—as well as a lavaliere and a shotgun mic—to test
while writing this book. (A senior engineer with Shure provided the expert sidebar later in this module.) The
Shure handheld SM63LB performed flawlessly within a wide frequency range, accurately capturing low and high
voices. It retails for $225.

Most handheld mics use what's called a dynamic transducer. As Figure 13.2 illustrates, the transducer is a thin
diaphragm attached to a tiny coil. As sound waves vibrate the diaphragm, the wire moves over a magnet, which
converts that physical energy into an electrical signal. Dynamic transducer mics do not require any electrical
power to operate.

Shure, Inc. notes that “Dynamic mics are rugged and can handle high sound pressure levels, like those delivered
by kick drums, snare drums, and high volume guitar amps. They're also good for loud, aggressive vocals. Most
people start out recording with dynamic mics because of their lower cost and high durability.”

The other type of mic—the condenser transducer, also shown in Figure 13.2—needs "phantom" power to be
provided by a mixer or batteries. It uses a thin, flat plastic or metal diaphragm layered over another piece of
metal or metal-coated ceramic. This type of mic is typically very small and has an extremely weak signal that
requires preamplification before sending it to your camcorder or a mixer.
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FIGURE 13.2: Cutaway views of a dynamic transducer mic (left) and a condenser transducer mic. (Illustration
courtesy of Shure Inc., 2003.)

Shure adds that “condenser mics are more sensitive than dynamic mics and are very responsive to high
frequencies produced by an acoustic guitar or cymbals on a drum-kit.” Condenser mics are excellent for
interviews, narrations, and performance or studio music vocal recordings.

Lavaliere Mic

Most lavalieres use condenser transducer technology. They're perfect for formal, sit-down interviews. Their tiny
size means that you can conceal them to minimize that "Oh, we're watching TV" disconnect. The downside is
that most require batteries. As you know, batteries invariably fail at critical moments, so always use fresh, high-
quality mic batteries. It is possible to power lavalieres directly from some mixers, but few budding video
producers will use mixers.

I tested Shure's WL50B. The clear and crisp sound was a cut above the handheld and is reflected in its higher
price: $316.

Shotgun Mic

So-named because it resembles a shotgun barrel, the shotgun mic's unidirectional barrel (called an interference
tube) narrows the focus of the audio field to about 30 degrees.

A shotgun mic can handle a number of tasks. I picked up one idea from top freelance photojournalist John
Alpert. He's a one-man band who ventures into uncomfortable and frequently dangerous situations and uses his
affable demeanor to get some amazingly revealing sound bites. Instead of shoving a handheld mic into his
subjects' faces—which frequently leads to "mic-stare" and other nervous reactions—he uses a shotgun mic
tucked under his armpit. He leans his head away from the camera viewfinder and simply chats with his subjects
in his unique, gee-whiz kind of way. It works like magic.

One thing shotgun mics don't do is zoom. As Chris Lyons, the Shure engineer who wrote the audio expert
sidebar says, "They're more like looking through a long tube at someone." They narrow your "view" of the sound.
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Note: A Telephoto Mic

The telephoto lens equivalent in the microphone world is a parabolic dish. You've seen networks use them
along the sidelines of NFL games to get those great crunching hits.

Good shotgun mics will set you back about $1,000. I tried out Shure's superb SM89 ($1,180). This is a condenser
mic and needs phantom power that a standard prosumer camcorder cannot provide. A $100 (list price) PB224
portable phantom power adapter from the Rolls Corporation (    www.rolls.com    ) will take care of that.

Boundary or Surface Mount Mics

You'll use these very specialized mics to pick up several speakers at a conference table or on a theater stage.
They're built to be placed on a flat surface and pick up sound waves in both the air and from the hard surface. A
good omnidirectional boundary mic costs about $160.

Wireless Systems

A wireless system is a major purchase that might set you
back about as much as a medium-quality DV camcorder.
And it can be a battery hog. But it can make your life a
whole lot simpler and give you some incredible audio.

Wireless mics open a whole new spectrum of
possibilities—a presenter at a trade show, the priest at a
wedding, or a football coach working the sidelines.
Wireless mics enable you to grab sound from a distance.
After you've used one, you'll wonder how you got along
without it. Wireless mics are a luxury, and good ones are
priced to match. My Shure UP4 test unit, including
receiver and an M58 mic with a built-in U2  transmitter,
retails for $2,086 (see Figure 13.3).

FIGURE 13.3: The Shure UP4 wireless receiver with a
combo mic and wireless transmitter.

Connecting Mics to Your Camcorder or PC

Surprisingly, this is the place where most mic problems arise. Most consumer and prosumer camcorders do not
have decent mic input connections. They typically do not have enough amplification to "hear" standard
handheld mics. What's more, they use mini-plugs, whereas most professional mics use rugged, reliable, three-
pronged XLR jacks.

What you might need is a transformer with an XLR-to-mini–plug cable to increase the impedance and enable
you to connect your mic to your camcorder. Such transformers are passive, meaning that they don't require
electricity. Shure has just such a transformer—the A96F—for $54. If you use a powered mic such as a lavaliere,
you might need only the XLR-to-mini–plug converter cable.
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Making the PC Connection

Adobe Premiere Pro makes it possible for you add a narration track to your project, live, as you watch your video
play. To do that, you need to connect a mic to your soundcard (I cover that recording process in the next
module, “Editing Audio.”

Voice-overs created with soundcards generally can’t sound as good as those recorded with professional
equipment in a recording studio or even as good as those made using a mic plugged into your camcorder. But
they still can sound good enough for basic production work. You can take two routes: simple or not-so-simple.

Simple Approach

The simple approach is to visit your local Radio Shack and spend $20 to $30 on a mic. You’ll have two basic
choices:

• Dynamic mics come in two models. One is combined with a headset. Gamers and those who use their
PCs to make phone calls like this hands-free approach. The other is a long-neck version that sets on your
desk, which minimizes extraneous noise.

• Condenser mics offer slightly better voice-over quality and require a battery. They typically are lavaliere-
style.

Buy a mic with a 1/8-inch (3.5mm) stereo minijack connection so that it can plug directly into your soundcard.
Figure 13.4 shows a typical soundcard rear panel. Plug the mic into the correct jack (usually marked Mic or with a
mic icon) and not the Line-in
jack used with amplified devices
such as CD players and sound
mixers.

FIGURE 13.4: Plug your mic into
the Mic jack on your soundcard’s
back panel. Use the Line-in jack
only if you’re using an amplified
mixer with your mic.

Whichever mic you choose, make sure that you also get a headset. As I mention later this module in “Voicing
Solid Narrations,” it’s important to hear how the mic hears you.

Tip: Smooth Voice-over Recording

Recording a voice-over while editing video is a system-intensive process. To ensure glitch-free recording,
free up resources: Close anti-virus software, system-monitoring products, and other programs that might be
running in the background with the exception of those required for the video, audio, and system
components to function properly.

Not-So-Simple Approach

Here’s how you can up the soundcard voice-over ante. Buy two professional omnidirectional mics. Most come
with 1/4-inch or the much larger XLR connectors. Connect them to a pre-amplifier and a mixer. The pre-amp will
improve the “color” of the sound. The mixer enables you to increase the stereo effect or sweet spot. To achieve
that sweet spot, place the mics a few inches apart and then voice your narration into both of them. Doing so will
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better approximate the human ear spacing for stereo recording. You’ll need an adapter to connect the mixer to
the soundcard’s 1/8-inch plug.

Getting the Most from Your Mics—Expert Audio Tips

When I considered whom I'd tap for audio expertise, only one name came
to mind: Shure, Inc. Throughout my TV news and video production
career, Shure mics have been the staple in our audio kits.

This 78-year-old company is a world leader in microphone technology,
playing a role in audio history from the Japanese surrender ending World War II and President John F. Kennedy's
inaugural address to Woodstock and the 2002 Winter Olympics, where Shure's wireless systems captured all the
opening ceremonies' audio moments. You heard Shure mics at the 2003 Montreux Jazz Festival, the 2003
Country Music Awards, and the Rock and Roll Hall of Fame Museum.

Shure's "Elvis mic," the Unidyne, kicked things off when the company first introduced it in 1939. Frank Sinatra
and the Rolling Stones field-tested the SM58—the world's best-selling, all-purpose vocal mic, which was
introduced in 1966. And now groups such as N*SYNC and D'Angelo rely on Shure's Beta Series.

Shure put me in touch with Chris Lyons, a Senior Engineer in Shure's Applications Group. In his 13 years with
Shure, he has served as Technical Liaison for Shure's broadcast customers and as Product Line Manager for Wired
Microphones. Chris has presented hundreds of audio training seminars to broadcasters, educators, government
agencies, and audio/visual production specialists. He has written and edited numerous articles and technical
papers, including the booklet Guide to Better Audio for Video Production, available for free download at
http://www.shure.com/booklets/techpubs.html .

Chris offers this expert advice:

• Always place the microphone as close as is practical to the sound source. Every time the source-to-mic
distance increases by a factor of two, the sound pressure level (SPL) reaching the mic decreases by a
factor of four, making clear sound pickup progressively more difficult. This is called the inverse-square
rule, and it applies whether the distance increases from 6 inches to 12 inches or from 6 feet to 12 feet.
This means that the talker-to-mic distance must be cut in half to cause a significant improvement in
sound quality.

• Use the fewest number of microphones necessary for the situation. People sometimes have a tendency to
over-mic a shot, using three or four microphones when one or two would be sufficient. Using excess
mics means more background noise pickup, a greater chance of feedback or "tin can" sound, and more
levels for the operator to keep track of. If additional mics don't make things sound better, they'll
probably make things sound worse.

• Advice for using a handheld mic: Whether held in the hand or mounted on a stand, place this mic about
6-12 inches from the talker's mouth, pointing up at about a 45-degree angle (see Figure 13.5). With
some types of microphones, holding the microphone very close (3–6 inches) will cause additional
emphasis of the lower frequencies (known as proximity effect), resulting in a warmer, bass-heavy sound.
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FIGURE 13.5: Proper placement for a handheld mic. (Illustration courtesy
Shure, Inc. 2003.)

• Tips on using a lavaliere mic: For best results, clip a lavaliere mic
on the outside of clothing, about 6 to 8 inches below the chin.
You can clip the mic to the collar of a shirt or blouse, but
sound quality in this position tends to be somewhat muffled
because some high frequencies (which contain consonants)
do not fully wrap around to the area under the chin.

• Concealing a lavaliere mic: Concealing the mic gives your
production an extra level of quality. Make sure that you keep
both the microphone and the first few inches of cable from rubbing against either the body or clothing,
which will cause noise. Try taping the "lav" under the shirt collar near the opening in front. The cable can
be routed around to the back of the neck, over the collar, and under the shirt. Alternatively, tape it to
the interviewee's eyeglasses on the inside by the temple. Route the wire over the ear and down the
back.

• When to use a surface mount mic: These are great for panel discussions and work best when positioned
on a smooth, flat surface, such as a table or desk. A thin piece of soft foam rubber or a computer mouse
pad underneath the mic helps minimize problems created by surface vibrations. Small surfaces—less
than 3-feet square—reduce the pickup of low frequencies and might improve the clarity of deep voices
by reducing "boominess."

• Working with a shotgun mic: Avoid aiming shotgun mics at hard surfaces such as tile floors, brick walls,
and flat ceilings. These surfaces reflect background noise into the microphone or cause the sound to be
slightly hollow. Place a heavy blanket on a reflective surface to provide some sound absorption.
Shotgun mics are more sensitive to wind noise than standard microphones, so use a foam windscreen
and don't move them too rapidly. A rubber-isolated shock mount will help control handling noise.

• Why work with low-impedance microphones? Low-impedance or "low-Z" mics (less than 600 ohms)
enable you to use very long runs of cable (more than 1,000 feet) with negligible loss of sound quality.
"High-Z" mics (greater than 10,000 ohms) lose high frequencies and begin to sound muffled with 20-
foot cables. The impedance of a microphone should not match the impedance of the input to which it is
connected. Matching the impedance causes significant signal level loss. Always connect low-impedance
microphones to higher-impedance inputs—preferably 5 to 10 times greater. Inputs on professional
mixers typically have an impedance of 1,000 ohms or more.

• Wireless system issues: Try to keep the distance from the transmitter to the receiver as short as possible.
Always do a walkaround with the mic before the event. If dropouts occur, try moving the receiver a few
feet and repeat the walkaround. Dual-antenna diversity receivers minimize dropout because it is
unlikely that the signal to both antennas will be interrupted at the same instant. If possible, do your
sound check at the same time of day as the event to discover whether there are any nearby users of
your wireless frequencies. When using belt-pack-type transmitters, make sure that the antenna cable is
hanging straight. Coiling it up in the wearer's pocket significantly reduces transmission distance. With
handheld transmitters that have an external antenna, discourage users from holding their hands over
the antenna to avoid reducing transmission range and increasing dropout.

• Use balanced cables and connectors. Their metal shielding keeps the audio signal free of interference
from things such as florescent lights, dimmer switches, and other audio or electrical cables. Use cables
with braided or mesh shielding. They are more resistant than metal foil shielding to cracks or tears,
which cause electrical shorts.

• Plan ahead. This is the most important thing you can do to improve the audio quality of your
productions. When you set up your equipment, look for things that might cause a problem with your
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audio—air conditioning ducts, noisy doors, fluorescent lights, and so on. Check for things that you can
use to your advantage—sound-absorbent carpeting or a built-in PA system. Experiment with different
mic placements, but don't gamble an important project on a method you've never tried. Monitor your
audio and listen carefully for anything that sounds unnatural. As the saying goes, "If you notice the
sound, there's something wrong with it."

Building a Simple and Inexpensive Voice-Recording Area

To create your voice-over narration, you'll need a quiet, sound-absorbing location. I touched base with the
industry leader in sound absorption material: Auralex Acoustics.

Auralex suggests that the easiest solution is to build a temporary recording area simply by hanging some thick
blankets or fiberglass insulation on two joining corner walls. It is an old audio myth that egg cartons, carpeting,
and foam rubber  work well. Avoid them. If you can create something like a four-sided, blanketed cubicle, so
much the better.

If you drape the blankets only in one corner, point the mic toward that corner, place yourself between the mic
and the corner, and speak away from the blankets. It seems counterintuitive, but the mic is sort of like a camera.
It "sees" what's in front of it (even if it is omnidirectional). In this case, it "sees" your face and the hanging, sound-
absorbing blankets.

If you want to take your voice-recording area quality up several notches, consider purchasing Auralex's studio
foam sheets or a portable recording area kit. These kits range in price from $159 to $999. Figure 13.6 illustrates
two of these acoustic environments, as Auralex calls them. The company emphasizes that these kits are not true
isolation booths. Those are intended to keep sound out and require some serious construction. Visit
http://www.auralex.com/  for
product and dealer info, plus a
contact phone number. Auralex is
very customer-service oriented
and will help you find a solution.

FIGURE 13.6: Acoustic
environments from Auralex—MAX-
Wall 420 (right) and MAX-Wall
1141VB (left). (Photos courtesy
Auralex Acoustics.)

Voicing Solid Narrations

Creating narrations is as easy as turning on your camcorder. If you have a handheld mic (or some other external
mic), plug it into your camcorder. Otherwise, you can use the built-in, onboard camcorder mic.

Before you record your voice-over, go over this checklist to make sure that you're ready:

• Read your copy out loud. Listen to your words. They should sound comfortable, conversational, even
informal.

• Avoid technical jargon. That demands extra effort from your listeners, and you might lose them.

• Short sentences work best. If you find yourself stumbling over certain phrases, rewrite them.
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• Emphasize important words and phrases. As you review your copy, underline important words. When you
record your voice-over, you'll want to give those words extra emphasis—more volume and punch.

• Mark pauses. Go through your copy and mark logical breaks with short parallel lines. They'll remind you
to pause at those points. Avoid overly smooth and constant pacing. That's characteristic of a scripted
delivery and, once again, you don't want to remind viewers that this is TV. It's real life. It's conversational.

• Break up your copy into shorter sentences. Always be on the lookout for convoluted, wandering
sentences. Too many modifiers can be unwieldy. Break long sentences into several shorter ones. Shorter
sentences tend to have only one key point. It's easier to emphasize one key point in one sentence
versus multiple points in a rambling speech.

• Punch up your voice. When reading copy, it's too easy to slip into a dull, monotone voice. Instead, add
some zest and enthusiasm to your narration. As one consultant told me, "Pump up your projection." You
want people to pay attention. You do that by speaking as if the subject truly interests you. On the other
hand, you aren't trying to be a professional announcer. No need to put on airs or use a basso profundo
voice.

• Practice. Record a couple narrations and listen. Have others listen. Most first-time narrators mumble or
swallow words. Have you made yourself clear?

• Use a windscreen. Although you need to record close to the mic for best effect—12 inches away or
so—getting too close can lead to "popping P's." As you say P-words, you project a small blast of wind at
the mic. Using a windscreen minimizes that, as does not speaking directly into the mic.

• Wear earphones. In this case, the purpose is not to make sure that you're actually getting audio; rather,
it's to hear yourself. That might seem a bit odd. You can hear yourself just fine without a headset. But
you need the headset to see how the mic "hears" you. You'll also discover whether you're popping any
P's or speaking with too much sibilance—an overemphasis on the S sound.

Ripping Music CDs

The easiest source for video production music is next to your stereo: your personal music CD collection. All CD
cuts are digital and easily ripped to your hard drive. Once ripped—converted from CD audio a digital file on your
hard drive—it’s a simple matter to import CD music into Adobe Premiere Pro.

Caution: Beware the Copyright Police

Those tunes on your CDs are all copyrighted. I'm not an attorney and don't pretend to understand copyright
law. That said, I'd suggest treading carefully when using someone else's music. Generally, if it's for personal
use, it's considered fair use and there are no copyright issues. But just about any other use can step outside
fair use.

To be on the safe side, compose your own music (see “Creating Custom Music with SmartSound Movie
Maestro” later in this module for one means to that end) or license or buy royalty-free music. To find out
more about the latter, search on     www.Google.com     for music licensing or royalty-free music. I’ve worked with
such three firms:     www.LicenseMusic.com    ,    www.dittybase.com    , and    www.Stock-Music.com     .

Using Adobe Audition to Rip Tunes from CDs

No, the modules are not taking a violent twist. Ripping is just how some describe the process of transferring
music from a CD to a PC. Several products are available to do that. The one most likely to be at your fingertips is
Windows Media Player. I go over how it works in a moment.
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First a brief look at how to rip CDs using Adobe Audition. It’s a powerful audio editing, mixing and recording
product. I present an in-depth series of Adobe Audition tasks in Module 16, “Adobe Audition: A Professional
Audio Tool.”

One of its side benefits is its ability to rip tracks from audio CDs. Unlike Adobe Audition, most products that offer
this capability do not offer audio editing. Their primary purpose is for you to copy those tunes to your PC for
playback or to use them to create your own customized CDs.

For that reason, I cover the Windows Media Player’s CD ripping functionality in this module.

However, if you’re geared more to editing tunes ripped from CDs, Adobe Audition is the right product. The
process is very easy. Since I will cover Adobe Audition in greater detail later, I will give only a brief overview here
of three ways to extract audio from a music CD. Method 1, the File > Open process is if you want to rip entire
tunes from a CD. Method 2, the Extraction process lets you rip portions of a tune and specify the ripping process.
Method 3 is for those who have older CD drives that don’t support CD audio extraction:

Ripping CD Audio – Method 1 – File > Open

1. Adobe Audition has three modes: Multitrack, Waveform Edit and CD Project (for recording to a CD).
Click on the Edit View tab. Select File > Open.

2. Navigate to your audio CD. As shown in Figure 13.7, Adobe Audition will display the music CD’s
numbered tracks (no titles).

FIGURE 13.7: Adobe Audition readily rips tracks from a CD.
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3. Select one or more and click Open.

4. After copying the CDA files, the waveform for the last track in the group you ripped will display in
Adobe Audition’s interface. You access the other tracks from the Files list highlighted in Figure 13.8.

FIGURE 13.8: In Adobe Audition’s Waveform workspace, you can edit the track you just copied and access other
tracks from the highlighted file list.

5. You can listen to that tune by pressing the space bar or use the standard playback controls at the
bottom of the screen.

6. Save the ripped tunes in one of about 20 different audio formats supported by Adobe Audition by
selecting File > Save as.
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Ripping CD Audio – Method 2 – Extraction

1. In the Edit or CD Project view select File > Extract Audio from a CD. That opens the window shown in
Figure 13.8a. Note that it lists every track on your CD in Minutes:Seconds:Frames (Each second of CD
Audio has 75 frames).

2. Click the Time button to extract part of a track or a segment of audio that spans multiple tracks. Enter
the beginning frame in the Start box (note that if you select a track, its beginning and ending frame
values display) and the total number of frames you wish to extract in the Length box.

3. For Interface Option, choose Generic Win32 or ASPI/SPTI. In most cases, ASPI/SPTI is the best choice.
Select Generic Win32 only if the ASPI/SPTI option doesn't produce satisfactory results. The Generic
Win32 option causes the Extract Audio From CD feature to use Input/Output control codes instead of
SCSI commands.

4. For Error Correction, CDDA Accurate is automatically selected if the CD-ROM drive has built-in ripping
error correction. For these types of drives, no error correction is needed, so you won't be able to select
any options from this part of the Extract Audio From CD dialog box.

5. If your drive isn't CDDA Accurate, you have access to No Correction and Jitter Correction options. Jitter
Correction compensates for data reading problems that older drives might have.

6. After you finish setting options, click OK.
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FIGURE 13.9: Audition gives you the option to extract a portion of an Audio CD track --or multiple tracks -- as one file.

Ripping CD Audio – Method 3 – Internal Recording

If you have an older CD-ROM drive that doesn't support digital extraction, or if you have problems ripping a track
into Adobe Audition, then you can record from a CD in real-time through the sound card on your computer. This
method is called internal recording. To do this you will need to have an internal audio cable connecting your CD
drive to your sound card. Be aware that not all computers react the same way when recording from CD
internally. As a result, this method might not work as well as digitally extracting audio from a CD.

1. You need to first set the CD Audio input level. Open a CD player like Windows Media Player and play the
loudest part of the CD.

2. Switch to Adobe Audition, click on the Edit or Multitrack View and choose Options > Monitor Record
Level. If you don’t see anything in the Level Meters, select Options > Windows Recording Control panel.
Select either Wave/MP3 or CD-Audio. Watch the Audition VU meter to see which one works.

3. Use the Level Meters in Adobe Audition to monitor the amplitude of the incoming signal. You want the
input level to be as loud as possible without exceeding 0 dB. If the input level exceeds 0 dB, clipping
occurs (part of the audio signal is lost).

4. You can adjust the CD Audio input level using the volume control in Windows Media Player or in the
Windows Recording Control panel. Access it by choosing Options > Windows Recording Mixer.

5. After you set the record level, turn off the VU meter by selecting Options > Monitor Record Level to
uncheck it.
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6. To record from a CD internally make sure you’re in Edit View then select File > New. Select the 44,100
sample rate (CD Audio) and click OK.

7. Stop the CD.

8. Click the red Record button in the lower left corner of the Audition interface.

9. Start the desired track in your CD player application.

10. When completed, stop recording in both Adobe Audition and the CD player application.

Using Windows Media Player to Rip CD Cuts

Since the focus of this module is obtaining audio for use in Adobe Premiere Pro projects, using Adobe Audition
to rip music is like hiring the Philharmonic Orchestra to play at a high school prom. What works best in this case
is a utility geared to this narrow task.

Task: Use Windows Media Player to Rip CD Cuts
Windows Media Player is just such a utility. Here's how it works:

1. Open Windows Media Player. It's probably in the Start menu under Accessories. If not, its default location is
C:\Program Files\Windows Media Player\wmplayer.exe  . You can open My Computer, go to this location, and
double-click    wmplayer.exe  . Doing so opens the interface shown in Figure 13.10.
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Tip: Automatically Opening Windows Media Player

FIGURE 13.10: Use Windows Media Player to rip tracks from music CDs.

Tip: Automatically Opening Windows Media Player

You can open Windows Media Player another way. Simply insert a music CD into your DVD or CD drive and,
depending on your version of Windows, either Windows Media Player automatically starts playing that CD
or you're given an option of playing the CD with one of several programs that you have installed on your PC.

2. Click Copy from CD, as highlighted in Figure 13.11. That pops up a message asking you to insert an audio
CD.

3. Insert a music CD. Either Windows will ask you which CD player you want to use (select Media Player), or
Windows Media Player will automatically start playing the CD. Click the Stop button, as shown in Figure
13.11.
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FIGURE 13.11: Windows Media Player's Copy CD interface displays information about your CD retrieved from the
Internet (to avoid any possible copyright conflicts, I created a “dummy” screenshot using my choir’s material).

Note: Online Album Details

All music CDs have unique identification codes. Those codes are generated by examining track times. If
you're connected to the Internet, Media Player will send your music CD’s data to www.allmusic.com (going
through www.windowsmedia.com along the way). That site (owned by All Media Guide) is a repository of a
huge database on music CDs. It uses that identifier number to retrieve your CD’s information—title, artist,
and track names—and then Windows Media Player displays them. As shown in Figure 13.11, click View
Album Info for a full listing plus a review. Even my example, the brilliant but little known classical men’s
choir, Chanticleer, shows up.
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4. By default, all tracks are checkmarked for copying to your hard drive. You can uncheck any that you don't
want to copy.

Tip: Preview a Tune

If you want to preview a track, click it to select it, and then click the Play button.

5. The default copy location is    C:\Documents and
Settings\current user\My Documents\My
Music   . Windows Media Player creates a folder
for the artists and a subfolder for the selected
album. If you want to change that location,
select Tools, Options from the menu bar. Doing
so opens the Options menu, shown in Figure
13.12. Select the Copy Music tab and change
the directory.

FIGURE 13.12: Use the Options interface to change
the file folder storage location for your selected music
tracks.

Tip: Avoid Vocals for Background Music

When selecting music for use in video or DVD
productions, instrumentals generally work best.
Vocals can step on your narration, natural
sound, or voices in your videos.

6. When you're ready to copy the tracks, click the Copy Music button at the top of the interface. That opens
two dialog boxes: The first reminds you to not make illegal copies and the second asks you about setting the
recording quality level. It’s best to use the highest quality setting for tunes you’ll use in an Adobe Premiere
Pro project. When you're past the dialogs, Windows Media Player displays progress bars to let you know
how things are proceeding.
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Now that you've ripped a few tunes, you can use Adobe Audition or Windows Media Player to burn a music CD. I
discuss the CD recording aspects of Audition in Module 16: “Adobe Audition: A Professional Audio Tool.”

For now, I suggest you use the Media Player. As shown in Figure 13.13, access the Player’s CD burning feature by
clicking Copy to CD or Device, select the tracks or play list you want to burn, place a recordable CD in your drive,
and click the Copy button. This is a great way to create personalized CDs of your favorite tunes.

FIGURE 13.13: Use Windows Media Player to create personalized, customized music CDs.
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Audio is critical to a high-quality video production. Most important is the original footage. Take some extra
measures to ensure high-quality audio. Select the right mics for the job, turn to wireless audio if your budget
allows, and use professional voice-over techniques.

Strapped for cash and you need music for a video for personal use? Not to worry: Rip music from CDs or create
custom music using Adobe Audition (I explain how to do that in Module 16).

Q. When I videotape indoors, my audio has a "tin-can" quality. What's going on?

A. This happens for one of two reasons. The simplest reason is that the mic is too far from your subject and
you're in a room with reflective surfaces such as flat walls and an uncarpeted floor. Move the mic closer and, if
possible, hang blankets where they won’t show up in your video. The other is more complicated and involves
what audio engineers call the 3-to-1 Rule. If you use more than one mic for several speakers, as in a panel
discussion, you need to place the mics three times as far apart as they are to the speakers. That is, if a mic is two
feet from a panelist, the next mic should be at least six feet away from the first mic. Otherwise, the mics pick up
audio at about the same time, cancel each other out, and create that tin-can sound.

Q. I bought professional-quality mics, but I can barely hear them in my headset and later when I listen to
my tape. Why?

A. Unlike with professional camcorders, there are no mic standards for consumer and prosumer camcorders. If
you read your camcorder's spec sheet, you probably won't see anything about the mic input, whether it's stereo
or mono, and whether it needs external amplification. If you're using a low-impedance mic, such as a
professional handheld mic with a cable longer than 20 feet, you'll probably need a transformer for most
camcorders. That should resolve your low-volume problem. If you're using an unpowered condenser mic, such
as a shotgun, you'll need phantom power, from a battery, a mixer, or a portable phantom power adapter.

 Quiz

1. Why should you use external mics?

2. If you had a budget for only one professional mic, what would it be?

3. When you set up a voice recording space in the corner of a room, which way do you face to voice the
narration and why?
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Quiz Answers

1. Your camcorder's onboard mic is a jack-of-all-trades and a master of none. It picks up sound all around you,
including noise you make when handling the camcorder. External mics capture sound at the source. Using
external mics is invariably better and greatly improves the quality of your production.

2. This is kind of a trick question. I think the best bet is a wireless shotgun mic. On news stories, a wireless
shotgun gives reporters much greater mobility and puts interviewees at ease. Working with a shotgun mic
means there’s no need to stick a mic in someone’s face. And going wireless obviates that awkward pause to
plug a cable into the camera.

3. As counterintuitive as it seems, face away from the sound-absorbing material. The mic picks up sound from
the direction it's facing. The absorbing material minimizes the reflections it would pick up if the mic faced
away from that material.

Exercises

1. Build a simple two-wall voice-recording area using the methods described in this module. Experiment with
mic placement, distance from your mouth, and whether the mic points toward or away from the sound
absorbing material. Listen critically to the audio quality. Tinny, noisy, muffled, too much echo or just right.
Find what works best for you.

2. Work on your narration style. Do several voice-overs using the same script. Listen to your inflection, cadence,
and pauses. Do you sound interested in the subject matter? Do you enunciate clearly without sounding
pedantic? Try to find a comfort level between overly enthusiastic and bored. And feel free to combine
narration segments from different takes. No one take has to be perfect.

3. Check the Yellow Pages for Recording Service or Recording Studio and pay one or two a visit. I took some high
school students to a studio in Portland, Oregon, and we had a blast. The sound engineer demonstrated
some amazing voice-sweetening tricks.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education

Adobe, the Adobe logo, Adobe Premiere, Adobe Audition, Adobe Encore, Acrobat, After Effects, GoLive, Illustrator, InDesign, Photoshop, and

Tools for the New Work are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other

countries. All other trademarks are the property of their respective owners.

© 2004 Adobe Systems Incorporated. All rights reserved.
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Module 14

Editing Audio

Adobe® raised the audio bar with the release of Adobe Premiere® Pro. From the moment your students load any
type of audio into a project (music, narration, or natural sound linked to some video) Adobe Premiere Pro treats
it with a whole level of care.

While audio has never been an afterthought, it is now a critical element in the full suite of editing tools available
in Adobe Premiere Pro, including a new mixer, a full suite of audio effects, and sample-level editing.

At the end of this lesson, students will have learned about:

• Adobe Premiere Pro—a new aural experience

• Basic Adobe Premiere Pro audio editing

• Higher-level audio editing

• Making an automated music video using markers

Adobe Premiere Pro—A New Aural Experience

As I mentioned in Module 4, “Touring Adobe Premiere Pro’s Interface and Features,” Adobe Premiere Pro utilizes
many new technologies. Heading the list is audio.

Adobe hired an audio software engineering expert to completely revamp Adobe Premiere Pro’s take on audio.
You can see (and hear) his work throughout Adobe Premiere Pro.

Here's a rundown of the changes he implemented (I go into more detail in upcoming sections and in the next
module):

• Two audio track types: clip and submix.

• Three audio track flavors: mono, stereo, and 5.1 surround sound

• A separate master audio track

• Conforming audio

• Sample-specific edits

• A new audio mixer

• Live voice-over recording

In addition, Adobe Premiere Pro’s compliance with two audio industry standards: ASIO (Audio Stream In/Out)
and VST (Virtual Studio Technology) ensures that it works smoothly with a wide range of audio cards and accepts
dozens of audio effect plug-ins. I give you a taste of those plug-ins in Module 15, “Sweetening Your Sound.”
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Audio Track Layout

There are now two distinct kinds of audio tracks in Adobe Premiere Pro: regular clip tracks and submix tracks.

Audio clip tracks are very similar to audio tracks in previous versions of Adobe Premiere. They are where you put
your audio clips or audio portions of A/V clips. The new wrinkle is that you need to match the channel type of
your clip to the track on which you are placing it—stereo to stereo, mono to mono, and 5.1 to 5.1. To simplify
that, Adobe Premiere Pro automatically creates the proper track flavor, if necessary, when you drag a new clip to
a sequence.

Submix tracks are completely new. They don't take clips at all. You use them to route or combine the output of
multiple clip tracks and other submix tracks into a separate submix track so you can apply effects, volume
changes, and other characteristics to the group as a whole. I explain more about why you’ll want to use submix
tracks, how to create them, and how you route other tracks to them in the next module, “Sweetening Your
Sound.”

Adobe Premiere Pro now enables you to place effects on entire tracks and submixes as well as on clips. You can
edit keyframes on tracks in a sequence. In this way, you can create a consistent sound quality for an entire track
rather than a clip at a time. For instance, you might lay down several narration segments on a track. Instead of
applying the Reverb audio effect to each clip, you can apply it to the entire track.

Conforming Audio

Adobe Premiere Pro converts all audio to 32-bit floating-point data and matches audio to the project audio
sample rate settings. (48kHz is the standard DV sample rate and 44.1kHz is CD audio.) If the original audio clip is
at a lower quality setting than your project, Adobe Premiere Pro “up-converts” it. That audio conforming ensures
that there is no loss in quality during any subsequent edits or when you apply audio effects to your clips.

To conform audio takes some time and consumes some disk space. Here is the basic hard disk space calculation:

Time in seconds x 4 x sample rate x number of channels = bytes

So, one hour of DV footage in a 48kHz project consumes

3,600 seconds x 4 x 48,000 x 2 = 1,382,400,000 = 1.38GB

Taking that to its logical extreme, if you have a one-hour, 5.1 audio segment at 96kHz (the highest available
setting), your conforming audio (CFA) file will be 8.28GB.

On a PC with a 2.8GHz hyperthreaded CPU, here’s approximately how long it takes to conform a one-hour DV
clip with 32k audio:

• Conforming into a 32k project—44 seconds

• Conforming into a 48k project—2 minutes

In the first case, Adobe Premiere Pro simply reads the audio from the DV clip and writes it as a 32-bit floating-
point file to your hard drive. In the second case, Adobe Premiere Pro re-samples the audio to 48kHz, which takes
longer.

Conforming is a background process, which should not interfere with your work. It automatically pauses while
you're playing or scrubbing through video. And you can place clips that are still conforming in a sequence.
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As soon as Adobe Premiere Pro finishes conforming, you can switch on that clip’s waveform in the sequence (I
show you how to do that in “Basic Adobe Premiere Pro Audio Editing,” later this module).

Note: Developer Comment—Conforming Audio File Management

The biggest conforming audio development issue came down to the management of these files. There's no
easy way for the user to know which files are associated with which projects. If you clean one project, will
you regret it because you lost your CFAs for several other projects? Do we clean only those files that have
not been used for some time?

Anyway, we know that Adobe Premiere Pro has some media management issues that need a
comprehensive solution. This is on all of our lists of needed additions to subsequent revisions.

As for deleting the CFA files, simply find the folder (specified in the scratch disk preferences) and delete it. Of
course, when you reopen the project, you'll have to regenerate them, which will take place in the
background as it did originally.

I cover the other new developments—sample-specific editing, the audio mixer, and live voice-over
recording—in the following sections and the next module.

Basic Adobe Premiere Pro Audio Editing

Before you add scintillating sound to your project, I want to show you a few audio fundamentals.

Task: Experiment with an Audio File Waveform
To experiment with an audio file waveform, follow these steps:

1. Open Adobe Premiere Pro, clear your sequence of clips, and select Window > Workspace > Audio.

2. If the Effects tab does not display in the Project window, then you’ve run into a small bug. Take care of
that by selecting Window > Effects to add the Effects palette to your workspace and then drag its tab to
the Project window. Your workspace should look like Figure 14.1.

3. For future use, save this workspace as a slightly improved default audio workspace by selecting Window
> Workspace > Save Workspace, giving it a name such as My Audio Workspace, and clicking Save. Next
time, you can select that workspace from the Window > Workspace list.



Adobe Digital Video Curriculum Guide – Module 14 14-4

Adobe Digital Video CURRICULUM GUIDE

FIGURE 14.1: One way that your personalized audio workspace could look before you complete the following steps.

4. Drag any audio clip or linked A/V clip to your empty sequence. Adobe Premiere Pro handles most
standard audio types, including AIF, AVI, MP3, M2V, MPEG, QuickTime (MOV), WAV, and Windows Media
Audio (WMA).

5. Expand the audio track on which your new clip resides by clicking its Collapse/Expand Track triangle (to
the left of Audio #). Then greatly expand the height of the Timeline window by dragging its top and/or
bottom edges. Finally, as shown in Figure 14.2, drag the bottom of the audio track to fill the screen.
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6. By default, the clip’s waveform should be visible. If not, click the little Set Display Style button circled in
Figure 14.2 (below the speaker icon) and select Show Waveform.

FIGURE 14.2: Expand the audio track to see the clip’s waveform. Note that in this stereo track, the top row is the left
channel and the bottom is the right. I explain the various highlighted items in Steps 5, 6 and 8.
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7. Experiment with this waveform for a while. Drag the CTI edit line to the beginning and press the space
bar to play the waveform. The amplitude of the waveform reflects the volume of the original clip: The
fatter/taller the line, the louder the sound.

Note: Waveforms Are Immutable

Nothing that you do in Adobe Premiere Pro will affect the visible waveform of a media clip. Even if you
change a clip’s volume or apply audio effects to it, the waveform will always display the clip’s original
volume levels.

8. Press the =/+ key a couple times to expand—or zoom in—the view of the audio clip on the sequence.
This will give you a clearer take on your audio levels. In my case (refer to Figure 14.2), the sudden drops
in volume are when I pressed pause/record on my camcorder.

9. As shown in Figure 14.3, you change the audio time ruler markers to sample-level units by clicking the
Timeline window wing menu and selecting Audio Units.

FIGURE 14.3: Change the time ruler to sample-specific editing by selecting Audio Units from the Timeline window
wing menu.

Note: Sample Unit Time Ruler Markings

Take a look at Figure 14.3. With Audio Units selected, the time ruler markings change to
hours:minutes:seconds:samples. In my example, the project setting is 32kHz, or 32,000 audio samples per
second. Note that I have placed the CTI at one second and 31,999 samples —one sample shy of 2 seconds.
This sample-specific editing enables you to precisely cut audio. Previous versions of Adobe Premiere let you
cut audio only at each video frame, or every 1/30 of a second.

10. Zoom in on the sequence view to its highest magnification: individual samples. The sequence width
displayed in Figure 14.4 is 20 samples or 3/5,000 of a second. In my case, this spot is where the audio
drops off dramatically. Adobe Premiere Pro makes it easy to cut one sample before that drop, if I so
choose.
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FIGURE 14.4: At its highest zoom level,
you can make sample-specific edits and
adjust the sequence display so only a few-
thousandths of a second fill a sequence
width.

Note:  Adjusting Volume

You might want to decrease or
increase the volume of an entire clip
or parts of a clip. For example, you
might want to bring the natural
sound down by half while you
narrate, gradually fade up the audio
at the start or end, or fade up an
interview just as the narrator
completes a segment. The latter is
known as a J-cut. I explain that in the
next section, “Higher-level Audio
Editing.”

Task:  Adjusting the
Volume
To do any of those audio edits, you use
the Volume audio effect in the Effect
Controls window. Here's how it works:

1. To give yourself a little more
screen real estate, reduce the size of the audio track and the Timeline window so that you can see the
Effect Controls window.

2. Click the Show Keyframes button circled in Figure 14.5 and select Show Clip Volume.

3. Select your clip by clicking either the video or audio portion to display it in the ECW.
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FIGURE 14.5: Select Show Clip Volume both to see your work in the clip’s waveform and to ensure that you can apply
a volume change to the clip, as opposed to only the entire track.

Caution: Can’t Select the Audio Clip? Uncheck Track Audio Options

When you open the Show Keyframes menu, you could select two track options: Show Track Keyframes and
Show Track Volume. If you select either of these and you have an audio-only clip (no linked video associated
with it), Adobe Premiere Pro will not allow you to select the audio clip to apply any volume changes or
effects to it. If you have a linked A/V clip, the only way to select the audio portion is the click on its video
partner. With track options checked, you can apply volume changes and effects only on an entire track basis
using the mixer. I explain that process in the next module.
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4. Raise or lower the overall
volume of this clip by moving
the level slider to the right or
left. As shown in Figure 14.6,
as you make those changes,
the volume level indicator line
moves to a higher or lower
position.

FIGURE 14.6: As you change the clip
volume by moving the level slider in the
ECW, the thin yellow volume line in the
clip moves up or down accordingly (I
thickened the line in this figure to
demonstrate that).

5. Return the volume to 0.00dB.

Note: Changing Volume Does
Not Change Original Clip

Whatever changes you make to
the clip volume in a sequence
won't change the original clip's
volume. They change only how
the clip plays back in your project.
The default volume setting is zero
decibels. That is, Adobe Premiere
Pro plays source audio clips at
their original volume unless you
tell it to do otherwise.

6. Take the first step to manually add a fade-in and a fade-out to your clip (in the next section, “Higher-
Level Audio Editing,” you use an Audio Transition to automate this) by pressing the Home keyboard
shortcut, turning on keyframes by clicking the level stopwatch, and moving the level slider to the far left
(-∝).

7. Move the CTI into your clip (about 2 seconds works well), and increase the Level to 0dB.

8. Finish this process by moving the CTI to about 2 seconds from the end of your clip, clicking the
keyframe diamond (between the two keyframe navigation triangles) to set a new keyframe without
changing the volume level, and then moving to the end of the clip, and dropping the volume Level
back to the far left (-∝).
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Note: An Updated Waveform Display

Take a look at the clip’s waveform display. Note two things: The yellow line (I darkened it in Figure 14.6 to
make it easier to see) now has keyframe handles about 2 seconds from the start point and end point, and
that line moves from the bottom (-∝) to the center of the clip (0dB) and back to the bottom.

The Figure 14.7 also shows what happens if you drag a volume keyframe to a new location, as described in
Step 9.

9. After you’ve added keyframes, you can use the volume handles in the clip’s waveform display
(annotated in Figure 14.7) to change those keyframe settings. Simply grab one and drag it to increase or
decrease volume and to change the keyframe location. Note the real-time readout of your changes in
the box at the bottom of the clip display.

FIGURE 14.7: As you make changes to the clip volume in the ECW, it changes the volume line in the clip waveform
display (the lower line in this figure). You can grab and move the volume handles (keyframes) to change their location
and dB level (the top line).

10. Add some interpolation values to your audio to make the volume changes more appealing. As a
reminder to do that, right-click on a keyframe in the ECW and select from the five choices. Applying Fast
Out to the starting keyframe gets to the action more quickly and works well for my go-kart video. A Fast
Out on the ending keyframe also works well.

11. Listen to your fade-in and fade-out by pressing Home and the space bar.

Higher-Level Audio Editing

Just as you created transitions between video clips, you can make smooth transitions between audio clips.
Adobe Premiere Pro offers only two; both are crossfades, and they work just like a video cross-dissolve in that the
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audio in the first clip fades down as the audio in the next clip increases in volume. They add a real nice touch to
your project. I recommend using them virtually every time you make some kind of smooth video transition.

On the other hand, you might want to have greater control over your transitions than the two crossfades offer. In
that case, you need to place audio clips on separate audio tracks and use their individual volume controls to
create the transition. You’ll do both in this section.

Task: Crossfade Between Two Audio Clips
New to Adobe Premiere Pro is the audio crossfade. You used to have to follow an elaborate manual crossfade
process. Now you apply the Crossfade transitions to two audio clips just as you applied a cross-dissolve to two
video clips. Here are the steps to follow:

1. Add another audio-only or linked A/V clip to your sequence, and butt it up against the first clip. Make
sure you’ve trimmed both clips to allow for some overlap.

2. Clear out the volume changes that you applied to the first clip by clicking the keyframe stopwatch to
turn off keyframes, and then drag the level slider to 0dB or press the Reset button.

3. Drag the Constant Power audio transition from the Crossfade folder in the Effects palette to the edit
point between the two clips. To display it in the ECW, click on it in the sequence. Your sequence and
ECW should look like Figure 14.8.
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FIGURE 14.8: How your sequence and ECW should look after applying a Constant Power Crossfade between two
audio clips.

4. As with video transitions, you can change the center point of the transition or change when it starts and
ends by dragging it in its entirety or dragging its edges.

5. Lengthen it a bit to get a better feel for the transition, and then listen to it and note how the volume
levels change.

Tip: Use Crossfade to Start or End a Piece

Just as you can use the Dip to Black video  transition to ease into or out of the start or end of a video (fade
from/to black), you can use the audio Crossfade to achieve the same results. Simply apply either Crossfade
audio transition to the beginning or end of a clip.
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6. Replace the Constant Power transition with the only other audio transition by dragging Constant Gain
to the transition on the sequence.

7. Lengthen and listen to it as well. You’ll note that it does not have quite the same high level of sustained
volume level as Constant Gain. Save your project so that you can use it in the next task.

News-Style Audio Editing: Using J-Cuts and L-Cuts

Frequently you'll want to start a clip by having its sound play under the previous video clip and then transition to
its associated video. This is a great way to let your audience know that someone is about to say something or
that a transition is coming. It's kind of like foreshadowing. This is called a J-cut, so named because it looks like a ‘J’
on the sequence.

Conversely, another slick editing technique is to let the audio tail off under the next video clip. This is an L-cut (it
looks like an ‘L’).

Task: Making J-Cuts and L-Cuts
To do either of these cuts requires that you unlink the audio and video portions of a linked A/V clip. After they've
been unlinked, you can move that audio segment to another audio track and then extend or shorten the audio
portion to make the J- or L-cut.

Here's the basic approach you need to follow:

1. Use the project you saved in the previous task. Delete the crossfade by selecting it on the sequence and
pressing Delete.

2. Using Figure 14.9 as a reference, unlink the audio and video portions of the second clip by right-clicking
on it and selecting Unlink Audio and Video (see the next Tip for a keyboard shortcut unlinking method).
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FIGURE 14.9: Right-click on a clip and select Unlink Audio and Video to enable you to separately edit the audio and
video portions of an A/V clip.

3. Deselect that clip (this confirms the unlink) by clicking somewhere in the sequence besides on that clip.

Caution: Stay in Synch

Take care as you move the audio portions of your clips in the sequence that you don’t slide it left or right
when you drag it. Otherwise, the audio and video will get out of synch. Adobe Premiere Pro gives you a
visual cue to help you line up your clips: As shown in Figure 14.10, if you see a black line with a triangle, your
clips are properly lined up. If that black line disappears, you have moved out of synch.
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FIGURE 14.10: When dragging an unlinked audio clip to a new audio track, keep it in synch with the original video
segment by noting when the highlighted black line pops on screen.

Tip: An Easy Way to Unlink and Move a Clip to a New Track

Here's a nifty keyboard shortcut that you can use to unlink and move a clip. Hold down the Alt key while you
click on the portion of a clip that you want to move (that unlinks it), drag it to the new track (or, in this case,
below the master audio track to make a new audio track), and drop it.

4. Drag the audio portion of the second clip down to the gray area below the audio master track. Adobe
Premiere Pro will indicate it’s about to automatically add a new audio track to accommodate this clip;
you can then release the mouse. Your sequence should look like Figure 14.11.



Adobe Digital Video Curriculum Guide – Module 14 14-16

Adobe Digital Video CURRICULUM GUIDE

FIGURE 14.11: Drag the audio portion of the unlinked clip below the audio master track to add it to an automatically
created new audio track.

5. Drag the end of that audio clip under the end of the previous clip.

Caution: Drag the End—Don’t Slide the Clip

Don't slide the audio clip. Doing so will un-synch it with its original video portion. Rather, drag the clip's
starting point to the left to extend its duration.

6. Open the volume effect for that clip, switch on keyframes for level, move the cursor to the starting
point, and decrease the volume to about -8dB (you can adjust this volume later to make it fit your
purposes).

7. Move the CTI edit line to just before the end of the first clip and set a keyframe there by clicking the
keyframe diamond between the two keyframe navigation triangles. This sets a keyframe with the same
-8dB value.

8. Drag the CTI to the end of the first clip and increase the level to 0dB (automatically setting a new
keyframe in the process). That is a J-cut. The audio in the second clip plays under the first clip and then
increases in volume just as the second clip appears. Your sequence should look like Figure 14.12.

Tip: Use a Video Dissolve to Further Ease the Transition

The purpose of a J- or L-cut is to ease viewers into or out of a clip. To enhance that transition, add a video
Dissolve or some other smooth video transition between the two clips.
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FIGURE 14.12: A J-cut is used to lay audio under a preceding video clip and then increase its volume at the point
where its associated video pops onscreen.

Play your edited selection to see how that sound-under style works. The volume might increase too quickly or
too slowly. It’s a simple matter to adjust volume levels. Open the audio waveform portion of the audio track,
switch on Show Clip Volume, and drag the volume keyframe handles around. You can also add an audio
crossfade to the end of first clip (or use the Volume effect) to fade it out, or you might cut it completely just
before the edit depending on your needs.

You can make an L-cut using the same basic technique. In this case, you’ll want to unlink the audio and video of
the first clip, extend its audio segment under the second clip, and reduce its volume accordingly. Figure 14.13 is
an example of an L-cut.
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FIGURE 14.13: Use an L-cut to ease viewers out of a clip. Note that I added a video Dissolve, eased out the audio in
the first clip, and eased in the audio of the second clip.

Tip: Use the Alt Shortcut to Extend an Audio Segment

You can use the Alt unlink keyboard shortcut for yet another unlinking use. Because you’ve already moved
the second clip’s audio to a new track and need only extend the first clip’s audio segment to the right a bit,
hold down the Alt key, click on the end of that first clip’s audio segment, and then drag to the right. By
holding down the Alt key, you'll extend only the audio segment of the clip.

Task: Freeze Frame and Dissolve to Black
One other L-cut-type edit is to end a piece with a freeze frame, and then dissolve to black while continuing the
audio beneath both video elements. Here’s a brief rundown of the steps:

1. As you did in Module 10, “Advanced Editing Techniques and Workspace Tools,” drag the CTI edit line to
the ending point of the project’s final clip—the frame you want to freeze.

2. Right-click on the clip and select Copy.

3. Click End to move the CTI to the end of that clip.

4. From the Main Menu, select Edit > Paste to add that duplicate clip to the end of your video.
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5. Right-click on that duplicate clip and select Frame Hold > Hold On > OutPoint. Click OK.

6. Unlink the audio portion of that freeze-frame clip and delete that audio.

7. Add black video to your sequence by clicking the New Item button, selecting Black Video, and dragging
that object to the end of your sequence.

8. Hold down Alt while dragging the audio segment of the final motion video clip all the way to the end of
the piece. (You need enough extra, unused audio on the original clip to do this.)

9. Add a Cross Dissolve video transition between the freeze-frame and the black video.

10. Use the Volume effect and keyframes to drop the audio, starting at the beginning of the freeze frame
and decreasing it to -∝ by the end of the black video. Your project should look like Figure 14.14.

FIGURE 14.14: Using a freeze frame, black video, a Cross Dissolve, and the Volume effect to create a gradual fade to
black.

Making an Automated Music Video Using Timeline Markers

I saved the fun task for last. Here, you're going to place a music clip on your timeline, add markers to match the
beat (or wherever you want to place them), and then automatically add video clips, one for each marker.
Voila—a music video. Well, it's not exactly MTV, but at the very least it’s a great way to make a slideshow.

Task: Setting Timeline Markers and Automatically Adding Clips
Follow these steps to set the timeline markers:

1. Clear your timeline by deleting everything on it.

2. Drag a music track to the Audio 2 track. (If you don’t have a music track, return to Module 13, “Acquiring
Audio,” and follow the instructions in the “Ripping Music CDs” section to use a track from an audio CD.)



Adobe Digital Video Curriculum Guide – Module 14 14-20

Adobe Digital Video CURRICULUM GUIDE

Tip: Why Audio Track 2?

You need to keep the Audio 1 track free for any natural sound associated with the clips that you’ll add to
the video. When you use the Project window’s Automate to Sequence feature, it places that nat-sound on
Audio 1.

3. Move the CTI to that clip’s first frame (use the Home key) and press the asterisk (*) key on the numeric
keypad (not Shift+8). That adds a marker on that first frame. A little pointed icon appears right below
the time ruler.

4. Play that audio clip, and when you hear a place where you'd like to edit in a new clip, press the asterisk
(*) key again to add another marker. Do that for each edit point. If you're using a laptop and don't have a
numeric keypad, you can use Alt+Shift+=.

Tip: Use Markers with a Narration

You can use markers with other audio, notably narrations. As you listen to a narration, press the asterisk key
when you hear a logical break in the narration copy or when the script calls for a specific shot. Even if you
don’t use the Automate to Sequence option, those markers will help you locate edit points.

5. At the end of the song, or when you think you've made enough markers, stop the music. As shown in
Figure 14.15, a whole slew of little gray tab stops will populate your sequence.

FIGURE 14.15: The timeline loaded with markers, ready to make a music video.
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6. Use the Project to select clips. You can
change it to the Icon view and
rearrange clips as you did in Module 7,
“Creating a Cuts-Only Video,” or you
can simply Ctrl+click on several to set
the order in which they’ll end up on
the sequence.

7. After you have your clips arranged,
click the Automate to Sequence icon
(third icon in from the left at the
bottom of the Project window).

8. That pops up the Automate to
Sequence dialog box. Figure 14.16
shows the interface properly filled in
for this music video. In this case, you
want to change Placement to At
Unnumbered Markers, set Method to
Insert Edit, and leave the Ignore Audio
and Ignore Video boxes unchecked.
This means natural sound will end up
on audio track 1, where you can
change its volume or delete it to suit
the video.

FIGURE 14.16: The Automate to Sequence
dialog box, filled out to make a music video.

9. When you've made all the selections, click OK. Your timeline should fill up with clips. Move the edit line
to the beginning and play. Slick.
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Adobe Premiere Pro has taken audio editing to a new, much higher plane than in previous versions. By
incorporating new technologies, industry-standard plug-ins, and high-end features such as audio conforming,
sample-specific editing, and multiple track types, Adobe Premiere Pro gives audiophiles all they need to add a
top-notch aural quality to their productions.

Basic audio editing—typically volume changes and crossfades—is now greatly simplified and takes place
primarily in the Effect Controls window.

Some standard news-style audio-editing L- and J-cuts will take your audio one step higher. You can also create
slideshows with a musical bed or have it timed to a narration by using markers and the Automate to Sequence
option.

Q. I adjusted the volume settings. And now my  clip does sounds different, but the waveform hasn't
changed. What’s going on?

A. This is Adobe Premiere Pro’s default behavior. The waveform always represents the clip’s original audio
volume shape. And no matter how loud or quiet the original clip, the default starting Volume effect level for all
clips is always 0dB.

Q. Right after I added a music clip to my Project window, I dragged it to the sequence and tried to view
the waveform and play it. But no waveform displayed. Only after I clicked Stop did the waveform pop on
screen. What’s going on?

A. Audio conforming is going on. When you add audio or an audio/video clip, Adobe Premiere Pro creates a new
audio file using the project setting audio sample rate (usually 32kHz or 48kHz) and using 32-bit floating point
data. That can take a little while. During the beta testing, you could not listen to the audio during conforming.
Beta testers complained loudly, and Adobe made some clever fixes, allowing the audio to play at a reduced
quality. But it will not display the waveform until it’s done conforming (you can’t get everything you want). And
if you play the clip while conforming is going on, it won’t display the waveform until you stop playing it.

Quiz

1. You want to start your piece by fading up your audio. Explain two ways to do that?

2. Why use an L-cut or a J-cut? What are the basic editing steps?

3. You have a quiet video clip, but in the middle, someone honks a car horn. How could you remove that
sound and replace it with the original quiet background of the original clip?
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Quiz Answers

1. Use an Audio Crossfade transition (Constant Power or Constant Gain) to the beginning of the clip. Or
use the Volume audio effect and keyframes to set the level to -∝ at the start and increase volume to 0dB
within a second or two. Use interpolation controls to smooth what would otherwise be a straight-line
fade-in.

2. In both instances, you're creating smooth transitions to either ease a cut with specific sound into your
project or let it fade out. A J-cut starts audio under the preceding video cut (which also has associated
audio) and then fades up as you transition or cut to the video portion of that clip. An L-cut fades audio
under the next clip as a way to ease out of that audio/video clip. You create both edits by unlinking the
audio from the clip you're going to extend, moving that audio to a different audio track, extending the
audio in the appropriate direction, and then using the Volume effect to create a crossfade. It sounds
best if you make those volume changes on both clips.

3. This one’s kind of tough. First, remove the horn by using the Volume effect and keyframes to isolate it
and reduce the volume to -∝ for that small segment. Then add that same clip somewhere out of the
way on the sequence, unlink its audio, delete the video, drag in the ends of the audio clip to create a
chunk of quiet audio that matches the rest of the original clip, and place it on the audio track right
below the removed car horn. Listen to this passage. You might need to fade up and later fade out the
quiet segment to ease in and out of it. If that sounds like a lot of work, it’s only a small taste of what
audio engineers do to enhance sound.

Exercises

1. J- and L-cuts should be a part of every production. The only way that's going to happen is if you get
comfortable doing them. Make a few of each.

2. When using a narration, typically you'll lay down some of that voice-over, put in a clip with some nice
natural sound, and then add more narration and more natural sound throughout your story. Give that
process a try by cutting your narration with the Razor tool and inserting nat-sound clips at those breaks
(hold down the Ctrl key when dragging clips to the razored point to perform an insert edit, thereby
sliding clips to the right). Use J- and L-cuts liberally.

3. I'll cover audio special effects in Module 15, but you can preview that process by adding effects to an
audio clip. The best clip to use is a narration because you know what it should sound like and any
changes you add will be more obvious. Open the Audio Effects tab in the Effects palette, open the folder
that matches your clip (Mono, Stereo, or 5.1), and drag and drop Reverb on your audio clip. Select the
clip and check out all the Reverb features in the Effect Controls window.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education
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Module 15

Sweetening Your Sound

Adobe® Premiere® Pro's audio effects "sweeten" your sound. They can dramatically change the feel of your
students’ projects. As with video effects, you set the parameters of audio effects from within the Effect Controls
window. Some are specialized effects from a family of audio plug-ins using VST—Virtual Studio Technology—a
new feature of Adobe Premiere Pro.

Adobe Premiere Pro’s audio mixer is a leap forward in controlling audio for projects. Combined with Adobe
Premiere Pro’s new submix track option, track-level audio effects, and live narration recording, they bring a lot of
flexibility to your students’ audio management.

At the end of this lesson, students will have learned about:

• Sweetening sound—Adobe Premiere Pro’s audio effects

• Revealing the power of VST plug-ins

• Delving into Adobe Premiere Pro’s new audio tracks

• Working with the new audio mixer

Sweetening Sound—Adobe Premiere Pro’s Audio Effects

Adobe has updated Adobe Premiere Pro’s suite of audio effects. Most of the new effects arrive courtesy of VST
software that fosters the integration of audio effect processors with PCs. In the case of Adobe Premiere Pro, it
opens the door to a world of third party audio effect plug-ins; little mini-programs that show up in the Audio
Effects palette. You can add dozens of VST audio effects to that collection. I cover VST in the next section,
“Revealing the Power of VST Plug-ins.”

Previous versions of Adobe Premiere placed the audio effects into seven categories. Now, you access them
alphabetically. Unless you’re an audio engineer, some of their names—Bandpass, MultibandCompressor, and
Parametric EQ, for instance—might be a bit obtuse.

I take you through some of them to give you a taste of what to expect. For more information on what each effect
does, take a look at the Adobe Premiere Pro online help section. Under Contents, select Applying Effects, and
then select Audio Effects Included With Adobe Premiere Pro.

Ultimately, the best way to learn more about these effects is to try them out. They are nondestructive. That is,
you can use them on any clip without changing the original clip’s audio quality.
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Task: Working with Audio Effects
Before I explain the audio effects function, I want to give you a
brief overview of how to work with them. You’ll start with a
couple straightforward effects and then take a look at some of
the higher-level tools. Here’s how to add audio effects to clips:

1. Open Adobe Premiere Pro to either your customized
audio workspace or the default workspace by
selecting Window > Workspace > Audio—or—Your
Audio Workspace.

2. Clear everything off your sequence and place a short
(no more than 30 seconds) audio or linked
audio/video clip by itself on the Audio 1 track. The
reason for the short clip duration is your audio
playback convenience.

3. Open the Effects tab (its default location is in the
Project window). Twirl down the Audio Effects
disclosure triangle to reveal three sub-folders: 5.1,
Stereo, and Mono (with only a couple exceptions,
such as Balance, all three have the same set of audio
effects). Twirl down the Stereo disclosure triangle to
reveal its 24 effects. Figure 15.1 shows how that
should look.

4. Drag and drop the Balance effect on your audio clip.
Select that clip to display it in the Effects Control
window (ECW). Twirl down the two disclosure
triangles to reveal the two keyframable parameters
shown in Figure 15.2: Bypass and Balance.

FIGURE 15.1: Adobe Premiere Pro's full set of 24
stereo audio effects.



Adobe Digital Video Curriculum Guide – Module 15 15-3

Adobe Digital Video CURRICULUM GUIDE

FIGURE 15.2: How the simplest of Adobe
Premiere Pro’s audio effects looks

Tip: What’s Bypass?

All audio effects (including the fixed
Volume effect) have a Bypass parameter.
Basically, checking Bypass means Adobe
Premiere Pro will ignore this effect and
play the clip as if the effect had not been
applied to it. What makes this an important
feature of each audio effect, is that Bypass
is keyframable—you can set the exact
moments when it switches off an effect
and switches it back on.

5. Using keyframes, set the balance
completely to the left (-100%) at the start of your clip and then move it to the right (+100%) at the end.
Play the clip. The audio should move from left to right.

Tip: Use Keyframes Liberally

Consider how you could use keyframes. The obvious usage is to change an effect over time. But consider
those obnoxious ads in which the narrator suddenly has a booming, echoing voice. You, too, can duplicate
those spots. Simply select Reverb and set keyframes for the beginning and end of that booming delivery.

6. Add two Bypass keyframes somewhere
toward the middle of your clip. The first
should have the Bypass box checked, but
the second should be unchecked. Play the
clip. The sound should begin to move from
the left to the right, jump to the center,
jump toward the right, and finish its move
to the right channel. Bypass tells Adobe
Premiere Pro to ignore any effect settings.

7. Remove the Balance effect (or click its little
f to turn it off) and drag Delay, a slightly
more complex audio effect, to the ECW.
Twirl down its disclosure triangles to reveal
three parameters (shown in Figure 15.3):
Delay, Feedback, and Mix. Delay creates
distinct echoes as opposed to Reverb,
which creates more of a collection of
echoes that you’d experience in a closed
room.

FIGURE 15.3: Delay—or echo—has slightly more
complexity than Balance.
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Tip: Delay Equals Echo

The Delay parameter specifies the amount of time before the echo plays. Increasing the Feedback setting
means you get echoes of echoes. And the Mix setting determines the prominence or subtlety of the echo.

Take a look at the Multitap Delay. This creates up to four distinct sets of delays or echoes using the same
parameters as the Delay effect.

8. Remove the Delay effect, drag Parametric EQ to the ECW, and twirl down its disclosure triangles. As
shown in Figure 15.4, this effect boosts or decreases the gain of a selected frequency region. If you want
to boost the bass, move the Center slider to the left (lower frequencies), and increase the Boost. Cut the
bass by moving the Boost slider to the left. Increase the width of the selected frequencies using the Q
slider.

Tip: Multiple Uses of the Same Effect

You’ve probably seen an equalizer. Many
car and home stereos have them. They
enable you punch up multiple, pre-set
frequency ranges. Many enthusiasts use
them to boost the heck out of the bass and
rattle windshields and nerves of passing
motorists.

Parametric EQ lets you select only one
frequency range. But you can use
Parametric EQ multiple times and select
multiple frequencies. In effect, you can
build a full graphic equalizer within the
ECW. Or you can use Adobe Premiere Pro’s
EQ effect and its built-in five frequency
ranges.

FIGURE 15.4: Parametric EQ lets you boost or
decrease the gain for a user-set frequency range
at a user-designated frequency.

Revealing the Power of VST Plug-ins

Take a look at one more audio effect. This one is guaranteed to make your head spin. Delete Parametric EQ and
drag MultibandCompressor to the ECW. As Figure 15.5 shows, you'll need to dramatically expand the ECW to see
only some of the parameters.

It works best if you drag the tab out of the Monitor window to create a separate Effect Controls window. Then
drag the right edge of the parameter view by placing the cursor over the thin line until it turns into the double-
arrow cursor circled in Figure 15.5.



Adobe Digital Video Curriculum Guide – Module 15 15-5

Adobe Digital Video CURRICULUM GUIDE

FIGURE 15.5: The MultibandCompressor audio effect is one of several VST plug-ins. Its primary use is to reduce a clip’s
dynamic range. That is, decrease the gain for loud sounds and increase it for soft sounds.

Tip: Close the ECW Timeline to Free Up
Space

To add a little screen real estate to the ECW, close its mini-timeline display. Do that by clicking the chevron
indicated by an arrow in Figure 15.4. Re-open it using the same chevron button.
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This sudden appearance of a rack of control knobs signals your first look at a VST plug-in. These are custom-
designed audio effects that adhere to a standard set by Steinberg audio. Invariably, those who create VST audio
effect plug-ins want them to have a unique look and offer some very specialized audio effects.

Note: Charlie Steinberg—Audio Visionary

To learn more about VST, I suggest you read an interview with Charlie Steinberg, the man behind VST and
other audio innovations. You can start at   http://www.steinberg.net .

The MultibandCompressor’s purpose is to narrow the dynamic range for up to three sets of frequency ranges. It
works like the Dynamics effect but can create a softer sound.

Explaining its parameters could take a full module. Instead, note that it offers a collection of pre-sets. Adobe
Premiere Pro alerts you to the presence of that collection by adding a tiny triangle below the reset button. I’ve
put a box around it in Figure 15.5.

While the audio is playing, experiment with the MultibandCompressor by grabbing the diamond-shaped
handles in the display screen and dragging the three boxes up or down or their vertices left or right. Finally, take
a look at the mind-boggling array of additional individual parameters below the knobs. One real important
reason to break them out individually is to let you set keyframes for any of them.

Other VST Effects

Take the Adobe Premiere Pro’s other VST audio effects for brief spins:

• DeNoiser—Automatically detects and removes tape noise

• Dynamics—Compresses dynamic range

• EQ—A multiple-band parametric EQ

• Pitch Shifter—Raises or lowers pitch

• Reverb—Simulates various room sounds

• DeEsser -- Remove sibilance and other high frequency "SSS"-type sounds, which are often created when
a narrator or vocalist pronounces the letters "s" and "t."

• DeHummer -- Removes unwanted 50 Hz/60 Hz hum from the audio caused by poorly shielded cables,
grounding loops, and dimmer. Select 50 or 60 Hz depending on your location: 50 Hz for Europe and
Japan, 60 for the U.S. and Canada.

Tip: Some EQ Uses

You can use EQ to give oomph to a thin vocal by rolling off the high frequencies and boosting the bass.

If you have isolated recordings of instruments in a band, you can add presence to each one by boosting
portions of their frequency range. Giving them a little more treble increases their "attack." If you have
trouble with audio hum or "popped P's," reducing the low frequencies might help. You can use EQ to "carve
out" a vocalist's range within an instrumental, giving that singer more "visibility."
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There is a treasure trove of VST plug-ins available on the Internet. I suggest you start your quest at
http://www.kvr-vst.com/  . Check out Quick Effect Links for a lengthy listing of VST audio effects, all of which
should work with Adobe Premiere Pro.

There's no need to check out K-V-R’s Quick Instrument Links because Adobe Premiere Pro does not support
instruments.

Most of these VST audio effect plug-ins cost something, but there are a few freebies. In particular, check out
Little Duck. Figure 15.6 shows how it appears in Adobe Premiere Pro. It emulates a classic analog filter bank.

Little Duck’s developer, Land of Cockaigne, offers several other free VST plug-ins featuring an older analog look
at its Web site:    http://www.funkelectric.com/~cockaigne/ .

FIGURE 15.6: The Little Duck VST plug-in audio effect offers five analog-like filters as well as other controls.

Adding Multiple Audio Effects to a Clip

You can add multiple audio (and video) effects to the same clip. For instance, you might have a video with a bass
player on the left and a guitar on the right. You could use Balance to start on the left and use Bass to emphasize
that instrument. Then as you move the balance to the right using keyframes, you could reduce Bass and bring in
Treble.

Note: Combine Effects for Surprising Results

For a little fun, add both a Highpass and Lowpass filter to a clip. These effects pass through high or low
frequencies and cut off the rest. Set each high and low cutoff frequency to the same value. The result should
be near or complete silence.

Delving Into Adobe Premiere Pro’s New Audio Tracks

Adobe Premiere Pro's new audio tracks open up extra editing opportunities. There are now three track types:
clip, submix, and master. As you work with Adobe Premiere Pro, you'll begin to see the value of these additional
tracks.
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Basically, your original clips go into clip tracks. You then can send them directly to the final master track (that’s
the default action) or send some or all of them to submix track(s). You can set volume levels and apply effects to
the clips individually, to entire clip tracks, and to entire submix tracks and to the master track itself. Anything you
do to a clip or clip track changes how it sounds in the submix and master tracks. Anything you do to a submix
track changes how the master track sounds. To give you an idea of how this might work in real-world
productions, here are two scenarios as suggested by the Adobe Premiere Pro development team:

• A two-camera shoot with additional narration and background music. You have two tracks of audio
(one from each camera) and a narration, and then you have two tracks of music. You would like to be
able to control the overall balance of voice and music. To do that, add two submix tracks. Assign all the
voice tracks to one track and all the music tracks to the other. Now you can use the Volume effect in the
voice submix track to control all the voice levels together and the Volume effect in the music submix
track to control all the music together. This is called stemming. You still can adjust the relative levels of
the clips within their own voice and music clip tracks.

•  You want to add reverb to two tracks of vocals. To make this sound right, you want to use the same
reverb parameters for both tracks. Add a submix track and add the reverb filter to that track. Assign
each of the voice tracks to the submix track. Now you have what is known as a dry (original) signal in
each clip track and a wet (edited) signal on the submix. You can control the amount of voice going to
the reverb by changing the volume on the original clip track(s).

Adding and Sending Audio Tracks

You’ve noted that if you drag a clip to an empty space in a sequence, Adobe Premiere Pro automatically creates
a new audio track that matches the type of audio: mono, stereo, or 5.1.

Task: Creating a Submix Track
If you want to add a submix track, you need to take a less automated route. You can use the same process to add
any other type of track. Here’s how you create a submix and send—or assign—an audio track to it:

1. As shown in Figure 15.7, right-click on an empty area on the left side (where the track names are) of a
sequence and select Add Tracks.

FIGURE 15.7: Use the sequence's context (right-click) menu to select Add Tracks.
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2. In the Add Tracks dialog box shown in Figure 15.8, set Add Video Track(s) and Add Audio Track(s) to 0,
set Audio Submix Tracks to 1, select a placement and track type, and click OK.

FIGURE 15.8: Use the Add Tracks dialog box to add an audio submix (or other video and audio tracks.

3. Take a look at the bottom of the audio mixer. As highlighted in Figure 15.9, Audio 1 (and any other clip
tracks you have in your sequence) now has the option to send its signal to Submix 1. If you select
Submix 1, whatever audio is on Audio 1 will also go to Submix 1. If you send several clip tracks to
Submix 1, Adobe Premiere Pro combines them using whatever audio gain levels and effects you set in
their original clip tracks.
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FIGURE 15.9: The drop-down list at the bottom of the audio
mixer now enables you to send an audio clip track to a
submix track.

Working with the New Audio Mixer

Adobe Premiere Pro’s new audio mixer is a giant step up
from previous versions. It is the focal point of your audio
production. In previous versions of Adobe Premiere its
primary task was to enable you to manually control audio
levels (recording your actions as you applied them). This
updated version improves on that functionality as and
offers two big improvements: the capability to apply
effects to entire tracks and a means to record a narration
directly to a sequence.

Task: Recording a Narration and
Adding Track Effects
I won't go into too many details because the Adobe
manual explains things well. However, I do suggest
experimenting with the audio mixer:

1. If you haven't already done so, expand the Audio
Mixer view by clicking the disclosure triangle
circled in Figure 15.10.

2. To record a narration, make sure that your PC mic
is plugged in to the Mic input on your sound card and  turned on. To do that, open the Control Panel,
and double-click Sounds and Audio. In the Volume tab, click Advanced and check to see that
Microphone is not muted.

3. Activate the Adobe Premiere Pro narration record mode by clicking the Microphone button in one of
the audio clip tracks (you can’t record a narration to the master or submix tracks).

4. Click the red Record button at the bottom of the audio mixer. It’ll start blinking. You can move the CTI
edit line to where you want this narration to begin (it'll cover up any audio at that location) and then
click the Play button to start recording. When you finish recording, click the Stop button and note that
an audio clip appears on the selected audio track.
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FIGURE 15.10: Open the Audio Mixer to display all its
features by clicking the circled disclosure triangle.

Note: Watch Your Levels

Watch your voice levels in the mixer’s audio track VU
meter—the two parallel, vertical bars next to the
volume slider. You want to avoid too much volume
(indicated by a red display in the VU meters) or too
little. Occasionally jumping into the yellow zone
toward the top is fine.

Note: What to Do About Feedback

If you record audio and you have taken no steps to
mute the output, you might get feedback—that lovely
screeching noise that happens when a mic gets too
close to a loud speaker. There are several remedies:

• Use the Mute button on the track in the sequence

• Drop the master fader bar to -∝

• Change the assign for the track to a submix track
and drop that Submix track fader bar to -∝

• Turn down your speakers (you can use
headphones to hear yourself)

5. You use the Audio Mixer to add audio effects to
the entire track by clicking the drop-down list
triangle highlighted in Figure 15.11 and selecting
from that list (it has all but a few of the clip-based
effects).

6. Each effect offers some level of control at the
bottom of the audio mixer’s mini-window. Some
effects, such as Reverb shown in Figure 15.11,
have drop-down lists of pre-sets.
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FIGURE 15.11: Add a track effect by clicking the triangle to reveal a
drop-down list. Make adjustments using controls that display in the
Mixer mini-window.

Note: Effects Apply to Entire Track

These effects do not have the detailed control that you find
when applying them to clips. Nor can you use keyframes.
These effects apply to entire tracks. That's the beauty of
track-based effects: their uniformity over an entire track.

Changing Track Gain and Balance or Pan

Adobe Premiere Pro’s online help file has a thorough
explanation of the audio mixer. Select Help > Contents > Mixing
Audio to open that lengthy and detailed section.

Essentially, the audio mixer makes it possible for you to adjust
audio gain and balance (or pan for mono tracks) on the fly,
recording your changes as you make them. If you don’t like the
mix, you can make adjustments using the mixer or, as shown in
Figure 15.12, by dragging the Track Volume handles in the audio
track waveform display. To display those keyframes, click the
Show Keyframes button and select Show Track Volume.
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FIGURE 15.12: After using the audio mixer to set volume or gain levels for an entire track, you can move the volume
handles in that track’s waveform in the Timeline Window to adjust those levels.

You make your audio gain and left/right balance changes after selecting an automation
setting from the drop-down list (shown in Figure 15.13) at the top of the selected track.
You have five automation setting choices:

FIGURE 15.13: Adobe Premiere Pro offers five automation controls in the audio mixer. Latch,
Touch, and Write each gives you slightly different levels of control over how you change a
track’s volume.

• Off—Ignores any existing playback settings so that you can preview any changes as you make them
without reverting to previous settings and without recording those changes.

• Read—Plays back any automation changes you’ve made.

• Write—Records adjustments as you make them and creates keyframe handles that display in the
sequence’s track waveform.

• Latch—Same as the Write setting except that nothing changes until you adjust a value; that value then
holds until you change it.
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• Touch—Same as the Latch setting except if you release the gain fader, the value returns to its previous
setting.

Automation Keyframe Optimization

Automating audio changes in the Audio Mixer typically creates many more keyframes in the audio track than
necessary. That can cause a degradation in performance and make it difficult to edit individual keyframes
because they are so densely packed.

Premiere Pro 1.5 has a new feature
that fixes that minor irritation
Automation Keyframe Optimization.

To set the Automation Keyframe
Optimization preference, choose
Edit > Preferences > Audio.

As shown in Figure 15.14, in the
Automation Keyframe Optimizations
area, select one or both of the
following options, and then click OK:

FIGURE 15.14: New to Premiere Pro
1.5 is a means to avoid overloading
your audio clip with keyframes when
automating audio changes in the
Audio Mixer.

Linear Keyframe Thinning -- Creates keyframes only at points that do not have a linear relationship to the start
and end keyframes. For example, suppose you are automating a fade from 0 dB to -12 dB. With this option
selected, Adobe Premiere Pro only creates keyframes at the points that represent an increase in value from the
beginning (0 dB) and ending (-12 dB) keyframes. If you do not select this option, Adobe Premiere Pro may create
several incremental keyframes of identical values between those two points, depending on the speed at which
you change the value. This option is selected by default.

Minimal Time Interval Thinning -- Creates keyframes only at intervals larger than the value that you specify. Enter
a value between 1 and 30 milliseconds.

Surround Sound Panning

As far as automation is concerned, the surround panner works just like the stereo panner. As shown in Figure
15.13, if you create a 5.1 project, the audio mixer master track will have six VU meters and each clip track (mono,
stereo, or 5.1) will have a panner setting display window.
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To manually set panning for a track, set Automation to one of the Write
modes, play your audio track, and grab and drag the little dot
(highlighted with an arrow in Figure 15.15) to move the audio around the
5.1 surround location.

FIGURE 15.15: When working with 5.1 clips or projects, Adobe Premiere Pro
enables you to manually adjust surround sound panner settings by dragging
the little dot around inside this little window.

As you set these new locations, they show up as keyframe handles in your
sequence. To view them and manually change them, click the Show
Keyframes button and select Show Track Keyframes.

It would be impractical to show all keyframes for all six surround sound
locations. Adobe Premiere Pro makes it possible for you narrow down
your view in the clip’s waveform display. As shown in Figure 15.16, use
the clip’s drop-down list and select Panner > Left-Right, Front-Rear,
Center or LFE (low-frequency effects that are routed to the sub-woofer) to
display the keyframe handles you created in the mixer.

FIGURE 15.16: 5.1 panner adjustments done in the audio mixer show up as keyframe handles in the audio track.

You can use the Pen tool (it offers more precise control than the Selection arrow and enables you to add
keyframes) from the Tools palette to add, delete, or adjust these handles:
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• Add a keyframe by holding Ctrl and clicking on the yellow panning line.

• Move keyframes by grabbing and dragging them.

• Use the Pen tool (select it from the Tools palette or use its keyboard shortcut: ‘P’) to drag bounding
boxes around groups of keyframes, and then hold down Shift, grab one of the highlighted keyframes,
and drag the collection en masse to a new location.

• Delete a keyframe by selecting it with the Pen tool and pressing Delete. Delete a group by dragging a
bounding box around them and pressing Delete.

Note: Panner Seems Jerky—Not to Worry

The surround panner definitely tracks smoothly between points. If your PC is slower than most, you might
see some jumpiness on the display updates in the mixer window, but the internals will track smoothly.
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Adding effects to clips on an Adobe Premiere Pro sequence can bring a project to life. The Effect Controls
window tracks each clip's effects, gives you detailed control over their individual features, and offers keyframes
for those attributes. The addition of VST plug-in support means Adobe was able to include some very powerful
and detailed effects.

The new audio mixer and audio tracks open up all sorts of extra control possibilities for Adobe Premiere Pro. It’s a
simple matter to apply effects to entire tracks and adjust volume and balance/panning changes on the fly.

Q. I worked in the audio mixer for a while and then returned to the Timeline window. When I play my
video, I don’t hear anything, but I didn't mute the audio track. What’s going on?

A. You probably muted the track in the audio mixer. Unfortunately, that action does not make itself apparent in
the sequence display. Go back to the audio mixer and unselect the Mute button for your track. The button is
right above the volume fader bar.

Q. I want to get a nice distinct echo effect, but Reverb sounds like a lot of echoes instead of only one. Is
there a way to get only one echo, or at least some limited number of echoes?

A. Yes. Use Delay. It creates an exact duplication of whatever is on your audio clip. That can be very
disconcerting if it’s music—you’ll hear every guitar strum twice, for instance. But if you have a voice shouting out
a word or phrase, you can adjust the settings to have that echo come back quickly or with a delay of up to 2
seconds and have it blend with the original clip or not.

Quiz

1. You need to boost treble and bass. You have several possibilities. What are they?

2. There are at least three ways to make audio move from the right channel to the left and back. What are
they?

3. You recorded a speech, but the presenter is too quiet and the waiter's clattering trays are too jarring. How
can you fix those problems?
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Quiz Answers

1. Take your pick. The easiest but least precise method is to add treble and bass to the clip. Using the
Parametric EQ effect twice to boost each end of the audio frequency spectrum gives you a fine level of
control. Or try EQ, turn off the midrange frequency bands, and adjust the low and high ends.

2. Use one of two effects: Balance adjusts the overall balance, left or right, and Channel Volume enables you to
adjust the volume of each channel individually. If you drop the left to -∝ and the right to full 6dB, you’ve
accomplished virtually the same effect, but the clip will sound louder. To get audio to switch back and forth,
use keyframes. Or use the Audio Mixer’s Left/Right Balance control knob.

3. You want to minimize the clattering trays by reducing the high end of the volume when the clattering
happens and remove it when the speaker pauses. Also, you want to increase the low-volume portions to
better hear the speaker. Use Dynamics to do both. Use its Gate feature to cut off the signal when the speaker
pauses, use Compressor to bring up the soft speaker levels, and use Limiter to cut off any loud sounds.

Exercises

1. Experiment with the Multitap Delay audio effect. Use it on a solo instrument, a solo voice (record your own,
perhaps), and music with a hard beat. This is a slick and exciting toy that can give some real presence to
audio.

2. Create a chorus using a voice. Use your camcorder or PC mic to record yourself (or a volunteer) singing a
song. Add it to a sequence. Then use the PitchShifter audio effect on it. Add several audio tracks. Place the
CTI edit line at the beginning of the original clip, copy the clip (right-click > Copy), select an empty track by
clicking the track name, and then select Edit > Paste (or Ctrl+V) to place that copy on the sequence. Do that
several times. Select each clip in turn and slightly adjust the PitchShifter’s Fine setting. It takes some trial and
error to avoid a warbling sound, but if all goes well, you’ll turn a soloist into an ensemble.

3. Create a full-featured graphics equalizer by layering several Parametric EQ effects on the same clip. You can
use EQ’s five frequency presets, but using multiple instances of Parametric EQ is a good way to precisely
control some very specific frequencies ranges. Preview your work as you make changes. After you've created
a collection in the ECW, turn one or more of the effects off (click the ‘f’ check box) and then listen to the
difference.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education
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Module 16

Adobe Audition: A Professional Audio Tool

Music can make or break a production. If your students aren't dedicated musicians with some fairly sophisticated
PC music hardware and software, they probably can’t create that music themselves. As I mentioned in Module
13, “Acquiring Audio,” they can rip music from a CD, but that raises the copyright infringement red flag.

One excellent solution is Adobe® Audition™. This product enables you to take custom music creation further by
offering more than  5,000 music loops that you can tap to create compositions. Plus, it’s loaded with professional
audio editing tools and high-end effects that go beyond those available in Adobe Premiere® Pro.

At the end of this lesson, students will have learned about:

• Adobe Audition’s Attributes

• Adobe Audition’s audio effects

• Using Adobe Audition to craft a tune

• Burning audio CDs with Audition

Adobe Audition’s Attributes

Adobe Audition is a complete, professional, 128-track
recording and mastering studio that offers advanced audio
mixing, editing, and effects processing. You’ll want to use
Adobe Audition for music productions, radio broadcasts, or to
enhance audio for your Adobe Premiere Pro video.

Adobe Audition started its life as Cool Edit, a high-end,
professional audio editing tool from Syntrillium Software. In
mid-2003, Adobe bought Syntrillium’s technology assets and
re-released Cool Edit Pro 2 as Adobe Audition ($299 retail,
$149 education price).

Although Adobe originally made no changes to the Cool Edit Pro 2 code, the company did add one tremendous
feature: 4,500+ music loops. The loops are typically a few bars of an instrument playing in a certain musical style.
These are not MIDI files. They were recorded live using real musicians playing real instruments. You can combine
these loops, to create unique, customized soundtracks that sound terrific. With the release of Audition 1.5,
Adobe added more than 500 more loops, upgraded the interface, enhanced some effects, and improved the
interface and workflow.

Here are some of Adobe Audition’s features:
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• Change pitch and tempo without losing sonic fidelity—Adobe Audition’s beat-marking technology and
superior stretch engine enable you to make pitch and tempo changes while retaining all the
characteristics of the original instrument or voice.

• Audio repair—Noise reduction selectively removes room noise, hiss, hum, and even camera motors(!)
while retaining full audio quality. Automated and user-defined click and pop removal cleans up vinyl
recordings.

• Sound your best—Adobe Audition supports files with sample rates up to 10MHz (that’s 10 MEGAHertz!
as opposed to the standard CD-audio sampling rate of 44 KILOHertz), so whether your destination is
tape, CD, DVD, or DVD-Audio, Adobe Audition can handle the files. All processing is done at the
maximum 32-bit resolution for the highest quality sound. All edits are sample-accurate, and short
crossfades can be added for smooth, pop-free cuts every time.

• Additional features—It also offers real-time effects, loop creation, audio analysis tools, and video
support.

Auditioning Adobe Audition

In the following tasks I'm going to put Adobe Audition through a few of its paces. If you have the retail version, I
urge you to follow along. If not, I suggest you download the trial version of Adobe Audition from the Adobe Web
site:     www.adobe.com/products/audition   . There you'll find links to the tryout download (30MB) and to the
“loopology” content. The content is divided into musical genres ranging in size from 5 MB to 58 MB. Knowing
that 58MB might be a hefty download for you, I chose a genre with a relatively small file size: rockabilly (9MB).

Task: Introducing Adobe Audition—Basic Editing
Adobe Audition is really three products in one: a single waveform editor (meaning that you can narrow your
audio processing down to a single audio element), a multitrack audio recorder and mixer, and a music creation
tool. I give you a taste of all these elements in this and other upcoming tasks. We begin with a multitrack project:
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Open Adobe Audition. If it opens to its default project, you’ll see it populate its screen with a few music clips and
then play the Adobe Audition theme. Your workspace should look like Figure 16.1.

FIGURE 16.1: The Adobe Audition multitrack workspace with the Adobe Audition Theme open.
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Note: What to Do If the Theme Does Not Appear

The Adobe Audition theme might not appear (typically because you've opened Adobe Audition before). To
load that project, do the following:

1. Make sure that you’re in multitrack mode. If you don’t see a collection of parallel, horizontal tracks,
then you are in either the Edit View or CD Project View. Switch to the Multitrack View by clicking the
tab highlighted in Figure 16.1 or the Multitrack icon in the upper left corner (also highlighted in
Figure 16.1).

2. Select File > Open Session.

3. Go to the Adobe Audition directory (default location:    C:\Program Files\Adobe\Audition 1.5\Audition
Theme  ).

4. Double-click on    Audition-    Theme.ses  . Doing so will open the file in the main Adobe Audition
multitrack user interface.

To play this 12-second spot, click the Play button at the bottom of the screen (or use the space bar keyboard
shortcut). With the exception of the narration and a couple clips, this theme was created using loops from the
Adobe Audition library.

Slow down its tempo from 129 BPM to 100 BPM (or whatever new beat suits you) by highlighting 129 in the
Tempo window in the lower-right corner of the screen, typing in the new BPM, and pressing Enter. After Adobe
Audition finishes taking a few seconds to reprocess the audio, listen to the changes by pressing the Home key to
return the edit line to the beginning of the tracks and clicking Play.

Note: Changed Tempo—Unchanged Pitch

I hope that what you’re hearing amazes you. Everything slows down, but the instruments’ characteristics
remain unchanged. The narrator’s voice still has the same pitch, and he isn’t dragging his words. The drums
have the same presence, and the instruments sustain their tonal qualities. This powerful feature opens up
myriad possibilities. To whet your appetite, think of doing a 30-second spot with a 35-second narration. Use
Adobe Audition to compress that narration without turning it into Alvin and the Chipmunks.

Take the tempo up to 150 BPM. Amazing, isn’t it?
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Now we’ll change a clip’s volume. We’ll work with a clip in Track 5. To make it easier to hear your changes, solo
that track by clicking the little S, which is indicated by an arrow in Figure 16.2.

FIGURE 16.2: Click the Solo button to listen to only that track. Change a clip’s audio gain by clicking and dragging its
volume handles.

Note: Expanding the track view

Depending on your screen resolution you may see more buttons on each track than shown in Figure 16.2 (or
16.1). For instance you might see only the “S” (solo) and “M” (mute) buttons. Or you might not see the Lock
or FX # buttons. To see more expand the track view in up to two ways. You can expand the width of the
button collection by dragging the tall, vertical gray bar to the right. Or you can expand the height by
clicking the Zoom In Vertically button highlighted in Figure 16.3.

FIGURE 16.3:The Zoom In Vertically button
expands the height of the tracks, displaying
volume and panning lines more clearly and
displaying more control buttons on the left side of
each track.

Move the edit line to the beginning of that clip
by dragging its small triangle at the top or bottom of the multitrack window.

To make sure you can make volume changes within a clip display, select View and see to it that both Show
Volume Envelopes and Enable Envelope Editing are have check marks next to them.

Click on the SweepBass02-Eb clip to select. Doing so switches on its volume and pan envelope handles
(highlighted earlier in Figure 16.2 – volume handles are at the top of the clip, pan handles are in the center). Grab
them and move them around a bit. Press the space bar to play the clip and check out the changes. Do this as
much as you want with this or any other track. When done, switch off the Solo button.

Change the Pan settings for a clip. The pan handles should be visible by default. If not displayed, click the Show
Pan Envelopes button at the top of the interface (see Figure 16.4).

FIGURE 16.4: Turn on the pan envelope display by clicking this button at the
top of the user interface.

Adobe Audition color codes pan and volume lines: Pan lines are blue and
the volume lines are green. If you choose, you can make it easier to see the pan envelope handles by turning off
the Volume Envelopes display by clicking its button (to the left of the Pan button).

Solo Track 6 and select the first clip: grooveRhodes19-Ab. Note that it’s set to pan slightly to the right (the line is
below center and if you hold your cursor on a handle it’ll say “Pan 60” or something similar to that). Grab and
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move those pan handles and listen to those changes. You can add handles by clicking on the Pan line and
dragging it to a new location.

Adobe Audition’s Audio Effects

As you’ve heard during the previous module, Adobe Premiere Pro has a wealth of high-end audio effects. Not
surprisingly, Adobe Audition does as well. What you’ll note when working with them is all the extra features they
offer.

Task: Test Adobe Audition’s Audio Effects
Applying audio effects is a relatively simple task.
But deciding what works well and when to do it
takes a lot of trial and error. A good way to get to
know what Adobe Audition can do for you is by
sampling its effects. You can add them to entire
tracks or to individual clips. Here’s how:

1. Solo Track 1 by clicking its little S.

2. Open its Properties window by right-
clicking in an empty space below the track
name (in this case below the word
“EuroBeat”). Note that you can use the
Properties window to set volume, panning
and other effects for the entire track).

FIGURE 16.5: The track Properties window gives you
access to volume and panning
controls as well as all effects added to
a track.

3. Open the track’s Effects
Rack (shown in Figure 16.6)
by clicking the “FX 1”
button highlighted in
Figure 16.5

FIGURE 16.6: Use the Track Effects
Rack to add or remove effects from a
track.
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4. To apply an effect to the entire track (affecting all clips
on the track equally), you select one from the
collections on the left side of the Track 1 Effects Rack. In
this case, expand the Delay Effects list, select Full
Reverb, click Add, and then click OK to close the Rack
(you can click Properties to access the FX Properties
window, referred to in the next step).

5. That returns you to the Track Properties window. Click
the “FX 1” button again (it’s now a light blue color,
indicating an effect has been added to the track) to
open the FX window for Track 1.

FIGURE 16.7: The FX window lets you adjust each effect’s
parameters individually or select from a collection of presets.

6. Play the clip by pressing the space bar or the Play
button, and try out a few Full Reverb pre-sets by
selecting them from the drop-down list highlighted in
Figure 16.7. Great Hall gives your music a dramatic, expansive sound. Move some of the
sliders—especially “Reverb (wet)”—to see how that changes the sound (it mixes a percentage of the
original audio with the reverb version). Full Reverb is a very involved effect, so there might be a pause
between selecting a different preset and hearing Audition apply it.

7. Add another effect to this track by clicking the Rack Setup button (in the upper-right corner) to re-open
the Track  Effects Rack window.. Open the Special folder, select Distortion, click Add, and click OK to
return to the FX 1 window.

Tip: What to Do When the Music Ends

If you want to play a clip over and over, you have two choices: When the song ends, click Stop and then click
Play to start it over, or use the Loop Play button (it’s shaped like the ∝ infinity symbol.

5. Click the Distortion tab to open its control display, shown in Figure 16.7. Play the clip and try out some
pre-sets. Move the handles on the display. This effect can give your audio a grungy, garage band sound.
You can keep it by closing the dialog box, or you can click the Rack Setup button, select Distortion from
the Current Effect Rack, click Remove, click OK, and then close the FX 8 dialog box.
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FIGURE 16.8: The Distortion dialog box offers pre-sets plus something a bit out of the ordinary: graphic controls.
Drag the handles along the curved line to further adjust the sound.

Tip: Drag and Drop Effects on to Tracks

The alternative means of adding an effect to a track is to simply drag it from the Effects list on the left side of
the Adobe Audition user interface, shown in Figure 16.8, and drop it anywhere on a track. Just for grins,
open Delay Effects, drag Chorus to Track 1 and select More Sopranos from the drop-down list. It’ll sound like
a hard edged marching band.
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FIGURE 16.9: Even if a track’s FX dialog box is closed, you can add an effect to a
track simply by dragging it from this collection to the anywhere on the track.

Note : Track Effect Versus Clip Effect

When you're in multitrack view, all effects are applied to entire tracks, not
to individual clips. Even if you drop an effect on a clip in a track, it still
affects the entire track. To apply effects directly to clips, you need to open
a clip in the Waveform window. I cover that starting in Step 6.

6. Double-click the AA-TakesAA6a clip to open that part of the narration in the waveform edit window
(see Figure 16.9).
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FIGURE 16.10: Double-clicking a clip segment opens it in the waveform edit window. You’ll use the Chorus effect on
this narration to give the clip some presence.

7. Add the Chorus effect to this clip by double-clicking it (it’s in the Delay Effects group). That opens the
Chorus settings dialog box shown in Figure 16.11. Note that it has a different look than the track effect
settings dialog box.
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FIGURE 16.11: When adding effects to clips—in this case, the Chorus effect—the dialog boxes take on a different
look but still offer virtually the same functionality.

8. This dialog box has a Preview button. Click it and try out the various pre-sets. I like Rich Chorus. When
you're done, click Cancel.

9. Open Time/Pitch and double-click Pitch Bender. This is a very cool effect (shown in Figure 16.12) that
can give a narrator a whole new pitch. Select Down a Whole Step from the pre-sets and click Preview. A
deeper, more sonorous voice emits from your speakers. You can drag the pitch handles in the screen
and make changes on the fly. Try the other pre-sets as well. This will change the length of the clip. So,
for example, selecting a lower pitch will make the clip longer. Cancel out of this effect.

10. To change the pitch without changing the clip length, select Stretch. Click the “Pitch Shift (preserves
tempo) radio button, open the Transpose drop-down list and select a new pitch – b means drop some
number of steps and # means go up. Preview those changes.
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FIGURE 16.12: Pitch Bender raises or lowers a clip’s frequency, giving a narrator a high, squeaky voice or a basso
profundo voice, for instance.

There is a passel of additional effects. Of particular interest is the Noise Reduction group. For instance, you can
use its Auto Click/Pop Eliminator to analyze recordings made from vinyl records and automatically remove
scratches. Noise Reduction will analyze a quiet passage of a concert and remove things like electronic hum from
the music. Hiss Reduction will fix old audio tapes.

Using Adobe Audition to Craft a Tune

You’ve done multitrack and waveform editing; now you’ll create a tune using Adobe Audition’s loops. To do this,
you’ll need to download the Rockabilly loopology collection from the Adobe Audition site:
www.adobe.com/products/audition  . If you feel like venturing off on your own, feel free to try a different set of
loops.

Task: Composing Music Using Loops
Creating a tune using loops is great fun. The possibilities are endless. I give you a taste of that experience in this
task. The basic process is to preview loops from an Adobe Audition library. They will be variety of similar riffs
(within the selected musical genre) using a several different instruments. You’ll want to select some that you
think will play well together.
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In this task I will have you work with some specific loops. But feel free to experiment, head off on a different tack,
or throw in some special effects. This is one of those activities where you might find yourself still at in the wee
hours of the morning, wondering where the night went. Here’s how it works:

1. Before we get started on this, you’ll need some Audition Loopology content. If you have the Audition
CD, then use it to access the content, otherwise download the Rockabilly files from:
http://www.adobe.com/special/products/audition/loopology.html.

2. Close your Theme session by selecting File > Close All. When it asks you if you want to save the changes
click No.

3. If you’re not in the multitrack view, click the multitrack button in the upper left corner to open a blank
multitrack interface.

4. Start a new multitrack session by selecting File > New Session, choose 44100 from the New Multitrack
Session dialog box, and click OK.

5. Click the File folder button in the upper left (below the File tab). That opens the Open an Import
window shown in Figure 16.13. Things will get a bit tedious here, but one at a time, open each file
folder, select all the loop files (they have the CEL suffix—a hold-over to the pre-Adobe Audition, Cool
Edit loop file naming convention), and click Open for each collection.

FIGURE 16.13: One at a time, open each of these folders, select all the CEL files, and click Open to add about 115
loops to your project.
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6. When you’re done, you’ll have about 115 loops loaded into your workspace. As shown in Figure 16.14,
select Sort By: Filename to get them into alphabetical order.

FIGURE 16.14: How your workspace should look after adding the
rockabilly loops to your project.

7. Now the fun begins. Click on the Auto-Play button (below the
Sort By: drop-down list) to switch it on. Click on a loop to listen to
it. Preview as many loops as suits you to get a feel for what’s to
come. You’ll note that most play for four beats—in this case, one
measure of music.

Note: Follow the Keys

Most of the clip names include their key, as in their musical key
signature. It’s a good idea to place loops in the same key at the same
time in the piece. If you’re not into music and don’t get this, I think it
will become clearer in a few steps.

8. Start your piece by dragging IntroPickup to Track 1. Once on
the track, left-click and drag it to the beginning of the track.

9. Drag Kick&Snr07 to Track 1 and slide it up against IntroPickup.
Extend it another three bars (four in all) by dragging its right
edge to the right. As shown in Figure 16.14, the cursor changes
to something like the Adobe Premiere Pro Ripple Edit tool. As in
Adobe Premiere Pro, Snap-to-Edges makes it easy to create four
bars exactly (Adobe Audition displays those bar divisions with
thin, vertical dashed lines). That five-bar track segment should
look like Figure 16.15.

FIGURE 16.15: After adding a loop, you can grab its right edge and
drag it to build additional bars. In this case, four bars in all.

10. Play that segment and note how the IntroPickup loop
moves seamlessly into Kick&Snr07.

11. Add three more drum loops to Track 1: Kick&Snr10 (four
bars), Kick&Snr05, and Kick&Snr04 (two bars each).

12. Here are the loops that I suggest you add to the rest of the tracks:

• Track 2: ChugginA starting at bar four (note the bar number ruler at the bottom of the multitrack
screen) for two bars, Walkdown_A2 (two loops equaling one bar), WalkUpTo4 (two loops equaling
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one bar), ChugginA (two bars), Chuggin5 (two bars), ChugginA (two bars), WalkDownA_2 (two
loops equaling one bar), and TremBarEndingChord02-E (one loop equaling two bars)

• Track 3: FunkierThanBilly-B starting at bar six for two bars, HappyGoLuckyB (two bars), and
HappyGoLuckyA (two bars)

• Track 4: HonkyTnk04-A starting at bar eight for two bars, HonkyTnk05-B (two bars), HonkyTnk03-A
(two bars), and PianoCmp03-A (one bar)

• Track 5: BowFidl07-A starting at bar four for four bars, BowFidl09-A (two bars), BowFidl12-B (two
bars), and BowFidl10-A (two bars)

13. If you followed my song-building suggestion, your project should look like Figure 16.16. Play it. I think
you’ll enjoy it.
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FIGURE 16.16: How your completed composition should look.

Note: Key Consistency

To see what I meant in the “Follow the Keys” note, take a look at the clips in bar eight. All end with a large
letter A. They are all in the key of A. At bar ten, they’re all in the key of B (Chuggin5 is the exception, but it
sounds like the key of B). At any rate, it’s generally a good idea to match key signatures in the same bar.
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Tip: Coloring Clips

That the clips are uniformly green is Adobe Audition’s default behavior. As in the Adobe Audition Theme
session, if you want to give your clips different colors, simply right-click on a clip, select Clip Color, move the
slider to color you like, and click OK.

13. Make a waveform edit by double-clicking   TremBarEndingChord02-E   at the end
of Track 2. Note that it has a little extra scrunch sound at the end of the
waveform. Remove that by positioning the cursor between the stereo
waveforms right before the extra noise starts, noting the cursor turns into an I-
beam, and dragging it to the right to highlight the section to remove. Use
Figure 16.17 as a reference. Press the Delete key. Adobe Audition automatically
stretches the clip to fit its original two bars.

14. Click the Multitrack button to return to that window. Feel free to add some
effects to clips and/or tracks, change volume levels to highlight certain
passages, and pan the instruments across the stereo field if that suits you.

FIGURE 16.17: To remove an offending bit of noise, open the clip in the Waveform edit
window, drag the cursor to highlight the offending segment, and press Delete.
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Loopology Creation

Adobe Audition’s 5,000+ loops are essentially the product of one man: Jason Levine. As performer, engineer, and
producer, he created, recorded, and mastered this entire library of original, royalty-free music. Levine has a
lengthy history as an accomplished musician and recording studio engineer. He says that the "most exciting
studio experiences of my life involved a two-year engagement working with one of the industry's most
respected and honored engineers, Roger Nichols of Steely Dan fame."

Levine worked for Syntrillium as Music Director, with a heavy emphasis on
Cool Edit Pro 2's concept and workflow. With Adobe's purchase of Syntrillium,
he became Adobe Audition’s main "evangelist," presenting the product at
conventions and workshops across the globe.

During his Syntrillium tenure and before making the move to Adobe Audition
evangelist, Levine created production-quality music loops. Using his home
recording studio and Adobe Audition’s multi-track recording capability,
Levine (performing on keyboards and synthesizers, plus bass guitar and
drums) worked with two other musicians: guitarist and Adobe Audition user
interface designer Steve Fazio and drummer Fred Fung. Together, they
crafted the true, ensemble sound of the 4,500 loops that ship with Adobe
Audition.

That is a big selling point for Adobe Audition. Because Levine recorded the loops as live performances by the
three musicians working together in the studio, those loops have a real, ensemble feel and work well together.
No other loop collection can tout that.

His recording setup probably has a few more bells and whistles than what you might have at hand or want to
purchase. But if you want to create original audio content, I think you can learn from his methodology.

Adobe Audition—An Audio Recording Studio

Here's a basic rundown of the audio studio setup that
Levine used to record the loops:

• Two M-Audio Delta 1010 audio cards—Street
price: $599 each (   http://www.m-audio.com/ ).
These have eight analog input/outputs and
one pair of digital I/Os (see Figure 16.21).
Adobe Audition sees each of those discrete
channels and can record them to individual
tracks.

FIGURE 16.18: Jason Levine used two M-Audio Delta
1010 sound cards (20 input/output channels in all) to
capture audio to his PC.

• Industry-standard Mackie mixers (   http://www.mackie.com/ ) to ensure proper levels and mix. Basic
Mackie mixers that will serve most purposes start at only about $200. The 1202-VLZ Pro has 12 channels
and a street price of $400.
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• Several different types of preamps captured and enhanced drum, bass,
and guitar sounds. Preamps can be a bit expensive. When in doubt, you
can always turn to the transparent, clean sounds inherent in Mackie
mixers‘ built-in preamps.

• A varied collection of microphones rounded out the audio-capture
process. Levine selected each mic to lend its distinctive quality to the
many instruments recorded for the Adobe Audition content library. These
included Shure’s SM57 ($147) and SM58 ($188) (   http://www.shure.com    )
and the ubiquitous, high-end studio favorite C414 ($799 street
price—see Figure 16.17) from AKG (   http://www.akg.com    ).

FIGURE 16.19: You’ll find the AKG C414 microphone in most professional audio
production studios.

Even without all this gear, you can record audio using Adobe Audition. Simply plug a mic or musical instrument
into the mic or line input, respectively, on your sound card. As shown in Figure 16.20, press the R record button
on a track to switch to its record mode, open the Recording Devices dialog box by clicking the “In 1” button,
select the input channel (most standard sound cards offer only one stereo line input), and then click the Record
button at the bottom of the multitrack window.

FIGURE 16.20: Access Adobe Audition’s 32-track recording mode by clicking a track's Record button and assigning an
input channel to that track.

Your sound card probably has only one stereo line input, but Adobe Audition enables you to split the channels
onto two distinct tracks. This works well for radio announcers who record a narration on one of those mono
channels while listening to the music accompaniment as it's being recorded to the other channel.
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Burning Audio CDs with Audition

Audition 1.5 has a new functionality: a full-featured, Audio CD Creation tool. Click the CD Project View tab.
Double-click in the empty space to open the Insert Audio window, navigate to any audio track of virtually any file
type and add it to the CD Project. As shown in Figure 16.21, Audition automatically adds a two second pause
between cuts (you can change that to any amount, including zero) and will convert virtually any audio file type
to CD-audio once you click the Write CD button. This is a great addition to Audition 1.5 and works much better
than most commercial, stand-alone Audio CD creation products.

FIGURE 16.21: Use Audition’s CD Project View to create custom audio CDs using virtually any type of audio file.
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Music adds immeasurably to your video projects’ overall quality. Finding just the right piece to fit or set a mood
can be arduous. Adobe Audition goes a long way to simplifying that search.

Adobe Audition ships with 5,000+ music loops that you can place on up to 128 tracks to create your own unique
musical arrangements. In addition, you can add numerous audio effects, record your own audio (instruments
and voice), and use Adobe Audition to remove tape hiss, vinyl record clicks, and ambient noise from live
recordings.

Q. I have the QuickTracks plug-in for Adobe Premiere 6.5. Is there any compelling reason for me to use
Audition to create musical content?

A. It depends on your musical needs. QuickTracks is a fun product, but it has a limited library and you need to
pay a licensing fee to SmartSound to use its tunes on commercial products. Auditions Loopology content is
royalty-free, meaning you can use them for all productions: personal or professional. And Audition gives you
absolute control over the editing of each tune.

Q. Why use Adobe Audition to add special effects to audio when Adobe Premiere Pro can do the same
thing?

A. It’s true that Adobe Premiere Pro has many of the same types of audio effects as Adobe Audition, but overall,
Adobe Audition’s collection has more control options, more pre-sets, and better audio restoration capabilities
than Adobe Premiere Pro. In addition, it ships with those 4,500 music loops and has a multitrack editor/mixer
and a 32-track recording capability.

Quiz

1. In Adobe Audition, how do you display both volume and panning characteristics for clips?

2. In Adobe Audition, you’ve already added QuickVerb to a track but want to swap that out for the more fully
featured Reverb effect (you want to use its Shower setting—yep, as in singing in the shower). How do you
make the exchange?

3. You want to speed up your announcer’s delivery. How do you do that?
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Answers

1. Make sure that the track on which your clips reside is unlocked. Then select the clip by clicking on it, and
click the dB and the L/R buttons at the top of the screen to display the volume  and  panning handles. Note
that moving the panning line to the top of the clip sets its value to -100 and places the audio completely in
the left channel.

2. Click that track’s FX button, click Rack Setup, select QuickVerb, click Remove, select Reverb from the Effects
window, click Add, and click OK. That takes you back to the FX dialog box where you can change the pre-set
for Reverb to Shower. Don’t forget to sing a few bars: “Soap, soap, soap, soap.”

3. The Tempo value at the lower-right corner of Adobe Audition’s user interface works well for music with a
beat, but it’s not intended for voice. To change the speed of your announcer, try the Stretch effect in the
Time/Pitch Effects group.

Exercises

1. Record some vinyl records to your hard drive. You’ll probably need to use an amplifier connected to the line-
in plug on your PC sound card. Use Adobe Audition’s built-in Clip/Pop Eliminator to automatically remove
most of those annoying clips. Then use the waveform editor to isolate single clicks (you’ll see sudden, sharp
jumps in the waveform) to remove the rest.

2. Jason Levine’s (the Adobe Audition loopology creator) favorite loop content is Funk Rock. Those loop files
(contained in two downloadable Zip files totaling 104MB) really lend themselves to the creation of some fun
powerful music. If you have the Internet bandwidth, download them and take your loop music creation to
new levels. After you’ve laid down a few tracks, give the clips and tracks some special effects—Reverb,
Chorus, and Distortion, for example—and adjust their volume and pan characteristics. Also try out some
tempo changes.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education
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Module 17

Using Higher-Level Video Effects

I introduced you to several video effects in Module 11, “Working with Video Effects.” In this module, I present
most of the remaining effects. The major exception is the set of Keying effects that I cover in Module 18,
“Compositing Part 1: Layering and Keying Clips.” I also leave the Color Corrector effect and some effects that
work best with clips on more than one video track for later modules.

Adobe® Premiere® Pro's 90-plus video effects run the gamut from simple to complex. They have a wide range of
uses. Some your students may rely on regularly, whereas others fill such narrow niches they may never see the
light of day.

With so many video effects staring up at you, it's darned
hard to know when and why to use any one of them. In
this module, I'll single out my favorites and try to make
sense of the rest.

At the end of this lesson, students will have learned
about:

• Making sense of the plethora of video effects

• Technical fix effects

• Blur & Sharpen effects

• Distort effects

• Color and Appearance Effects including 4
image correcting effects, new to Premiere Pro
1.5

• Selected Adobe After Effects® effects

Making Sense of the Plethora of Video Effects

It's not easy wading through Adobe Premiere Pro's 14
video effects categories (as I mentioned in Module 11,
you might have more than 14 categories), trying to
unravel what their 90-plus effects do and how they do it
(see Figure 17.1). The category names do not necessarily
match their functions. And some effects have multiple
functions with numerous options.

Figure 17.1: Adobe Premiere Pro's 14  category names for
video effects do not necessarily describe their contents.
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Note: Additional Categories – SteadyMove & Transitions

If you added SteadyMove when you installed Adobe Premiere Pro, it will reside in its own category: 2d3.
SteadyMove is a third party plug-in that smoothes out shaky camera work. If you have After Effects installed
on your PC, you probably will see an additional Video Effect category called “Transitions.”

The categories themselves can be confounding. The Gamma Correction video effect is in the Image Control file
folder but is also a parameter of the Levels effect, which is in the Adjust file folder. Convolution Kernel is in the
Adjust folder but handles 10 different functions of several single-purpose effects in the Stylize and Blur &
Sharpen folders. And the Transform effect is not in the Transform file folder, it’s in the Distort folder.

Some effects resolve rarely encountered technical problems, such as missing fields or "interlace flicker." Still
others don't seem to achieve their stated purposes.

To minimize clutter, ease access, and keep things simple, I have organized this chapter by effect categories. I
suggest you create several new video effects file folders to match those categories: Technical Fixes, Color and
Appearance, and Selected After Effects. You'll continue to use the Blur & Sharpen and Distort group.

To further eliminate clutter, I've placed the also-rans in one other category—Other.

Tip: Creating Custom Folders

To create these new categories, click on the Video Effects tab in the Project window, click the fly-out menu
triangle and select New Custom Bin. It creates a folder named “Favorites.” Change that name by clicking on
it to highlight it and then typing in a new name: Technical Fixes, Color and Appearance, and so on. To
further clarify this new organization, you might add your initials to each bin name. Later, as I go over the
various effects, you can drag and drop their icons to the new folders.

Even after you drag an effect to a custom bin, the effect remains in its default bin. You cannot delete effects
or bins.

Technical Fix Effects

When you think of video effects, technical fixes do not come to mind. The primary reason you use video effects is
to alter the appearance of your video clips—to blur, emboss, tint, or distort—or to add graphic elements, such as
lightning and lens flare.

So I'll get this mundane but useful technical stuff out of the way first.

At first, you may use a variety of single-purpose effects from Adobe Premiere Pro’s collection of technical fix
effects. Eventually, you might settle on the one effect that can do just about anything those others can
do—Levels.

I'll introduce Levels, list the technical fix effects with brief explanations, and then go over how to use the Levels
effect.
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My Favorite Technical Fix Effect: Levels

The Levels effect (shown in Figure 17.2 with all its parameters and its separate settings dialog box) is one of
several jacks-of-all-trades video effects. It manipulates the overall brightness and contrast of a clip and of its
individual color channels, enabling you to adjust the following four image characteristics (each of which has its
own separate video effect):

Brightness & Contrast—This is standard TV control stuff that can significantly enhance your video.

Color Balance RGB—You will use this time and time again. No matter how carefully you use white balance
when shooting your videos, some video clips will turn out too red, green or blue. The Levels effect enables
you to fix that by adjusting the individual RGB color brightness and contrast levels.

Gamma Correction—Anyone who's played a video game with a too-dark setting knows that bringing up
the gamma levels brightens the scene without washing it out. This effect accomplishes that by bringing up
the mid-tones while leaving dark and light areas unaffected.

Invert—This switches color information making your video look like a color negative.

Figure 17.2: The Levels Settings keyframable parameters and its dialog box are not immediately intuitive.
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Using Levels to do these simple tasks may be overkill. Instead, you might want to first use each of those four
features’ much more user-friendly, stand-alone video effects. In another Adobe Premiere Pro conundrum, you’ll
find them in two different video effects bins: Adjust and Image Control.

Using the Levels Effect

To see the Levels effect in action, drag it from the Adjust bin to a video clip (or select a clip and drag Levels to
the ECW (Effect Controls Window). In the ECW, click on the Levels Settings dialog box icon (the little PC screen
icon).

This is not your father's TV set brightness and contrast control. The interface takes some explanation. The chart is
a histogram of your currently selected frame. Brightness values from dark to light run along the X-axis. The Y-axis
represents the number of pixels at each brightness value.

Use the drop-down list at the top of the interface to choose whether you want the tonal adjustments to apply to
one of the three color channels or to all three at once (RGB).

The sliders directly below the histogram control contrast and gamma. Drag the black triangle to the right to
increase the shadows, the white triangle to the left to increase the highlights, and the gray triangle to control the
gamma—the mid-tones.

The Output Levels slider reduces contrast. Dragging the black triangle to the right eliminates the darkest values
in the clip, whereas sliding the white triangle to the left eliminates the brightest values.

Other Technical Fix Effects

In addition to Levels and its four siblings, here are the other technical fix effects that are available to you:

Broadcast Colors—This effect ensures that color values will play back on PAL or NTSC TVs. It's a powerful tool
with simple controls, but you might never need to use it.

Clip—Trims away noise from the edges of your videos, replacing the removed pixels with a user-specified frame
color. If you don’t want a frame, use the Motion effect to zoom in on your video to push noisy frame edges off-
screen. I demonstrate a practical use for Clip at the end of the “Bevel Alpha, Bevel Edges, and Edge Feather”
section later this module (I do it then because that’s when I have you open a new project in which this effect
works well).

Color Balance (HLS)—This alters a clip’s hue, luminance, and color saturation. It doesn’t have the color accuracy
of Color Balance RGB. Gamma Correction and Brightness & Contrast perform similar functions.

Field Interpolate—Rarely used. It's for instances when field loss (basically, half a video frame) occurs during
capture.

Median—Median's strength is its oil painting effect (see the “Color and Appearance—Painting Effects” section
later this module). But its original purpose was to reduce video noise.
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Blur & Sharpen Effects

As with the Levels effect and its narrower purpose siblings, at the core of most of the Blur & Sharpen effects is
another jack-of-all-trades, the Convolution Kernel effect.

As shown in Figure 17.3, the Convolution Kernel effect also has a Settings dialog box and a lengthy list of
keyframable parameters.

Figure 17.3: Convolution Kernel is fun to experiment with, but it’s a heck of lot easier to use individual Blur & Sharpen
effects than to tweak its matrix values or presets.

It changes the brightness values of pixels using a three-by-three matrix and a mathematical formula. The
formula divides the sum of those pixel values by another user-set variable and then adds yet another user-
selected value to that quotient, thus creating the desired effect.

So it's not surprising the Convolution Kernel effect can handle most of the effects in this category. But Adobe's
Premiere Pro effects creators recognize that Convolution Kernel is not for the faint of heart. For all but two pre-
set effects, it’s easier to use individual, narrower-purpose Adobe Premiere Pro effects rather than the
Convolution Kernel's matrix calculations or even its presets.

Convolution Kernel Overview

Convolution Kernel is the workhorse of this category. But of its 10 presets shown in Figure 17.3 and in the
following list, only Gaussian Sharpen and Sharpen Edges work as well or better than their single-purpose
siblings. Stick to the other recommended Blur & Sharpen effects and experiment with Convolution Kernel to
create your own effects.

• Blur—Very subtle. Use Directional Blur or Fast Blur instead.

• Blur More—Directional Blur and Fast Blur work better.
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• Emboss—Use the Emboss effect instead. It gives you more control.

• Light Emboss—Use Emboss instead.

• Find Edges—This identifies and emphasizes areas of an image with obvious transitions/edges. The
stand-alone Find Edges effect is a full-featured and powerful tool that I cover in the Color and
Appearance Effects section later this module.

• Gaussian Blur—This is nearly the same as Fast Blur.

• Gaussian Sharpen—This is on par with the separate Gaussian Sharpen effect.

• Sharpen—The After Effects Sharpen effect has a slider, so it works better.

• Sharpen Edges—This is the only Convolution Kernel preset that outshines the specialized effect.

• Sharpen More—Use Sharpen instead.

My Favorite Blur & Sharpen Effects

Each of the following video effects can either soften or sharpen entire clips or elements within clips:

Antialias—It softens edges between contrasting colors and light.

Channel Blur— This effect, illustrated in Figure 17.4, shifts RGB (red, green, and blue) colors individually,
creating a blurring effect. It works well with alpha channels (transparent portions of some graphics), enabling
you to shift the colors of graphics.

Figure 17.4: The Channel Blur blurs individual color channels.
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Directional Blur—By smearing pixels in a user-selected direction, this effect supposedly gives the illusion of
motion. I don't think it's all that effective, but it is a good way to simply create a blurred image.

Fast Blur—This creates a much more blurred image than Directional Blur. Figure 17.5 shows how easy it is to
use. Apply keyframes to create an ever-increasing blur over time. This works better than Gaussian Blur or Camera
Blur.

Figure 17.5: Fast Blur creates the blurriest images.

Radial Blur—The "Psycho" look. It creates a whirlpool blur that simulates a swirling camera. Figure 17.6 shows
that you can vary the location, type, and quality of the blur.
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Figure 17.6: Radial Blur gives a video clip a soft swirling look.

Caution: Radial Blur—A CPU Cycles Hog

Radial Blur is a processor-intensive effect—thus the three Quality settings. At the highest quality, Adobe
Premiere Pro's Real-time Preview might stutter through the clip. Rendering Radial Blur at its full quality takes
extra time.

Sharpen—This effect sharpens a soft-focus image by increasing contrast where color changes occur. This effect
uses only a single slider. It works better than Gaussian Sharpen or the Convolution Kernel's Sharpen and Sharpen
More presets.

Duplicate Blur & Sharpen Effects

Feel free to place the following four video effects in your Other folder. Other effects handle their chores as well
or better than they do:

Camera Blur—The Directional Blur effect handles this and adds a direction component.

Gaussian Blur—Same as the Fast Blur effect.

Gaussian Sharpen—The Convolution Kernel preset is as good as this stand-alone video effect.

Sharpen Edges—The Convolution Kernel preset is as good as this stand-alone video effect and has more
options.
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Distort Effects

With a few exceptions, these effects all do the same kind of thing. They twist and contort your clip into funhouse
mirror shapes. To use them well takes some experimentation on your part. Rather than explain them in detail, I'll
lump similar effects together and use figure captions to identify them.

I will give brief explanations of the non-funhouse distortion effects at the end of this section.

Spherize, Bend, Lens Distortion, Ripple, and Wave Warp

The five effects shown in Figures 17.7–17.11 all create undulating, twisting effects:

Figure 17.7 Spherize pushes out or pulls in the image using a ball shape. You can grab its crosshair target to move its
location around the screen.
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Figure 17.8: Bend most closely re-creates a funhouse mirror effect. It fills the screen with the distorted image.

Figure 17.9: Lens Distortion’s
primary function is to reduce
distortion effects, i.e., when shooting
at extreme angles or with special
lenses. In addition, it has a feature
that enables you to fill any gaps you
create with a color selected from the
clip (rolling the cursor over the small
image automatically switches on
the highlighted eyedropper tool) or
from the color picker window.
Alternatively, you can turn that gap
into a transparent alpha channel
(discussed in Module 19,
“Compositing Part 2: Alpha
Channels and Mattes”) to allow clips
below it on the sequence to show
through.
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Figure 17.10: Ripple is like
Bend but leaves gaps
around the curves that you
can fill with color, just as
you can do with Lens
Distortion. Except in this
case, you do not have an
Alpha Channel option.

Figure 17.11: Wave Warp is new to
Premiere Pro 1.5. This After Effect effect
replaces the Wave Photoshop effect. It offers
many more parameters including more wave
types and whether you can “pin” the wave to
one or more edges of the screen.

Mirror, Polar Coordinates, and Twirl

These three effects, shown in Figures
17.12–17.14, are all After Effects effects. For
one thing, that means they do not have
separate Settings dialog boxes. Note that
Mirror and Twirl are both motion-style
effects (they have a bounding box cursor
before their names in the ECW) and
therefore have a crosshair you can drag
around onscreen to set the focal point of
the effect.
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Figure 17.12: Mirror perfectly reflects the scene at the crosshair (switch it on by clicking on “Mirror”) using the angle
selected, where 90 degrees creates a reflection along a horizontal line, and 0 degrees creates a reflection along a
vertical line.

Figure 17.13: Polar Coordinates converts the clip's X/Y coordinates into polar coordinates (or vice versa) to create this
odd little lens distortion. The slider intensifies the effect.
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Figure 17.14: Twirl rotates a clip around the crosshair. The greater the radius and angle, the more intense the twirl.
Animate this using keyframes to create a real cool effect.

Horizontal Hold and Vertical Hold

The effects shown in Figures 17.15 and 17.16 give the impression
that something is dreadfully wrong with the viewer's TV. You can
use them both on the same clip to really make things go haywire.

Figure 17.15: Horizontal Hold has a separate dialog box with slider
control to set its severity.
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Figure 17.16: Vertical Hold has no parameters. It’s either on or off. When it’s on, your image just rolls and rolls and
rolls.

Noise—Give Your Clips That Old VHS Feel

You do what you can to create clean, sharp, noise-free video. So what does Adobe do? It includes this Noise
effect in Adobe Premiere Pro to give your videos that low-light, consumer, analog camcorder look.

The Amount of Noise slider sets the noise level by distorting or randomly displacing pixels. As illustrated in
Figure 17.17, at a setting of 20% or so, the effect creates a very noisy image. Crank it up to 75% and your clip
might become unrecognizable.
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Figure 17.17: Noise can give your tape the look of a worn-out VHS tape.

Checking the Use Color Noise box randomly changes the red, green, and blue values of the image's pixels.
Unchecked means all color values change equally.

Checking the Clip Result Values box creates a more realistic Noise display by letting color values that reach their
maximum value "wrap around" and start over at 0% noise. Leaving it unchecked means color values that "max
out" stay at that maximum level, making some portions of your scene shimmer with noise.

Tip: Noise to the Max

To completely randomize Noise, turn on Use Color Noise and turn off Clip Result Values. To reproduce "true"
noise, set the slider to about 20%, turn off Use Color Noise, and turn on Clip Result Values.

Camera View

This effect warrants special mention. As shown in Figure 17.18, Camera View gives the impression of a camera
looking at your clip from different angles. It works a lot like the Basic 3D effect in that it rotates, flips, and zooms
a clip. What makes it stand out from Basic 3D is that it gives immediate feedback in its Settings dialog box.
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Figure 17.18: Camera View
enables you to twist, flip, and
zoom your clip, simulating a
camera viewing the clip from
varying angles.

Basic 3D—Create That
Glint Shot

This effect is not all that
different from the Camera
View effect. In fact, Camera
View has more options, the
most important being
Zoom-in and Roll. What
makes Basic 3D worth your
time is its Specular
Highlight option. As shown
in Figure 17.19, a simulated
light source can create a
moving glint on the surface
of your clip as it changes
angles and moves around the screen.
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Figure 17.19: I used Basic 3D's Specular Highlight to add a glint to this windshield where none existed. You also can
use that highlight to add  a realistic touch when tilting a screen and moving it in 3D space.

Note: A Glint Is Not a Lens Flare

Do not confuse this with Lens Flare (covered later this module). In that case, the light is not reflecting off the
surface of the clip; it’s simulating a series of refractions that occurs when a camera lens is pointed at an
oblique angle toward a light source.

The move takes place on only two axes:

Swivel—Controls horizontal rotation

Tilt—Controls vertical rotation

Go beyond 90 degrees in either direction, and you see the back (mirror view) of your image. The Preview mode
switches to a wireframe view. It notes the presence and location of the specular highlight using a green plus (+)
sign (enlarged for emphasis in Figure 17.20). A red plus sign shows the highlight’s location but indicates that it
won't be visible because the image is not tilted toward the simulated light source.
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Figure 17.20: Switching to Preview mode turns on a
wireframe view, making it easier to locate and follow the
specular highlight.

Caution: Specular Highlight Issues

Basic 3D’s Specular Highlight (the main reason
you’d want to use Basic 3D) is a surprisingly
processor-intensive effect. Not even a single frame
will display it if you have your Monitor window set
to Draft Mode. To see it, either switch to Highest
Quality (click the wing menu to access that feature)
or render the clip.

Also, it can be very bright if the reflection is straight
at you—that is, if the highlight is at the center of the
screen. To avoid that, try to make your moves so the
highlight travels around the edges of the screen.
Alternatively, use keyframes to turn on the highlight only when it reaches an edge.

Bevel Alpha, Bevel Edges, and Edge Feather

These effects create 3D beveled frame-like edges for your clips. Bevel Edges and Edge Feather are for regular
video clips and Bevel Alpha works only with graphics or videos that have alpha channels. All three are great tools
to use when you're using motion settings to fly clips over another image. Using them gives those flying clips
extra depth.

Task: Creating Beveled Images
In this case, rather than only showing you an effect I want you to try both of these. The purpose is twofold: to
show you how to combine effects and to introduce the concept of alpha channels:

1. When you installed Adobe Premiere Pro, you also might have copied the Sample Project NTSC or PAL to
your hard drive. If not, you’ll find those projects on the sample files CD that came with your boxed
version of Adobe Premiere Pro. To do this task, you need to copy that folder to your hard drive
(wherever you store your media assets is a good location).

2. Open Adobe Premiere Pro, click on New Project, navigate to your Sample Project folder, select Sample
Project (NTSC or PAL) and click Open.

Note: The Saleen Assets

The Saleen S7 is a custom-built automobile (still a prototype as we went to press). Adobe worked out a deal
with the manufacturer and the video production studio to include these assets with Adobe Premiere Pro
and use them in numerous demos. Feel free to view this project. Some of the effects are from Adobe
Premiere Pro and others were built in Adobe After Effects. I cover that latter product in Modules 24 and 25,
“Creating Animated Text with After Effects” and “Creating Motion Graphics with After Effects”.
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3. Select the Saleen_Car_08 clip (you can choose any clip but this one works well for the next few steps).
Apply Edge Feather to it and, as shown in Figure 17.21, increase the edge thickness to make the soft
frame obvious.

Figure 17.21: Edge Feather gives a soft border to a clip.

4. Delete Edge Feather and apply Bevel Edges to this clip. As shown in Figure 17.22, increase the edge
thickness to make the bevel obvious.
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Figure 17.22: Bevel Edges gives video clips a nice 3D frame.

Tip: Give Frames to Clips in Motion

When you fly reduced-size clips on screen using the Motion effect, giving them frames is a nice touch. Bevel
Edges, Edge Feather or Clip work well.

5. Apply Lens Distortion to this clip by dragging the effect to the ECW below Bevel Edges. Create a
distortion and note that, as shown in Figure 17.23, the bevel matches that new shape.
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Figure 17.23: If you apply another effect—in this case Lens Distortion—Bevel Edges adjusts its actions to match any
changes to the clip’s shape.

Tip: Effect Order Counts

Adobe Premiere Pro applies effects starting at the bottom of the ECW and working its way up. So in this
case, it performs the Lens Distortion and then applies Bevel Edges to it. Adobe Premiere Pro’s two fixed
video effects—Opacity and Motion—are last in line. If you want to apply Motion earlier in the effect chain,
use the Transform effect (it has the same parameters). If you want to apply Opacity earlier (I cover Opacity
and other layering tools in the next Module, “Compositing Part 1: Layering and Keying Clips), use the Alpha
Adjust effect.

6. Remove all the effects (select them one at a time and press Delete) and add Bevel Alpha to the ECW.
Increase the Edge Thickness and note that hardly anything happens. The reason: This effect works only
with graphics that have an alpha channel. That is, a transparent layer. You’ll see that in action in Step 12.
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7. The last clip in the sequence (highlighted in Figure 17.24) is not a standard video clip or graphic—it’s a
nested sequence (see the “What’s a Nested Sequence?” Tip for more on that). Double-click that nested
sequence to open it as a separate sequence in the Timeline window.

Figure 17.24: The last clip is a nested sequence—a separate sequence added to this sequence as a means to simplify
the editing process.

Tip: What’s a Nested Sequence?

Saleen_logo_Layers is a nested sequence. That is, it’s a separate sequence that is placed in another
sequence as a clip. In this case, this nested sequence is simply two layered—or composited—graphics that
have motion effects applied to them individually. Any work you do on this Saleen_logo_Layers sequence
will show up in that nested sequence clip.

One advantage to working with nested sequences is that you can apply an effect to a nested sequence
instead of having to do that with whatever number of clips made up that original sequence. I go over nested
sequences in depth in Module 20, “Adobe Premiere Pro Editing Tips, Tricks and Techniques.”

You can tell this clip is a nested sequence because its clip color is different than other clips. The default color
for sequence clips is light blue/green, but you can change that by selecting Edit > Preferences then Label
Colors and Label Defaults. And, as shown in Figure 17.24, if you select the clip with the Info palette open, it
notes that it’s a Sequence.

8. Play the Saleen_logo_Layers sequence and note that it’s simply two graphics that fly in from opposite
sides of the screen.
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Note: Layered Graphics with Alpha Channels

Two things to note: First, this sequence is an example of composited or layered clips. The clip on Video Track
B (renamed by the Saleen video editor by right-clicking on the track header, selecting Rename and typing in
a new name) plays on top of the clip on the track below it.

Second, the reason the clip on top (the word “Saleen”) does not cover the clip below is because the “Saleen”
clip is a Adobe Photoshop® graphic created with a transparent alpha channel. In other words, only the word
“Saleen” is opaque. The rest of the graphic is clear, like putting a decal on a window.

Because the default background color for an Adobe Premiere Pro sequence is black, that’s the color that
shows through the alpha channel transparency along with the red Saleen logo on the lower video track. It,
too, is a Photoshop PSD graphic with a transparent alpha channel.

9. Turn off the Video track 2 (the upper track) display by clicking its eyeball to the left of the track name.

10. Select the red logo clip by clicking it (it’s on the lower video track).

11. Switch on Motion by clicking on it in the ECW. Note that the motion line appears in the Monitor window
Program screen. Expand the size of the logo by increasing the Scale to about 500%. Change its location
to make it fit on screen. Use Figure 17.25 as a reference.

Figure 17.25: Adjust the logo clip’s Motion Scale and Position parameters to expand the graphic and center it on
screen (I selected a 25% screen Zoom level so you could see the dotted line, diagonal motion path).
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12. Apply Bevel Alpha to this graphic by dragging it to the
ECW. Increase the Edge Thickness and Light Intensity
settings and note how the graphic changes. As shown in
Figure 17.26, because the areas between the parallel red
bars are also transparent, Bevel Alpha gives each of those
bars a beveled look.

13. To return this project to its original state, open the History
palette (select Window > History), scroll to the top entry (it
should be New/Open), and click on it.

Figure 17.26: Bevel Alpha gives a 3D look to each parallel bar in this
graphic.

Tip: Test Drive the Clip Effect

I mentioned in the “Technical Fix Effects” section that I’d show you one use for the Clip Effect. Select the
Saleen_Car_07 clip (second to last in the Saleen_Sample sequence) and apply Clip to it. As shown in the
Figure 17.27 before-and-after images, that clip has a distracting element on the left side. Use the Clip effect
to cover that with black (this works well because the original video has a black background).

Figure 17.27: Use Clip to remove unwanted junk from the edges of your video.

Duplicate Distort Effects

Feel free to place the following three effects in your Other folder: Horizontal Flip, Vertical Flip (Camera View is
better), and Roll. Note that Roll is not a duplicate. It simply has a very limited value. It "rolls" one edge of the
screen around to the other side. Since you can’t set keyframes or vary the amount of roll, there are few uses for
this effect.
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Color and Appearance Effects

In Module 11, "Working with Video Effects," I demonstrated several color appearance effects, including Black &
White  and Replicate. Some make your video look like a painting. Others shift pixels or delay their display
creating embossed or ghosting effects.

I've created subcategories to clarify differences within the Color and Appearance category. I briefly explain most
effects and go into detail on a handful.

Color and Appearance—Painting Effects

Eight video effects fit into this category: Crystallize, Facet, Median, Mosaic, Pointillize, Posterize, Solarize, and Tint
(I suggest including the Black & White effect here as well for convenience). All are very easy to apply. You can use
keyframes for all but Facet. I covered three of them in Module 11. I'll go over Median, Mosaic, and Tint here.

Median

The Median effect replaces pixels with the median value of neighboring pixels. A radius of one or two pixels
reduces noise (see the discussion of technical fixes), but at about five pixels a video gets a nice soft-focus
painting feel to it.

Try out Median by applying it to a clip. Note that the Radius slider, shown in Figure 17.28, goes only to 10 but
you can type in higher values up to 255. The higher the number, the softer the focus (my example uses 15).
Because you can use keyframes, you can change this effect over time.

Figure 17.28: The Median effect's Radius slider creates a soft-focus painting look.
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Mosaic

Mosaic  cuts your clip into rectangles. As Figure 17.29 shows, you select the number of horizontal blocks and
vertical blocks (rows and columns)—from 1 to 200—to create a collection of rectangles. The higher the number,
the smaller the rectangles and the closer the image will match the original. At 200, it's simply jittery.

The Sharp Colors check box creates more distinct, clearly defined rectangles.

Tip: Mosaic—More Than Only an Effect

Use Mosaic as something like a transition. Using keyframes or simply the default start-point and end-point,
start the "transition" near the end of the clip by setting both Horizontal and Vertical Blocks to 200. Then drop
this setting to about 20 each at the end of the clip. Start the next clip at 20 and quickly build it to 200.
Uncheck the Sharp Colors box; otherwise, the transition from 200 x200 blocks to standard video will be
somewhat abrupt.

Figure 17.29: You can use Mosaic to create a faux transition.
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Tint

Tint enables you to give a clip an overall color. Use it to set moods—a blue cast—or an era—a sepia tone. You
select colors, either from within the original clip or using the Color Picker, and assign them to the image’s black
and white zones.

Color and Appearance—Color-Manipulation Effects

Channel Mixer—This effect, shown in Figure 17.30 enables you to modify each color channel. You can map one
color onto another and increase or decrease a color's values to create high-quality tinted images.

Figure 17.30: The Channel Mixer gives you precise control over your clip's colors.

The default value is 100% of each color. Dragging the sliders or inputting specific values will lead to sometimes
dramatic results. Negative numbers invert the color.

Using keyframes with distinctly different values leads to some unique, gradual color changes as your clip plays.
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Color Pass—You've seen those advertisements where one color stands out. Using Color Pass is one way to do it.
Color Pass converts a clip to grayscale, with the exception of one user-selected color. As shown in Figure 17.35,
select that color by moving the cursor into the image on the left and clicking on a color from that frame. Or
select a color from the color picker. The Similarity slider expands or contracts that color value on the spectrum.
Use the right screen to find the "sweet spot." Clicking Reverse "grays out" that selected color and retains all
others.

Tip: Tricky Tasks

Color Pass is a super-slick effect that requires some careful pre-production preparation. To do it right, you
need to create a setting where the object you want to highlight is a distinctly different color and is evenly lit.
Painting your object a color such as lime green will make it much easier to isolate with Color Pass later. Once
it's converted, you can apply Color Replace to the same clip to alter that horrible lime green color into
something more palatable.

Figure 17.31: The Color Pass Settings dialog box's Eyedropper tool makes it possible for you to select a color to
highlight.

Color Replace—This effect works more or less the same as Color Pass except that in this case it enables you to
select a color and then replace it with another.

Extract—This effect converts a clip to grayscale and enables you to manipulate its appearance—from soft to
harsh.
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Color and Appearance—Color Shift Effects

Slightly altering or shifting some color characteristics can create dramatic visual effects. The following six video
effects fall into this catchall subcategory:

Alpha Glow—This effect provides a very slick way to give a graphic (with an Alpha channel) a glowing fringe or
shadow by adding color around its edges. To see it in action, apply Alpha Glow to either or both graphics in the
Saleen_logo_Layers sequence (refer to Figure 17.32). You can apply keyframes to have the glow grow, then fade
away.

Figure 17.32: Alpha Glow adds a fringe around a graphic. Use keyframes to animate it.

Color Emboss—This is the one Color and Appearance effect that does not appeal to me all that much. It's
supposed to give elements within a clip a full-color embossed look, but it just seems to scramble colors
haphazardly.

Emboss—This effect does in fact create embossed images. It offers more readily accessible controls than the
Emboss element within the Convolution Kernel effect. As Figure 17.33 demonstrates, the "Blend With" slider
makes it possible for you to add color to your image while making very distinct embossed edges. In that way,
you can use it to create both black-and-white and color embossed effects.
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Figure 17.33: The Emboss effect creates very distinct embossed effects—in black and white or color.

Find Edges

Find Edges—This effect locates elements in the image with obvious differences in contrast and color; then, as
illustrated in Figure 17.34, it creates distinct dark edges on a white background. The slider enables you to
combine a percentage of the original image with the converted image. Invert swaps black and white, creating
white lines for edges.
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Figure 17.34: Find Edges creates what appear to be coloring-book-style sketched outlines.

Tip: A Wild Combo: Find Edges and Color Replace

Here's one totally bizarre application of the Find Edges effect. Use it on any clip, add the Color Replace
effect, and select any of the many black borders created by Find Edges. Replace that color with something
distinct—bright red, for instance. Then click the Solid Colors check box to replace the black lines with the
new color. Looks like you just strung everything with Christmas lights.

Ghosting—This is a nifty effect where pre-production planning can be a big help. It creates ghost-like "comet
trails" behind anything that moves. It works great if you hold the camera really steady while something moves
through the scene.

Invert—This multifunction color shifter lets you substitute inverse RGB (Red, Green, Blue) color information, HLS
(Hue, Lightness, Saturation), and YIQ (NTSC luminance and chrominance values). It works much more easily than
the Levels effect version. The Effect Controls window’s options are deceptively simple. Use the drop-down menu,
shown in Figure 17.35, to adjust those elements by their group type or individually.
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Figure 17.35: Invert packs a powerful color shifting punch in only a few controls.

My Favorite Color and Appearance Special Effects

My guess is that you will come to use each of the following three video effects, which create their own unique
and nifty visual impression:

Lens Flare—Most of the time you shoot your scenes trying to avoid lens flare—that sudden appearance of
glowing balls and halos, falling along a straight line. This effect, shown in Figure 17.36, enables you to add those
glowing orbs to a scene. It works well for slow camera moves. If you use keyframes, you can add the effect
gradually and adjust its location and brightness over time as your camera moves by the sun or other light source.

Note: Crosshair in Dialog Box, Not in ECW

Apply Lens Flare to a clip (I suggest Saleen_Car_08 in the Saleen_Sample sequence). Open its Settings dialog
box and note it has crosshairs to place the flare. But if you want to add keyframes (true for all but static
shots), you need to use the ECW. However, the crosshair feature is not available in the ECW, so you’ll need to
use the Center X and Center Y parameters.
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Figure 17.36: The Lens Flare effect coupled with keyframes enables you to insert a flare, change its brightness, and
alter its location.

Replicate—You might have tried this effect in Module 11. Use Replicate to display your clip in multiple, evenly
distributed screen. The minimum setting is four rectangles—two by two. Maximum is 16 by 16. Each mini-screen
displays the entire original clip.

Color and Lighting Effects – New to Premiere Pro 1.5

Adobe added four very nifty Photoshop effects to Premiere Pro 1.5: Auto Color, Auto Contrast, Auto Levels and
Shadow/Highlight. All are in the Adjust folder.

Use Auto Color, Auto Contrast, and Auto Levels to make quick global adjustments to a clip. Auto Color adjusts
the contrast and color of a clip by neutralizing the midtones and clipping – or limiting -- the upper and lower
values of the white and black pixels. Auto Contrast adjusts the overall contrast and mixture of colors, without
introducing or removing color casts. Auto Levels automatically corrects the highlights and shadows. Because
Auto Levels adjusts each color channel individually, it may remove or introduce color casts. Figure 17.37 gives
one example of how these effects work.
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Figure 17.37: Three new Photoshop Auto Image Enhancing effects simplify setting accurate colors, contrast and
correcting highlights and shadows.

Use the Shadow/Highlight effect to brighten shadowed subjects in an image or to reduce the highlights in an
image. This effect does not apply a global darkening or lightening of an image, but rather adjusts the shadows
and highlights independently, based on the surrounding pixels. You can also adjust the overall contrast of an
image.

The default settings are optimized to fix images with backlighting problems. In Figure 17.38 I switched off the
auto setting and adjusted the Highlight Radius and Color Correction to bring out details in the shadows while
toning down that large hotspot in the center of the clip.
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Figure 17.38: Shadow/Highlight brings out details in shadows while keeping highlights from overpowering an
image.

Introducing the Color Corrector

The addition of a Color Corrector video effect to Adobe Premiere Pro is a big deal. It is much more than a single,
narrow-purpose technical fix effect. Rather, it is a full-featured suite of tools that go well beyond simply repairing
color balance, for example. I view it more as an artist’s palette that you can use to create different moods. It’s
such a major improvement to Adobe Premiere that it has its own pre-set workspace.

Instead of cramming more into this already fully loaded module, I’m going to present the Color Corrector in
Module 21, “Tips, Tricks, and Techniques: Part 2.”

Color and Appearance Effect—Limited Use

Color Offset fails to perform as designed. Its purpose is to create 3D images to use with red/blue 3D goggles, but
I don't think it provides a practical means to accomplish that. Feel free to put it in your Other folder.

Adobe After Effects: Astounding Visual Effects

Some of Adobe Premiere Pro's best video effects come straight from another member of the Adobe Video
Collection—the high-end, motion graphic tool: After Effects (I give you an overview of that product’s
functionality in Modules 24 and 25). You encountered some After Effects video effects earlier this module,
including: Mosaic, Find Edges, Basic 3D, and Noise.
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Three others—Blend, Drop Shadow and Texturize—work only with clips on more than one track, so I cover them
in Module 19, “Compositing Part 2: “Alpha Channels and Mattes”. And Transform is virtually identical to Adobe
Premiere Pro’s Motion video effect, so I won’t cover it at all.

What’s left then are three exciting After Effects effects: Echo, Strobe Light, and Lightning.

Adding Multiple Action Images Using Echo

Echo is an exciting effect with numerous possibilities. It layers multiple sequential frames of a clip to convert
simple action into streaking, smearing, or a sequence. As Figure 17.41 demonstrates, you control Echo using five
parameters:

Echo Time—The time, in seconds, between echoes. Negative values create echoes from later frames, causing
ghosting or streaking to follow the action. Positive values use earlier frames, laying those echoed images ahead
of the action.

Number of Echoes—The number of extra frames added to the original to make this effect. Two echoes create
three images—the original plus two other (subsequent or preceding) frames. The slider values go from 1 to 10,
but you can type in a number up to 3,000! From what I've seen, any value greater than 10 creates only 10 echoes.

Starting Intensity—The relative brightness of the first frame in the sequence. At the highest value (1), the first
frame is at normal intensity. A setting of one-half (0.5) displays the first frame at half its regular intensity.

Decay—Notes the decrease in intensity for each subsequent frame. A Decay setting of 0.5 means the first echo
will be half as bright as the original frame, the second will be one-quarter (0.25) as bright, and the third will be
one-eighth (0.125) as bright.

Tip: Smooth Out Jerky Streaks

To create smooth streaking and trail effects, use a large number of echoes (eight or more) and a short echo
time (one-tenth or so).

Echo Operator—Indicates how Echo combines frames. Here are the options:

• The Add option combines the echoes by adding their pixel values. If the Starting Intensity setting is too
high, your action will turn into bright, white streaks.

Tip: Avoid Intense Echoes

To give the first frame and all echoes the same value while avoiding those bright white streaks, set Echo
Operator to Add, set Starting Intensity to a value equal to 1 divided by the number of echoes, and set Decay
to 1. For example, for four echoes, set Starting Intensity to .25 (1 / 4 = .25). A Decay setting of 1 means there
will be no decay—all echoes will have the same value.

• Maximum uses the maximum pixel value from all the echoes, which emphasizes the brighter action
elements.
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• Minimum uses the minimum pixel value from all the echoes, displaying only the darker values.

• Screen is like Add but does not overload as easily.

• The two Composite options are for video clips with alpha channels (this will not work on graphics or most
video clips). The Composite in Back option layers them back to front, whereas the Composite in Front
option layers them front to back.

Figure 17.39: Echo converts motion into streaks, smears, and repeated actions.

Note: Echo Trumps Previously Applied Effects

Echo is a special video effect. By default, it switches off any other effects applied before it to the clip (those
that appear above it in the ECW). Those that come below it on the Effect Controls window still work.
However, there is a workaround: Create a nested sequence. Apply all the effects you want to apply before
Echo to a clip in a separate sequence, and then use that sequence as a clip in another sequence (making it a
nested sequence) and apply Echo to that.

Giving Your Project Flash with the Strobe Light Effect

This effect opens the door to numerous creative possibilities. It works like a strobe light, flashing frames as your
clip plays. Those frames can look like a super-bright strobe light or be black, transparent, or an inverse image.
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The options, as illustrated in Figure 17.40, are listed here:

Strobe Color—This strobe effect can be any flashing color you want. Because color is keyframable, you can
change that color over time.

Blend with Original—This option blends the Strobe Light effect with the original to adjust the intensity or
brightness of the effect.

Strobe Duration—Sets the length, in seconds, for each strobe flash. Less than a half second is most like a real
strobe, but you might want a strobe to stay on longer to show the inverse image or another image below this
clip in the timeline.

Strobe Period—Sets the time, in seconds, between the start of subsequent strobes. Setting a strobe period of 2
seconds, for example, and a strobe duration of 0.5 seconds means that you would see the strobe effect for a half
second. Then there would be a 1.5-second break until the next strobe effect. If the strobe period is less than or
equal to the strobe duration, the strobe stays on all the time.

Random Strobe Probability—Set at a value other than zero means the effect will have a more realistic feel. It'll
cause strobing even if the strobe period is less than or equal to the strobe duration.

Strobe drop-down menu —This menu has two options: Operates on Color Only and Makes Layer Transparent.
A clearer way to state these options is Opaque and Transparent. If you choose Makes Layer Transparent, you can
superimpose the strobe effect clip over another, revealing the lower clip during strobes. I'll cover transparency
issues in Module 19, "Compositing Part 2: Alpha Channels and Mattes."

Strobe Operator—Gives you extra control if you choose Operates on Color Only (opaque). Copy is the default
setting. Subtract displays a black strobe screen, and Difference pops on an inverse image. There are 10 other
options.
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Figure 17.40: The Strobe Light effect opens up numerous creative possibilities.

Tip: Strobe Humor

For a little comic relief, use the Strobe Light effect with Strobe Operator set to Difference and Duration and
Period set fairly low. The resulting strobe effect is reminiscent of a cartoon character sticking his finger in a
light socket.

Adding Dazzle to Your Project with the Lightning Effect

Lightning is a wild and wacky effect. It produces a flashing electric arc like those used in old horror movies.

As you'll see when you drag it to the Effect Controls window, its creators went overboard in the number of
options—25 parameters! To avoid being equally guilty of overkill, I won't go over all of them.

As I've demonstrated in Figure 17.41, you use its two crosshairs to set start and end locations for the lightning.
Setting keyframes enables you to alter those locations over the duration of your clip. In my case, I set two extra
keyframes to have the lightning follow the car headlights.

The many options make it possible for you to set the size and intensity of the lightning. Increasing the number of
segments, amount of branching, and level of detail make the flashes more jagged (kind of nastier looking).
Choose any colors you like—both the core and outside colors. The default white/blue scheme works well, but
red/yellow provides an evil, organic touch.
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Figure 17.41: Experimenting with Lightning is great fun. Try a red/orange color scheme.
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I introduced you to Adobe Premiere Pro's 90-plus video effects in Module 11. In this module, I presented the full
spectrum of effects, from the mundane (but useful) technical fix variety to the exciting, high-end After Effects
effects.

Adobe Premiere Pro’s wide variety of video guarantees you will have plenty of creative latitude as you build your
video projects. You will use them to change the appearance of your video clips or to repair poorly lit or color
balanced footage.

Organizing the video effects into new, more descriptive file folders or bins goes a long way toward easing access.
Removing redundant or underperforming effects further simplifies your video production process.

Q. I added an effect to a clip and used keyframes to change its behavior during the clip, but I don't like the
result. How can I change this?

A. Use the Keyframe Navigator—the diamond with the two triangles on the right side of each effect
parameter—to move to the frame(s) you want to fix. Change the parameter setting. If you simply want to move a
keyframe to a different time in the sequence, grab it and slide it to a new position. If you want to make the move
frame-specific, put the edit line at your new location and create a new keyframe there by changing the
parameter value in the ECW. Then delete the errant frame by selecting it and clicking the Keyframe Navigator
diamond (or right-click on the keyframe and select Cut).

Q. I use Echo, but the clip becomes so bright it washes everything out. What's up?

A. You've probably selected the Add or Screen option, which means that the brightness level of each echo adds
itself to the original clip and its other echoes. If the Starting Intensity setting is high—near or at 1—then it takes
only about two or three clips to obliterate your image. To keep the overall image intensity more or less equal to
the original image, set the Starting Intensity to 1 divided by the number of echoes. For instance, if you use five
echoes, set the Starting Intensity to 0.2 (1/5 = 0.2).

Q. I get that same kind of washed-out look when using Basic 3D to add a specular highlight to my clip.
How do I avoid that?

A. Use the wireframe preview and the 3D move to keep the highlight (the green crosshair) near the edge of your
clip. If it moves toward the center, the effect is like a mirror directly reflecting the sun.

Quiz

1. You shot an interview indoors but near a window. The interviewee's face is blue! How do you fix this?

2. You "broke the plane" in a cutaway. How can you get your interviewer to face the right direction?
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3. How do you create an "Electric Horseman"? If you missed this enjoyable Robert Redford/Jane Fonda flick,
Redford rides out on a Las Vegas stage decked out with electric lights to promote breakfast cereal.

4. You can use the Mosaic effect to create a "transition." How do you do that?
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Quiz Answers

1. Use the Color Balance (RGB) effect, or if you're up to the extra level of detail involved, try adjusting individual
Red, Green, and Blue channels in the Levels effect.

2. Use Camera View to flip the image on its vertical axis (Vertical Flip does this as well). That way, your
interviewer will face the correct direction, no longer breaking the plane (of course, her mother might notice
her face is a mirror image of the real thing).

3. Use Find Edges on a clip to create distinct outlines. Use Color Replace to swap a bright color for the black
outline. Check the Solid Colors box to make the entire outline take on the new hue.

4. Use the Mosaic effect to give the illusion of a transition. This is not a true transition. It's simply a straight cut
edit between two adjacent clips that appears to be a transition. Apply the Mosaic effect to both clips and
use keyframes to have the effect start just a second or so before the end of the first clip and operate for a
second or so at the beginning of the next clip. For the first clip, set the starting number of horizontal and
vertical blocks to 200 and the end to something like 10; then reverse that process for the second clip.

Exercises

1. Use Lens Flare to create a moving glow that "reacts" to a light source. A panning shot, a tilt, or a light source
moving through the image (a race car’s headlights for example) all work well. Simply use keyframes in
several locations to attempt to equal the light source’s movement. It doesn’t have to be exact because the
lens flare does not have to rest directly on the light source.

2. Use keyframes to create a radial blur that gradually moves around an image.

3. Use Color Pass and Color Replace to isolate an object and give it a new color.

4. Experiment with the Lightning effect using the Saleen_Car_10 clip I used in Figure 17.43. The goal is to have
two sets of lightning emanating from the same source above the screen and splitting so that one each hits
the car’s headlights. To do that, you’ll need to apply the effect twice (just drag it to the ECW two times),
switch on keyframes for the Start- and End-points, and set a few other keyframes for both moving End-
points. For extra credit, change the attributes of the lightning over the duration of the clip. Increase the
intensity by changing values for segments, branching, and amplitude. Also, change the color of the
lightning during the clip.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education
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Module 18

Compositing Part 1: Layering Images and Clips

One great strength of Adobe® Premiere® Pro is its ability to layer (or composite) multiple clips over one another.
Compositing can be as simple as placing a logo over a product shot or as complex as shooting actors in front of a
green screen and then electronically placing them within a scene with both foreground and background
elements.

Adobe Premiere Pro makes it possible for you to layer up to 99 video tracks. I can’t imagine any project that
would require so many layers, but I think you get the drift that permitting that level of complexity in Adobe
Premiere Pro demonstrates that compositing can be a big part of any video production.

There are four basic compositing methods:

• Using the Opacity video effect to reduce the opacity of an entire clip so that a clip (or clips) below it on
the timeline can show through.

• Using Keying effects to make portions of a clip transparent so that portions of clips below it on the
sequence show through.

• Blocking or matting parts of one clip to let parts of other clips show through.

• Using a clip's alpha channel or using video effects with built-in alpha channels to create transparencies.

This module covers the first two topics. I save the latter two for the next module, "Compositing Part 2: Alpha
Channels and Mattes."

I start simple with some standard TV news-style cutaways—video clips placed on a track above an interview, for
example—with the express purpose of covering whatever is below it. When you apply those, you need to be
aware of the rules Adobe Premiere Pro follows when handling the audio portions of those cutaways.

Some editors would argue that such cutaways aren’t compositing because nothing on the first layer shows
through. But because some cutaways use more than one video track, I consider it compositing, and it’s a good
introduction to more complex layering to come.

That introduction begins when your students take clips they’ve shot for this module and make them partially
transparent to let portions of the clips on lower tracks show through.

At the end of this lesson, students will have learned about:

• Making compositing part of your projects

• News-style cutaways and multi-track audio rules

• Your assignment: grab shots for compositing

• Working with the Opacity effect

• Keying clips
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Making Compositing Part of Your Projects

If you've tried out Adobe Premiere Pro's Title Designer, used the Motion effect, or worked on video effects that
use alpha channels, you already have moved toward compositing—that is, layering graphics or video clips over
other clips.

For instance, anything you create in the Title Designer can display over another clip, layering text onto that clip
while letting the rest of it show through. When you apply the Motion effect to a clip, you usually play it over
another clip or a graphic background. And when you work with some video effects that have alpha channels,
such as Lens Distortion, you can use them to combine two clips with portions of one clip showing around the
edges of the distorted clip.

Compositing can add immeasurably to your video projects.
Sometimes the impact is obvious—sliding videos in boxes onto the
screen sends a clear message that you have done something out of
the ordinary with your production. Other times, the effect is more
subtle. We don't think twice when we see a TV weatherperson
gesturing at a map or graphics. As shown in Figure 18.1, in fact that
TV personality is standing in front of a green or blue wall. The
program’s technical director electronically makes that wall
transparent and inserts videos, maps and other graphics in its
place. The meteorologist watches studio monitors to see what he
or she is pointing at.

FIGURE 18.1: Matt Zaffino, Chief Meteorologist—KGW-TV, Portland, Oregon.

Most computer games with live actors and many movies use compositing. "Green screen" studios enable game
developers and film directors to place actors in science fiction and other settings created with 3D computer
graphics. Such sets make it possible for actors to work in relative safety while the finished product has them
dangling from a skyscraper, hundreds of feet in the air.

For most budding professional video producers, such high-budget studio access may be out of the question. But
you can add some nice composited special effects to your projects simply with a few tweaks of Adobe Premiere
Pro's tools.

News-style Cutaways and Multi-track Audio Rules

As an introduction to compositing or layering, you’ll start by adding news-style cutaways over the edit point of
two adjacent clips. This is a practical and frequently used technique used by TV news editors to cover an edit
between sound bites and as a way to show viewers that the reporter actually did the interview.

In the coming task, some of the methods place the cutaway on a new track (compositing) whereas others cover
a clip on the Video 1 track (not truly compositing). I’ve lumped both approaches together because they both fall
into the cutaway category.

What works best for the upcoming task are two sound bites from the same person that you want to place back-
to-back. If you don't have two such clips, you can use any two clips (plus a cutaway) just to get a feel for how this
works. For instance, two soccer goals plus a crowd shot cutaway will work well. Make sure all three clips have
video and audio.
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Task: Creating TV News-style Cutaways
There are several ways to add cutaways. I’ll explain three. Here are the steps to follow:

1. Import the linked A/V sound bites (or whatever clips you're using) plus the cutaway to the Project
window.

2. Delete all the clips in a sequence or open a new sequence (File > New > Sequence). Keep your sequence
simple: one video track and one audio track.

3. Drag the two clips to the Video 1 track on the sequence, one right after the other. As shown in Figure
18.2, drag the Timeline window’s top or bottom edge to expand it vertically a bit, creating some space
above and below the video and audio tracks (you need that room later to automatically add video and
audio tracks). Now play the clips. If this is an interview, there probably will be a slight image shift—a
jump-cut—between clip 1 and clip 2 because the interviewee moved a bit or you moved the camera.

FIGURE 18.2: How your sequence should look before you add a cutaway.

4. Select a short clip from your Project window to use as a cutaway. Drag it to a point just above the Video
1 track (in the gray area where a new track will be automatically created). Line up its end with the edit
point between the two clips. As shown in Figure 18.3, Adobe Premiere Pro displays two icons: a black
line with a triangle indicating you’ve aligned the end of the cutaway with the cut edit between the two
clips and an Insert edit marker indicating that if you release the mouse button your clip will end up in
the sequence at that point.
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FIGURE 18.3 Add a cutaway by dragging it above the edit point you want to cover.

5. Release your mouse and take a look at what just happened. You automatically created two new
tracks—video and audio—and your cutaway is positioned such that it covers the end of the first clip.

6. If you play this section, you’ll hear audio from the cutaway “stepping” on the interview. To remove that
audio, unlink the cutaway’s audio and video (right-click on the clip, select Unlink Audio and Video, and
click somewhere in the sequence to complete the unlink process). Right-click on the audio portion and
select Cut. Now play this edit. You have just created a news-style cutaway.

Tip: Cutaway Locations

You might notice that using this technique means the cutaway ends exactly as the next sound bit begins.
That's a method I like because usually the second sound bite is a new thought and it "feels" more natural to
see the interviewee as he or she starts a new comment. That's not always the case, and you might want to
slide the cutaway over Clip B—covering the end of Clip A and the beginning of Clip B—or even start it right
at the beginning of Clip B.

Tip: Keeping Cutaway Audio

You don’t have to remove the cutaway’s audio. If you are editing a sporting event and use a cutaway shot of
a screaming fan, you’ll want to leave in that sound and adjust its volume to fit the crowd noise in the two
clips you just covered up.

7. The problem with this method is that the cutaway might not be the exact shot or duration that suits
your needs. To resolve that, use the Monitor window Source screen to create a more accurate cutaway.
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First delete the cutaway from the
sequence, and then double-click on a
longer clip to open it in the Source
screen.

8. As shown in Figure 18.4, set an in-point
and an out-point (use the curly
brackets). I’ve set this cutaway to 3
seconds—a comfortable clip length.

9. Click the Toggle Take Audio and Video
button until it becomes a video-only
filmstrip icon, as shown in Figure 18.4.
This means that when you add this
trimmed clip to your production, only
the video portion will end up in the
sequence.

FIGURE 18.4: Use the Monitor window Source
screen to trim your cutaway and then set the Toggle
Take Audio and Video to the video-only filmstrip
icon.

10. Click anywhere in the Source screen and
drag that trimmed clip to the sequence.
As before, you can drag it above the two
clips to the newly created video track.
Or, as shown in Figure 18.5, you can drag
it right onto those two
clips—positioning it where it suits you
(you can always change this edit later on the sequence track). In either case, only the video portion will
end up in your sequence.



Adobe Digital Video Curriculum Guide – Module 18 18-6

Adobe Digital Video CURRICULUM GUIDE

FIGURE 18.5: You can drag a trimmed clip from the Source screen directly to the sequence and easily line it up with
the edit point.

Tip: Use the Source Screen Method to Add Audio

If you want to use this method to add a cutaway with its audio, you simply change the Toggle Take Audio
and Video button to the combo filmstrip/speaker icon and then drag the clip to the sequence. If you drag it
to a separate track, the audio will go to its own separate track. If you drag it on top of a clip, the cutaway
audio will replace that clip’s audio for the duration of the cutaway.

11. Finally, rather than dragging the clip to the sequence, use the Overlay button in the Source window
instead. To do that, first set track targets. They are the track(s) on the sequence where you want the
audio and/or video portions of the clip to go. The easiest way to target a track is to click its name (if you
don’t already have a Video 2 track, add it first by right-clicking on a track name and selecting Add
Tracks). In Figure 18.6, I selected Video 2 and Audio 2 (changing the track headers to a darker beige).
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FIGURE 18.6: Clicking on a track name “targets” it so that when you click the Overlay button in the Source screen, the
video or audio portions go to the tracks you’ve selected.

12. Move the CTI edit line to where you want to place the first frame of the cutaway and click the Overlay
button (to the left of the Toggle Audio and Video button). Don’t use Insert. It defeats the purpose of a
cutaway because an Insert edit cuts (razors) the clip at that point, drops in the cutaway, and shoves
everything to the right.

Tip: Edit Line Placement

Take a look at Figure 18.7. I purposely chose to have this cutaway cover the end of Clip A and the beginning
of Clip B. I did that by moving the edit line a bit to the right (it automatically jumps to the end of the cutaway
after it makes the overlay). If I don’t like the exact placement, I can always slide the clip to the left or right
and/or trim it. That’s one advantage to putting it on a different track than the original clips.
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FIGURE 18.7: Position the CTI edit line to your edit point, then click the Overlay button to drop your cutaway into your
project.

Multi-Track Audio Rules

You’ve already seen a bit of the Adobe Premiere Pro’s rule set when it comes to adding clips to multi-track
projects. For instance, when you dragged a clip above Video 1, Adobe Premiere Pro added new video and audio



Adobe Digital Video Curriculum Guide – Module 18 18-9

Adobe Digital Video CURRICULUM GUIDE

tracks and dropped the clip’s video and audio segments there. The new, automatically created audio track also
matched the source material: In your case, it was probably stereo.

But it can get much more complicated. There are two basic circumstances: when a user is dragging a clip from
the Project window to a sequence and when the user is dragging clips within a sequence.

Dragging Clips from the Project Window

Adobe Premiere Pro’s developers gave this a lot of thought. They concluded that when a typical user is dragging
clips from the Project window, the user wants to "cascade" his layout (that is, match video track and audio track
numbers). So, in this case only, Adobe Premiere Pro associates Video 1 with Audio 1, Video 2 with Audio 2, and so
forth.

There are exceptions, of course. Adobe Premiere Pro matches audio clips to the "next best" track that fits the
channel type (mono, stereo, 5.1). If you try to drop an A/V clip onto Video 1 and Audio 1, but the audio types
don't match, Adobe Premiere Pro "skips" the audio tracks that are not compatible (as well as locked tracks) and
finds the next best one or automatically creates a new track of the right channel type, if needed.

This also means that if you drag a clip to Video 1 and there is already audio in the same location on Audio 1, the
new clip’s audio goes to Audio 1 and covers up whatever was there.

Dragging Clips Within a Sequence

The rules change when working within a sequence. Again Adobe Premiere Pro’s developers gave this a lot of
thought.

With the advent of track-based effects on the audio side, the developers wanted to give the user the opportunity
to move around the video portion of the A/V clip that is already in the sequence, without changing its audio
track assignment. In this way, you can "bump" the video portion up/down one track, without messing up your
audio mix. The same is true if you want to move the audio portion of the clip to a new track (with different track
effects for example) without moving the video around (because its relative layering is important).

Therefore, if you drag a clip to a new track and slide it off to one side or another, the audio remains on its original
track. If you slide it to a portion of the track that already has audio, it replaces that audio.

Note: Developer’s Comment—Sequence Philosophy

Let me describe what has been our philosophy of the timeline:

In video, the "relative" vertical layering of each clip is important (but not the actual numeric track
assignments).

In audio, the "absolute" track assignment of each clip is important because of track effects, submix track
assignments, and so on, but the relative position of one clip track with respect to another is not important at
all.

The most common reason to move clips on video tracks is to alter the rendering order. However, audio
tracks do not have a similar rendering order concept. Lower audio tracks do not block the audio on higher
tracks.
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Because of that, we are trying to slowly move away from the old paradigm that always matched V1 to A1, V2
to A2, and so forth. It now matters a lot what audio track you are on, so we don't want to make an automatic
decision for you, which, in most cases, is going to mess something up. But we are still trying to be “nice” in
some cases (for example, when dragging from the Project window to a sequence).

Your Assignment: Grab Shots for Compositing

Most of the remaining tasks in this module involve creating transparencies in clips by removing certain colors or
luminance (brightness). To best see how that works in the real world, you need to grab your camcorder and tape
a few quick shots.

Tip: Locking Down Your Camcorder—Critical to Keying

For images that you intend to key, you'd need to normally have your camera absolutely locked down. No
camera movement at all. In this case, because it's just an experiment, don't worry too much about that. But
after you’ve seen how much of a viewer disconnect there is when a keyed object bounces around over a
keyed-in background, you'll understand why a rock-steady camera is critical. Use a tripod.

Here's your assignment:

• Videotape an inanimate object—preferably a smooth object to minimize shadows within it—in front of
a solid color. That color should be distinctly different from the color(s) of the object. Otherwise, when
you later "key out" that background color, similar colors in the object will turn transparent, too, leading
to some odd results.

• Tape a person talking or moving in front of a solid color background. The best is light blue because
that's complementary to skin tones. Seek out a smooth surface, not cloth or anything with obvious
texture or shadows. Just make sure that your subject's clothes don't have colors that match or nearly
match the background, and avoid fly-away hair and fuzzy clothes (they create blurred edges in key
shots). Most production studios use chroma blue (or green) screens. I'll highlight the advantages of each
in a sidebar later.

• Tape a dark object in front of a lightly colored surface (white is best) and a lightly colored object in front
of a dark backdrop. Try this with a person as well. The greater the contrast between the subject and the
background, the easier it'll be to make the background transparent.

• Tape a distinct background with nothing moving in it—that is, no waving palm trees or soaring birds.
Then, without turning off or moving the camera (this is the one exercise when you need a rock-steady
shot), have someone walk into the left side of the scene, stand around for a while, and then walk back
out the left side. Have that person do the same thing entering from the right side and then walking out
to the right. For a bit of comic relief, have your "actor" wave toward the center of the scene before
walking off camera. You'll use this in the next module to create split-screen and difference mattes, but
you might as well shoot it now while you're at it.

• Finally, grab a few shots of background locations in which you'd like to place the objects/people you've
videotaped. You will later key your subjects onto those locations.
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Working with the Opacity Effect

Before keying out colors or working with luminance, I want to cover opacity.

Adobe Premiere Pro and other nonlinear editors like it have a general operating practice. Video tracks above
Video 1 trump tracks below them on the timeline. In other words, whatever appears on the highest track covers
up whatever is below it. However, the object isn't to use tracks above Video 1 to obliterate what's beneath them.
It's to enhance what's down there.

Adobe Premiere Pro offers up to 98 of those "superimposing" tracks (with Video 1, 99 tracks in all). Their purpose
is for layering (compositing).

One easy way to see compositing at work is to place a video or graphic on a superimposing track and make it
transparent—turn down its opacity to let video(s) on lower track(s) show through.

A tool to accomplish this is the Opacity effect.

Task: Use the Opacity Video Effect
Here's one way to see the Opacity effect in action. For this exercise, I'll have you place a "super" (text) in a
superimposing track above a clip. Then you'll use the Opacity effect to fade that text in (its background is
automatically transparent), display it over your clip for a while, and then fade the text out.

Here are the steps to follow for this task:

1. Place a video clip on Video 1. Any clip will do, but trim it to about 15 seconds to simplify things.

2. Open the Title Designer (File > New > Title) and create some simple text. Make it large and add color if
you like. In my example (see Figure 18.8), I gave the text an outer stroke and a drop shadow to make it
more visible over the background.

3. Save your text (File > Save). It'll show up automatically in the Project window.

4. As shown in Figure 18.8, drag the text to Video 2, drag its right edge to make it as long as the Video 1
clip, and expand the Video 2 track by clicking the triangle next to the words Video 2.

5. Click the Show Keyframes button (highlighted in Figure 18.8) and select Show Opacity Handles. That
displays the Opacity line (I thickened it for emphasis in Figure 18.8), which for the moment is straight
and at the top of the clip display (100% opacity).

6. Select the text clip by clicking on it, and open the Effect Controls window (ECW). Click the Opacity
effect’s two disclosure triangles to reveal the keyframable Opacity slider. Note that the keyframe
stopwatch is turned on by default. Now set four keyframes:
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FIGURE 18.8 Using text is a good introduction to the Opacity video effect. With Show Opacity Handles selected in the
sequence, you will be able to see any changes you make to opacity show up in the expanded track view.
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• Set the beginning of the clip (press the Home key) Opacity slider to 0%.

• Move the CTI to about 2 seconds into the clip, and set Opacity to 100%.

• Move to a couple seconds from the end, and set Opacity to 100% (click the keyframe
diamond to set that keyframe).

• Move to the end of the clip (press End and the left arrow key once), and set the opacity
slider back to 0%.

7. Your ECW should look like Figure 18.9. Note that Opacity handles have now shown up in the expanded
view of the clip in the sequence (I’ve expanded them for emphasis in Figure 18.9).

8. Play your clip. The title should fade up, hold for a while, and then fade down. That's compositing in its
simplest form.

FIGURE 18.9: Using the fixed Opacity video effect with keyframes enables you to fade in a super, hold it onscreen for a
while, and then fade it out.
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Superimpose Two Clips

Try a similar process with two video clips, but choose your clips with some care. If you select just any two clips,
blending the two together can look way too busy.

The purpose is to let the clip on the lower track show through the higher clip in a pleasing fashion. Try to use a
clip on the higher track with a distinct bright or well-lit area. The reason: When you reduce its opacity, that bright
area will let clips below it show through more clearly. For my example, shown in Figure 18.10, I used some
flowers with the sky as a backdrop. Here's how this works:

1. Drag the clip you want to show through to Video 1 and the clip with the bright section to Video 2.

2. Follow the same four-step Opacity keyframe process you used in the previous task on the clip on Video
2.

3. Preview this effect. The lower clip should show through the upper clip, especially in the lighter areas of
the upper clip.

FIGURE 18.10: Two superimposed clips.
Reducing the opacity in the upper clip lets the
lower clip show through, particularly through
light areas such as the sky.
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Keying Clips

The Opacity effect works great with text and some videos and
images, but most of the time when you use it with two full-screen
clips or graphics, it can be an inexact science. You can get more
precise compositing results using Keying effects.

Take a look at Adobe Premiere Pro’s keying effects by opening the
Effects palette, selecting Video Effects and then Keying. As illustrated
in Figure 18.11, that reveals 16 Keying effects (Note: Alpha Adjust,
technically is not a keying filter. It is simply the Opacity effect).

FIGURE 18.11: Adobe Premiere Pro’s 16 Keying effects give you a full
range of possibilities.

I’ve grouped them into four categories:

• Color: RGB, Chroma, Blue Screen, Green Screen, Non-Red

• Luminance: Luma, Multiply, Screen

• Matte: Difference Matte, Garbage Mattes, Image Matte,
Remove Matte, Track Matte

• Alpha: Alpha Channel

In this module, I'll go over the Color and Luminance keys. In Module 19, I'll explain the Matte and Alpha Channel
keys.

Using the RGB Difference Key

First up is the simplest key—the RGB Difference Key. You use it to make a selected color transparent, thereby
making a background transparent.

This key works well when you have a brightly lit scene with no shadows, a solid-color background, and a subject
with a color that's distinctly different from the background. Not many scenes will qualify. Almost all have some
shadows, especially when the subject has texture. But it's a good way to see how keying works
or—frequently—does not work.

Task: Use the RGB Difference Key
To use the RGB Difference key, follow these steps:

1. Place the clip from the first item in the assignment list—the inanimate object shot in front of a solid
color—on Video 2.

2. Drag the location clip, the fifth item in the assignment list, to Video 1.
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3. Select the clip on Video 2, and drag the RGB Difference Key to the ECW. In my example, shown in Figure
18.12, I will key out the sky in the right image (Video 2) to let the left image (Video 1) show through.

FIGURE 18.12: Two clips that I will combine using the RGB Difference Key.

4. Click on the eyedropper tool (I’ve highlighted it in Figure 18.13) and drag it to the clip image in the
Monitor window Program screen. Use it to select the color you want to key out; that is the color you
want to make transparent.

5. Drag the Similarity slider to the right, and watch the Program screen as your background
disappears—becomes transparent—to reveal the clip on Video 1. Similarity expands or reduces the
range of background color keyed out. However, the more you increase Similarity, the more likely you
are to key out colors and create transparencies in both the background and the subject itself. In my
example in Figure 18.13, a similarity of 16 removed the blue sky without removing any colors of my
wooden frog and his hovering lily pad.
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FIGURE 18.13: Use the RGB Difference Key to remove a color from a clip.

Tip: Other RGB Difference Parameters

Smoothing enables you to remove “aliasing" or "jaggies," those stair-step edges common to diagonal lines
in computer monitors and TV sets. Just as you did with transitions, you can turn on anti-aliasing to fix that. It
blends the pixels around the edges of your object. Use the Smoothing drop-down menu, choose Low or
High, and check your results in the Sample screen.

Mask Only turns your keyed clip into a black-and-white image to help you fine-tune the similarity setting.

Drop Shadow adds a thin drop shadow to give your clip a 3D feel. But there are no user adjustable
parameters. It’s either on or off. The shadow always falls down and to the right. Inconsistencies arise when
your background scene has shadows going some other direction. If that's the case, you might consider
using the Camera View video effect on the background to flip the image right-to-left to swap its shadow
directions.

You might find that it’s darned difficult to get the color and similarity just right. Welcome to keying. It can take
some trial and error to find an approach that works.
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Before using other keying types, try the RGB Difference key on the person you taped in front of a solid color.
Doing so might be more challenging than using it on an inanimate object. Because the person you taped
probably moves around a bit, it makes finding
the right "similarity" around the edges of that
person that much more difficult.

Using the Chroma Key

Because RGB Difference works only for very
limited, well-planned shots, you'll likely rely on
other color or transparency keying techniques.

It's very easy to try them out. Chroma-keying is
your best all-around method, but it's not as
accurate as the more narrowly defined
green/blue screens I'll cover later. It has more
options than RGB Difference and therefore
gives you a better chance to create a decent-
looking key.

Delete the RGB Difference key from the ECW
and replace it with the Chroma key. As I've
highlighted in Figure 18.14, in addition to
Similarity, you have sliders for Blend, Threshold,
and Cutoff:

FIGURE 18.14: Chroma-keying offers more
options that increase the likelihood of a
successful key.

Blend—Softens the transition edges between the keyed subject and the clip below it. Gradually slide Blend to
the right and watch as the image on Video 1 begins to replace the few remaining bits of your object's single-
color background. Those snippets of background color typically fall right around the subjects outline.

Threshold—Controls the extent of shadowing thrown by the subject that will show up in the keyed clip. To see
this in action, take a close look at any shadow on the solid background color and see how this looks in the
composited image.

Cutoff—Darkens or lightens shadows. Its value must be less than the Threshold value; otherwise, it'll invert gray
and transparent pixels and your screen will become black.

Tip: Using Threshold and Cutoff Effectively

A good way to use Threshold and Cutoff to your best advantage is to click the check box next to Mask Only,
which displays only the silhouette of your subject and the keyed-out color/background. What you want is a
black background and a white subject. What you'll probably start with is a dark gray background and a light
gray subject. As you slide Threshold to the left, the background darkens. Try to turn it black. Then slide
Cutoff to the right and try to get the subject as white as possible.

Despite your best efforts, even the Chroma key might not make the entire background color transparent without
punching a few transparent holes in your subject.
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Try the Chroma key on the person you taped. As with the RGB Difference key, you probably will find it difficult to
make a clean key, especially in and around the subject's hair.

Using the Luma Key

To test this key, use the images from the third item in the assignment list—the dark object with a light
background and vice versa.

In my case, I’ll combine the two images shown in Figure 18.15. I’ll use the Luma Key to remove the black
background of the image on the right.

FIGURE 18.15: The Luma key works well if you have a highly contrasting subject and background and little texture to
your subject.

Place your high contrast image on Video 2 and apply the Luma Key to it. When you first open Luma, the
Threshold setting is 100%, meaning the widest range of dark values will become transparent. As shown in Figure
18.16, reduce the Threshold value and you tighten that range. Cutoff sets just how transparent those dark areas
will become. Higher values increase transparency.

As my subjects demonstrate in Figure 18.16 and 18.17, if you taped very contrasting scenes, the Luma key
should work smoothly. It's similar to the Image Mask transition covered in the next module. Whatever is dark
gets keyed out (that is, it becomes transparent, letting images below it show through), and light areas remain
opaque, displaying whatever is on the upper clip.
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FIGURE 18.16: The Luma key works well if you have a highly contrasting subject and background and little texture to
your subject.

FIGURE 18.17: Use the Luma key on a dark object like this clock shot against a light background to create this unique
visual combination.
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Tip: Blur the Background—Make It Realistic

To add a realistic feel to any keyed shot, make the
background blurry. Typically, you want to make the
subject, which you've shot with a key in mind, the
focal point of your composited clip. By using a
background that's a bit out of focus, the subject
stands out even more. To create that illusion, simply
use the Fast Blur video effect on the background clip. I
used that effect with the sand dollar clip in Figure
18.18.

FIGURE 18.18: Using the Fast Blur video effect on the
background clip makes the keyed image stand out.

Again, this key takes some planning. When you're
shooting, it's best to illuminate the light object or
background and work to make the dark area as dark as
possible. Objects with fine edge detail such as hair are very hard to key under any circumstances, including when
you use Luma.

Tip: Put Keyed Clips in Motion

You can add motion to clips keyed with Luma and other keying effects. Simply click on the Motion effect to
switch it on or click on the clip in the Monitor window Program screen to select it. Then, as shown in Figure
18.19, move the keyed clip around the screen just as you would any other clip or graphic (including rotating
it).

Previous versions of Adobe Premiere displayed the entire clip as opposed to only the keyed subject. If you
scaled it down a bit, you ended up with a rectangular box moving around the screen. You needed to take
some extra steps to fix that. Now, thankfully, that’s no longer necessary.
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FIGURE 18.19: You easily can move, scale, and rotate a keyed
clip using the Motion effect.

Using the Multiply and Screen Keys

The Multiply and Screen keys are like the Luma key, but they
create more subtle superimpositions. They both examine
the clip below the superimposed clip on the timeline to
determine what areas of the keyed clip to make transparent.
Multiply looks for bright areas, and Screen looks for dark
areas. Then they make portions of the superimposed clip
transparent to match those areas.

Each effect has two sliders: Opacity and Cutoff. Higher
values lead to less transparency.

Using the Blue Screen and Green Screen Keys

The Blue Screen and Green Screen keys are your best bets
for accurate, relatively low-budget keying. To use them well,
you'll not only need what are called chroma blue and chroma
green backdrops, but you'll also need to follow a few procedures as well. Because this is sort of an involved
process, I've included a sidebar on the subject.

The Blue Screen key and Green Screen key options work like other Adobe Premiere Pro keys, only they're simpler
because Adobe Premiere Pro is looking for very specific chroma blue and green background colors.

There are only two principal slider controls: Threshold and Cutoff. Again, drag Threshold to the left to make the
entire blue/green screen transparent. Drag Cutoff to the right to ensure that the opaque areas look satisfactory. I
asked Matt Zaffino, my favorite weatherman, to demonstrate in Figure 18.20 how things look before and after
applying keying effects.

FIGURE 18.20: KGW-
TV's Matt Zaffino in front
of a Chromakey green
screen (left) and with the
Green Screen Key (right)
turned on to display a
weather graphic.
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Tip: Extra Keying Help Using a Nested Sequence

If at first your key does not succeed, try again. Sometimes try as you might, you cannot remove all the
jaggies from the edges of your green- or blue-screened actors. This is endemic to consumer/prosumer DV
(technically, DV25) camcorders. To possibly remedy that, key them twice.

However, that won't work for the original clip on the timeline. Going back to Transparency Settings and
tweaking the existing blue/green screen settings only changes them—it doesn't apply the settings twice.

To do that requires creating a nested sequence. I'll explain that concept in Module 20, "Tips, Tricks, and
Techniques: Part 1."

Sidebar: Making Blue and Green Screens Work

Setting up chroma green or blue backdrops can be a royal pain—especially on location. About 10 years ago,
I hired one of Portland's top production companies to do a fairly involved blue screen shoot at a local
college. They lit the heck out of that blue screen, got the dolly rails and the trucking move down perfectly,
and rolled and recorded.

When we got back to the studio, try as we might, we could not completely key out the blue screen without
creating some transparency in the actor. We ended up building an elaborate moving matte (it had to fit the
actor's shifting silhouette). What a time-consuming hassle!

As someone once said, "It's not easy being green" (or blue). Here are some tips:

• Blue and green screens require "flat" lighting—no hot spots. If you can set up your screen outdoors,
overcast or cloudy days work best. No need to overdo the lighting. Simply make it even.

• The actor's lighting does not have to be flat. Controlled spot lights or lights with "barn doors" work well.
Using soft lighting with umbrellas and reflectors is less dramatic but also is effective. A key backlight
aimed at the actor's head helps more clearly illuminate hair to eliminate or at least minimize blue or
green screen "halos."

• If you plan to key in an outdoor background, try to re-create outdoor lighting on your subject. If you're
working with live actors, further enhance the illusion by using a fan to blow their hair around a bit.

• Avoid the dreaded blue or green spill. Actors' skin will pick up the reflected color of the backdrop if
they're too close to it. Move them at least a few feet away. One other way to minimize this is to use a
backlight.

• Tight shots work better than full-body shots. The closer you are to your subject, the more realistic the
finished product will be.

• If there is fast-paced action in your shot, you might have trouble keying right to the edges of your
subjects.

• Set your camcorder to Manual and open the iris  (you'll probably need to increase shutter speed to
avoid overexposure). A wide-open iris—1.8 or so—limits the focal plane to your subject and throws the
green screen a bit out of focus, making it easier to key out.

• To build a backdrop on a budget, consider using unofficial chroma blue or green paint (the real stuff
retails for about $40 a gallon). Grab a paint sample collection, videotape it, and then use Adobe
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Premiere Pro's blue screen or green screen transparency on it. Find a color that keys well and buy a
gallon. Paint that on a large piece of plywood, and you have a portable studio.

Alternatively, you can buy Chroma key fabric or wide rolls of Chroma key paper. Both run about $10 a square
yard. One source is     www.Filmtools.com    .

• Which color to use? With chroma green, you have reasonable assurance that no one will have clothing
that matches and therefore will key out. Chroma blue works well because it's complementary to skin
tones. The kind of scene you key in might be the determining factor. If you will have your actors keyed
in to a scene with a blue sky, use a blue screen. In this case, the dreaded blue spill could be a nice
feature.

• Consumer and prosumer camcorders do not key as well as professional camcorders. The 4:1:1 color
sampling compression leads to some quality loss. Because the green portion of an RGB signal receives
extra weight to correspond to the sensitivity of human eyes to different colors, green screens key more
cleanly than blue when using consumer DV – or DV 25 -- camcorders. A mathematical analysis done a
few years ago showed that using a green screen with a DV camcorder keys only 15% less cleanly than a
broadcast-quality Betacam SP camcorder.

Using the Non-Red Key

The Non-Red key is your blue/green screen fallback. Both Blue and Green Screen keys look for very specific
colors. They offer no "similarity" controls to select a color range. If you just can't quite dial in a Blue/Green Screen
key because somehow the color is slightly off or there is too much fringing around the edges of nontransparent
subjects, try the Non-Red key. It's a little more forgiving. As you move the Threshold slider, this key looks for non-
red colors (blue/green) to key out.

As I've demonstrated in two before-and-after images with Matt Zaffino (Figures 18.21), the Non-Red key offers
one other control: Blend. This ostensibly lets you smoothly blend two scenes together. I've found that it doesn't
make much difference if you already have a reasonably good blue/green screen shot.

FIGURE 18.21: Sometimes, as in the left image, the Chroma or Green/Blue Screen keys fail to fulfill their promise. The
Non-Red key (right) tends to clear up the "jaggies" along the edges of your opaque subjects.
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Compositing tools enable you to greatly enhance your projects by adding multiple layers of video and images.
First stabs at compositing typically involve adding cutaways to interviews and other video work.

Then you move on to creating transparencies. The principle transparency compositing tools are the Opacity and
Keying video effects. The Opacity effect is always available in the ECW and has only one keyframable parameter:
Opacity percentage.

The Keying effects come in four flavors: Color, Luminance, Matte, and Alpha. I covered the first two in this
module, and will go over Mattes and Alpha channels in the next module.

Making keys work well takes some extra effort. Proper backdrop colors, lighting, and keying techniques all come
into play. Green/blue screens work best but invariably take some trial and error.

Q. No matter how many different key types I try, I get a "halo" effect along the edges of my keyed objects,
especially in their hair. What should I do?

A. This is endemic to this technology. Using consumer and prosumer DV camcorders and Adobe Premiere Pro's
less-than-pixel-specific keying controls means you might never get rid of those halos. Some video capture cards,
such as the Canopus DVStorm2, and software such as Adobe After Effects® 6.0 Professional, have much higher-
quality Chroma key tools. You might notice that your local weather forecaster does not have such halos (unless
you live in a tiny TV market that's behind the technology curve). Many of those stations use a keying technology
from Ultimatte (    www.ultimatte.com     ). It offers incredible flexibility and creates very clean keying in difficult
situations, such as through smoke, hair, water, and glass. Ultimatte offers a $1,495 product that includes plug-ins
that work with 10 products including Adobe Premiere Pro, Adobe Photoshop® and Adobe After Effects 6.0. The
hardware prices start in the neighborhood of $28,000.

Q. When I drag a linked audio/video clip to Video 2, the audio goes to Video 2 as I’d expect. But when I
drag a linked A/V clip from Video 1 to Video 2, its audio stays on Audio 1 and covers up the audio that was
there. What’s going on?

A. Your clips are following Adobe Premiere Pro’s new multitrack audio rules. When you add clips from the Project
window, Adobe Premiere Pro tries to cascade the audio portions. That is, if at all possible, it tries to put them on
track numbers that match where you placed the video. There are exceptions for locked tracks and mismatched
track types (mono, stereo, and 5.1). When you move clips within a sequence, the audio stays on its track. The
reasoning? With Adobe Premiere Pro’s new track-based audio effects and controls, developers want to ensure
any such clip moves don’t lead to surprising results. If you want to move the audio to a new track, unlink audio
and video and move both clips individually.
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Quiz

1. How do you blend two full-screen clips?

2. What's the difference between the two sets of Chroma Key sliders—Similarity/Blend and Threshold/Cutoff?
What's a more descriptive name for the Smoothing drop-down menu?

3. When do you use the Non-Red key?
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Quiz Answers

1. Either of two ways: Use the fixed Opacity video effect (or its non-fixed twin: Alpha Adjust) to reduce the
opacity of the superimposed clip, or use the Screen (or Multiply) transparency for a subtle blend that lets
dark (or light) areas of the bottom track show through the superimposed clip. Screen more closely
approximates the Opacity effect. Multiply acts more like a real key.

2. Similarity and Blend work together to set a "width" for the color range to key out of a superimposed clip and
to blend the two clips smoothly together. Threshold and Cutoff deal with shadows. Threshold controls the
amount of shadows from the superimposed clip that will display on the lower track's clip. Cutoff controls
how dark or light those shadows are. "Smoothing" is the same as anti-aliasing. It gets rid of the jaggies along
the edges of keyed objects.

3. Non-Red enables you to key out, well, non-red backgrounds (that is, green and blue). It's a helpful backup if
the Green or Blue Screen keys don't work as well as you'd like, which might happen if the green or blue are
not true chroma key colors.

Exercises

1. Use the Luma key to isolate a ball by keying out a highly contrasting background. Then use motion settings
to bounce it around a scene. Use keyframe interpolation with the bounces and apexes to more realistically
mimic a bouncing ball.

2. Use the Title Designer to create several titles. Place them in various superimposing tracks and fade them in
and out of your Video 1 clip at various times, sometimes displaying more than one title at a time. Remember,
you drag the edges of a title clip to make it any length you want. Finally, give a couple titles motion using
the Motion effect.

3. Experiment with the Chroma and Green/Blue Screen keys. Find a backdrop color and a lighting setup that
works well.

4. Ask to visit a local TV station or production studio to watch how the crew members set up green/blue
screens. You’ll see that they take great pains to light it evenly and to have the actor stand a good distance
from the screen.

5. Start watching TV commercials more critically, looking for examples of compositing. It's a rare spot that
doesn't use layering. This is a great source of ideas.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education
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Tools for the New Work are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other

countries. All other trademarks are the property of their respective owners.

© 2004 Adobe Systems Incorporated. All rights reserved.
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Module 19

Compositing Part 2: Alpha Channels, Mattes and Pictures-in-a-Picture

In the previous module, I presented three ways to composite clips: the Opacity effect, and the Color and
Luminance keying effects. There are two other ways to make portions of a clip transparent—creating something
like digital holes: using alpha channels and mattes. Alpha channels are common elements of graphics created in
programs such as Adobe® Photoshop® and Illustrator®. Adobe Premiere® Pro makes them transparent.

In addition, several of Adobe Premiere Pro’s video effects have built-in transparent alpha channels that enable
portions of clips below them on a sequence to show through.

Mattes used for keying generally are simple graphics, completely opaque with transparent elements. Adobe
Premiere Pro has several ways to use them to create transparencies. Both alpha channels and mattes are
effective, useful means to composite clips in Adobe Premiere Pro.

Finally, simply shrinking a clip will reveal whatever is below it on a sequence. Your students worked with that
general concept earlier in Module 12: “Putting Video and Still Clips in Motion.” In this module, I’ll show how to
create Pictures-in-a-picture.

At the end of this lesson, students will have learned about:

• Working with alpha channel transparencies

• Using video effects with alpha channel transparencies

• Using the Motion effect to make pictures-in-a-picture

• Two multiple track video effects: Blend and Texturize

• Creating and working with matte keys

• Using mattes to build split screens

Working with Alpha Channel Transparencies

Most video clips and many graphics have alpha channels. Coupled with a clip’s visible red/green/blue (RGB)
color channels, an alpha channel defines what parts of an image are transparent or semitransparent. You don’t
see the alpha channel. Rather Adobe Premiere Pro uses the gray scale information from that channel to set the
level of opacity or transparency.

The alpha channel uses 8 bits of information to describe 256 shades of gray. In typical computer graphic
applications, pure white regions of the alpha channel are opaque—that is, they cover any clips beneath them on
the timeline. Pure black regions are transparent and let any lower clips show through. Finally, gray regions let
some background come through, depending on the level of gray.

On the other hand, a typical video's alpha channel describes gray values on a pixel-by-pixel basis instead of by a
larger region, making it impractical to use the Alpha Channel Transparency setting to carve out a transparent
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hole in a video clip. That’s why the only work you’ll do with Alpha Channels will be on graphics or as a parameter
in a Adobe Premiere Pro Video Effect.

Alpha Channels—Straight or Premultiplied

An alpha channel is either straight or premultiplied. A straight alpha channel stores its transparency information
only in the alpha channel. By default, Adobe Premiere Pro automatically makes any straight alpha channel
transparent. You can make that alpha channel opaque if it suits you. I explain how in a moment.

Graphics with premultiplied alpha channels sometimes need some extra attention when working with them in
Adobe Premiere Pro. The reason? Premultiplied alpha channels include transparency information in both the
alpha channel and the edges of the graphic. When Adobe Premiere Pro makes those alpha channel areas
transparent, the graphic elements frequently have halos—blurry edges or stray pixels of variable color around
them. Adobe Premiere Pro’s Remove Matte effect can fix that. I explain it later this module in the "Dealing with
Premultiplied Alpha Channels" sidebar.

Task: Make an Alpha Channel Visible
To see how an alpha channel transparency works, follow these steps:

1. Place any video clip on Video 1 in the timeline. I used Saleen_Car_01.avi from the Sample Project that
shipped with Adobe Premiere Pro.

2. If you have a graphic with an alpha channel (most Photoshop graphics meet that criterion), import it to
your Project window (File > Import). If you don’t have such a file, use the Saleen_logo_layers.psd file
from the Sample Project.

Note: Import Layered Graphics as Sequences

If you use the Saleen Photoshop file or any other layered graphic file, when you attempt to import it, Adobe
Premiere Pro will pop up a dialog box asking how you want Adobe Premiere Pro to deal with its layers. In
this case, select Import as: Sequence and click OK. That will create a new sequence in your Project window
with the graphics layers listed as separate clips.

3. Drag that graphic to a superimposing track—Video 2 or higher—directly above the clip on Video 1.
Drag the ends of the clip to make it match the length of the clip below it. Your project should look like
Figure 19.1 (I used the Motion effects Scale parameter to blow up the logo for emphasis). By default,
Adobe Premiere Pro makes the graphic’s alpha channel transparent, allowing whatever is below it on
the sequence to show through.
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FIGURE 19.1: Adobe Premiere Pro automatically makes a graphic’s alpha channel transparent, displaying whatever
is below it on a sequence.

4. To see some alpha channel options, apply the Alpha Adjust video effect to this clip. This effect’s primary
function is to enable you to apply the Opacity effect at some point other than second to last in any
collection of effects you set up (Motion is applied last). As shown in Figure 19.2, it does have some extra
settings that give you a feel for alpha channels:

• Ignore Alpha—Switches off the alpha channel transparency and turns it into opaque white (its original
color is black—the color seen as transparent by Adobe Premiere Pro).

• Invert Alpha—Makes the alpha channel opaque and the graphic transparent. As highlighted in Figure
19.2, this is a very cool effect, and it’s keyframable (as are the other two checkboxes). For example, if you
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use a graphic with a recognizable shape, you can easily insert other images and videos into that shape
using the Invert Alpha parameter.

• Mask Only—Converts the opaque graphic into a solid white opaque object.

• Opacity—This is the Alpha Adjust effect’s primary function—duplicating Adobe Premiere Pro’s fixed
Opacity effect.

FIGURE 19.2: The Alpha Adjust effect enables you to manipulate the alpha channel and any associated graphics.
Selecting the Invert Alpha parameter makes the graphic element transparent and the alpha channel opaque.

Put Alpha Channel Graphics in Motion

You can apply motion to a graphic using the Motion effect. To do that, in this case, first delete Alpha Adjust from
the Effect Controls window (ECW) and then click Motion to switch it on or click on the clip in the Monitor window
Program screen.

Just as you did in Module 12, “Putting Video and Still Clips in Motion,” click inside the clip,  move the graphic’s
bounding box around and change some other Motion parameters.

As shown in Figure 19.3, even though the bounding box defines the edges of the graphic’s transparent alpha
channel region, you won’t see a rectangular, screen-sized object moving around the screen. You will see only the
clip’s opaque graphic element.
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FIGURE 19.3: It’s a simple matter to put alpha channel graphics in motion.

Sidebar: Fixing Premultiplied Alpha Channel Fringing

Think of straight alpha channels as cookie cutters. Graphic artists "bleed" some of their graphics slightly
beyond the edges of the white portion of the alpha channel, knowing that when they apply an alpha
channel transparency, it will act like a cookie cutter, slicing a sharply defined edge along the graphic and
ensuring there will be no gaps along the border.

In a graphic with a premultiplied alpha channel, the white (opaque) portion of the alpha channel exactly
matches the edge of the pixels in the RGB graphic. In most cases, premultiplied graphics have either black or
white backgrounds. Because of anti-aliasing, the background color darkens or lightens these pixels along
the edge of the graphics.
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If you use graphics with premultiplied alpha channels in Adobe Premiere Pro, you might experience some
unpredictable fringing around the edges. To fix that, use the Remove Matte Key. Its only parameter is a
drop-down list from which you select White or Black. Select whichever color matches your graphic’s
premultiplied background color. That will key out that background and create a sharper edge to your
graphic.

Using Video Effects with Alpha Channel Transparencies

Of Adobe Premiere Pro's 90-plus video effects, several have either an alpha channel or have special adjustments
for clips with alpha channels. I'll go over 10 of them.

In previous modules, I've touched on all of these effects and noted some of their Alpha Channel characteristics,
so I'll try to avoid too much repetition.

I've placed them in two groups: Video Effects with Alpha Channels and Effects that work well with graphics that
have Alpha Channels.

Video Effects with Alpha Channels

Six Adobe Premiere Pro video effects have built-in alpha channels:

• Lens Distortion

• Strobe Light

• Motion

• Transform

• Basic 3D

• Camera View

Note: Transparent By Default

Typically, these effects move clips around the screen, revealing whatever is below them on a sequence. It
used to be that you could block that see-through view by selecting one of the effect’s parameters and
opting for a background color or some other action. With Adobe Premiere Pro, transparency is the default
setting, and to block that you need to apply the Alpha Adjust effect and select Ignore Alpha. I explain that
further in a couple of the upcoming examples.

To see these effects in action, remove the alpha channel graphic from the Video 2 track and replace it with a
video that’s distinctly different than the one below it on Video 1. In my case, I used the Saleen_Car_01 and
Saleen_Car_02 clips from the Sample Project. Then select the clip on Video 2 to open it in the ECW, where you
will apply video effects to it.
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Twisting Away an Image with Lens Distortion

I am including this as an effect with an Alpha Channel but that might not be the case in the version of Premiere
Pro that you are using. There is a bug that disables this Alpha Channel Transparency setting. Adobe is aware of
this issue but, as is company policy, has not announced when or if it will post a patch to fix that bug. Assuming
Adobe has fixed this bug by now, here’s how this features works (or is supposed to work).

With this video effect, there is no need to use Alpha Adjust to switch transparency off. As shown in Figure 19.4,
there is a checkbox to do that in the Lens Distortion settings dialog box. If you use Lens Distortion such that it
parts of the clip no longer fill the screen, unchecking the Fill Alpha Channel box in the Settings Dialog Box
should reveal whatever is below this clip on a sequence. However, due to the bug, that did not happen in the
version used when writing this module. One effect for which that checkbox does work is Camera View, which I
cover later in this section.

FIGURE 19.4: Unchecking the
Lens Distortion Fill Alpha
Channel check box should
reveal the clip below. Checking
it displays a solid color
background.

Flashing a Second Image with
Strobe Light

To have each strobe flash
reveal the clip on Video 1
(instead of displaying a solid
strobe color), use the drop-
down menu highlighted in
Figure 19.5 and select Makes
Layer Transparent. You can
use Blend With Original to
reduce the opacity of the clip
on Video 2, thereby making
the strobe changes less
abrupt.
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FIGURE 19.5: Strobe Light flashes can reveal the layer beneath it on the timeline.

Task: Using Strobe on a Moving Object
You know how a strobe light can momentarily freeze a moving object. You can use Adobe Premiere Pro to do
the same thing in what appears to be a 3D space. Here’s how:

1. Add another video track to the timeline (unless you already have a Video 3 track) by right-clicking on a
track header and selecting Add Tracks. Move the clip on Video 2 to Video 3.

2. Strobe Light should remain associated with that clip (if not, re-apply it). Set a short Duration (0.2 or so).
Set a strobe period about twice as long (0.4 or so). Put some randomness in (5% works well). Also, set
the Strobe parameter to Make Layer Transparent.

3. Add a graphic with an alpha channel to Video 2 (you can use the Saleen logo) and drag its ends to
match the length of the other two clips.

4. As shown in Figure 19.6, give the graphic on Video 2 some motion, keeping it within the screen. The
faster it moves the better, so feel free to give it a convoluted and long motion path, forcing it to zip
around the screen.
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FIGURE 19.6: Layer a graphic with a Drop Shadow between two clips and apply Strobe Light to the top clip for a fun,
disco-strobe-light effect.

5. Give that graphic a drop shadow to lend a bit of a 3D feel to this set of effects.

6. Now preview that section. The top clip should do the strobe thing, and if the graphic moves fast
enough, it’ll be reminiscent of a disco dance nightclub.

7. To make upcoming tasks work smoothly, remove the video clip from Video 3, but leave the graphic on
Video 2 and the video clip on Video 1.
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Working with Motion and Transform

Motion and its non-fixed video effect twin Transform move your clip in apparent 3D space. Once displaced from
a normal full-screen aspect, both effects leave transparent gaps around the edges of the clip.

As shown in Figure 19.7, Transform has a few extra attributes not included in the Motion effect: Skew and
Opacity. Once again, you can use Alpha Adjust if you want to turn off or invert the alpha channel transparency.

FIGURE 19.7: Transform can skew a clip to reveal the clip beneath it.

Note: Transform’s Disabled Adobe After Effects  Attributes

Transform is an Adobe After Effects®  effect and it has two parameters that work only in After Effects: Use
Composition’s Shutter Angle and Shutter Angle. Both are included as parameters in the ECW but are
disabled.

Revealing a Clip with Basic 3D

As is the case with Transform and Motion, you can use Basic 3D to reveal a clip below it on a sequence. As shown
in Figure 19.8, this is a good effect to use as something like a transition. You can spin and tilt the entire screen
toward the front or back while changing the Distance to Image slider to move it away from the viewer. As I
mentioned in Module 17, “Using Higher-Level Video Effects,” Basic 3D’s primary appeal to me is its specular
highlight.
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FIGURE 19.8: Basic 3D is another tool you can use to reveal a clip below it on the timeline.

Opting to Reveal a Clip Using Camera View

This effect works a lot like Basic 3D with a few additional controls thrown in. As shown in Figure 19.9, it has the
same type of settings dialog box as Lens Distortion, including a Fill Alpha Channel check box. Un-checking it
reveals the clip below it on the sequence.
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FIGURE 19.9: Uncheck the Camera View effect's Fill Alpha Channel box to display the clip below it on the timeline.

Effects That Work Well with Graphics That Have Alpha Channels

Four video effects work well with a graphic: Alpha Glow, Bevel Alpha, Channel Blur, and Drop Shadow. You
briefly encountered all of them in Module 17. I’ll cover a few additional highlights in this upcoming task.

Task: Using All Four Effects At Once
I'll ask you to take a different tack in this section. Instead of trying each effect separately, I'll have you apply these
effects to the same graphic, eventually viewing all four at once. Admittedly, by that time, the graphic will be a
hodgepodge. You can use the Saleen logo or any other graphic that has an alpha channel:
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1. If you are using the Saleen logo graphic, enlarge it using the Scale parameter in the Motion effect. 400%
works well. Center it on screen by dragging the crosshairs or adjusting the position parameters: 400 and
560 work well.

2. Apply Alpha Glow to the graphic on Video 2 and experiment with its settings (use Figure 19.10 as a
reference):

• Glow—Sets the size of the glow.

• Brightness—Might be a little counter-intuitive. A high value (255 is the maximum) darkens
the glow, and a low value makes it lighter and more transparent.

• Start Color—The color closest to the graphic.

• End Color—The color at the outer edge of the glow.

3. Open Alpha Glow’s Settings dialog box by clicking the little Setup button next to its reset button. Note
that it has one extra option: Fade Out. By default, Fade Out is checked. Un-checking it gives your glow’s
perimeter a hard edge.

FIGURE 19.10: Alpha Glow creates a halo around a graphic that has an alpha channel.

4. Drag Bevel Alpha to the ECW. As you did in Module 17, give this graphic a 3D beveled feel by adjusting
this effect’s parameters. Figure 19.11 shows one look you might come up with.
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FIGURE 19.11: Bevel Alpha adds a 3D edge to the graphic. Because this clip also has Alpha Glow applied to it, the
beveled edges are not very distinct.

5. Add Channel Blur to the ECW. This shifts individual color values—red/green/blue—as well as blurs the
graphic. Feel free to make adjustments using all the sliders. Figure 19.12 shows the results of my
parameter adjustments.

Tip: Effect Order Makes a Difference

As illustrated in Figure 19.12, as you make changes using the Channel Blur effect sliders, the Bevel Alpha and
Alpha Glow effects change. You might want to experiment as you add even more effects to the same clip.

Turn individual effects off and on by clicking the f in the check box. The order of the effects also alters the
overall appearance of a clip. Adobe Premiere Pro renders effects from the top down (saving the fixed
effects—Motion and Opacity—for last), reflecting the order in which you applied them to the clip.

You can change that order after the fact by dragging effects to new positions in the Effect Controls window.
Try that for these three effects to see what happens.

For instance, as I've demonstrated in Figure 19.13, if you place Channel Blur at the top (below Motion and
Opacity), any changes made when it's in that position will have a much more dramatic effect than if you
place Channel Blur toward the bottom of the palette.
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FIGURE 19.12: Because Channel Blur is, for the moment, the lowest effect in the Effect Controls palette, it blurs all
effects above it.

FIGURE 19.13: Placing Channel Blur at the top of the Effect Controls palette amplifies any adjustments you make to
it.
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6. Apply Drop Shadow to the ECW. Because the three other effects have softened the edges of the
graphic, Drop Shadow won't have all that dramatic an effect. If you increase its Opacity, as I did in Figure
19.14, you’ll get a more distinct shadow.

FIGURE 19.14: Drop Shadow has a subtle feel when applied to effects that have already blurred the image.

Tip: Move Drop Shadow to the Top

Because Adobe Premiere Pro applies effects from the top of the ECW, down, if you drag this effect to the top
of the effect chain in the Effect Controls palette, it will create a very distinct drop shadow. Toward the
bottom of the palette, it acts much more in character with the other effects. In this case, because the graphic
has soft edges applied to it, the drop shadow will have a soft-edged look as well.
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Tip: Applying Keyframes Within the Sequence

If you're in a particularly ambitious mood, feel free to apply keyframes to each individual video effect. You
can access all the effects within the Effect Controls window or within the clip itself on the sequence.

To do that, expand the Video 2 track by clicking the Collapse/Expand Track triangle. Then click the Show
Keyframes button and select Show Keyframes. That adds an effect drop-down list to the clip to the right of
its name.

You can select any of the effects, and then select any of that effect’s parameters. Once selected, you’ll see
that particular parameter’s keyframe line. Use the Pen tool (keyboard shortcut ‘P’) to drag keyframes to new
locations or create new ones by clicking it on the keyframe line.

Using the Motion Effect to Make Pictures-in-a-Picture

Pictures-in-a-picture is one of the top uses of the Motion effect. And it’s one of the easiest ways to see how you
can composite more than two clips. I’ll first take you through the fundamentals then cover the easy-to-use PiP
presets that ship with Premiere Pro 1.5.

Task: Pictures-in-a-picture Fundamentals
Because you worked with Motion in Module 12, “Putting Video and Still Clips in Motion,” I won’t repeat the basic
instructions. Rather I’ll give you a few tips:

1. To do this, place several clips stacked one above the other on a sequence (for my example, I used six
Saleen_Car AVI clips from the Sample Project).

Tip: Automatic Track Creation

There is no need to add video tracks to your sequence. Simply drag each new clip to somewhere above the
current video tracks and drop it. Adobe Premiere Pro will create a new video track (and an audio track if
you’re adding a linked A/V clip) to accommodate you.

2. To keep things easy, trim the clips so that they all are the same length, and keep them short.

Tip: Top-down Thinking

It’s best to work from the top clip down because each clip covers the one below it. If instead you first apply
Motion to a clip below the top track, you won’t see it in the Monitor window Program screen.

If you must work from the bottom up, simply switch off the higher tracks’ Toggle Track Output eyeballs. That
way you can see what’s on those lower tracks.



Adobe Digital Video Curriculum Guide – Module 19 19-18

Adobe Digital Video CURRICULUM GUIDE

3. Click on the top-most clip to select it. You will apply three effects to it, then copy and paste those effects
to the rest of the clips to create a uniform look.

4. Switch on Motion by clicking it in the ECW. Scale the clip down to about 25%. As you reduce its size, you
reveal the clip in the video track below it in the sequence. Position it in a corner. Use Figure 19.15 as a
reference.

FIGURE 19.15: Create pictures-in-a-picture by stacking video clips in multiple tracks and then applying motion
settings to them.
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Tip: Area versus Perimeter

The 25% figure in Step 4 refers not to a change in the clip’s area, rather to its perimeter. Each side becomes
1/4th its original length, which means the clip’s area drops to 1/16th, or .0625 of its original size. That may be a
bit counter-intuitive to those who would expect scaling to 25% would create a clip that fills one-quarter of a
full screen.

5. To make your clips stand out from the background, use the Clip effect to give them frames. Drag that
effect to the ECW, open its settings dialog box (shown in Figure 19.16), and give your clips a frame size
of five pixels or so and a color that complements the predominant colors of the clip on Video 1 that will
serve as the background.

FIGURE 19.16: Add a frame to your clip using the Clip effect.

6. To further distance the moving clips from the background, drag the Drop Shadow effect to the ECW and
create a fairly obvious drop shadow. As shown in Figure 19.17, an Opacity of 80, a Distance of 50, and a
Softness of 25 work well.
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FIGURE 19.17: Using Drop Shadow gives a 3D feel to the moving clips.

7. Right-click on this selected clip in the sequence and select Copy. Right-click on the clip below it and
select Paste Attributes. That will change the scale of that clip, give it the same size and color frame, and
add a drop shadow.

8. By right-clicking that clip, you also select it. Click on Motion in the ECW to display a bounding box
around it (you’ll see the bounding box but not the clip since the clip on the higher video track is
covering it up). Grab the bounding box crosshairs and drag this clip to another corner (after you start
moving it, you’ll see the clip).

9. Working your way down the video tracks, follow the same procedure for each clip (right-click, select
Paste Attributes, click Motion, move the clip), leaving the clip on Video 1 alone (it’s the background
video—the “picture”—of this pictures-in-a-picture). When you’re done, your Program screen should
look something like Figure 19.18
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FIGURE 19.18: As you add more moving clips,
those higher on the sequence will throw
shadows on those below.

10. You can call it a day, or you can take
this further by putting each clip in
motion. You can use keyframes to fly
the clips onscreen at different times
and then have them fly off. Or you
can use the Opacity effect to have
them fade in and then out. You can
expand one of them to full screen as
a way to transition to that clip. Using
pictures-in-a-picture lends itself to
many possibilities.

Using Premiere Pro 1.5’s New PiP Presets

Premiere Pro 1.5 ships with a passel of video
effect presets. You saw most of them in
Module 11: “Working with Video Effects.” The
one I saved for now is PiP: Picture-in-a-
picture. Open the PiP folder and open the
25%UL subfolder as shown in Figure 19.19.
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FIGURE 19.19: Premiere Pro 1.5 ships with several dozen PiP
video effect presets.

The 25% refers to the relative size of the PiP. As I mentioned
earlier, 25% refers to the change in perimeter size, not the
area. And “UL” means Upper Left. Scale means the clip grows
or shrinks over time, and Spin and Slide describe how the clip
behaves as it moves on screen.

These presets have a very basic functionality. When dragged
to a clip on a sequence or in the ECW, they simply change the
Motion settings. To see this in action, select a clip and open
the ECW. Then drag PiP 25% UL to the ECW and note that the
Motion settings suddenly change: Position shifts to 197.5, 122
and Scale drops to 25%. No keyframes are added since this is a
straightforward PiP. You can use this as a starting position and
now can add some animation or other motion.

Replace the PiP 25% UL preset by dragging 25% UL Spin In
Right. As shown in Figure 19.20, that sets four keyframes for
Position and Rotation and sets the Scale to 25%. By default the
Keyframes start with the clip’s first frame and end one second
into the clip. If you now drag PiP 25% UL Spin Out Right, that
will add four more keyframes, that spin the clip back off the
right side of the screen. These keyframes start one second
before the end of the clip.
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FIGURE 19.20: Using a
PiP preset changes the
Motion settings and
typically adds some
keyframes.

Experiment with other
PiP combinations.
Depending on what’s
already applied, adding a
new PiP might cancel
current Motion settings.
Or, as you just saw, you
can have two work
together.

If you adjust a PiP Preset’s
settings to suit a project
and expect to use that
same setting on other
project, save those
settings as a customized
Preset by clicking on the word Motion, opening the ECW’s Wing Menu, selecting Save Preset, giving it a name
and noting whether you want it to scale to the length of the clip or anchor it at the start or end of a clip.

Two Multiple Track Video Effects: Blend and Texturize

Two video effects combine clips on two tracks. Blend works something like a crossfade but gives you extra
options that can have some surprisingly colorful results. Texturize lets you give a clip something akin to an
embossed feel using a clip below it on the sequence.

Using Blend to Combine Two Clips

As illustrated in Figure 19.21, Blend has several parameters. The one you cannot keyframe is the track with which
you’re doing the blending. It can be any track, but if it’s a track above the track you’re working on, you need to
switch off the upper track’s eyeball to see the effect.
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FIGURE 19.21: Blend lets a clip on a different video track show through the selected clip.

The Mode parameters drop-down list offers Crossfade, Color Only, Tint Only, Darken Only, and Lighten Only.
Each lets different values of the lower clip show through. Blend With Original sets a relative percentage of
opacity for the selected clip. A setting of 100% displays only the selected clip. 0% shows only the Blend With
Layer clip, and 50% sets each at 50% opacity.

You can use keyframes on the Blend With Original slider to gradually transition from one clip to another.

Tip: Combine a Graphic and Video

For an unusual effect, use a graphic for one clip and a colorful video for the other. Selecting anything but
Crossfade leads to some bizarre results. Try using the graphic as the selected clip, selecting Color Only, and
moving the Blend with Original slider to 0%, which converts the graphic to grayscale and colors it using the
Blend With Layer clip.

Using Texturize to Add an Embossed Look to Another Clip

Texturize has tons of possibilities. You apply Texturize to whichever clip you want to give some texture to, select
the track that has the clip to use to create that texture, then adjust Light Direction and Texture Contrast settings
to set the depth of the embossing (see Figure 19.22).
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FIGURE 19.22: Texturize embosses one clip and imparts that 3D feel to a clip on a different track in the sequence.

The Texture Placement parameter apparently is disabled; changing it had virtually no influence on the effect.

Tip: Texturize Has Many Uses

The name Texturize is too narrow. Yes, you can use a clip with obvious texture—rug, sand, or rippling
water—and impart that feel to another clip. But there are many other uses. You can bring up an embossed
version of your logo beneath a product shot or place one distinctly different setting under another. How
about embossed waving palm trees behind a frozen arctic tundra?

Caution: Texturize Disables Motion Settings

Texturize will not work with motion settings. Therefore, if you want to move around your embossed logo
under another clip, you'll have to create a nested sequence to do that. I cover this topic in the next module,
“Adobe Premiere Pro Editing Tips, Tricks and Techniques: Part 1.” The basic approach is to create a new
sequence, add only the logo to it, apply the Motion effect to that clip and adjust any Motion parameters that
suit you, drag that sequence to your other sequence as a separate clip, and then apply Texturize. That’s a
nested sequence—a sequence in a sequence.
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Creating and Working with Mattes

On the surface, the matte is a straightforward concept. But confusing terms and applications can make using
one counterintuitive.

By definition, mattes are color or grayscale graphics or images. When used with Matte Key effects, they create
transparent and opaque areas in clips.

When you use mattes with Adobe Premiere Pro Matte Keying effects, they follow standard transparency rules:
Black areas are transparent, white areas are opaque, and gray areas create varying levels of opacity depending
on the tone of gray.

If the matte is a color image or graphic, then Adobe Premiere Pro removes the same level of color from the clip
you are keying, thus creating an inverse image. So if you use a matte with green in it, the displayed image will
look purple (the matte removes green, leaving red and blue).

You can create basic graphic mattes using Adobe Premiere Pro’s Title Designer (except for Image Mattes),
Photoshop, or any basic graphics program. Or you can use video clips or still images as mattes. You can use an
Adobe Premiere Pro video effect to convert a color clip to a grayscale matte to avoid dealing with color
inversions.

Most of the time, mattes are simply black-and-white graphics. In those cases, they work like scissors on white
paper. Any (black) holes cut into the paper let those portions of the clip below it on the sequence show through
and combine with the matted clip above it on the timeline.

Task: Combine Clips with an Image Matte Key
Image Matte Keys let you cut “holes” in one clip to allow portions of another clip to show through. For example,
you can use an Image Matte Key to highlight an element in a clip or insert a portrait in a frame. I offer up a
practical example in the next module. Here’s how to use an Image Matte Key:

1. The Image Matte Key works only with graphic files supported by Adobe Premiere Pro. It does not work
with files created in the Title Designer. So, open a graphics program such as Photoshop or Microsoft
Paint. Set the image canvas to a resolution that matches your project: 720×480 for NTSC or 720×576 for
PAL (see the following Did You Know for more on the canvas size).

Tip: Image Matte Photoshop Setup

When using Photoshop to create a graphic to use as an Image Matte key, select File > New and choose one
of the NTSC or PAL Preset Sizes. When opening a new canvas in Photoshop, set the mode to RGB color, and
if you want an opaque background, click the White radio button under Contents.
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2. As I've demonstrated in Figure 19.23, start with a white background, create a simple shape, and fill it in
with solid black. Create another shape and fill it with gray. Save your work and remember where you
stored this file.

FIGURE 19.23: Use a graphic program such as Adobe Photoshop to create a basic Image Matte.

3. Return to the sequence and place two different video clips or still images on Video 1 and Video 2 (for my
example, I used the Saleen_Car AVI clips).

4. Select the clip on Video 2 and apply the Image Matte Key to it.

5. Twirl down the Image Matte disclosure triangle and change the Composite using parameter to Matte
Luma (if you created a graphic with an alpha channel, you can leave the Composite Using setting on
Matte Alpha). As shown in Figure 19.24, your Program screen should now display the clip on Video 2
with whatever “holes” you drew in the graphic showing portions of the clip on Video 1. Black “holes” are
completely transparent, gray ones are partially transparent.
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FIGURE 19.24: Using an Image Matte Key lets you cut “holes” in one clip, disclosing portions of the clip below it on a
sequence.

Tip: Reversing the Effect

You can electronically swap black with white (transparency with opacity) by clicking the Image Matte Key’s
Reverse check box. That will swap transparent and opaque areas of the clip on Video 2, letting different
portions of the clip on Video 1 show through.

Using the Track Matte Key

A Track Matte key works much like an image matte but has a few advantages and one obvious difference. What
makes it different is that you place the matte graphic on a video track rather than apply it directly to a clip.

As with an Image Matte, it slices holes in a clip, revealing whatever is below it on a sequence. What makes it
more convenient is that you can use Adobe Premiere Pro’s Title Designer to create the graphic. What makes it
more interesting is that you can use the Motion effect on that matte to turn it into a “traveling matte.”

Just about every older movie involving "impossible" motion—spaceships, Superman in flight, or giant spiders
(such as the 1955 cult classic, Tarantula, with Clint Eastwood in a minor supporting role as a pilot)—uses
traveling mattes.
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Task: Working with a Track Matte
To give it that motion requires using a Nested Sequence. In the next module, I explain that concept plus
demonstrate how to use a Track Matte to create a traveling matte that highlights action and to conceal
someone’s identity. For now, follow these steps simply to see how to apply a static Track Matte Key to a clip:

1. You can use the Image Matte graphic you created for the previous task, or you can create a new one in
Adobe Premiere Pro’s Title Designer. To use the Image Matte, import it to your Project window (select
File > Import). If you use the Title Designer, save your graphic, calling it something like Track Matte Key.
It’ll show up automatically in the Project window.

Tip: Creating Mattes in the Title Designer

Both the Image Matte Key and the Track Matte Key can use graphics that have alpha channels. When you
create a graphic in Adobe Premiere Pro’s Title Designer, it’ll have an alpha channel by default. At this point,
things will make more sense if you don’t use that alpha channel (I show you a cool way to use it in the next
module). So, if you use the Title Designer, first create a solid white rectangle that fills the screen, and then
place whatever black/gray-scale graphics you want to use to create transparencies on that. In that way, the
white area will be opaque and the black/grayscale areas will be transparent as you’d expect.

2. Use the same two clips from the previous task. Drag whichever graphic you want to use as a Track Matte
Key from the Project window to Video 3 and drag its edges to fit the other two clips.

3. You need to disable the display of that Matte (otherwise it’ll cover all clips below it on the sequence). As
shown in Figure 19.25, do that by right-clicking on the clip and selecting Enable to un-check that
attribute. Alternatively, you can unclick the Video 3 eyeball, but that disables the entire video track,
switching off the display for any other clip you might later put on Video 3.
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FIGURE 19.25: You need to un-
check Enable for this clip to keep it
from covering up clips below it on
the sequence.

4. Select the clip on Video
2. Delete the Image
Matte Key from the ECW
and apply the Track
Matte Key. Set
Composite Using to
Matte Luma. Your
project should look
something like Figure
19.26.

FIGURE 19.26: Track Matte uses a matte  on a higher video track and applies it to the clip below it. The end result in
this case is strikingly similar to the Image Matte Key example, but there is no need to resize the clip to cover gaps.



Adobe Digital Video Curriculum Guide – Module 19 19-31

Adobe Digital Video CURRICULUM GUIDE

Using Mattes to Build Split-screens

There are several ways to create a split screen. For instance, you can use an Image Matte or a Track Matte with
black on one side and white on the other. Or a more complicated Difference Matte. But the Garbage Matte is the
easiest method, so we’ll start with that.

Working with Garbage Matte Keys

You've seen movies with the same actor playing multiple characters in the same scene. There are several ways to
accomplish this. Using a Garbage Matte Key to make a split-screenis one. Using a Difference Matte Key is
another. I explain both in the next two tasks.

So, what the heck is a Garbage Matte Key doing in a nice place like Adobe Premiere Pro?

The garbage matte is so named because you use it to get rid of garbage in your image. Frequently, a boom
microphone might be in a shot done in front of a Chroma Key screen. Or there might be some video noise
around the edges of a keyed shot. The Garbage Matte Key readily removes those things.

Previous versions of Premiere offered only one Garbage Matte. Premiere Pro 1.5 has three: Four-Point, Eight-
Point and Sixteen-Point Garbage Mattes. More points give it more precision. To show you what I mean, we’ll start
simple with the Four-Point Garbage Matte Key.

Take a look at Figure 19.27. I applied RGB Difference to this shot. That keys out the single-color background but
not the shadow on the right and that extraneous stuff in the lower-left corner.

FIGURE 19.27: I can use RBG Difference to key out the background of this shot, but that doesn’t remove the
detritus—the shadow and that object in the lower left corner.
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I apply the Four-Point Garbage Matte Key to remove those other items. As you can see in Figure 19.28, it’s a
bounding box with four handles in the corners. I can drag those handles into the clip and cover up those objects.

FIGURE 19.28: Use the Garbage Matte Key to slice away those unwanted items and replace them with transparent
regions.

Any gaps you create by dragging in the Garbage Matte’s corners become transparent, letting whatever is below
them on a sequence show through. You also can use keyframes to adjust the size and shape of this box over
time.

The Four-Point Garbage Matte Key has its limitations. It’s good at removing items along the edges of a clip, but if
you try to get at anything toward the middle, you’ll probably cut off the object you’re keying.

You can remedy that inconvenience by using a Garbage Matte with more points. Try out the Sixteen-Point
Garbage Matte. As shown in Figure 19.29, you can drag the vertices anywhere along the outside of the matte,
thereby increasing the accuracy of the segment you want to remove or save.
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FIGURE 19.29: The Sixteen-Point Garbage Matte Key offers much more control over what you are removing or saving
than the Four-Point version.

Using the Four-Point Garbage Matte Key to Make a Split-Screen

This is where assignment number five from Module 18, "Compositing Part 1: Layering and Keying Clips," comes
into play.

Note: Assignment Review

As a reminder, for the task in Module 18, you were to tape a distinct background with nothing moving in
it—that is, no waving palm trees or soaring birds. Then, without turning off or moving the camera (this is one
exercise where you need a rock-steady shot), have someone walk into the left side of the scene without
crossing the center line, stand around for a while, and then walk back out the left side. Have that person do
the same thing entering from the right side and walking out to the right. For a bit of comic relief, have your
"actor" wave toward the center of the scene before walking off camera.

Task: Create a Split-Screen Effect
To create a split-screen effect using your video track assignment from Module 18, follow these steps:

1. In the Project window, double-click the assignment clip to display it in the Monitor window Source
screen.
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2. Trim the left side of the clip to a point just before your actor enters the scene. Drag the trimmed clip to
Video 1 at the start of the sequence.

3. In the Source screen, trim the clip to a point just before your actor enters the right side. Drag it to Video
2, right above the clip on Video 1. Move the CTI edit line far enough into the clips so that your actor has
moved on screen.

4. Apply the Four-Point Garbage Matte Key to the clip on Video 2. As shown in Figure 19.28, drag the
corners to reveal the clip beneath it on the sequence.

5. Preview your split screen. As shown in Figure 19.30, your actor should enter the scene from both sides,
hang around, wave to his/her other self, and then walk off.

FIGURE 19.30: Using the Four-Point Garbage Matte Key lets you place the same actor in two locations (or more)
within the same setting.

Obviously this takes some planning. The actor shouldn’t cross the line that divides the set in two, for instance
(you can keyframe the Garbage Matte box edges to accommodate some overlap). The lighting can't change
from one shot to the next, and there can't be any movement in the in the vicinity of the scene’s dividing line.

Using a Difference Matte

Split screens work fine if you can keep your actors from moving across the imaginary line dividing the image or
don’t have more than only a few actors (you can use the Garbage Matte Key on more than two clips but doing so
takes some real planning).

You can resort to the Difference Matte when there is just too much action to neatly divide a scene into a few
Garbage Matte-defined rectangles. The Difference Matte behaves more like a Chroma Key. As with the Garbage
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Matte Key split-screen, the Difference Matte lets you tape an actor working in one spot in the scene and then
tape the same or another actor working in another section at a different time. It doesn't have to be distinctly left
and right sides. And you can have multiple actors.

Here's how it works: Just as you did in your assignment, you use a locked-down camera to avoid any movement,
you tape a scene with a static background, and you create a still image of that scene with no actors present.
Then for each scene shot with an actor, you use the Difference Matte Key to look for differences between the
two scenes (in this case, the presence of an actor) and key-out everything else. What you end up with is the actor
over a transparent background. You can do that for any number of action elements, keying out the background
and keeping the action.

Then you place the static background on Video 1 and layer all the action scenes over it.

If you've seen the Eddie Murphy film Dr. Doolittle 2 (hey, I'm the father of a 9-year-old child), you've seen
technology like this in action. In one scene, they had a couple dozen animals all paying rapt attention to another
animal. Those animals weren't all there at the same time. The production crew filmed them in several takes at
different times and then combined them using technology like the difference matte.

Task: Working with a Difference Matte
Try it out by following these steps:

1. You could use the clips already on the timeline, but it's easier to start fresh. Therefore, clear the timeline
and place the assignment clip on Video 2 (not Video 1).

2. Move the edit line to a section of the clip on Video 2 where there are no actors in the scene. You'll use
that scene for your still image.

3. To create a still image, go to the main menu and select File > Export > Frame. Navigate to the Scratch
Disk file folder, name the image something such as Difference Matte, and click Save. The default
image settings (BMP file) should work fine. This new still image automatically appears in your Project
window. Leave it there for now.

4. Move the CTI Edit line to the point in the clip on Video 2 where the actor moves onscreen.

5. Apply the Difference Matte Key to the clip on Video 2. Click the Settings button, find your newly created
image, and click Open. You're going to use that still image to key out that static background showing
only the actor over a black (transparent) background.

6. Check the Reverse Key box and use the Similarity slider to fine-tune the removal of the background. In a
perfect world, the background would disappear, leaving only the actor. If you are working with a
standard prosumer DV25 camcorder, its less-than-razor sharp images make it difficult to remove all but
the actor. Glitches are common.

7. Trim your assignment clip in the Source screen to the point where your actor enters from the other side
of the scene. Drag that to Video 3.
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8. Apply the Difference Matte to it, and follow the same procedures used in Step 7 to remove the
background.

9. Drag the newly created Difference Matte still image you created in Step 3 on Video 1, and drag its edges
to make it long enough to match the action on the two clips above it.

FIGURE 19.31: Using a Difference Matte on two clips frequently creates jagged edges or gaps in the actor(s) like the
one highlighted here.

Preview your project. You should see something akin to the split screen you worked on earlier. But you'll
probably notice that this is far from a flawless process. As shown in Figure 19.31, sometimes, no matter how you
adjust the Similarity sliders, you’ll still key out parts of your actors.

You probably will have to experiment a lot to find two Similarity settings that allow the actors in both clips to
look reasonably sharp.

Tip: Difference Matte Versus Chroma Key

You can use a Difference Matte to place an actor or object over a background other than the one you shot
on the original set. But that's really the wrong technology for that effect. If you tape actors in front of a static
setting, you probably want to use that setting in the final cut. If you want to place your actors into a different
background, you might as well tape your actors in front of a blue or green screen.

Difference Mattes take a very controlled and simple background to pull off. In most cases, you might want to
stick to split screens or blue/green screens.
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Tip: Improved Matte Key Previews

One way to see a more accurate preview of any matte or other key is to create a bright, solid-color matte
(yes, the terms can be confusing) and place it on Video 1 to use as a temporary background. As a reminder,
to create a solid-color matte, click the New Item button at the bottom of the Project window and select
Color Matte. Select a color, name the matte, and save it. It'll appear in the Project window.
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Alpha channels and mattes round out Adobe Premiere Pro's compositing tools. Graphics frequently have alpha
channels built in. Adobe Premiere Pro "switches on" those alpha channels, creating distinct, easy-to-use
transparencies.

Adobe Premiere Pro has several video effects with alpha channel transparencies built in, as well as some effects
that work only on clips on more than one track.

Matte Keys are yet another way to combine or composite clips. They come in several styles. The most common is
a simple black-and-white graphic. When applied to a clip, it makes portions transparent and other areas opaque.

Q. I placed a graphic I wanted to use as a Track Matte on a sequence, and I used the Motion effect on it to
move it around the screen. But when I applied that graphic to another clip using the Track Matte Key, the
graphic doesn’t move. What’s going on?

A. To get that Track Matte to move—to become a “traveling matte—you need to put the graphic in a separate
sequence that you will later “nest” inside the original sequence. I explain that process in the next module.

Q. I tried using the Difference matte, but when I move the Similarity slider, my actor disappears, not the
background scene. Why?

A. The difference matte is an odd duck. It looks for differences between two images and removes them. But that's
not what you want to do. You want to remove similarities. Therefore, check the Reverse Key box to do just that.
Now when you move the slider, the background should disappear and your actor should remain.

Quiz

1. You have a lovely logo created in Photoshop. How do you give it some sharp, beveled edges and fly it over a
clip of your office exterior?

2. If black areas of an alpha channel are transparent, why is black text on a graphic with an alpha channel
opaque?

3. What's the difference between an Image Matte and a Track Matte?



Adobe Digital Video Curriculum Guide – Module 19 19-39

Adobe Digital Video CURRICULUM GUIDE

Quiz Answers

1. Place it in a video track above your office shot. Open the Transparency Settings dialog box and select Alpha
Channel from the drop-down list. Then apply the Bevel Alpha effect to it. Adjust the Edge Thickness, Light
Angle, Light Color, and Light Intensity settings to suit your needs.

2. The color of the graphic does not set opacity. The color of the alpha channel does. Typically, artists create
graphics and build an alpha channel stencil to match the graphic's borders. In that alpha channel layer, areas
beneath the graphic are white to ensure the graphic remains opaque no matter what color it is.

3. You apply an image matte directly to a clip by clicking that clip's Image Matte Settings box and selecting the
Image Matte graphic file. Track Matte is not as direct. You place that matte clip on a separate video track.
Then you apply the Track Matte Key effect to a clip and select the video track with the matte graphic. You
use track mattes to create traveling or moving mattes. I explain that in the next module.

Exercises

1. Create a four-segment split screen. You can do this by applying a Garbage Matte Key three times, adjusting
its bounding box to display three different corners. Or you can make three mattes with black covering three-
quarters of each one. Then place the same person/object in each quadrant of the same scene.

2. Use Camera View to have one clip move back to one side then spin away to reveal a second clip behind it.
Then move that second clip back to the other side to reveal another clip behind it. You can apply the Motion
effect to keep the “hinges” of each door attached to the side of the screen before twirling the clip off into
the distance. On the other hand, you could use the Swing In or Swing Out transitions. But that would be too
easy, and your custom version will look much better.

3. Use the Strobe Light effect with keyframes on a clip on Video 2 (above another clip) to flash white frames,
black frames, inverse frames (set the Strobe Operator to Difference), and transparent frames showing
through to the clip below. For anything but transparent flashes, set Strobe to Operates on Color Only. For
white, set Strobe Operator to Add or Copy; for Black, use Subtract; and for Inverse, use Difference. To see
through to the lower video track, set Strobe to Makes Layer Transparent. All these parameters are
keyframable.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education
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Module 20

Adobe Premiere Pro Editing Tips, Tricks, and Techniques: Part 1

In this module and the next, I'm going to take things beyond the scope of most Adobe® Premiere® Pro how-to
guides by presenting tips, tricks, and techniques. These are the kinds of tools that experienced editors frequently
use. But if you've never seen them in action, you probably wouldn't come up with them on your own. Once your
students do try them out, they’ll find myriad ways to apply them to their projects.

First up in this module, I’ll cover Adobe Premiere Pro 1.5’s new Project Manager. It was high on the feature list of
many version 1.0 beta testers and is a great way to save only the essential elements of a project. Following that
I’ll offer up six specific uses for nested sequences and present two other practical Adobe Premiere Pro editing
applications.

In the next module, I take you through Adobe Premiere Pro’s most important new video effect: the Color
Corrector. Plus I offer up a couple fun tasks, several keyboard shortcuts, and a collection of expert tips from an
Adobe corporate Premiere Pro evangelist.

At the end of this lesson, students will have learned about:

• Working with the Project Manager

• Highlighting a portion of your clip

• Applying realistic drop shadows to rotating objects

• Working with nested sequences

• Enhancing two effects using nested sequences

• Giving motion to two immovable effects

• Obscuring someone’s identity

• Fine-tuning keys using a nested sequence

Working with the Project Manager

The Project Manager gives you the opportunity to manage the size and organization of assets. You typically start
projects with much more vieo footage than you need. You can use the Project Manager to save your project
using only the footage segments you use. You then can delete or archive the original footage. If you originally
captured the footage at a low resolution, you can use the trimmed project, in conjunction with batch capture, to
recapture the exact footage that you need at a higher quality. Project Manager can also help you organize your
footage by storing all the footage for a particular program in one location.

To see Project Manager at work, select Project > Project Manager. As shown in Figure 20.0, you have two
principal options:

• Create New Trimmed Project –- This lets you save your project, storing only the trimmed footage and
stills you used. This process creates separate files for each of the audio and video segments used in the
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project. You can choose to
include head and tail material in
the new footage files to use as
handles, in case you want to
make minor edits to the footage
later. The new footage retains
the timecode and reel number
of the original captured footage.

• Collect Files and Copy to New
Location –- This lets you
assemble all of your footage
and place it in a single file
folder. This is useful if you have
source footage residing in
different folders and need to
consolidate it all for easy access
and archiving.

Figure 20.0: Use the Project Manager to
save only the portions of the clips you used
in your project or to gather all disparate
assets into one disk location.

To see how the Project Manager works, click the Calculate button at the bottom. That will examine the original
clip file sizes versus the portions of the clips used in the project. If you uncheck the Include Handles box and
recalculate you’ll note a slight drop in the Resulting Project Size.

Selecting the Make Offline option saves only the reel names and timecode of your clip segments. This
significantly reduces the Resulting Project Size. When you re-open such a project, you simply go to the Batch
Capture mode to transfer the clips to your PC. Selecting this option is especially useful if you used low resolution
footage in your original project.

If you select Collect Files you then are given options to Include Preview Files or Include Audio Conform Files.
Preview files are segments of your project that you rendered. Audio Conforming takes place automatically
whenever you import a new clip. Including either of these file types will take up more space in the new saved
project but will speed up your work later.

Highlighting a Portion of Your Clip

Frequently you'll want to draw attention to something within your clip without completely obscuring that
portion of the clip. You might want to apply a graphic or super there or highlight an object or person.

You do that by putting the same clip on Video 1 and Video 2, using an Image or Track Matte Key on the clip on
Video 2 to highlight a portion of the clip, and applying a video effect to the clip on Video 1 to make the matted
section of your clip stand out.
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Task: Highlight a Portion of Your Clip
How you choose to highlight your clip is up to you. You'll see what I mean as I take you through this task. The
fundamental process works for a variety of situations. In this case, I'll go over how to change the color and
sharpness of a portion of your clip so that when you add text, it stands out from the image. Here are the steps:

1. Create a new sequence: select File > New > Sequence, name it Highlight a Clip and click OK.

2. Using the Sample Project that shipped with Adobe Premiere Pro, drag Saleen_Car_10 to Video 1 and to
Video 2 (you can use your own clip: a brief scene—15 seconds or so—that does not have much action in
it). For this effect to work properly, both clips must be lined up, one above the other. Figure 20.1
demonstrates what I mean. Drag the CTI edit line into the clip a bit.

Figure 20.1: To highlight a location on a clip, start the process by placing that clip on both Video 1 and Video 2.

3. I prefer using the Track Matte Key because it works with mattes created in the Title Designer. So, open
the Title Designer (File > New > Title) to create the matte. Click Show Video to see your clip as you
create the matte.

4. In this case, because you later will put text within the highlighted portion of your clip, create a black,
rounded rectangle to define that area—something along the lines of the one shown in Figure 20.2. Save
your title by selecting File > Save, give it a name like Clip Highlight Matte and click Save (that
automatically puts it in the Project window).
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Figure 20.2: A rounded rectangle matte works well to frame text.

Tip: Matte Creation Suggestions

In my example, I used the Rounded Corner Rectangle Tool to create that vertical oval. By default, the Fill
color is black, which works fine. To give it that gray border, I opened Strokes, clicked Add next to Outer
Strokes, set the size to 10, clicked the rectangle next to the word Color to access the Color Picker to pick
gray, and set the Opacity to 50% to let some of the clip show through when I apply the Track Matte Key in a
moment.

5. Drag your matte clip to Video 3 of your sequence and extend it to fit over the clips on Video 1 and 2.
Switch off its display by right-clicking it and un-checking Enable.
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Tip: What’s Going On Here?

The object here is to change the appearance of the clip on Video 1 to have that slightly altered view show
through the matte applied to the clip on Video 2. What you’ll do is blur the clip on Video 1 and change its
color. That tinted, soft focus will let that clip’s action show through but will serve as a relatively non-
distracting backdrop for some text.

6. Switch off the Eyeball on Video 2 so that you can see your work on Video 1.

7. Select the clip on Video 1, and in the Effect Controls window (ECW) apply Fast Blur and Tint to it. As
shown in Figure 20.3, a low blur setting works well. You have two tinting options: You can select a color
to apply to light pixels in your clip and a color to apply to dark pixels. Once these are selected, adjust the
Amount to Tint. The object is to make things look softer without losing some detail. You can make
adjustments later if necessary.

Figure 20.3: Give the clip on Video 1 a slight blur and a different tint to make it stand out when placed inside the
Track Matte Key oval graphic.

8. Turn on the eyeball for Video 2, select the clip on Video 2 and apply the Track Matte Key. As shown in
Figure 20.4, in the ECW set Matte to Video 3, Composite Using Matte Alpha, and click Reverse. That latter
parameter makes the alpha channel in this clip opaque (covering the clip on Video 1) and makes the
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oval and its border transparent, letting the altered clip show through. The end result should look
something like Figure 20.4.

Figure 20.4: Applying the Track Matte Key to the clip on Video 2 cuts a digital “hole” in that clip, letting the blurred
clip on Video 1 show through.

9. Finally, you can add text to this clip by returning to the Title Designer. Using one of the vertical type
tools would work well for this graphic. After creating the text, save it and add it to the sequence on a
track above the two clips. Figure 20.5 shows one example. The blurred clip on Video 1 makes the text
stand out.
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Figure 20.5: Use a Vertical Type Tool to create text for this Track Matte Key.

Applying realistic drop shadows to rotating objects

As I mentioned in Module 12, “Putting Video and Still Clips in Motion,” the Drop Shadow effect does not throw a
realistic shadow when using the Rotation parameter. The shadow “sticks” to the clip, meaning it turns with it as if
it were part of the clip, rather than a real shadow. It’s as if Rotation also moves the position of the sun. You’ll
encounter this any time you create a picture-in-picture or layer a graphic over another clip. Drop shadows are
just about standard for such effects, and if you spin those pics-in-pics, you want those shadows to behave
realistically.

Two effects overcome that minor inconvenience: Transform and Camera View. A third, Basic 3D, works
reasonably well with the Drop Shadow effect, but it does have two issues:

• It doesn’t have rotation as a parameter.

• As you tilt the clip toward the viewer, the shadow remains the same size and shape as the clip. You see
it as a clip-sized rectangle lying behind and parallel to the clip. It does not change size and shape to
match the move.

Applying Drop Shadow to Transform

Rather than a fully fleshed out task, I’ll give you a basic run-through of how to use Drop Shadows with Transform.

Using Figure 20.6 as a reference, I put a color matte on Video 1 and a clip on Video 2. I applied Transform to that
clip, reduced its Scale and used keyframes to have it move across the screen, rotating twice along the way.
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Then I applied the Drop Shadow effect. Now as the clip spins across the screen, the shadow always falls down
and to the right. You do need to apply Drop Shadow after you apply Transform (so it’s below Transform in the
ECW); otherwise, it will stick to the clip just as it does when used with Motion.

Figure 20.6: The Drop Shadow effect creates realistic shadows when used with the Transform effect.
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Using Camera View with Drop Shadow

You use Camera View when you want to simulate a changing clip viewing angle. As shown in Figure 20.7,
updating some parameters distorts the clip shape, giving it perspective. Using the Roll parameter works much
like Rotation in Transform, and the Drop Shadow effect works smoothly with that spinning clip.

Figure 20.7: Camera View also works hand-in-hand with Drop Shadow to create realistic shadows to spinning clips.

The one caveat is that, just as with Basic 3D, as you tilt the clip toward the viewer, the drop shadow starts looking
unrealistic, matching the shape and size of the clip and lying parallel to it.
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One other point: For the Drop Shadow to work, you need to open Camera View’s Setup dialog box and unclick
the Fill Alpha Channel check box.

Working with Nested Sequences

The Nested Sequence concept is new to Adobe Premiere Pro and replaces something called Virtual Clips. Nested
sequences are a huge improvement. I won’t explain Virtual Clips; I’ll only say that all sorts of things could go
wrong with them and they were very confusing. Nested sequences greatly simplify the virtual clip process.

A Nested Sequence is a sequence-in-a-sequence. You can create an entire project segment in one sequence and
drop that sequence—with all its clips, graphics, layers, multiple audio/video tracks, and effects—into another
sequence. There it will look and behave like a single, linked audio/video clip.

You use nested sequences for several reasons:

• To apply an effect or effects to a collection of layered clips. That saves having to do that to each layer or
clip, one at a time.

• To apply more than one transition between clips.

• To build multiple picture-in-picture effects.

• To give motion or apply other effects to immovable effects.

• To reuse sequences or use the same sequence but give it different looks each time.

• To simplify editing by creating complex sequences separately. This helps you avoid running into
conflicts and inadvertently shifting clips on a track that are far from your current work area.

• It's also very helpful organizationally—for the same reason you might create sub-folders in the project
window or in Windows Explorer. It avoids confusion and shortens editing time.

Note: Developer Comment—Our Take on Nested Sequences

They have so many uses that aren't immediately apparent. Not only does this feature enable you to break up
your project into more manageable chunks, it also allows you to treat longer segments as one piece.

A prime example is color correction or other effects. If you want a 2-minute sequence of multiple cuts to
have the same dreamy look or be in black-and-white, for example, rather than apply these effects to the
individual cuts, you would apply the effects to the entire sequence that has been placed in another
sequence.

Once nested, a sequence acts just like a clip, which means you can apply one effect to the entire time span.
And if you want to change the settings, you can do it in one place rather than changing one and then
setting the rest of the clips to the same setting.

I introduced nested sequences back in Module 17, “Using Higher-Level Video Effects.” As a reminder, open the
Sample Project that shipped with Adobe Premiere Pro. In the Saleen_Sample sequence, double-click on the last
clip: Saleen_logo_Layers. That clip is a nested sequence, and double-clicking it adds that sequence to the
Timeline window and switches the view to that sequence. As shown in Figure 20.8, this sequence is simply two
graphic clips.



Adobe Digital Video Curriculum Guide – Module 20 20-11

Adobe Digital Video CURRICULUM GUIDE

Figure 20.8: Double-clicking a nested sequence clip opens its sequence in the Timeline window.

The Sample Project’s editor chose to create this two-layer sequence for a simple reason: to fade to black. To see
that, return to the Saleen_Sample sequence by clicking its tab in the Timeline window. As shown in Figure 20.9,
the last clip, the Saleen_logo_Layers sequence, has the Cross Dissolve transition applied to it. When used at the
end of a piece, it fades the video to black.

Figure 20.9: The highlighted clip, actually a nested sequence, has a Cross Dissolve applied to it—a minor timesaving
step.

If this project’s editor had not used this nested sequence, he would have had to apply the Cross Dissolve to both
clips. In this case, the nested sequence avoided only a minor inconvenience. But I think you get the idea of how
nested sequences can help.

Enhancing Two Effects Using Nested Sequences

In this section, I explain work-arounds for two Adobe Premiere Pro video effects. Both have issues that only a
nested sequence can address:
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• The Echo video effect disables all effects applied above it (before it) in the Effect Controls window.
Frequently you want to apply some other effects before using Echo. For instance, you might want to use
a Key Effect to remove a background before applying the Echo effect. A nested sequence lets you do
that.

• The only way to apply motion to a Track Matte Key is by using a nested sequence. This is critical because
you usually use Track Mattes to make Traveling Mattes—moving screens that, for example, follow action
or obscure someone’s identity.

Task: Giving Echo More Attributes
This can be fairly straightforward, but I’ve extended it a bit
by adding a few housekeeping steps to help with upcoming
tasks. In this task ,you create a new sequence, add a clip,
apply a key effect to it, open that nested sequence clip in
another sequence, and apply Echo to it:

1. To keep things orderly, create a new bin in the
Project window by clicking the Bin button at the
bottom of that window. Name it Nested Sequences.
It shows up in the Project Window and is
automatically selected. This is where you will store
any new sequences.

2. Create a new sequence by selecting File >
New—Sequence. Type in a name—I suggest
Nested Sequence Test—and click OK. As illustrated
in Figure 20.10, because the newly created Nested
Sequences bin was highlighted, this new sequence
shows up in that bin.

Figure 20.10: Click the highlighted Bin button to create a new
bin to store the sequences you will create in the upcoming
tasks.

3. Follow the same process used in Step 2 and create another sequence. Name it Echo Effect Sequence.

4. Take a look at the Timeline window. As shown in Figure 20.11, your new sequence should be open, and
there should be a tab at the top of the window denoting the presence of the other new sequence. The
default new sequence layout is three video and audio tracks plus a master audio track.



Adobe Digital Video Curriculum Guide – Module 20 20-13

Adobe Digital Video CURRICULUM GUIDE

Figure 20.11: As you create new sequences, they show up as tabs in the Timeline window.

5. From the Project window, Sample Media bin, drag Saleen_Car_04 to Video 2 of Echo Effect Sequence
(you will add a color matte to Video 1 in a moment). You can drag both ends to lengthen it a bit.

Tip: Expanding Clip Display—Keyboard Shortcut

You might notice in Figure 20.11 that the Saleen_Car_04 clip fills the length of the Timeline window even
though it’s only five seconds long. That’s because I used the keyboard shortcut ‘\’ (backslash). That
automatically zooms the time scale in the Timeline window to fit the full length of the all the clips on the
sequence—which may shrink or enlarge the current display. In this case, that amounts to one very small clip
taking up the entire sequence display.

6. Create a color matte by clicking the New Item button at the bottom of the Project Window, selecting
Color Matte, selecting a color (bright yellow works well), clicking OK, giving that matte a name, and
clicking OK. Drag that matte from the Project window to Video 1 and extend it to match the length of
the Saleen_Car_04 clip.

7. Apply the Luma Key effect to the Saleen_Car_04 clip. Adjust the Threshold and Cutoff sliders to remove
the black background. As you can see in Figure 20.12, I chose values of 18% and 7%, respectively.
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Figure 20.12: Apply the Luma Key effect to key out the black areas of this clip.

8. Remove the color matte from the sequence by selecting it and pressing Delete. You used it only as a
reference, and you don’t want it showing up in the final project.

9. Switch to the Nested Sequence Test sequence by clicking its tab in the Timeline window.

10. Drag Echo Effect Sequence from the Project window to Video 2. It will have a different label color than
other clips (unless you’ve changed the default color for sequence clips), and it will display as a linked
A/V clip despite the fact that the AVI clip in that sequence has no audio.

Note: Unlink and Remove Audio

You don’t have to remove the silent audio portion of the clip, but it’s helpful to remove useless items. As a
reminder, to delete the audio portion of a linked A/V clip, right-click on the clip, select Unlink Audio and
Video, click in the sequence (but not on the clips) to complete the unlink process, click on the audio portion,
and press the Delete key.

11. Drag Saleen_Car_01 to Video 1. This will be the background for the keyed out areas of the Echo Effect
Sequence clip.

12. Apply Echo to the Echo Effect Sequence nested sequence clip. Finding settings that reveal the clip
while still creating an Echo takes some doing. Use Figure 20.13 as a guide. Preview your work.
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Figure 20.13: Using a nested sequence means that you can key an effect before applying the Echo effect.

Note: Try Some Other Effects

Apply just about any video effect to the original clip in the Echo Effect Sequence. I like Invert. It reverses
color or luminance information, creating a color negative (inverse) effect. Try the HLS (Hue, Lightness, and
Saturation) setting. Make adjustments to the Blend With Original slider. Less than 50% or so creates a
dramatic color shift. Greater than 50% tends to be a more subtle change.

Any changes you make will show up immediately in the clip in the Nested Sequence Test sequence.

Task: Using More Than One Transition at a Time
Adobe Premiere Pro does not permit more than one transition at an edit point. But you can use a nested
sequence if you want more. Here’s how to do that:

1. Create a new sequence by selecting the Nested Sequence bin in the Project window, selecting File >
New > Sequence, naming that sequence Multiple Transitions, and clicking OK.

2. Add two clips to that sequence in the Timeline window. Any two will work, but as long as you have the
Sample Project open, add Saleen_Car_09 and Saleen_Car 10 to Video 1.
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3. Apply an obvious transition to them. I suggest Center Split. For my example, I added a white border to
make the transition look more obvious.

4. Click on the Nested Sequence Test tab in the Timeline window and remove the two clips from the
previous task.

5. Drag the Multiple Transitions sequence clip from the Project window to Video 1.

6. Move the CTI edit line to the center of the transition (you’ll need to watch the clip in the monitor, you
won’t see the transition point in the nested sequence clip).

7. As shown in Figure 20.14, select the Razor tool (keyboard shortcut C) and cut the clip at that point.

Figure 20.14: Create a double transition by razoring a nested sequence clip at the center of an existing transition and
then dropping another transition there.

8. Add an obvious transition here. As shown in Figure 20.15, I went with Center Split again and gave it a
blue border. That gave me a very cool looking, split-in-a-split transition.
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Figure 20.15: Adding the same Center Split transition to an existing Center Split transition leads to this wild effect.

Giving Motion to Two Immovable Effects

Adobe Premiere Pro will not allow you apply any effects, including motion, whenever you use either the
Texturize or the Track Matte Key effects. They effectively switch off all other effects. Nested sequences resolve
that.

Task: Applying Motion (and Other Effects) to Texturize
Texturize works well as a static effect but it has many other interesting possibilities. The only way you can take
advantage of them is by putting the clip you will use to create the texture in a nested sequence. After it’s there,
you can apply any effect to it, including Motion. Here’s how to do that:

1. Just as you did in the two previous tasks, make a new sequence. Name it Texturize.

2. Drag the Saleen_logo_Layers graphic to Video 1 in the Texturize sequence.

3. Apply Motion to it. As shown in Figure 20.16, I scaled it up to 300% and used keyframes to have it move
from the upper left to the lower right.
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Figure 20.16: Apply motion settings to a graphic to prepare to demonstrate another use for a nested sequence:
applying motion or other effects when using the Texturize effect.

4. Click the Nested Sequence Test tab to open it in the Timeline window. Remove all clips, add
Saleen_Car_08 to Video 1, and the Texturize sequence to Video 2.

5. Apply Texturize to the clip in Video 1. As shown in Figure 20.17, set the Texture Layer to Video 2 (the
track with the nested sequence), adjust the light direction for maximum texture, and raise the contrast.
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Figure 20.17: Give Texturize higher contrast to further emphasize a graphic.

6. Play the clip, and note that the logo gives the Saleen car clip a moving, embossed look.

7. Return to the Texturize sequence and apply some other motion or effects to the graphic. Bevel Edges,
for instance, will amplify the embossed effect.

8. Return to the Nested Sequence Test, and note that the new effects show up immediately in the
Saleen_Car_08 clip.

Task: Following Action with Traveling Mattes
This method is an exciting way to focus attention on action. Its methodology is sort of a combination of this
module’s first task, “Highlighting a Portion of Your Clip,” and the previous task, “Applying Motion (and other
Effects) to Texturize.” In this case, you'll use a Track Matte Key to highlight an object in motion.

To accomplish this effect, follow these steps:

1. As you’ve done in previous tasks, make a new sequence. Name this one Traveling Matte.

2. Drag the Saleen_Car_10 clip to Video 1 and extend it to its full length by dragging both edges. The clip
is just shy of 9 seconds long. Move the CTI edit line to a few seconds into the clip so that you can see the
car’s headlights emerging from the fog.

3. Open the Adobe Title Designer by selecting File > New > Title.
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4. As shown in Figure 20.18, switch on Show Video, create a solid-colored) oval such that it covers the car’s
headlights. Choose a color other than black so that you can see it on a black background. As long as it’s
opaque, the color doesn’t matter. Save this title: File > Save. Name it Traveling Matte. Saving it
automatically places it in your Project window.

Figure 20.18: Use the Title Designer to create a traveling matte that will highlight a moving object.

5. Drag the Traveling Matte clip from the Project window to Video 2 of your Traveling Matte sequence.
Extend it to fit completely above the Saleen_Car_10 clip.

6. Now you will apply some motion characteristics to the Traveling Matte sequence to have it follow the
car’s headlights. As shown in Figure 20.19, do that by pressing the Home key to place the CTI on the first
frame, reducing Opacity (so that you can see the headlights), selecting Motion, turning on keyframes for
Position and Scale, and then adjusting the location and the size of the matte to fit the headlights.



Adobe Digital Video Curriculum Guide – Module 20 20-21

Adobe Digital Video CURRICULUM GUIDE

Figure 20.19: Apply motion settings to have the oval move and expand as the headlights move through the scene.

7. Move the CTI into the clip about 5 seconds (just before the car turns to its left) and adjust the Motion
Position and Scale parameters again to match the growing headlights. Doing so will automatically add
new keyframes for those parameters.

8. Move the CTI to the end of the clip (press End and the Left Arrow key). Adjust the Motion settings again.
Remember, you can set Scale to something greater than 100% by typing in a value higher than 100 (the
slider goes only to 100%). You can fine-tune this parameter setting process by adding other points in
the clip, but I think setting three points gives you an idea about how this works.

9. If you want, you can go back to the beginning of the clip and set keyframes for opacity to have the
matte gradually reveal itself over the lights (start at 0% Opacity and climb to 100% as lights appear
through the fog). If not, click the Opacity reset button to put it back to 100% (the oval will switch back to
its solid color).

10. Remove the Saleen_Car_10 clip from Video 1 by selecting it and pressing the Delete key (you had it
there only as a guide for your motion settings).
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11. Open the Nested Sequence Test sequence, remove all clips, add Saleen_Car_10 to Video 1, extend it
to its full length, do that again for Video 2 (you can Copy/Paste as well), and drag the Traveling Matte
sequence from the Project window to Video 3. Your sequence should look like the one in the Timeline
window in Figure 20.20.

12. Right-click the Traveling Matte sequence and uncheck Enable.

13. Select the clip on Video 1, apply the Brightness & Contrast video effect to it, and reduce its Brightness to
about –65%. This will darken the clip while the Track Matte Key will display the headlight portions of the
clip on Video 2 at full brightness.

14. Select the clip on Video 2 and apply the Track Matte Key to it. Set the Matte to Video 3 and Composite
Using to Matte Alpha. Preview your sequence. It should look something like the image in the Monitor
window Program screen in Figure 20.20 (it has an oval highlighting the headlights).

Figure 20.20: How your Track Matte Key sequence should look.
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A Slicker Means to the Same End

As is the case with all things in Adobe Premiere Pro, there is a slightly different, faster (once you get used to it)
way to impart motion to a Track Matte. If your PC is reasonably fast, this approach should work smoothly. Slower
PCs might require a little extra effort, but I recommend you try this, fast PC or not.

The principal difference is that you have both the nested sequence and the final project open in the two Monitor
window screens and do your work there. It saves you a step and demonstrates yet another cool feature of Adobe
Premiere Pro: ganging your Source and Program Monitor window screens. It also takes some reverse thinking
because you will put your project sequence in the Source screen and your original Track Matte graphic clip in the
Program screen.

Task: Creating a Traveling Matte Using Both Monitor Screens
In any event, this is a very slick way to apply effects to a nested sequence and see immediate feedback in the
final project. The process and setup for this method are very similar to the task you just completed. Here’s how
you do it:

1. Use the same two sequences: Traveling Matte and Nested Sequence Test.

2. Place only your Traveling Matte graphic clip in the Traveling Matte sequence on Video 1 (there’s no
need to temporarily use a video clip as a reference for motion settings – you’ll rely on the Monitor
window screens).

3. As before, put the clip you want to apply the Track Matte Key to on Video 1 and Video 2 of the Nested
Sequence Test sequence. And drag the Traveling Matte sequence clip from the Project window to
Video 3 of the Nested Sequence Test sequence.

4. Drag the Nested Sequence Test sequence from the Project window to the Monitor window Source
screen.

5. Select the Traveling Matte sequence in the Timeline window and put the CTI edit line on that
Traveling Matte clip to display it in the Program screen.

6. As shown in Figure 20.21, gang the Program and Source screens together by clicking either the Source
or Program wing menu and selecting Gang Source and Program. With that feature enabled, when you
move the CTI for one window, the CTI in the other window moves in synch.
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Figure 20.21: Gang the Monitor Source and Program screens to help simplify the traveling matte creation process.

7. Select the Traveling Matte clip. In the ECW, select Motion and move, scale, or rotate the clip and add
keyframes as needed. On faster machines, you should see all your Motion attributes display in the
Source window. On slower machines, you might need to drag the CTI a bit to force a screen update.

Obscuring Someone's Identity

This is another use for a traveling matte. You’ve seen those TV programs that hide the identity of a witness or a
suspect by making their faces look like out of focus or like animated mosaics (using black rectangles to cover
eyes—or other body parts—is so old school). They typically use a traveling matte combined with an effect such
as Fast Blur or Crystallize to accomplish that feat.

Take a look at Figure 20.22. Here’s how I obscured that person’s identity (don’t worry; she’s neither a witness nor
a suspect).
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Figure 20.22: Obscure someone's identity by using an oval graphic as a Track Matte Key and the  Mosaic video effect.

1. I used the Title Designer to create an  oval.

2. Just as you did in the previous task, I put it in motion and adjusted its size to match the motion of the
subject.

3. In addition, I applied Fast Blur to it to soften its edges.

4. In a different sequence, I put the video clip on the first two tracks and the traveling matte sequence
(making it a nested sequence) on the third.

5. I applied the Mosaic video effect to the clip on Video 1.
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6. I applied the Track Matte Key to the clip on Video 2, set the Matte to Video 3, and set Composite Using
to Matte Luma or Alpha depending on the color of the oval.

7. Finally, and this is the significant difference between this use of the Track Matte Key and the use in the
task you just completed, I clicked the Reverse check box. That reverses the alpha channels. What that
does is use the clip on Video 2 to obscure the clip on Video 1 with the exception of letting the portion of
Video 1 within the track matte oval show through. That means the Mosaic effect shows only within the
oval.

Tip: A Faster and Easier Alternative

Using Adobe Premiere Pro to create a traveling matte and applying motion settings to it can be relatively
simple if the motion is easy to follow and generally falls on a straight line. Curved or convoluted paths are a
trickier proposition (Premiere Pro 1.5’s new Bezier motion does make that work better). That’s where Adobe
After Effects® shines. The Professional version of that powerful video production tool has a Motion Tracker
that automatically builds a traveling matte path in a matter of moments. I demonstrate that in Module 25,
“Creating Motion Graphics with Adobe After Effects®.”

Fine Tuning Keys Using a Nested Sequence

Keying can be hit or miss. Frequently you'll be hard-pressed to remove pixels near the edges of the subject you
want to key over a background. At other times, hotspots —unevenly lit areas of your green/blue screen—will not
key out. Creating a nested sequence as a means to apply a key twice can help. It's not a guarantee, but it
sometimes can be the difference between unusable and acceptable.

Task: Fine-tune Keys with a Nested Sequence
To fine-tune keys with a nested sequence, follow these steps:

1. Open the Nested Sequence Test sequence you worked on in the “Creating a Traveling Matte Using
Both Monitor Screens” task earlier and remove all clips.

2. Use a clip from assignment No. 1 back in Module 18, "Compositing Part 1: Layering and Keying Clips."
That called for you to tape a subject in front of a solid—and differently colored—backdrop. Drag that
clip to Video 2.

3. Drag any clip that can serve as a background to Video 1.

Tip: A Color Matte Can Make Keying Easier

Instead of a video clip background, consider using a color matte. This gives you a more accurate
representation of how well your key is working. As a reminder, to make a color matte, click the New Item
button in the Project window, select Color Matte, choose a color, give your matte a descriptive name, and
click OK. The matte will appear in your Project window.

4. Apply a color-based key to the clip on Video 2. Your pick: Chroma, RGB Difference, Blue/Green Screen, or
Non-Red.
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5. Use the eyedropper tool to select
the color to key out and then
adjust the slider(s) as well as you
can without impacting the
subject. My example in Figure
20.23 has hotspots that do not
key out without creating a
transparency in the subject. Click
OK.

Figure 20.23: A first-time application of an
RGB key shows hotspots on the green
screen.

Tip: Try Different Keys or a Matte

You might try different keys. RGB
Difference might work better than
Green Screen, depending on how
closely your green screen matches
true chroma green.

Or create a matte to block out the
areas that did not key correctly. For
example, you could use the Title
Designer, switch on Show Video so
you can see where to place the mask
on the screen, and use the Shape tools to build an object or objects to cover up the problem area(s).

6. Remove the background clip.

7. In a different sequence, drag the nested sequence you just created to Video 2, drag the background
color matte to Video 1, and apply a color-based key to the Nested Sequence clip.

8. Once again, adjust the sliders to suit your needs. As shown in Figure 20.24, I managed to fine-tune the
key effect enough to clean up those stray pixels.
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Figure 20.24: Applying the RGB key a second
time to a virtual clip cleans up most of the poorly
keyed portion of the original key.

Tip: Leave Room for the Eyedropper
Tool to Grab a Color

If you carefully adjust Similarity or other
values in the original clip so there is almost
no unkeyed area left, you might not be
able to use the Eyedropper tool in the
nested sequence clip to select a color to
key out. Therefore, go easy on the first
attempt.
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Experienced Adobe Premiere Pro users typically have a few editing tricks up their sleeves. Unless you see them at
work, you might not come up with them yourself. In this module, I've explained two of them: highlighting an
area of your clip using a matte and a couple video effects, and adding realistic drop shadows to rotating clips.

In addition, I explained several uses for nested sequences, taking you through specific tasks that showed you
how to enhance the Echo effect, use multiple transitions at one location, apply motion to the Texturize effect,
follow action and obscure someone’s identity with a Track Matte Key, and to fine-tune chroma keys.

Finally, at the top of this module I presented a new feature in version 1.5 of Premiere Pro: the Project Manager.
It’s a powerful tool that lets you manage the size and organization of your assets. Project Manager lets you trim
your project so that it includes only the clips segments you use.

Q. I used the Track Matte Key with a graphic I made using the Title Designer. My purpose was to highlight
a portion of a clip by putting that area into a soft focus. But it's in sharp focus and the rest of the clip is
blurred. Why?

A. You need to click the Reverse option check box in the Track Matte Key’s display in the ECW. Normally, when
using a graphic with a transparent alpha channel regions (almost always the case for graphics created with the
Title Designer), the graphic elements of your matte are opaque and everything else is transparent. So when you
chose Matte Alpha for the Matte type, that let the clip on Video 1 show through those alpha channel regions.
Selecting Reverse makes the alpha channel regions opaque and the graphic elements transparent, thereby
creating the desired effect.

Q. I put a clip in a sequence, nested that sequence into another, and applied some effects. Later I wanted
to nest that sequence in another part of the project, but I wanted it to look a bit different. So I changed
the clip’s appearance before dragging that sequence to the new location. But now the first nested
sequence clip has changed appearance, too. What's up?

A. Basically you defeated the purpose of nested sequences. When you want to use a nested sequence more than
once, you have to make any changes to it after you apply it to a new sequence. Any changes you make to the
original clip in its sequence will ripple through the project to all instances where you added that sequence to a
project.

Quiz

1. When rotating a clip over another clip, what two effects ensure that Drop Shadow performs realistically?
When do you apply Drop Shadow? Above or below those effects in the ECW?

2. For the Track Matte Key tasks in this module, you used graphics with alpha channels. How would using
simple graphics that don’t have alpha channels be different?
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3. In the traveling matte task, you reduced the brightness on the clip in Track 1 to make the highlighted area
stand out. How can you do that with the track matte graphic itself?
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Quiz Answers

1. Use Drop Shadow with Transform and Camera View to give rotating clips shadows that fall in a same relative
direction. Apply Drop Shadow after Transform (below it in the ECW).

2. You’d need to keep in mind that white portions of your graphic will be opaque and black will be
transparent. Gray areas will have some transparency. And in the ECW, you’d set the Track Matte Key’s
Composite Using parameter to Matte Luma. You can reverse that black/white transparency behavior by
clicking the Reverse check box.

3. When you create a graphic, in either the Title Designer or a graphics editing program, color the entire
graphic gray (In the Title Designer, you can reduce its opacity and use the Matte Alpha setting or keep the
opacity at 100% and use the Matte Luma setting). Then create a black shape you will use for the highlight.
The only caveat here is that if you use Motion or some other effect to reduce the size of the graphic, you will
see that gray area as a rectangle in your clip. The way around that is to make a very large graphic or a smaller
highlighted area that you expand to fit the area of the clip you want to highlight. As I’ve mentioned several
times, Adobe Premiere Pro has so many options, you can almost always find other ways to accomplish the
same tasks.

Exercises

1. Get used to working with nested sequences by creating a quad transition. Apply one transition to a clip.
Drop it in a new sequence, add another transition to it, drop that into another sequence, and so on. With
each additional transition, lengthen the duration by a second or so. As a means to get a clearer picture of
what's going on, choose transitions that have borders and make the borders thick to further emphasize each
transition. When you're done, go back and change the attributes of a couple transitions and see how that
affects the final quad transition.

2. Highlight an area of a clip using a track matte. Then try out a number of different video effects combinations
on the clip on Video 1 as a means to alter it and make it stand out. Conversely, try to make it less prominent
to allow something else—a graphic, logo, or text—to stand out on it. Switch back and forth between using
the Reverse option and not using it.

3. Creating traveling mattes that actually follow action should become part of your standard editing arsenal.
They add some real visual interest to your projects. To gain facility with their creation, make a couple.
Experiment a bit. Change the shape of the matte, give it a soft focus using the Fast Blur effect, and add a
border. Alter the appearance of the highlighted area, use keyframes to fade in that change and fade it out.
Try both traveling matte production methods: working on the matte in the sequence and ganging the
Monitor window screens.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education
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Module 21

Tips, Tricks, and Techniques: Part 2

Adobe® Premiere® Pro's depth lends itself to discovery. Experienced editors frequently stumble across
undocumented editing tricks that fall outside those described in the printed manual and the online help file that
accompany your copy of Adobe Premiere Pro.

For this module's lesson, I've assembled several such tips, tricks, and techniques, including a half dozen favorites
from Adobe’s principal corporate Adobe Premiere Pro evangelist. They should help your students become faster,
more efficient and creative editors.

I also take on a tour of Adobe Premiere Pro’s most important new video effect—the Color Corrector—and its two
narrower-purpose siblings—Broadcast Colors and Color Match. And I show you how to tap the power of another
new and very helpful feature: the Trim window.

At the end of this lesson, students will have learned about:

• Adjusting color—Three Color Correcting Effects

• Working in the Trim window

• Four fun editing techniques

• Five fast editing tips

• Using Timeline window keyboard shortcuts

• Checking out several workspace shortcuts and tools

• Tips from an Adobe corporate Adobe Premiere Pro evangelist

Adjusting Color—Three Color Correcting Effects

The addition of the Color Corrector effect to Adobe Premiere Pro along with its more specialized partners, Color
Match and Broadcast Colors, is a big deal. They are much more than single, narrow-purpose video effects. Rather,
taken together, they are a full-featured suite of tools. The Color Corrector even has its own pre-set workspace.

Open that workspace by selecting Window > Workspace > Color Correction. Your interface should look like
Figure 21.1. Those three graphical displays in the Monitor window are called (in clockwise order starting at the
upper left) Waveform, Vectorscope, and RGB Parade. The one other available option not displayed in this default
view is the YCbCr Parade.
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FIGURE 21.1: Adobe Premiere Pro’s Color Correction workspace puts several new tools and displays at your fingertips.

Tip: Color Correction Alphabet Soup

Venturing into the color correction arena opens up a whole new can of alphabet soup. In the case of the
Reference monitor display options: RGB Parade refers to the Red, Green, and Blue elements used in PC
monitor displays. Y, Cb, and Cr refer to the color mode used by the television industry for digital video. Y is
Luma and Cb and Cr are the Chroma (color) components.

The power and scope of Adobe Premiere Pro’s Color Corrector, Broadcast Colors, and Color Match effects go way
beyond what I can cover in this small section. Entire books are written on color correction. I recommend “Color
Correction for Digital Video” by Steve Hullfish and Jaime Fowler. If you become adept at the various color
correction features, you can turn those skills into a marketable commodity. Good colorists command substantial
salaries.
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I don’t think of these effects solely as means to correct something. They are also color adjusters. You can use the
Color Corrector to set a mood and Color Match to ensure a project has a consistent look as you go from one
scene to the next. What follows is a basic overview of how they work.

Using the Broadcast Colors Effect

Consumer TV sets cannot handle the same luminance (brightness) as PC monitors. To compensate for that, some
video editors apply the Broadcast Colors effect to selected clips or their entire project.

Tip: Applying an Effect to More Than One Clip

To apply the Broadcast Colors effect (or any other video effect) to more than one clip or even an entire
project, use a nested sequence. Assemble your clips in one sequence and nest it into another sequence
where it’ll appear as a single clip. Then apply the effect to it.

You might not ever need to do this. Most TV stations have built-in limiters and other electronic gear designed to
compensate for luminance problems. But in case you do need to keep your videos within broadcast
specifications, give Broadcast Colors a try.

Task: Try Out Broadcast Colors
I applied Broadcast Colors to the clip in Figure 21.2. Here’s how to duplicate that process:

1. Opening the Color Corrector workspace puts a Reference monitor in the Monitor window Source
screen. Switch to its Waveform view by clicking that monitor’s wing menu and selecting Waveform.

2. Gang the Reference monitor to the Program screen by clicking the Source screen wing menu and
selecting Gang to Program Monitor. That way, when you move the CTI in your clip, the Reference
monitor will display the selected frame’s waveform.

3. Move the CTI somewhere inside your clip and note how the Waveform changes. In my case, the vertical
shafts of sunlight on the left show up on the left side of the Waveform. Even the white blaze on the
horse’s nose creates a luminance peak.

Note: Luminance Values

Typically, NTSC Luminance values should run from 7.5 (dark areas) to 100 (bright areas) IRE (Institute of
Radio Engineers—yes, Radio) units. Japan’s implementation of NTSC allows for darker blacks, and it starts at
zero IRE units. Most DV typically peaks closer to 120—the maximum possible transmission amplitude. 110 is
the default value in the Broadcast Colors effect.
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FIGURE 21.2: The Waveform display gives a graphical representation of the luminance values of your video. The
Broadcast Colors effect lets you reduce the maximum luminance as well as de-saturate colors.

4. Apply the Broadcast Colors effect to this clip. As shown in Figure 21.2, you select either PAL or NTSC as
well as a few other features. Rather then enumerate them, I suggest you read about them in Adobe
Premiere Pro’s online help file. Select Help > Contents, navigate to Applying Effects and Video Effects,
and then select Broadcast Colors.

5. Change the Maximum Signal slider, and note that as you drop that amount, the clip takes on a duller
cast. Selecting the Reduce Saturation option makes it even less colorful.

Creating a Consistent Look With Color Match

This is a great means to avoid horrible color shifts common to video projects. Even the best lighting technicians
cannot ensure that all scenes will have the same color temperature.

Fluorescent lights are notorious for giving off varying hues of green. Incandescent bulbs look orange. Sunlight is
blue. And mercury vapor lamps are yellow. Use the Color Match effect to make all these scenes look as if they
had the same lighting (that is, if that’s the desired outcome).

Task: Testing Color Match
Figure 21.3 is the typical setup for the Color Match effect. Once arranged, the color match process can become a
bit tricky and takes some trial and error. My goal here simply is to get you started:

1. Place the clip you want to fix and the one you want to match it to on your sequence.

2. Un-gang the Reference monitor so you can cue up the Master clip independently of the clip needing
repair. Do that by opening the Source screen wing menu and un-checking Gang to Program Monitor.

3. Using that same menu, set the screen display to Composite so you can see the clip instead of the
Waveform.

4. Drag the CTI edit line in the Source screen to the frame you want to use as a reference.
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FIGURE 21.3: The Color Match effect allows you to give scenes shot in different lighting conditions a consistent color
cast. In this case I use the pink jacket as a reference color since it’s in both clips.

5. Select the clip you want to fix, move the CTI to the frame with subjects that have colors you can match
with the reference clip, and apply Color Match to that clip.

6. Expand the ECW Color Match view. This is where the experimentation begins. Basically you can match
using HSL (Hue, Saturation, and Luminance), RGB (Red, Green, Blue), or Curves (in this case, simplified
versions of complex multi-point defined curves found in the Color Corrector). You use the eyedropper
tools to select reference colors from the Sample frame (the Source screen) and use the Target
eyedropper tools to select colors to match for each instance in the clip you want to fix (in the Program
screen).

Venturing Into Color Correction

This is the real workhorse of this trio. It has more than 40 parameters and sub-parameters. I can’t begin to cover
them all. It introduces concepts like Pedestal (akin to Brightness), HSL Hue Offsets (Circular tools to adjust colors
in shadows, midtones and highlights), and Curves (graphical displays of Red, Green, and Blue curves with user-
added points for more precise control).

For brief explanations of most of the parameters, read Adobe Premiere Pro’s online help section: Help >
Contents, select Applying Effects, Video Effects Included with Adobe Premiere Pro, and then select Color
Corrector.

You apply Color Corrector to a single clip or a nested sequence. Figure 21.4 gives you a taste of its features.



Adobe Digital Video Curriculum Guide – Module 21 21-6

Adobe Digital Video CURRICULUM GUIDE

FIGURE 21.4: The Color Corrector is a powerful tool in Adobe Premiere Pro that opens up a wide range of possibilities
but takes a real commitment from the user.

I will give you a brief rundown of some of the elements displayed in Figure 21.4:

• I set the Reference Monitor to display the Vectorgraph, Waveform, and RGB Parade. As I make changes
in the Color Corrector, those displays update in real time.

Tip: Developer Comment—Two Sequence Views

This tip is from Adobe’s Premiere Pro corporate evangelist, Daniel Brown. He provides five more tips in this
Module’s concluding section.

Using the Reference Monitor can give you two different views of the same timeline. This was created
primarily to let you see a vector scope in one window while you see straight video footage in the other
window, but you can have two video sources as well. As described earlier in the Color Match effect section, if
you want to match colors across different parts of the timeline, this is tremendously helpful.
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• Split Screen Preview—this is darned near essential. As you make changes, you can see the before and
after in the Program screen.

• Black/White Balance—In a normal workflow, these will likely be your first, and perhaps only
adjustments. They work extremely well. Drag each eyedropper in turn to locations in your clip that you
determine best represent Black, Gray, and White. When done, even scenes shot under fluorescent lights
can match sunlit locales.

Tip: Avoid Instant Color Updating

As you drag the eyedroppers around, the colors in your clip update instantly. In the split screen, that can be
good visual feedback, letting you know how things will look depending on your selections. But if you want
to turn off that constant color shifting, hold down the Shift key while dragging the eyedropper tool around.

• Brightness, Contrast, and Gamma—These might be the other most used controls. You can find them
under the HSL and RGB sections.

• Tonal Range Definition—This group of parameters lets you define shadow and highlight zones using
sliders and a visual representation of those regions. As shown in Figure 21.5, switch on the Tonal Range
Definition Preview. The Program screen displays black for shadows, white for highlights, and gray for
midtones. As you move the sliders, those zones expand or contract accordingly. This comes in real
handy when working the HSL Hue Offsets (next point).

FIGURE 21.5: With the Tonal Range Definition Preview on, it’s a simple matter to define the highlight and shadow
regions of your clip.



Adobe Digital Video Curriculum Guide – Module 21 21-8

Adobe Digital Video CURRICULUM GUIDE

• HSL Hue Offsets—These color circles allow you to change the clip’s overall color value in addition to
letting you adjust colors in shadows, midtones, and highlights. To make the adjustments, click on a
color wheel’s center point and drag in the direction of the desired color. The longer the line, the greater
the color intensity.

• Curves—These let you individually adjust the Red, Green, and Blue color channels as well as the overall
color intensity.

I’m barely tapping the Color Corrector’s potential. To go beyond this introduction, I suggest you work with it.
Start simple by using Black/White Balance to fix improperly lighted or color-balanced scenes. Then create a
visual mood for a project. Give your clips a warmer, richer look by increasing the Red values and contrast. Or
attempt to duplicate the Saleen clips’ green/blue cast.

Working in the Trim Window

The Trim window is yet another very helpful addition to
Adobe Premiere Pro. It allows you to fine-tune edits in a
sequence, performing either Rolling or Ripple edits with
great precision and immediate visual feedback.

Note: Rolling and Rippling Reminder

As a reminder, Rolling edits do not change the length
of your project. They take place at an edit point
between two clips: shortening one and lengthening
the other. Ripple edits do change the length of your
project. You apply them to only one clip. Then the rest
of the project slides over to accommodate the change.

Open the Trim window by clicking the Trim button in the
lower right corner of the Monitor window Program screen
(keyboard shortcut—Ctrl+T). I’ve circled it in Figure 21.6.

FIGURE 21.6: Open the Trim window by clicking the
highlighted Trim button in the Monitor window.

Caution: Select a Target Track

When you attempt to open the Trim window, you might receive this error message: “Target track must not
be empty.” To open the Trim window, you need to tell it what video track you’re working in. Do that by
clicking on a track’s name. And that track has to have at least a clip in it.
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Take a look at the Trim window in Figures 21.7 and 21.8. I will give you two views as a means to explain what it
can do. The first will go over some basic clip navigation and Rolling edits. The second will display Ripple edits.

FIGURE 21.7: The Trim window’s clip navigation and Rolling edit tools.

When you open the Trim window, the CTI edit line jumps to the nearest edit point. The two Trim window screens
display the last frame of the clip to the left of edit point and the first frame of the clip to the right.

To move to other edit points, use the edit navigation buttons (annotated in Figure 21.7) or the keyboard
shortcuts: Page Down for the next edit, Page Up for the previous edit.

Trim Window Rolling Edits

As shown in Figure 21.7, there are five ways to perform a Rolling edit:

1. Move your cursor between the two clip windows. It turns into a Rolling edit tool. Simply drag it left or
right and note the changes in real-time in the two screens.

2. Change the center time code by dragging it or typing in a new value.

3. Shift the edit point one or five frames left or right by clicking on the associated number.

4. Type in the number of frames you want to shift the edit point in the center boxed number. Use a
negative number to shift left.

5. Drag the center jog disk left or right.

Trim Window Ripple Edits

Take a look at Figure 21.8. There are also five ways to make Ripple edits:

1. Move your cursor next to or on either clip. It turns into a Ripple edit tool. Drag it to the left or right
accordingly and note the changing out- or in-point for that clip.
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2. Change the left or right clip’s time code by dragging it or typing in a new value.

3. Drag the in- our out-point bracket on either clip’s mini-timeline.

4. Change the left or right time code shift by dragging it or typing in a new value.

5. Use the left or right jog disk to make the edit.

Once you make your edit, you can preview it in the Trim window. Simply use the Play button. Clicking the Loop
button, then the Play button, will loop the edit.

FIGURE 21.8: The Trim windows also offers five means to make Ripple edits.

Four Fun Editing Techniques

There’s no real way to categorize these techniques. They are just some of the little editing tidbits one picks up
over the years. I’ll show you how to fix a slanted scene, produce true mirrored effects, use the razor tool with
effects, and create animated text.

Fixing a Slanted Scene

Even the best-planned productions can go awry. One common mistake is a tripod that wasn't quite level, or the
perspective in a scene looks cockeyed. Fortunately, a simple fix is available. Use the Motion effect to set things
right. As shown in Figure 21.9, switch on the Motion effect for that clip, use rotation to align it properly, and then
scale it up just enough to fill the gaps in the corners created by the rotation.
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FIGURE 21.9: Use the Motion effect Rotation and Scale parameters to fix an askew scene (I added the yellow line to
emphasize the scene slant).

Creating Real, Animated Mirrored Effects

Adobe Premiere Pro has a Mirror video effect. So why bother trying some other way to create a mirrored effect?
Because the method I’m about to describe uses an entire clip while the Mirror effect divides a clip along a user-
defined line and creates a reflection of that portion of the clip.
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In addition, using the upcoming mirror method lets you add mirrored animation to a graphic.

First, try a simple approach. Take a look at Figure 21.10. Here’s how to create that:

1. Place the same clip on Video 1 and Video 2

2. Apply Basic 3D to one of the clips (I chose the one on Video 2) and set its Swivel parameter to 180
degrees (minus or plus—it doesn’t matter). That creates a reverse—mirrored—image.

3. Use Motion’s Scale parameter on both clips to shrink them to 50%.

4. Use Motion’s Position parameter to place the two clips side by side, creating a true, mirrored effect
using the entire (albeit smaller) clip.

FIGURE 21.10: A full-clip mirror effect created using Basic 3D and the Motion effect.
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Now for the trickier mirrored animation effect that displays two graphics spinning in opposite directions. Take a
look at Figure 21.11. Here’s how I set that up:

1. Place a clip to use as a background on Video 1.

2. Place the graphic you want to use above that clip on Video 2 and Video 3.

FIGURE 21.11: Use Motion’s Rotation parameter to rotate the graphics in opposite directions.

Note: Centered Graphics Are Easier

I pulled out a chestnut for this demo: the ubiquitous Veloman graphic from the Adobe Premiere 6 sample
media assets. I chose this because the Veloman graphic is centered in its frame, thereby allowing me to
rotate it without having to make some tricky adjustments.

If I had used the Saleen Logo (it’s slightly above the frame’s center point), for instance, I’d need to apply the
Transform effect and carefully adjust that graphic’s anchor point and position to get that logo to rotate on
its center. If that anchor point were slightly off center, the graphic would revolve around that anchor point
like a ball on a string.

3. Use Motion’s Position parameter to place the graphics in the upper and lower right corners.

4. As shown in Figure 21.11, I set Basic 3D’s Tilt parameter to 180 degrees to flip the bottom graphic
upside down, creating a mirror image of the graphic above it.
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5. I apply keyframes and Rotation to both clips, giving one clip a positive spin and the other an equal but
negative rotation value. Now they spin in opposite directions, further reinforcing their mirrored
appearance.

6. You can take this approach one step further. Use Keyframes and the Position parameter to roll the
graphics across the screen.

Using the Razor Tool With Effects

Keyframes allow smooth changes to an effect. To create sudden shifts or to start an effect mid-clip, use the Razor
tool to slice a clip into smaller chunks and apply different effects or effect parameters to each segment. Here are
some uses:

Apply the same effect to each clip chunk, and give each instance drastically different characteristics. Use this
method to make quick shifts in color or quick changes from inverted images back to positive. As I demonstrated
in Module 10, “Advanced Editing Techniques and Workspace Tools,” the same razor-sliced clip approach works
to make abrupt or smooth transitions from a full-motion clip to fast, slow, or reverse motion.

Note: Slicing Leaves No Visible Wounds

Such slices do not leave any gaps in the clip, nor are they visible to viewers. With no effects applied, it
appears the sliced clip is actually intact.

Abrupt changes work well when you want to draw attention to movement. Consider a gymnast's floor exercise.
Just before a twisting flip, slice the clip and place slow motion on the flip. Or you could gradually slow down a
horserace photo finish. As the thoroughbreds pound down the straightaway, make two or three razor slices,
gradually slowing the motion in each segment.

Note: No Video Effect Bypass

Unlike Audio effects, Adobe Premiere Pro Video effects do not have a keyframable bypass option. That is,
you cannot turn on or turn off an effect at selected points in a clip. In addition, most effects start at least
partially on, so you can’t apply them with a zero-parameter state and then use keyframes to switch on a
parameter. Thus the need to use the Razor tool.

Creating Animated Text

Another use for the Motion effect is to give text some zest. For this example, I used the Title Designer to create
some large font text and placed that in a rounded rectangle backdrop.

Tip: Create Title Elements in Any Order

Whether you make the background graphic first or last is not critical. To place it "behind" the text, select
Title, Arrange, Send to Back (from the main menu bar).
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Place your text on Video 2, and place a background on Video 1. I chose a color matte.

As shown in Figure 21.12, I applied the Motion effect Rotation and Scale parameters to the title. In this case, I
chose to duplicate that old newsreel effect of a spinning title appearing from a great distance, zooming to full
screen (or beyond), and then zooming off the page. I also use the Camera View to spin the text like a top.

FIGURE 21.12: Apply motion settings to your text for a dramatic effect.

Five Fast Editing Tips

In this section, I’ll give you a quick run-through of some easy and effective editing ideas on setting keyframes,
tinting clips, working with still images, fixing “noisy” video, and using multiple transparencies.

Set Your Ending Keyframe First

When using keyframes with effects, your workflow will go more smoothly if you think in terms of how you want
the effect to end (it doesn’t have to be the clip’s last frame). Move the CTI edit line to that point (either in the
ECW mini-timeline window or in your sequence) and switch on Keyframes by clicking the little stopwatch icon in
the Effect Controls window.

Now set that effect’s ending condition. Move the CTI to where you want the effect to start and work your way
toward that concluding keyframe.
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Using Title Designer for Tinting

Adobe Premiere Pro’s Tint video effect does a fine job of creating a two-tone tint. But consider using Adobe
Premiere Pro's Title Designer to take a different, single, or massively multihued, approach.

Task: Create a Unique Tint with the Title Designer
Follow these steps:

1. As I've illustrated in Figure 21.13, open the Title Designer and create a rectangle that goes well to the
edges of the Title window to ensure it entirely covers a clip.

2. Create a color matte. Open Fill and select a fill type. Solid will give you a single color tint, whereas 4
Color Gradient creates a rainbow effect. Couple the latter with a twisting, contorted video effect, and it's
the ’60s all over again. Click the Show Video check box to see how your clip works with this gradient.

3. Adjust the Opacity settings for each Color Stop to customize your matte further. Or, you can save this
color rectangle at full 100% opacity and use the Opacity effect to change its overall transparency later.

FIGURE 21.13: Use Premiere's Title Designer to create color mattes to tint your clips.
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Working With Still Images

As I mentioned in Module 12, “Putting Video and Still Clips in Motion,” Adobe Premiere Pro’s Motion effect is a
really effective way to make a static shot more interesting. Here are a few tips to consider when working with
still:

• If you plan to zoom or pan, then set you scanner resolution at something greater than the standard 72
dpi (dots per inch) TV screen display. That way, when you zoom in, the image will remain crisp.

• Scan some images twice. Use one for your wide shot and the other for a tight shot. You can place them
side-by-side on the timeline and do a cross-dissolve between them. Use motion settings to zoom in on
each, but add a pause at the beginning on the tight shot to let the dissolve finish before starting the
zoom.

• Consider putting a frame around your image. The easy way is to use the Clip video effect and dragging
in the edges a bit and giving that border a color. If you don’t want to cut off the edges, place a color
matte on the track below the clip and use the Motion effect Scale parameter to shrink the clip slightly.
You can create a series of clips like this on a sequence, nest that sequence in another sequence, cut it up
into each individual image, stack them on video tracks, and create a pictures-in-a picture effect.

Reducing Noise in Low-Light Clips

Video shot in low-light conditions typically looks "noisy." There are a few tricks you can use to try and fix that:

• Adjust the contrast and brightness.

• Use the slider controls below the histogram in the Levels video effect to increase shadows and
highlights.

• Try using the Color Balance video effect to boost Red values a bit.

Using Multiple Transparencies

In previous versions of Premiere, you could apply only one type of transparency to a clip. Now you can stack
multiple transparency effects. This is a slick way to create a transparent alpha channel in an otherwise opaque
video clip.

Using a video clip from your Keying Effects exercises, apply a color key effect to it to make part of the clip
transparent, apply the Alpha Adjust video effect to it, and then invert the alpha channel. That will make the
otherwise opaque portion of your clip transparent.

Timeline Window Keyboard Shortcuts

Adobe Premiere Pro has more keyboard shortcuts than you can use, much less memorize. And you can create
dozens more while customizing existing ones. To get an idea of just how vast the shortcut opportunities are
select Edit > Keyboard Customization. That will open the dialog box shown in Figure 21.14.
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FIGURE 21.14: The Keyboard Customization dialog lets you create shortcuts for just about any function in Adobe
Premiere Pro.

Note that the default view listing reflects the main menu options. That is: File, Edit, Project, etc. You can open
each of those lists and find commands that match virtually everything available in the main menu.

Many mimic standard Windows shortcuts: Save=Ctrl+S, Copy=Ctrl+C, and Undo=Ctrl+Z. Some take far too much
effort. For instance, when in the Monitor window Source screen, you frequently want to target a track for an
overlay or insert edit. The keyboard “shortcut” to target the track above the current targeted track is:
Ctrl+Shift+=. It’s a heck of lot easier simply to click on the targeted track’s name.

That said, there are about a dozen shortcuts I use all the time. To see a bunch of them, as shown in Figure 21.15,
click the Keyboard Customization drop-down list and select Tools.
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FIGURE 21.15: The Tools keyboard shortcuts are all single letters. The reason: you will use them frequently.

Note that all the Tools shortcuts are single letters. The reason is obvious. You will use most of them frequently. At
the very least: Selection (V), Ripple Edit (B), Rolling Edit (N), and Razor(C) should be engrained in your brain.

Caution: Editing Keyboard Shortcuts

Feel free to change these shortcuts. Simply click on the existing shortcut letter or keystroke-combination (or
the blank space next to a command that doesn’t have an assigned shortcut), to highlight it, click again, then
type in your customized shortcut. But be aware that other Adobe Premiere Pro functions have shortcuts and
that your new one might match an existing one. As shown in Figure 21.16, if that’s the case, Adobe Premiere
Pro lets you know and gives you a chance to opt out.
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FIGURE 21.16: Changing a shortcut frequently
means stealing an existing shortcut. Adobe
Premiere Pro warns you and lets you click Undo
if you want to rethink that change.

Timeline Window Shortcuts

Most of your work takes place in the Timeline window. In no time at all, the following shortcuts will become
second nature to you:

The backslash (\) key —This is my most frequently used keyboard shortcut. Pressing the backslash key resizes
the timeline to display your entire project. It's a great way to get a handle on where you are in the workflow.

Tip: Slash Confusion

By the way, don’t confuse the backslash (\) with the forward slash (/). Previous versions of Adobe Premiere
used the forward slash to delete some clips. In Adobe Premiere Pro’s default collection of keyboard
shortcuts, the forward slash key is unassigned. You might want to use it as one of your customized shortcuts.

Playback Controls—J, K, and L keys are great shortcuts. Normally, when working in the timeline, you play your
project by pressing the space bar. That's fine, but J, K, and L give you much more control.

The J key plays your project in reverse, the K key stops playback (as does pressing the space bar), and the L key
plays your project forward. What makes these shortcuts truly great is that pressing J or L two or three times
incrementally speeds up playback.

The Home and End keys—When you're in the timeline window and don’t have a clip selected, pressing the
Home key places the edit line at the first frame of your project. Pressing End instantly moves the cursor to the
last frame. Alternately, if you have a clip selected, Home and End move to the beginning and end of that clip,
respectively.

Add Marker—While you're playing the timeline, pressing the asterisk (*) key on the numeric keypad (not
Shift+8) adds a marker to the timeline. If you created a music video in Module 14, "Editing Audio," then you used
the asterisk key. It marks in-points on the timeline for each clip from a storyboard. I'll cover markers in more
detail when going over exporting your project to a DVD or for use on the Internet.

Snap-to-Edges—If Snap-to-Edges is not on (if the little two-pronged icon in the upper left corner of the
Timeline window is not highlighted), then pressing the ‘S’ key, even while dragging a clip, will switch it on.

Note: CTI Does Not Snap

The CTI does not snap to items. Items snap to it. The reason: If it did snap to edit points, scrubbing the
sequence would become a jumpy mess.

Work Area Bar End Points—ALT+[ and ALT+] set the work area bar ends. (I’ve highlighted the work area bar in
Figure 21.17). If you want to render a part of your project (you might do that to smooth playback of a complex
section), then you need to set the beginning and end of that section. Pressing Alt+[ sets the beginning to
wherever the CTI edit line is. Alt+] sets the end. Note: Double-clicking the work area bar sets the bar ends to the
visible area of the sequence. You can simply drag the ends of the bar to those points as well.
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FIGURE 21.17: Use Alt+[ and Alt+] to set the beginning and end points of the work area bar.

Temporarily Unlink Audio and Video—Press the Alt key as you click on the end of the audio or video portion
of a linked clip and you can drag that end to make a ‘J’ or an ‘L’ edit. This saves the right-click/unlinking process,
and if you drag the ends and not the entire segment, you won’t make the audio and video get out of synch.

Move to the in or out of a selected clip—Use the Page Up key to jump to the previous edit and Page Down to
jump to the next edit (the beginning of the next clip or the end of the current clip). This applies to all clips on all
tracks. So if you have many clips with outpoints that don’t line up, this will move through them one at a time.

Jump to a specific timecode—Use the numeric keypad (number lock needs to be switched on), enter a
timecode, and press Enter. If you use a whole number, Adobe Premiere Pro will divide that by your project’s
frames per second, then by 60, and down the line to make minutes, seconds, etc. Or if you type in numbers
separated by periods (use the keypad’s decimal key), Adobe Premiere Pro will consider them as
hours:minutes:seconds:frames.

Entering a '+' and then numbers from the numeric keypad will jump forward the entered amount. Entering a '-'
and then numbers from the numeric keypad will jump backward the entered amount.

Note: Developer Comment—Unassignable Keys

The +/- keys in the Keypad area are unassignable as shortcut keys by design. These keys and all numeric
keypad keys (0-9) need to be unassignable to guarantee that you can reliably enter timecode values (or
timecode deltas using the +/- prior to the timecode value) when the sequence has focus (when it’s active).
As you enter new timecode values via the keypad while the Timeline window has focus, you will see your
numeric values display in the CTI Position timecode control in the top left corner of the Timeline window.

Checking Out Several Workspace Shortcuts and Tools

While much of your work takes place in the Timeline window, you will venture to other user interface locations.
Here are a few more shortcuts and nifty tools that I think will make your work go faster and more smoothly.

Hide/Show palettes—A great way to quickly free up desktop space or access a palette is the Tab key. Use it to
display or conceal so-called floating windows. Those are the Tools, Info, and History palettes. For this to work,
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you need to have had them open at some time and used the Tab key to hide them. If you close one (or more) by
clicking the little ‘x’ in the upper right corner, that disables the Tab shortcut for that palette.

Horizontal Tool palette—As long as you’re cleaning up the user interface, flip the Tools palette to a horizontal
view by right-clicking an empty space around the tools and selecting Arrange Horizontal.

Snap to Keyframes in the ECW—This is a very slick tool. Hold down the Shift key as you move the CTI in the
Effect Controls window and it’ll snap to any keyframes you’ve applied.

Open sequences in the Source screen—This is a very nifty way to trim a nested sequence. Hold down the Ctrl
key as you double-click a sequence or collection of sequences and it or they will open in the Monitor window
Source screen. This is a great way to trim a sequence before nesting it in another sequence.

Marquee Selection—In previous versions of Premiere, a separate tool—Range Select—was required to select
more than one clip in a sequence, a so-called Marquee Selection. One of the design goals of the Adobe Premiere
Pro team was to reduce the number of tools so that editors could perform the most common editing tasks with
the Selection tool (shortcut ‘V’). To select more than one contiguous clip on single or multiple tracks, use the
Selection tool to click and drag from an empty area in the sequence and create a bounding box around the clips.
If there is no empty space visible, use the vertical scroll bars on the right side of the Timeline window.

Import Folders—Instead of importing a file or collection of files, Adobe Premiere Pro now allows you to import
an entire folder. If you’ve used folders to organize your media assets, this is a nice little time-saver. When you
launch the Import dialog (File > Import), you’ll see an Import Folder button in the lower right corner. Selecting a
folder and then clicking that button creates a bin in the Project window with the exact folder name and imports
the associated files.

Program screen draft mode—If you open the wing-menu in the upper right corner of the Monitor window,
you’ll note three related options: Highest Quality, Draft Quality, and Automatic Quality. These refer to the
playback display quality in the Program screen. Draft mode displays to the desktop at 1/4 resolution, whether or
not you have rendered. If you use Automatic resolution, then rendered material is displayed at full resolution
and unrendered material is displayed at 1/4 resolution. In High, everything is rendered at full resolution,
rendered or not.

Staying centered while zooming—Note that when zooming in on a sequence, Adobe Premiere Pro always
attempts to center the CTI edit line. This is a welcome addition to Adobe Premiere Pro. In previous versions,
Adobe Premiere would ignore the position of the play head and attempt to zoom into different areas, forcing
you to find the play head.
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Tips from an Adobe Corporate Adobe Premiere Pro
Evangelist

From database integration for AT&T to digital image retouching and
graphic design for advertisements in Newsweek and Time, Daniel Brown has
balanced a passion for right- and left-brain abilities. Daniel formed the Web
development team at Metagraphics in Palo Alto, California, (now
Artmachine.com) with clients such as Apple, Netscape, Sun, Silicon
Graphics, and Hewlett Packard.

Daniel Brown, Senior Evangelist, DV/Motion Graphics, Adobe Systems, Inc.

In 1998, Daniel joined Adobe Systems in the role of "evangelist," lending a hand in product development,
marketing, interface design, and customer education. He is a frequent speaker at industry events worldwide and
has taught classes at Santa Fe Digital Workshops, Anderson Ranch in Aspen, Colorado, and the Pacific Imaging
Center in Makawao, Hawaii. Daniel currently handles Adobe After Effects®, Adobe Premiere, and Adobe
LiveMotion.

Here are five of Brown's favorite Adobe Premiere Pro tips:

Title Designer External Monitor Preview—Take a look at Figure 21.18. Clicking the circled button will display
the Title Designer window in any video device attached to your PC. Many times text looks different on a TV
versus your PC’s monitor so this can be very helpful.

This is a vast improvement over previous versions of Premiere. Before, you had to click after every editing
change. In Adobe Premiere 6.5, the "Preview" option was simply a "send frame to firewire" command. Hence, you
couldn't design in real-time on an external monitor. Now, once the check box is on, you see the results of your
edits all the time.
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FIGURE 21.18: Use the Send Frame to External Monitor button to view your work in real-time on any TV or monitor
connected to your PC.

Using the Project-Archive folder—If you accidentally erase or completely mess up a project file, don't panic.
Every time you save a project, Adobe Premiere Pro saves over the file you're currently working on, but it will also
save a copy of the previous version in its Auto-Save folder. Depending on the installation, it may be in your
Documents folder (see Figure 21.35) or the folder that holds the actual application.

Project files are tiny compared to video files, and they're worth any extra disk space they occupy. To specify how
many versions of a single project Adobe Premiere Pro will archive, select Edit > Preferences—Auto Save to open
the dialog box shown in figure 21.19.

To restore an archived project, select File > Open and then navigate to the Project-Archive folder and select a
project.
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FIGURE 21.19: Use this dialog box to set how many versions of your project Adobe Premiere Pro will archive.

Adding multiple clips to the Source screen—You can select multiple clips in the Project window, drag them to
the Source window, and, as illustrated in Figure 21.20, choose from among them in the drop-down menu. To
clear the active clip from that Source window drop-down menu, press Crtl+Backspace. This will delete the
currently visible clip and move the others up the list.
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FIGURE 21.20: Drag several clips to the
Monitor window Source screen and then
access them using this drop-down list.

Re-use clips from another project—In
previous versions of Premiere, if you
wanted to use the same collection of
clips in another project, you could export
a Project window’s bin data to a text file.
That’s no longer the case.

That’s still essentially true, but
completely different. Now, rather than
Export what you want, you simply import
the other Adobe Premiere Pro project.
This will bring in all clips, on- or off-line,
and import the timeline as a sequence
within the new project.

This is a great way to "merge" Adobe
Premiere 6.5 projects with Adobe
Premiere Pro projects. But I'd
recommend converting the older
projects to Adobe Premiere Pro first, and
then importing them into one another.

Using a master clip—Double-clicking a
trimmed clip in the timeline will open
that original, full-length clip in the
Monitor window Source screen with the
current clip's in- and out-points displayed. Using the Source screen, you can shift those edit markers to create
new in- and out-points and drag that trimmed segment from the Source screen to a different spot in the
timeline.

This is a very easy way to pull more than one segment from a master clip. One other tip within a tip: If the in- and
out-points fall off the edges of the Source screen’s mini-timeline, drag the end of the work area bar (highlighted
in Figure 21.21) to zoom out and get the full clip-width view.
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FIGURE 21.21: Double-clicking an edited
clip in a sequence opens the master clip in
the Monitor window Source screen. If you
can’t see the entire edited portion on the
mini-timeline, drag the highlighted end of
the work area bar
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There's a lot more to Adobe Premiere Pro than you might expect. Software this deep is bound to foster plenty of
undocumented or thinly referenced functionality. In this module, I presented some editing tips and techniques
running the gamut from fixing slanted scenes to using the Razor tool to make sudden effect changes.

Adobe Premiere Pro features dozens of customizable keyboard shortcuts. I listed my favorites. They likely will
become second nature to you. You might also come to rely on the Trim window. It’s a great way to fine tune
edits.

New to Adobe Premiere Pro is the Color Corrector. It and its two narrower-purpose partner effects—Broadcast
Colors and Color Match—bring a whole new level of quality and professionalism to this non-linear editor.

Q. When using Color Match, I selected the Reference Monitor, but only those scopes showed up in the
Source screen. How do I see my clip?

A. First, double-click on your clip to put it in the Source screen, then open the Source screen’s wing menu and
select Composite. That will display your clip. That wing menu is also where you can Gang the Source screen to
the Program screen when using the Waveform display with the Broadcast Colors effect.

Q. I tried using the Color Corrector’s Black/White Balance features. When I dragged the eyedropper tool
into the Program screen, the colors in that clip shifted around wildly. What was going on?

A. The Color Corrector effect, by default, is always “on.” So when you move the Black Point eyedropper around a
scene, for instance, the effect thinks you are selecting that particular color as representative of black in the clip. It
them immediately changes your clip colors to show that. Turn the effect “off” by holding down the Shift key as
you move the eyedropper around. Or select Split Screen Preview and opt to use Shift or not, depending on your
needs.

Quiz

1. You want to trim several edits in your project without changing its length. What would be the best way to
go about that?

2. What keyboard shortcuts let you rewind, stop, play your project?

3. Why don't you want to use the Mirror video effect to create a split screen with mirrored animated action?
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Quiz Answers

1. Use the Trim window and its various Rolling edit tools. It’s a simple matter to jump from edit to edit in the
Trim window, so there’s no need to move back and forth between it and the Timeline window.

2. J, K, and L. Pressing J or L more than once speeds up the reverse and forward speeds. K stops playback.

3. Mirror is a wonderful video effect. It's easy to use and creates a perfect reflection, but it slices your clip and
reflects only a portion of it. When using a graphic, unless it’s entirely on one side of the screen, Mirror will
chop it along a straight line. Using the Motion effect to make a mirror effect means you can put an entire clip
on both sides of the screen, creating a true, full-clip reflection.

Exercises

1. Create some tints using the Title Designer. There are so many possibilities, especially when using the various
gradients. You can create partial screen tints and layer them to create even wilder effects.

2. Really try out the Color Match and Color Corrector effects. They are so powerful and fully featured that the
only way you’ll begin to discover all that they can do is to experiment with them.

3. Create a mirrored animation using a diagonal dividing line. Use a graphic with an alpha channel, and use the
Motion effect Position parameter to move the graphic following the diagonal line from the upper-left corner
to the lower-right corner. You'll need to think through the start- and endpoints a bit more than when the
graphic moved horizontally, but otherwise this should be fairly routine.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education

Adobe, the Adobe logo, Adobe Premiere, Adobe Audition, Adobe Encore, Acrobat, After Effects, GoLive, Illustrator, InDesign, Photoshop, and

Tools for the New Work are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other

countries. All other trademarks are the property of their respective owners.
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Module 22

Exporting Adobe Premiere Pro Frames, Clips, and Sequences

Adobe® Premiere® Pro offers a dizzying array of so-called export options—methods to record projects to
videotape, convert them into files, or burn them to DVDs. Making sense of them is the goal of this module.

The simplest task is to use Adobe Premiere Pro as a digital video recorder. In addition, your students can export a
still frame or frame sequence to their hard drives for use in other programs, record only the audio portion of their
projects, or convert a video segment or entire project into one of several standard (but somewhat dated) PC
video formats.

Of greater relevance are the higher-level video encoding formats available in Adobe Premiere Pro: MPEG,
Windows Media, QuickTime, and RealMedia. Adobe Premiere Pro’s export workhorse—the Adobe Media
Encoder—offers all four of those formats with uncountable options for each. Your students will use that
powerful tool to create projects to post to a Web site, for multimedia CD-ROMs, or to create DVD movies.

At the end of this module students will have learned about:

• Exporting Fundamentals

• Recording a sequence to videotape

• Creating basic media files

• Using the Adobe Media Encoder

• Using Adobe Premiere Pro to burn a video to a DVD

Exporting Fundamentals

When you purchased Adobe Premiere Pro, you might have had only one basic concept in mind: Create video
projects to put on VHS tapes and play them on the home VCR. Turns out that's only one of many possibilities.

As technology has changed, Adobe has responded by adding new output features to Adobe Premiere Pro. A few
years ago, the idea of creating a video for playback on the Internet was unheard of. And personal DVDs weren't
even on the radar. Now they are both major elements of Adobe Premiere Pro.

So before venturing off into recording to videotape, take a look at those possibilities:

Make sure a sequence is active (otherwise Adobe Premiere Pro will not present Export as an option) by clicking
somewhere in the Timeline window.

Select File > Export. As shown in Figure 22.1, Adobe Premiere Pro offers six Export options:

• Movie—Create Windows AVI or Apple QuickTime video files or collections of still images.

• Frame—Convert a selected frame into a still image using one of four formats: BMP, GIF, Targa, or TIFF.
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• Audio—Record an audio-
only file in one of three
formats: WAV, AVI, DV
AVI, or QuickTime.

• Export to
Tape—Transfer your
project to videotape.

• Adobe Media
Encoder—Transcode
your project or a segment
into one of four high-end
file formats: MPEG,
Windows Media,
RealMedia, or QuickTime.

• Export To DVD—Burn
your Adobe Premiere Pro
project directly to a DVD.

Figure 22.1: Adobe Premiere Pro’s
six export options.

Three Other Export Options

Adobe Premiere Pro offers three other, infrequently used, export options. To see them, make the Project window
active by clicking somewhere inside it, and then select Project from the Main Menu. Among other things, that
drop-down menu displays three export options:

• Export Batch List—You might never use this option. As shown in Figure 22.2, an Exported Batch List is
a CSV (comma-separated value) file that lists only the video files used in your project. When imported,
Adobe Premiere Pro considers Batch List files as off-line media, that is, you’ll need to use their in- and
out-point data to have Adobe Premiere Pro import them from a DV device. You use Batch files to
transfer projects between logging utility software and products like Adobe Premiere Pro.

• Export Project as EDL (Edit Decision List) —- Editors typically use EDLs when they plan to make their
final edits on high-end hardware video editors. Premiere Pro uses a widely accepted and robust of the
EDL format: CMX3600. Nevertheless, if you plan to use an EDL, you need to use no more than one video
track, two stereo audio tracks, and no nested sequences.
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• Export Project as AAF—On the
other hand, you might have an
increasing need for this option.
AAF (Advanced Authoring
Format) is replacing Edit Decision
Lists as the means to transfer
media asset and editing
information among various
editing devices and software. It
handles most common transitions
but does not support video effects
or audio fade and pan
information.

Figure 22.2: Exporting a Project Batch List
creates a text file that you can read in a
spreadsheet program like Excel or in word
processing software.

Recording a Sequence to Videotape

While a videotape is no longer the principal output medium for projects made using Adobe Premiere, it’s still a
very common choice. All you need is a DV recording device—most commonly, the same DV camcorder you used
to import the original raw video. You can also use an analog videotape recorder, but that takes some extra effort
(see What About Analog Export?).

Task: Export To Tape
Even with something as straightforward as dubbing your sequence to videotape, Adobe Premiere Pro gives you
multiple options. Here’s how to do it:

1. Connect your DV camcorder to your computer, just as you did when you captured video. Turn that
device on and set it to VCR or VTR (not Camera as you might expect).
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Note: What About Analog Export?

Adobe Premiere Pro offers only DV export. If you want to export (record) to an analog machine, you have
three choices. You can record to DV and then record that to an analog device, record to a DV device and
pass it through to an analog camcorder, or purchase a video card with Adobe Premiere Pro Import/Export
plug-ins like the Canopus DVStorm2 discussed in Module 5, “Adobe Premiere Pro Setup.” Once installed,
those cards add their unique analog (and DV) export options to Adobe Premiere Pro. I explain how to export
to so-called non-device controlled recorders later in “Non-device Control—Manual—Recording.”

2. Select the sequence you want to record. The default process will export only an entire sequence as
opposed to a selected segment. To export only a segment, follow the Non-device Control instructions
listed in the Tip presented later in this task.

Tip: Leave a Little Room

To give your project a little breathing room on your DV tape, add black video to its beginning. You know the
drill: Click on the New Item button at the bottom of the Project window (or right-click in the Project window
and select New Item) and select Black Video. Drag that to the start of your project (hold down CTRL to Insert
it and slide all other clips to the right).

If you're going to have a postproduction studio duplicate your tapes, add 30 seconds of "bars and tone" to
the beginning so they can set up their gear. Same
drill as black video: Right-click the Project
window, select New Item > Bars and Tone. Drag it
to the beginning of your project and change its
duration to 30 seconds (you can use the Trim
window’s Ripple edit option or right-click and
select Speed/Duration).

3. Select File > Export > Export to Tape. That
will pop up the dialog box shown in Figure
22.3. Here is a rundown of its options:

Figure 22.3: The Export to Tape dialog box lets you fine-
tune the export process before starting to record your
project to your DV or analog device.
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• Activate Recording Device—When checked, Adobe Premiere Pro will control your DV device.
Uncheck it if you want to record to a device that you’ll control manually.

Tip: Non-device Control—Manual—Recording

To record to a non-device control machine, set up your camcorder for recording, then play the sequence to
make sure you see it display on your external recording device. Cue your tape to where you want recording
to begin, position the CTI edit line to where you want playback to begin, press the record button on your
device, and press the Play button in the Monitor window Program screen (or press Enter).

When the sequence or segment finishes, press the Stop button in the Program screen and then stop the
tape on the device.

It’s best to render your sequence before doing manual, non-device control recording. Otherwise, you’ll have
to wait with your finger on the device record button and press it just as rendering ends.

• Assemble at Timecode—Use this to select an In-point on the tape where you want recording to begin.
When unchecked, recording will begin at the current tape location.

• Delay Movie Start—This is for the few DV recording devices that need a brief period of time between
receiving the video signal and recording it. Check your device’s manual to see what the manufacturer
recommends.

• Preroll—Most decks needs little or no time to get up to the proper tape recording speed. To be on the
safe side, select 150 frames (five seconds) or add black video to the start of your project (see previous
Tip).

• Options—These are self-explanatory.

4. Click Record. If you have not rendered your project (by pressing Enter for playback instead of the Space
bar), Adobe Premiere Pro will do that now. If you have a slower machine, this could take quite a
while—several multiples of your project length. You can watch the progress in the Rendering Files
display and by watching the red horizontal lines
at the top of the sequence. Once Adobe Premiere
Pro renders their associated clips, those lines turn
green.

5. When rendering is complete, Adobe Premiere Pro
will start your camcorder and record your project
to it.

Figure 22.4: The Rendering Files display gives you one
indication of rendering progress.

Creating Basic Media Files

Three of the Export options are Movie, Frame, and Audio. All use older, basic file formats like AVI for the Movie
and Audio option. My general view is that if you want to convert a sequence into an audio or audio/video file,
use the Adobe Media Encoder. I cover it in the next section.

That said, you certainly will make still images (Frames) from your video clips, and WAV (Windows Audio
Waveform) audio files are still heavily used in audio editing software like Adobe Audition™. So there are still
reasons to use these three export categories. I’ll take you through each in turn.
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Task: Exporting Still Images
Grabbing still images of video frames is a common practice. You might want to use them for promotional
literature, to post on the Web, as cover art for a video, and as a DVD menu background. This is a very simple
process:

1. Move the CTI edit line to the video frame you want to save as a graphic file.

2. Select File > Export > Frame. As illustrated in Figure 22.5, that opens the Export Frame dialog box to
your current project’s file folder (you can opt to store this graphic in any other folder).

3. The default file type is BMP (bitmap). You can accept that default, type in a file name, click Save and that
would be that. If you want to use one of the other three available file types—GIF, Targa, and TIFF—then
click the Settings button highlighted in Figure 22.5

Figure 22.5: The Export Frame dialog box defaults to your project location.
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4. In the newly opened Export Frame Settings dialog box shown in Figure 22.6, note the drop-down File
Type list. Select one of the other three file types.

5. Note, you have one other option: Add to Project When Finished. If you don’t want to add the file to the
Project window, uncheck the box.

6. Click OK to return to the Export Frame dialog, where you can give your image a file name using the
newly selected file type. Then click Save.

Figure 22.6: The Export Frame Settings dialog box offers only four file types.

Task: Exporting Audio
The basic audio file side of things follows the same steps as exporting a frame but has a few more options. Once
again you choose from four file types, but you can tweak parameters like the sample rate and the audio
compression software used. And you can opt to export only a portion of your sequence. Here’s how to do all
that:

1. If you want to export a portion of your selected sequence, click and drag the Work Area bar’s beginning
and end points to define that segment. As a reminder, the Work Area bar is directly below the Timescale
in the Timeline window.

2. Select File > Export > Audio to open the Export Audio dialog box.
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Tip: Go Directly to Export Movie

Once you complete this task, there really is no need to use this Export Audio option again. Instead, select
Export Movie, and de-select its Export Video option, leaving the Export Audio option active.

3. As with the Export Frame dialog, you can accept the default file type (WAV) or click Settings to open the
Export Audio Settings dialog box shown in Figure 22.7.

Figure 22.7: Like the Export Frame Settings dialog box, the Export Audio Settings dialog box offers only a few options.

4. Select whether you want the Range to be the Entire Sequence or the Work Area Bar.

5. Click the File Type drop-down menu. You have four choices, all of which are old Windows stand-bys.
Windows Waveform (WAV) is the only audio-specific format. Microsoft AVI, DV AVI, and QuickTime MOV
are the same as those found in the upcoming Export Video Settings dialog. In this case, so you can see
one extra feature, select QuickTime and then click the Audio option in the left column (highlighted in
Figure 22.7).

6. The Audio section (shown in Figure 22.8) offers five options:

• Compressor—There is no way to briefly explain all the Compressor options. Click the drop-down list
and note the 14 options associated with QuickTime. If you had chosen Windows Waveform or AVI, you
would have seen similar but shorter lists. DV AVI has no compression options. It is, by definition,
uncompressed.

• Sample Rate—Samples per second. 44,100 is CD-Audio quality. A lower rate saves CPU cycles but audio
quality suffers.
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• Sample Type—Number of bits per sample. 16-bit is standard but Adobe Premiere Pro supports up to
32-bit floating point.

• Channels—Stereo or Mono. Dolby 5.1 is not available for any of these audio files.

• Interleave—Usually refers to how audio information is inserted into video frames. This is kind of
superfluous. Stick with the 1 Frame default setting.

Figure 22.8: Switching to the Audio options window in Export Audio Settings dialog box reveals five drop-down
menus.
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Tip: Is Advanced Settings Unavailable?

You will likely note the Advanced Settings button is inactive. Only three QuickTime compatible compressor
types have additional settings: Qdesign Music 2, Qualcomm PureVoice, and the two sets of Integer and
Floating Point compressors (all use Endian technology, which refers to the order in which bytes are stored in
memory). Selecting one of these activates the Advanced Settings button.

Just for grins I assembled those three interfaces in Figure 22.9. Take a look at them, since you should use the
Adobe Media Encoder for virtually all audio compression, this might be the only time you see them.

Figure 22.9: Only three compressor types have Advanced Options: Qdesign Music 2, Qualcomm PureVoice, and the
four Endian compressors.

7. After selecting your options, click OK to return to the Export Audio dialog box. Your new file type will
show up as the default. Give your audio file a name and click Save.
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Exporting a Movie

Since this process is so similar to exporting audio, I’ll simply go over the various options rather than present a
task.

When you open the Export Movie Settings dialog box, shown in Figure 22.10, and click the File Type drop-down
list, you will discover standard video file fare plus something that may be new to you: still frame sequences.

Figure 22.10: Export Movie Settings offers basic video files plus still frame sequences.

Frequently editors transfer such still frame sequences to programs like Adobe Photoshop®, where they add
graphic elements to them —a process referred to as Rotoscoping—and then import them back into Adobe
Premiere Pro for further editing. The Filmstrip option is specifically for use in Photoshop. On the other hand,
Animated GIF sequences work best with solid-color, motion graphics, typically for use on the Internet. They are a
great way to animate a logo, for instance.

Tip: Adobe After Effects 6.0: A Better Rotoscoper

Rotoscoping is even more effective in Adobe After Effects®. In that powerful motion graphics product, you
can apply animated artwork directly to video rather than use the frame-at-a-time method in Photoshop.
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As I mentioned earlier this module, Export Audio is a subset of Export Movie. Therefore, you can use Export
Movie for all your A/V basic file creation needs. Export Movie has all the file types found in Export Audio
(Windows Waveform is audio-only; AVI, DV AVI and QuickTime are A/V). The same Audio options you
encountered in the Audio Export section are also available in the Export Movie Settings dialog box. Access them
the same way by clicking Audio on the left side of the dialog box.

What’s different about the Export Movie dialog box is the Video section and the Keyframe and Rendering
section.

Video Options

Click on Video to access those options (refer to Figure 22.11). If you start checking drop-down lists, you will get
the sense that things can become a bit complicated here. I'll try to simplify things by breaking the process down
by file types available for export.

Figure 22.11: The Video section of the Export Movie Settings dialog box just begins to show all the many options
available.

Some options make huge differences in the quality of your exported file, whereas others have minimal
differences. Which options are available depends entirely on the file type you select in the General section of the
Export Movie Settings dialog box.

The Video options include Frame Size, Frame Rate, Color Depth, and Quality. All are fairly self-explanatory. Some
are dependent on the chosen codec (compression/decompression algorithm). The smaller the frame size and
lower the frame rate, color depth, and quality, the smaller the exported file size. This used to be a critical issue.
Many older computers could not handle higher data-rate A/V files. It's not that critical any more. Here are some
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of the other options (for additional information, check Adobe Premiere Pro’s Help section under Video Export
Settings):

• Microsoft DV AVI—It has virtually no options. It operates only at its default quality. You choose
between NTSC and PAL. You also set the pixel aspect ratio—basically wide-screen or regular.

• Microsoft AVI and QuickTime—They present the most options. The most perplexing is the codec
you'll use. AVI works with 9, QuickTime with 22. Which one you choose is largely up to your needs.
Adobe does not offer documentation on any of the codecs supported by Adobe Premiere Pro. I wrote
up a simplified rundown in the following sidebar.

Some of these codecs let you set a maximum data rate. Originally this was to ensure the newly created video file
did not exceed the speed ratings of lower-end CD-ROM drives. That, too, is ancient history. Checking
Recompress gives you two options: Always recompresses every frame, even if it is below the stated maximum
data rate, and Maintain Data Rate recompresses only those frames above the maximum rate.

• Quality, which can have a setting from 0 to 100%, is another narrow-purpose option. If you captured
video using a codec, you should use that same quality setting or less for export. Because you probably
will work with DV source video most of the time—and therefore will not do any compression during
capture—this issue rarely will be a factor.

Sidebar: Codec Characteristics

The number of codecs available in the Video section of the Export Movie Settings dialog box is
overwhelming. You will find no documentation on any of them in your Adobe Premiere Pro printed manual
or online help file. Here is a barebones rundown:

Standard video QuickTime/Windows AVI codecs—Cinepak and Indeo. Cinepak, developed in the late
1980s, is the Old Guard industry standard. Indeo 4 is better than Cinepak but requires a fast computer.

Newer video codecs (QuickTime only)—Sorenson and Motion JPEG. Both are a step up from Cinepak and
Indeo. In general, Sorenson is your best bet of all standard QuickTime codecs. Motion JPEG is used mainly for
storage, not playback. (Note that Photo JPEG creates high-quality images but is slow.)

Graphic animation codecs (QuickTime only)—Animation and Planar RGB.

Still image codecs (QuickTime only)—TIFF, BMP, TGA, and PNG.

Others (QuickTime only)—H.261 and H.263 are for video conferencing.

For more information on video codecs, see
http://www.siggraph.org/education/materials/HyperGraph/video/codecs/Default.htm     .

Keyframe and Rendering Options

With the exception of Fields, you may never use the settings in this dialog box, shown in Figure 22.12. Here's a
rundown on what's available:

Fields—This is one of those easily overlooked "gotchas." The default setting for all DV output should be Lower
Field First. For computer monitors, it's No Fields. Adobe Premiere Pro should automatically change this setting,
depending on the file type, but it’s a good idea to check this. Some video hardware needs to have an Upper Field
setting. You'll have to check your documentation to find out.
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Deinterlace Video Footage—Most video is interlaced. It consists of two fields, one containing odd numbered
lines, the other even. TV interlaces these fields to create the full-screen image. Select the Deinterlace option if
you are exporting to a non-interlaced medium like motion picture film or if you are going to apply high-quality
effects in another program like Adobe After Effects 6.0.

Optimize Stills—With today’s fast Pcs, this will be a non-starter for most Adobe Premiere Pro users. Its primary
goal is to save disk space, but that can have a drawback: playback problems. Optimize Stills converts still images
within an exported video into single, longer-playing frames.

Keyframes—Offers a level of control few video producers will ever need nor want to exploit. Some
codecs—Cinepak, Intel Indeo, Sorenson, and others—offer this user-selected option. Basically, more keyframes
means better looking compressed video and more rendering time. But this is serious engineering overkill.

Figure 22.12: The Export Movie Settings, Keyframe and Rendering dialog box.

Using the Adobe Media Encoder

This is Adobe Premiere Pro’s export powerhouse tool. It offers several flavors of MPEG encoding plus Windows
Media, RealMedia, and QuickTime streaming media (as opposed to the QuickTime MOV files you encountered in
Export Audio and Export Movie).
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Each of the four basic encoding engines has so many presets, few editors will need to do any parameter
tweaking. That said, there are customizable options aplenty, but most are too arcane for me.

Rather than attempt to explain each encoding engine’s unique characteristics, I’ll show you how to access them
and explain a couple general concepts. If you want to go beyond that and unravel, for example, the mysteries of
QuickTime’s Spatial Quality setting, you’re on your own.

Open the Adobe Media Encoder by selecting File > Export > Adobe Media Encoder. As shown in Figure 22.13,
that opens the Transcode Settings dialog box.

Figure 22.13: The Adobe Media Encoder has four transcode modules with uncountable options.

Here’s a run-through of the Adobe Media Encoder’s features:
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• Format—Open this drop-down list to see the four transcode file types: MPEG (five varieties), QuickTime,
RealMedia, and Windows Media.

• Preset—Depending on the Format, opening this drop-down list could overwhelm you. Select Windows
Media as a format, then check out the dozens of possibilities.

• Comment—You can create a custom preset. If so, you can add a comment here.

• Summary—Selecting Summary displays all the various attributes of the Format, Preset, and any other
parameters selected from the Video and Audio options.

• General—Any additional options not available in the Video or Audio sections. Varies depending on the
encoder Format.

• Video—Selecting this lets you choose a codec, frame size, and some other options. Again, each format
has its own unique set of parameters.

• Audio—Same concept as Video.

• Metadata—Information about the video. Click on Add/Remove Fields to open the Select Metadata
dialog box. Only Windows Media lets you add fields. But in each case, you can select items like Title,
Author, and Parental Rating. Click OK and then input your metadata by selecting the word Metadata in
the Transcode Settings dialog box. As shown in Figure 22.14, that displays whatever metadata tags you
selected.

Figure 22.14: Use the Select Metadata dialog box to add some descriptive textual information to your encoded
project.
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Figure 22.15: Once you select Metadata tags, you can edit their contents by selecting Metadata in the Transcode
Settings dialog box.

• Audiences—This term is a bit misleading. “Bandwidth” would be more apropos. All three of the Adobe
Media Encoder’s non-MPEG formats are geared to Internet playback. As shown in Figure 22.16,
Audiences is where you can select bandwidths for your final file. In the case of Windows Media, you
have 16 options from 14.4 dial-up modems to T1 lines and faster.

Figure 22.16: The Target Audience dialog box lets you select multiple bandwidths you want to include in your
transcoded file.
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QuickTime

QuickTime offers the most options but has a limited number of presets. To see what it has to offer, select
QuickTime in the Format drop-down list. Take a look at the Preset drop-down list and select QT 256 streaming
NTSC (or PAL). Now, as shown in Figure 22.17, select Video and note that as with QuickTime MOV files, you can
select from a list of 20-plus codecs, set frame size, frame rate, and a few other characteristics. Its General options
also far outnumber any offered by RealMedia and Windows Media.

Figure 22.17: QuickTime’s Video option offers more than 20 codecs and a number of other options.

If you check out the Audio options, you’ll note it offers the same list of compression algorithms as are available
for QuickTime MOV files. It has a fairly limited number of Metadata fields and Bandwidth options.
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RealMedia

RealMedia takes more of the consumer-friendly, handholding approach and offers the fewest user options and
presets. Select the RealMedia format, keep the Summary window open, and click through a few presets. As
illustrated in Figure 22.18, you might note that one option is two-pass encoding. Both RealMedia and Windows
Media offer this. If selected, the encoder will analyze the original video project twice before transcoding it. That
means encoding will take almost twice as long, but the resulting video will look better than a single-pass version
using all the same parameters.

Figure 22.18: RealMedia offers fewer options, but unlike QuickTime, it lets users opt for two-pass encoding.

If you select the RM9 NTSC (or PAL) streaming modem preset, you’ll note that RealMedia automatically selects six
Audiences (bandwidths). You can add or remove others, but that automatic setup approach is the Hallmark of
RealMedia.
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Windows Media

This is the most versatile video format for use in Windows PCs and for playback on the Internet. You can use it to
create anything from simple, low bitrate files for use on CD-ROMs to high-definition, wide screen videos for
playback in theaters or on High-def plasma TV screens. In addition, it can create single files with multiple
bandwidth bit stream rates for use on Web sites as a means to compensate for varying Internet user connection
speeds.

As shown in Figure 22.19, its video options are very limited. But as I mentioned earlier, it has about 60 presets,
has the largest number of Audience (bandwidth) selections, and offers the widest range of Metadata options.

Figure 22.19: Windows Media has the fewest video and audio options but by far the largest number of presets and
bandwidth selections.



Adobe Digital Video Curriculum Guide – Module 22 22-21

Adobe Digital Video CURRICULUM GUIDE

Note one feature of the Windows Media Video option: Bitrate
Mode. Constant bitrate is best for smooth playback on the
Internet, but high data rate scenes (typically fast action) will
suffer some degradation. Variable bitrate is the better choice for
consistent visual quality and is more appropriate when
archiving video or creating projects for playback on a PC.

As illustrated in Figure 22.20, one other feature of the Adobe
Media Encoder is the extra information it presents as it encodes
your files.

Figure 22.20: The Adobe Media Encoder offers a more verbose
render progress indicator than that used in the Export to Tape
option.

MPEG

Why a special encoder for MPEG? MPEG-2 is the de facto standard codec for DVD movies and videos. It presents
sharp video and CD-quality audio at about one-thirtieth the data rate of regular analog video and one-fourth the
data rate of DV. You've seen movies on DVD and know how good they look. And you've seen those razor-sharp
digital satellite TV images. Both systems use MPEG-2-encoded videos.

If you want to create DVDs to play on your home or business DVD video system, you must use MPEG-encoded
video files. That's been the case ever since DVD movies arrived on the scene a few years ago.

Note: Prosumer DV Can’t Match Film

Because you probably shot your videos using prosumer DV (so-called DV25), they will not look as good as
Hollywood DVD movies. Hollywood DVD movies start their lives as 35 mm (or larger) film. DV25 can't touch
that for quality. And those great video images you see on digital satellite systems—while running under
MPEG-2 compression—probably started as broadcast-quality analog or digital video signals—also several
cuts above prosumer DV.

Only now are professional video producers embracing this technology. It took the convergence of two
technological advances to bring us to this point of putting a software-based MPEG encoder in Adobe Premiere
Pro:

• First, MPEG is asymmetrical. It takes a lot of computer horsepower to encode a DV or analog TV signal
into MPEG-2 or other MPEG formats. On the other hand, decoding (playback on your DVD player) takes
much less processor juice. Until relatively recently, encoding MPEG-2 required some expensive
hardware, priced beyond the reach of most video producers. Now increases in processor power and
improved MPEG-encoding software have eliminated the need for hardware MPEG encoders.

• Second, DVD recorders have come way, way down in price. Pioneer Electronics is driving this continuing
downward price spiral. By late 2003, its standard DVD recorder retailed for less than $150. Along with
this drop in hardware pricing, DVD recordable media prices have dropped dramatically, to as low as $1
per disc when purchased in bulk.

What this means is that now you have an opportunity to create media that will play on most DVD players and is
interactive and high quality.
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Using the Adobe Media Encoder to Export MPEG-1 and MPEG-2

Before we get into the exporting/encoding details, I want to give you a little background on exporting MPEG-1
and MPEG-2 from Adobe Premiere Pro. In Adobe Premiere 6.5, these capabilities were provided by the Adobe
MPEG Encoder, a separate plug-in powered by MainConcept. Adobe Premiere Pro also uses the MainConcept
MPEG-1 and MPEG-2 technology, but it’s now included in the new Adobe Media Encoder interface.

Figure 22.21 shows the Adobe Media Encoder set to export MPEG-2 for DVD.

Figure 22.21: MainConcept’s MPEG encoding technology is now part of the Adobe Media Encoder.

MainConcept is a long-standing German firm (from the days of the Amiga PC) with a solid reputation as a creator
of powerful multimedia tools and codecs. Adobe Premiere Pro also uses MainConcept’s DV codec to maintain
optimal quality and speed throughout the DV editing and exporting processes.
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As I mentioned earlier, including a software MPEG encoder in Adobe Premiere Pro is a big deal. Before version
6.5, if Adobe Premiere users wanted to create MPEG-2 videos, they had to buy a third-party plug-in or use a
hardware encoder. Now Adobe Premiere Pro users get a powerful encoder for free.

MainConcept’s encoder is widely recognized as the leader in software MPEG encoding and is used in a variety of
video editing and DVD authoring software. The MainConcept codecs offer exceptional quality, plus speed that
can exceed that of hardware encoders in many situations.

Exporting MPEG for CD or DVD disc output using the Adobe Media Encoder is easy. Although the MPEG
standards include many parameters, when you select a DVD, VCD, or SVCD preset, only the recommended
parameters appear. Power users can expose other parameters by choosing a generic MPEG profile instead of one
for a specific disc format such as DVD.

MainConcept has a support/resource site for the Adobe MPEG Encoder. It includes an FAQ about the encoder
and MPEG in general, new settings files to download, test results, and a link to the relevant User-to-User forums
on Adobe.com. The link to the support/resource site is   http://www.mainconcept.com/adobemedia.html .

Tip: MainConcept.com—It’s Worth the Visit

MainConcept's Web site is worth a visit at the very least because it offers free "texture loops"—four-second
motion video clips you can drop into Adobe Premiere Pro for some dazzling background animation. Figure
22.22 illustrates how they look. One use for them is as animated text backdrops.

It's a simple matter to
copy/paste the same loop
several times to create a
smooth background
animation. When placed
end to end, there is a
seamless transition from
one copy of the clip to the
next. You may also change
the speed/duration of the
clips to alter the character
of the animations.

MainConcept updates their
texture loop page monthly
with new offerings:
http://www.mainconcept.c  
om/texture_loops.shtml .

Figure 22.22: Visit
www.mainconcept.com      to pick
up a few texture loops for use
within Adobe Premiere Pro.
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Encoding an MPEG File

Here’s a basic overview of the many options available in the MPEG encoder area of the Adobe Media Encoder.

There are five MPEG file formats; most have multiple presets:

MPEG1—This is a VHS-quality MPEG compression standard. If your goal is to create video to play on a VCD, then
use the MPEG1-VCD format instead. If you want to tweak the settings, then this MPEG1 format will suit your
needs. As shown in Figure 22.23, access those settings by clicking on Video, Audio, and Multiplexer in turn.

Figure 22.23: Selecting Video (or Audio or Multiplexer) in either the MPEG1 or the MPEG2 formats opens extensive
lists of options.
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MPEG1-VCD (Video CD)—If you select this option, the Encoder will make a special kind of MPEG-1 file of your
project. Later, using standalone CD-authoring and/or writing software that supports VCD, you can "burn" up to
about an hour of MPEG-1 video onto a CD that will play on most consumer DVD video players and computer
DVD and CD drives. A good online resource for VCD and SVCD issues is http://www.dvdrhelp.com/vcd.htm.

MPEG2—This is the high-end MPEG format geared to DVDs. As with MPEG1, if your goal is to create DVD
content, select MPEG2-DVD. If you want to tweak the MPEG-2, parameters then stick with the MPEG2 format.

MPEG2-DVD—Selecting this option means the Encoder will create MPEG-2 content for inclusion on a DVD.
DVDs can hold up to 4.7GB of data, which can include as much 133 minutes of MPEG-2 video depending on the
bitrate. However, at the bitrates needed for very high-quality video, you should expect to fit much less data on a
disc

You also can place VHS-quality MPEG-1 video on them. Either flavor of MPEG plays in both standalone DVD
players and in computers with DVD drives. Depending on the Multiplexer settings, the Encoder may create a
program stream (a single file containing both video and audio) or elementary streams (separate video and audio
files). Some DVD authoring programs require program streams, while others prefer elementary. Check your
authoring software’s documentation to find out the appropriate setting for you.

Note: DVD Stands For, Well, Nothing

DVD is not an official acronym. Most companies say DVD stands for Digital Versatile Disc, but that's not the
case. DVDs started as "digital video discs," but industry politics killed that idea. A journalist suggested
"versatile" and through repeated usage that has become the de facto, standardized name.

MPEG2-SVCD (Super Video CD)—This is a step up from VCD. In this case, the Encoder will create a reduced
bitstream rate, specialized MPEG-2 file. Depending on parameters you set, you can put up to about 45 minutes
of video on a CD using this low-end MPEG-2 (still better than MPEG-1) video. Again, you need authoring- and/or
CD-burning software that supports SVCD to create an SVCD CD-ROM. A good online resource for VCD and SVCD
issues is http://www.dvdrhelp.com/svcd.htm.

Note: SVCD Issues

SVCD creates videos in a 480×480 resolution (NTSC) or 480×576 resolution (PAL). If you play them back on
standard video players such as the Windows Media Player or within Adobe Premiere Pro in the Source
window, they'll look "tall" (that is, squashed in at the sides).

If you open these files in software that recognizes this standard MPEG format, such as DVD player software,
they will play in the proper aspect ratio. If you place them on Adobe Premiere Pro's timeline and play them
in the Monitor window, they will display in the proper aspect ratio, but as noted later in the sidebar "Why
Adobe Premiere Pro Does Not Edit Native MPEG Video," Adobe Premiere Pro is not fully intended to handle
any MPEG format.

Once you make your format selection (MainConcept’s MPEG encoder or any of the three other encoders), click
OK. That takes you to a Save File dialog box. There, you select whether you want to export the entire sequence or
the segment under the Work Area bar.
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Click Save and the rendering and transcoding begin. Depending on the quality-level settings, this can take a
long time. As I mentioned earlier this module, rendering on its own can take several times the length of your
sequence. Transcoding times might be about double the length of your piece.

Note: Is MPEG Encoding Taking Longer?

Users of the Adobe MPEG Encoder in Adobe Premiere 6.5 might think that the MPEG encoder in Adobe
Premiere Pro is slower. However, MainConcept testing shows it to actually be a bit faster at comparable
settings.

The reason for the apparent disparity is that Adobe Premiere Pro’s export settings default to the highest
possible quality level, which can increase exporting time. The new support for two-pass encoding in Adobe
Premiere Pro (the MPEG encoder analyzes the video twice to find the best means to compress while
retaining quality) also roughly doubles the exporting time.

The PremierePro.README.pdf file (in Adobe Premiere Pro’s main file folder) includes details on this issue.
MainConcept’s support/resource site also includes additional MPEG encoding presets for Adobe Premiere
Pro, which are designed to speed encoding while still maintaining good quality.

Sidebar: Why Adobe Premiere Pro Does Not Edit Native MPEG Video

As I put together this module on MPEG encoding, I swapped several emails
with the MainConcept U.S. subsidiary Chief Operating Officer, Mark Bailey.

Bailey is the company's primary liaison with Adobe. His solid grasp of the
MPEG compression universe completely impressed me. After reading several
emails from several Beta testers on the Adobe Premiere Pro forum asking why
Adobe Premiere Pro didn't offer native MPEG editing, I asked Bailey for his
take on this topic. The remainder of this sidebar summarizes what he had to
say.

Although MPEG is an excellent way to deliver material, it has some limitations as an editing format. Because
of its high compression and the way that some frames are calculated, MPEG material can be subject to
significant quality degradation when rendered multiple times. Because video editing and compositing
projects often involve many generations of rendering, there is the potential for noticeable loss.

Although Adobe Premiere Pro does import MPEG material, it doesn’t offer native MPEG editing. Imported
MPEG files are transcoded to DV for editing, then the DV data must be re-transcoded if a user wants to
export the project as MPEG. This can result in two additional generations of compression.

Of course, it's best to start any editing or compositing project with the least-compressed source material
available. Using highly compressed media from the start could present serious problems, except when
special tools are used to work around these problems.

The workflow explained in this book—editing in DV and encoding the finished project to MPEG—works
very well.
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However, there are some cases in which people might need to edit MPEG, and some companies offer plug-
ins that enable it with varying results. MainConcept has created a plug-in that makes MPEG editing a viable
option and even make it advantageous in some circumstances. Features include:

• Native MPEG editing in Adobe Premiere Pro.

• Real-time, high-quality capture to MPEG from a variety of source devices, for example from a DV
camcorder.

• DV support, meaning that MPEG and DV material can be included in the same project with equal
efficiency.

• Smart rendering, meaning that only changed frames are re-encoded.

• Smart requantizing—the ability to transcode from one MPEG format (such as Sony MICROMV) to
another (such as DVD-compliant MPEG-2) without re-encoding.

• High Definition support.

• Export to a variety of devices.

This plug-in presents a very viable workflow. For example, you could capture directly to DVD-compliant
MPEG-2, edit the captured material, and export the project with very minimal rendering.

For more details, visit MainConcept’s website at www.mainconcept.com.

Using Adobe Premiere Pro to Burn a Video to a DVD

New to Adobe Premiere Pro is the capability to take a sequence or a video segment and burn it directly to a DVD.
Once completed, you then can take that DVD, place it in a set-top player, and it will automatically play your
video. It won’t have the menus, buttons, and other options associated with Hollywood DVDs. But it can have
chapter points that you can jump to using your DVD player’s remote control.

If you want to add DVD features like menus, buttons, scene selection options, subtitles, and multiple languages,
you’ll need DVD authoring software like Adobe Encore™ DVD. I devote the second-to-last module of this
curriculum guide to that excellent Adobe product.

Task: Creating a DVD
Here are the basic steps to take when exporting a video to a DVD:

1. You can give your video chapter points. That’ll let viewers quickly navigate through your project using
the chapter buttons on their DVD remote.

2. To add chapter points (called Sequence Markers in Adobe Premiere Pro), move your CTI to the
beginning of a new scene (for example), right-click in the Time Ruler bar, select Set Sequence Marker >
Unnumbered (keyboard shortcut—numeric keypad asterisk ‘*’ key). Do that as many times as you like.
There are two caveats:  chapter points (sequence markers) must be at least 15 frames apart (this is an
MPEG encoding requirement) – and – for some products to recognize the markers as chapter points,
double-click each one to open the Marker information box and type something (“Scene #” for example)
into the Chapter line.
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3. Select File > Export > Export to DVD. That opens the dialog box shown in Figure 22.24. Give your project
a name by selecting Custom from the drop-down list. And check the Timeframe Markers if you want to
add chapter points, and check Loop Playback if you want your video to start over after it ends.

Figure 22.24: The first step in the DVD creation process: Give your disc a name and note whether you want the video
to loop or have chapter points.
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4. Select Encoding. As shown in Figure 22.25, this dialog lets you specify the encoding quality. The file
format is MPEG-2, and you cannot change that. But you can tweak its settings, using many of the
features available in the Adobe Media Encoder. To access those features, click the Edit button.

Figure 22.25: The Export to DVD Encoding section allows you to access the MPEG encoder parameters.

Tip: Bitrate Settings

Select a bitrate that fits your needs and video length. If your project is less than about 90 minutes, you can
use the highest target bitrate—7Mbps. If it’s longer, your video might not fit on a standard DVD-R/RW at
that rate, so choose a 4Mbps preset. Selecting VBR (variable bitrate) means the MainConcept encoder will
find the best bitrate for each frame (maxing out at 9Mbps for the 7Mbps target and 7Mbps for the 4Mbps
target setting).

5. Select the Export Range: Entire Sequence or Work Area.

6. Check out the DVD Burner section. It identifies any burners on your PC and allows you to set the number
of DVD copies and whether you want to Record, Test Only, or Test and Record.

7. When done, click Record. You’ll see a progress bar for Transcoding and DVD burning.
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Note: Dolby AC-3 Licensing

If you select a preset that includes “SurCode for Dolby Digital,” a warning will pop up telling you that you
can encode to AC-3, Dolby Digital Audio only three times. Beyond that, you’ll need to purchase a license.
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Adobe Premiere Pro offers three basic means to export your project: recording to videotape, creating basic PC
files, and transcoding your files using one of four high-end encoders. Recording to videotape is straightforward.
Creating a file offers many more options. You can create video files, still frames, sequences of still frames, or
animation files. In each instance, you can adjust various settings to reduce file size, generally as a means to
streamline playback.

As more of your video projects move to DVD and the Internet, you will rely heavily on the four high-end export
modules available in the Adobe Media Encoder: MPEG, QuickTime, RealMedia, and Windows Media. Creating
MPEG files opens the door to DVD authoring and placing MPEG files on CDs. The three other encoders all allow
you to create single files that can play back your video at multiple bandwidths. A great feature for Internet
playback. In addition, the Windows Media encoder offers high-end compression for wide screen and high
definition videos.

Q. When I use Export to Tape, I viewed a full-screen version of my project in the TV monitor attached to
my PC. But playback on my computer is choppy. What's up?

A. Your computer may not have the power to process both video data streams. Select Project > Project Settings
and in the General section click Playback Settings. Because you probably want to view this at the very least on
your computer monitor, uncheck Play Video on DV Hardware, or in the Real-Time Playback section select
Playback on Desktop Only. If you must view it on your DV/camcorder monitor, select Playback on DV Hardware
Only.

Q: I encoded an MPEG-2 file, but it stutters on playback. Any idea why?

A: Did you select Upper Field First in the Fields drop-down menu in the MPEG Encoder? If so, that may be the
cause (a slow PC could be another reason). No Fields is the safest choice if you don't know which to choose, but
its output quality is not as good as finding the correct setting—Upper or Lower.

Q: I encoded an MPEG-2 file, played it back in the Windows Media Player, and there was no audio. What's
up?

A: When you created that MPEG file using the Adobe Media Encoder, you probably built "elementary stream"
(separate audio and video) files. To make a multiplexed (or muxed) file, click the Multiplexer option and select
DVD (de-selecting None in the process).
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Quiz

1. How do you create a sequence of still images, selecting one frame per second from your project?

2. How do you convert an AVI clip into a Windows Media file?

3. You have a two-hour video and you want to use Adobe Premiere Pro to burn it directly to a DVD. In general,
what settings will work best?
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Quiz Answers

1. Use the Export Movie process. Place the work area bar over the portion of your project from which you want
to create still images, select File > Export > Export Movie. Click Settings. Choose a sequence file type—TIFF,
Targa, GIF, or Windows Bitmap—move to Video and select a frame size and change the Frame Rate setting
to 1.

2. Add the clip to a sequence, place the work area bar over that clip, select File > Export > Windows Media
Encoder, select Windows Media, and select from the various settings. To see if all went well, open Windows
Media Player, select File—Open, locate your newly created file, and play it. You can view any Metadata you
added to it by selecting File > Properties and clicking the Content tab.

3. Two hours of the highest quality MPEG-2 video exceeds the capacity of a single-side, single-layer DVD. So
you need to crank down the encoding quality. Select a preset that has a 4 Mbps bitrate. You can still use one
that encodes using a variable bit rate (it tops out at 7 Mbps at this level). That will improve the overall
quality. Use a constant bitrate only when you need a smooth flow of data, typically for Internet or network
playback.

Exercises

1. Create both Windows Media and RealMedia files using similar settings and see how long the encoding
processes take, how large the files are, and how the encoded clips look and sound.

2. Take a small step into the highly technical world of customized MPEG settings by selecting the MPEG2
format and opening the three advanced settings sections: Video, Audio, and Multiplexer. Some are fairly
self-explanatory: Bitrate Encoding (CBR or VBR), Encoding Passes (one or two) and Maximum Bitrate. But
beyond that, you start entering the arcane world of I, B, and P frames and GOPs (Groups of Pictures). To learn
more, start by visiting http://www.mpeg.org.

3.  Do a personal test on video and audio codecs. Set the work area bar over a small section of your timeline
and then export it using different codecs. Use the same Frame Size, Frame Rate, and Quality settings. When
completed, note the file sizes and playback quality of the saved files.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education
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Module 23

Adobe Photoshop in DV Projects: Still Images and Layers

The Adobe® Video Collection Professional features five products: Adobe Premiere® Pro, Adobe Audition™,
Adobe Photoshop® CS, Adobe After Effects®, and Adobe Encore™ DVD. Each stands alone at the top of its
respective field. Taken together, they give video producers all the tools they need to do excellent work.

I took you through Adobe Audition’s paces in Module 15, “Adobe Audition: A Professional Audio Tool.” In this
curriculum guide’s second-to-last module, I show you how to use Adobe Encore DVD to create Hollywood-style
DVDs. In this module, I introduce you to Photoshop CS, and in the next two modules, I present After Effects.

After Effects is the de facto video production industry-standard text animation and motion graphics tool. If it
moves on your TV set or movie theater screen, someone probably used After Effects to create it.

Anyone who does anything with print graphics and photo retouching probably has Photoshop. It is the
workhorse of the graphic design industry. But it is becoming an increasingly important part of the video world as
well.

Photoshop CS is a powerful tool with great depth and versatility. However, it plays only a supporting role in
Digital Video production. So in this module, I present only an introduction plus some tips on using it for DV
production. In this DV curriculum guide’s concluding module, I present one other very helpful Photoshop
feature: menu creating and editing for Adobe Encore DVD.

At the end of this lesson, students will have learned about:

• Photoshop CS Fundamentals

• An introduction to Photoshop CS basics

• Tips for using Photoshop CS in video production

Photoshop CS Fundamentals

Making the move to Photoshop CS (shown in Figure 23.1) means joining forces with just about every image-
editing professional on the planet. It's that ubiquitous.
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FIGURE 23.1: Adobe Photoshop CS is the undisputed image-editing tool of choice.

Photoshop CS (Creative Suite) offers deep customizability. The Layer Style dialog box in Figure 23.2—very
reminiscent of Adobe Premiere Pro's Title Designer—is a case in point. Everything you need is at your fingertips.
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FIGURE 23.2: Photoshop's Layer Style dialog box puts major functionality within one intuitive interface.

The drawing tools and Artwork palette in Photoshop CS let you create graphics, like the one in Figure 23.3, in
only a few minutes.
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FIGURE 23.3: Photoshop's intuitive drawing tools speed up graphics creation.

Photoshop CS includes several creative paintbrush tools in that palette such as Charcoal, Pastel, and Oil Paint.
Using them with a graphics tablet, such as the pressure-sensitive Wacom Intuos, means you can apply more or
less texture as you draw.

Other Photoshop CS features include the following:

• A "healing" brush that does amazingly accurate and automatic dust, scratch, and blemish removal while
compensating for differences in lighting, shading, and texture.

• Auto color correction, which analyzes an image and balances color with a single click. This works well on
photos shot under fluorescent lights.

• More powerful Web integration.

• A spell checker. This may not seem like a standard image-editing tool, but graphic artists have clamored
for it.

Of primary importance to the scope of this book is just how strongly Photoshop CS is connected to Adobe
Premiere Pro and to video production.
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An obvious example is Adobe Premiere Pro's Edit Original command. Place any Photoshop graphic on the
timeline, right-click it, and select Edit Original. This opens Photoshop CS and lets you immediately edit the
graphic. Once saved within Photoshop CS, the new version of the graphic shows up in Adobe Premiere Pro.

Here are three other Adobe Premiere Pro/Photoshop CS connections:

• Adobe Premiere Pro’s "filmstrip" export feature is specifically designed to work with Photoshop CS.
Convert video clips into filmstrips—collections of individual frames. To do that, mark the sequence
segment you want to convert with the Work Area bar, then select File > Export > Export Movie. Click
Settings. For File Type, choose Filmstrip and then choose the frame rate. As shown in Figure 23.4, you
then open the frames in Photoshop and paint directly on the clips using a process called rotoscoping.

FIGURE 23.4: Use Photoshop’s Filmstrip file format and its paint tools to rotoscope Adobe Premiere Pro clips on a
frame-by-frame basis.
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• Export a frame of a video to Photoshop CS to create a matte to mask or highlight certain areas of that
clip. Here's how: Using that frame as a guide, create a shape using the Marquee or one of the Lasso
tools. In the Tool Options bar, set Feather to about 15 px to give it that soft border. Fill the interior with
black to make it transparent. Fill the rest with white to make that part opaque. Within Adobe Premiere
Pro, you can use this mask as a track matte to adjust its location and size and to follow action. Plus, you
can line up the original clip on both Video 1 and Video 2, apply some blur to Video 2, and use the soft-
edged matte to highlight an element in your clip while throwing everything else out of focus.

• You can use Photoshop CS to cut objects out of a scene using the Extract filter and fill in the gap using
the Clone tool or the healing brush. Then place the removed object in a separate layer so you can
animate it using Adobe Premiere Pro's Motion video effect. Monty Python-esque comical situations
come to mind. Consider a photo of a statue in a park. Move it off the pedestal and slide it next to an
unsuspecting park patron seated on a bench.

Before you can start using these features, you'll need to learn the fundamentals. I present a basic introduction to
Photoshop CS in the next section. If you choose to add Photoshop CS to your digital video production repertoire,
peruse the tips for first-time users provided by a Photoshop expert in this module’s concluding section.

An Introduction to Photoshop CS Basics

This section is for those who have never worked with any incarnation of Photoshop. If you already are
comfortable using Photoshop, skip this section and read the next section: “Using Photoshop CS in Video
Production.”

At its core, Photoshop CS is an image touch-up tool. You can import images, then burn and dodge, change
contrast and brightness levels, repair scratches, remove dust, fix red-eye, and add tinting. Photoshop generally
doesn’t make these changes directly on the original image. Rather, it places them in layers above the image.

It’s sort of like the way cartoon animators work. They build a background image and draw characters on sheets
of clear film. Then they layer those sheets one over the other. You can see through the unpainted portions while
opaque sections and those elements with reduced opacity completely or partially cover up what’s below.

That layering also lends itself to graphics work. Photoshop CS enables you to position graphic elements in those
layers, add effects to them individually or collectively, and make adjustments on a layer-by-layer basis.

Task: Taking a Tour of Photoshop CS
To see how this works, I’ll take you through some of Photoshop CS standard image editing and creation tools.
Then I’ll cover some effects. Here’s how it works:

1. Open Photoshop CS. Import an image using its Browse feature. To do that select File > Browse. That
opens the File Browser shown in Figure 23.5. Navigate to the image(s) you want to use and click on one.
That places it in the Preview window and displays its data: date created, file format, resolution, color
mode, and a wealth of other information. Double-click to open an image.
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FIGURE 23.5: Use the File Browser to simplify the image importing process.

2. That opens the image in its own window. You can drag its corners to expand the view and use menu
commands to zoom in or out (View > Zoom In/Out) or keyboard shortcuts (Ctrl++ to zoom in, Ctrl+- to
zoom out).

3. Select Image > Adjustments to open up a list of tools to fix the overall look of the image. Most will be
familiar to you because of your work with Adobe Premiere Pro and with photos in general. Photo Filter
warrants special attention. Select it. As shown in Figure 23.6, it offers more than a dozen preset tinting
options, including a few that give a warm or cool feel to your photo.
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FIGURE 23.6: From the Image>Adjustments group, select Photo Filter to access a collection of preset tint styles.

4. Take a look at the Tools palette shown in Figure 23.7. Roll your cursor over its buttons, and Photoshop
CS tool-tips will tell you each button’s name. If the button has a little triangle in the lower right corner,
that means it has more than one function. To see that, click on the rectangle tool (circled in Figure 23.7)
and hold down the mouse button. It reveals five other shape tools.
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FIGURE 23.7: There’s more to the Tools palette than immediately meets
the eye. Tool buttons with tiny triangles have more than one tool from
which to choose.

5. Select a shape tool (I chose Rounded Rectangle). As illustrated
in Figure 23.8, note that its features show up in the menu bar
at the top of the interface. One feature is its Style. Click that
button to reveal a default set of Styles for shapes. I appended
that limited default list by adding many other available in
Photoshop CS. To do that, click the wing-out menu, select a
group from the drop-down list, and when prompted click
Append.

FIGURE 23.8: Photoshop CS ships with dozens of shape drawing Styles.
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6. Use your selected drawing tool and a Style of your choosing to add a graphic element to your image. In
my case, I chose the Woodgrain Style (they all have names), clicked on the image, and dragged its
outlines to make the button in Figure 23.9. Press Enter to apply it to your image. Note that a new layer
appears in the Layers palette (if the Layers palette is not visible, select Window > Layers). As highlighted
in Figure 23.9, you can see that the Woodgrain style is comprised of several effects.

FIGURE 23.9: Adding shapes is easy. Select one of the six shapes from the Tools palette, select a Style, and drag a drop
the shape.

7. Add text to your image by clicking the Text tool (the large ‘T’ in the Tools palette) and selecting a font
and other text characteristics from the collection now displayed in the menu bar. Once completed, click
the “Commit any current edits” checkmark to the right of the text options in the Menu bar.

8. Apply some extra features to that text (or any other object in any layer) by selecting it (click on it in the
Layers palette) and opening the Layer Styles dialog box. To do that, click the little ‘f’ in the lower left
corner of the Layers palette and select one of the options. That opens the Layer Style dialog with that
option selected (another way to open Layer Style is by selecting Layer > Layer Style and choosing from
the same collection of options).

9. In the Layer Style dialog, shown in Figure 23.10, you can choose from the same styles you find in Adobe
Premiere Pro’s Title Designer, along with a few extras like the three Overlays.
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FIGURE 23.10: Just as you can choose from a collection of Styles when you create objects, Photoshop CS enables you
to add Styles to objects in layers.

10. In Photoshop CS, effects are called Filters. To see them all, select Filter > Filter Gallery. Open any of the
Filter groups and select a filter. As shown in Figure 23.11, that immediately displays how that Filter will
work with your particular photo. This is a wonderful and creative tool.

11. One very slick feature of the Filter Gallery is its layering window. It’s in the lower right corner and is
highlighted in Figure 23.11. To apply more effects (and see how those multiple effects work together),
click the New Effect Layer button (bottom right corner next to the trash can), then click on a new Effect.
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FIGURE 23.11: The Filter Gallery gets my vote as the slickest graphics tool in Photoshop. In it, you get immediate
feedback on how an effect alters an image’s appearance. And you can readily test multiple layered effects in the lower
right corner.

12. There are several photo touch-up methods. I’ll show you one. Select the Healing tool. It’s the bandage in
the Tools palette highlighted in Figure 23.12. Open its brush characteristics menu in the Menu bar and
set its size to match the area needing repair. Set other options: Mode=Normal and Source=Sampled.
Alt/Option-click an area of the image you want to use to touch-up the damaged area. That captures
those pixels. Click and drag the mouse over the damaged area. Photoshop CS will calculate the level of
healing. Note the “after” close-up in Figure 23.13. This easy fix took only a few seconds.
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FIGURE 23.12: This old photo has a flaw on the man’s chin. The Healing Tool makes fixing damaged photos easy.

FIGURE 23.13: This fix took only a few seconds.
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13. Finally, if you want to create graphics from scratch, it’s best to do it in a resolution and aspect ratio that
match your video project. If you are working with PAL or NTSC, then you need to create graphics using
so-called non-square pixels (see the following section, “Using Photoshop CS in Video Production,” for
more on that). Photoshop takes care of all that in its New document dialog box. Select File > New to
open it, and as shows in Figure 23.14, select a TV preset. Note that in the case of NTSC DV, the Pixel
Aspect Ratio (as opposed to the 4:3 screen aspect ratio) is (0.9). That is the non-square aspect ratio
needed when working with NTSC projects.

Figure 23.14: When creating Photoshop graphics from scratch, select a document preset that matches your video
format.

Using Photoshop CS in Video Production

If you aren’t a Photoshop user, I strongly recommend downloading the Photoshop CS trial version from
http://www.adobe.com.

One other alternative means to get up to speed on Photoshop CS is to start with its slimmed-down sibling:
Photoshop Elements. It’s a more user-friendly piece of software that features the same layered graphic approach
used in Photoshop CS.
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Expert Tips

Whichever approach you take, you’ll want to follow a few standard
procedures when creating graphics for use in video projects. I contacted a
well-regarded professional in this use of Photoshop—Glen Stephens—to
provide some tips.

Glen Stephens is an expert Photoshop user and designer for desktop and
broadcast video. He has more than 10 years of experience as a graphic
designer, editor, and director in broadcast video.

Glen Stephens, Pixel Post Studios.

Stephens is the developer of the Tools for Television Pro – (   http://www.toolsfortelevision.com    ), a valuable
productivity tool for people who want to integrate video production and Photoshop.

Stephens' company, Pixel Post Studios (   http://www.pixelpoststudios.com     ), provides training and design services
for the broadcast video industry.

Here are Stephens' tips for using Photoshop in your video productions (note that * indicates that actions are
available on the Tools for Television—Photoshop Toolbox CD to automate the task):

• Place each element of your image onto a new and separate layer. This allows you to keep your
designs editable in case you decide to make changes later. It's tempting to flatten your images when
you are done to reduce their file size, but this prevents you from later making text or color changes.

• Use the built-in features of Photoshop, such as layer styles, to create effects such as drop
shadows, glows, and bevels. Layer styles and adjustment layers are very valuable and allow you to
create powerful image effects that are always adjustable later in the process, as long as you do not
render or rasterize them. Experiment with these and get into the habit of using them.

• Use safe areas. * Overscan on
television sets covers about 10% of
each side of your image. Therefore,
when creating graphics for video,
use Photoshop CS’s new Title Safe
guides when you select a video pre-
set when opening a new document.
Make sure you place all your text
inside that delineated portion of
your image (see Figure 23.15). It's
okay to let background images and
elements extend to the edges so
that they appear to fill the screen,
but overscan will cover any text that
extends outside of the title-safe
area.

FIGURE 23.15: Keep your text within the title-
safe area to avoid losing the edges in the
overscan region.
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• Watch your font sizes. Font sizes of 24 points or larger work best. Anything smaller may look like dust
specks on a TV screen. For a header or primary text, 32 to 48 points work well, depending on how much
text you use. (Note that typeface sizes vary. A 24-point font for one typeface may be smaller/larger than
a 24-point font for a different typeface.)

Also, space your text evenly. Don't crowd the screen with too much large text, and avoid thin fonts that may
become illegible in an interlaced video signal.

• Adjust image dimensions to compensate for non-square pixels. * Photoshop works only with
square pixels. But some TV systems use so-called non-square (slightly rectangular) pixels. To ensure your
Photoshop graphics translate well to the final video output format, use Photoshop CS’ new Pixel Aspect
Ratio Correction feature. It makes your images look square while you are working on them in
Photoshop, but the pixels are actually non-square in their native form in Photoshop.

To ensure the proper pixel aspect ratio, use one of Photoshop’s TV image presets. Select whatever output you’ll
use for your project when you open a new document in Photoshop. If you care to confirm that setting, choose
the Advanced Settings > Pixel Aspect Ratio drop-down menu in the new document setup dialog box.

Once you’ve made that selection, don’t change that from square to non-square or vice versa. That could alter
your image in an irreparable way.

Computer monitors, Regular NTSC (non-D1 or DV), and
HDTV (High-Definition TV) use square pixels. NTSC D1,
NTSC DV, and PAL use non-square pixels. If you do not
use the Pixel Aspect Ratio Correction for non-square
formats, you images will look like the graphics in
Figure 23.16—stretched or squashed, depending on
the video system.

FIGURE 23.16: Failing to use the correct resolution in a
Photoshop graphic may lead to squashed or elongated
images, depending on the output video format.

Note: 72 DPI Fits the Bill

Unless you plan to zoom in on a graphic within Adobe Premiere Pro, it's best to create all Photoshop images
as RGB images at 72 dpi resolution (see the section, "Scanning tips for photographs" later in this chapter for
more info).

• Using bitmap versus vector graphics. Computer graphics fall into two main categories: bitmap and
vector. You can import both types into Adobe Premiere Pro, but Adobe Premiere Pro converts vector
graphics to bitmap images before editing them. Here's a basic overview of both types:

o Bitmap images—technically called raster images —use a grid of colors known as pixels. Some
pixels have been magnified in Figure 23.17 to illustrate this. Each pixel is assigned a specific
location and color value. When working with bitmap images, you edit pixels rather than objects
or shapes.
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Bitmap images are the most
common electronic
medium for continuous-
tone images, such as
photographs, because they
can represent subtle
gradations of shades and
color. Bitmap images are
resolution
dependent—that is, they
contain a fixed number of
pixels. As a result, they can
lose detail and appear
jagged if they are scaled
larger.

All images created in
Photoshop are bitmap.

FIGURE 23.17: Magnified bitmap pixels.

o Vector graphics are made up of lines and curves defined by mathematical objects called
vectors. Figure 23.18 demonstrates how vectors describe an image according to its geometric
characteristics. For example, a circle in a vector graphic is made up of a mathematical definition
of a circle drawn with a certain radius, set at a specific location, and filled with a specific color.
You can move, resize, or
change the color of the circle
without losing the quality of
the graphic.

Vector graphics are resolution
independent—that is, they
can be scaled to any size and
printed at any resolution
without losing detail or
clarity. As a result, vector
graphics are the best choice
for representing bold
graphics that must retain
crisp lines when scaled to
various sizes (for example,
logos).

All images created with
Adobe Illustrator are vector
based.

FIGURE 23.18: Vector graphics are made up of
mathematical objects—lines and curves—to
ensure sharp, crisp images, no matter how much
they're scaled up.
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• Fixing interlacing and "shaky" graphics. * If
your Photoshop graphics vibrate when
displayed on a TV set, this is likely due to
interlacing.

This happens when thin horizontal lines, especially
bright lines, in your graphic or image fall between the
interlaced scan lines of your video signal. It's a common
occurrence with scanned photographs. You want to
avoid this.

You fix it by either making horizontal lines thicker or
applying a motion blur. Figure 23.19 demonstrates the
latter.

Select Filter, Blur, Motion Blur. This opens the Motion
Blur dialog box. Apply one pixel at 90 degrees to the
problem area in the image. This stretches the width of
the horizontal lines into the next scan line in the video
signal and corrects the problem. In some cases, one
pixel will not be enough. Try two or three if the problem
is really bad.

FIGURE 23.19: Use Photoshop's Motion Blur effect to
resolve jitters on interlaced TV sets caused by thin lines in
the graphic.

Note: Limit Blurred Region

It generally works best if you apply the blur only to the problem areas in the image. If you apply the blur to
the overall image, it may lose sharpness.

There are exceptions: In the case of a scanned photo, you may need to apply it to the entire image.

You can use Adobe Premiere Pro's Edit Original command on the suspect graphic to automatically open
Photoshop to do your graphic touchup work. When you save the altered graphic, it will show up in its new
form within Adobe Premiere Pro.

• File-management tips: When you're working in Photoshop, I suggest using a file folder system that
keeps two sets of image files for a project: design and production.

Design files are the original Photoshop (PSD) images that contain text data, layers, adjustment layers, layer
masks, and the safe grid and background.

Production files are the flattened files you can export to other software applications. These files do not have any
layered information and cannot be edited later. You can save these files in any format your editing software will
take. It is a good idea that these files be flattened because many applications cannot read layer styles or
adjustment layers from Photoshop, and items such as drop shadows may be lost in the editing software. Simply
select Save As in Photoshop and uncheck the Layers button in the Save dialog box to flatten the image.

• Color-selection tips: Certain colors work better than others when working with video. Any color that is
highly saturated and too bright will cause problems when transferred to video. Muted, less bright colors
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will yield better results. Typically red is not a good color to use. However, if you keep the saturation and
brightness down, you may be able to get away with it. Blues, yellows, and greens work well.

Photoshop has a filter that will help shift "illegal" colors into an NTSC safe-color space. Select Filter > Video >
NTSC Colors to use it. However, just because a color is NTSC safe does not mean it will not bleed or look bad!

When working with text, make sure there is a significant amount of contrast between the color of the text and
the background. You want the text to jump off the screen at your viewers.

I rarely use color in text. If I do, it is just a faint shade. Your viewers' eyes will be drawn naturally to the brightest
portion of your image. Try to "guide" your viewers to what you are trying to communicate with them.

Note: Color Theory

The book Color Harmony by Hideaki Chijiiwa is an excellent resource if you want to learn color theory and
how to use colors to help communicate your message.

• Scanning tips for photographs: When scanning photographs for use in a video project, it is not
necessary to scan images at a high resolution. Because all video graphics end up at 72 dpi, anything
more than that is overkill.

There are exceptions, though. If you plan to pan, move around, or zoom in on the image in Adobe Premiere Pro,
you will want to scan at a higher resolution than 72 dpi.

Because Photoshop works with pixels, if you scan a small image and try to scale it larger in Photoshop, you will
end up with a blurry version of your image. Scaling down does not make an image look obviously worse, but
scaling up does.

In general, scan all images at a slightly larger size than the expected output video resolution so that you can
scale the image down to the size you want it on your video screen.

Table 23.1 lists image sizes that will fill a screen at 72 dpi for each video format. If your original image is smaller
than the sizes listed here, scan it at a higher resolution to ensure sharp details in the final edited video.

Table 23.1—Video Frame Size Versus Optimum Size of Original Document to Ensure Sharp Onscreen Display

Video Frame Size Minimum Image Size to Ensure Sharp Onscreen Display

640×480 8 7/8 × 6 5/8 inches

720×480 10 × 6 5/8 inches

720×486 10 × 6 3/4 inches

720×576 10 × 8 inches

1280×720 17 2/3 × 10 inches

1920×1080 26 2/3 × 15 inches
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The Adobe Video Collection Professional contains everything you need to create high-end video projects. The
tool covered in this module—Photoshop CS—is an industry-leading powerhouse. Virtually everyone who works
with digital images uses Photoshop.

Photoshop CS is geared to still image work, but there are many ways to incorporate those layered stills into a
video production. In this module, I called on an expert in using Photoshop for DV work to offer up some tips
along those lines.

Q. Your scanning tips in the Photoshop CS video production section say that there’s no real need to scan
at higher than 72 dpi. If I do use higher resolution settings, does that create a problem?

A. Probably not. At worst you might experience minor inconveniences along the lines of disc space, CPU cycles,
scanning speed, and whether you want to pan or zoom in on your scanned images. Most people scan at 600 dpi
or higher to ensure sharp printouts. That’s serious overkill for TV sets that can’t display at more than 72 dpi. And
those files take up massive disc space versus images scanned at 72 dpi. High-res images also can take more
processor horsepower to display quickly. Finally, if you plan to use put your images in motion (pan or zoom),
higher resolution is a must to avoid fuzzy photos.

Q. If I’m working with non-square pixels in Photoshop CS so that my graphics can match my video project,
how come the images in Photoshop CS don’t look squashed or elongated?

A. Photoshop CS has a new feature that automatically compensates for non-square pixels for both NTSC and PAL
video projects. When you set up a project with non-square pixels, Photoshop CS displays them as they will look
in your project but saves them in the proper formatting.

Quiz

1. Photoshop primarily uses bit-mapped graphics. Illustrator is geared to vector-based graphics. Describe the
difference.

2. What’s the principal difference between rotoscoping a two-second Adobe Premiere Pro clip in Photoshop
versus After Effects?

3. What’s an easy and quick way to see how multiple filters will look when applied to an image?
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Answers

1. Bit-mapped images are like photographs or paintings. Once you’ve created them, you can’t expand them
without causing some damage. When you blowup bit-mapped images, the graphics or video editing
software fills in the expanding gaps between the existing color bits with a best guess color. The more you
expand, the less distinct your image becomes. Vector-based graphics are defined by mathematical formulas
and are geared primarily to higher-resolution print media. As you expand or shrink them, they always
remain as sharply defined as the original image.

2. In Photoshop, you import that clip as a Filmstrip of still frames, then apply your hand-drawn artwork one
frame at a time. In After Effects, you work with the video clip itself. You can use the Paint tools to draw on its
first frame then use some effect and motion controls to animate it for the length of the clip. After Effects can
save an enormous amount of time.

3. Select that image’s layer in the Layers palette and then open the Filter Gallery (Filter > Filter Gallery). Select
one filter, click the New Effect Layer button (that adds a line for a new filter using the name of the first filter
you selected), and then click on another filter. You can add several filters, although more than about three
and your image can lose any resemblance to its original appearance.

Exercises

1. If you’re new to Photoshop, a great way to learn more about its many features is to experiment with it. Scan
or import some photos and then paint on them, apply special effects, and do touch-up work.

2. Create some graphics to use in a video production. Make sure you select one of the video pre-sets when you
start your document. Create separate layers for each new graphic element, then when you import the PSD
file into Adobe Premiere Pro, import it as a sequence—thereby separating the layers into individually
editable objects—and animate the individual layers so they end up in the same positions in which you
created them in Photoshop CS.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education

Adobe, the Adobe logo, Adobe Premiere, Adobe Audition, Adobe Encore, Acrobat, After Effects, GoLive, Illustrator, InDesign, Photoshop, and

Tools for the New Work are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other

countries. All other trademarks are the property of their respective owners.

© 2004 Adobe Systems Incorporated. All rights reserved.
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Module 24

Creating Animated Text with Adobe After Effects

Adobe® After Effects® is the de facto video and film industry-standard text animation and motion graphics tool.
If it moves on your TV set or movie theater screen, someone probably used After Effects to create it.

To cover it in depth would take more modules than I’ve written so far for this entire curriculum guide. It is a huge
program with incredibly deep potential. Working with it is akin to presenting an artist with every medium
imaginable and telling him to “be creative.”

Its tool set and possibilities can be overwhelming. What you do with it will likely amount to a sub-set of its
creative prospects. So, my intention in this and the next module is to introduce you and your students to its
powerful features. In this module, I take you all through several text animation tasks. In the next module, I go
over some of its special effects, paint, and motion graphics tools.

At the end of this lesson, students will have learned about:

• After Effects  background

• After Effects’ tight integration with Adobe Video Collection

• Creating text in After Effects

• Text animation—one or more characters at a
time

• Examining animation presets

After Effects Background

Recently you might have noticed a change in video
production techniques. Suddenly, it seems, text is flying
all over our screens. Advertisements, kids’ programs,
and entertainment shows feature jittery, shifting,
ambling, and rambling text. Why the sudden shift?
Animated text features added to Adobe After Effects 6.0
and supplemented in version 6.5.

FIGURE 24.1: After Effects  is the industry leading motion
graphics, animated text, and visual effects tool.

After Effects 6.5 features new, easy-to-use, and wildly imaginative text animation tools. And video production
houses around the world, most of which rely on After Effects for their day-to-day visual effects work, have
enthusiastically exploited these new tools.

In addition, they’ve started using After Effects 6.5’s new Adobe Photoshop®-style vector paint tools and its
improved motion graphics features.
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As you ramp-up your Adobe Premiere® Pro skill set, you might want to consider using After Effects 6.5 in your
productions. It is the tool-of-choice for editors who want to produce exciting and innovative motion graphics,
visual effects, and animated text for film, video, DVD, and the Web.

Top Ten New Features of After Effects 6.0 and 6.5

After Effects 6.0 and 6.5 have numerous new features. Topping my list are Paint and Text creation tools ported
from Photoshop. No longer do After Effects editors have to switch back and forth between programs to handle
these fundamental functions. Here are my favorite new features:

1. Text creation and groundbreaking text animation tools and presets—Create animated text with
unprecedented ease. Type and edit text in the Comp window, define character-level animations, and
much more. And use the more than 250, professionally designed, text animations presets added to
version 6.5 to simplify otherwise complex motion.

2. Fully integrated vector paint tools—Use built-in vector paint tools based on Photoshop technology
to perform touch-up and rotoscoping tasks.

3. Motion Tracker—Get significantly faster and more accurate results using the new Motion Tracker to
isolate and track the motion of an element on a layer (Professional edition only). With version 6.5, a
handy magnification tool makes motion tracking even more accurate. And now you can adjust the scale
of the object linked to the tracking (for example, an effect like steam emanating from a model train
smokestack) and limit tracking to just the horizontal or vertical movement of a scene.

4. New grain management (professional edition only) and color correction tools—Add Grain, Match
Grain, and Remove Grain help video footage look more like film or minimize grain differences between
various film stocks. Color Finesse (a $595 retail value) is a professional color processing system offers
dozens of tools to help you correct or fine tune color in your footage.

5. Keylight—Create award-quality mattes using the new Keylight keyer. Built-in spill suppression,
secondary mattes, and other tools make fine-tuning results easy (Professional edition only).

6. Impressive performance gains—Be more productive thanks to performance optimizations such as
OpenGL support, background rendering, customizable Keyboard shortcuts (like Adobe Premiere Pro),
and optimizing performance based on hardware characteristics.

7. Leading-edge visual effects—Create visual effects using more than 100 plug-ins to blur, sharpen,
distort, shatter, and more. The nearly 80 new effects added to versions 6.0 and 6.5 include a collection
from Cycore, the original developer of After Effects (the Cycore effects are not included in the Education
version of After Effects). You now can add sparks and smoke using Particle World tap the power of
Liquify, Warp, Scribble, and several dozen other new effects.

8. Render automation and intelligent disk caching—Automate production tasks, including managing
the Render Queue, with JavaScript-based scripts that save time and help ensure consistency
(Professional edition only). And Intelligent Disk caching extends the power of RAM previews so you
spend less time re-rendering as you make changes.

9. Tight Adobe integration—Work with rich content: Import Adobe Photoshop and Adobe Illustrator®
files with layers and other attributes preserved. Save an After Effects frame as a Photoshop file and
nested compositions become editable, Photoshop layer. In Windows, import Adobe Premiere Pro
projects and export motion graphics for use as menus in Adobe Encore™ DVD. With version 6.5, you
now can copy and paste Premiere Pro sequence segments into After Effects, retaining all track layers
and effects.
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10. Enhanced interface—Work more intuitively with streamlined Item, Footage, and Comp windows,
improved options for solid layers, Effect Favorites, and other refinements.

After Effects  Users—Two Camps

After Effects  users tend to fall into two distinct camps: Motion Graphics artists and Animated Text artists. Some
production houses specialize in one or the other. There is so much that After Effects  can do, it’s darned hard to
wrap your brain around all of it. So I’ll focus on one main area at a time.

After Effects  does have a steep learning curve. So, rather than present a collection of tips or a series of tasks that
would require a massive amount of explanation just to get you up to speed, I will attempt to keep my tasks
focused and introduce only a sampling of After Effects  features.
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After Effects’ Tight Adobe Video Collection Integration

If you migrate to After Effects , you likely will use it to add special motion effects to Adobe Premiere Pro and
Photoshop projects. Importing them into After Effects  is easy. Simply start After Effects, double-click in the
Project window and select a Premiere Pro project. After Effects will ask you if you want to import all sequences or
only a specific one and whether you want to import audio, then click OK. Once imported, double-click on a
sequence to open it. Figure 24.2 shows the Saleen Adobe Premiere Pro project you worked on earlier in this
book.

FIGURE 24.2: Imported Adobe Premiere Pro projects retain their effects and transitions into After Effects .

As with Adobe Premiere Pro, After Effects  has a Project window, but the icons and terminology are a bit
different. For instance, Adobe Premiere Pro Sequences become Compositions or “Comps” in After Effects .

Double-clicking a Sequence/Composition opens it in the Timeline window. Each numbered line is an asset or
effect from the original Adobe Premiere Pro project. Instead of tracks, you work with layers in After Effects .

Edits, effects, dissolves, motion keyframes, transparencies, nested sequences, crops, and clip speed changes built
in the Adobe Premiere Pro project are all maintained when imported into After Effects .
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As shown in Figure 24.3, those elements take on a different look in After Effects . Even with the highlighted basic
cross dissolve, you have the option to control it to the minutest detail. As with Adobe Premiere Pro 1.5, you can
apply keyframe parameters and Bezier curves to create the motion exactly as you envision it plus  you can
smooth the dissolve, and speed it up or slow it down as it approaches a keyframe. You can do that within After
Effects for dissolves and just about any other Premiere Pro effect.

FIGURE 24.3: After Effects  enables you to have absolute control of the minutest detail of virtually any effect.

You can also import Photoshop layered files into After Effects . Figure 24.4 shows a DVD menu that you will work
with in Module 26, “Authoring DVDs With Adobe Encore DVD.”
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FIGURE 24.4: You can import Photoshop graphics into After Effects  and preserve all their layers and characteristics.

The Project window displays each Photoshop layer. You can apply effects to each layer, put each in motion on
separate paths, and animate and scale the text. Basically, you can start with a static, layered image and turn it
into an animated, video menu that you can use in your DVDs.

For those of you who work with Adobe Illustrator, those files, too, can be imported into After Effects  while
retaining their layers.

Working with Text Created in Photoshop

After Effects  lets you take text created in Photoshop and convert it to editable After Effects  text. Meaning it will
now behave as if you created it directly in After Effects . That opens the door to creative potential beyond
anything you can imagine.

Figure 24.5 gives you an idea of what that entails. You can add text animation features to this composition layer,
change attributes and apply them over time using keyframes.
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FIGURE 24.5: After Effects  can convert text created in Photoshop to text you can animate down to a character-by-
character basis.
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Creating Text in After Effects

The new Text tool in After Effects  will look mighty familiar to anyone
who has worked in Photoshop. Take a look at Figure 24.6. By clicking the
highlighted text tool, I opened the Character and Paragraph palettes.
You can select from all of your PC’s type fonts, apply foreground and
background colors, add strokes (borders around each character), plus
perform just about any other standard Photoshop-style text task. It’s not
as full-featured or robust as either Photoshop’s text tool or Adobe
Premiere Pro Title Designer, but it will handle most of your text needs.

FIGURE 24.6: Anyone familiar with Photoshop will welcome the addition of
this familiar tool set to After Effects .

Task: Creating Text
It’s a simple matter to choose the Text tool, add a bounding box to a
video clip, set the font and its size, and then type in your text message.
Once written, you can select a portion of the text and apply different
font-style attributes. Here’s how:

1. Open After Effects . You will see a nearly empty user interface
with only a small Project window. You will add
Compositions—or Comps in After Effects  parlance—to that
Project. To do that, select Composition > New Composition.
Since the focus of this curriculum guide is video, select one of
the video presets. As shown in Figure 24.7, I chose NTSC DV.
Give your Comp a name, accept the other defaults (in particular the 10-second duration), and click OK.
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FIGURE 24.7: Set your project parameters in the Composition Settings dialog box.

2. Your interface now includes a Comp window, a Timeline window, and a collection of Tools and some
other palettes. You’ll add text directly to this Comp. Select Composition > Background Color and give
your Comp a color other than the default black (I chose gray to make it easier to see the text).

Tip: Make Those Palettes Disappear

As is true for all things Adobe, you’ll find that keyboard shortcuts for one product frequently work on others
in the Adobe line. Pressing Tab will make the palettes disappear or reappear. This is one way to pick up a
little extra screen real estate.

3. In the Tools palette (if it’s not open, select Window > Tools), select the Text tool and click and drag a text
bounding box in your Comp window. As shown in Figure 24.8, just as you can in Photoshop and Adobe
Premiere Pro, you can change the font, its size and color, and add strokes. The two color boxes in the
upper right corner specify the font and stroke color as well as whether they’re activated (clicking the
small box with the red diagonal line will turn off the display of whichever color box is in front).
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FIGURE 24.8: Add text directly to a Comp
using the Text tool in the Comp window.

4. Take a look at the Timeline shown
in Figure 24.9. When you add text
to a Comp, After Effects
automatically names that text
layer with whatever you’ve
written. Twirl down the new text
layer’s disclosure triangles and
note some similarities with
Premier Pro’s Motion and Opacity
effects. After Effects  has the same
keyframable parameters – Anchor
Point, Position, Scale, Rotation and Opacity -- along with a couple additional options. You can add
many, many other parameters to this text layer or any other object in the Timeline. I explain how to do
that and offer up a few examples in the upcoming tasks.

FIGURE 24.9: If you add text to a Comp window, it shows up in the Timeline with a number of default parameters.

5. Feel free to set keyframes for any of the Transform parameters, drag the CTI (Current Time Indicator)
into the project, and change those parameters (click on a stopwatch to switch on keyframes). Then
press the Play button in the Time Controls palette (or drag the CTI) to see your work.

6. You can move your text in 3D space. Do that by switching on the 3D button. To do that, click the empty
box below the 3D rectangle, highlighted in Figure 24.10, to add that rectangle to that box and turn on
3D. That adds the X/Y/Z axis circled in Figure 24.10. Place the Selection tool cursor over the end points
of the X/Y/Z axis to select one of the three directions and drag the text. Click the Rotation tool (next to
the Selection tool) and drag it in around on the text in your Comp window. It will spin all over the place.
Any new location or move you make is keyframable.
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FIGURE 24.10: Switching on the 3D functionality (the small rectangular box) adds an X/Y/Z axis. Using the Rotation
tool lets you add some wild motion to your text object.

7. Instead of creating text only on a blank slate, you can place it over an image or video and adjust it to fit
the background. To do that, import the demo project included with Adobe Premiere Pro:
Sample_NTSC (or PAL).prproj. Select File > Import > File, select the appropriate .prproj, file and click
Open.

8. Take a look at your After Effects  Project window now. Twirl down all the disclosure triangles. As shown
in Figure 24.11, depending on whatever work you did in the original Adobe Premiere Pro project, it’ll
include all sequences, media assets, and Photoshop files (and layers).
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FIGURE 24.11: Opening the Adobe Premiere Pro project you
worked on adds all its assets, sequence’s and layered
graphics to your After Effects Comp.

9. Drag a video to the Timeline window (I chose
Saleen_Car_08.avi), and note that it adds a new
layer and shows up in the Comp window.

10. Delete your text or click its eyeball (Photoshop-
style) to turn off its display in the Comp window.
Type in a line of text. In Figure 24.12, I used a
couple different text styles.
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FIGURE 24.12: You can add text in a layer above a video or static background.

11. With the new text layer selected (click on it to highlight it in the Timeline), click the Pen tool (to the right
of the Text tool) and draw a path using the same techniques you used in Adobe Premiere Pro (and
Photoshop). Click on the new RotoBezier check box in the Tools palette to smooth the curve. Finally, put
that text on this new path by twirling down Text and its Path Options in the Timeline and setting Path to
Mask. Use Figure 24.13 as a reference.

FIGURE 24.13: Use the Pen tool to draw a curved line, on which you will place the text you just created.
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12. Now put this text in motion on this path. To do that, in the Text layer in the Timeline window, set
Animate to Tracking and set Tracking amount to 20 (that spaces the text).

13. Set Keyframes to animate First Margin and Last Margin, and click and drag on each setting to move the
text on the path. You can also use keyframes in the Text Layer’s Transform section to move the path and
change its shape to follow the motion of the car.

Text Animation—One or More Characters at a Time

After Effects  has a ground-breaking approach to text animation—per-character/word animation. Previously you
had to go through a laborious and tedious process to animate one letter or word at a time. Now, you tell After
Effects  how many letters or whole words to animate at any one time. And with the release of After Effects 6.5,
you now can tap more than 250 professionally designed text animation presets. We’ll start with simple
animations.

Flying Text

There are so many text animation and effects possibilities, it would be impractical to go over them here. Instead,
I will give you some barebones examples with some basic instructions, and you can use what you learn here to
try them out. This example gives flight to your words:

1. You can use the text you created for the previous task or start a new Comp. If you use your existing
comp, remove the Path you created by selecting it and pressing Delete.

2. For the Text layer, select Animate > Position. That adds a new set of parameters to your Text layer called
Animator 1. You can rename it by clicking it and typing in a new name—this comes in handy when
you’ve added many animation parameters to a Comp.

3. Twirl down Animator 1 > Range Selector 1 and set the Position parameters to move your text below the
bottom center of the screen(50, 350 should work in this case). Alternatively, you can click on the
“Position” (the word “Position” in the Animator 1 group, not “Position” in the Transform group), use the
Select Tool (keyboard shortcut ‘V’ – same as in Premiere Pro) to move the text off-screen.

4. Turn on keyframes for Start, set the Start value to 0%, move the CTI into the clip a few seconds, and set
the Start value to 100%. You’ll see that your text will suddenly appear back on screen. If you drag the CTI
around, you’ll see the text jump from beneath the screen, one letter at a time.

5. Add additional characteristics to this text animation using the Animator Add button. To do that, click
the Animator 1 Add button and select Property > Skew. Skew will show up as a new parameter.Set its
value 45.

6. Click the Animator 1 Add button again and select Property > Opacity. Set that to 0% (meaning the text
will start animating at 0% opacity and gradually increase to 100%).

7. Click the Animator 1 Add button yet again and select Selector > Wiggly. Twirl down the newly added
Wiggly Selector 1 and feel free to accept the defaults or to change any of its nine parameters. The
options are plentiful.

8. Finally, open Range Selector > Advanced. This is where you choose whether you want to have the
characters animate one-at-a-time or in some other fashion. I will give you a more detailed overview of
that process in the next task. You can fine-tune how Wiggly performs (including changing text colors)
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using the various parameters. Drag your CTI (or do a RAM preview in the Time Controls palette) Your
text should look something like Figure 24.14.

FIGURE 24.14: In this example, you set a start and end location for the text, skewed them, had them start at 0%
opacity, put in a little wiggle, and animated their colors.

Per Character Text Animation

This will demonstrate how to select characters in a group and animate across an entire phrase.

1. To set this up, turn off all the layer eyeballs and click all the opened disclosure triangle (to free up some
Timeline real estate) to return your Comp view to its original solid color background.

2. Select the Text tool, select a font, and type in a phrase that fits the width of the Comp window.
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3. Twirl down the Text layer in the Timeline window, click on the Animate button and select Scale. Change
Scale to 300% (the two values are linked by default, so changing one will change the other).

4. Twirl down Range Selector 1 and set the end parameter to 0.

5. Change Range Selector 1 > Advanced > Units to Index and set End (under Range Selector 1) to 3 (that
will animate 3 characters at a time). Note that in the Comp window you can change that range by
dragging the Grey Triangle that shows up when the Range parameter is active.

6. Move the CTI to 0:00 and set Offset to –3, Start 0, and turn on Keyframes for Offset (these changes starts
the animation three characters before the first character—meaning the characters will be the regular
size at the start of the animation).

7. Move the CTI to the end of the Timeline and set the Offset to the number of characters and spaces in
your phrase plus 3 (I set mine, in Figure 24.5, to 27). Things will look a little scrunched together. The next
step will fix that.

8. Select Animator1 > Add > Property > Tracking and set the Tracking amount to 30. That will space the
text properly.

9. Close the Animator 1 disclosure triangle (to free up space in the Timeline window), and in the Text line,
select Animate > Fill Color > RGB (Red is the default, but you can change that and even animate color
changes  over time using keyframes). In this case, rather than select a different color or colors, you’ll use
Wiggly to get a little crazy in the color department.

10. Twirl down the newly added Animator2, press Add > Selector > Wiggly and scrub (If you increase the
Min Amount to something greater than zero, the color will fall into a smaller range). Your Comp should
look something like Figure 24.15. Feel free to play with the Wiggly parameters, and note how it effects
the text colors.
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FIGURE 24.15: Animate on a group of characters using Range parameters and change colors using Wiggly.

Animating Text Outlines

One very cool trick is to animate the outlines of text. This works real well on large type. To do this, follow these
steps:

1. Turn off all the layer eyeballs to return to the original solid color background.

2. Select the Text tool, select a font, and type in two characters.

3. Select the Text and increase the font size by clicking next to its numeric value in the Character palette
and dragging until it gets to around 200 or so. Notice that as you increase text size, the text looks blurry
for a moment, but then After Effects  recalculates the text (it’s vector-based), and it gets suddenly crisp
again. Even 200 point text looks sharp.

4. From the Main Menu, select Layer > Create Outlines. That creates a new layer with the word Outlines
added to the original Text layer’s name. Turn off the display of the original Text layer by clicking its
eyeball in the Timeline window.

5. With the Outlines Layer selected, select Effects > Render > Stroke.

6. In the newly opened Effect Controls Window (shades of Adobe Premiere Pro), click the All Masks check
box and set Paint Style to On Transparent.

7. Select View > Hide Layer Controls (this gets rid of bounding box and handles in Comp window).

8. In the Timeline window, twirl down the Outlines text layer and its newly-added Effects and Stroke
disclosure triangles to reveal several keyframable parameters that match those in the ECW.

9. Move the CTI to 0:00, set End to 0%, switch on keyframes, move the CTI to the end of the timeline (press
the End shortcut key), and set End parameter to 100%.

10. Now RAM preview. Your two-character animation should paint on and look something like Figure 24.16.
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FIGURE 24.16: Use the Outlines effect to animate a text outline.

Animating Text Interiors

Using the setup you just worked on, you can animate within that large text as well. Here’s how to do it:

1. With your text Outlines layer selected, select Effects > Render > Scribble.

2. In the ECW (you can click the Stroke disclosure triangle to save some space), change Scribble to All
Masks, Fill Type to Inside, and Composite to On Transparent (you can try all three options—Reveal
Original Image will draw a scribble along the outline you just created).

3. Once again, in the Timeline window, twirl down the newly added Scribble effect disclosure triangle,
and, using keyframes, set End to 0% for the first frame and 100% for the last frame of the animation.

4. RAM preview. It should look something like Figure 24.17.
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FIGURE 24.17: Two ways to animate the interior or edges of text with the Scribble effect.

5. Feel free to adjust other options like Angle, Stroke Width, Color, Wiggle Type, and Wiggles/Second. You
can turn off the Stroke effect by clicking the little “f” next to its name in the ECW. That, too, will change
how this Scribble effect works. And you can turn on the original Text layer’s eyeball to see how these
animations work with it.

There are many other After Effects  text animation characteristics. Letters can bounce, move through 3D space,
twist, bend, curl, flip, invert, change colors and opacities, and even change randomly to different characters or to
pre-selected words. I leave it to you and your students to test out the many parameters available within the Add
and Animate menus built in to any text layer in the Timeline window.
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Examining Animation Presets

New to After Effects 6.5 is a collection of
professionally designed, animation presets. To
get an idea of their depth and versatility, check
out the After Effects 6.5 Help Files.

To do that select Help > Text Preset Gallery.
Select a group from the 15 subsets and watch
as they animate in your browser. Figure 24.18 is
a few of the nearly 300 text animation presets
available.

Figure 24.18 Open After Effects 6.5’s help file
and navigate to the Gallery of Text Animation
Presets to see animations of how each works.

Here’s how you apply a text animation
preset to text. Open the Effects and
Presets palette by selecting Window >
Effects & Presets. Click the Animation
Preset’s disclosure triangle to reveal the
15 preset categories. Open a category of
your choice and select a preset (as
shown in Figure 24.19, I selected Red
Circles from the Graphical preset
collection.

Figure 24.19: To use a Text Animation
Preset, simply drag and drop it on the Text
layer name in the Timeline window or on
the Text itself in the Comp window.

Simply drag and drop the selected
preset directly on the text in the Comp
window or on the text name in the
Timeline window. Note how that adds
several parameters – typically additional
Animators and Effects. You probably will
need to twirl down a couple disclosure
triangles to see that and twirl down a
few more to see all the parameters
within each Animator. In my case,
adding Red Circles added two Animators
(with unique names to help identify
them) and a Wiggle Frequency effect.
You can tweak all these parameters to
suit your needs or curiosity.

Once you take a look at all that goes into each of these presets you begin to see their value, not only as cool
effects but for all the time you’ll save.
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Those viewing After Effects  for the first time might find its wealth of possibilities daunting. It’s so big that many
production houses literally specialize in either its text animation features or its motion graphics tools.

Its tight integration with Adobe Premiere Pro, Photoshop, and Adobe Encore DVD make it an integral part of
your DV production process.

In this Module, I gave you a taste of what it can do on the text animation front. Using Photoshop-like text tools,
you can easily create text. Then using After Effects’ Pen and 3D Rotation tools, you can move that text along a
path or in 3D space. In particular, After Effects  enables you to animate text on a per-character basis. Using the
new Wiggly feature gives some fun randomness to your text animation and colors. And finally, the nearly 300
text animation presets that ship with After Effects 6.5 give you immediate access to professional quality and
labor saving animation tools.

Q. When I add text to a Comp, there aren’t all that many parameters available for it. How is it that the
examples in this module had so many?

A. Instead of overwhelming you with tons of options, After Effects  enables you to add parameters of your
choosing. With text in particular, use the Add and Animate wing-out menus to access many of those parameters.
In addition, as you add effects, as you did with Stroke and Scribble, parameters associated with those Effects
show up in the Timeline window as well.

Q. As long as I can put Photoshop graphics in motion in Adobe Premiere Pro plus apply keyframable
animated effects to video, why use After Effects  to do just about the same thing?

A. Adobe Premiere Pro is a professional quality tool with a full feature set. But it has some limitations when
compared to After Effects . You can animate text by “crawling” it or “rolling” it, but you can not begin to apply all
the wild twists, turns, and character-based effects available in After Effects . Adobe Premiere Pro can handle the
bulk of your day-to-day video editing needs, but if you want to match some of the really high-end video effects
you see mainly in high-budget advertisements and Hollywood films, you’ll need to move up to After Effects .

Quiz

1. How do you work on an Adobe Premiere Pro project in After Effects ?

2. When creating text, how do you add an outer stroke?

3. How do you animate one character at a time over the entire length of a text line?
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Answers

1. Import that project by selecting File > Import > File, selecting your Adobe Premiere Pro .prproj file, and
clicking Open. Or, just as you can in Adobe Premiere Pro, double-click an empty space in the Project window
to open the Import File dialog. No need to import specific assets. After Effects  brings in everything you
associated with your original Adobe Premiere Pro project.

2. The text Character palette has two color boxes in the upper right corner—a solid color text interior color
selector and a square-in-a-square for the Stroke. Click the Stroke color selector, choose a color, and then set
the Stroke width using that selector in the left middle of the Character palette.

3. Once you create text on a Comp, After Effects  adds that text layer with an Animate button. Select an
attribute in that Animate button’s wing-menu list (like Scale), and that adds a Range Selector option to the
Timeline. Twirl down the Range Selectors Advanced parameter and set Units to Index and Based On to
Characters. In the Range Selector, set Start to 0, End to 1 (that’s your 1 character animation), move the CTI to
the first frame, turn on keyframes for Offset and set it to –1. Now move to where you want the text
animation to end, and change Offset to the number of characters and spaces in your text string. Now you
need to change an attribute in the Animator 1 group like Scale or Position. Drag the CTI and your text string
will exhibit that behavior, one character at a time.

Exercises

1. The only way to get proficient with text animation is to practice. Create some text and apply effects and
animation to it over brief spurts of time, using keyframes to isolate individual animation attributes. You can
also use keyframes to switch words mid-Comp. Simply turn on keyframes for the Source parameter, move
the CTI to a new position, highlight the portion of the text you want to change, and type in some new text.
When you RAM preview, that new text will replace whatever was there before it.

2. If you have the Adobe Video Collection Standard Edition, then Motion Tracker will not be in your version of
After Effects . The trial version of After Effects  does have Motion Tracking (it doesn’t have Keylight).
Download the trial version and take Motion Tracking for a test drive.

3. Start taking a closer look at TV advertisements with high production values. Knowing what After Effects  can
do, try to spot vide edits that equal or go beyond what you can do with Adobe Premiere Pro. Try to figure
out generally how they did them. Compile a list of the effects that you think are the most effective and see
whether you can duplicate them in Adobe Premiere Pro or in After Effects .

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education
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Tools for the New Work are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other

countries. All other trademarks are the property of their respective owners.
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Module 25

Creating Motion Graphics With Adobe After Effects

The animated text examples in the previous module gave you an idea of how you can move objects through 2D
or 3D space in Adobe® After Effects® . You can apply motion to any object, and you can give that object’s motion
keyframable parameters that change its characteristics over time.

What makes this different than similar keyframable motion effects in Adobe Premiere® Pro is the minute level of
control you have over the motion (including speed, curves, and the use of 3D space) and the number of special
parameters.

I’ll introduce that motion graphics concept with some simple paint and touch-up examples, show you a few
special effects, then go over two higher level chroma key and motion tools.

At the end of this lesson, students will have learned about:

• Using After Effects  painting and touch-up tools

• Working with effects

• Accurate and fast chromakeying with Keylight

• Putting effects in motion with the new Motion Tracker

Using After Effects  Painting and Touch-up Tools

After Effects  includes a new set of Adobe Photoshop®-style paint and touch-up tools. You can use them simply
to create some wild, animated art and, as shown in Figure 25.1, to apply rotoscope-style animation to video. The
huge advantage when using After Effects  instead of Photoshop to do rotoscoping is the ability to animate it
over time instead of tediously applying it on a frame-by-frame basis.
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FIGURE 25.1: Use After Effects ’s Photoshop-style paint tools to apply rotoscope-style animation to videos.

The paint tools, along with the additional Photoshop-style Clone tool, enable you to repair problem areas in a
video. Figure 25.2 shows the paint tools and brushes. It’s a simple matter to use the eyedropper tool to select a
color right next to that black smudge in the car door and then select a soft-tipped brush to fix that smudge.
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FIGURE 25.2: After Effects  uses Photoshop-style paint and touch-up tools that let you fix video miscues on a frame-
by-frame basis if need be.

By using keyframes, you can apply touch-ups to multiple frames to track any movement in the video clip. That
work can be mighty tedious—to fix this two-second clip required applying touch-up work to several dozen
frames.

After Effects  has a solution. Its new Motion Tracker can automate this touch-up process as well as perform some
much more dramatic effects. I cover it later in this module.

Painting with After Effects

Working with the Paint tools is slightly different than working with the Text tools. When you create text, you
automatically create a new layer in the Timeline window and you work directly in the Comp window.

With Paint, you need to open a specific layer in a separate window and apply the paint to it. Making that
adaptation requires only a couple extra mouse-clicks. To see how your work effects the rest of the comp, you can
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drag its layer tab out of the Comp window and view the Comp and the layer side-by-side. This is yet another
reason why editors who work with After Effects  and Adobe Premiere Pro like to use dual monitor systems.

Task: Using the Paint Tools
What makes Paint in After Effects  so much more powerful than in Photoshop,
for instance, is that every paint characteristic is keyframable. You can animate
brush strokes, colors, and brush dynamics—diameter, angle, hardness,
roundness, and so on. Here’s a basic overview:

1. Open a new Comp by selecting Composition > New Composition
and selecting a TV preset.

2. Give your Comp a solid background using a different method than
you used with the text exercises. In this case  select Layer > New >
Solid. Select Make Comp Size so the layer matches your TV preset,
and either accept the default black color or give it a new color by
using its color picker.

3. Double-click on the solid layer in the Comp window or Timeline to
access it in its own Layer window (as I mentioned earlier, painting
happens in the Layer window as opposed to directly on the Comp).

4. Open the Tools palette (Window > Tools) and click on the Paint tool
(highlighted in Figure 25.3). That opens the Brush Tips and Paint
(both within the same palette) As shown in Figure 25.3, you can drag
one of the tabs outside the palette to create its own palette. Also
note that the Brush Tips palette is expandable (it has little dots in the
lower right corner to let you know), so feel free to open it up a bit as I
did in the Figure 25.3.

5. Select a Brush tip and note that you can change its diameter, put it at
an angle, change its roundness (turn it into an oval), alter its hardness
(more or less diffusion around its perimeter), and switch on and
update spacing. Select a color and paint some strokes on the Solid
layer window.

6. Take a look at the Timeline window and your Solid Color layer in that
Timeline. Note that After Effects  has added an Effect parameter to
that layer. Open it to access its Paint parameter and then open Paint.
Note that each brush stroke has its own layer in this Comp. This is an
amazing level of control. As shown in Figure 25.4, you can slide each
brush stroke into the Timeline a bit to have each one pop on-screen
individually.

Note: What is Spacing?

Spacing is the distance between the brush tip marks in a stroke. The
value is a percentage of the brush diameter. When this option is
deselected, the speed of the cursor determines the spacing.

Figure 25.3: After Effects  Paint
tools include Brush Tips and Paint
options.
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Figure 25.4: After Effects  gives each brush stroke its own layer. I stair-stepped them to have each stroke appear on
screen in the order I drew them.

7. As if putting each brush stroke into its own layer is not detail enough, note that each stroke has its own
disclosure triangle. Click one, and click its Stroke Options parameter. Here you can alter each stroke’s
characteristics using the same parameters available in the Brush Tips and Paint palettes. As shown in
Figure 25.5, I changed each stroke’s color. Note that these are all keyframable. That is, you can change a
stroke’s tip size, color, hardness, and so on, at any point in the Timeline.
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Figure 25.5: The level of detail for the brush strokes goes well beyond putting each in a separate layer. Twirl down a
stroke’s disclosure triangles to access the many keyframable parameters like Color.
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8. Now we’ll go beyond simply popping each stroke onscreen. We’ll animate them in such a way to make
them come on screen just as you painted them in the first place. To do that, Select Brush 1, expand its
Stroke Options subgroup, move the CTI to the first frame (press the Home shortcut key), switch on
Keyframes for the End parameter, set End to 0%, move the CTI in a couple seconds, and set End to
100%. Now drag the CTI or RAM preview and watch as that stroke animates just as you drew it. You can
do the same for the rest of the Brushes.

9. You can paint directly on a video. Simply drag a video clip to your Timeline window. Double click its
layer to open it in its own Layer window and draw directly on that clip. Once again you can access each
Brush Stroke in the Timeline window, and you can use the Transform parameters to have your paint job
follow the motion of the object you colored in the clip.

Note: Rotoscoping, After Effects  Style

Step 9 is an example of Rotoscoping. I covered it in Module 23, “Photoshop in DV Projects: Still Images and
Layers.” But in this case, you don’t have to apply the rotoscoping on a frame-by-frame basis. Here you simply
change the Transform parameters to have it follow the action and alter the Stroke Options to animate things
like brush tip size and paint color. This is yet another example of how After Effects  can speed up production
and enhance your DV project.

Using the Clone Tool for Touch-ups

This next task demonstrates how to touch up a video clip on a frame-by-frame basis. It can be tedious and time-
consuming work, depending on how many frames need changing and how much motion there is within the
video clip.

Task: Repairing Video with the Clone Stamp Tool
The After Effects Clone Stamp tool works just as it does in Photoshop except in the case of After Effects, you
likely will apply a clone to multiple frames. Basically, you select a portion of the video clip to serve as the patch,
then apply that group of pixels to the area that needs fixing. As with Paint, you do it directly on the layer of the
asset that you’re fixing rather than work directly in the Comp window.

New to After Effects 6.5 is the ability to see the clone stamp tool's current sample point, as well as the entire
source layer, directly in your target layer as you paint over multiple frames. This gives you much more control.
You might need to do cloning on a frame-by-frame basis, but, as you’ll learn later in this module, you can use the
Motion Tracker to automate that process. Here’s how to do it:

1. Either open a new Comp or switch off the display of the layers in your current Comp. Add a video
snippet to it that might need some repair work. In the case of Figure 25.6, I want to get rid of that little
plane. Double click that clip, either in the Timeline or Comp window to open it in its own layer window.
Just as when working with Paint, you need to do your cloning in a separate layer window.
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Figure 25.6: It’s a simple matter to use the After Effects Clone tool to rid the skies of
that pesky little plane.

2. In the Tools palette, select the Clone Stamp tool (highlighted in Figure
25.7). That opens the Paint palette, which displays a few options
specific to cloning. In this case, set Duration to Constant, deselect
Aligned  and select Lock Source Time.

Figure 25.7: The Clone Stamp tool opens the Paint and Brush Tips palettes you
used previously. In this case, the Paint palette has several other options.
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3. From the Brush Tips palette, select a brush to suit your circumstances. In my case, I selected an oval
brush that matched the size and angle of the little plane I wanted to remove.

Tip: Video Cloning Advantage

In Photoshop, when repairing still images, you typically select a region from which you want to sample
some pixels by trying to find something in the image that works well to fix the place you want to repair. Not
necessarily an exact science.

Repairing video with the Clone tool has at least one advantage. You can replace something (the plane in my
case) with whatever was there before the plane arrived (in this case, blue sky). I think you’ll see what I’m
talking about when you move on to Step 4.

4. How you make your repairs will depend on your video. Here’s what I did. I moved the CTI in a couple
seconds, placed my Clone
tool over the plane, pressed
Home to move the video to
its first frame without
moving the Clone tool, and
I sampled that spot in the
sky (Alt-Click for Windows
and Option-click for a Mac).
Then I moved the video so
the plane was back in
position, and I clicked the
Clone Stamp tool icon (in
my case, an oval) there
(you’ll note, as shown in
Figure 25.7a, that in version
6.5 of After Effects, you now
see the entire Source video
frame overlaid on the
Target frame to better help
you adjust the placement of
the clone).

Figure 25.7a: After Effects 6.5 adds a
Clone Source Overlay option to help
you identify the sample area more
easily.

5. In the Timeline window, I twirled down the newly added Paint Effect, then Clone 1, and finally its Stroke
Options. I set a keyframe for the Clone Position.

6. I pressed End to go to the edit-out point of the video, rolled my cursor over the plane and noted its
position in the Info palette. I typed in those X/Y figures in the Clone Position settings to set that ending
position for what amounts to a moving Clone.
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7. Then I twirled down Transform and set the exact same keyframes for its position Parameter. Thereby
removing the plane from my video.

I was able to automatically move the clone to follow the plane’s flight path because it was a linear motion. Other
clones don’t follow such a predictable path. In that case, you can create multiple clones for every changing
frame.

Working with Effects

After Effects 6.0 and 6.5  have nearly 70 new  new effects that enable you to correct and enhance your footage.
For example:

• Blur sharp-edged objects with the new Box Blur effect to create unique looks

• Remove, add, or match the grain or noise in an image with new grain effects

• Produce different hand-drawn appearances with new options for the Scribble effect

• The Warp effect transforms layers into geometric shapes, arcs, waves, and fish-eye lens views.

• Magnify simulates placing a magnifying glass over an area of the image.

• You can distort footage with Liquify’s 10 brush-based tools.

• Turbulent Displace uses fractal noise to create distortions.

Task: Try Out Some Cool Effects
Working with effects in After Effects  is a lot like working with Effects in Adobe Premiere Pro. Each effect typically
has a set of parameters unique to that effect. As you apply effects to a layer, they show up in the Effect Controls
Window (ECW), and you can adjust parameters globally or with keyframes there. You also can make the same
adjustments in the Timeline window. Here’s how it works:

1. Place a video clip, graphic, or text in your Timeline and select it to display it in the Comp window.
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2. We’ll start with Warp. It’ll look and act a lot like the Adobe Premiere Pro’s Distort and Twirl effects. To
access it, do what you did in Adobe Premiere Pro, open the Effects palette (select Window > Effects),
twirl down the Distort bin disclosure triangle (or type in Warp in the Contains window), and drag Warp
to the Comp window or to the selected layer in the Timeline window. Your interface should look
something like Figure 25.8.

Figure 25.8: You apply effects in After Effects  similarly to the way you do that in Adobe Premiere Pro.

3. In the ECW, try out the various presets such as Wave, Flag, and Arc. Move the other sliders as well as
grab the bounding box corners to change the size of your original clip.

4. Delete Warp or switch it off (click its little ‘f’ button) and try another effect: Magnify. As shown in Figure
25.9, this one highlights a square or circular portion of your clip and magnifies it. There are many
keyframable parameters, including its location and size.
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Figure 25.9: The Magnify effect highlights and magnifies a portion of your clip.

5. Try the Liquify effect. You can access it from the Effects palette or select Effect > Distort > Liquify. Figure
25.10 shows you its parameters. This may be a first for you: icons in an ECW. Liquify lets you manually
distort portions of an image. To see how that distortion works, you can turn on the effect’s Mesh view
which shifts and distorts as you drag one of Liquify’s 10 tools around the screen.
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FIGURE 25.10: Liquify uses a mesh as a guide so you can see the x/y axis changes as you drag one of its distortion
tools around the screen.

6. Finally, try Turbulent Displace. As shown in figure 25.11, this effect is a customized contortion creator.
Basically, if you can imagine some way to twist and bend a clip, Turbulent Displace can probably match
your imagination.
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Figure 25.11: Turbulent Displace deforms your clip in as many ways as you can imagine.

7. There are dozens more effects at your disposal. The best way to learn more about them is to try them.
Here are a few more cool ones worth checking out: Brush Strokes, Motion Tile, Scatter, and Block
Dissolve.

Accurate and Fast Chromakeying with Keylight

Keylight is a new addition to the After Effects  Professional version. It offers better, more powerful chroma keying
technology than you’ll find in Adobe Premiere Pro.

Keylight performs powerful chroma key analysis. It will retain things like reflections off the windows and will not
leave “jaggies” around actors’ hair.

Figure 25.12 shows the two shots that I’ll key. In print it’s difficult to see, but there are a few wisps of hair on the
right, and the windows have reflections.
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FIGURE 25.12: Combining these two images and retaining elements like reflections would be difficult if not
impossible without a powerful chroma key analysis tool.

Applying Keylight to the scene and tweaking a few parameters led to the perfect key shown in Figure 25.24

FIGURE 25.13: Keylight analyzes the scene and, with some user parameter adjustments, achieves a realistic keyed
effect.
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Putting Effects in Motion with the New Motion Tracker

After Effects  Professional’s new Motion Tracker enables you to accurately, quickly and painlessly follow motion
and then connect effects to those moving objects. You can track any number of moving objects and then link
effects directly to those objects. And new to version 6.5, you now have even greater motion tracking accuracy,
can track the scale of an object (having the effect attached to the motion tracker change size accordingly) and
limit tracking to only the horizontal or vertical movement of a scene.

As I mentioned earlier in this module, you can track something you want to touch up, then apply that touch-up
effect to the track (actually a collection of keyframes) and save a lot of time.

Its more exciting use is as a means to add cool effects to action items. You can highlight a skier by having a
transparent, color matte match his every move. Follow a golf swing, leaving an arc that shows the swing’s
characteristics. Or, in this coming example, add headlights and lens flare to race cars.

As shown in Figure 25.14, the race car’s headlights emit only a faint glow. After Effects  can fix that, and then
some.

FIGURE 25.14: This race car needs some extra visual pizzazz. I will use the Motion Tracker to follow its headlights,
then assign a cool visual effect to that motion route.
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Task: Applying Effects to Automated Motion Tracking
In previous versions of After Effects, motion tracking was a manual process. You marked a location and gave it a
keyframe, then moved the video forward and applied another keyframe, and so on. Now, with a few simple
mouse clicks, the Motion Tracker does all that for you in record time, and with precision. Here’s how to do it:

1. Place a video with some action you want to apply an effect to in your Comp’s Timeline window.

2. When you track motion, you need to apply an effect or text or some other object in the Comp to that
motion track. Add whatever it is you want to apply to your motion track, to the video in your Timeline.
In my case, I added the Lens Flare effect twice (select Effect > Render > Lens Flare).

3. Select Animation > Track Motion. That opens your video in a new window as a separate layer and opens
the Tracker Controls dialog box shown in Figure 25.15.

Figure 25.15: Using the Tracker Controls, you apply a target to a moving object, change a couple other parameters,
then have After Effects  automatically follow that motion.
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4. Check the Tracker Control settings to make sure the Motion Source is your video, that the Current Track
is Tracker 1 (I’ll add a Tracker 2
for the second headlight in a
moment), Track Type is
Transform, and Position is
checked.

5. Click Edit Target. As shown in
Figure 25.15, this is where you
tell After Effects  to what you
want to attach the motion. In
my case, it’s Lens Flare/Flare
Center (note that when you add
two effects to a layer, After
Effects  names the second
instance of that effect, “[effect
name]1”). I will apply Tracker 2
to Lens Flare 1 in a moment.

Figure 25.15a: Version 6.5 of After Effects
has a new feature for the Motion Tracker: a
400% zoom to help you find the exact pixel
to track.

6. Drag the Track Point 1 double-square/crosshair and center the crosshair on the object you want to
track. To drag it, click somewhere inside either the inner or the outer box. If you click on an edge, that
will expand the box, thereby increasing the area on the screen it has to examine to look for and track
the moving target. And if you click on the Crosshair, that will move the target outside the box. As shown
in Figure 25.15a, After Effects 6.5 has a new feature built-in to the Motion Tracker – an automatic 400%
zoom to help you find the exact pixel to track.

7. You can have the Motion Tracker analyze the video both by going forward and backward depending on
where in the video clip you have been working. In my case, I clicked the forward Play button in the
Tracker Controls dialog, the video played and the Track Point 1 box followed the targeted headlight
perfectly.
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8. When the Tracker completes the analysis, click Apply. As shown in Figure 25.16, that adds dozens of
keyframes to the Lens Flare Center’s line in the Timeline. Consider how long it would have taken to add
those keyframes manually and you begin to see the value of this very powerful tool. Depending on your
use of the Motion Tracker, you could now return to the Comp window and preview the animated effect.
I’ll hold on that until I add the second Lens Flare.

Figure 25.16: After analyzing your clip’s object in motion, the Motion Tracker adds dozens of keyframes to the Effect
you are attaching to that motion.

9. In the Tracker Controls dialog box, click Track Motion to add Tracker 2 to the Current Track drop-down
list. In the Edit Target dialog box, I apply that motion to Lens Flare 1. In this case, the Tracker jumped to
a glint on the bumper as the car rounded the turn, so I clicked the Stop button in the Tracker Controls
dialog box, backed up the video to a point where the tracker was on the proper object, and tightened
the Track Point’s inner box. I started analyzing the motion from that point and everything went
smoothly.

10. Figure 25.17 shows the results. The race car now has what appear to be bright headlights that throw off
a realistic lens flare as it moves through the scene. Now I can animate those lens flares, dimming them a
bit when the car is off in the distance and ramping up their brightness as the car moves forward. Very
slick.
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Figure 25.17: The completed motion tracking project applies two lens flares to the race, car simulating bright
headlights.
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The other After Effects  camp is motion graphics. You can apply motion to anything in a Comp. Using the
plethora of keyframable parameters means you can make the object behave any way you can imagine; for
example, distort, move in 3D space, follow a motion track, and change color.

After Effects ’s new Paint tools add tremendous functionality without forcing you to work in other programs to
do work at what amounts to a fundamental level. It’s easy to animate those paint strokes to rotoscope a video or
simulate handwriting.

Finally, two new major effects really make the Professional version of After Effects  shine: Keylight and Motion
Tracking. Keylight is a powerful chroma key analysis tool that preserves subtleties such as wispy hair and
reflections. Motion Tracking automates what was a laborious task: setting keyframes to follow an object in
motion, then applying an effect or object (like text) to that motion.

Q. I see in the Brush Tips palette that there’s a set of parameters called Brush Dynamics. What’s that?

A. You can use Brush Dynamics if you have a pressure-sensitive digitizing tablet such as one from Wacom. These
are standard tools-of-the-trade for graphic artists who use those tablets to draw just as if they were drawing on a
sketch pad. After Effects’ Paint tool reacts to changes in stylus pressure and angle by changing the appearance
of the paint effect as the artist draws. It’s a very powerful feature that’s worth checking out.

Q. When I add a video to a Comp by dragging it to the Timeline, it doesn’t start at the beginning of the
Comp. It starts a few seconds into it. And the end of the video is cut off. What’s going on?

A. When you drag an asset to a Comp’s Timeline, it places that asset’s first frame wherever you happen to have
the CTI at that moment. So if you want the video to start at the beginning of the Comp, press Home to put the
CTI on the first frame before dragging the asset to the Timeline. If the end of your video is not showing, that is
due to the original length that you set for your Comp. To make it long enough, right/option-click on its name in
the Timeline window, select Composition Settings, and change the duration.

Quiz

1. You want to write a name in cursive and have it animate on screen just as you wrote it. What’s the basic
means to do that?

2. What’s the one distinct difference between how effect keyframes are handled in After Effects  and Adobe
Premiere Pro?

3. What’s the basic process used to apply an effect to an object moving through a video?
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Answers

1. Use a Paint tool and simply draw onscreen with the mouse or a tablet tool. If you need to dot an ‘i’ or cross a
‘t’ ,that will add an extra brush stroke layer in your timeline, but you can add those for emphasis at the end
of your animation. Then in the Timeline, under each Brush Stroke, Stroke Options, turn on keyframes for the
End parameter, set the initial frame to 0% and the last frame to 100%. That will animate the cursive portion
of your writing. You can pop on the dotted ‘i’s or crossed ‘t’s either during that animation or to add a little
whimsy at the end.

2. In Adobe Premiere Pro, you can adjust keyframes only in the Effect Controls window (ECW). After Effects  lets
you apply keyframes in two windows: the ECW and in the Timeline window. This is yet another example of
the level of detail and control available in After Effects .

3. Add whatever it is you want to attach to that moving object (an effect, a graphic, text, touch-up artwork) to
its layer in the Comp timeline. Use Motion Tracking on the video and assign its output the object or effect
you’re going to animate. Then use the Motion Tracker analysis tools to add a series of position keyframes to
that element in your Timeline.

Exercises

1. Practice, practice, practice. Use the Paint tools to create some art or cursive writing, and use keyframes to
animate it or have it follow action.

2. Check out After Effects  effects and use keyframes to apply their parameters at different points. You can turn
some static graphics into some wild animations this way.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education
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Module 26

Authoring DVDs with Adobe Encore DVD

Your students are undoubtedly itching to create multimedia DVDs—with menus, buttons, videos, music, and still
images. In this module, I introduce them to Adobe® Encore™ DVD, giving them some basics as a means to get
them started along the path to DVD authoring.

I present an overview of the authoring process, take them on a tour of Adobe Encore DVD, have them gather
assets, and then start building their projects using menus, buttons, and media. Finally, they’ll link those assets
and see how to burn a DVD.

At the end of this lesson, students will have learned about:

• DVD authoring fundamentals

• Overview of Adobe Encore DVD

• Assembling assets and editing media

• Editing menus in Adobe Encore

• Linking menus, buttons, and media

• Using Playlists

• Burning the DVD

DVD Authoring Fundamentals

Authoring DVDs used to be solely for those with Hollywood budgets. As recently as the late 1990s, DVD
recorders cost about $10,000 and the software used to put movies with menus and other interactive features on
DVDs, cost more than $20,000.

Now, DVD recorders sell for less than $200, and professional-quality authoring software, like Adobe Encore DVD,
retails for about $500.

Authoring a DVD can be as simple as using Adobe Premiere® Pro’s Export to DVD function or as complex as
creating a Hollywood-style DVD with multiple menus, dozens of buttons, several audio tracks, and subtitles.

The process varies from authoring project to authoring project, but the fundamentals remain the same.

Authoring Your DVD

Authoring typically begins in much the same way you start working with Adobe Premiere Pro by assembling
media assets into one readily accessible location. Then you venture off in a new direction as you build menus
using static backgrounds (graphics, video still images, or photos), or you might opt to use a video or animation
for your backgrounds.
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You also might want to add audio to your menus, such as music or a brief narration, and have them repeat (or
loop) until the viewer takes some action. And you add buttons or other graphics to those menus to serve as links
to media assets or other menus.

Adobe Encore DVD offers a plethora of menu templates, buttons, and backgrounds. But its real strength is that it
lets you use menus you build from scratch in Adobe Photoshop®.

In this module, to keep things simple, you'll rely primarily on the library of assets that ships with both the retail
and trial versions of Adobe Encore DVD.

Organizing Your DVD's Menu Structure

DVDs are interactive. That's one of their real fortes. You should therefore organize your DVDs to exploit that
strength. To do that, use nested menus, intuitive navigation, and clearly labeled buttons.

Nested menus are menus within menus. You’ve encountered them time and again in Hollywood movie DVDs.
Typically, those DVDs start with a main menu with buttons that take you to nested menus: special features,
scene selection, or audio and subtitle setup menus.

Consider the family history DVD structure shown in Figure 26.1. Its main menu has button links to a video
overview, immigration stories, photos, documents, and living history interviews. The stories’ nested menu offers
links to other nested sub-menus, one for each family line.
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To ensure a logical flow to your DVD, organize it using a flowchart like the one in Figure 26.1.

FIGURE 26.1: One possible DVD menu flowchart for a family history DVD.

Overview of Adobe Encore DVD

Adobe Encore DVD lets you create full-featured, Hollywood-style
DVDs complete with videos, motion menus with audio,
animated buttons, scene selection, stills, Dolby digital audio,
multiple language and audio tracks, and subtitles. Its tight
integration with Adobe Photoshop (for menu and button
creation), Adobe After Effects®  (for motion menus), and Adobe
Premiere Pro for MPEG videos, plus its easy-to-use text and
menu design tools, give you the freedom to present your media
in its best light.

Its roots go back to Adobe Premiere 6.5. Adobe foresaw the
explosive growth in the DVD authoring market and wanted to
add a DVD authoring module to that immensely popular NLE. The company worked out a deal with Sonic
Solutions, the DVD authoring market-leading firm, to bundle its popular DVDit! with Adobe Premiere 6.5.

That relationship led to another deal to license Sonic Solutions’ AuthorScript software (the engine that drives all
of its DVD authoring products) as well as provide a team of Sonic Solutions engineers to help Adobe develop the
stand-alone, DVD authoring product, Adobe Encore DVD.
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At $549 ($249 education price), it fits into a unique market niche: above Sonic Solutions’ consumer/prosumer
DVDit! and below Sonic’s high-end professional products: ReelDVD and DVD Producer. Adobe geared Adobe
Encore™  DVD specifically for those who are comfortable working with Adobe Premiere Pro and Adobe
Photoshop.

Tour Adobe Encore DVD’s User Interface

As shown in Figure 26.2, Adobe Encore DVD’s user interface has the look and feel of other Adobe products. It
uses timelines like those in Adobe Premiere Pro and After Effects  for videos and slideshows. It incorporates
graphics editing windows and text tools similar to those in Adobe Photoshop. Plus, it features an Explorer-like
window to tabulate menus, buttons, and their attributes; and Monitor windows with tabs to readily move from
one function to another.

FIGURE 26.2: Adobe Encore DVD uses a familiar Adobe-style interface, including file lists and window tabs to easily
access and update menus and buttons.

It offers some neat twists on setting DVD menu and button navigation. Figures 26.3 and 26.4 show two such
schemes: a collection of arrows that you can drag and drop to change button navigation routing (the order in
which buttons highlight as viewers click up/down/left/right arrows on their remotes) within a menu and a
means to create links using a cool drag-and-drop tool called the Pick-whip.
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FIGURE 26.3: Use this four-point tool to drag and drop
new button routing within a menu.

FIGURE 26.4: Use Adobe Encore DVD’s Pick-whip to set button links by dragging and dropping them from a dialog
box to a menu.
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Another strength is Adobe Encore’s close ties to Adobe Photoshop. It has a built-in means to recognize menus
and other graphic elements created in Adobe Photoshop specifically for Adobe Encore and uses the Photoshop
layers approach to facilitate customizing button highlight colors and other characteristics (see Figure 26.5).
Encore DVD 1.5 has the additional feature of a Tool palette “Edit in Photoshop” button.

FIGURE 26.5: Adobe Encore DVD emulates Photoshop layers to give users direct control over setting button highlight
attributes. And the latest version sports a direct, “Edit in Photoshop” button in the Tool palette.

One other strength is Adobe Encore’s menu design capabilities. It includes extensive menu layout options, full
text editing functionality, numerous style presets, and Adobe Photoshop design tools that let you make
immediate, easily reversible changes.

Plus it offers features you’d expect to see only in more expensive professional authoring apps such as chapters
(for scene selection menus), 8 audio tracks (for multiple languages and director comments), 32 subtitle tracks,
and the option to add DVD-ROM data files to your project. For those who have doubted the value of DVD
authoring applications, Adobe’s entry into this market should make believers out of them.

Assembling Assets and Editing Media

In most instances, the first stages of your Adobe Encore DVD workflow will run in parallel and might use a
number of Adobe Video Collection products. You will create media assets in video editing apps like Adobe
Premiere Pro and, build static menus in Adobe Photoshop and motions menus in After Effects. Then you
assemble them all in Adobe Encore DVD.
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Task: Getting Started
Much like Adobe Premiere Pro, Adobe Encore DVD’s Project window serves as the asset repository. It gives you
easy access to assets: menus, media, timelines, and project parameters.

Once assembled, you can add chapters, subtitles, and audio to those assets. Here how that works:

1. Start a new project by selecting File > New Project. Select NTSC or PAL and click OK.

2. As shown in Figure 26.6, that displays the Project window (with its four tabs) and the Library palette
(with its four tabs) and Properties in a separate palette. Note that I dragged  the Properties tab into the
top of the Library palette to simplify the workspace. Take a look at each Tab starting with those in the
Project window:

Project Window

• Project—Here you access all your imported assets: audio, video, and image files.

• Menus—When you import assets, you tell Adobe Encore™ which ones are Menus. Those menus,
plus any menus you build using Adobe Encore DVD, are stored here.

• Timeline—To play videos in your DVD project, you need to convert them to Timelines (you don’t
need to convert videos you’ll use for menu backgrounds). In addition, you might want to add
chapter points, subtitles, or extra audio tracks to your media assets. You do that within a Timeline.
You access all timelines you create within Adobe Encore DVD here.

• Disc—Take a look at the Disc tab shown in Figure 26.6. This is sort of the catchall Project window
tab. You come here as you’re wrapping up your authoring. The Check Project button is a powerful
tool that identifies any buttons, menus, or assets with missing links (if a viewer clicks an unlinked
button, nothing will happen) as well as several other areas where things can go wrong. The Project
Settings button  lets you add Region Codes to your DVD as well as Copy Protection and a couple
other odds and ends.
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FIGURE 26.6: The Project window (left)  is your asset manager. The Library palette (right) contains your menu
building and link, creating tools.

Library Palette

• Library—This holds your menu-building assets: menus templates, buttons, and graphic
elements (images, in Adobe Encore™ parlance). The trial version includes a couple dozen items.
The retail version has several hundred.

• Layers—This is something like a mini-Photoshop layers palette. It offers up a subset of the
standard Adobe Photoshop layers tools that enable you to make some simple fixes to menu
items like adjusting locations and sizes of banners and buttons.

• Character—Use this to add and edit text in menus and buttons.

• Styles—This is new to Encore DVD 1.5. It’s a collection of Photoshop-created actions such as
drop shadows, glows, bevels, embosses, glass, metal, and textures that you can apply to
graphics or text in menus. In this way you can alter Library elements to give you project a
customized look without the need to edit menus in Photoshop.

• Properties—Select an item, be it a menu, a button in a menu or an asset in the Project
window, and the Properties palette will display that item’s characteristics, such as: duration,
links, and name.

3. Click the Project tab, and then import assets by double-clicking the blank space in the Project window
to open the Import as Asset dialog. Adobe Encore™ works with only three types of video files: MPEG,
AVI and QuickTime MOV (new to Encore DVD 1.5). You also can import a variety of still image and audio
file types.
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Tip: Other Methods to Import

As with all things Adobe, there is more than one way to do a routine task like importing assets. Here are two
such options: right-click in the Project window and select Import as Asset or Import as Menu—OR—select
File > Import as Asset or Import as Menu.

Note: Use Saleen Assets.

If you don’t have any video assets to import, use the Saleen assets that shipped with your copy of Adobe
Premiere Pro. Or if you have the full retail version of Adobe Encore DVD, copy the Encore-Assets folder off
the Adobe Encore DVD to your hard drive and use its four media files (you’ll use the
DreamMovieSubtitles.txt file later).

4. Take a look at Figure 26.7. I imported the four audio/video files in the Encore-Assets/Movies folder that
ship with the retail version of Adobe Encore DVD. They consist of a video-only elementary MPEG file, its
associated audio WAV file, and two AVI audio/video files. As I did in Figure 26.7, click on an audio or
audio/video file and play it in the small preview window.

FIGURE 26.7: Organize assets in the Project window. Note that MPEG files need no additional transcoding before
making your DVD.
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Note: No MPEG Transcoding Needed

The selected file’s properties show up in the Properties palette. In particular, since this file is an MPEG-2 file,
Adobe Encore™ will not do any additional transcoding of it before burning your DVD.

5. To have the audio and video play together on your DVD, you need to add them both to the same
timeline. To do that, select Timeline > New Timeline (keyboard shortcut: Ctrl+T).

Note: Customize Your Workspace.

Encore DVD 1.5 took a cue from other Adobe products and now has customizable workspaces. Organize
your workspace to suit you (as I mentioned earlier, I like to dock the Properties palette in the Library palette)
then save it by selecting Window > Workspace > Save Workspace.

6. If you have the Encore-Assets, drag DreamMovie.m2v to the Video track and DreamMovie.wav to the
Audio 1 track. Your Timeline should look like the one in Figure 26.8. You can view your video in the
Monitor window that opened when you created the Timeline. New to Encore DVD 1.5 is a cool shortcut:
select the two assets (CTRL or Shift-click) then click the New Timeline button at the bottom of the
Project window(annotated in Figure 26.7).

Note: Only One Video Track

Unlike Adobe Premiere Pro, Adobe Encore DVD has only one video track per timeline. The reason? You
aren’t using this for editing or compositing, rather this timeline is for adding chapters to the video plus
audio tracks and subtitles.
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FIGURE 26.8: Use the Timeline to join an elementary, video-only MPEG with its associated Audio-only file.

7. Create another timeline by right-clicking RacingClip.avi in the Project window and selecting New
Timeline (you need to place this video on a timeline to enable you to link a menu button to it).

Tip: Naming Timelines

Adobe Encore DVD automatically names this new Timeline “RacingClip.” You can name your other timeline
by right-clicking it in the Project window, selecting Rename Timeline, and giving it a new name.

8. You can add subtitles manually from the Timeline’s Monitor window or use a text file made in any word
processor or Windows Notepad. First add a Subtitle track by right-clicking inside the Timeline window
and selecting Add Subtitle Track.

9. As shown in Figure 26.9, right-click on the newly added subtitle track and select Import Subtitles > Text
Script. Using the Encore-Assets, navigate to Encore-Assets/Movies and select DreamMovieSubtitles.txt.
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FIGURE 26.9: To add subtitles, add a subtitle track, then right-click on that new track to add a basic subtitle text file.

10. That opens the Import Subtitles (Text
Script) dialog shown in Figure 26.10.
This is a very handy feature that no
other DVD authoring product I’m aware
of has (I tested more than a dozen for
my book, “SAMS Teach Yourself DVD
Authoring in 26 Hours”). Here you can
set several font attributes such as size,
placement on the screen, color, and
justification. Click OK to accept the
current settings.

FIGURE 26.10: Before you finalize the import of
subtitle text files, adjust their display attributes in
this Import Subtitles (Text Script) dialog box.

11. As shown in Figure 26.11, those subtitles
now appear in the subtitle track as
individual clips. You can edit
them—move them and change their
lengths—in the Timeline window and
edit their appearance in the Monitor
window. Move the CTI edit line to one of
them, click on the Character tab in the
Library palette, select the Text tool from
the Tools palette, highlight the text, and
use the Character dialog box to make
changes. I center justified the text and
increased its size. It’s also possible to
move the text elsewhere on the screen.
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FIGURE 26.11: View and edit your subtitles in the Monitor window.

Tip: Switch Off Subtitles

You can turn off the display of subtitles by clicking the little button to the left of the word Subtitle 1 in the
Timeline window.

12. Add chapter points to your video for later inclusion in a scene selection sub-menu. Do that by moving
the CTI to where you want to add a chapter and clicking the Chapter icon in the Timeline or the Monitor
window (keyboard shortcut: numeric keypad ‘*’). I highlighted both in Figure 26.12. Later, you will link
these chapter points to buttons in a scene selection menu.

13. Save your project: File > Save.
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FIGURE 26.12: Add chapters to your video using the Chapter buttons in the Monitor or Timeline windows.

Note: Adding Chapters—An Inexact Science

When you add chapters to an MPEG video, setting an exact location is a hit or miss affair. MPEG compression
does not use each frame in a video. It selects scattered frames and then calculates the differences between
those frames. In that way, an MPEG file has many fewer frames than DV, for example. So when you select a
chapter point frame, Adobe Encore™ locates the nearest actual frame and places the chapter point there.

When you add chapter points to an AVI video in Adobe Encore DVD and later transcode that to MPEG, the
transcoder ensures that the frame you selected remains associated with that chapter point.

Editing Menus in Adobe Encore DVD

Menus are the focus of DVD authoring. They not only put a face on your production but provide all its
interactivity. The full retail version of Adobe Encore DVD is loaded with menu templates, backgrounds, and
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buttons. Certainly more than enough to create many DVDs. But as you become more facile with DVD authoring,
you will want to make custom menus. In those cases, Adobe Photoshop is the ideal candidate, as it is fully
integrated with Adobe Encore DVD. I go over how to work with Adobe Encore DVD menus in Adobe Photoshop
in the next and final module.

Task: Building Menus Within Adobe
Encore DVD
For this task, I’ll use both the Encore-Assets provided with
the retail version of Adobe Encore™ and one of the three
menu templates provided with all versions of Adobe Encore
DVD. You can start with an empty background and add
buttons, text, and graphics to suit your needs—or—edit an
existing menu. We’ll start with a blank slate:

1. In your project, open the Library palette (Window >
Library) and select the Library tab. As shown in
Figure 26.13, that displays the standard library of
menu templates, buttons, and other graphic
elements that ship with all versions of Adobe
Encore DVD.

FIGURE 26.13: The Library palette contains all your menu
building assets: buttons, menu templates and graphics.

Tip: Highlighting Specific Library Groups

Take a look at Figure 26.13. The six buttons across the center of the palette represent menu-building assets:
menu templates, buttons, images, layer sets, text items and shapes.  To display only one group, click on its
button.  To select more than one group, Shift-Click on the icons. New to Encore DVD 1.5 are layer sets
(essentially a group of graphic elements like a banner with text), text items (text style presets) and Shapes.
Also new to version 1.5 is Library Sets. Select the General set and look at its lengthy Shapes collection. All
shapes are blue but you can change their colors. I explain that later in this task.

2. Open the Corporate Set, right-click on Blue Grid Menu and select Create New Menu. Click the
Backgrounds button, right-click the Blue Grid BG graphic and select Create New Menu. They will appear
in the Project window under the both the Project and Menu tabs. This process also will open the Menu
window with both new menus accessible using tabs.

Tip: Other Menu Adding Methods

There are two other ways to add a menu selected from the Library to your project. Click on a menu name in
the Library palette and click on the New Menu button (third from the right at the bottom of the Library
palette). Or, drag a Menu from the Library palette to the Project window Menu tab (if you drag it to the
Project tab, Adobe Encore™ DVD will consider it only as a graphic, not a menu).

If you have the Encore-Assets (or some other menus), you can add them to your project by double-clicking
or right-clicking on an empty area in the Project window Menu tab to open the Import as Menu dialog.
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3. Click on the BlueGrid tab in the  the Menu window to open it.

4. As shown in Figure 26.14, add buttons to it by dragging them from the Library palette to that window.

5. As I did in Figure 26.14, you can use several means to neatly arrange buttons as you add them. Switch
on the Guides by clicking the Show Guides button (the left button highlighted in 26.14). As you drag
buttons, their bounding boxes will snap-to a guide line. You can add guides by clicking the other
highlighted Guide button. Also select Object > Align or Object > Distribute and try one of their
functions.

FIGURE 26.14: You can build a menu from scratch using a menu background and some buttons.

6. The text associated with these buttons is too dark. Fix that by selecting the Text tool (open the Tools
palette by selecting Window > Tools), highlighting the text by dragging the tool on the text (or double-
clicking on the text), clicking the Character tab and, as shown in Figure 26.15, changing the color to
something lighter. You can also use the Text tool to add text directly to the menu. A title for instance.

7. New to Encore DVD 1.5 is the Styles palette. It is a collection of Photoshop actions that you can apply to
graphics and text within menus. As shown in Figure 26.15, Encore DVD divides them into three groups:
Image, Text and Shape styles. Test out a few. I applied the Abstract Fire style to the (formerly) red button
background in the menu (if you were to open this menu in Photoshop – something I discuss later –
you’d see that this Abstract Fire Style is made up of two effects: Gradient Overlay and Pattern Overlay).
To apply a Style, select either an entire button or use the Direct Select Tool (keyboard shortcut ‘A’ and
highlighted in Figure 26.15) to select a layer in a button set. Then double-click a style. If you select a
button set then double-click a Text style, Encore DVD will apply that Style only to the text portion of the
button set.
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FIGURE 26.15: Quickly and easily give your menu elements – buttons, text and graphics – a customized look using
Encore DVD 1.5’s new Styles.

FIGURE 26.16: Edit text using the Text tool and the Character palette.
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8. With the  Blue Grid BG menu open, click on the Layers tab in the Library palette. As shown in Figure
26.17, this shows the Photoshop-style layers for each element in the menu. Click the disclosure triangles
to see the layers for each graphic element.

FIGURE 26.17: Displaying a menu’s Layers reveals each graphic element. Clicking the circled Selected Subpicture
Highlights button reveals how the graphic will change when the viewer moves the remote to a button.

Note: Symbols, Zones and Graphic Colors

Take a close look at the Layers palette. You’ll see these layer name prefixes: (=1), (+), and (%). Each tells
Adobe Encore™  DVD what that kind of layer or graphic item it is. I explain these further in the next module,
“Using Adobe Photoshop to Edit Menus for Adobe Encore DVD.”

I added a button that has a solid color to show how to change a graphics color. In the case of big arrow
button (you can find it in the Corporate Set as “Blue Arrow Button”), I changed the blue arrow to red by
double-clicking its color box in the Layers palette and selecting a new color from the color picker.

Each of the Layers palette items defines a zone. You can’t have overlapping button zones or your viewers
won’t be able to use their remote to select a particular button.

9. Each of this menu’s buttons has a subpicture highlight. This is a fairly obtuse and arcane part of the DVD
specification. But its practical benefit is its ability to display button or text highlights as the viewer
moves the remote to those menu elements (the “selected” highlight) and then clicks on one
(“activated”). Click on the Show Selected Subpicture Highlights button, circled in Figure 26.16. It
displays red triangles below the four video buttons and a red border around the Arrow button (in this
case the Activated state looks the same because the Encore DVD’s automatic Color Set does not use
different colors but, as I explain in the next few steps, you can change that).

10. Change that Selected subpicture color by clicking somewhere in the menu outside a button to select
the menu, click the Library palette Properties tab and select Menu Default from the Color Set drop-
down list at the bottom of the palette. That is a different set of editable highlight colors. Depending on
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the default values in your version of Adobe Encore™ DVD, the red triangle highlights likely will change
to orange and the red arrow button border will likely change to blue (they are different colors because
they are in different “groups” – I’ll explain that in a moment).

11. Click the Activated Subpicture Highlight button at the bottom of the Menu window and you’ll see that
the triangles and border change to different colors. The reason: the Menu Default subpicture color
collection has different colors pre-set for the Selected and Activated states (as opposed to the
Automatic color set having the same colors for Selected and Activated).

12. Change that new color to one of your choosing by selecting Menu > Edit Color Sets. Take a look at
Figure 26.18. Select Menu Default from the Color Set drop-down list. Click the Preview button then the
Selected highlight button so you can see changes in your menu as you make them in the Menu Color
Set dialog box.

FIGURE 26.18: Use Menu Color Set dialog box to change Subpicture highlight colors for menu buttons.

13. The Triangle highlights are in Highlight Group 1 (you can check this later by clicking on a button and
opening the Property tab in the Library palette). Click on the Highlight Group 1 Selected State Color 1,
click on NTSC Colors Only (to avoid smearing colors in NTSC TV sets), choose a new color, and click OK.
Change the opacity to a higher number (to make the color change more obvious and check out your
work in the Menu window).

14. Note in Figure 26.18 that I chose purple and an 87% opacity and that those changes showed up right
away in the Menu window. I also changed the Group 2 Selected State Color 1 to change the border
around the arrow button. If you select either of these buttons then open its layer display, you see that
the highlight layer for each has the (=1) prefix. (=1) means this highlight will use color number 1 within
its selected group. This group and highlight prefix number allow you to assign up to six colors (two
groups, three prefixes) to buttons within a menu. You can create different color schemes for each menu
if you like, although most DVD producers like to use one color scheme throughout a DVD.
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15. Change the Highlight Group 1 Activated State Color 1 to some other color and higher opacity. Now
when you click on the Show Activated Subpicture Highlight button at the bottom of the Menu window,
this new color will show up.

Linking Menus, Buttons, and Media

A strength of DVDs is their interactivity. Not unlike Web pages, you create menus with links to material “behind”
those menus.

In the case of DVD authoring, you decide what gets linked to what. Adobe Encore DVD offers up several linking
methods, most of which are simple drag and drop affairs or use drop-down menu lists.

On large projects with dozens of menus, buttons, and assets; tracking links can be a chore. Adobe Encore DVD
takes care of that with another powerful feature. Adobe Encore DVD’s Check Project tool lists all buttons, menus,
and media that do not have links (as well as checking a half-dozen other items). Then you can drag and drop
links to and from that list—a real nifty feature that no other DVD authoring product I know of has.

Task: Linking Assets
To show you the breadth of Adobe Encore’s linking capabilities, I’ll present several scenarios. You could
accomplish most of your linking tasks using only one of them, but there are unique benefits to each. Here’s how
they work:

1. Click on the Project window Project tab to open it.

2. Click on the Blue Grid Menu tab in the Menu window to open it.

3. From the Project Window, click on the name of the first Timeline you created (if you used the Encore-
Assets in your timelines, select the one that has the DreamMovie video in it), and drag it to the “play
movie” button in the Menu window. As shown in Figure 26.19, as you hover over “play movie,” its hot
spot text box becomes highlighted. Creating this link means that when viewers play your DVD and click
on “play movie,” it will do just that.



Adobe Digital Video Curriculum Guide – Module 26 26-21

Adobe Digital Video CURRICULUM GUIDE

FIGURE 26.19: Drag a timeline from the Project window to the button/text you want viewers to click to access that
timeline.

4. Add the Blue Grid Submenu to your project by locating it in the Library (in the Corporate set) and
double-clicking it. Encore DVD will add it to the Menu window.  The purpose here is to create a link
between this menu’s Main Menu button and this project’s actual Main Menu. Instead of the drag and
drop method of step 3, you’ll use a drop down menu. Click on the Blue Grid Submenu’s “Main Menu”
button (make sure you use the Selection tool as opposed to a Text tool).

5. Click on the Properties tab in the Library window. As shown in Figure 26.20, this context-sensitive
palette should note that you’ve selected the “menu button,” the name given to the button’s Adobe
Photoshop layer (as opposed to its text string: “Main Menu”). To link it to this project’s Main Menu, select
Link > NTSC Blue Grid Menu > Default.
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FIGURE 26.20: The Properties palette is context-sensitive. That is, it displays the properties of whatever item you’ve
selected in the Menu or Project windows. Set a link to that selected item using its Link drop-down list.

6. Now you’ll use the Pick-whip tool to set another link. To prepare to do that, select the Menus palette in
the Project window, click the Blue Grid Menu tab in the Menu window, and open the Properties palette
in the Library window.

7. On the Blue Grid Menu, click the “special features” button to open its display in the Library window
Properties palette.

8. As shown in Figure 26.21, click on the  Pick Whip button (to the right of the word “Link” in the Properties
palette) and drag the Pick Whip to the NTSC_Blue Grid Submenu in the Project window, Menus palette
(note how the line whips back to the Properties Palette and the Link name changes from “Not Set” to
NTSC_Blue Grid Submenu). The Blue Grid Submenu will serve as this project’s scene selection menu.
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FIGURE 26.21: Use the Pick-whip tool to link an object in the Properties palette to a menu or media asset in the
Project window.

9. Click the Timelines tab in the Project window (it should have two timelines—in my case, Saleen
Overview and RacingClip), click the “behind the scenes” button on the Blue Grid Menu, and drag its
Pick-whip from the Properties palette to the RacingClip timeline listing.

10. Add poster frames and links to the video chapters in the scene selection menu by opening the main
movie’s Timeline (double-click it in the Project window, Timeline palette) and open the Blue Grid
Submenu in the Menu window.

11. Click on individual Chapter numbers (Chapter 1 is always the first frame, and you can use it for a scene
selection if that suits you), and then drag them in turn to their respective scene frames. Your scene
selection menu has poster frame thumbnail images in each button and looks something like Figure
26.22.
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FIGURE 26.22: Drag chapter points to the scene frames to link those buttons to their respective scenes in the main
video.

Tip: Changing Chapter Poster Frames or Locations

Using Figure 26.22 as a reference, drag a chapter point along the timeline to see how that updates the
poster frame in the Monitor Window. Moving that marker also moves the location where that scene will start
playing to that new point.

Change a chapter point poster frame (without changing the Chapter Marker location) by selecting a chapter
point on the Timeline, moving the CTI to a new location (view it in the Monitor window), right-clicking the
chapter marker, and selecting Set Poster Frame (it shows up immediately in the menu window).
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12. By default, these scene-selection buttons will display only as static poster frames. To animate them—to
have them play a few seconds of video—click on the Blue Grid Submenu tab to select it, click the
Properties tab, and check the Animate Buttons check box. Put in a duration (five seconds works well)
and the number of loops until the buttons revert to still images (Forever is one choice).

13. Render these video buttons by selecting File > Render Motion Menu (this project might take 30 seconds
to render—it’s creating 120 full frames of that menu, not just the buttons, to play as a looping video).

Setting First Play

You know that when you put a DVD in your set-top player, it doesn’t just sit there, waiting for you to tell it what
to do. Depending on how its editor authored it, it might display a menu, play a brief video and then open a
menu, or simply start playing the movie with no menu. In DVD specification parlance, those are all first play
actions.

By default, Adobe Encore DVD sets the first menu or timeline you work on as the first play. Here’s how to
override that:

• If you have the Saleen-Assets material, you want to set IntroMovie as the First Play item. To do that, you
need to put IntroMovie on a timeline. Do that by right-clicking IntroMovie and selecting New Timeline
(or drag IntroMovie to the New Timeline button at the bottom of the Project window). That opens the
Timeline window. Since you don’t have to work in it, simply close it to free up screen real estate.

• In the Project window, look for the asset with the little triangle in its file type icon. As shown in Figure
26.23, in my case it’s the Saleen Overview Timeline. That triangle indicates it’s the First Play item (it’ll
play automatically right after the viewer inserts the DVD into the player or PC DVD drive). Override that
by right-clicking the newly added IntroMovie Timeline and selecting Set as First Play.
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FIGURE 26.23: The asset with the little triangle in its icon is the project’s First Play item. Override that by right-clicking
a different asset and selecting Set as First Play.

Setting End Actions

You need to tell IntroMovie what to do when it finishes playing or if the viewer presses the Stop button. That’s
called its End Action. In this case, you want it to jump to the main menu.

• Select IntroMovie in the Project window and open the Properties tab.

• As shown in Figure 26.24, open the End Action drop-down list and select Blue Grid Menu > Default.

• Set End Actions for the other two videos, having them both return viewers to the Main Menu.
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FIGURE 26.24: Set the End Action in the asset’s Properties palette.

Setting Overrides

You sometimes need to override default actions. For instance, the typical end action for most movies is to return
to the DVD’s Main Menu. But if your viewer accesses that movie via the scene selection menu, you want to return
the viewer to the scene selection menu if he presses Stop. You set that using the Override drop-down list in the
Properties palette.

• Using the Scene Selection menu you just created, click on the “scene 1” button.

• As shown in Figure 26.25, in the Properties palette open the Override drop-down list and select Blue
Grid Submenu > scene 2. You choose “scene 2” because you want to have the button highlighted when
the viewer returns to this menu because you assume he won’t want to view “scene 1” again.

• Do this for the other three buttons, setting the “scene 4” button override to Main Menu to highlight that
button since you assume the viewer has exhausted the Scene Selection menu possibilities.
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FIGURE 26.25: Set Override actions to ensure viewers come back to the correct menu.

Changing Button Navigation

When you view Hollywood DVDs, you might notice that as you press the arrow keys on your remote, you move
through the menu button selections in what seems like a logical order—typically top to bottom or left to right.
By default, Adobe Encore DVD determines what it calculates to be a logical order. It’s best to check that to see
whether it matches your view of what constitutes a logical flow.

To see that, click the Show Button Routing button circled in Figure 26.26. That displays the four-arrow button
routing symbols. The center number is the button number set by Adobe Encore DVD; the left/right/up/down
arrows indicate which button will highlight when the viewer presses the associated button on the remote.
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FIGURE 26.26: Change the Button Navigation to override the default values set by Adobe Encore DVD.

In the case of the Blue Grid Menu, since the text buttons do not fall in a straight vertical column, the button
navigation is illogical.

• To adjust them, click the Blue Grid Menu tab to select it.

• Open the Properties palette and uncheck the Automatically
Route Buttons check box at the bottom of the palette.

• Now, as shown earlier in Figure 26.26, drag and drop each
arrow to set the navigation that suits you. Figure 26.27
shows you how I set the navigation for this project.

• Change the navigation for any other menus you’ve created.

FIGURE 26.27: New button navigation settings have viewers move
from top-to-bottom without skipping buttons as would have happened
if I accepted the default navigation set by Adobe Encore DVD.

Setting User Operations Controls

Encore DVD 1.5 has a new feature that lets you set so-called “user operations.” These are the interactions a user
has with a DVD using the remote control. You can disable certain user operations, like preventing the viewer
from fast forwarding through the FBI warning.

Encore DVD 1.5 lets you disable operations for the entire disc as well as selected timelines and menus. The
operations you can disable vary depending on the asset. For example, you can disable the previous or next
chapter buttons for a timeline, but not for a menu since that operation only applies to timelines.
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Access the User Operations dialog box in the Properties palette. To change user operations settings for the
entire disc, click the Disc tab in the Project window and then click the Operations Set button at the bottom of the
Properties palette. To change user operations for a Timeline (it has the most options and is the example I used
for Figure 26.28), select a Timeline in the Project window and click its Operations Set button in the Properties
palette.

FIGURE 26.28: Encore DVD 1.5 lets you disable certain user operations such as jumping to the Main Menu during
opening credits.

Previewing Your Work So Far

Adobe Encore DVD lets you simulate how your project will function when played on a TV using a remote control.
You can preview a specific menu by right-clicking on that menu and selecting Preview from Here. Or preview the
entire project by clicking the Preview button in the Tools palette or selecting File > Preview. As shown in Figure
26.29, those latter actions open the Project Preview window, which then plays your First Play video.

If you wait for the video to end, the Project Preview window will execute the End Action and should display the
main menu. To expedite that, click the Execute End Action button highlighted in Figure 26.29 (clicking the Stop
button has unpredictable results).
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FIGURE 26.29: Open the Project Preview window to see how your project will work when it plays in a set-top DVD
player.

• Once in the Main Menu, move the cursor around to show the buttons’ “selected” highlights and then
click on “languages.” Nothing will happen since it does not have a link.

• Click on “special features” to open the scene selection menu. Play the four scenes and click the Execute
End Action button for each of them. That should take you back to the Scene Selection menu with the
next scene’s button highlighted.

• Click its Main Menu button to return to the opening menu. Click “play movie” or “behind the scenes”
and their respective movies will play. Use the Execute End Action feature on them and you should
return to the Main Menu.

• Click the Exit button highlighted earlier in Figure 26.29 to return to the Adobe Encore™  DVD authoring
interface.
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Using Playlists

Playlists are new to Encore DVD 1.5. A playlist is a collection of timelines that play sequentially (from each one's
specified chapter) and can include one end action. Playlists provide more efficient and robust navigation
possibilities than overrides alone.

Playlists, in effect, let you set overrides for several timelines at once, making DVD authoring more efficient. For
example, you might create a DVD with for a company that has several product lines. You might want to have
customized menus for each dealer that handles unique sub-sets of your product groups. So you can create
several playlists that tap the same collection of videos.

Or if you have a collection of music videos, you can create a Play All button that links to a playlist containing all
the timelines and an end action that points back to the menu. And you then create the individual music video
buttons that link to each separate timeline with an end action pointing back to the menu. To create this
navigation scheme without using a playlist, you’d have to set each timeline's end action to points to the next
video (the play all scheme) and set an override for each video button pointing back to the menu (the play
individual videos scheme). Using playlists saves you this tedium.

Create a Playlist in one of two ways: with the Project window open, select File > New Playlist – or – click the New
Playlist button at the bottom of the Project window. You can select several Timelines and then click that button
to automatically populate the new playlist with videos.

FIGURE 26.30:New to Encore DVD 1.5 is a Playlist feature that gives you much more flexibility and saves a lot of
authoring time when using Timelines multiple times within a project.

As shown in Figure 26.30, open that playlist by selecting it in the Project window and opening the Properties
palette in the Library palette. You can change the order the Timelines play by dragging them in the Playlist
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window, select at which chapter they start playing using the wing-out menu, use the Pick-Whip tool in the upper
right corner to add more Timelines, and the Pick Whip tool to set an End Action for the entire Playlist.

Burning the DVD

Since this is just a demonstration project, there is no need to actually record this project to a DVD, but I will show
you how the process works.

Task: Burning Your Project to a DVD
When doing these final steps, you get to take one last peak at your links and project settings. Here’s how to
make a DVD:

1. Click the Disc tab in the Project window to open it.

2. Click Check Project, accept the default setting (all items are selected), and click Start. If, as is the case in
Figure 26.31, there are assets with End Actions that don’t suit you, or Links that are Not Set, or any of a
dozen other possible fixes, you can change them right in this dialog box. Simply click on one, open the
Properties palette, and make the changes there using the Pick Whip or drop down menus. When done,
click Done.

FIGURE 26.31: Use the Check Project dialog box (with the Properties palette) to repair any broken links or change End
Actions and Overrides.
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Note: Title and Menu Remote

Title Remote is a global setting that specifies what displays when the viewer presses the Title button on the
remote control. You generally set this button to return the viewer to the Main Menu. You set the Title
Remote by clicking the Disc tab in the Project window and choosing the Title Remote in the Properties
Palette’s, Title Button window.

The Menu button is a more local setting, rather than a DVD-wide setting. The Menu button is a Timeline
setting and generally should take the viewer back to the menu for the current feature. You set the Menu
button within a Timeline’s Property palette.

3. Click Project Settings and note that Adobe Encore DVD offers several Copy Protection options as well as
Region settings. Cancel out of that dialog box.

4. If you want to add DVD-ROM content—word processing files, spread sheets, images, and other material
users can work with on their PCs—use that feature in the Disc tab. You need to gather up all such assets
in one hard drive folder then select that folder in the DVD-ROM content section of the Project Settings
dialog box.

5. Click Build Project to open a dialog that lets you select a DVD burner.

6. Insert a recordable DVD in your DVD burner and click Next. That displays a Make DVD Disc: Summary
dialog box. If all seems to be in order, click Build. The progress indicator will display how things are
going.

7. When completed, you can take the DVD you just burned and play it in your set-top DVD player.
Congratulations.
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I saved Adobe Encore DVD for the final modules of this curriculum guide because it’s kind of the icing on a video
project cake. You’ve worked hard to create a fine looking video, and Adobe Encore DVD gives you the
opportunity to present that work in the best light.

No longer is DVD authoring for the few and the wealthy. With this $549 product, you can build Hollywood-style
DVDs complete with menus, video buttons, scene selection options, multiple language audio tracks, and
subtitles.

Adobe Encore DVD features tight integration with other Adobe DV products, notably Adobe Photoshop, for
menu creation and editing. It ships with many menu templates, buttons, and graphics. It offers multiple methods
to create links among menus, buttons, and assets, and it automatically checks for missing links.

Q. When I preview my DVD project, I play a video for a while and then press the Stop button, expecting
the video to jump back to its menu. But all I get is a blank screen. What’s going on?

A. When you pressed the Stop button, you expected the video to execute its End Action. Were this a true DVD
remote control, that would be the case. But in the Adobe Encore™  DVD Preview window, pressing stop simply
stops the video. To execute the End Action, click that specialized button at the bottom of the screen.

Q. When I access a video chapter via my scene selection menu, it plays beyond the next chapter point.
Why doesn’t it stop automatically? And when I press stop, it returns to the main menu. What’s going on?

A. This is a DVD specification issue. Clicking on a scene selection button simply starts the video at that point. It
will continue to the end of the video if you don’t press Stop. There is no means built-in to Encore DVD to change
this. Your only work-around is to create a series of video segments instead of using chapter points. There is an
upside to this: you can use the Playlist feature to present those segments in a number of ways.

Quiz

1. You drag and drop chapters to buttons in a scene selection menu. But the poster frame’s thumbnail images
don’t represent the chapter’s contents. How do you fix that?

2. You want your button navigation to go left-to-right, but in Preview window, when you click the right arrow,
it skips a button. How do you fix that?

3. Instead of a Selected highlight being a simple frame around a thumbnail image, you want little stars to
appear with text like “Ouch!” How do you do that?
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Answers

1. You can change the poster frame while keeping the chapter point at the same frame. Do that by moving the
CTI to a frame that is more representative of the chapter’s content, then right-click on the chapter point
number in the time ruler and select Set Poster Frame.

2. Use the Show Button Routing feature in the Menu window. First you need to turn off the default
Automatically Route Buttons feature by un-checking its checkbox in the menu’s Properties palette. Then use
the Show Button Routing, four-pointer icons to drag and drop the proper navigation.

3. I will cover this in Module 27: “Using Adobe Photoshop to Edit Menus for Adobe Encore DVD.” Consider this
answer a preview: Edit the menu in Adobe Photoshop. Add a layer to the existing button and name it using
the (=#) convention. Then simply use Adobe Photoshop’s graphic building tools to create the stars and the
text in a single layer. Back in Adobe Encore, you can give that new graphic its own unique color and opacity
using the Color Sets dialog box.

Exercises

1. DVDs are great archive media. Use Adobe Encore DVD to create a basic menu, showing thumbnails of each
of your video projects that take viewers to brief snippets, not the entire video clips. Then, when you burn the
project, use the Adobe Encore DVD’s DVD-ROM feature to add the original DV AVI or MPEG (they take up
less space) videos. That way you won’t have to re-capture them if you want to work on them in Adobe
Premiere Pro again. And you can play them on your PC without having to hook up your camcorder and do a
lot of fast-forwarding or rewinding.

2. If you are in the video production business, use Adobe Encore DVD to author a demo reel. Have the main
menu take viewers to screens that say more about who you are, what you do, and show some brief samples
of your work.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education
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Module 27

Using Adobe Photoshop to Edit Menus for Adobe Encore DVD

Adobe® Encore™ DVD works hand-in-hand with Adobe Photoshop® CS. Although Adobe Encore DVD ships with
many menu and button templates, your students eventually will want to create custom menus. They can take
two different approaches: edit existing Adobe Encore DVD menus in Photoshop or use Photoshop to build
menus from scratch.

At the end of this lesson, students will have learned about:

• Adobe Encore DVD and Photoshop CS Integration

• Using Photoshop CS to edit Adobe Encore DVD menus

• Creating menus from scratch in Photoshop CS

Adobe Encore DVD and Photoshop Integration

Since I covered basic Photoshop editing in Module 23, “Photoshop in DV Projects: Still Images and Layers,” I
won’t offer up those kinds of editing tips here. Rather, I simply will point out how Adobe has integrated Adobe
Encore DVD and Photoshop CS.

Note: Encore works with older versions of Photoshop

You can create and edit Encore DVD menus in older versions of Photoshop. But there are some minor
drawbacks. Photoshop CS works with nested layer sets. Some previous versions do not. There are also some
text layout issues that might crop up when working with previous versions of Photoshop. There are many
advantages to working with Photoshop CS. For example, it has several video presets and works with non-
square pixels.

When editing menus in Adobe Encore DVD, you can do these things:

• Change or add text

• Add graphic elements from the library

• Alter the size of the video button frames

• Copy and paste objects already in the menu

• Add a new background

• Apply preset Styles

• Change the color of text or graphic elements

• Change the location of any element

In Photoshop, you can do all of the above plus these tasks:
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• Create new graphics

• Change the appearance or styles of graphics

The crux of that integration is that you can edit Adobe Encore DVD menus in Photoshop or build Adobe Encore
DVD menus from scratch in Photoshop. All it takes is some attention to layer naming conventions.

Using Photoshop CS to Edit Adobe Encore DVD Menus

Integration between Adobe Encore DVD and Photoshop is so tight, it’s almost like they are modules within the
same larger program. The Photoshop CS “engine” is built in to Encore DVD 1.5. In that way, for example, you
can undo edits made in Photoshop within Encore DVD. To edit an Adobe Encore DVD menu in Photoshop CS, all
you have to do is click the Edit in Photoshop button on the Tools palette or select Edit > Edit in Photoshop. Once
you complete editing your menu, you simply save it in Photoshop CS and when you return to Adobe Encore
DVD, whatever changes you made in Photoshop CS will be on display in Adobe Encore DVD.

Follow these steps to see how this works:

1. Select the Blue Grid Submenu by clicking its tab in the Menu window and then click the  Edit in
Photoshop button on the Tools palette.

2. That opens Photoshop with that menu front and center. Open the Layers palette by selecting Window >
Layers.

3. Twirl down the disclosure triangles next to Title and Scene 1, and make sure all eyeballs are on. Your
layout should look like Figure 27.1.

You will note that the layer and layer elements have symbols or numbers in parentheses as prefixes. These are
the naming conventions used in Adobe Encore DVD menus (I will explain this in more detail in the next section).
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FIGURE 27.1: You can edit any Adobe Encore DVD menu in Photoshop.

To see how any changes made to an Adobe Encore DVD menu in Photoshop work, select the Background layer
(click on the word “Background” in the Layers palette), select Image > Adjustment > Hue/Sat and move Hue
slider to the right to about +72 (purple). Click OK. Then select File > Save.

Tip: Original Menu Remains Unchanged

These changes will not alter the original Adobe Encore DVD Library Blue Grid Submenu Photoshop file.
Photoshop automatically creates a new file for this project. This new file creation is transparent to the user.
You might note that when you save a changed menu Photoshop gives it a new name using a unique numeric
identifier.

Close Photoshop, return to Adobe Encore DVD, and note that your menu has the new background color you
gave it in Photoshop.

Creating Menus from Scratch in Photoshop CS

Creating menus in Photoshop CS for use in Adobe Encore DVD takes only a little extra attention to a few details.
There are three general issues to consider: project setup, graphic elements to ensure clear display on TV sets,
and layer purposes and naming conventions.
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Task: Making Adobe Encore DVD Menus in Photoshop CS
I’ll point out those details as you work through the following task. Here’s how you use Photoshop CS to build
menus for Adobe Encore DVD:

1. Open a new document in Photoshop CS by selecting File > New. Select a Preset that matches your video
project: NTSC, PAL, or HDTV; DV or D1; standard or widescreen. Click OK.

2. Create a background. In my case, shown in Figure 27.2, I copied and pasted an image (the cross hatch lines
indicate the Action Safe and Title Safe zones). You can add any number of graphic elements, layer the
background, or merge it into one layer, and add additional images. All elements that are not specifically
identified as button sets (by using certain layer-naming prefixes) are considered by Adobe Encore DVD to be
part of the background. You need to make sure this layer is called Background so Encore DVD knows its
function in a menu.
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FIGURE 27.2:  Selecting a video-oriented preset opens an image window with safe zone grid lines
on it.

Note: Graphic Creating Issues

• To make sure buttons are visible on TV screens, they should be at least 70x60 pixels.

• Feel free to make graphic (like logos) and button elements a bit larger than need be. You can shrink
them down a bit in Adobe Encore DVD if need be, and they will retain clarity. If you make them too
small, then expanding them in Adobe Encore DVD will reduce their sharpness.

• Horizontal lines need to be at least 3 pixels wide. Thinner lines will flicker on TV screens.

• Use RGB color images. Convert any non-RGB images (CMYK, for example) to RGB before adding them to
Adobe Encore DVD menus.

• Use NTSC safe colors to avoid a glowing, halo effect on TV screens. Use the Photoshop NTSC filter to
take care of that: Select Filter > Video > NTSC Colors.

• Font sizes should be at least 20 points; otherwise, viewers might not be able to read your text.
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3. You build each button within its own
Layer Set. Create a Layer Set by clicking
the Create a new set button highlighted
in Figure 27.3.

FIGURE 27.3: Create a layer set for each
button by clicking the Create a new set button.
Use the (+) prefix when naming button layer
sets.

4. You need to name the layer set using an
Adobe Encore DVD layer prefix. To do
that, Right/Option-click on the Layer Set
name, select Layer Set Properties, and
type in a name. Start it with (+) to
indicate this is a button set (there is no
space between the (+) prefix and the
layer name). I’ve listed all the Adobe
Encore DVD menu-naming naming
conventions in the following note.

Note: Adobe Encore DVD Layer Naming
Prefixes

• (+) on a Layer indicates this layer is a
button. You’ll note the first layer—Title
with the text “Scene Selection”—does
not have a (+). That means that text
string cannot be a button. You can
change that text to a button within
Encore DVD. Simply select the text string and select Object > Convert to Button. That will put a (+) in front
of that layer name and add an unnamed Subpicture Highlight layer with the (=1) prefix. NOTE: do not use
a prefix for the button text or image layers.

• (=1) or (=2) or (=3) selects the Highlight Menu Color Set Group (the so-called Subpicture layers I discussed
in the previous module). It’s best to use the same number (1, 2, or 3) for items you want to
have highlighted using the same color set. That ensures a consistent look to the menu in that all highlight
colors will be the same throughout the project.

• (%) denotes that this graphic is a placeholder for a video thumbnail image or animation.

5. Create the button in one of several ways: by using the shape building tools, by importing a button (be it an
image or graphic), or by simply adding some text. Buttons don’t have to look like buttons. You simply define
their layer set as a button and Adobe Encore DVD will treat whatever you put there as a button.
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Note: Take Care to Not Overlap Button Hot Zones

The button elements you create define a “hot zone.” Adobe Encore DVD sets each button’s boundaries at the
smallest rectangle that encompasses all elements of a button set. If anyone will play your DVD on a PC (just
about a certainty), take care not to have any overlapping hot zones. There is no setting to display hot zones in
Photoshop CS, so you simply have to take care as you build your menus. If you do have overlapping hot zones,
they’ll show up as you work on the menus in Adobe Encore DVD. You can fix most overlapping problems by
dragging button elements farther apart. One quick way to check for overlapping zones within Encore DVD is
to use the Check Project feature within the Disc section of the Project window. Click on the Button Overlap
checkbox and click Start.

6. You can create buttons that will display video thumbnail images or animation. To do that, create a new layer
set using the standard (+) naming convention. Add a layer to it, and name it using the (%) prefix.

7. It’s best to make video thumbnail buttons that match the aspect ratio of the original video. The easiest way
to do that is to make your button the same size as your project window and then scale it proportionately. To
scale it, select your button and then select Edit > Transform Path > Scale. As shown in Figure 27.4, that adds
the transform parameters to the menu bar. Make sure the Maintain Aspect Ratio chain link icon is unbroken,
and drag a button corner to set the new, properly proportioned size.
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FIGURE 27.4: Use Transform and its highlighted Maintain Aspect Ratio feature to reduce a full-screen-size button to
the size that fits your project (my button size is way too big for most purposes—it’s for demonstration only).

8. You need to add highlight layers to your buttons (Read the following note for an explanation about
highlight layers). You can apply them to your existing button layer or start a new one. Make sure you use the
(+) button layer set naming convention.

Note: Whys and Wherefores for Button Highlights

You know that when you click the arrow keys on your DVD remote, the buttons highlight in some fashion to
indicate that if you press the remote’s Enter button, that menu button’s action will take place. That highlight
can be any graphic or text and doesn’t have to match the shape, size ,or location of the original button (there
are hot spot overlap issues that do play a part in locating highlights, however).
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You can have up to three highlight layers for each of the subpicture highlight “states”: normal, selected, and
activated. Normal is how a button looks when your remote is not on it. For the most part, you don’t need a
“normal” highlight layer. “Selected” is when you’ve moved the remote to that button. “Activated” is what
happens when you click enter on a button. The activated highlight lasts for only a second or so.

9. Take a look at Figure 27.5 to see how that works. This is a standard button with a graphic and text. Note that
I put a box around its two, subpicture highlight layers (I have turned off their display for the moment). Note
that they have a (=#) prefix. That number can be 1, 2, or 3.

FIGURE 27.5: A button with two highlight layers (I’ve switched off their display). Note the (=1) and (=2) layer naming
convention.

10. Take a look at Figure 27.6. As I’ve said before, the whole subpicture highlight color issue can be mighty
confusing. This set-up gives you a chance to test the subpicture highlight color scheme as a means to make
sense of it. In this case, I have turned off the button and its text and displayed only the two highlights.
Within Adobe Encore DVD, you can define which is the Selected highlight and which is Activated. In this
case, you want the yellow box to be Selected (it will appear when the viewer moves the remote to it) and
the blue arrow to be Activated (it will display for a moment after the viewer presses the Enter button). To
have this happen you need to make some changes to the Color Set within Encore DVD. To make sure the
highlight with the (=2) has no Selected highlight, you need to set the opacity for the Selected State Color 2
to 0%. To make sure the highlight with the (=1) has no Activated highlight, you need to set the opacity for
the Activated State Color 1 to 0%.

FIGURE 27.6: The same button with only the highlight layers visible.

11. Finish your menu by creating more buttons or copying the existing ones and putting them in new layers.
You also can tap Adobe Encore DVD’s library of buttons, make changes to them and add them to your
menu.
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12. After saving your menu, you can open Adobe Encore DVD, start a new project or open an existing one, and
import your customized menu by selecting File > Import as Menu. If you want to do additional work on your
menus, simply select a menu and select Menu > Edit in Photoshop.
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Adobe Encore DVD’s tight integration with Photoshop CS is a major selling point for Adobe Encore DVD. It
greatly streamlines the menu creation process and ensures your menus will work as expected. It lets you easily
customize menus to suit the styles of the videos you use on your DVDs.

It’s a simple matter to open an existing Adobe Encore DVD menu in Photoshop, edit it, save it, and then return
to Adobe Encore DVD where those changes will be on display. Additionally, by using only a few naming
conventions, you can create menus in Photoshop that will perform certain DVD-related tasks (Video buttons and
Selected and Activated “states”) with no need for additional input from you.

Q. Why bother adding highlight subpictures to a button?

A. If you don’t have at least one subpicture, your viewers will have no way of knowing which button they’ve
navigated to as they press the arrow keys on their remote. You need to at least have a Selected highlight to
enable normal navigation. Of course, if you want to add “Easter Eggs” to your project, you can create hidden
buttons. One way is to switch off the graphic (click on its eyeball in the Encore DVD Layers palette) to define the
hot spot and give the subpicture highlight colors 0% opacity. Another option is to give only the Activated
subpicture highlight an opacity so when users navigate to the hidden button and press Enter on their remote,
that highlight will display confirming they found the Easter Egg.

Q. I named a layer using the (+) convention, but Adobe Encore DVD does not display it as a button. Why?

A. You need to name the Layer Set using the (+) prefix, not the layer itself. Then, whatever graphics and text you
create in that layer set define the hot spot for that button.

Quiz

1. What happens if you don’t use the (+) for a button layer set name?

2. While working in Adobe Encore DVD, you want to fix a menu you created in Photoshop CS. How do you do
that?

3. Why do you need to create lines that are at least 3 pixels in size?
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Quiz Answers

1. Adobe Encore DVD will consider that layer set to be part of the menu’s background, even if its layers have
(%) or (=#) prefixes.

2. Select the menu and click the Edit in Photoshop button on the Tools palette of select Edit > Edit in
Photoshop. Do your editing in Photoshop, save the menu, and return to Adobe Encore DVD. The changes
you made will have been applied to the open menu.

3. Anything less than 3 pixels will appear shaky on many TV screens. This rule-of-thumb also applies to adding
strokes to text.

Exercises

1. The easiest way to see Adobe Encore DVD and Photoshop CS integration is to edit some Adobe Encore DVD
menus in Photoshop CS. Select menus with video thumbnail buttons to see how they work.

2. Import buttons into Photoshop from the Adobe Encore DVD library to see how subpicture overlays are
handled. Add a second or third subpicture overlay to a button, then import it into Adobe Encore DVD, drag
it onto a menu background, and click the “Show Selected Subpicture Highlights” button at the bottom of
the Menu Editor window.

3. Take graphic elements from a video project and create menus with them. In this way, you preserve the
“look” of a project, giving your DVD an even more customized feel.

4. One cool thing to do with a group photo—team, classroom, or old family portrait for example—is to create
highlight graphics for each person. What you want the viewer to see, as he moves the remote from person
to person, is a transparent oval on the person’s head with that person’s name below it. Then when viewers
click on that person, they’ll go to a submenu on that person—season statistics, school art project, or family
history narrative. Create such a highlight graphic, and use it to create links to your DVD content. The one
caveat is that you need to avoid overlapping buttons and that the DVD specification defines button hot
zones as the smallest rectangle that encompasses all button elements. So even if you have an oval button
and subpicture highlight, they will serve to define a rectangular hot zone.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education
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